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KIRISH
Ushbu darslik pedagogika oliy ta’lim muassasalarining barcha vo'nalishlarida 

o‘qitiladigan «Ta’limda axborot texnologiyalari» o‘quv fani bo'yicha tuzilgan bo'lib, 
bo'lajak o'qituvchilar egallashi va amalda qo'Ilashi kerak bo'lgan quyidagi bilimlar 
va konikmalar majmuini o'z ichiga oladi:

Axborot, uning turlari, ko'rinishlari, axborotni saqlash, uzatish, qabul qilish va 
unga ishlov berish, elektron hisoblash mashinalarining arxitekturasi va ishlash 
printsiplari, mashina tili tushunchasi, mikroprotsessoming tuzilishi va ishlash 
printsiplari, Pascal dasturlash tili, dasturiy ta’minot, fayllar bilan ishlash, Windows 
operatsion tizimi, texnologiya tushunchasi, axborot texnologiyalari, zamonaviy 
axborot texnologiyalari, shaxsning ta iim, tarbiyasi va rivojlanishida zamonaviy 
axborot texnologiyalari, pedagogik dasturiy vositalar. matn va grafik axborotlami 
tayyorlash hamda ularga ishlov berish texnologiyasi, multimediya texnologiyasi, 
tarmoq texnologiyalari, internet texnologiyasi va uning xizmatlari, elektron tijorat, 
electron raqamli imzo, axborot xavfsizligi.

Fanning maqsadi va vazifalari. Ushbu darslik har bir kasb egasi uning faolivat 
ko'rsatish turidan qat’iy nazar egallashi kerak bo'lgan tayanch nazariy va amaliy 
ma’lumotlami o'z ichiga oladi. Fanni o'qitishdan maqsad - zamonaviy axborot 
texnologiyalari asoslari, zamonaviy shaxsiy kompyuterlar va ulaming atrof 
qurilmalari, tizimli dasturiy ta’minoti, amaliy dasturiy vositalar, zamonaviy 
kommunikatsion texnologiyalar, web-dizayn asoslari, dasturlash, Microsoft Office 
paketining dasturiy vositalari, internet texnologiyasi va uning xizmatlari, elektron 
tijorat, electron raqamli imzo, axborot xavfsizligi haqidagi bilimlar bilan 
qurollantirishdan iborat.

Ta limda axborot texnologiyalari fanning vazifalari quyidagilardan iborat:
■ Informatika va axborot texnologiyalari haqida bir butun tasavvur hosil qilish;
■ Informatika va axborot texnologiyalarining har bir inson hayotidagi va 

jamiyatning rivojidagi rolini ochib berish;
■ Informatikaning texnik va dasturiy vositalarining imkoniyatlarini ochib berish;
■ axborot tizimlari va texnologiyalarini nima maqsadda va qanday qo'llash 

haqida tushuncha hosil qilishdan iborat.
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IV BOB. KOMPYUTER GRAFIKASI

17-§. Kompyuter grafikasi va uning turlari

Tayanch tushunchalar: kompyuter grafikasi, kompyuter animatsiyasi, rastrli 
grafika, vektorli grafika, fraktal grafika, piksel, to 'g ri chiziq, uchburchak, grafik 
muharrir, tasvir sifati.

Kompyuter grafikasi uzoq yillar davomida vujudga kelib, 1960 yillarda ham 
toiaqonli grafik tizimlar mavjud boigan. Hozirgi kunda kompyuter grafikasi va 
kompyuter animatsiyasi atamalaridan foydalaniladi. Kompyuter grafikasi tushunchasi 
statik tasvirlar bilan ishlashning barcha ko'rinishlarini o‘z ichiga olsa, kompyuter 
animatsiyasi dinamik o‘zgaruvchi tasvirlar bilan ishlaydi.

Kompyuter grafikasi -  elektron hisoblash mashinalari boshqaruvida grafik 
ob’yektlami kiritish. chiqarish, tasvirlash. o^zgartirish va tahrirlashdir.

Kompyuter grafikasi -  informatikaning maxsus qismi boiib. dasturiv-apparat 
hisoblash komplekslari yordamida tasvirlami yaratish va qayta ishlash usullari va 
vositalarini o rganadi.

Kompyuter grafikasi -  bu virtual grafikli ob’yektlarni yaratish 
texnologiyasidir (I. Reznik).

Kompyuter animatsiyasi -  ekranda tasvirlami «jonlantirish», kompyuterda 
dinamik tasvirlar sintezidir.

Virtual fazoda hajmli ob’yektlami yaratish usullarini о rganuvchi soha uch 
oichovli (3D) grafika deb nomlanadi. Odatda unda tasvir yaratishning vektorli va 
rastrli usullaridan foydalaniladi.

Maiumki web-dizaynning ajralmas qismi bu kompyuter grafikasi hisoblanadi. 
Boshqacha aytganda kompyuter grafikasi yordamida savtlami dizayni 
mukammallashtiriladi. Saytlami bezash uchun turli xil illyustratsiyalar (rasmlar, 
grafiklar, roliklar, animatsiyalar, bannerlar va boshqalar) yaratishda va tayyor grafik 
formatdagi ma lumotlami o‘zgartirishda kompyuter grafikasidan keng foydalaniladi. 
Kompyuter grafikasi va uning tarkibiy qismi boigan grafik va turli tasvirlar axborot 
texnologiyasida muhim o‘rinni egallaydi. Pedagogika oliy taiim  muassasalarida 
taiim  olayotgan talabalarga grafik axborot texnologiyalan haqidagi bilimlami beradi 
va professional faoliyatida ulardan samarali foydalanishga tayyorlaydi. Boshqacha 
aytganda har qanday boiajak o'qituvchi, kelajakda o zining fani bo vicha elektron 
o‘quv resurslarini yaratishda foydalanadi. Bu bilan esa taiim  samaradorligiga 
erishiladi. 0 ‘qituvchi dasturlash texnologiyasidan yaxshi xabardor boiib, ammo u 
yaratgan resurslari talabalami o'ziga tortadigan dizayn bilan boyitilmagan boisa, u 
holda har qanday dasturiy mahsulotning o‘qitish jarayonidagi samaradorligi past 
boiadi. Shuning uchun ham dasturlash bilan birga kompyuter grafikasini ham 
mukammal o‘rganish talab qilinadi.
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4.1-rasm. Kompyuter grafikasi 
Kompyuter grafikasi va dizaynga oid materiallami o'rganish natijasida 

quyidagilami bajara olish mumkin:
- rasmlar bilan ishlash;
- ko'p bo‘g‘inli statik rasmlar bilan ishlash;
- grafik muharrirlar imkoniyatlaridan foydalanish;
- turli maqsadlardagi grafik paketlami qo llagan holda rang-barang grafik 

ob’yektlami yaratish;
- nashrga tasvirlami tayyorlash.

Kompyuter grafikasi fani asosan elektron rasm va tasvirlar bilan ishlashni 
o‘rgatadi. Hozirgi kunda grafik dasturlar soni juda ko‘p bo‘lib ular ishlash tamoyiliga 
ko‘ra har xil grafikada bo'lishi mumkin. Masalan: Rastrli grafika bilan ishlovchi 
dasturlar Paint, Adobe Photoshop, CorelPhotoPaint va boshqalar (grafik 
muharrirlaming umumiy ro‘yxati 4.1-jadval).

4.1-jadval. Grafik muharrirlar ro'yxati
№ Grafik muharrir Izoh
1. Adobe Photoshop Rastrla grafikani qayta ishlash uchun mo'ljallangan
2. TwistedBrush Pro 

Studio 15.74
Tasvirlami ehizish va tahrirlashga mo'ljallangan grafik muharrir

3. CorelDraw Graphics 
Suite X4

Vektosrli grafika bilan ishlashga mo'ljallangan grafik muharrir

4. 3D Studio Max 3D-modellashtirish, ammatsava va vizualizatsiva uchun 
mo'ljallangan

5. Adobe Flash С S3 
Professional

Professional animatsiyali Flash-fayllarni yaratishga 
mo'ljallangan dastur.

6. Paint.NET Grafik muharrir (standart Paint dasturmi o'mini bosuvchi)
7. AutoCAD 2010 Eng murakkab loyihalami chizishga mo'ljallangan dastur
8. Adobe Illustrator CS3 Har qanday murakkablikdagj vektorli tasvirlami yaratishga 

mo'ljallangan
9. Adobe Creative Suite 5 

Master Collection
Loyihalami ehizish va qayta ishlashga mo'ljallangan dastur

10. ZBrush 3X) Ikki va uch o'lchamli loyihalashga mo'ljallangan grafik muharrir
11. The GIMP Rastrla grafik muharrir
12. Adobe InDesign С S3 Har qpnday dizayndagi chop etiladigan va Internet nashrlarini 

loyihalashga mo'ljallangan professional dastur
13. Xara Xtreme Pro Rastrli va vektorli grafikani qo‘Hagan holda professional web- 

grafikani yaratish uchun mo'ljallangan grafik muharrir
14. Adobe Fireworks CS3 Web-savtlar uchun mo'ljallangan grafikani tayvorlashga 

mo'ljallangan grafik muharrir
15. Corel Painter 11 Illyustratsivalar ehizish va tavyorlashga mo'ljallangan dastur
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Rastrli grafik muharrirlarida har bir tasvir nuqta ya'ni piksel asosida quriladi. 
Bu dasturlar yordamida yaratilgan fayllar *.bmp, *.jpg, *.psd, *.tif va boshqa 
formatlarda saqlanishi mumkin. Bu turdagi fayllar ranglari vorqinligining juda sifatli 
ekani bilan ajralib turadi. Ulaming kamchiligi sifatida esa tasvimi kattalashtirish 
bilan uning sifati yo qolib borishini va xotiradan k o p  joy egallashini avtib oiish 
lozim. Shuning uchun ko‘pincha ulardan tayyor rasmlami qayta ishlashda 
foydalanish tavsiva qilinadi.

Axborot va uni taqdim etishning turli ko‘rinishlari. Hozirgi kunda inson 
faolivatining turli sohalari ichida o‘zining muhimligi bilan ajralib turuvchi soha - bu 
tashkiliy, ya’ni ishlab chiqarish va xo‘jalik hamda. ijtimoiv jarayonlami boshqaruv 
sohasidir. Busiz barcha sohalarda faoliyat yuritib boimaydi. Boshqaruv axboroti 
jarayon hisoblanib, tizimlar holatini qanday o'zgarishiga qarab qo‘yilgan maqsadga 
erishish uchun yetakchi yo‘nalishdir. Har qanday tizim tobg‘ri va teskari aloqa 
tamoyilidan iborat. Ma iumki, axborotlarni insonlar bir-biriga uzatish jarayonida 
matn, jadval, tovush va tasvir ko‘rinishdagi signallardan foydalanadi.

Tasvir ко 'rinishida berilgan axborotlarni qayta ishlash texnologiyalari
Ixtiyoriy matn yoki hujjatda grafiklar, diagrammalar, chizmalar, rasmlar, 

vorliqlarini kiritish ehtivoji grafik muharrirlarini yaratish zaruriyatini hosil qiladi. 
Grafik muhamrlar uskuna vositalardan iborat boiib, ular o‘ziga mos axborot 
texnologiyalardan foydalanib grafik obrazlarini yaratish va o'zgartirish 
imkoniyatlarini beradi.

Grafikaning quy idagi turlari bor:
- tijorat grafikasi;
- tasviriv grafika
- ilmiy grafika.

Tijorat grafikasining axborot texnologiyasi aylanma diagrammalar, ustunli 
gistogrammalar, chiziqli grafiklar hamda boshqa tipdagi ikki va uch oichamli grafik 
ko‘rinishda elektron jadvalli muharrirlarida maiumotlar bazalarida va aiohida lokal 
fayllarda saqlanavotgan axborotlarni ekranga akslantiradi.

Tasviriy grafikaning texnologiyasi turli xil matnli hujjatlar uchun regulyar va 
noregulyar struktura ko'rinishdagi foydalanuvchining rasmlari (piksel grafikasi) 
tasvirini yaratish imkoniyatlarini beradi. Tasviriy grafika texnologiyasini amalga 
oshiruvchi muhamrlar foydalanuvchiga chiziq qalinligi va rangi, matnni yozish 
uchun shrift, oldin yaratilgan grafik obrazlarini tanlash uchun vosita beradi. Bundan 
tashqari, foydalanuvchi rasmni o'chirish, qirqish va uning qismini bir jovdan 
boshqasiga surishi mumkin. Ammo, tasvirlami slaydda maxsus effektlar va ulami 
jonlantirish rejimida ko rish imkoniyatlarini beruvchi (CorelDravv, Stonyboard, 
3DStudioMAX va boshqalar) informatsion grafik texnologiyalar ham bor.

Ilmiy grafikaning texnologiyasi kartografiva masalalari. kimyoviy, matematik 
va boshqa formulalami o‘z ichiga oluvchi ilmiy hisoblashlami bezab joylashtirish 
uchun xizmat qiladi.

Kompyuter grafikasi qoilaniladigan asosiy sohalami ko'rsatib o‘tamiz:
1) Grafiklami chizish;
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2) Kartografik-geografik, tabiiy yoki iqtisodiy hodisalarni o'zaro chegaradosh 
mamlakatlar, viloyatlar, oikalar va shu kabilarni aaiq tasviri;

3) Chizma va konstruktorlik ishlarini avlomatlashtirish;
4) Modellashtirish va multiplikatsiya;
5) Turli texnologik jarayonlami boshqansh - real dunyo masshtabida interfaol rejimda 

ishlash. Texnologik jaravonni eng kerakli nuqtalariga o‘matilgan dastlabki axborot 
manbai boigan datchiklardan kelay otgan axborotlar qiymatini vizual idrok qilish;

6) Nashr ishlarini avtomatlashtirisih va chop etishni elektron usuli. Reklama va san’at - 
qandavdir fikmi ifodalash va estetik yoqimli tasvirlar orqali jamoani diqqatini tortish.

Tasvir ко ‘rinishda berilgan axborotlami qayta ishlashning umumiy masalalari 
Tasvir ko‘rinishida berilgan axborotlami kompyuterda qayta ishlash 

texnologiyasi xilma-xil bo‘lib, juda ko‘p amaliy masalalami hal qilishga tatbiq 
etiladi. Axborotlami qayta ishlashning bu sohasini quyidagi uch vo'nalishga 
ajratiladi:

1. Kompyuter grafikasi (COMPUTER GRAPHICS);
2. Tasvirlami qayta ishlash (IMAGE PROCESSING);
3. Tasvirlami tanib olish (COMPUTER VISION).

Tasvir ko‘rinishga ega bo'lmagan axborotlami vizuallashtirish (ya’ni 
tasvimi yaratish) masalalari bilan kompyuter grafikasi (COMPUTER GRAPHICS) 
shug‘ullanadi.

Vizuallashtirish tasvirlanishi zarur boigan ob'yektning tasnifi (modeli) 
asosida bajariladi. Hozirgi paytda vizuallashtirish usullari va algoritmlari juda ko‘p 
bo‘lib, ular nimani va qanday qilib aks ettirish bilan bir-biridan farq qiladi.

Vizuallashtirishga misollar (murakkablashib borish tartibida) sifatida 
quyidagilami ko‘rsatish mumkin:

□ funktsiyalar grafigi;
I diagrammalari;

□ geografik xaritalar;
□ animatsiyalar.

Shuni ta’kidlab o'tish kerakki, grafiklar vaqtga nisbatan o‘zgarmas (statik) 
boMadi.

Tasvirlami qayta ishlash (IMAGE PROCESSING) - bu tasvirlami 
almashtirish bilan bog‘liq masalalar hisoblanadi. Tasvirlami qayta ishlash 
algoritmlari uchun boshlang‘ich maiumotlar ham tasvirlar, natija ham tasvirlar 
boiadi.
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Grafik ma'lumotlami tasvirlash.
/. Kompyuter grafikasi turlari

• Ikki 0‘lchamli
• Uch oichamli
• Rastrli
• Vektorli
• Fraktal
• Simvolli

• Statik
• Interfaol

• Muhandislik
• Dizayn
• Web

4.2-rasm. Kompyuter grafikasi turlari
Kompyuter grafikasi tasvirlami shakllantirish usullariga bog‘liq holda 3 turga 

boiinadi (4-tur grafika faqat mantning simvollandan tarkib topgani uchun tasnifga 
kiritilmaydi va chuqur o'rganilmavdi):

1. Rastrli grafika:
2. Vektorli grafika:
3. Fraktal grafika.
Ular bir-birlaridan tasvir ko‘rinishdagi axborotlami hosil qilish va qayta ishlash 

texnologiyalari bilan farq qiladi.
Rastrli grafika1. Rastrli grafikada tasvirlar kichik nuqtalardan -  piksellardan 

(pixel, px) tarkib topadi. Har qanday rastrli tasvir qayd qilingan sondagi 
piksellarga ega bo'ladi. Agar siz fotografiyani kattalashtirsangiz, u holda siz aynan 
piksellami ko'rasizki — ular tasvimi hosil qilgan turli rangdagi kvadratlardan 
iborat bo'ladi. Ular gohida manosiga tushunib boimavdigan detal qirrasini 
eslatadi (4.3-rasm).

Bu holatda, fotografiyadagi tasvimi tushunish qiyin boiadi. Rastrli tasvimi 
chop etgandagi sifati uning zichligiga bog'liq bo'ladi. Masshtablashda o'zining 
pikselli tabiatiga ko'ra rastrli grafika o'z sifatini yo'qotadi. Rastrli tasvirga misol 
sifatida har qanday fotografiva xizmat qilishi mumkin. U skanerlash yo'li bilan 
olinadimi yoki raqamli fotokamera yordamida suratga olinadimi buning ahamivati 
yo'q.

Adobe Photoshop — rastrli tasvimi qayta ishlash uchun moijallangan eng 
yaxshi dastur hisoblanadi

Piksel (picture element so zlarining qisqartmasi bo'lib, element kartinka 
elementi manosini anglatadi) — rastrli tasviming eng kichik bo'linmaydigan 
komponenti hisoblanib, uning ustida ishlash mumkin bo'ladi. U ikkita xususiyatga 
ega: holati va rangi.

Oichoviga ko ra

Shakllanjsh iga ko ra

D in am ik asiga  ko ra 

Ix tisosia sh u v iga  ко ra

1 Евгении Тучкевич Adobe Photoshop CS6 Мастер-класс — СПб.: БХВ-Петербург, 2013. —
20 с.



4.3-rasm. Turli masshtablarda rastrli tasvirga misol 
Rastrli grafika vositasida shakllangan tasvir asosan elektron va poligrafiya 

nashriyotlarida qoMlaniladi. Rastrli tasvir ikki o‘lchovli massiv (matritsa) 
ko‘rinishdagi nuqtalar to‘plamidan iborat bo‘lib. ular piksellar deb ataladi. Rastrli 
tasviming eng kichik elementi peksildan iborat (4.4-rasm). Uning atributlari 
boshqa piksellaming atributlari bilan bog‘liq emas.

О

4.4-rasm. Rastrli grafikada piksellaming ko‘rinishi 
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Tasviming kengaytmasi (разрешение) — bu uzunlik oichov birligidagi 
piksellar (nuqtalar) soni hisoblanadi. Odatda buni dyuymdagi nuqtalar soni (dots per 
inch, dpi) yoki dyuymdagi piksellar soni (pixel per inch, ppi) bilan oichanadi.

Eslatma
Dyuym 2,54 santimetrga teng

Shu tarzda, kengaytma qancha katta boisa, pikselnmg o‘lchami shuncha kichik 
boiadi. Kengaytma qancha katta bo‘lsa, dyuymda shuncha ko‘p piksellar joylashadi. 
Kengaytma qancha katta boisa, tasvir sifati shuncha katta boiadi (4.5-rasm)2.

0 1 0  1 0  1
I....I—L -L—I—L—l... I J  [ _ 1 . . .  1. . 1, I 1 1 I I I 1 I I l 1

8 dpi 16 dpi 72 dpi
4.5-rasm. Kengaytma va tasvir sifati 

Kengaytma har bir tasvir uchun individual tarzda yigilib olinadi va u qaverda 
ishlatilishiga bogiiq boiadi. Masalan, agar siz rasmni intemetda ishlashini 
rejalashtirayotgan boisangiz, u holda kengaytma 72 ppi tanlab olinadi. Bunday 
tanlovda sizning tasviringizni monitorga shu tarzda uzatilib beriladi. Internet uchun 
asosiy mezon bu tasviming ajovib sifati emas balki tasviming yuklanish tezligi 
hisoblanadi. Shuning uchun ham faylning tegishli formati tanlanadiki, unda sifati 
birinchi o'rindan yiroq boiadi.

Kompyuterda qoilaniladigan operatsion tizimlaming imkonivatiga ko'ra, 
480x640, 800x600, 1024x768 va undan ko'proq pikselga ega boigan tasvirlar 
joylashishi mumkin. Tasviming oichamiga ko‘ra uning imkoniyati ham oshib 
boradi. Ekranning imkoniyati parametrik boiib. bir dyuy mdagi nuqtalar soni bilan 
belgilanadi. Rastrli grafik vositalari bilan bajarilgan (tayyorlangan) tasvirlar juda 
kam hollardagina kompyuter dasturlaridan foydalanib ishlab chiqiladi. Bu 
maqsadda professional rassom chizgan rasm yoki fotografiya texnik vositalari 
yordamida kompyuterga kiritiladi.

2 Евгении Тучкевич. Adobe Photoshop CS6 Мастер-класс. —  СПб.: БХВ-Петербург, 2013. —
22 c.
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Oxirgi paytda rastrli tasvirlami kompyuterga kiritish uchun raqamli foto va 
videokameralardan foydalanilmoqda. Shu sababli rastr grafikasini asosiy maqsadi 
tasvimi yaratish emas, balki mavjud tasvimi qayta ishlashdir.

Rastrli grafikaning ijobiy tomonlari sifatida quyidagilami ko‘rsatish
mumkin:
□ universallligi (bu holatda har qanday tasvimi taqdim etish mumkin);
] shakllantirishning soddaligi;

□ rang jilolarini berish aniqligining yuqoriligi.
Ushbu usulning salbiy tomonlari sifatida quyidagilami ko‘rsatish mumkin:

□ rastrli grafik bloklar hajmirang juda kattaligi;
] ulaming masshtabi o'zgarganda tasvir sifatining pasayishi.

Rastrli grafikada har bir tasvimi kodlash va saqlash uchun katta hajmdagi 
xotira talab etiladi. Tasvirdagi juda kichik ob'yektlami ko'nsh uchun uning 
masshtabini kattalashtirib bo'lmaydi. Bu rastrli tasvirlami qayta ishlash jarayonida 
ba’zi bir muammolami paydo bo‘lishiga olib keladi.

Rastrli tasvirlar quyidagi tiplarga boiinadi: binar, kulrang, palitrali, to‘liq 
kulrang. Bunda tasviming elementlari faqat ikki qivmatni (0 yoki 1) qabul qilish 
mumkin. Bu tasvirlar turlicha pavdo boiishi mumkin. Ammo ko‘p hollarda kulrang, 
palitrali va turli rangli tasvirlami o‘zgarmas yoki adektiv chegaraviy son bilan binar 
tasvirga almashtirish natijasida paydo bo‘ladi. Binar tasvirlami saqlash uchun juda 
ham katta joy talab qilinadi. Ulaming har bir elementi uchun 1 bit joy kerak boiadi. 
Kulrang tasvimi elementlari ma’lum bir rang intensivligining turli xil qiymatlari 
qabul qiladi. Odatda bu tasvirlaming har bir elementini saqlash uchun 8 bit 
ishlatiladi. Kulrang tasvirlar turli xil amaliy masalalami hal qilishda eng ko‘p 
qoilaniladigan tasvirlardan biri hisoblanadi.

Palitrali tasvirlaming har bir elementiga ranglar xaritasining bir katakchasidagi 
rang mos qo‘viladi. Palitra -  bu ikki o‘lchovli massiv boiib, uning satrlariga turli 
ranglar, har bir ustunlariga esa ma’lum bir rangning intensivligi joylashtiriladi.

Toiiq  rangli tasvirlar elementlari rangni tashkil etuvchi yorqinliklari haqidagi 
axborotni o zini saqlaydi. Shu bilan u palitrali tasvirlardan farq qiladi. Amaliy 
masalalar vechishda qaysi tipdagi tasvimi tanlash masalasining o‘ziga xos 
xususiyatlaridan boshlab, tasvirdagi zarur axborotni qanchalik to iiq  ifodalanishi 
bilan xarakterlanadi.

Vektorli graflka. Vektorli grafikada tasvir sifati kengaytmaga bogiiq 
bo'lmaydi. Vektorli ob’yektlar matematik tenglamalarda ifodalanadi. Shuning uchun 
ham masshtablanganda ular sifatni yo‘qotmaydi (4.6-rasm).

Ammo tenglamalaming natijasini ko‘rish imkoni boimasa, ulaming o'zi- 
o'zicha hech qanday ahamiyat kasb etmaydi. Vektorli ob’yektlar monitor yoki printer 
singari chiqarish qurilmalarida rastrlanadi. Vektorli grafika natijasi sifatida katta aniq 
shakllar uchun, masalan, matnlar, logotiplar, yassi rasmlami aytish mumkin. Corel 
Draw, Adobe Illustrator — dasturlari vektorli tasvimi yaratish va qayta ishlash uchun 
moijallangan dastur hisoblanadi. Vektorli fayl hajmi uning tarkibiga kiradigan 
ob’yektlar soniga bogiiq boiadi. Vektorli grafika vositasida shakllangan tasvir
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sodda grafik ob'yektlar to‘plamidan tuzilgan boiib, uning tipik elementiga mos 
keladi. Vektorli tasviming asosiy elementi chiziq boiib hisoblanadi3.

4.6-rasm. Turli masshtablarda vektorli tasviming ko‘rinishi.
Kompyuter xotirasida bu chiziq juda katta joy egallamaydi, chunki xotirada 

chiziqni faqat parametrlari ko‘rsatiladi. Unda sodda ob’yektlar murakkab 
ob’yektlarga birlashtiriladi. Shu sababli vektor grafikasini ob’yektga yo‘naltirilgan 
grafika deb ham aytiladi. Kompyuter xotirasida vektor grafikasi chiziqlar sifatida 
saqlanib turishiga qaramasdan, tasvir ekranga nuqtalar sifatida chiqariladi. Tasvimi 
ekranga chiqarishdan oldin har bir parametmi hisoblab chiqadi. Shu sababli vektor 
grafikasini hisoblanuvchi grafika deb aytiladi. Vektor grafikasi yordamida sodda 
turdagi bezash ishlarini olib borish mumkin.

Vektorli grafik tizimning muhim tavsifi boiib, uning sodda grafik 
elementlarining tarkibi xizmat qiladi. Sodda grafik elementlariga bir nechta misol 
keltiramiz:

! Koordinatasi ko'rsatilgan nuqtalar boshlanuvchi maium bir burchak ostida 
yo nalgan va berilgan uzunlikka ega boigan chiziq;
LI Markaziy koordinatalari ko‘rsatilgan nuqtada joylashuvchi, yarim o‘qlarining 
uzunligi, chiziqning rang va qalinligi, hamda uni bo‘yash rangi berilgan ellips;
□ Chap tomondagi yuqori burchagiga joylashgan nuqtaning koordinatalari, 
tomonlar uzunligi, chiziq qalinligi va rangi ko‘rsatilgan to g‘ri to‘rtburchak.

3 Евгении Тучкевич. Adobe Photoshop CS6. Мастер-класс —  СПб.: БХВ-Петербург, 2013. —
21с.

12



Vektorli tasvimi ko'rsatayotganda sodda elementlaming chiziqli geometrik 
atributlari, uning boshlang'ich va zarur o'lchamlari ortasidagi munosabatni, hamda 
chiqarish qurilmalarida (monitorlar, chop etish qurilmasi) ruxsat berilgan xatolikni 
hisobga olgan holda hisoblab chiqadi. Bunday usul masshtablashtirish imkoniyatini 
sezilarli darajada oshiradi. Tasvir oichamini qancha ko'pavtirsa ham, uning sifati 
o'zgarmaydi. Tasviming oichamlarini juda kichiklashtirib yuborganda, sodda 
elemenlaming chiziqlari ustma-ust tushib qolishi va xatolami ixchamlash hisobiga u 
o'zgarishi (buzilishi) mumkin.

Fraktal grafika vositasida shakllangan tasvirlar ham xuddi vektorli grafika 
kabi matematik hisoblarga asoslangan. Ammo kompyuter xotirasida hech qanday 
ob yektni saqlamasligi bilan undan farq qiladi. Tasvir tenglama (yoki tenglamalar 
tizimi) bo'yicha quriladi. Shuning uchun formulalardan boshqa hech narsani 
saqlash kerak emas.

«Fraktal» atamasi lotincha “fractus” so'zidan olingan va u «qismlardan 
tuzilgan» ma nosini anglatadi. Fransuz matematigi Benua Mandelbrot 1975 yilda 
«The fractal geometry of Nature» kitobini nashr qildi va fraktal so'zi eng ko'p 
tarqalgan aiamalardan biriga aylandi.

Eng sodda fraktal ob yekt sifatida qor uchqunlarini yoki paporotnik bargini 
keltirish mumkin. Shuning uchun ham fraktal ob yekt ehizish yoki bezash asosida 
emas, balki dasturlashtirish asosida hosil bo'ladi. Kompyuterda tashkil qilingan turli 
o'yinlarda ham fraktal grafikadan foydalaniladi. Fraktal grafika kompyuter xotirasida 
saqlanib turmavdi. Har bir tasvir tenglama yoki tenglamalar tizimi asosida quriladi. 
Fraktal grafikadagi tenglamaning biror koeffitsiyentini o'zgartirish orqali butunlay 
boshqa tasvimi hosil qilish mumkin.

Sanab o'tilgan kompyuter grafikasi turlarini tashkil qilish va ulami boshqarish 
uchun bir qator dasturiy vositalar ishlab chiqilgan.

Rastrli tasvirlar va ulaming asosiy xarakteristikalari. Rastr - bu juda 
kichik yuzaga ega bo'lgan geometrik figuralar (piksellardan), masalan 
kvadratchalandan tuzilgan matritsa. Har bir piksel o'z rangiga ega bo'lishi mumkin. 
Turli ranglarga ega bo'lgan rastrlar to'plami tasvimi tashkil etadi. Tasvir 
ko'rsatilayotgan sirtda piksellami joylashishiga nisbatan rastrlar turli tiplarga 
bo'linadi: kvadrat, to'rt burchak, doira va shu kabilar. Piksellar joyiashishini 
tasvirlash uchun turli xil koordinata tizimlaridan foydalaniladi. Bu tizimlami 
hammasi uchun umumiy bo'lgan xossa, ularda piksel koordinatalarining diskret 
qiymatlar qatoridan (butun son boimasligi mumkin) tashkil topgandir. Ko'p hollarda 
butun sonlar koordinatasidan foydalaniladi. Bunda piksellaming boshlang'ich 
koordinatasi chap tomondagi yuqori burchakdan boshlanadi.

Rastrning geometrik xarakteristikalari quyidagilardan iborat:
] Ruxsat berilgan xatolik;

□ O'lcham;
□ Piksel shakli.

Rastrda ruxsat berilgan xatolik o'zaro qo shni (yonma-yon) joylashgan 
piksellar orasidagi masofa bilan xarakterlanadi. Ruxsat berilgan xatolik bir birlik
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uzunlikdagi piksellar soni bilan oichanadi. Eng ko‘p tarqalgan o‘lchov birligi boiib, 
dpi (dots per inch) xizmat qiladi. U bir dyuym (25,4 mm) uzunlikdagi piksellar soni.

Rastming o'lchami odatda gorizontal va vertikal o‘qlar bo‘yicha joylashgan 
piksellar soni bilan aniqlanadi. Shuni ta’kidlab aytish mumkinki, har ikki o‘qlar 
uchun bir xil qadamli (va ni, dpiX = dpiY) rastr kompyuter grafikasi uchun juda 
qulay. Bu ayniqsa grafik ob’yektlami chiqarish algoritmlari uchun qulay. Aks holda 
muammo paydo bo ladi.

Rastr piksellarini shakli tasvimi chiqarish qurilmasining xususiyatlari bilan 
aniqlanadi. Masalan, piksellar quy idagi shakllarda boiishi mumkin:
1. Kvadrat (y oki to‘g‘ri to‘rtburchak shaklidagi piksellar). Ular o‘lchami bo‘yicha 
rastr qadamiga teng (suvuq kristalli displevda);
2. Doira shaklidagi piksellar. Ular o‘lchami bo‘yicha rastr qadamiga teng boimasligi 
mumkin (printerlar).

Ranglar soni (rang chuqurligi) ham rastming eng muhim xarakteristikalaridan 
biri. Ranglar soni faqat rastrli tasvir uchun emas. Balki har qanday tasvir uchun ham 
muhim xarakteristika hisoblanadi.

Kompyuter grafikasining vositalari. Kompyuterda tasvirlar bilan ishlash 
jarayonida turli-tuman vositalardan foydalaniladi. Shuningdek bu vositalardan 
foydalanishda kompyuteming o'ziga ham talablar qo‘yiladi. Tasvirlar bilan ishlashga 
moijallangan kompyuterlar boshqa kompy uteri arga qaraganda kuchliroq boiishi 
zarur. Eng avvalo uning xotirasi ko‘p va qattiq disk sig‘imi katta bo‘lishi lozim. 
Chunki grafik favllaming oichamlari juda katta boiadi. Bunday kompy uterlaming 
operativ xotirasi-minimum 128 megabavt boiishi mumkin. Agar 256 megabayt va 
undan yuqori xotira о matilsa maqsadga muvofiq boiadi. Biroz avval ishlab 
chiqilgan kompyuterlarda qattiq diskning hajmi 20 gigabavt atrofida boiishi 
mumkin. Agar bizning diskimiz oichami 5 gigabayt boisa yangi rasm chizilgandan 
kevin, eskizlarini olib tashlashga to‘g‘ri keladi. Kompyuterlarda kompakt disklarga 
yozib oluvchi moslama boisa illyustratsiyalami boshqa kompyuterlarga ko‘chirish 
qulay boiadi.

Protsessor zamonaviy va y etarlicha tez boiishi kerak. Aks holda tasvirlami 
tahrirlashda kompyuter ko‘p o‘ylanib turish mumkin.

Har qanday kompyuterda monitor asosiy komponentlardan hisoblanadi. 17 
dyuy mdan kichik diagonalli monitorlar eskirgan hisoblanadi. Yaxshisi 19 dyuymli 
monitorlardan foydalangan ma qul.

Qo‘shimcha vositalar. Kompyuter grafikasida ishlatiladigan qo'shimcha 
vositalardan biri bu raqamli fotokamera hisoblanadi. Ular oddiy fotoapparat singari 
ishlaydi, lekin plyonka o‘rniga tasvimi elektr signallariga avlantirib beruvchi 
yorugiik sezuvchi elementdan foydalaniladi. Tasvir signallari kodlanganidan keyin, 
ular kameraning xotirasiga joylashadi. undan keyin esa xohlagan pay tda kompyuterga 
yozib olish mumkin. Shundan keyin bu tasvirlar xohlagan grafik muhanirda qavta 
ishlanadi va printerda chop qilinadi.

Bundan tashqari siz grafik fayllami kompakt disklarga yozib olib, raqamli 
ko‘rinishda fotoalbom tashkil qilishingiz mumkin. Agar sifatli fotokamera boisa 
skaner yoki nusxa ko'chiruvchi qurilmalar kerak boimaydi. Kompyuter grafikasi
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uchun yana bir zarur vositalardan biri bu maxsus peroli grafik planshet hisoblanadi. 
Planshetga grafik pero bilan xuddi qalamda qog'ozga chizgandek chiziladi. Bu esa 
rasm chizuvchilarga katta imkoniyatlar beradi. Bu planshetlami Wacom firmasi 
ishlab chiqaradi. Grafik peroda iste’mol elementi va birlashtiruvchi kabel boMmaydi. 
Pero oddiy ruchkaga o'xshaydi Grafik peroni orqasiga aylantmlib. huddi o'chirg'ich 
bilan ochirgandek ochiriladi.

Kompyuterlarga rasmlar va sur'atlami kiritish uchun skanerlardan 
foydalaniladi. Yuqori sifatli skanerlami Agfa va UMAX firmalari ishlab chiqaradi.

Grafikani qog‘ozga chiqarish uchun lazer printerlaridan foydalangan ma’qul. 
Lazer printerida oq-qora tasvirlar va muhim boimagan rasmlar chop qilinadi. Lekin 
chop qilingan rasmlar rangsiz bo isa o"z go'zalligini yo qotadi.

Yuqori sifatli realistik tasvirlami chop qilish uchun fotografik printerlardan 
foydalaniladi. Foto printerlardan eng sifatlisi Epson. Stylus photo seriyasidagi 
printerlar hisoblanadi. Bu printerlar uchun maxsus qog;ozlardan foydalaniladi.

Savol va topshiriqlar:
1. Kompyuteming grafik imkonivatlari va ulaming turlarini aytib bering?
2. Qanday amaliy grafik dasturlami bilasiz?
3. PhotoShop-rastrli grafik muharriri haqida nimalami bilasiz?
4. CorelDraw-vektorli grafik muharriri haqida nimalami bilasiz?
5. AvtoC AD, CD Studio MAX - dasturi haqida nimalami bilasiz?

Test savollari
1. Grafik muharrirlar to‘g‘ri keltirilgan qaturni 
toping?
A) MS Paint, Adobe Photoshop, Corel Draw
B) MS Word. MS Paint, Adobe Photoshop, Corel 
Draw
C) MS Excel. MS Paint, Adobe Photoshop, Corel 
Draw
D) Home Site, MS Paint, Adobe Photoshop, Corel 
Draw

2. Rastrli grafik» bilan ishlashga mo'Ijallangan 
dasturlami toping?
A) MS Paint, Adobe Photoshop
B) MS Paint, Adobe Photoshop, Corel Draw
C) Adobe Photo^iop, Corel Draw
D) Corel Draw, Adobe Photo Paint

3. Vektorli grafika bilan ishlashga mo ijallangan 
dasturlami toping?
A) Corel Draw, AvtoCAD
B) MS Paint, Adobe Photoshop
C) MS Paint, Adobe Photoshop, Corel Draw
D) Adobe Photoshop, Corel Draw

4 Kompyuter grafikasi nima?
A) elektmn hisoblash mashinalari boshqaruvida 
grafik ob’yektlami kiritish. chiqarish, tasvirlash, 
o‘zgartirish va tahrirlashdir.
B) ekranda tasvirlami 'jonlantirish”, kompyuterda

8. Tijorat grafikaga xos javobni toping'.'
A) aylanma diagrammalar. ustunli gistogrammalar, 
ehiziqli grafiklar hamda boshqa tipdagi ikki va uch 
o‘lchamli grafik ko‘rinishda elektron jadvalli 
muharrirlanda, ma’lumotlar bazalarida va alohida 
lokal fayllarda saqlanayotgan axborotlami ekranga 
akslantiradi.
B) turli xil matnli hujjatlar uchun regulyar va 
noregulyar struktura ko‘rinishdagi 
foydalanuvchining rasmlari (piksel grafikasi) 
tasvirini yaratish imkoniyatlarini beradi.
C) kartografiya masalalari. kimyoviy, matematik va 
boshqa fmmulalami o‘z ichiga oluvchi ilmiv 
hisoblashlami bezab joylashtirish uchun xizmat 
qiladi.
D) ekranda tasvirlami '“jonlantinsh”, kompyuterda 
dinamik tasvirlar sintezidir.

9. Tasviriy grafikaga xos javobni toping?
A) turli xil matnli hujjatlar uchun regulyar va 
noregulyar struktura ko‘rinishdagi 
foydalanuvchining rasmlari (piksel grafikasi) 
tasvirini yaratish imkoniyatlarini beradi
B) aylanma diagrammalar, ustunli gistogrammalar, 
ehiziqli grafiklar hamda boshqa tipdagi ikki va uch 
o‘lchamli grafik ko‘rinishda elektron jadvalli 
muhamrlanda, ma’lumotlar bazalarida va alohida 
lokal fayllarda saqlanayotgan axborotlami ekranga 
akslantiradi.
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dinamik tasvirlar sintezidir.
C) ko‘p bo'g'inli statik rasmlar bilan ishlash;
D) grafik muharrirlar imkonivatlaridan foydalanish;

5 Kompyuter animatsivasi nima?
A) ekranda tasvirlami “jonlantinsh”, kompyuterda 
dinamik tasvirlar sintezidir,
B) elektron hisoblash mashinalari boshqaruvida 
grafik ob'yektlarni kiritish-chiqarish, tasvirlash, 
o'zgartirish va tahrirlashdir;
C) ko'p bo'g'inli statik rasmlar bilan ishlash;
D) grafik muliarrirlar imkonivatlaridan foydalanish;

6. Rastrli grafiklar formatini aniqlang?
A) bmp. jpg. psd, tif va boshqa formatlar;
B) avi, mov, wmf
C) fla, swf, exe
D) cdr

7. Vektorli grafiklar formatini aniqlang?
A) cdr
B) bmp, jpg, psd, tif va boshqa formatlar;
C) avi, mov, wmf
D) fla, swf, exe

C) kartografiya masalalari, kimyoviy, matematik va 
boshqa formulalami o'z ichiga oluvchi ilmiy 
hisoblashlami bezab joylashtirish uchun xizmat 
qiladi.
D) ekranda tasvirlami “jonlantirish”. kompyuterda 
dinamik tasvirlar sintezidir.

10. Ilmiy grafik a ga xos javobni toping?
A) kartografiya masalalari, kimyoviy, matematik 
va boshqa formulalami o'z ichiga oluvchi ilmiy 
hisoblashlami bezab joylashtirish uchun xizmat 
qiladi.
B) turli xil matnli hujjatlar uchun regulvar va 
noregulyar struktura ko'rinishdagi 
foydalanuvchining rasmlari (piksel grafikasi) 
tasvirini yaratish imkoniyatlarini beradi
C) aylanma diagrammalar, ustunli gistogrammalar, 
chiziqli grafiklar hamda boshqa tipdagi ikki va uch 
o'lchamli grafik ko'rinishda elektron jadvalli 
muharrirlarida, ma’lumotlar bazalarida va alohida 
lokal fayllarda saqlanayotgan axborotlami ekranga 
akslantiradi.
D) ekranda tasvirlami “jonlantirish”, kompyuterda 
dinamik tasvirlar sintezidir.

18-§. COREL DRAW grafik protsessori va uning imkoniyatlari

Tayanch tushunchalar: sarlavha satri, atributlar paneli, standart uskunalar paneli, 
ranglar palitrasi, menyu satri.

Corel DRAW dasturi paket dasturi hisoblanadi. Dastur vektorli grafika bilan 
ishlashga moijallangan bo'lib, uning X7 versiyasi o'zida zamonaviy imkoniyatlami 
birlashtirgan bo'lib 2014 yilda ishlab chiqarilgan (4.2-jadval).

4.2-jadval. Corel DRAW paketi versiyalari 
Ilo\<a 2002 2004 2006 2008 2010 2012 2014
Corel Draw 11 12 X3 X4 X5 X6 X7

Bu dastur sanoat dizayni da, reklama mahsulotlarini ishlab chiqishda, nashriyot 
tizimlarida va web-sahifalar uchun turli tasvirlar yaratishda ishlatiladi. Corel DRAW 
dasturi paket dastur hisoblanib o 'z ichiga bir nechta qism dasturlami oladi. Bu 
dasturlar o'zaro ma lumot almashishning yengil kechishini ta’minlaydi. Ular 
quyidagi dasturlar: Corel CAPTURE, Corel BARCODE WIZARD, CorelDRAW, 
Corel Photo-PAINT. Corel CAPTURE dasturi CorelDRAW dasturi oynasi va uning 
qismlarini rasmga olish uchun ishlatiladi. Uning yordamida dastur oynasi ayni 
ko'rinishini to'liq yoki menyu ko'rinishini yoki biror qismni to'rtburchak shaklda, 
avlana yoki ellips shaklida va ixtiyoriv shaklda aylantirib belgilab rasmga olishi 
mumkin. Corel BARCODE WIZARD dasturi esa shtrix-kod bilan ishlashga 
mo'ljallangan. Unda berilgan standartlardan birini tanlab, so'ng keltirilgan namuna
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bo‘yicha raqam va harflami kiritamiz. Corel Photo-PAINT dasturi esa rasmlar 
chizishga moijallangan.

Ehtiyoj doim taklifni keltirib chiqaradi, shuning uchun grafik tasvirlami 
avtomatlashtirishga moijallangan dasturiy ta’minotlar bozori juda turli xil va 
kengdir. Corel nomi bilan ataluvchi Kanadaning dasturiy ta'minoti bilan 
shug'ullanuvchi firmasi so'zsiz shu peshqadamlardan biri hisoblanadi. CorelDRAW 
reklama mahsulotlarini ishlab chiqarishda, nashrlami tayyorlashda, hamda Web- 
sahifalari uchun tasvirlami yaratishda katta imkoniyatga ega. Shunga qaramasdan 
vektorli grafika bilan ishlaydigan dunyo bo‘yicha peshqadam dasturlar mavjud. 
Shulardan biri - Adobe Illustrator grafik dasturi. Lekin CorelDRAW, Adobe 
Illustrator dasturidan qolishmavdi, u ko'p parametrlar bo'yicha undan ustun ham 
keladi.

Corel DRAW - bu grafikLi dastur boiib. uning yordamida vektorli tasvirlami, 
grafikli matnlami, hamda sizning tasav vuringizdagi barcha ijodiv g‘oyalaringizni 
amalga oshirishga yordam beradi.

Corel DRAW dasturi ishlaydigan barcha tasvirlar ikki sinfga boiinadi: nuqtali 
va vektorli. Vektorli grafikada tasviming asosiy elementi sifatida chiziq qaraladi. 
Chiziq sifatida to g'ri chiziq boiishi mumkin. Rastrli grafikada bunday chiziqlar 
nuqtalar (piksellar) yordamida yaratilsa, vektorli grafikada esa tasvirlar yaratishda 
nuqtaga nisbatan umumiyroq boigan chiziqlardan foydalaniladi va shuning hisobiga 
tasvirlar aniqroq boiadi.

Vektorli grafikaning ixtiyoriy tasviri chiziqlardan tashkil topadi va oddiy 
chiziqlardan murakkablari hosil qilinadi. Vektorli grafikaning matematik asosini 
geometrik figuralaming xossasini o'rganish hosil qiladi. Vektorli tasvirlami 
kompyuter xotirasida ifodalanishi nuqtali tasvirga qaraganda murakkabroq boiadi. 
Nuqtali tasviming kamchiligi - kompyuter xotirasida ulami saqlash katta joy talab 
etiladi. Nuqtali tasvirlar bilan yuqori aniqliqda ishlashda, ularga mos fayllaming 
oichami vuzlab megabavtlami tashkil etadi. Ko'pincha, bunday katta ob’yektlar 
bilan ishlaganda hattoki zamonaviy kompyuterlaming tezligi yetmay qoladi. Vektorli 
tasvir bilan ishlash mutlaqo oson. Uni katta yoki kichik qilish uchun, faqat uni 
boshqaradigan tasvir parametrini o'zgartirish mumkin. Bunda vektorli tasvir faylining 
oichami bir baytgaham oshmaydi.

Corel DRAW dasturini ishga tushirish. Corel DRAW X7 grafik muharririni 
ishga tushirish uchun Пуск tugmasiga kirib, Программы buyrugi boiimi tanlanadi, 
so‘ng ro yxatdan Corel DRAW X7 buyrugi beriladi yoki Windows ish stolida uning 
yorligi ustida sichqoncha chap tugmasi ikki marta bosiladi. Dastur yuklangandan 
so‘ng ekranda CorelDRAW X7 dasturining bosh oynasi paydo boiadi.

Corel DRAW muharrir oynasining tuzilishi
□ Sarlavha satri. Bu yerda: Corel DRAW X7 - dasturning nomi.
[ Рисунок 1] - hujjatning formal (vaqtincha) nomi. Ish yakunida formal nomga 

real (haqiqiy) nom beriladi
J Menyu satri.
Window's standartlariga mos boigan menyu satri. CorelDRAWda menyu satri 

murakkab boiib, qism menyu va ularga mos buyruqlardan iborat. Boshqa
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dasturlardagi kabi bu menyu ham CorelDrawning kcfpchilik funktsiyalariga kirishni 
ta'minlaydi, lekin ko‘pchilik harakatlar u siz ham bajarilishi mumkin. Menyuni 
sozlashning chegaralanmagan imkoniyatlari foydalanuvchini chalkashtirib yuboradi. 
CorelDRAW dasturining har qanday buyruq va uskunalarim boshqa menyuga 
kochirish mumkin. Shuning uchun keyingi paragraflarda birinchi navbatda menyusiz 
ishlash yo llarini zarur boiganda uning buyruqlariga murojaat qilishni o'rganamiz.

Bu satr 11 ta menyudan iborat. Har bir menyu o ziga xos buyruqlar 
toplamidan tashkil topgan. Corel DRAW menyusi murakkab tuzilgan bo iib, har bir 
menyuda bir necha ichki menvular bo‘lishi mumkin.

Standart uskunalar paneli. Menyu satrining ostida standart uskunalar paneli 
joylashgan. Bu satrda eng kop  bajariladigan buvruqlarga mos boshqarish elementlari 
joylashgan. Masalan, Открыть (ochish), Закрыть (yopish), Сохранить (saqlash) 
buyruqlari, tizimli almashish buferining operatsiyalari, rasmlami ko‘rish holati 
uskunalari joylashgan.

Создание документа

Ии»: 5 5 5 Е 5 Я З Е

Назначен» заготовки; Параметр по умолчанию Сот,.. чш
°азпер: Letter

ЦЬрина: 8.5 * — - дюймы 7 )

Высота:

001СТ -Когмчествс сгра-*ч:СЮ 1ТТ»

п . 0 '  - г  0  а

1 ~~-

Режин основного цвета: 

Разрешение отображения:

СМУК

»  то...

прооютра: Расширенный

? Параметры цвета 

it Описание
Щелкните, «тобы добавить -встраиваемое назначение.

*

Бо/ьше не покаэьеатъ это окно

[7 ОК Отнема | Cnpaeta *]

4.7-rasm. Создать новый документ muloqot oynasi

Atributlar paneli. Standart uskunalar panelining ostida atributlar paneli 
joylashgan. U belgilangan ob’yektning parametrlarini o'zgartiradigan boshqarish 
elementlari to‘plamidan iborat. Atributlar paneli ichidagi elementlar belgilangan 
ob’yektning shakliga qarab o'zgarib turadi. Bu panel foydalanuvchining asosiy ish 
paneli deb ataladi.

Ranglar palitrasi. Oynaning o‘ng chegarasi bo'ylab Палитра цветов (ranglar 
palitrasi) paneli joylashgan. U rangni to'ldirish va rasmli ob’yektlaming atrofmi 
himoyalash, aylantirib bo‘yash uchun qo‘llaniladi.
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Uskunalar paneli. Ish maydonining chap qismida uskunalar to'plami 
(toolbox) oynasi joylashgan. Undagi kerakli uskunani tanlash uchun uning ustida 
sichqoncha tugmasi bosiladi. Kerakli uskunani tanlash bilan foydalanuvchining tasvir 
ustida barcha harakatlari boshlanadi.

Har doim CorelDRAW dasturi yuklangandan so'ng yangi hujjat ochiladi. Agar 
ish jarayonida yana bitta yangi hujjat yaratish kerak bo'lsa u holda. File (Файл) 
inenyusidan New (Новый документ) buyrug'ini bering yoki standart uskunalar 
panelining chap qismida joylashgan New (Новый документ) tugmasini sichqoncha 
chap tugmasi yordamida bosing. Hujjatga nom berish, bet o'lchamini berish, CMYK 
voki RGB singari rangli rejimni tanlash va rangli profillami sozlash mumkin4.

Agar uskunalar panelidagi tugmalami vazifalarini yaxshi bilmasangiz yoki 
unutib qo'vgan boisangiz u holda shu tugma ustida sichqon ko rsatkichini biroz 
ushlab tursangiz, uning ustida nomi aks etgan eslatma paydo bo'ladi.

Ochiladigan
strelka

Uskunalar to'plami

4

&
4

Ц.

%  Ф и г у р * Р1 0

O ' Р « з м * } ы е в ю с ц а я  к и с т »

ъ ?  Г  р у б л я  КИСТЬ

P u  С с о б с д и о с  п р е о 6 р * з о в * н и «

М д с т и х и м

4  В е р о к * *

, >  .П р и т я г и в а т ь

j v S  О т т в л к и м т ь  ^ к

Quyidagi bo'lim
uskunalaming asosiy 
kategoriyalari bo'yicha 
yig'ma ma lumotlardan 
tarkib topgan.

4.8-rasm. Yoyiladigan menyw 
Ishchi fazoda sichqoncha yordamida Фигура uskunasidagi ochiladigan 

strelkani bosish orqali menyu ochiladi. U o'zaro bog'langan uskunalardan tarkib 
topadi (4.3-jadval).
___________________________________________________ 4.3-jadval. Q ‘zaro boR’langan uskunalar
Ko‘rsatkich

Указатель va Сводный выбор uskunalari 
ob’yektlami tanlash. o'lchamini o'zgartirish, 
egiltirish va burish imkonini beradi.

Shakllar

4 Joseph Diaz. CorelDRAW® Graphics Suite X6. Rukovodstvo. Corel. 36-p.
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Figuralar uskunalari to‘g‘ri to‘rtburchak, 
ellipslar. yulduzchalar, ko‘pburchaklar va 
spirallar va boshqa turli xil figuralami 
chizish imkonini beradi. Bu kategoriyaning 
qo‘shimcha uskunalari yordamida (bu yerda 
ko'rsatilmagan) jilmayib turgan yuz, 
strelkalar. bannerlar va sxemalar kabi 
figuralami chizish mumkin.

Shakllami o‘zgartirish uskunalari

f* \ M

C? 111

* >1

5© N

O'zgartinsh uskunalari mavjud 
ob’yekt shakllarini o‘zgartirish 
imkonini beradi.

Qiyshiq chizish uskunalari

0
Qiyshiq chizish uskunalari to'g‘ri chiziqlar 
va qingir-qiyshiq chiziqlar chizish imkonini 
beradi. Erkin shakldagi chiziqlar, tcTg'ri 
chiziqlar va Безье egri chiziqlari singari 
chiziqlami chizish imkonini beradi. 
Художественное оформление uskunasi 
yordamida shuningdek tasvimi sepish, 
kalligrafik chiziqlami chizish va shutka 
rangini olib kelish5.

s Joseph Diaz. CorelDRAW® Graphics Suite X6. Руководство. Corel. 33-p.
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Rang quyish uskunalari

Ф

Rang quyish uskunalari ob’yektlarga rang 
quyishning turli xillarini taqdim qiladt. Bir 
turli, fontanli va to'rli rang quyishlami * » 
amalga oshirish imkonini beradi.

Interfaol uskunalar

%

o

Interfaol uskunalar ob'yektlarga maxsus 
effaktlami biriktirish imkonini beradi. 
Bunday effektlarga 
ko‘ehib o‘tish, konturlar. soyalar, 
cho'zish yoki siqish va shafToflik kiradi6.

Щ

Qirqish va o'chirish uskunalari

Qirqish va o'chirish uskunalan hujjatning bir 
qismini o'chirish imkonini beradi.

171

# 1

%

O'lcham uskunalari

‘ Joseph Diaz. CorelDRAW® Graphics Suite X6. Руководство. Corel. 34-p.
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CVlcham uskunalari egilgan. hujjatda to‘g‘ri 
va (ob’yektlar qismini o4chash uchun) 
burchakli o‘lchamli chiziqlami chizish 
imkonini beradi.

Birlashtiruvchi chiziqlar
Щ■ Birlashtiruvchi uskunalar diagrammalar va 

sxemalardagi ob yektlami birlashtiruvchi 
chiziqlami chizish imkonini beradi.

—.......

■ в в о
ik Is4

Matn

----  Текст uskunasi so'zlami figurali yoki
bevosita ekranda oddiy matnga kiritish 
imkonini beradi.

Jadval

Таблица uskunasi jadvallami chizish va 
o'zgartirish imkonini beradi. Bu uskuna 
tanlangandan kevin atributlar paneli unga 
tegishli atributlarga o‘zgaradi.
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Masshtab

Масштаб uskunasi hujjat oynasida 
kattalashtirib ko'rsatish darajasini 
o'zgartirish imkonini beradi.

Hujjatni ochish va yopish. CorelDRAW dasturida avvaldan tayyorlab 
qo'yilgan hujjatlar Windows operatsion tizimining boshqa amaliy dasturlari singari 
quyidagi yo ilar bilan ochiladi: Corel DRAW dasturida yaratilgan faylni bosib ochish 
orqali yuklash; File (Файл) menyusidagi Open (Открыть) buyrugini berish orqali 
voki standart uskunalar panelidagi Open (Открыть) tugmasini bosish orqali. Oxirgi 
ikki holatda ekranda Open Drawing (Открыть доку мент) muloqot oynasi pay do 
boiadi. Bu muloqot oynasida Windows operatsion tizimining barcha amaliy 
dasturlaridagi hujjatlami ochish oynasining standart elementlari mavjud. Undan 
tashqari, fayllar ro yxatining o ng tomonida (Preview (Предварительный просмотр) 
belgisi faollashganda) tanlangan favlda saqlanayotgan tasvimi ko'rish mumkin. Bu 
esa biz ochmoqchi boigan faylni aynan shu tasvir ekanligini bilib olish uchun imkon 
beradi. CorelDRAW hujjatlarini saqlashda berilgan kalit so‘zlar yoki eslatmalar 
Keywords (Ключевые слова) va Notes (Замечания) maydonida paydo boiadi.

Hujjatlami yopish uchun esa File > Close buyrug‘ini berish yoki ekranning 
yuqori o‘ng burchagida joylashgan Close tugmasini bosish kerak. Shundan so'ng agar 
hujjat yaratilgandan keyin unda biror o zgansh boigan boisa u holda hujjatni 
saqlash yoki saqlamaslik haqida oyna chiqadi. Agar bu oynada Да tugmasi bosilsa, 
Save muloqot oynasi (hujjatni saqlash oy nasi) paydo boiadi. Aks holda, Нет bosilsa, 
u holda hujjatdagi barcha o‘zgarishlar saqlanmasdan o‘chib ketadi. Bu ogohlantirish 
oynasida ikki tugma bilan birga uchinchi tugma Cancel ham mavjud. Ayrim hollarda 
hujjatni bekitishga buyruq berilgandan so*ng muloqot oynasi avtomatik holda 
chiqqandan key in, foydalanuvchining fikri o'zgarib vuqoridagi ikki holatdan birini 
emas, balki uchinchi holatga qaytib, ya ni hujjatga qavtib ishni davom ettirishi 
mumkin. Buning uchun Cancel tugmasini bosish kerak.

MASHQ. Corel Draw dasturida matnli ob’yektlar 
Ishning maqsadi: Corel Draw dasturida matnli ob vektlar bilan ishlashga organish

1. Sarlavha matnini qo shish uchun Type (Текст) uskunasini tanlang va chizma 
oynasining ixtiyoriy joviga bosing va sarlavha matnini kiriting. Matnni tugatish 
uchun boshqa uskunani tanlang7.

2. Abzatsli matnni kiritish uchun Type (Текст) uskunasini tanlang, kiritish 
ramkasi oichamini belgilang (kiriting) va matnni kirting.

Л.Б.Левковец. Векторная графика. CorelDRAW Хб -  СПб: НИУ ИТМО, 2013. -  199 с.
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3. Mavjud berk (yopiq) ob'vekt ichiga matnni joylashtirish uchun ob’yekt 
konturiga kursomi olib boring va qachonki kursor qo'yish kursoriga aylansa. 
sichqoncha chap tugmasini bosing. Ob’yekt ichiga matn kiriting.

4. Matn va ob’yektni ajratish uchun Pick (Указатель) uskunasini tanlang, 
ob’yektni belgilang va Arrange (Упорядочивание) menyusidan Break Paragraph 
Text inside a Path Apart (Разъединить абзацный текст внутри контура) 
buyrug'ini bering.

5. Abzatsli matn ramkasim matn o'lchami bo'yicha avtomatik tarzda sozlash 
uchun Tools > Options (Настройки>Параметры) muloqot oynasida abzatsli matn 
parametrlarini o'zgartirish uchun Expand and shrink paragraph text frames to fit 
text (Расширять и сокращать рамку для абзаца для подгонки текста) 
bayroqchasini o'mating.

ESLATMA.
• Matnning qizil matn ramkasi abzatsli matnni matn ramkasining o'ng pastki 
chegarasidan chiqayotganligini ko'rsatadi. Bu holat agar Expand and shrink 
paragraph text frames to fit text (Расширять и сокращать рамку абзаца для 
подгонки текста) bavroqchasi o'matilmagan holatlarda ro'y beradi.
• Abzatsli matn ramkasi o'lchamini sozlash uchun Pick (Указатель) uskunasini 
qo'llash mumkin. Matn ramkasini bosing va ixtiyoriy tanlash markerini surib keling.
• Text (Tekst) > Paragraph text Frame > Show Text frame (Текст > Рамка абзацного 
текста > Показать рамку текста) buyrug'i yordamida matn ramkasini o'chirish 
mumkin8.

— ш m
■3 .TP ДаГАГЦЭДрННЫЙ „ т д к с т -

А это абзацный текст. Для его 
Создания предварительно 
роздана прямоугольная рамка 
набора.

/ /  этот текст 
{['вставлен в замкнутый 
Ч  .объект

&

4.9-rasm. Matnning turli tiplariga misollar

8Л Б Левковец, Векторная графикд CorelDRAW Хб -  СПб: НИУ ИТМО, 2 0 1 3 .-2 0 0  с.
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MASHQ. Matnni import qilish va qo‘yish parametrlarini sozlash 
Ishning maqsadi: Matnni import qilish va qo'yish parametrlarini sozlashga 
o'rganish

CorelDRAW dasturi hujjatiga boshqa dasturdagi matnni import qilish mumkin. 
Buning uchun ikki variant mavjud:

1. Tashqi dasturdan matnni almashinuv buferiga oling. CorelDRAW dasturida 
Edit > Paste buy rug'ini bering.

Special (Правка > Специальная Вставка). Специальная Вставка (4.10-rasm) 
muloqot oynasida talab qilingan parametmi o'mating va OK tugmasini bosing.

I  U*lСпециальная вставка
Исто**ж DALLB\H»a»*«\Book СОХЕЧТвма 3.doc 

Вставить сея.»

• Вставить

ОК п
Отмена

Рие«*м«*. (метафайл)
Rich Те* Forma*
Т сЛ T  g еиае значка
Ptcturef Enhanced MeiVde j

Регулы ат
Встаем е документ содержимого буфера с 
веэможиостыо «тимцни объекте при 

У М 1* !  гомеши McrawftWoid

4.10-rasm. Специальная Вставки muloqot oynasi
2. File (Файл) menyusidan Import (Импорт) buyrug'ini bering. Shu nomdagi 

muloqot oynasidan CorelDRAW dasturiga import qilish uchun matnli faylni 
belgilang9.

I  S  
5  1  |

I I I

.c .

T O

*  в г
I I

Ш £  I ,  t  ®
Lsl

ТБ

s.I s ;

Ы

4.11-rasm. Importing > Pasting Text muloqot oynasi 
Importing > Pasting Text (Import > Вставка текста) (4.11-rasm) muloqot 

oynasidan quyidagi parametrlar dan birini tanlang:
• Maintain Fonts and Formatting (Сохранять шрифты и форматирование);
• Maintain Formatting Only (Сохранять только форматирование);

9Л.Б.Ле*го»ец. Векторная графика. CorelDRAW X6 -  СПб: НИУ ИТМО, 2013. — 201 с.
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• Discard Fonts and Formatting (Сбросить шрифты и форматирование).
Agar import qilinadigan qora matn uchun CMYK rang modelidagi qora rangi 

biriktirish talab qilinsa, Force CMYK Black (Черный CMYK) bayroqchasini 
©‘mating. Matn formatlari saqlanadigan parametr tanlangan bo‘lsagina bu 
bayroqchaga bogianish mumkin boiadi. Agar Cancel (Отмена) tugmasi bosilsa, 
import qilish yoki qo‘yish amallari bekor qilinadi10.

ESLATMA. Agar shriftlami saqlash talab qilinsayu, biroq kompyuterda 
kerakli shriftlar o‘matilmagan boisa, shriftlarni taqqoslash PANOSE tizimi boshqa 
shriftga almashtirishni taklif qiladi.

Undan tashqari. importlanadigan matn uchun ko‘chirish parametrlarini ham 
berish mumkin. Agar matnni har bir import qilish yoki qo‘yishda formatlashning bir 
xil parametrlarini qoilash talab qilinsa, u holda Don’t show this warning again 
(Больше не показывать это предупреждение) bayroqchasini o‘mating. 
Ogohlantirishni yana faollashtirish uchun Tools>Options (Настройки>Параметры) 
muloqot oynasidan Workspace (Рабочее пространство) toifalar ro‘vxatidan 
Warnings (Предупреждения) tanlang va Pasting and Importing Text (импорт и 
Вставка текста) bayroqchasini о‘mating. Sarlavhali matnni, aiohida simvollami va 
abzatsli matnlami belgilashga misollar 4 .12-rasmda keltirilgan.

■ ■ ■
B.T«s^ywg,yi щ ад а  £ ломдщыо.
■ ■ ■

Для выбора определенных символов необходимо 
п е р е т а щ и т ь  к у р с о р  и н с т р у м е н т а

Для изменения текста его сначала
Необходимо выбрать. Можно выбирать j
«текстовые обьекты целиком или только ;

■определенные символы. Текстовый ;■
Ьбьект целиком выбирается с помощью ; 
инструмента

■........................................а ......................................*■

4.12-rasm. Sarlavhali matnni (yuqorida), aiohida simvollami (o‘rtada) va abzatsli matnlami (pastda)
belgilashga misollar

MASHQ. Abzatsli matnni formatlash 
Ishning maqsadi: Talabalarga abzatsli matnni formatlashni o'rgatish CorelDRAW 
dasturi abzatsli matnni formatlashning turli xil parametrlarini taqdim qiladi. Masalan, 
matnni abzatsli matn ramkasiga joylashtirish mumkin. Ramkaga matnni 
joylashtirishda va bunda matn ramkaga to iiq  joylashishi uchun punktlardagi matn 
oichami kattalashadi yoki kichiklashadi. Undan tashqari, matnning katta tarkibli 
loyihalarini komponovka qilish uchun ustunlami qoilash mumkin. Bularga misol

10Л.Б.Левко»ец, Векторная графика. CorelDRAW Хб -  СПб: НИУ ИТМО, 2013. -  202 с.
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qilib byulletenlar, jumallar va gazetalami aytish mumkin. Bir xil yoki har xil enga 
ega bo'lgan, bir xil yoki har xil shu’lalarga ega bo'lgan ustunlami yaratish mumkin.

Matnni abzatsli matn ramkasiga joylashtirish (freymga).
1. Abzatsli matn ramkasini tanlang.
2 Text>Paragraph Text Frame>Fit text To Frame (Текст>Абзацный текст>Текст в 
рамку)ni tanlang.

Abzatsli matn ramkasiga ustun qo'shish
1. Abzatsli matn ramkasini tanlang.
2. Text>Columns (Текст>Столбцы)ш tanlang.

Matn ustunlarda qandav dcs ettirilishini ko'rish talab qilinsa. Column Settings 
(Настройки колонки) muloqot oynasida Preview (Просмотр) tugmasini bosing.
3. Number o f Columns (Число столбцов) maydoniga qiymat kiriting.
Ustunlar va yorug'lik shulalari o'lchamini o'zgartirish mumkin. Text (Текст) 
uskunasini tanlash va ehizish oynasiga tanlashning yon markerlarini surib kelish 
kerak.

Bukvitsalar qo'shish11.
1. Abzatsli matnni belgilang.
2. Text >Bullets (Текст>Буквица)ш tanlang
3. Agar matndagi bukvitsani qanday aks etishini ko'rmoqchi bo'lsangiz, Bullets> 
Буквица muloqot oynasidan Preview (Просмотр) tugmasini bosing.
4. Use bullets (Исползоват буквиц} ) bayroqchasini o'mating.

Qo'shimcha ravishda quy idagi sozlamalami bajarish mumkin:
• Bukvitsani (chapda) yoki teskari xat boshi bukvitsasini (o'ngda) qo'shish.
• Bukvitsa yaqinida qatorlar sonini ko'rsatish.
• Bukvitsa va asosiy matn o'rtasidagi masofani ko'rsatish.
• Bukvitsadan keyin intervalni sozlash.

Matnni ko'chirish. Abzatsli matnni verstka qilishda agar oxirgi so'z 
butunligicha qatorga sig'masa uni bo'lish uchun ko'chirish imkoniyatlarini qo'llash 
mumkin. Avtomatik ko'chirishni foydalanuvchi tomonidan oldindan berilgan 
parametrlar asosidagi ko'chirish yordamida o'matish mumkin. Ko'chirishdan oldingi 
va keyingi simvollami minimal sonini o'matish mumkin. Undan tashqari, ko'chirish 
hududi uchun mumkin bo'lgan simvollar sonini ko'rsatish mumkin. Ya ni qator 
oxirida qancha simvoldan keyin ko'chirishni amalga oshirish kerakligini belgilab 
qo'yish mumkin. Qator oxirida so'zni bo'lishni amalga oshirishda so'zga qo'shimcha 
ko'chirish qo'yish mumkin. Shuningdek foydalanuvchi tomonidan so'zni kiritish, 
qo'yish va gapga import qilish vaqtida uni bo'lib ko'chirishning qo'shimcha 
imkoniyatlarini yaratish mumkin.

Oddiy matnda avtomatik ko'chirishlar.
1. Abzats matni ramkasini yoki abzatsni tanlang.
2. Text>Use Hyphenation (Текст > Использоват nepeHoc)ni tanlang.

Ko'chirish funktsivasi har qanday til uchun qo'llanilishi mumkin. Qaysiki 
buning uchun ilovada to'g'ri yozilganlikni tekshirish uchun vositao'matilgan bo'lishi 
kerak.
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Agar Text>Use Hyphenation (Текст>Использовать перенос) buvrug'ini 
bajargandan so'ng abzatsda so'z ko'chirish amalga oshmasa, u holda ko'chirish 
sozlamasim o'zgartirish mumkin.

Ko‘chirish parametrlarini o'zgartirish.
1. Abzatsni yoki abzatsli matn ramkasini tanlang.
2. Text> Hyphenation Settings (Текст>Параметры переноса) tanlang
3. Shu nomdagi muloqot oynasidan Automatically hyphenate Paragraph Text 
(Автоматические переносы в абзацном тексте) bavroqchasini o'mating.
4. Yuqorida keltirilgan ko‘chirishning boshqa sozlamalarini bayroqchalami o'matish 
yo ii bilan yoki qiymatlar sonini kiritish yo‘li bilan bajaring.

Qo‘shimcha ko‘chirish. Qo'shimcha ko'chirish qo'yish uchun <Ctrl> + <-> 
klavishalarini bosish kerak.

Birlashtirish va abzatsli matn ramkasini bog‘Iash. Abzatsli matn 
ramkalarini birlashtirish mumkin. Undan tashqari, abzatsli matn ramkasini yanada 
mayda komponentlar: ustunlar, abzatslar, markerlar, qatorlar, so'z va simvollarga 
bo'lish mumkin. Matn ramkalari har bir bo‘linishida komponent ostilari alohida 
abzatsli matn ramkalariga joylashadi. Ramkalami abzatsli matn bilan bogiashni 
matnni kochib otishi bilan boshqariladi. Agar matn birinchi ramka chegarasidan 
chiqib ketsa, bunda bitta matn ramkasidan boshqasiga ko'chib o'tish amalga oshadi. 
Bog'langan abzatsli matn ramkalar kichiklashtirilganda yoki kattalashtirilganda yoki 
matn o'lchami o'zgartirilganda navbatdagi ramka matni o'lchamlari avtomatik tarzda 
sozlanadi. Abzatsli matn ramkalarini matn kiritilmasdan oldin va keyin bog'lash 
mumkin. Sarlavhali matnni bogiash mumkin emas. Biroq, abzatsli matn ramkasi 
bilan ochiq yoki berk ob’yektlar bogiashni o'matish mumkin. Abzatsli matn 
ramkasini ochiq ob’yekt bilan, masalan chiziq bilan bog'lashda matn chiziqning 
konturi yaqinidan jovlashada. Matn ramkasini berk ob’yekt bilan bog'lashda, masalan 
to'rtburchak bilan bog'lashda, abzatsli matn ramkasini qo'yish va matnni ob’yektga 
ko'chib o'tirishini boshqarish amalga oshadi. Agar matn ochiq yoki berk kontur 
doirasidan tashqariga chiqadigan boisa, matnni boshqa matn ramkasi yoki boshqa 
ob’yekt bilan bog'lash mumkin. Undan tashqari, abzatsli matn ramkalarini boshqa 
sahifada joylashgan ob’yektlar bilan bog'lash mumkin. Abzatsli matn ramkasiga 
bog'lanish o'matib, ko'chirilishni bir ob'yekt yoki matn ramkasidan boshqasiga 
qayta yo'naltirish mumkin. Bu strelkalami bekitish mumkin yoki aks ettirish 
mumkin12.

Matnni bir joydan ikkinchi joyga otishini ramkalar va ob’yektlar o'rtasida 
matnni bog'lash yo'li bilan amalga oshirish mumkin. Bir nechta abzatsli matn 
ramkalari o'rtasidagi bog'liqlikni olib tashlash mumkin. Shuningdek, abzatsli matn 
ramkalari bilan ob’yektlar o'rtasidagi bog'liqlikni ham olib tashlash mumkin. Agar 
faqat ikkita abzatsli matn ramkasi mavjud bo'lganda, ular o'rtasidagi bog'liqlik olib 
tashlansa, matnni qolgan abzatsli matn ramkasiga quyilishi amalga oshiriladi. Qator 
bogiiqliklarga ega boigan abzatsli matn ramkalari o'rtasidagi aloqa o'chirilganda, 
matn navbatdagi abzatsli matn ramkasiga voki ob’yektga qayta yonaltiriladi. Aslida 
o'matilgan abzatsni formatlash, masalan ustunlami, bukvitsalami va markerlami

1 “Л.Б.Левковсц, Векторная графика. CorelDRAW Хб -  СПб: НИУ ИТМО, 2013. -  221 с.
28



formatlash, faqat tanlangan abzatsli matn ramkalariga joriy qilinadi. Undan tashqari, 
barcha aloqador ramkalar yoki barcha tanlangan va ketma-ket bogMangan ramkalarga 
formatlash joriv qilinishi uchun sozlamalami ham o'zgartirish mumkin.

Abzatsli matn ramkasini birlashtirish yoki bo'lish.
1 Matn ramkasini oling. Agar matn ramkalarim birlashtirish talab qilinsa <Shift> 
klavishasini bosib ushlab turgan holda, Pick (Указатель) uskunasi yordamida matn 
ramkalari ketma-ketligini tanlang.
2 Arrange >(Упорядочит) tanlang va quyidagi parametrlardan birini bosing:
• Combine (Объединит) - birlashtirish;
• Break Paragraph Text (Разъединит) -  bo'lish (ajratish).
Quyidagi afzalliklami ko'zda tutish kerak:
• Matn ramkasini obolochkalar. kontur yaqinida joylashgan matn va bogMangan 
ramkalar bilan birlashtirib boMmaydi.
• matnni birlashgan ramkalarida agar birinchi matn ramkasi ustunlari bilan tanlangan 
boMsa, bunda ham ustunlar qo‘llaniladi.

Abzatsli matn ramkasi va ob’yektlar o‘rtasida bog'lanish13.
1 Text (Текст) uskunasi yordamida birinchi ramkani tanlang.
2. Ob’yekt yoki matn ramkasining pastki qismida matnni ko‘chib o'tish vorlig'ini 
(треуголник) bosing. Agar ramkaga butun matn sigmasa yorliqda strelka paydo 
boMadi, ramkaning o‘zi esa qizil rangga oMadi.
3. Qachonki ko‘rsatkich bogMash (aloqa) ko'rsatkichiga o‘zgarsa, bunda matnni 
davom ettirish talab qilingan ramka yoki ob’yektni bosing. Agar ramka yoki ob yekt 
boshqa sahifada joylashgan boMsa, hujjat navigatoridan mos sahifaning vkladkasiga 
o'ting.
• Agar matn ramkasi bogMangan boMsa, matn ko‘chirish yorligM o‘zgaradi. 
ko‘rsatkich esa matn ko'chib o‘tish yo‘nalishini ko‘rsatadi. Agar bogMangan matn 
boshqa sahifada boMsa, sahifa nomeri va punktirli ko‘k chiziq aks ettiriladi.
• Abzatsli matn ramkasini bogMash muvofaqiyatli amalga oshishi uchun, matn 
ramkasi oichami avtomatik tarza sozlanishi kerak emas.

Matnni ko‘chib o'tish yo'nalishini boshqa matn ramkasiga yoki ob’yektga 
o'zgartirish.
1. Pick (Указатель) uskunasini tanlagan holda, ob’yekt yoki matn ramkasining pastki 
qismida matnni ko'chirish yorlig‘ini tanlang. U bog‘lanishdan tarkib topib, 
o'zgartirish talab qilinadi.
2. Matnni davom ettirish talab etilgan yangi matn yoki ob’yekt ramkasini tanlang.

Matn ramkalari yoki ob’yektlar o'rtasidagi bog'lanishni yo'qotish.
1. Boshqa matn ramkasi bogMangan matn ramkasini bosing.
2. Arrange > Break Paragraph Text (Упорядочит > Разъединит)ш tanlang.
• Turli sahifalarda joylashgan bogMangan ramkalar aloqalarini olib tashlash mumkin.

Abzatsli matn uchun formatlash parametrlarini tanlash
1. Tools>Options (Инструменты >Параметры) buy rug'ini bering.
2. Kategoriyalar ro'vxati Workspace (Рабочее пространствовал Text (Текст)ш ikki 
marta bosing, key in Paragraph Text frame (Абзац)ш bosing.
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Agar matnni o iish indikatorlari bekitish yoki aks ettirish talab qilinsa, buning 
uchun Show linking of text frames (Показыват связи с рамкой текста) 
bayroqchasini olib tashlash yoki o‘matish kerak boiadi.
3. Quyidagi parametrlardan birini tanlang:
• All linked frames (Ко всем связанным рамкам) -  abzatsni formatlashni tanlangan 
ramka va u bilan bogiangan barcha ramkalar uchun joriy qilish.
• Selected frames only (К выбранным рамкам) -  faqat tanlangan ramkalar uchun 
abzatsni formatlashni joriy qilish.
• Selected and subsequent frames (К выделенным и следующим рамкам) -  har 
qanday ramka va tanlangan ramka uchun abzatsni formatlashni joriy qiling.

Ob’yektlar, sarlavha matni va ramka atrofida abzatsli matnni siiliqlash. 
Ob’yekt, sarlavha matni yoki abzatsli matn ramkasi atrofida oddiy matn bilan 

aylantirib o‘rab olish mumkin. Matnni aylantirib oiashni aylantirish stillarini kontur 
boyicha yoki maydon bo‘yicha amalga oshirish mumkin. Kontur bo'yicha 
aylantirish stillarini qoilashda matn qiyshiq ob'yektda joylashadi. Maydon bo‘vicha 
aylantirish stillarini qoilashda matn ob’yekt blokini chegaralaydigan chiziqda 
joylashadi. Undan tashqari, oddiy matn va ob’yekt yoki matn o'rtasida bo‘sh fazoni 
sozlash mumkin. Shuningdek avval qoilanilgan har qanday aylantirish stilini 
vo‘qotish mumkin.
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Обтекание абзацного текста вокруг! Object Properties

» Summary

Объектов, заголовочного текста  
рамок
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форм у 
примем 
обтек 
jiipoci 

■!гексг 
вокру 

обьекга, 
мною текста 
р а м к н
о текста. Можно выполнить обтекание; 
текста, используя стили обтекания но> 
контуру или по площа ди.  При  
Использовании стилей обтекания по;
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Ob’yektlar, sarlavha matni va ramka atrofida abzatsli matnni silliqlashni 
amalga oshirish.
1. Matn aylantirib o ralishi kerak boigan ob'yekt yoki matnni tanlang.
2. Window>Dockers>Object properties (Окно>Окна Настройки>Свойства) 
tanlang.
3. Object properties (Свойства объекта) sozlash oynasidan Summary (Общие) 
vkladkasiga oiing.
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4. Avlantirib o'rash stillari royxatidan (4.13-rasm) zarur stilni tanlang. Agar 
aylantirib o‘raladigan matn va ob’yekt bilan yoki matn bilan oralaridagi masofani 
o'zgartirish talab qilinsa u holda Text wrap offset (Сдвиг при обтекании) maydoni 
qiymatini o‘zgartiring.
5. Text (Текст) uskunasini tanlang va matn yoki ob’yekt atrofida abzatsli matn 
ramkasini yaratish uchun kursomi surib keling.
6. Abzatsli matn ramkasiga matn kiriting.

O byekt uchun aylantirib o'rash stilini qo‘llagan holda abzats matni ramkasini 
ob’yektga surib kelish kerak.

0 ‘rab olish stilini o‘chirish.
1. Ushbu matn yordamida aylantirib olinadigan matn yoki obyektni tanlang.
2. Window>Dockers>Object properties (Окно>Окна H астр ойки >C в ой ств a)n i 
tanlang.
3. Object properties (Свойства объекта) sozlashlar oynasida Summary (Общие) 
vkladkasiga o‘ting.
4. Aylantirib o'rab olish stillari robyxatidan (4.15-rasm) None (Без обтекания) 
variantini tanlang14.

Grafikani qurish va maxsus simvollar qo‘shish. Matn ichiga grafikli ob yekt 
yoki pikselli tasvir qo'yish mumkin. Buning natijasida grafikli ob yekt yoki pikselli 
tasvir matn simvoli sifatida qaraladi. Shuning uchun ham matnning tipiga bog‘liq 
ravishda, grafikli ob yekt ichki qurilgan matn uchun turli xil formatlashlami joriy 
qilish mumkin. Undan tashqari. matndan ichki joylangan ob’yektni o‘chirib tashlash 
mumkin. Shundan keyin ob yekt holati awalgidek bo'ladi. Matn ob yektlari sifatida, 
grafikli ob’yektlar sifatida matnga maxsus simvollami qo'shish mumkin. Agar 
maxsus simvollar matn sifatida qo'shilsa simvollami matn singari formatlash 
mumkin. Agar maxsus simvollar grafik ob’yekt siftida qo‘shilsa simvollar qiyshiq 
singari qaraladi. Shuning uchun ham ulami boshqa grafikli ob’yektlar singari 
tahrirlash mumkin.

Grafikli ob’yektni matn ichiga joylash.
1. Grafikli ob’yektni tanlang.
2. Edit (Правка) tanlang va quyidagi buyruqlardan birini tanlang:
• Cut (Вырезат) -  qirqib olish;
• Copy (Копировать) -  nusxa olish.
3. Text (Текст) uskunasi yordamida grafikli ob’yekt qayerga qo‘yilishi kerak bo'lsa 
o'shayerga bosing.
4. Edit>Paste (Правка>Вставить)ш tanlang.

Matnda ichki qo‘yilgan ob’yektni yo‘qotish.
1. Text (Tekst) uskunasi yordamida ichki qurilgan ob yektni tanlang.
2. Edit> Cut (Правка>Вырезать)ш tanlang.
3. Pick (Указатель) uskunasini tanlang va matn ob’yekti atrofini bosing.
4. Edit>Paste (Правка>Вставить)ш tanlang.

Matn ob’yekti sifatida maxsus simvollami qo‘shish.
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1. Text (Текст) uskunasi yordamida maxsus simvol qo‘shiladigan joyga sichqonchani 
bosing.
2. Text>Insert Symbol Character (Текст>Вставит знак символами tanlang.
3. Insert Symbol (Вставка символа) sozlashlar oynasidagi Font (Шрифт) 
ro’yxatidan shriftni tanlang.
4. Ro'yxatdagi simvolni ikki marta bosing. Simvol oichami matndagi shrift oichami 
bilan belgilanadi.
• Вставка символа sozlamasi maydonida tezkor chaqiruv klavishalari aks etadi. 
Qaysiki ulami maxsus simvollami qo‘shish uchun qoilash mumkin.

Maxsus simvolni grafik ob’yekt sifatida qo'shish:
1. Текст Вставить знак символа tanlanadi.
2. Вставка символа sozlamalar oynasidagi Шрифт ro'yxatidan shriftni tanlang.
3. Размер символа maydoniga qiymatni kiriting.
4. Maxsus simvollami ro‘vxatdan chizish sahifasiga olib keling15.
• bu holatda maxsus simvol grafikli stilda qo‘yiladi. Grafikli stillar haqida 
ko'rsatmalar olish uchun «Работа со стилями графики, текста и цветовыми 
стилями» boiimini qarang.

MASHQ. Corel Draw dasturida matnli ob’yektlar yaratish 
Ishning maqsadi: Corel Draw dasturida matnli ob’yektlar yaratish va ulaming 
xususiyatlarini o'zgartirishni o'rgatish.
Topshiriqni bajarish bo‘yicha metodik ko‘rsatma Har qanday tilda matnni to'g'ri 
aks ettirish. Abzatsli matnni kiriting.
1. Text>Encoding (Текст>Кодироват)ш tanlang.
2. Text Encoding (Кодировка текста) muloqot oynasidan Other encoding (Другая 
кодировка) variantini tanlang.
3. Other encoding (Другая кодировка) ro'yxatida kodirovka variantini tanlang. 
Bunda shunday variantni tanlash kerakki uni qoilash natijasida matnni o'qish 
mumkin bo'lsin. Oldindan ko'rishning Preview oynasida matn kodirovkaning 
tanlangan parametriga mos ko'rinishni egallaydi.
Matnning asosiy xususiyatlarini o'zgartirish. Dastlab matnning parametrlarini 
sozlash imkoniyatini sanab o‘tamiz. Zarurat bo'lganda sarlavhali va abzatsli matnni 
o'zgartirish mumkin. Buning uchun uning simvollariga talab qilingan xususiyatni 
berish kerak. Undan tashqari, butun yangi hujjatga shu xususiyatlar o'matilishi uchun 
matn stilini ham asli holidan o'zgartirish mumkin. Masalan, shrift o'lchami va tipini 
o'zgartirish yoki matnni qalinlashtirish yoki egiltirish mumkin. Undan tashqari, matn 
formatini indeksga (qatordan pastga) yoki darajaga (qatordan yuqorida) o'zgartirish 
mumkin. Matnga ostidan chizish, ustidan chizish chiziqlarini qo'shish mumkin. Bu 
chiziqlaming qalinligini o'zgartirish, shuningdek chiziq bilan matn orasidagi 
masofani ham o'zgartirish mumkin. Matn registrini harflami o'chirmasdan va 
almashtirmasdan pastki va yuqorigiga o'zgartirish mumkin. Ko'rsatilgan qadamda 
shrift o'lchamini kattalashtirish yoki kichiklashtirish mumkin. Asli holida o'lchov 
birligi bo'lib punktlar hisoblanadi. Bu sozlamani faol rasm va barcha rasmlar uchun
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o‘zgartirish mumkin. Qaysiki, pirovardida yangi o'lchov birligi shriftning barcha 
sozlamalarida qoMlanilishi uchun yaratiladi16.

Agar matnni qaytadan chizish tezligini oshirish talab qilinsa, shrift oMchami 
kichik qiymatda aniqlangan boMib. matnni taqdim qilish uchun chiziqlami qo‘llash 
mumkin. Bunday usul matnni soddalashtirish deb nomlanib, hujjatlar va rasmlami 
prototiplarini (timsollarini) yaratish uchun foydali hisoblanadi. Matnni 
soddalashtirish qiymatini kichiklashtirish yoki matnni kattalashtirish vo‘li bilan yana 
o‘qiladigan qilish mumkin.

Corel Drawda matnli ob’yektlar. Matnni ko‘chirish (qo‘zg‘atish) va burish 
bo‘yicha mashqni mustaqil bajaring. Buning uchun Text (Текст) menyusi va 
xususiyatlar panelini qollang.

Kursomi diagonal bo‘ylab harakatlanishidan matnni keskin o‘zgarishi.
1. Text (Текст) uskunasi yordamida sarlavha matnini yoki abzats matni ramkasini 
tanlang.
2. Tanlashning burchak markerini matn orqali teskari burchakda joylashgan markerga 
ko‘chiring.

Kontur yaqinida matnni joylashtirish. Sarlavha matnini ochiq ob'yekt 
konturi (masalan, chiziqlar) yoki berk ob’yekt (masalan, kvadratlar) konturi yaqinida 
qo‘shish mumkin. Undan tashqari, mavjud matnni kontur yaqinida joylashtirish 
mumkin. Abzatsli matnni faqat ochiq kontur yaqinida joylashtirish mumkin. Shundan 
kevin, matn konturga qanday joylashtirilishini, shu konturga nisbatan matn qandav 
joylashishini sozlash mumkin. Masalan. matnni gorizontal bo‘yicha, vertikal bolyicha 
yoki ikkala yo‘nalishda ham aks ettirish mumkin. Bo‘linishlar orasidagi intervalni 
qoMlagan holda, matn vayoM orasidagi aniq masofani ko^rsatish mumkin.

Biroq, agar matn kontuming qismi boMishi boshqa talab qilinmasa matnni 
ob’yektdan ajratish mumkin. Matnni egilgan yoki berk konturdan ajratilganda matn 
o‘zi joylashtirilgan ob yektning figurasi boiib qolaveradi. Matnni to‘g‘rilashda u 
joriy ko‘rinishni oladi.

Matn oMchamini kattalashtirish
1. Matnning oMchamini kattalashtirish uchun quyidagi amallami bajaring: 

raqamli klaviaturani faollashtirish uchun <Num Lock> klavishasini bosing.
2. Text (Текст) uskunasi yordamida matnni belgilang.
3. <Ctri> klavishasini ushlab turgan holatda raqamli klaviaturada 8 klavishasini 

bosing. Matn oMchami kattalashadi.
4. Matn o ichamini kichiklashtirish uchun uni belgilagandan kevin Text 

(Текст) uskunasi yordamida va <Ctrl> klavishasini bosish ushlab turgan holatda 
raqamli klaviaturadan 2 klavishasini bosish kerak.

ESLATMA. Matnni oMchamini o‘zgartirish qadamini belgilash uchun 
Tools>Options (Настройки>Парамегры) menyu punktini tanlang. Royxatlar 
kategoriyasidan Text (Текст) tanlang va Revboard Text Increment (Шаг текста 
клавиатуры) maydoniga qiymat kiriting.

0 ‘lchov birligini o‘zgartirish. Tools>Options (Настройки > Параметры) 
menyu punktini tanlang. Kategoriyalar ro‘yxatidan Workspace (Рабочее
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пространство) tanlang, keyin esa Text (Текст) va Default text units (Единицы 
текста по умолчанию) qismidan o'lchov birligini tanlang (points, millimeters, peas 
va boshqalar).

Matnni soddalashtirish. Tools>Options (Настройки > Параметры) menyu 
punktini tanlang. Kategoriyalar ro'yxatidan Workspace (Рабочее пространство) 
tanlang va keyin Text (Текст)т tanlang. Greek text below (Упрощат представление 
текста при размерах до) maydoniga qiymatlarni kiriting. Kichik o'lchamda 
ko'rsatilgan matn plashkalar bilan aks ettiriladi.

Matnni qidirish, tahrirlash va qayta o‘zgartirish. Rasmdagi matnni 
avtomatik tarzda qidirish va almashtirish mumkin. Undan tashqari, ma’lum bir 
simvollami qidirib topish mumkin Masalan. uzun tire yoki qo'shimcha 
ko'chirishlami. Matnni to'g'ridan-tog'ri ehizish oynasida yoki muloqot oynasida 
o'zgartirish mumkin. Sarlavha matni bilan ishlashda formatlashning qo'shimcha 
parametrlari mavjud. Formatlashning bu parametrlari sarlavha matniga uni abzats 
matniga aylantirilgandan keyin qo‘llash mumkin. Shunga o'xshash tarzda maxsus 
effektlarni abzatsli matnlarga ulami sarlavhali matnga avlantirgan holda qo'llash 
mumkin. Abzatsli matnni ham, sarlavhali matnni ham qiyshiq ko'rinishga avlantirish 
mumkin. Alohida chiziqlarda yoki egri ob yektlarda simvollami qayta o'zgartirib, 
alohida simvollar shaklini o'zgartirish uchun ulaming tugunlarini o'chirib tashlash, 
qo'shish yoki ko'chirish mumkin. Matnning egri ko rinishida matnni qayta 
o'zgartirishda matn ko'rinishi o'zgarishsiz saqlanadi. Shuningdek matnning aloqador 
barcha ob yektlari egriga qayta o'zgartiriladi. Qayd qilingan o'lchamli ramkada 
joylashgan abzatsli matnni qayta o'zgartirishda egridagi har qanday matn ramkadan 
tashqariga chiqsa o'chiriladi17.

Matnni qidirish.
1. Edit>Find and replace>Find Text (Правка> Поиск и замена>Поиск текста) 
tanlang.
2. Find (Найти) maydoniga qidirilishi kerak boMgan matnni kiriting.
Agar faqat ko'rsatilgan registrdagi matnni topish kerak bo'lsa, u holda Match case 
(Учитыват регистр) bayroqchasini o'matish kerak bo'ladi.
3. Find Next (Найти далее) tugmasini bosing.

Shuningdek ma lum bir simvollami ham topish mumkin. Agar Find (Найти) 
maydoni yaqinidagi strelkani bosilsa, aniq bir simvolni tanlansa va Find Next (Найти 
далее) tugmasi bosish vo'li bilan qidirish mumkin.

Matnni qidirish va almashtirish. Matnni qidirish va almashtirish matnni 
abzatsli qidirishdan shunisi bilan farq qiladiki, topilishi kerak bo'lgan matnni 
ko'rsatish kerakligi bilan birga topilgan matnni almashtiradigan matn ham 
ko'rsatilishi mumkin.
1. Edit>Find and replace>Replace Text (Правка> Поиск и замена > Заменит 
текст)ш tanlang.
2. Find (Найти) maydoniga qidirilishi kerak bo'lgan matnni kiriting.
3. Almashtirish uchun matnni Replace With (Заменит на) maydoniga kirting.
4. Navbatdagi tugmalardan birini bosing:
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• Find Next (Найти далее): Find (Найти) maydoniga kiritilgan matnni navbatdagi 
joyini topish.
• Replace (Заменить): Find (Найти) maydonida berilgan tanlangan matnni 
joylashgan o'mi bo‘yicha almashtirish imkonini beradi. Agar joylashgan o‘mi 
tanlanmagan boisa, Replace (Заменить) tugmasini bosish bilan navbatdagi 
joylashgan o‘mini qidirish amalga oshinladi.
• Replace Ail (Заменить все): Find (Найти) maydoniga kiritilgan matnni har bir 
joylashgan o‘rindagisini almashtirish imkonini beradi.

Matnni tahrirlash
1. Matnni belgilang18.
2. Text>Edit Text (Текст>Редактироват текст) buyrugini bering.
3. Edit Text (Редактироват текст) muloqot oynasida matnga o'zgartirish kiriting.

• Qiyshiq holatga qayta o'zgartirilgan matnni tahrirlab boimaydi.
• Shuningdek matnni tahrirlash uchun Text (Текст) uskunasini qoilash 

mumkin. Text (Текст) uskunasini bosing, chizish oynasida matnni tanlang va matnga 
o'zgartirish kiriting.

Matnni qayta o‘zgartirish. Abzatsli matnni sarlavhali matnga o'zgartirish. 
Pick (Указатель) uskunasi yordamida matnni belgilang va Text>Convert To Artistic 
Text (Текст>Лреобразоват в заголовочный текст,)ш tanlang.

Savol va topshiriqlar:
1. Egri chiziqlar guruhi uskunalari panelida qanday uskunalar bor?
2. Dasturda ko'pburchaklar qanday yaratiladi?
3. Koordinata qog'ozli uskunasining (Graph Paper) imkonivatlari?
4. Chizish uskunalari qanday chiziqlar chizish uchun moijallangan?
5. Tayanch nuqtalari Corel Draw dasturida necha tipli boiishi mumkin?
6. To'g'ri chiziq yaratish uchun qanday uskuna qulay keladi?

Test savoilari
1. Corel Draw dasturi - ...  7. Corel Draw dasturi import jaravoni to'g'ri
A. vektorli grafika bilan ishlashga mo‘ljallangan keltirilgan javob?
dastur; А) Файл > Импорт... > импорт
B. rastrli grafika bilan ishlashga moijallangan В) Правка > Импорт... > импорт 
dastur; С) Файл >Экмпорт > импорт
C. yuqori darajali dasturlash tili; D) Файл > Импорт... > экспорт 
D animator dastur,

8. Corel Draw dasturining X7 versiyasi qachon,
2. Corel Draw dasturining asosiy texnologik qayerda va kim tomonidan ishlab chiqilgan? 
prinsipi nimaga asoslangan? A) 2014 yilda Kanadaning Corel firmasi
A) gratiklarga tomonidan;
B) matnlarga B) 2014 yilda Kanadaning Corel Draw firmasi
C) hisoblashlarga tomonidan;
D) ob=vektlarga. C) 2007 yikia Kanadaning Corel firmasi

tomonidan;
3. Corel Draw dasturida belgilangan ob’yekt D) 2017 yilda Kanadaning Corel firmasi 
nusxasini qanday olish mumkin? tomonidan;
A) Edit-Dublicatc
B) Edit-Paste. 9. Corel CAPTURE dasturi nima vazifani
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bajaradi?
A) CorelDRAW dasturi oynasi va uning qismlarini 
rasmga olish uchun ishlatiladi;
B) shtrix-kod bilan ishlashga mo‘ljallangan.
C) rasmlar chizishga moijallangan.
D) vektorli grafika bilan ishlashga mo'ljallangan;

10. Coril BARCODE WIZARD dasturi nima 
vazifani bajaradi?
A) dasturi esa shtrix-kod bilan ishlashga 
moMjallangan.
B) CorelDRAW dasturi oynasi va uning qismlarini 
rasmga olish uchun ishlatiladi;
C) Corel Photo-PAINT dasturi esa rasmlar 
chizishga moMjallangan.
D) Vektorli grafika bilan ishlashga mo‘ljallangan,

D) Alt

6. «Masshtab» paneli niinaga kerak?
A) Masshtabni o‘zgartirish uchun.
B) Faylni xotiraga olish
C) Ob’yektni rangini o‘zgartirish uchun
D) To‘g‘ri javob yo‘q

19-§. Corel Draw grafik prosessorida tasvirlarga ishlov berish texnologiyasi

Tayanch tushunchalar: Effekt, Oraliq transformatsiya, Contour effekti, Envelope 
effekti, Lens effekti, Power Cl ip effekti, Effektlami nusxalash, Blend.

CorelDraw dasturi nafaqat vektorli grafikani yaratish va ulami qayta ishlash 
imkonini beradi balki chizilgan vektorli tasvirlarga turli effektlami birlashtirgan 
holda yanada o‘zgacha tasvirlami hosil qilish imkonini beradi. Vektorli effektlardan 
foydalangan holda shaklni o‘zgartirish yo‘llari: oraliq transformatsiya (o‘zgaradigan), 
Contour effekti, Envelope effekti, Lens effekti, PowerClip effekti, Effektlami 
nusxalash.

Standart vositalarda vektorli tasvirlami yaratishda real fotorealistik 
illyustratsiyalami imitatsiya qilish qiyin. Dastur buyruqlarga shundav vazifalami 
yuklaganki, unda oddiy ob’yektlarga turli xil effektlami biriktirish, ob’yekt shaklini 
avtomatik o‘zgartirish imkonini beradigan, bir nechta joriy ob’yektlar o‘rtasida oraliq 
ob’yektni yaratish, bunda ulaming shakli va ranglarini ketma-ket o'zgartirgan holda, 
ob’yektga parallel vositalami qo‘shgan tarzda ob'yektni yoki ob’yektlar guruhini uch
o lchamli ko‘rinishda taqdim qilish mumkin. Bu barcha buyruqlar real effektlar 
yaratish uchun moMjallangan. Bunday' effektlarga ob’yekt soyasini yaratish va uni 
voritilganligini ta minlash. soya va chiroqni may donga yotqizish, predmetning 
qurshovini (hajmliligini) tasawur qilish, boshqa ob’yektning berilgan shakliga ko'ra 
ob’yekt shaklini o zgartirish, imitatsiya qilish kiradi.

Barcha ko‘rsatilgan effektlar Effects (Эффекты) menyusida to'planadi. Undan 
tashqari, juftlashadigan panellar va interaktiv uskunalar yordamida ham amalga

C) Edit-Redo
D) To‘g‘ri javob yo‘q

4. Corel Draw dasturida «Uskunalar paneli» 
nima vazifani bajaradi?
A) Ob'yektlaryaratadi, va ob’yektlar bilan ishlaydi.
B) Bunday panel umuman vo‘q
C) Faqat matn varatadi
D) ob’yektlar bilan ishlaydi

5. Corel Draw dasturida klaviatura yordamida 
qaysi tugmani bosib turib bir nechta ob’yektni 
belgilash mumkin?
A) Shift
B) Ctd
C) Tab
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oshirilishi mumkin. Ulami shartli ravishda shaklni o'zgartirishning vektorli effektlan 
va rangli korrektsiya bilan bog'liq effektlarga bo'lish mumkin.

Undan tashqari, CorelDravv dasturi importlangan pikselli tasvirlami qayta 
ishlashning ko'p sonli effektlarni qo'llash mumkin boMgan keng imkoniyatlami 
qamrab oladi. Bu mavzuda biz vektorli effektlarni o'rganamiz. Ob’yekt shaklini 
o'zgartirish imkonini beradigan, obyektlar o'rtasidagi oraliqlami yaratish yoki 
ob'yektning u yoki bu oraliqdagi o'zgarayotgan shaklini olish imkonini beradi

Oraliq transformatsiya (перетекание). Blend (перетекание) vektorli 
grafika dasturlari orasida eng taniqli va eng ko'p qo'llaniladigan effekt hisoblanadi. 
Qadamli o'tishlarda, o‘zgarishlar (shakl yoki rang) yoki ob’yekt o'zgarishlarida uni 
oraliq transformatsiya deb nomlanadi. Bu effektni ikkita ob yekt yoki ob’yektlar 
guruhi orasida, oreollar orasida, ochiq yoki yopiq konturlarda yoki standart 
ob’yektlarda o ‘matish mumkin. Bu o‘zgarishda qatnashadigan ob yektlar, aylantirib 
chiqish va rang quyishning turli parametrlariga ega bo'lishi mumkin. Natijada 
berilgan sondagi transformatsiyalangan ob’yektlar yaratiladi. Joriy ob’yektlami bir- 
birini qo'shilishini imitatsiya qiladigan ob’yektlar yaratiladi. Bunda oraliq 
ob’yektlaming nafaqat shakli ketma-ket o'zgaradi, balki rangi va obvodka 
parametrlari ham o'zgaradi. Yaratilgan ob yektlar majmui dinamik tarzda o'zaro 
bog'langan bo iadi. Ya'ni birlashish va tahrirlash imkonini beradi oqib tushish 
jaray onini tezlashtirish yoki sekinlashtirish, to'plamni bo'laklash y oki birlashtirish, 
ko'chib o‘tishni to'g'ri chiziq yoki ixtiy oriv yo'nalishda joylashtirish.

O'zgarishni hosil qilish uchun dasturda quyidagi element interfeyslari 
qo'llaniladi:
□ birlashadigan Blend (Перетекание) paneli, qaysiki Window>Dockers>Blend 
(Окно>Пристыковьшающиеся панели>Перетекание) menyudan yoki 
Effects>Blend (Эффекты>Перетекание) buyrug'i orqali chaqiriladigan;
□ Interactive Blend (Интерактивное Перетекание) uskunasi;
□ Property Bar (Свойства) paneli.

Tasvir ustida ko'p sonli maxsus effektlar qo'llash mumkin bo'lgan oddiy 
o‘zgarish yaratamiz19.

Blend -  bir-biriga yaqinlashadigan panel. Blend (Перетекание) paneli 
(4.14-rasm) ko‘chib o'tishlami boshqarish uchun parametrlardan tarkib topgan. 
Oraliq ob’y ektlar sonidan tashqari у aratiladigan ob’yektlar orasidagi intervalni ham 
ko'rsatish mumkin. Rotate (Поворот) maydoni oraliq obyektlami bir-biriga nisbatan 
qanday burchakda burilgan turishini belgilashga xizmat qiladi.
Burilish burchagini berilgandan keyin Loop (Цикл) bayroqchasiga bog'lanish 
imkoniyati paydo bo'ladi. Bu bayroqcha ko'chib o'tish burilishini va ulami hududini 
siljitish imkonini beradi. Siljish yo'nalishi belgilangan burilish burchagiga bog'liq 
bo'ladi Blend along full path (Перетекания вдол всей траектории) va Rotate all 
objects (Поворот всех объект) bayroqchalari joylashuvda travektoriya uzunasi 
bo'ylab joylashuvni ko'chib o'tishida qo'llaniladi. Panelning pastki qismida 
joylashgan Path (Траектория) o'ng tugmasi New Path (Новая траектория). Show
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Path (Показать траекторию) va Detach From Path (Отделить от траектории) 
buyruqlarini o'z ichiga olgan menyuni chaqiradi.

4.14-rasm. Oddiy oqib tushishga misollar
Starting object (Начальный объект) va Ending object (Конечный объект) 

tugmalari chapga va o‘ngga yo‘naltirilgan strelkalar bilan, tarkibiy o‘zgarishda yangi 
boshlangich va so‘nggi ob'yektlami ko‘rsatish uchun moijallangan. Endi biz oraliq 
ob’yektlami qanday burishni, va trayektoriya bo‘ylab o‘zgarish qanday joylashishini 
o‘rganamiz20.

Imitalsiya uskunasi (Artistic Media). Imitatsiya uskunasi nuqtali grafika dasturlarida 
ko proq ishlatiladi. Shunga qaramay vektorli dastur ham bu uskunani taqdim etadi. Bu 
uskuna orqali Peroda chizish o'mini bosa oladi. Shu bilan birga bezakli shtamp o‘mini ham 
bosadi. Bu uskunaning гу oy ibligi shundaki u asosiy kontumi chizib, bu kontur bo‘ylab turli 
ob’yektlarjoylashib manzarali va grafik efFektlami beradi.

Namuna rejimida shunday ob’yektlami yaratish mumkinki, bunda bu ob’yektlar 
tayyor namunalargaqarab o‘z shaklini o'zgartiradi. Bu rejimda shaklli chiziqlami ishlatish 
mumkin.

Muyqalam rejimi (Brush) - bu rqimda murakkab tuzilishga ega boigan bezakli 
shakllami y aratish mumkin.

Purkagich rejimi (Object Sprayer) kontur trayektoriyalari bo‘ylab turli grafik 
ob’yektlami joylashtiradi. Bu rejim murakkab ramkalar, bezakli qatorlami yaratish uchun 
moijallangan

^Л.Б.Левковец, Векторная графика. CorelDRAW Хб -  СПб: НИУ ИТМО, 2013. -  229 с.
38



Kalligrafiva rejimi (Calligraphis) - bu rejimda qalin pero yoki enli muyqalam egri
chiziqlanni chizish mumkin.

Rgessure rejimi - bu rejimda shunday chiziqlami chizish mumkinki bu chiziqlami
klaviatura orqali boshqarish mumkin

Xususiyatlar panelida bu rejim tanlansa quyidagi parametrlarga ega bo'lamiz: 
tekislash maydoni (Freehand Smoothing) asosiy chiziqni 0 dan 100 diapazonigacha 
tekislash imkoniyati (rasmda 1 raqami bilan Iffgatilgan); ’

,,  „„иств A rfotonb объекте художественного «фирмпения

^  “ + Ш М * Л  в  , . f e s B  *» U s  

[2 J 2-------------- ,--------
2 1 3 4 5

4 .15-rasm. Property Bar paneli.
O icham maydoni (Size) (2 raqam) bezakli shtrixlaming oichamini foizlar 

hisobida o‘zgartish imkonini beradi: 1 dan 999% gacha
Ob'yektlar ro'yxati maydoni (3 raqam) - bu ro'yxatda turli formatdagi 

purkaladigan ob'yektlaming namunalari keltirilgan.
Save tugmachasi (4 raqam) muy qalam rejimida ish yuritish bilan bir xil.
0 ‘chirish tugmachasi (Delete) ro‘yxatdagi xohlagan variantlardan birini 

o‘chiradi.
Purkash tartibi (Srau Order) ob'y ektning kontur bo vlab joylashish royxatini 

taqdim etadi: tasodifan (Random), ketma-ketli (Sequentially), yo‘nalish bo‘ylab (By 
Direction).

Ob'yektlar ro‘yxatiga qo‘shish tugmasi (Add to SprayList) ob’yektlar 
ro‘yxatiga yangi elementlarni qo‘shish imkoniy atini beradi. Ulardan keyinchalik 
«Ijrochi» qatorini (play list) tashkil qilish mumkin.

Uch oMchamli effektlar va effekt soyalar: Perspective effekti. Extrude 
effekti, Soya effekti, Bevel effekti.

CorelDraw dasturi ikki o‘lchamli tasvirlami qayta ishlash uchun moijallangan. 
Ammo avvalgi versiyasidan boshlab unga uch oMchamlilikni imitatsiya qiladigan 
effektlar qo‘shilgan. Buning uchun ikkita maxsus effekt qoilaniladi. Ulardan biri 
tasvimi manzarada taqdim qilish imkonini beradi. Boshqasi esa — uch o'lchamli 
ko'rinishda taqdim qilish imkonini beradi. Birinchi holatda ham, ikkinchi holatda 
ham ob’yektlar ikki olchamliligicha qolaveradi, biroq ulaming yordamida 
ob’yektlami yanada haqqoniy va ravshan taqdim qilish mumkin.

Hajmni imitatsiya qilishning yana bir usuli yoki aniqroq aytganda, 
chuqurlikning illvuziy alari boiib, ob’yektga soyani qo‘shishni ham avtish mumkin. 
Dasturda qirralami yaivilib ketilishi bilan yassi soyani yaratish imkoniyati mavjud. 
Bunda uning har qanday rangini berish, yoritish va haqqoniy effektlami yaratish 
mumkin

Perspective efTekti. Barcha haqiqiy predmetlami biz tasvirda ko‘ramiz. 
Insoniyat ko‘rish qobiliyati shunday yaratilgan. Chiziqli qonunga ko‘ra 
kuzatuvchidan ma lum bir masofa bilan predmetlar kichik tuyuladi: predmet elementi
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qancha uzoqda joylashgan bo'lsa, shunchalik biz uni kichik ko'ramiz. Shundan 
quyidagi tushuncha kelib chiqadiki, tushish nuqtasi shartli chiziqlar kesishadi. 
Masofada joylashgan predmetni o‘lchamlarim o‘zgarishini aniqlaydi.

Tasvimi yaratish uchun Effects (Эффекты) Add Perspective (Добавить 
перспективу) menyu buy ruq qo llaniladi. Buning uchun oldindan Pick (Указатель) 
uskunasi bilan ob’yektni yoki ob’yektlar guruhini belgilash kerak va Add 
Perspective (Добавить перспективу) buyrug'ini berish kerak. Bu buyruq 
bajarilgandan keyin belgilangan ob’yektlar to‘ming sakkizta gorizontal va sakidzta 
vertikal katakchalariga bo‘linadi. Qaysiki keyinchalik tasvirda ob’yektning 
o‘zgarishlari aks ettiriladi (4.16 or-rasm). Qo‘shimcha ravishda ob’yekt atrofida to‘rtta 
oicham markerlari paydo boiib, ular tasvirlami yaratish uchun mo'ljallangan va 
Shape (Фигура) uskunasi faollashadi.

Tasvir oicham markerlarini qo‘lda surish orqali yaratiladi. Agar ob’yekt 
sezilarli o'zgarsa, u holda market ko'chirilishining yo'nalishiga bog‘liq ravishda 
ishchi maydonda krestik ko‘rinishidagi bitta yoki ikkita tushish nuqtasi paydo bo‘ladi 
(4.16 b-rasm). Agar tushish nuqtasi ekranda paydo bo'lmasa, F3 klavishani bosgan 
holda rasmni aks etish masshtabini kichiklashtirish kerak bo'ladi. Tushish nuqtasi 
paydo bolgandan so'ng tasvimi o'lcham markerlarini ko'chirish singari, shuningdek 
tushish nuqtasi orqali ham o'zgartirish mumkin.

Extrude effekti. Extmde (Экструзия) effekti — dastuming nisbatan 
qiziqarliroq effekti hisoblanadi Ob yektni uch o'lchamli namovon bo‘lishi joriy 
ob’yektga yon qirralami qo‘shish bilan amalga oshiriladi. Bu esa ob’yektni uch 
o'lchamli ko'rinishda yetarlicha yaqqol taqdim qiladi. Yaratiladigan tasvir ikki 
o'lchamli hisoblanadi Shu bilan birga predmetning u yoki bu rakursini aks ettirgan 
holda uni avlantirish mumkin. Unga turli xil variantdagi yoritilish va bo‘yashni 
qoilash mumkin.

Ekstruziya effektini yaratish. Dasturda yaratiladigan tasvir qalinligini 
o‘zgarishi bilan kechadigan variant mavjud. Uning natijasida manzara effektida, 
tushish nuqtasi tushunchasi paydo bo‘ladi Tushish nuqtasi bitta, biroq uni ob yektga 
bogiash yoki hujjat sahifasiga bog'lash mumkin. Dasturda ekstruzivani yaratish 
uchun interfeysning quyidagi elementlari qo'llaniladi:22

□ birlashishni amalga oshiradigan Extrude (Экструзия) panel, Window > 
Dockers > Extmde (Окно > Пристыковывающиеся панел > Экструзия) 
menyusidan chaqiriladigan yoki Effects > Extmde (Эффекты > Экструзия) buymg‘i 
bilan amalga oshadi;

1 Interactive Extmde (Интерактивная Экструзия) uskunasi;
□ Property Bar (Свойства) panel, qaysiki Interactive Extmde (Интерактивная 

Экструзия) uskunasini tanlaganda Extmde (Экструзия) panelining parametrlarini 
avnan ko‘chiradi. Extmde effektini yaratish bo‘yicha mashq bajarib ko‘ramiz.

Extrude Camera vkladkasi. Vanishing Point (Точка схода) ro'yxati 
ekstruziyaning oltita turidan tarkib topgan. Ular joriy ob’yektning effekt 
vo nalishlarini va uch o'lchamli qiyofa ozgarishini belgilaydi. Tanlangan tur shartli
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sxema ko'rinishida yaqqol ravishda korish hududida va Property Ваг (Свойства) 
panelida aks etadi.

I
4.16-rasm. Add Perspective eftektiga misollar

□ aslida Small Back (Назад с уменшением) tipi o‘matilgan bo‘ladi. Bunda 
orqa taraf qirrasi kichiklashadi va tushish nuqtasi ob’yekt orqasida joylashgan 
boiadi.

□ Small Front (Вперед с уменшением) — ob'yekt oldida tushish nuqtasini 
holatini va ob'yekt oldida ekstruziya holatini ta'minlaydi.

□ Big Back (Назад с увелечением) — teskari manzarani beradi. Tushish 
nuqtasi ob’yekt oldida joylashgan, ekstruziya orqaga yo‘naltinlgan. orqa qirra 
kattalashtirilgan.

П Big Front (Вперед с увелечением) — avvalgi tip bilan teskari joylashgan 
effektni taminlab beradi. Tushish nuqtasi ob'yekt orqasida boiadi va oldi qirralar 
kattalashishi amalga oshadi.

1 Oxirgi ikkita tip parallel ekstruziyani varatadi. Ulami qoilanilishida rasm 
effektining ko‘ndalang kesishuvi oichami o‘zgarmaydi. Back Parallel (Назад 
параллелно) varianti joriy ob’yekt orqaga, Front Parallel (Вперед параллелно) — 
esa teskari tarzda ya’ni oldinga ekstruziya yaratadi23.

□ Effektning ikkinchi muhim parametri boiib tushish nuqtasi hisoblanadi. U 
ob’yektlami kichiklashtirish yo‘nalishini belgilaydi. Shuni eslab qolish kerakki, 
tushish nuqtasi holati ekstruziya guruhi yo‘nalishi bilan mos tushmasligi mumkin. 
Vanishing Point Properties (Свойства точки схода) ro‘yxati tushish nuqtasini 
boshqarish quyidagi variantlardan tarkib topadi:

] VP Locked To Object (Привязат точки схода к объекту) — ob’yekt 
ko'chirilishida tushish nuqtasi o‘zining holatini ob’yektga nisbatan saqlab qoladi;
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□ VP Locked To Page (Привязать точки схода к странице) — ob’yekt 
holatini o'zgartirganda tushish nuqtasi o'zining holatini o'zgartirmaydi, 
ekstruziyamng o‘zgarishiga olib keladi;

□ Copy VP From (Копировать точку схода) — bu variant ob’yektning 
tushish nuqtasini ko'chirish zarur bo'lgan hollar uchun qollaniladi. Ya’ni ekstruziya 
effektlari qoilanilgan ob’yektni ixtiy oriy belgilangan ob’y^ektga qo'llaniladi. Buyruq 
bajarilgandan key in ikkala ob yekt ham umumiy tushish nuqtasiga ega bo‘ladi;

J Shared Vanishing Point (Объединить точку схода) — bu variant 
hujjatdagi bitta sahifada joylashgan belgilangan ob’yekt va analogik effektga ega 
boigan boshqa effekt bilan tushish nuqtalarim birlashtirish uchun moijallangan. 
Depth (Глубина) may doni ekstruziyamng chuqurligini berish uchun xizmat qiladi. 
Chuqurlik yon qirralaming uzunligi singari aniqlanadi. Joriy ob’yektdan tushish 
nuqtasigacha boigan oraliq masofaga tenglashib, 1 dan 99% gacha qiymat qabul 
qiladi.

Measured from (Otchet) boiimi qayta ulagichlan tushish nuqtasi 
koordinatlarini berish variantlaridan birini tanlash uchun qoilaniladi. Object center 
(Центр объекта) qayta ulagich ob’yekt markazidan koordinatani hisobini o'matadi, 
Page origin (Начало координат страницы) qayta ulagich esa — betning koordinata 
boshlanishidan hisobini o‘matadi. Tushish nuqtasining haqiqiy koordinatalari qiymati 
gorizontal va vertikal bo'yicha H va V raqamli maydonlarda beriladi24.

Extrude Rotation vkladkasi. Yaratilgan uchun qiziqarli imkoniyatlar boiib, 
yaratilgan ob yektni turli xil rakurslarda taqdim qilish maqsadidagi ayiantirish 
hisoblanadi. Ekstruziyani ayiantirish uchun Extrude (Экструзия) panelidagi 
Extrude Rotation (Поворот эксструзии) vkladkadan foydalaniladi. Panelning 
asosiy jovini avlana ko‘rinishidagi maxsus element egallagan. Ob yektni burish 
uchun uni Pick (Указатель) uskunasi bilan belgilash va vkladkaning pastki qismida 
joylashgan Edit (Правка) tugmasini bosing. Shundan keyin avlana faollashadi va 
unga kursomi olib borilganda u qoini tasviriga aylanadi. Burish uchun kursomi 
avlana hududiga olib kelish va aylanani ushlab burish kerak boiadi. Ob’yektni 
gorizontal yoki vertikal bo'yicha burish mumkin. Buning uchun kerakli holatni 
tanlash kerak boiadi. Ular shtrixli chiziqlarda aks etgan boiadi. Kerakli holatga 
kelgandan keyin vkladkaning pastki qismida joylashgan Apply (Применит) 
tugmasini bosish kerak. Buni bosish bilan tanlangan holatni o'matish qabul qilinadi.

Ekstruziyamng katta chuqurligiga ega ob’yektlami burishda ob’yektni mos 
keladigan holatini tanlash mashaqqatli hisoblanadi. Bu muammoni vechish uchun 
burish aylanasi pastida joylashgan ikkita tugma xizmat qiladi. Chap tugma 
boshlangich holatga qaytarish uchun moijallangan. O'ng tugma esa — ob yektni 
burish qiymatini ko'rsatish bilan burishni belgilashga o'tish uchun uchta koordinata 
o‘qi X, Y va Zga nisbatan amalga oshadi. Burishning qiymati protsentlarda-100 dan 
100 % gacha oraliqda beriladi. X maydoni ob’yektni gorizontal bo‘yicha burishni 
belgilaydi. Y maydoni ob yektni vertikal bo'yicha burishni belgilaydi. Z maydoni esa
— o'qqa nisbatan birmuncha burish, ekranning perpendikulyar tekisliklari
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hisoblanadi. Ob’yektni burishning yana bitta usuli Interactive Extrude 
(Интерактивная Экструзия) uskunasini faol rejimda qo‘llash mumkin.

Extrude Light vkladkasi. Ob'yektni ekstruziya effekti bilan yoritilishi unga 
katta ko‘rgazmalilik va haqqoniylik beradi. Extrude Light (Освещение экструзия) 
vkladkasida elektr lampasi tasviri bilan voritilishning boshqaruv elementlari 
joylashgan.

Lighting (Освещение) hududida yorug'likning uchta shartli manbalari 
joylashgan. Qavsiki ular odatda (по умолчанию) ochirilgan bo‘ladi. Manbalardan 
o‘ngroqda uch o‘lchamli karkasli sxema joylashgan bo‘lib, uning ichida sfera 
joylashgan. Yorug‘lik manbasini qo‘shish uchun uning tasviriga ko'rsatkich bilan 
bosish kerak. Keyin esa, u uch o'lchamli sxemada aks etgandan kevin, uni talab 
qilingan tugunlardan biriga ko'chiring.

Sxemada yoruglik manbasi joylashgandan keyin uning harakat natijasi 
sferaning yoritilganligida aks ettiriladi. Yoruglikning har bir manbasi yorqinlikning 
mustaqil sozlamasiga ega. Intensity (Яркость) polzunkasi yordamida belgilangan 
manba ostida o‘matiladi. U 0 dan 100 % gacha boigan oraliqdagi qiymatlami qabul 
qiladi25.

Use full color range (Испольвать полный диапозон цветов) bayroqchasi 
bo‘valgan ob’yektlar uchun yanada haqiqatga yaqin yoritilish natijasini olish 
imkonini beradi. Ob’yektni yoritish uchun uni Pick (Указатель) uskunasi bilan 
belgilash. Extrude Light (Освещение экструзии) vkladkasiga o‘tish va Edit 
(Правка) tugmasini bosish kerak. Shundan keyin yoritish manbalaridan birini bosish 
kerak. Uni karkasli sxemaning talab qilingan joyiga o‘matish va uning uchun 
vorqinlik qiymatini berish kerak. Zarurat bo‘lganda yorug lik manbaini o'chirish 
uchun chapdagi karkasli sxemadagi uning znachogini takror bosish kerak. Analogik 
tarzda bittadan uchtagacha yoruglik manbaini o’matish va yoqish mumkin. Kerakli 
sondagi talab qilingan manbalami o‘matib bo‘lingandan so‘ng Apply (Применить) 
tugmasini bosish kerak. Mustaqil tarzda ixtiyoriy ob yektga ekstruziya effektini 
qo'llang va uni yoriting.

MASHQ. Blend paneli yordamida o‘zgarishni hosil qilish
Ishning maqsadi: Blend (Перетекание) paneli yordamida o'zgarishni 

(boshqasiga o‘zgarish) yaratish jarayonini o‘rganamiz.
Odatda bu olzgarish ob’yektning boshlang'ich va so‘nggi holatlari orasida 

to‘g‘ri chiziq bo‘ylab yaratiladi.
1. Yangi hujjatni yaratish va uning parametrlarini sozlang.
2. Layout > Page Setup (Компоновка > Параметры страницы) buyrug ini bering. 
Sahifa oMchamini A4 (210.297 mm) o‘mating, oriyentatsiyasini Landscape 
(Альбомная).
3. Effects (Эффекты) menyusidan juftlashgan Blend (Перетекание) panelini 
chaqiring.
4. T o g r i to rtburchak va ellips chizing. To g'ri to‘rtburchak va ellips uchun turli xil 
ranglami quying va aylantiring.
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5. To'g'ri to'rtburchak va ellips belgilang va Blend (Перетекание) panelida Apply 
(Выполнить) tugmasini bosing. Bunda peretekaniya aslida mavjud boigan 
(принятыми по умольчанию) parametrlar bo'yicha yaratiladi.
6. Number of steps (Число шагов) maydoniga 3 qivmatini kiriting va Apply 
(Выполнить) tugmasiga yana bir marta bosing. Shu tarzda, Перетекание 
uskunasining asosiy parametri boiib, yaratiladigan ob'yektlar soni hisoblanadi.
7. Diagrammali setka va to'g 'ri chiziq qirqimi o rtasida, shuningdek yopiq kontur va 
standart ob'yektlar o'rtasida peretekaniya yaratish.
8. Peretekanivani ochiq konturlar o'rtasida ham yaratish mumkin. Shunday mashqni 
bajaring.
9. Predmet hajmini imitatsiya qiladigan peretekaniya yaratish.

Peretekanivani boshqa ob'yektlar orasida o'mating va o'zingizning papkangiz 
ichiga saqlang. Blend (Перетекание) effekti turli xil parametrlarga ega boiib, 
yaratiladigan ob’yektlar sonidan tashqari, ulami burilishi, ob'yektlar orasidagi 
masofa, rang, peretekaniya parametrlari, trayektoriya bo‘ylab joylashganlikni 
belgilaydi. Quyida sanalgan barcha parametrlar Blend (Перетекание) panelida 
o‘matiladi. Ulami hozir ko'rib chiqamiz.

Blend juftlashgan paneli. Blend (Перетекание) paneli peretekaniyalami 
boshqarish uchun parametrlami o'z ichiga oladi. Shunday qilib, oraliq ob'yektlar 
sonidan tashqari yaratiladigan ob'yektlar orasidagi intervalni ham ko'rsatish mumkin. 
Rotate (Поворот) maydoni oraliq ob’yektlami bir-biriga nisbatan burilish burchagini 
berish imkoniyatiga ega. Burchak berilgandan keyin burilishni ko'rish mumkin 
boiadi. Buning uchun Loop (цикл) bavroqchasi o'matilib, ko'chirilishning burilishi 
va ulaming travektoriyasi siljishi ta’minlanadi. Siljish yo'nalishi ornatilgan burilish 
burchagiga bogiiq boiadi. Blend along full path (Перетекания вдоль всей 
траектории) va Rotate all objects (Поворот всех объектов) bayroqchalari 
peretekaniyani trayektoriya bo‘ylab joylashuvida qoilaniladi26.

Panelning pastki qismida Path (Траектория) o'ng tugma menyuni chaqiradi. U 
menyu New Path (Новая траектория), Show Path (Показать траекторию) va 
Detach From Path (Отделить от траектории) buyruqlari dan tarkib topadi. Starting 
object (Начальный объект) va Ending object (Конечный объект) tugmalari chapga 
va o‘ngga yo'naltirilgan tugmalari bilan tarkibiy o'zgarishda yangi boshlangich yoki 
oxirgi ob’yektlami ko'rsatish uchun moijallangan. Endi biz oraliq ob’yektlami 
qanday burishni va peretekaniya trayektoriya bo'ylab qanday joylashishini 
o'rganamiz.

MASHQ. Perspektiva effektini ob’yektga biriktiramiz 
Ishning niaqsadi: Perspektiva effektini ob yektga biriktirishni o'rganish.
Perspektiva effektini ob’yektga biriktirib kevin esa uni boshqa ob’yektlarga 
nusxalaymiz.

1. To'g'ri to'rtburchak chizing.
2. Interactive Fill (Интерактивная заливка) uskunasi bilan to'g'ri 

to‘rtburchakga ehiziqli gradiyentli kulrangdan oq ranggacha quyishni amalga
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o s h i r in g .  To‘g i i  amalga oshirilgan rang quy ish perspektiva effektini yanada tabiiy 
qilib ko‘rsaiadi.

3. Pick (Указатель) uskunasi bilan to'g'ri to'rtburchakni belgilang va 
Effects>Add Perspective (Эффекты > Добавить перспективу) buyrug'ini
faollashtiring.

4. O'ng yuqori markerda strelka ko'rinishidagi korsatkichni qayd qiling. 
<Ctrl> tugmasini bosing va markemi tushish nuqtasi paydo bo'lgunga qadar chapga 
surib keling.

X X

4 .17-rasm. Perspektivalami yaratish va nusxalash
Maslahat. <Ctrl> tugmasini ushlab turgan holda, markemi qat’iy gorizontal 

bo‘ylab yoki vertikal bo'ylab siljitish mumkin. Bunda bitta tushish nuqtasiga ega 
perspektiva yaratiladi. Agar <Ctrl> + <Shift> klavishalarini ushlab tursangiz, 
qarama-qarshi joylashgan marker sinxron tarzda ko chiriladi.

5. Avval bajarilgan perspektivani bekor qiling. Buning uchun Pick (Указатель) 
uskunasi bilan effekt biriktirilgan ob’yektni belgilang va Effects>Clear Perspective 
(Эффекты>Отменить перспективу) buy rug'ini bajaring.

6. Ikkita tushish nuqtasiga ega perspektiva yaratish uchun to'g'ri to'rtburchakni 
belgilagandan keyin Effects>Add Perspective (Эффекты>Добавить перспективу) 
buyrug'ini berib keyin o'ng vuqoridagi markemi vertikal tushish nuqtasi pavdo 
bo'lgunga qadar chapga suring. Shundan keyin o'ng pastki markemi gorizontal 
tushish nuqtasi paydo bo'lgunga qadar yuqoriga ko'chiring.

7. Perspektivani tahrirlashni davom ettirish uchun ko'chish bilan tushish 
nuqtasini kiriting.
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8. Perspektivadan nusxa olish jarayonini o'rganish uchun 4 .17-rasmda pastda 
chapda ko'rsatilgandek ellips chizing.

9. Pick (Указатель) uskunasi bilan ellipsni belgilang. Effects (Эффекты) 
menyusidan Copy Effect>Perspective From (Копировать эффект > Перспектива 
из) buyrug'ini bering.

10. Qalin strelka ko rinishidagi ko‘rsatkichda (kursomi almashtirgan), 
perspektiva biriktirilgan to'g'ri to'rtburchakni korsating. Perspektiva ellipsga 
o'rnatiladi.

11. Nusxalangan perspektivani tahrirlash uchun Shape (Фигура) uskunasini 
faollashtiring va tushish nuqtasini yoki burchak markerlarini joyini o‘zgartiring. Shu 
tarzda, perspektiva effekti ob’yektga uchinchi olcham illyuzivasini olishga imkon 
beradi. Bunda ob’yektning taqdim qilinishini uch oichamliga yaqinlashtiriladi.

MASHQ. Extrude effektini yaratish 
Ishning maqsadi: Extrude effektini yaratishga o‘rgatish 

Ishni bajarish bo‘yicha metodik ko‘rsatma:
1. 4.18-rasmda yuqorida ko'rsatilganidek to'g'ri to‘rtburchak chizing.
2. Uni Pick (У казатель) uskunasi bilan belgilang.
3. Interactive Tool (Интерактивные Инструменты) uskunalar guruhidan 

Interactive Extrude (Интерактивная экструзия) uskunasini faollashtiring. To'g'ri 
burchak markazida uskunani qayd qiling va uni ko‘rsatkichini yuqoriga va o‘ngga 
suring. Natijada to‘g‘ri burchak ekstruziyasi yaratiladi.

4. Uni rasmdagi o‘ngda korsatilgan ko‘rinishda taqdim qilish uchun ekstruziya 
o^qida joylashgan va yon qirra uzunligini aniqlaydigan egilgan chiziqni (chegarani) 
ko'chiring.

Joriy ob’yektni ekstruziya elementlaridan ajratish uchun Break Extrude Group 
Apart (Отделить группу экструзии) buyrug‘i xizmat qiladi. Bu buyruqni chaqirish 
uchun effekt biriktirilgan ob’yekt ustida sichqoncha o‘ng tugmasini bosish orqali 
chaqiriladigan kontekstli menyudan beriladi. Effekt parametrlarini o‘rganish uchun 
hammasidan ko ra juftlashgan Extrude (Экструзия) panelidan foydalanish kerak 
(4.18-rasm). Panelda beshta vkladka bo4ib, ular panel yuqori qismi da joylashgan 
tugma yordamida chaqiriladi. Ulardan birinchisi — Extrude Camera (Камера 
экструзии) —4.18-rasmda keltirilgan. U ob yektga effekt biriktirilgandan keyin 
ko‘rinishni belgilaydigan parametrlardan tarkib topadi.
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MASHQ. Ob’yektni burish
Ishning maqsadi: Ob’yektga ekstruziya efTekti binktirilgandan kevin 

ob’yektni burishga o'rgatish.
1. Diametri 50 mmga teng aylana chizing.
2. Interactive Extrude (Интерактивная экструзия) uskunasini faollashtirib, uni 

aylana markazida qayd qiling va Small Back (Назад с уменьшением) tipidagi 
ekstruziya varatgan holda o'ng va yuqoriga suring.
Maslahat. Agar siz ob’yekt bilan aloqani yo‘qotsangiz va Extrude (Экструзия) 
paneli parametrlariga bog'lanish imkoni bo‘lmasa, Interactive Extrude 
(Интерактивная экструзия) uskunasini faollashtiring.

3. Yaratilgan effektni tahrirlash uchun Extrude (Экструзия) panelida Extrude 
Camera (Камера экструзии) vkladkasidan Edit (Правка) tugmasini bosing. Depth 
(Глубина) maydonida 30 qiymatini kiriting va Enter klavishasini bosing. Yaratilgan 
effekt natijasi 4 .19-rasmdagi tasvirda o'rtada keltirilgan27.

4. Ob'yektni burish uchun Extrude Rotation (поворот экструзии) Z o qiga 
nisbatan -30° burishni amalga oshiring.

5. Burishdan kevin joriy ob’yekt markaziy nuqtasiga bosing. Buning natijasida 
burish markerlari paydo bo‘ladi (4.19-rasm o'ngda).

6. Ob’yektni kerakli holatdagi joylashuvni olishi uchun uni buring.
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4 .19-rasm. Ekstruziya effekti va uni burishni yaratishga misol
V

Savol va topshiriqlar:
1. Imitatsiya uskunasi (Artistic Media) - deganda nimani tushunasiz?
2. Kalligrafiya rejimi (Calligraphis)da qanday chiziqlami chizish mumkin.
3. Ob vektlami purkash nima ?

Test savollari
1. Corel Draw dasturida muvqabun rejimi 
(Brush) nkna?
A) bu rejimda murakkab tuzilishga ega bo'lgan bczaldi 
shakllami yaratish mumkin.
B) kontur trayektoriyalari boylab turli grafik 
ob’yektlami joylashtiradi. Bu rejim murakkab 
ramkalar. bezakli qatorlami yaratish uchun 
moijallangan
C) bu igimda qalin pero yoki enli muyqalam egri 
chiziqlanni chizish mumldn.
D) bu rejimda shunday chiziqlami chizish mumkinld, bu 
chiziqlami klaviatura orqali boshqarish mumkin

2. Corel Draw dasturida Purkagich rejimi (Object 
Sprayer) nima?
A) kontur trayektoriyalari bo^ylab turli grafik 
ob’yektlami joylashtiradi. Bu rejim murakkab 
ramkalar. bezakli qatorlami yaratish uchun 
moijallangan.
B) bu rejimda murakkab tuzilishga ega boigan bezakli 
shakllami yaratish mumkin.
C) bu rejimda qalin pero voki enli muyqalam egri

6. Corel Draw dasturida Perspective eflekti 
nima?
A) barcha haqiqiy predmetlarni biz tasvirda 
ko‘ramiz. Insoniyat ko‘rish qobiliyati shunday 
yaratilgan. Chiziqli qonunga koia kuzatuvchidan 
ma’lum bir masola bilan predmetlar kichik 
tuyuladi: predmet elementi qancha uzoqda 
joylashgan boisa, shunchalik biz uni kichik 
ko‘ramiz.
B) qadamli oiishlarda, o‘zgarishlar (shakl yoki 
rang) yoki ob’yekt o‘zganshlarida uni oraliq 
transformatsiya deb nomlanib, bu eflektni ikkita 
ob’yekt yoki ob’yektlar guruhi orasida, oreollar 
orasida, ochiq yoki yopiq konturlarda yoki standart 
ob’yektlarda o‘matish mumkin.
C) ob’yektni uch o‘lchamli namoyon boiishi joriy 
ob’yektga yon qirralami qo‘shish bilan amalga 
oshiriladi.
D) bu rejimda shunday chiziqlami chizish mumkinki bu 
chiziqlami klaviatura orqali boshqarish mumkin

7. Corel Draw dasturida Extrude (Ekstruziya)
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clu aq ian n i chizisli mumkin
pj bu rejimda shunday chiziqlami ehizish mumidnki bu 
chiziqlam i klaviatura orqali boshqarish mumkia

3. Corel Draw dasturida Kaffignifiya rejimi 
(Saffigraphis) nima?
A) bu rejinvia qalin реш voki enli muyqalam egri 
chiziqlarini ehizish mumkia
B) kontur trayektoriyalari bo'ylab turli grafik 
ob’vektlaini jovlashtiradi Bu rejim murakkab 
ranikalar, bezakli qatoriarai yaratish uchun
mo'ljallangan
Q  bu rejimda murakkab tuzilisliga ega bo'lgan bezakli 
shakllami yaratish mumkia
D) bu rejimda shunday chiziqlami ehizish mumkinki bu 
chiziqlami klaviatura orqali boshqarish mumkia

4. Corel Draw dastuiida Rgessure rejimi nima?
A) bu rejimda ahunday chiziqlami ehizish mumlanki bu 
chiziqlami klaviatura orqali boshqarish mumkia
B) kontur trayektoriyalari bo'ylab turli grafik 
ob’yektlami jovlashtiradi. Bu rejim murakkab 
ranikalar, bezakli qatoriarai yaratish uchun 
mo'ljallangan
C) bu rejimda murakkab tuzilisliga ega bo'lgan bezakli 
shakllami yaratish mumkia
D) bu rejimda qalia реш yoki enli muyqalam egri 
chiziqlarini ehizish mumkia

5. Corel Draw dasturida Blend (перетекание) 
eflekti nima?
A) qadamli o‘tishlarda, o‘zgarishlar (shakl yoki 
rang) yoki ob’yekt o'zgarishlarida uni oraliq 
transformatsiya deb nomlanib, bu effektni ikkita 
ob’vekt yoki ob’yektlar guruhi orasida, oreollar 
orasida, ochiq yoki yopiq konturlarda yoki standart 
obvektlarda o‘matish mumkin.
B) barcha haqiqiy predmetlarni biz tasvirda 
ko‘ramiz. Insoniyat ko'rish qobiliyati shunday 
yaratilgan. Chiziqli qonunga ko ra kuzatuvchidan 
ma’lum bir masofa bilan predmetlar kichik 
tuyuladi: predmet elemeati qancha uzoqda 
joylashgaa bo'lsa, shunchalik biz uai kichik 
ko‘ramiz.
C) ob’yektni uch o‘lchamli namovoa bo'lishi joriy 
ob vektga yon qirralami qo‘shish bilaa amalga 
oshiriladi
D) bu rejimda iiunday chiziqlami ehizish mumkinki bu 
chiziqlami klaviatura orqali boshqarish mumkia

eflekti nima?
A) ob’yektni uch o‘lchamli namoyon bo'lishi joriy 
ob’yektga yon qirralami qo'shish bilan amalga 
oshiriladi.
B) barcha haqiqiy predmetlarni biz tasvirda 
ko'ramiz. Insoniyat ko'rish qobiliyati shunday 
yaratilgan. Chiziqli qonunga ko‘ra kuzatuvchidan 
malum bir masofa bilan predmetlar kichik 
tuyuladi: predmet elementi qancha uzoqda 
joylashgan bo'lsa, shunchalik biz uni kichik 
ko'ramiz.
C) qadamli o'tishlarda. o‘zgarishlar (shakl yoki 
rang) yoki ob’yekt o'zgarishlarida uni oraliq 
transformatsiya deb nomlanib. bu effektni ikkita 
ob’yekt yoki ob’yektlar guruhi orasida. oreollar 
orasida. ochiq y'oki yopiq kontuiHarda yoki standart 
ob’yektlarda o‘rnatish mumkin.
D) bu rejimda shunday chiziqlami ehizish mumkinki bu 
chiziqlama klaviatura orqali boshqarish mumkin

8. Corel Draw dasturi eksport jarayoni to'gTi 
keltirilgan javobni toping?
A) Файл > Экспорт... > Экспорт
B) Файл > Импорт... > Импорт
C) Правка > Экспорт... > Экспорт
D) Файл > Импорт ..> Экспорт

9. Corel Draw dasturida Эффекты menyusi 
vazifasi nima?
A) yaratilgan tasvirlar ustida maxsus effektlar 
qo‘shadi.
B) nuqtali tasvirlar ustida amallar bajaradi.
C) matnlar bilan ishlaydi
D) dasturda ishlash uchun ma’lumot olish 
imkoniyatini beradi

10. Corel Draw dasturida Текст menyusi 
vazifasi nima?
A) matnlar bilan ishlaydi
B) yaratilgan tasvirlar ustida maxsus effektlar 
qo'shadi.
C) nuqtali tasvirlar ustida amallar bajaradi.
D) dasturda ishlash uchun ma’lumot olish 
imkoniyatini beradi.
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20-§. Adobe Photoshop dasturi va uning imkoniyatlari

Tayanch tushunchalar: Фат menyusi, Правка menymi, Изображение menyusi, 
Слой menyusi, Выделить menyusi. Фильтр menyusi, Bud menyusi, Окно menyusi, 
Помощь menyusi.

Adobe Photoshop Windows muhitida ishlovchi elektron ko rinishdagi foto 
tasvirlarni tahrir qiluvchi dasturdir. Adobe Photoshop dasturi Adobe System, Inc 
kompaniyasi tomonidan ishlab chiqarilgan boiib. ishlatishdagi aiohida qulayliklari 
bilan mashhur hisoblanadi.

Adobe Photoshop grafik muharnri yordamida fotosuratlarga qo'shimchalar 
kiritish, fotosuratdagi dogiami o‘chirish va eski rasmlami qayta ishlash va tiklash. 
rasmlarga matn kiritish, qo‘shimcha maxsus effektlar bilan boyitish, bir fotosuratdagi 
elementlarni ikkinchi fotosuratga olib oiish, ranglarni o‘zgartirish, almashtirish 
mumkin. Adobe Photoshop imkoniyatlari keng qamrovli boiib, u gazeta va 
jumallami turli-tuman rasmlar bilan boyitishda juda katta qulayliklar yaratadi.

Adobe Photoshop ayniqsa dizavnerlar, rassomlaming ijodiy imkonivatlarini 
to ia  amalga oshirishlarida yordam beradi. Turli sohalar va bevosita matbuot yoki 
nashriyot sohasiga aloqador boigan shaxslaming mazkur dastur bilan ishlashni 
bilishi ular uchun qo'shimcha imkoniyatlami varatib beradi. Adobe Photoshop juda 
murakkab dasturdir. Foydalanuvchilar uning asosiy imkoniyatlaridangina 
foydalanadilar xolos.

Dastumi ishga tushirish ketma-ketligi quyidagicha: Windows 95, 98, ME, 
2000, XP yoki NT operatsion tizimlarida Start (Пуск) tugmasi ustida sichqoncha 
chap tugmasini bosing Programs (Программы) boiimiga kiring so‘ngra Adobe 
Photoshop elementi ustiga yana sichqoncha chap tugmasi bilan bosing. Bundan 
tashqari ish stolida mavjud Adobe Photoshop uchun maxsus belgida sichqonchaning 
chap tugmasi ikki marta bosish vo ii bilan ham dastumi ishga tushirish mumkin.

Adobe Photoshop dasturidan chiqish uchun quyidagi usullaming biridan 
foydalanish mumkin:

Alt + F4 tugmalarini bosish.
Файл menyusining Выход buyrugini tanlash.
Ekranning yuqori qismi o‘ng burchagida joylashgan x belgili tugmachani 

bosish voki Файл > Закрыть buyrugini berish kerak:
Dasturning har bir versiyasi o‘zida vangi elementlarni mujassamlantirgan.
Adobe Photoshop dasturi oynasi qismlari. Adobe Photoshop dasturi ishga 

tushirilgandan so‘ng ekranda Adobe Photoshop tasvimi tahrir qiluvchi oynasi hosil 
boiadi. Adobe Photoshop oynasining yuqori qismida sarlavha satri va Windowsga 
xos elementlar joylashadi. Sarlavha satridan so‘ng menyu satri joylashadi. 
Menyudagi kerakli buy ruqlami tanlashingiz mumkin. Adobe Photoshop dasturi har 
bir menyu tarkibida ochiladigan menyu bandlari mavjud. Ulami koTish kursor 
yordamida amalga oshiriladi. Menyu quyidagi boiimlardan iborat2*:

28Евгении Тучкевич. Adobe Photoshop CS6. Мастер-класс. — СПб.: БХВ-Петербург, 2013. —
34 c.
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File (Файл) menyusi quyidagi holatlarda ishlatiladi: varatish (создать), ochish 
(открыть), joylashtirish (разместить), yopish (закрыть), saqlash (сохранить), 
skanerlash (отсканеровать), import va eksport, tasvimi qog‘ozga chiqarish 
(напечатать изображение), faylni tarmoq orqali uzatish (передать файл по сети), 
bir nechta optsiyalami avtomatlashtirish uchun va albatta Photoshop dasturidan 
chiqish uchun.

4.4-jadval. Dastur Файл menyusi va undagi buyruqlar
Файл (File) menyusi buyruqlari

Новый (Ctrt-N) Yangi fayl yaratish
Открыть (Ctrl+O) Bu buyruq yordamida diskda mavjud fayllar ochiladi
Открыть как 
(Alt+Ctrl+O)

Faylni qanday ko‘rinishda ochishni tanlash

Сохранить (Ctrl+S) Faylni xotiraga mavjud formatda yozish (saqlash)
Сохранить как 
Shift+Ctrl+S

Faylni xotiraga boshqa nom bilan yozish. Ushbu 
buyruq fayl nomi, format va joylashgan papkasi kabi 
atributlarini o'zgartirishda foydalaniladi

Сохранить Копию 
(Alt+Ctrl+S)

Tasvir nusxasini xotiraga yozish

Вернуть Tasviming dastlabki holatiga qaytish
Поместить Boshqa mustaqil fayl bilan birlashtirish
Импорт Boshqa papkada joylashgan faylni Adobe Photoshop 

dasturiga olib kirish
Экспорт Tasvimi boshqa papkaga jo‘natish
Файл информация Fayl haqidagi ma'Iumotlami kiritish
Установка страницы 
(Shift+Ctrl+P)

Tasvimi printer yordamida chop etishga tayyorlash, 
qog‘oz shaklini tanlash

Печать (Ctrl+P) Tasvimi printerga jo‘natish (chop etish)
Предпочтения Adobe Photoshop dasturini kerakli tartibda sozlash
Настройка цвета Tasvir ranglarini sozlash
Adobe online Internet bilan bogianish
Выход (Ctrl+Q) Adobe Photoshop dasturidan chiqish

Edit (Правка) menyusida, tasvimi tahrirlash ya’ni sozlash uchun buyruqlar. 
nusxalash (копирования), o'zgartirish (трансформации), joylashtirish va tasvir
ranglarini tusini va muyqalam qalinligi va turini tanlash mumkin.
_____________________________________ 4.5-jadval. Dastur Правка menyusi va undagi buyruqlar

ПРАВКА (Edit) menyusi
Берн (Ctrl+Z) Tasvir ustida bajarilgan oxirgi amalni bekor qilish
Резать (Ctrl+X) Tasviming ajratilgan qismini buferga (xotiraga) olish
Копировать (Ctrl+C) Nusxa olish
Вставить (Ctrl+V) Buferdan (muvaqqat xotiradan) kursor ko‘rsatgan joyga 

qo‘yish
Вставить
(Shift+Ctrl+V)

Buferdan (muvaqqat xotiradan) belgilangan joyga qo"yish
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Очистить Tasvirda belgilangan mavdonni tozalash, o‘chirish. Bunda 
o‘chirilgan maydon fon rangiga bo‘yaladi.

Залить Штрих Tasvir yuzini asosiv rang bilan bo'vash
Трансформация
(Ctrl+T)

Tasvirda belgilangan maydonni shtrixlab ko'rsatish

Трансформ Tasvir shaklini o‘zgartirish. Tasvir shaklini turli 
ko'rinishlarda o‘zgartirish

Очистка «История» darchasida tasvir olib borilgan o‘zgartirish 
amallarini butunlay o‘chirish. Bu amal bajarilgandan 
so‘ng o‘zgartirishlami ortga qaytarish mumkin emas

Image (Изображения). Buyruqlari tasvimi o‘zgartirish uchun moijallangan 
boiib — rang modellari, rang va uning och-to'qligmi tuzatish buyruqlarini o'z ichiga
oladi.
_______________________________4.6-jadval. Dastur Изображение menyusi va undagi buyruqlar

ИЗОБРАЖЕНИЕ (Image) menyusi
Режим Rang modellarini o‘zgartirish
Настройка Tasvir ranglarini sozlash
Дубликат Tasvirdan nusxa olish
H&i ожить 
изображение

Tasvimi qo‘shimcha ranglar bilan boyitish

Вычисление Tasvirdagi ranglar kanallarini o‘chirish
Размер изображения Tasvir shaklini va oichamlarini o‘zgartirish
Размер холста Tasvir ramkasi oichamlarini o‘zgartirish
Обрезание Belgilangan may dondagi tasvimi kesib olish
Переверну ть Холст Xolstni soat strelkasi boylab yoki soat strelkasiga qarshi 

180°, 90° burish
Гистограмма Tasvirdagi ranglar miqdori haqidagi ma lumotlar darchasi

Layer (Слой) menyusida joylashgan buyruqlar, bir necha qatlamlarda 
joylashgan tasvir ustidagi amallar ya’ni: qatlamlararo bogianishni qatlamlar ketma-
ketligini va qatlamlami umumiy qatlamga birlashtirish imkoniyatini beradi. 
_______________________________________ 4.7-jadval. Dastur Слой menyusi va undagi buyruqlar

СЛОИ (Layer) menyusi
Новый yangi qatlamni hosil qilish
Дубликать слоя qatlam nusxasini hosil qilish
Удалить слой mavjud qatlamni xotiradan o^chirish
Эффекты qatlamga turli effektlami qo‘shish
Г руппа с qatlamlami bir-biriga birlashtirish
предыдущим
(Ctrl+G)
Разгру пировать 
(Shift+Ctrl+G)

qatlamlami bir-biridan ajratish

С клеть все слои mavjud barcha qatlamlami birlashtirish
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Select (Выделить) menyusida joylashgan buyruqlar -  kerakli qatlamlami 
tanlashda (belgilashda) ishlatiladi.
______________________________________ 4.8-jadval. Dastur Выбор menyusi va undagi buypiqbr

ВЫБОР (Select) menyusi
Bee (Ctrl+A) tasvimi belgilash
Убрать выделение 
(Ctrl+D)

tasviming belgilangan qismini xotiradan o'chirish

Выделить заново qavtadan belgilash
Обратно Sift+Ctrl+I) so'nggi bajarilgan amalni qaytarish
Цветовой ряд 
(Shift+Ctrl+D)

tasvirdagi ranglar asosida belgilash maydonini aniqlash

Модифицировать belgilash chizig'ini piksellarda kengaytirish
Увеличить belgilash may donini kengaytirish
Преобразовать
выделение

belgilangan mavdon shaklini o'zgartirish

Сохранить
выделение

belgilangan mavdon shaklini xotiraga joy lashtirish

Filter (Фильтр) meny usi o'zida tasvirlami birlashtirish va umumiy holga 
keltirish uchun kerakli boigan filtrlari mavjuddir.
_____________________________________ 4.9-jadval. Dastur Фильтр menyusi va undagi buyruqlar

ФИЛЬТР menyusi
Последние фильтр Foy dalanuvchi tomonidan oxirgi ishlatilgan filtmi 

qo'llash.
Заточка >
Пиксели > O'matiladigan filtrlar ro'yxati
Пятно >
Стили >
Ш \м >
Другое > Boshqa filtrlar

View (Вид) menyusidagi buy ruqlar, ekrandagi tasvimi ko'rinishlarini va dastur 
oynasi qismlarini nazorat qiladi.

4.10-jadval. Dastur Вид menyusi va undagi buyruqlar
ВИД (View) menyusi

Новый вид Asosiy tasvimi yangi darchada ochish
Увеличить (Crtl++) Tasviming ekrandaga ko'rinishini kattalashtirish

Window (Окно) menyusi buyruqlari, ekrandagi boshqa tasvirlami aks ettiradi 
va ulardan kerakli bo'lgan paytda foydalanish imkonini beradi.
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4.11-jadval. Dastur Окно menyusi va undagi buyruqlar

ОКНО (Window) menyusi
Доку менты > Ochilgan huiiatlar (rasmlar) ro'yxati
Рабочее 
пространство >
Инструменты_______
Опции_____________
Браузер файла_______  Ornatilish va va aksincha takror berilganda olib
Навигатор___________ tashlanishi mumkin bo'lgan dastur oynasi qismlari
Информация________
Цвет_______________
Образчики__________
Стили______________
История____________
Действия___________
Предустановки
инструмента________
Слои_______________
Каналы____________
Пути_______________
Кисти______________
Символ____________
Параграф___________
Строка состояния_____________________________________________

Help (Помощь) menyusidagi buyrugiar foydalanuvchi uchun kerakli bo‘lgan 
maslahatlar orqali ko'mak va hozirda bajarish mumkin bo‘lgan imkoniyatlar bilan 
tanishtiradi hamda Photoshop yaratuvchilari rasmiy saytiga murojaat qilish 
imkoniyatini beradi.

4.12-jadval. Dastur Помощь menyusi va undagi buyruqlar
ПОМОЩЬ (Help) menyusi

Помощь Photoshop FI Photoshop dasturi bo'yicha vordam ma'lumot olish
О программе 
Photoshop

Photoshop dasturi haqida ma’lumot olish. Unda 
dastuming nomi versiyasi ishlab chiquvchilar haqida 
ma’lumot beriladi.

System info.... Foydalanuvchining kompyuteri haqidagi ma’Iumotlami 
ko‘rsatadi.

Updates .... Intemetga ulanish orqali Photoshop dasturini yangilash 
imkonini beradi.

Registration ... Adobe Photoshop dasturini ro'yxatdan o tkazish
Adobe Online ... Adobe kompaniyasining web-saytini ochib beradi.
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Adobe Photoshop dasturida jami 46 ta uskunalar mavjud boiib, ulardan 20 tasi 
bevosita dastur ishga tushirilganda darchada ko‘zga tashlanib turadi. Qolganlarini esa 
qo‘shimcha buymqlami bajarish orqali ishga tushirish mumkin. Agar uskunalar 
panelida joylashgan tugmaning ostki qism o‘ng burchagida kichik uchburchak shakli 
tasvirlangan boisa, bu tasvir ushbu tugma tarkibida o xshash buymqni bajaruvchi 
uskunalar yashiringanligidan darak beradi.

Yashiringan uskunani faollashtirish uchun kursomi maxsus belgili tugma 
ustidan sichqonchaning chap tugmasini bosgan holda uskunalar panelidan tashqariga 
olib chiqiladi va kerakli tugma ustida kursomi keltirilib sichqonchaning chap tugmasi 
qo‘vib vuboriladi.

Har bir tugmaga kursor yaqinlashtirilsa, kursor belgisi ostidagi uskunaning 
qanday vazifani bajarishi haqidagi axborot paydo boiadi. Quyida Adobe Photoshop 
dasturida ishlash jarayonida keng qoilaniladigan uskunalaming qisqacha tavsifi 
keltiriladi.

Прямоугольная Область. Tasvirda to‘g‘ri to‘rtburchak shaklidagi 
maydonni belgilab olish uchun qoilaniladi. Bu uskuna yordamida tasvirdagi aiohida 
maydonni belgilab olmgandan keyin tasvirga kiritilgan barcha 0‘zgarishlar faqat 
belgilangan may don ichiga ta’sir etadi. Ushbu tugmaga qo‘shimcha tarzda Shift 
klavishi ishlatilsa, belgilangan maydon hududi ortadi. Shift klavish o‘mida Alt 
klavishi qoilanilgan taqdirda belgilangan maydon hududi qisqaradi. Ushbu amal 
JIacco va Волшебная палочка uskunalari bilan ishlashda qoilaniladi.

Эллиптическая Область: Tasvirda doira shaklidagi maydonni belgilab olish 
uchun qoilaniladi. Bu uskuna yordamida tasvirdagi aiohida maydonni belgilab 
olingandan kevin tasvirga kiritilgan barcha o'zgarishlar faqat belgilangan maydon 
ichiga ta’sir etadi.

Строка пикселей: Tasvirda gorizontal shakldagi chiziqni belgilavdi.
Столбец пикселей: Tasvir yuzida vertikal chiziqni belgilaydi.
Кадрирование: Ushbu uskuna asosan. tasvir chetlarini va keralksiz qismlarini 

kesib tashlash uchun qoilaniladi. Bu buyruq faollashtirilganda tasvir yuzida to‘g‘ri 
to'rtburchak shaklidagi ramka hosil boiadi. Ramkaning chetlari kichik 
kvadratchalardan iborat boiib, bu kvadratchalar yordamida ramka hajmi 
o‘zgartiriladi. Tasvir ramka ostiga olingandan so‘ng Enter klavishi bosilsa ramka 
tashqarisida qolgan ortiqcha boiaklar kesib tashlanadi. Ushbu buyruqni Esc 
klavishini bosib rad etish mumkin.

Перемещение: Ushbu uskuna tasvirdagi belgilangan maydonni yoki qatlamni 
siljitish va kesib olish uchun xizmat qiladi. Ba zan Перемещение buvrug'ini 
bajaradigan ayni jarayonni boshqa ayrim uskunalar (masalan, Волшебная палочка 
uskunasi) yordamida ham amalga oshirish mumkin.

Лассо: tasvirdagi turli shakldagi ob’yektlami belgilash uchun ishlatiladi.
Многоугольное лассо: Asosan tasvirdagi to‘g‘ri chiziqlardan iborat 

ob’yektlami belgilashda ishlatiladi. Alt klavishasi bilan qoilanilganda oddiy Лассо 
uskunasi vazifasini bajaradi.
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Магнитное лассо: Bu uskuna ishlatilganda Adobe Photoshop dasturi 
tasvirdagi ob'yekt chegaralarini o'zi belgilaydi. Ammo bu uskuna piksellardagi 
ranglami o'zgarishiga bog'liq tarzda chegaralami aniqlashi bois kam qoilaniladi.

Волшебная палочка: Bir-biriga yaqin bo'lgan rangdagi piksellar joylashgan 
maydonni belgilaydi. Shift bilan birgalikda qo'llansa belgilangan maydon hajmi 
ortadi. Alt bilan ishlatilganda esa belgilangan maydon hajmi kamayadi.

Аэрограф: Tasvimi bo'yashda ishlatiladi. Aerografm bir joyda ushlab turish 
siyohni tasvir bo'ylab yoyilib ketish effektini beradi. Bo‘yoqning tasvir bo'ylab 
oqishi kursomi qo‘yib уubormaguncha davom etadi. Odatda bu uskuna bilan 
yumshoq muyqalamlar ishlatiladi. Aerograf kursomi ushbu uskuna ustida bosish yoki 
klaviaturadagi J klavishni bosish orqali faollashtiriladi.

Кисть: Aerograf uskunasi kabi tasvimi bo'yashda ishlatiladi. Ammo Кист 
yordamida tasvimi sifatli bo'yash mumkin. Bu uskuna aerografga nisbatan ko'p 
qo'llaniladi. Кист uskunasini В klavishini bosish orqali faollashtirish mumkin. 
Brushes darchasi yordamida bo'yoq mo'yqalamlarining shaklini o'zgartirish 
mumkin.

Штамп: Tasvirdagi kichik bir boiak nusxasini kochinsh uchun ishlatiladi. 
Bu uskuna tasvirdagi ayrim nuqsonlami. doglami yo'qotish va eski rasmlami 
tiklashda keng qo'llaniladi.

Кисть предыдущих состояния: Bu uskuna tasvir haqidagi dastlabki 
ma lumotlar asosida ishlaydi. Uning yordamida tasvirga kiritilgan so'nggi 
o'zgartirishlami bekor qilish mumkin.

Ластик: Tasvimi o'chirish uchun ishlatiladi. U qo'llanganda tasvirda fon 
qaysi rangda boisa, osha  rangdagi chiziqlar hosil bo'ladi. Alt klavishini qoilash 
yordamida kompyuter xotirasiga olinmagan so'nggi o'zgartishlami bekor qilish 
mumkin. Lastik uskunasi E klavishini bosish orqali faollashtiriladi.

Карандаш: Turli chiziqlami ehizish uchun foydalaniladi. Alt klavishi 
bosilganda kursoming ekrandagi tasviri o'zgaradi va bevosita tasvirdan kerakli rangni 
tanlash mumkin. Bu amal bajarilgandan so'ng Карандаш uskunasi o sha rangda 
chiziq tortadi.

Линия: To'g'ri chiziqlami chizishda qo'llaniladi.
Размывка: Ushbu uskuna ishlatilganda, tasvirdagi yorqinlik pasayadi. Alt 

klavishi bilan qo'llanganda yorqinlik ortadi.
Резкость: Ushbu uskuna ishlatilganda tasvirdagi yorqinlik ortadi. Alt klavishi 

bilan qo'llanganda esa tasvir xiralashadi.
Палец: Tasvirdagi ranglar chayqaltirib, tasvirdagi ob'yektlar ortasidagi 

chegaralami bir-biriga qo'shishga xizmat qiladi.
Осветитель: Piksellardagi ranglar yorqinlashadi. Alt klavishi bilan 

qo'llanganda esa piksellardagi ranglar xiralashadi.
Заменитель: Tasvir ustida harakatlantirilganda piksellardagi ranglar qoramtir 

tus oladi.
Губка: Tasvir ustida harakatlantirilganda, tasvirdagi ranglar miqdori pasayadi. 

Губка bir joyda ko’p harakatlantirilsa tasviming o'sha joyi kul rang tus oladi.
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Перо: Peroni tasvir ustida harakatlantirilganda, nuqtalar hosil boiadi. Ushbu 
nuqtalar yordamida chizilgan tasvimi o'zgartinsh mumkin.

Магнитное перо: Bu uskuna xuddi Магнитное JIacco kabi harakatlanadi. 
Biror-bir tasvirdagi obyekt atrofida harakatlantirilganda, Adobe Photoshop 
dasturining o‘zi ob’yekt chetlarim belgilab chiqadi.

Произвольное перо: Juda qulay uskuna boiib? xohlagan shakldagi tasvimi u 
yordamida ifodalash mumkin.

Вставить точку: Bu uskuna pero yordamida chizilgan chiziq ustiga 
qo‘shimcha nuqtalami qo‘shadi.

Удалить точку: Pero yordamida chizilgan chiziq ustidagi ortiqcha boigan 
nuqtalami o chiradi.

Непосредственное выделение: U yoki bu pero bilan chizilgan chiziqlami 
tahrir qilish uchun xizmat qiladi. Uning yordamida chiziqdagi nuqtalami yakka 
tartibda harakatlantirish va kerakli joyga siljitish mumkin.

Преобразовать точку: Tasvir ustida chizilgan chiziqchalarda o‘matilgan har 
bir nuqta, burchak yoki yoy vazifasini bajaradi. Ushbu uskuna yordamida 
nuqtalaming vazifalarini o'zgartirish, ya’ni voyni burchakka va burchakni vovga 
almashtirish mumkin. Buning uchun kursomi nuqta ustiga olib borib sichqonchaning 
chap tugmasi bir marta bosiladi.

Текст: Ushbu uskuna yordamida tasvirga turli matnlarni kiritish mumkin. 
Текст uskunasi faollashtirilib, kursor tasvir ustida bosilsa, matn kiritish uchun 
alohida darcha hosil boiadi. Bu darchada harf o‘lchami, turi, rangi va boshqa 
ko rsatkichlari kiritiladi. Bu uskuna yordamida kiritilgan matnni qayta tahrir qilish 
imkoni mavjud emas

Текст-маска: Текст uskunasi kabi bu uskuna faollashtirilib, matn ustida bir 
marta bosilganda, Текстовый инструмент darchasi hosil boiadi. Lekin bu matn 
oddiy matndan tubdan farq qiladi. Harflaming cheti xuddi Lasso uskunasida belgilash 
kabi ko‘rinishga ega boiadi. Harflami turli ranglarga bo‘yash va Перемещение 
uskunasi yordamida o‘midan siljitish yoki boshqa rasmga olib o'tish mumkin.

Вертикальный текст: Agar tasvirga pastdan yuqoriga shaklda (vertikal 
shaklda) matn kiritmoqchi boisangiz ushbu uskunadan foydalanishingiz mumkin.

Вертикальная текст-маска: Xuddi Tekst-maska uskunasi kabi bir xil 
vazifani bajaradi. Ammo bu uskuna qoilanganida harflar ustma-ust ustun kabi 
joylashtiriladi.

Измеритель: Tasvirda turli oichoviami bajarish uchun ishlatiladi. Bu uskuna 
bilan bir nuqtadan ikkinchi nuqtaga kursor olib boriJishi kifoya Shundan so'ng dastur 
avtomatik tarzda ikki nuqta orasidagi masofani oichaydi.

Градиент: Bu uskuna ishlatilganda, tasvirdagi belgilangan maydonda ranglar 
kombinatsiyasi hosil boiadi. Asosiy rangning tasvir foniga sizib o‘tish effekti hosil 
boiadi.

Ковш: Ushbu uskunadan asosan. tasvimi yoki tasvirdagi ajratib olingan 
hududni bo'yashda foydalaniladi Ranglami qo shimcha buyruqlami bearish orqali 
tanlanadi. Bu uskunani faollashtirish uchun К klavishi bosiladi.
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Пипетка: Tasvirdagi asosiy yoki tasvir foni rangini o'zgartiradi. Pipetkani 
tasvir ustidagi biror nuqtada bosish bilan o‘sha nuqtadagi, ya ni pikseldagi rang 
asosiy (faol) rang sifatida tanlanadi. Agar ayni jarayonga Alt klavishasi qo'shilsa 
tanlangan rang tasvir fonini o'zgartirishiga olib keladi.

Выборка цветов: Ushbu uskuna tasvirdagi ranglar haqida axborot olishga 
xizmat qiladi. Info darchasida belgi qo'yilgan nuqtada necha foiz qizil, ko'k va qora 
ranglar mavjudligi haqidagi axborot hosil bo'ladi.

Рука: Tasviming ko'zga tashlanmay turgan qismlarini ko'rsatadi. Buning 
uchun ushbu uskuna faollashtirilib tasvir ustida sichqonchaning chap tugmasini 
bosgan holda kerakli tomonga harakatlantiriladi. Ayni jaravonm Adobe Photoshop 
dasturi darchasidagi Navigator yordamida ham amalga oshirish mumkin.

Масштаб: Tasvimi kattalashtirish yoki kichraytirib ko'rsatish uchun xizmat 
qiladi. Agar ushbu uskuna bilan birgalikda Alt klavishasi ishlatilsa, tasvir kichrayadi. 
Kursor ushbu uskuna faollashtirilgandan so'ng o'z shaklini o'zgartiradi va lupa 
ko'rinishini oladi. Kursor tasviming qaysi nuqtasida bosilsa Adobe Photoshop 
dasturi avtomatik tarzda o'sha nuqtani ekranga vaqinlashtiradi. Masshtab uskunasini 
faollashtirib, Enter klavishi bosilsa, Опция масштабирования darchasi ochiladi. 
Bu darchada maxsus to'rtburchak ichiga belgi qo'yilsa, tasvir o'lchamlari 
o'zgartirilganda tasvir darchasi ham mos tarzda o'zgaradi. Har safar tasvir 
o'lchamlarini kattalashtirish yoki kichraytirish uchun masshtab uskunasini 
faollashtirish zarur emas. Boshqa uskuna bilan ishlash paytida Ctrl+Probel bosilsa, 
ishlatilayotgan uskuna vaqtinchalik masshtab uskunasi vazifasini bajaradi va tasvir 
kattalashadi. Ctrl + Probel o'mida Alt+Probel qo'llanilsa, tasvir o'lchami kichrayadi. 
Shuningdek, tasvir o'lchamini Ctrl + + (plyus) klavishlari yordamida kattalashtirish 
yoki Ctrl-*- - (minus) yordamida kichraytirish mumkin. Adobe Photoshop dasturi 
darchasi ostida Строка состояния satrida tasvir o'lchamlari haqida axborot beruvchi 
maxsus darcha mavjud. Bu darchada tasvir o'lchamlari sonlarda ifodalangan. Ushbu 
sonlami o'zgartirish orqali tasviming aniq o'lchamlari kiritiladi.

Основной цвет: Ushbu uskuna ustida kursor ikki marta ketma-ket bosilganda 
Adobe Photoshop dasturining yangi darchasi (Выбор цвета) hosil bo'ladi. Bu 
darchada kerakli rang tanlanib, OK yoki Enter tugmasi bosiladi va tanlangan rangni 
Карандаш, Кисть, Аэрограф, Градиент kabi uskunalari yordamida qo'llash 
mumkin. Цвет фона: Ushbu tugma ustida sichqoncha chap tugmasi ikki marta 
ketma-ket bosilganda Adobe Photoshop dasturining yangi darchasi (Color Picker) 
hosil bo iadi. Bu darchada tasvir fonining rangi aniqlanadi. Tasvir fonidagi rang 
Наточка va Градиент uskunalari uchun qo'llaniladi.

Переключение цветов: Ushbu belgi ustida kursomi bosish bilan asosiy rang 
bilan tasvir foni ranglari o'mi almashtiriladi.

Цвета по умолчанию: Bu belgi ustida kursomi bir marta bosish bilan asosiy 
rang qoraga va tasvir foni ranglari oqqa ayianadi.

Марширующие муравьи. Bu tugma yordamida Adobe Photoshop dasturida 
tez niqoblash holati bekor qilinadi. Ekranda belgilash chegaralari chumolilar 
harakatini eslatuvchi punktir chiziq yordamida aks ettiriladi. Bu Adobe Photoshop 
dasturida odatda standart holat deb ataladi.
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Быстрая маска: Ushbu tugma ustida kursor bir marta bosilishi bilan Adobe 
Photoshop dasturi tez niqoblash holatiga o'tadi va natijada tasvirdagi niqoblanmagan 
hudud qizil rang bilan bo‘yaladi. Ushbu uskuna tasvirdagi turli ob'yektlami aniq 
niqoblashda ishlatiladi. Кист uskunasi yordamida niqobga ishlov bensh mumkin. 
Bunda qora rang bilan tasvir niqoblanadi, oq rang bilan tasvirdagi niqob o‘chiriladi.

Стандартное окно: Uskuna faollashtirilganda tasvir standart holatda boiadi.
Полный экран с меню: Bunday holat tasvir kompyuter ekraniga sig‘magan 

holda ishlatiladi. Ushbu uskuna faollashtirilganda ekranda faqatgina menyu satri 
hamda uskunalar paneli qoladi.

Полный экран: Ekranda faqat tasvir va uskunalar paneli hamda menyu satri 
qora fonda qoladi.

Tasvir o‘lchami. Adobe Photoshop dasturida ekranda tasviming barcha 
qismini yoki tasvirdagi kichik detallami ko‘rish uchun xohlagancha kattalashtirish 
yoki kichraytirish mumkin. Masalan, 100% - bu tasvirdagi piksellar soniga ekrandagi 
piksellar soni tengligini anglatadi. Ya'ni 1:1. 200%ga tasvir kattalashtirilganda 
ekrandagi bir pikselga katta miqdordagi piksellar miqdorini to‘g‘ri kelayotganligidan 
dalolat beradi.

MASHQ. Adobe Photoshop dasturida geometrik figuralar chizish 
Ishning maqsadi: Adobe Photoshop dasturida geometrik figuralar chizishni 
o‘rgatish.
Topshiriqni bajarish bo‘yicha metodik ko‘rsatma: Geometrik figuralar chizish 
uskunalari. Quyidagi uskunalar guruhi turli shakldagi geometrik shakllar chizish 
imkonini beradi (4.21-rasm).

i i  3  <3 о  о  /  *1 
_

4.21-rasm. Oddiy geometrik figuralar chizish uskunalari oilasi 
■ Rectangle Tool (U) (Прямоуголник) -  to‘g‘ri to‘rtburchak chizish imkonini 
beradi (Shift — klavishasini bosish bilan chizish kvadrat hosil qilish imkonini 
beradi). Bunda oldingi plan rangi quyiladi.
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■ Rounded Rectangle Tool (U) (Скругленный прямоуголник) yuqorida keltirilgan 
figuraga o xshash figura chizish imkonini beradi. Biroq unda to‘g‘ri to'rtburchak 
burchaklarini aylantirish radiusini kiritish imkonini beradi (parametrlar panelida 
Radius maydoniga kiritish orqali).
■ Ellipse Tool (U) (Эллипс) ayianalar chizish imkonini beradi (Shift — 
klavishasini bosish bilan birga chizilsa doira hosil bo iadi).
■ Poligon Tool (U) (Многоуголник) ixtiyoriy sondagi burchakli geometrik 
figuralar yaratish imkonini beradi. Shuningdek, ko'p nurli yulduzchalar ham hosil 
qilish imkonini beradi. Hech bir parametr o‘zgartirilmaganda esa qavariq 
beshburchak chizish imkonini beradi. Burchaklar soni esa parametrlar panelidagi 
Sides maydoni orqali beriladi.
■ Line Tool (U) (Линия) berilgan uzunlik, qalinlik, rang va yo‘nalishdagi to‘g‘ri 
chiziqlar chizish imkonini beradi. Chiziqning qalinligi parametrlar panelida Weight 
maydoni orqali aniqlanadi.
■ Custom Shape Tool (U) (Произвольная фигура) ixtiyoriy shakldagi geometrik 
figura yaratish imkonini beradi va uni keyinchalik qoilash uchun saqlab qo‘yish 
imkonini beradi. Bu uskunalar oilasining parametrlari paneli bir-biriga juda o‘xshash. 
Faqatgina o‘ng tomonda joylashgan figurani tanlash qismi maydonlari o‘zgaradi 
xolos. Shuningdek, Rounded Rectangl Tool modifikatorini tanlanganda bu yerda 
Radius (doira radiusi) maydoni joylashadi, Polygonal modifikatori uchun esa — 
Sides (kopburchakning tomonlar soni (burchaklar)) maydoni paydo boiadi. Custom 
Shape Tool modifikatori tanlanganda esa parametrlar panelining bu joyida Shape 
(Форма) yoyiladigan ro‘yxat paydo boiadi. Bu royxatdan zarur bir shaklni tanlash 
mumkin boiadi. Parametrlar panelining standart elementlari boiib rang quyish 
shakllari va chegara figuralari hisoblanadi. Yana shu yerda shaklni ko‘rsatish tipini 
belgilash mumkin.

MASHQ. Tasvir ustida har xil amallar bajarish 
Ishning maqsadi: Talabalarga tasvir ustida har xil amallar bajarishni o‘rgatish 
Topshiriqni bajarish bo‘yicha metodik kokrsatma: rasm oichamlarini o‘zgartirish. 
Tasvir oichamlarini ozgartirish uchun menvuning Image > Image Size 
(Изображение > Размер Изображения) buyrugi yordam beradi. Bu buyruq Image 
Size (Размер Изображения) muloqot oynasini ochib beradi (4.22-rasm)29.

Resample Image (Отслеживат изменения) bayroqchasi oinatilganligiga 
ishonch hosil qiling. Rasm eni va bo‘yi o‘rtasidagi nisbatni saqlash uchun Constrain 
Proportions (Сохранят пропорции) bayroqchasini olib tashlang. Pixel Dimensions 
(Размеры в пикселах) guruhiga Width (Ширина) va Height (Высота) parametrlari 
tegishli hisoblanadi. Eni vabalandligi bogiiqligi haqida zanjir zvenosi ko‘rinishidagi

29 Дунаев В. Photoshop CS6: Понятный самоучитель. — СПб.: Питер, 2013. — 91 с.
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piktogrammada dalolat beriladi Bu piktogramma qiymatlami kiritish maydonlaridan 
o‘ngda joylashgan. Rasm joriy o‘lchamlaridan kelib chiqib, o'lchamlar piksellarda 
voki protsentlarda o'matiladi.

Image See

Pstel Dmenaons: 2?,9M — — —  

Width: 3264 Pixels

Hagfrt: 2448 Paet л  ]*

l— g L -J
Cancel__j

Oocumer* See:

115,15 Centmeters ■»

86,36 Centimeters »

72 PtteWmch

Ш  Scale Styles 

№  Consbar Proportions 

Г / ResamcHe Image:

Bicutx Automatic

Nearest Neighbor (preserve hard edges} 
Bin ear
Bcubtc (best for smooth gradients) 
Bicubic Smoother (best for enbrgement) 
Bicubic Sharper (best for reduction)

4.22-rasm. Image Size muloqot oynasi 
Shu ovnada nafaqat hujjatdagi piksellar sonini balki uning o'lchamini ham 

o'zgartirish mumkin. Document Size (Размер документа) parametrlar guruhi 
hujjatning geometrik o'lchamini va sifatini (Resolution) o'zgartirish imkonini beradi. 
Joriy o'matilgan holatni tiklash uchun Image Size (Размер Изображения) oy nasida, 
Alt klavishasini bosing va bir vaqtda Reset (Восстановить) tugmasini bosing.

Rasmni aylantirish. Rasmni avlantirish imkonini menyudan Image > Image 
Rotation (Изображение>Вращение Изображения) buyrug'i amalga oshiradi. 
Menyuning ushbu punktini tanlagan holda burishning usullaridan birini tanlang. 
Menyuda 180°, 90° ga burish soat strelkasi yo'nalishi bo'yicha (90° CW) va 90° soat 
strelkasi yo'nalishiga teskari (90° CCW) tarzlarda burish mumkin. Menyudan Image
> Image Rotation > Arbitrary (Изображение > Вращение Изображения > 
Произволно) buyrug'i shaklni ixtiyoriv burchakka burish imkonini beradi. Undan 
tashqari, rasmni gorizontal (Flip Canvas Horizontal) va vertikal (Flip Canvas 
Vertical) bo'yicha oy nali aks ettirish imkoniyati mavjud (4.23-rasm)30.

50 Дунаев В. Photoshop CS6: Понятный самоучитель. — СПб.: Питер, 2013. — 208 с. 92-Ь.
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ьмлттшшятшят

90* CW

Trim...

Reveal АН Arbitrary...

Ouplkate.„
-  -  4 -

Ftip Canvas Horizontal
Apply Image... Fbp Canvas VerticalГ«1/иЫшт |11 Ii]in iinn irr.miiu II I - -г .
4.23-rasm. Menyuning Image>Image Rotation buy rug i

Joriy tasvir 180°gaburilgan

90° (CW)ga burilgan 90° (CCW)ga burilgan

4.24-rasm. Belgilangan burchakka rasmni burishga misollar31

27C°(CW)ga burilgan

31 Дунае* В Photoshop CS6: Понятный самоучитель. — СПб.: Питер. 2013. — 92 с.
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180 C°ga burilgan Gorizontal oynali (o'girib) aks ettirish
4.25-rasm. Oynali burishga misollar

Rasmni masshtabini o‘zgartirish. Juda ko‘p hollarda rasmning juda kichik 
fragmentini tahrirlashga to‘g‘ri keladi. Natijalar aniq boiishi, ishlash esa qulay 
boiishi uchun rasmni masshtabini o‘zgartirish imkoniyatidan foydalaning. 
Masshtabning joriy holati haqidagi axborot muharriming uchta joyida keltirilgan. 
Masshtab hujjat sarlavhasi qatorida qavslarda, rasm oynasi holat qatorining chap 
burchagida, shuningdek, Navigator (Навигатор) palitrasida koisatilgan. Bu 
masshtab rasmning oichamida, saqlanishiga yoki chop etishga berilganda umuman 
ta sir etmaydi. Adobe Photoshop CS6 dasturida rasm masshtabini o‘zgartirish uchun 
bir nechta usullar keltirilgan. Masalan, Zoom Tool (Масштаб) uskunasini qoilagan 
holda, faol ovnaning holat qatori chap burchagidagi qiymatni o'zgartirish. Bu 
sozlamalar faqat rasmga ta’sir koisatib, oyna oichamlari o‘zgarishsiz qoladi32.

Yana bir usuli — Navigator (Навигатор) palitrasi hisoblanadi. Masshtabning 
yangi qiymatlarini ushbu palitraning chap pastki burchagiga protsentlarda va nisbatiar 
ko‘rinishida (masalan, 1:1 yoki 1:4) kiriting. Keyin esa Enter klavishasini bosing. 
Agar ushbu maydonni faol tarzda saqlash kerak boisa. Shift+Enler klavishalar 
birikmasidan foydalaning. Rasmning ko‘ringan qismi masshtabini kamaytirish uchun 
Zoom out (Уменшит масштаб) tugmasini bosing. Rasmni ko'rinib turgan qismi 
masshtabini o‘zgartirish uchun Zoom slider (Ползунок масштабирования) 
polzunkasi joyini bu yoki u tomonga o'zgartirish (surib oikazing) kerak. Agar 
rasmni ko‘rinib turgan qismi masshtabini kattalashtirish kerak b o isa  Zoom in 
(Увеличит масштаб) tugmasini bosing. Ovnaga rasmni ko‘chirish uchun oynada 
hosil boigan ramkani «qo‘1» bilan surib keling. SHuningdek, parametrlar panelida 
joylashgan Zoom Level (Уровен масштаба) regulyatoridan ham foydalanish 
mumkin.

MASHQ. Adobe Photoshop dasturida tasvirga tuzatish kiritish
Ishning maqsadi: Adobe Photoshop dasturida tasvirga tuzatish kiritishni 

oigatish.
Topshiriqni bajarish bo‘yicha metodik ko Tsarina: Rasmni tuzatish ishlari.
Adobe Photoshop CS6 muharririda rasmni tuzatish uchun maxsus sozlamalar guruhi 
mavjud. U o‘z ichiga 16dan ortiq boshqaradigan-sozlamalami qamrab oladi. Ulaming 
barchasi menvuning Image>Adjustments (Изображение>Установки) buyrugida

33 Дунаев В. Photoshop CS6: Понятный самоучитель. — СПб.: Питер, 2013. — 95 с.
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joylashgan. Adobe Photoshop CS6 dasturida bu sozlamalar alohida Adjustments 
(Установки) palitrasiga o‘tkazilgan (4.26-rasm).

«4 X

Adjustments *§

A dd an a d ju stm e n t

• a t  m  f  g *  V

я  е ь  а  щ  a  s §

а  е э  я  m  а

4.26-rasm. Adjustments palitrasi

Ushbu palitraning tegishli piktogrammasini bosgan holda siz u yoki bu parametming 
zarur sozlamasini amalga oshirishingiz mumkin. Buning uchun muloqot oynasini 
ochish ham shart emas. Rasmni tuzatishning asosiy sozlamalarini ko‘rib chiqamiz. 
Yorqinlik va kontrastlik. Barcha grafik muharrirlari rasmni yorqinlik, kontrast va 
gammalarini sozlash uchun vositalarga ega. Adobe Photoshop CS6 dasturida 
menyuning Image > Adjustments > Brightness / Contrast (Изображение > 
Установка > Яркост / Констрастност) buyrug‘i yorqinlik va kontrastni boshqarish 
panelini ochib beradi (4.27-rasm). Unda yanada kuchliroq vositalar keltirilgan. Biroq 
bu oddiy uskunalar har qanday grafik muharrirda mavjud boiadi. Xattoki yorqinlik, 
kontrast va gammalarini sozlash MS Photo Editor panelining analogik ko‘rinishida 
ham mavjud33.

Brightness/Contrast H i

Brightness: 42 С 3и,,ш. _ _

Contrast: m
-  [  Cancel 3

a L .A uto.....3

Ej l»se Legacy У Preview
J

4.27-rasm. Brightness/Contrast oynasi 
Rasmlami koiish va tuzatishning mashhur ACDSee dasturlarida yorqinlikni, 

kontrastni va gammani boshqarishdan tashqari. oq va qora ranglami darajalarini 
berish mumkin. Aslida qora rang darajasi Oga teng, oq rang esa — 255ga teng 
boiadi. Masalan, oq ulushini pasaytiradi, katta yorqinlikka ega boigan piksellar, 
maksimal yorqinlikni ta minlab beradi. Analogik tarzda agar qora ulushini 
koiaradigan boisak, barcha qorong'u piksellar qoraga o'zgaradi. Yangi Auto 
tugmasiga e’tiboringizni qarating. U yorqinlik va kontrastni avtomatik sozlash

"Дунаев В. Photoshop CS6: Понятный самоучитель. — СПб.: Питер, 2013. — 97 с.
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imkonini beradi. Barcha keltirilgan sozlashlami tegishli palitradan ham amalga 
oshirish mumkin.

Darajalar va egilganlik. Yuqorida qaralgan rasmni tuzatish vositalari global 
hisoblanib, biroq sharoitga moslashmaydigan hisoblanadi. Ular tezkor qo'lda rasmni 
tuzatish uchun yaroqli hisoblanadi. Adobe Photoshop Extendedda professionallarga 
mashhur bo'lgan yana ikkita vosita mavjud — Levels (Уровни) va Curves (Кривые). 
Bu juda moslashuvchan uskunalar bo'lib, pikselgacha zichlikda rasmni yetarlicha 
aniq tuzatish imkonini beradi. Ulami meny uning Image> Adjustments 
(Изображение>Регулировки) buyrug'i orqali chaqiriladi. Ayrim foydalanuvchilar 
Levels (Уровни) uskunasini ma’qul ko'radi, boshqalari esa butunlay Curves 
(Кривые) uskunasini ma’qul ko'radi.

MASHQ. Adobe Photoshop dasturida yangi qatlam yaratish 
Ishning maqsadi: Talabalarga Adobe Photoshop dasturida yangi qatlam yaratishni 
o'rgatish.
Topshiriqni bajarish bo'yicha metodik ko‘rsatma: Yangi qatlam qanday 
yaratiladi. QatlamJami boshqarishning barcha elementlari asosan Layers (Слои) 
palitrasining pastki qismida joylashgan (4.28-rasm). Bu yerda yetita element mavjud 
bo'lib, yangi qatlam yaratish, kerak emas qatlamni o'chirish, qatlamdan nusxa olish 
va qatlamlar xususiyatlarini o'zgartirish imkonini beradi. 4.28-rasmda boshqaruv 
elementlari raqamlar bilan ko'rsatilgan34:

1 2 3 4 5 6 7

и и  e и и •*
4.28-rasm. Layers (Слои) palitrasi boshqaruv elementlari

1. Link Layers (Связат слои) hujjatning ikki yoki undan ortiq qatlamlarini bog'lash 
uchun mo'ljallangan. Oldindan barcha bog'lanadigan qatlamlami barchasini belgilab 
olish kerak.
2. Add a Layer style (Добавит стал слоя) joriy qatlam spetsifik stillarini yaratish 
uchun mo'ljallangan. Masalan, soyalar va yoritilganlik. Bunga teng kuchli 
menyusidan Layer>Layer S tylexO riw  слоя> buvrug'ini berish hisoblanadi. Layer 
Style (Стил слоя) muloqot oynasi ochiladi.
3. Add Layer Mask (Добавит маску слоя) joriy qatlamni niqoblash uchun 
mo'ljallangan.
4. Create New Fill or Adjustment Layer (Создать новое заполнение или 
регу лировки слоя) — joriy qatlamning yangi to'ldirish yoki yangi qatlamni sozlash 
imkonini beradi. Masalan, rang balansi va boshqalar.
5. Create a New Group (Создание новой группы) — qatlamlaming yangi guruhini 
yaratish.
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6. Create a New Layer (Создать новый слой) — yangi qatlamni yaratish (yoki 
nusxalash).
7. Delete Layer (Удалить слой) joriy qatlamni o‘chirish uchun moijallangan. Bu 
operatsiya hujjatda ikkitadan kam boimagan bekilmagan qatlamlar boigandagina
о rinli hisoblanadi. Normal (Нормалный) rejimida 100% noshafTof qatlam yaratish 
uchun Lay ers (Слои) palitrasi pastida joylashgan Create New Layer (Создать новый 
слой) tugmasini bosing.

Bu holatda hech qanday boshqa harakatlar talab qilinmaydi. Agar qatlamni 
yaratishda uning xususivatlarini berish talab qilinsa, menyudan Laver>New>Layer 
(Слой>Новый>Слой) buyrugini bering yoki Alt klavishasini bosgan holda Layers 
(Слой) palitrasi pastida joylashgan Create New Layer (Создать новый слой) 
tugmasini bosing. New Layer (Новый слой) muloqot oynasi ochiladi (4.29-rasm).

New Layer

Name; Я  1 OK 1

0  Use Previous Layer to Create Opprg Mask Cancel

Color: * None

Mode: Mormaf * Opacity: 100 > %

(No neatrai cofer exsts for Normal r^ode.)

4.29-rasm. New Layer muloqot oynasi 
Name (Имя) maydoniga yangi qatlam nomini kiriting. Shuningdek avtomatik 

taklif qilingan nomida ham qoldirish mumkin. Masalan. Lay er 3. Biroq yaxshisi 
qatlamlarga fikr у uritgan holda nom bergan ma’qul. Layers (Слои) palitrasidagi rang 
hududini tanlang. U ko‘z ko‘rinishidagi va muvqalam piktogrammasi ostida 
joylashgan. Kevin Mode (Режим смешивания) va Opacity (Непрозрачност) 
parametrlari qiymatlarini ko'rsating. Kevinroq bu xarakteristikalar o‘zgartirilishi 
mumkin. OK tugmasini bosing. Yangi qatlamlar bevosita ungacha mavjud va faol 
boigan qatlam ustida paydo boiadi35.

Qatlamni qanday nusxalash kerak. Mavjud qatlamni o sha parametrlari bilan 
nusxalash (дублирования) uchun avval o sha qatlamni belgilab olish kerak. Buning 
uchun Lay ers (Слои) palitrasida uning piktogrammasini sichqoncha chap tugmasi 
bilan bosish kerak. Keyin esa belgilangan qatlam ustida kursomi o'matib, 
sichqoncha chap tugmasini bosing va ushlab turing. Qatlam piktogrammasini Create 
New Layer (Создать новый слой) znachogiga surib keling va uni qo‘yib yuboring. 
Yangi qatlam-nusxa aslidan yuqorida va faol tarzda paydo boiadi. Uni nomi nusxa 
olingan qatlam nomini takrorlaydi. Biroq unda Copy sozi qo’shiladi (4.30-rasm).

Photoshop dasturida qatlamlami aynan ko'paytinsh uchun (дублирования) 
aiohida funktsiya mavjud. Aslida esa bu ham belgilangan qatlamni shunday tarzda 
nusxalaydi. Biroq, sozlashning yanada keng ro‘yxatini taklif qiladi.
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4.30-rasm. Layers palitrasi 
Menyudan Layer>Duplicate Layer (Слой>Дублироват слой) buy rug'ini 

berish Duplicate Layer (Дублировать слой) muloqot oynasini ochadi. Bu muloqot 
oynasidan qatlamni nusxalash uchun zarur sozlamalami amalga oshirishingiz 
mumkin (4.31-rasm)36.

Duplicate Layer

Oupicate: О ОО’ АЙБОЛИГ 

as:

Destination 

Document: настя_доктор.05С1

С1 Ж . Р
Caned

4.31-rasm. Duplicate Layer (Дублирования слоя) muloqot oynasi 
Siz oldindan yangi nusxalanadigan qatlam nomini As (как) maydoniga kiritib 

qo‘yishingiz mumkin. Undan tashqari, belgilangan qatlamni nafaqat joriy hujjatga. 
balki ixtiyoriy boshqa hujjatga ko'chirish mumkin. Buning uchun yoviladigan 
Document (Доку мент) ro'j'xatidan New (Новый) variantini tanlab, keyin esa Name 
(Имя) maydoniga belgilangan qatlam ko'chirilishi kerak bo'lgan yangi hujjat nomini 
ko'rsating.

Qatlam qanday o‘chiriladi. Layers (Слои) palitrasida o'dhirilishi kerak 
bo'lgan qatlamni belgilang. Keyin esa palitraning pastki qatorida joylashgan Delete 
Layer (Удалить слой) tugmani bosing va Yes (Да) javobini tanlang. Savolli oyna 
paydo bo'lmasligi uchun Alt klavishasini ushlab turgan holda korzina tugmasini 
bosing. Undan tashqari, oddiygina o'chiriladigan qatlam piktogrammasini korzina 
belgisi ustiga olib tashlash kerak. Layers (Слои) palitrasida o'chiriladigan qatlamni 
belgilang. Shundan keyin uni o'chirish uchun menyudan Layer > Delete > Layer 
(Слои > Удаление > Слой) buyrug'ini bering. Agar o'chirish xato amalga oshgan

36 Дунае* В, Photoshop CS6: Понятный самоучитель. — СПб.: Питер, 2013. —  153 с.
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boisa, qatlamni tiklash mumkm. Edit > Undo (Правка > Отменить) buyrugini 
bering yoki History (История) palitrasida avvalgi holatni bosing.

Qatfamlarni ketma-ket joylash tartibini o‘zgartirish. Layers (Слой) 
palitrasida boshqa qatlamlar holatiga nisbatan siz o‘zgartirmoqchi boigan qatlam 
nomi ustida bosing. Qatlam nomini yuqoriga yoki pastga surib keling va qachonki 
to q rangli gorizontal chiziq kerakli holatni egallaganidan kevin sichqoncha 
tugmasini qo'yib yuboring. Faol qatlamni boshqa qatlamlarga nisbatan joylashtirishni 
o'zgartirishni boshqa usul bilan ham amalga oshirish mumkin. Buning uchun Layer
> Arrange > Bring to Front (Слой > Расположит > Поверхност осталных), Bring 
Forward (Перенести вверх), Send Backward (Перенести вниз) yoki Send to Back 
(Ниже осталных) buyrugini berish kerak. Shuni esda tutish kerakki, qavsidir 
qatlamni fonning ostiga joylashtirish mumkin emas. Chunki o sha qatlamga 
biriktirilgan ob’yekt fon ostida qolib ketadi va natijada ko'rinmay qoladi. Qatlamlar 
ro‘yxatida fonni yuqoriga ko'chirish uchun avval uni qatlamga avlantirib olish kerak.

Yangi hujjat yarating. Uning uchun oichamni A4 va oriyentatsiyani Landscape 
(Албомная) qilib o‘mating.

1. Menyudan Window > Dockers (Окно > Пристыковывающиеся панели) 
buyrugini berish orqali Object Manager (Диспетчер объектов) panelini chaqiring. 
Ulami ajratib oling va ishchi sahifadan o‘ngga joylashtiring. Aslida esa yangi 
hujjatda bitta tasviriy qatlam Layerl nomi bilan yaratiladi.

2. Yangi qatlam yaratish uchun Object Manager (Диспетчер объектов) paneli 
menyusini oching va New Laver (Новый слой) buy rugini tanlang. Lay erl qatlami 
yuqorisida Layer2 nomdagi yangi qatlam yaratiladi.

3. Analogik tarzda uchinchi qatlamni Layer3 nomi bilan yarating.
4. Qatlamni qayta nomlaymiz. Layerl qatlamini qayta nomlash uchun ob yektlar 

dispetcherida uning nomida sichqoncha o‘ng tugmasini bosing va kontekstli 
menyudan Rename (Переименоват) buyrugini bering. Yangi qatlam nomini 
Background kiriting va Enter klavishasini bosing. Qatlam qayta nomlanadi.

5. Analogik tarzda ikkinchi qatlamni Objectsga uchinchi qatlamni esa Imagesga 
o'zgartinng.

6. Hujjatning ixtiyoriy qatlamlaridan birida rasmni bajarish uchun uni joriy 
qilish zarur. Buning uchun Object Manager (Диспетчер объектов) panelida qatlam 
nomi ustida bosing.

7. Joriy qatlamni Background (fon qatlam)ga o‘zgartiring.
8. Background qatlamining hujjat sahifasida uning oichamiga teng to‘g‘ri 

burchak varatamiz vauni teksturali tarzda bo'yaymiz. To‘g‘ri burchakni ishchi sahifa 
oichanuda yaratish uchun sichqoncha tugmasini Rectangle (Прямоуголник) 
uskunasida ikki marta bosing.

9. Fill (Заливка) uskunsini faollashtiring. Uning funktsional uskunalaridan 
Texture Fill (Текстурная заливка) tugmasini bosing. Teksturalar ro‘yxatidan 
Alabaster teksturani tanlang va u bilan Background qatlamidagi to‘g‘ri burchakni 
bo'vang.

10. Objects qatlamida ob’yektlar chizamiz. Joriy qatlamga Objects o'mating va 
unga bir nechta standart ob yektlar yoki rasmlar yrarating.

68



11 . Images qatlamida File > Import (Файл > Импорт) buyrugi yordamida bir 
nechta rastrli tasvimi import qiling37.

12. Qatlamda joylashgan ob'yektlami aks ettirmasligi uchun qatlam oldida 
turgan ko‘z ko‘rinishidagi tugmani bosing. Bu tugma ob’yektlami aks ettirish 
tugmasi hisoblanadi. Bu tugmani takror bosish ob'yektlami aks ettirishni yana 
faollashtiradi.

13. Background qatlami nomiga o'ng tugma bilan bosing. Paydo boigan 
menyudan Properties (Свойства) buyrug‘ini tanlang va Background Properties 
(Свойства слоя Background) muloqot oynasidan qatlam xususiyatlari oldidagi 
Editable (Редактируемый) bayroqchasini olib tashlang va Override full color view 
(Отображат только конту ры) oldidagi bayroqchani esa o'mating.

14. Analogik tarzda Objects va Images qatlamlar xususiyatlarini o‘zingizning 
qarashingizga ko‘ra o‘zgartiring.

15. Objects qatlami ob'yektlari uchun konturli rejimda aks ettirish rangini ko‘k, 
Images qatlami uchun esa — qizil o‘mating.

16. Konturli rejimga o‘tish uchun View > Wireframe (Просмотр > Контурный) 
buyrugini bering va bu rejimda qatlamlardagi ob'yektlami aks ettirilishiga 
e’tiboringizni qarating.

17. Images qatlamidagi import qilingan rasmlardan birini belgilang va uni 
shunday ko‘chiringki, Objects qatlamidagi ob'yektni qisman bekitsin. Qatlamlar 
bilan ishlashda bungdav holat tez-tez sodir boiadi. Rasmni teskari tartibda 
bekiladigan ham qilish mumkin (bizning holatda ob’yekt pikselli rasmni bekitishi 
kerak). Buning uchun qatlamlar tartibini o'zgartirish kerak. Object Manager 
(Диспетчер объектов) panelida Images qatlamini tuting va qatlam nomi ustida 
ushlab Objects qatlamidan pastga suring. Endi Objects qatlamidagi ob’yekt 
importlangan rasmni bekitadi.

Ob’yektlami bir qatlamdan boshqasiga nusxalash va ko‘chirish. Gohida 
amaliyotda ob’yektlami boshqa qatlamga nusxalash yoki ko‘chirishga to‘g‘ri keladi. 
Bunday operatsiyalar menyu panelining maxsus Object Manager (Диспетчер 
объектов) Move To Layer (Переместит на слой) va Copy To Layer (Копироват на 
слой) buyruqlari yordamida bajariladi.

Bu buyruqlami oiganish uchun avvalgi mashqqa qaytamiz. Import qilingan 
rasmni Images qatlamidan Objects qatlamiga ko‘chiramiz.

Savol va topshiriqlar:
1. Adobe Photoshop dasturi qanday ishga tushiriladi?
2. Adobe Photoshop dasturining asosiy menyusi nimalardan tashkil topgan?
3. Optsiyalar paneli nima uchun ishlatiladi?
4. Palitra operatsiyalari orqali nima bajarish mumkin?

1. Adobe Photoshop dasturida yangi fayl 
yaratish qanday amalga oshiriladi?
А) Новый (Ctr+N) buyrug‘ini berish orqali;

Test savollari
6. Adobe Photoshop dasturida tasvir nusxasini 
xotiraga yozish qanday amalga oshiriladi?
А) Сохранить Копию (Alt+Ctrl+S^ buyrug‘ini
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B) Открыть (Ctrl+O) biiyrug'ini berish orqali;
C) Открыть как (Alt+Ctrl+O) buyrugini berish 
orqali;
D) Сохранить (Ctrl+S) buvrug‘ini berish orqali.

2. Adobe Photoshop dasturida diskda mavjud 
fayllar ochish qanday amalga oshiriladi?
A) Открыть (Ctrl+O) buyrug‘ini berish orqali;
B) Новый (Ctr+N) buyrugini berish orqali;
C) Открыть как (Alt+Ctrl+O) buyrug‘ini berish 
orqali;
D) Сохранить (Ctrl+S) buyrugini berish orqali;

3. Adobe Photoshop dasturida faylni qanday 
koiinishda ochishni tanlash qanday amalga 
oshiriladi?
A) Открыть как (Alt+Ctrl+O) buyrug‘ini berish 
orqali,
B) Открыть (Ctrl+O) buyrugini berish orqali;
C) Новый (Ctr+N) buyrug‘ini berish orqali;
D) Сохранить (Ctrl+S) buvrug‘ini berish orqali;

4. Adobe Photoshop dasturida faylni xotiraga 
mavjud formatda yozish qanday amalga 
oshiriladi?
A) Сохранить (Ctrl+S) buyrugini berish orqali;
B) Открыть как (Alt+Ctrl-Ю) buyrugini berish 
orqali;
C) Открыть (Ctrl+O) buyrugini berish orqali;
D) Новый (Ctr+N) buyrug'ini berish orqali;

5. Adobe Photoshop dasturida faylni xotiraga 
boshqa nom bilan yozish qanday amalga 
oshiriladi?
A) Сохранить как Shift+Ctrl+S buyrugini berish 
orqali;
B) Сохранить Копию (Alt+Ctrl+S) buyrugini 
berish orqali;
C) Вернуть buyrugini berish orqali;
D) Поместить buyrugini berish orqali;

berish orqali;
B) Сохранить как Shift+Ctrl+S buyrugini berish 
orqali;
C) Вернуть buyrugini berish orqali;
D) Поместить buyrugini berish orqali;

7. Adobe Photoshop dasturida tasviming 
dastlabki holatiga qaytarish qanday amalga 
oshiriladi?
A) Вернуть buyrugini berish orqali,
B) Сохранить Копию (Alt+Ctrl+S) buyrugini 
berish orqali;
C) Сохранить как Shift+Ctrl+S buyrugini berish 
orqali;
D) Поместить buyrugini berish orqali;

8. Adobe Photoshop dasturida boshqa mustaqil 
fayl bilan birlashtirish qanday amalga 
oshiriladi?
A) Поместить buyrugini berish orqali;
B) Вернуть buyrugini berish orqali;
C) Сохранить Копию (Alt+Ctrl+S) buyrugini 
berish orqali;
D) Сохранить как Shift+Ctrl+S buyrugini berish 
orqali;

9. Adobe Photoshop dasturida boshqa papkada 
joylashgan faylni olib kirish qanday amalga 
oshiriladi?
A) Импорт buyrugini berish orqali;
B) Экспорт buyrugini berish orqali;
C) Файл информация buyrugini berish orqali;
D) Установка страницы (Shift+Ctrl+P) buyrugini 
berish orqali;

10. Adobe Photoshop dasturida tasvirni boshqa 
papkaga jo'natish qanday amalga oshiriladi?
A) Экспорт buyrugini berish orqali;
B) Импорт buyrugini berish orqali;
C) Файл информация buyrugini berish orqali;
D) Установка страницы (Shitt+Ctrl+P) buyrugini 
berish orqali;

21-§. Adobe Photoshop dasturida maxsus effektlar yaratish

Tayanch tushunchalar: Qatlamli effektlar, Layer Style muloqot oynasi, Bevel and 
Emboss effekti, Stroke effekti, Inner Shadow effekti, Inner Glow effekti.

Qatlamli effektlar — bu turli xususivatga ega imitatsiyalami qatlamga 
biriktirilishi, material va rang bilan bo‘yalishi. aylantirish, yoritilishi tushuniladi. Siz 
insonni hayoliga ham kelmavdigan turli xil effektlami yaratishingiz, sozlashingiz va 
bekor qilishingiz mumkin. Photoshop dasturida har bir qatlamlardagi rasmlarga, shu 
jumladan, matnlarga ham qatlamli effektlami biriktirish mumkin. Background

70



(Фон) qatlami bundan mustasno. Effektlaming parametrlari piksellarda beriladi. Bu 
shu narsani anglatadiki, bitta va shu sozlamalarga ega effektlar rasmda bir xil 
namoyon boimay balki turli xil kengaytma bilan namoyon bo‘ladi. Shu sababli ham 
effektlami masshtablashtirish imkoniyati mavjud. Qatlamli effektlar Layer style 
(Стиль слоя) muloqot oynasida yaratiladi va sozlanadi. Bitta yoki bir nechta qatlamli 
effektlaming majmui bitta stilni shakllantiradi (4.13-jadval). Photoshop CS 6 dasturi 
stillar kutubxonasiga ega boiib, uni siz o'zingiznmg shaxsiy namunalaringiz bilan 
toidirishingiz mumkin. Buni Slyles (Stili) palitrasiga qo‘shish orqali amalga 
oshiralidi38.

Bevel and Emboss 
(Тисение)
Stroke (обводка)

Inner Shadow (внутренная 
Тень)
Inner Glow (внутренная 
свечение)
Satin (глянец)

Color Overlay (наложение 
цвета)

Gradiyent Overlay 
(наложение градиента) 
Pattern Overlay 
(наложение узора) 
Outer Glow (внешное 
свечение)

Drop Shadow (Тень)

4.13-jadval. Effektlar
Effektning harakati

Fasok лга releflami yaratish. Yassi tasvirlar uchun emas, balki uch 
oicham li ob’yektlarga qo‘shimcha sifatida tavsiya qilingan.
Qatlamm rangli, gradiyentli yoki dekorativ bo'vashni yaratish 
uchun moijallangan.
Drop Shadow o ‘xshagan, ammo soya ichkariga tushadi

Outer Glow o'xshagan, ammo yorug‘lik ichkaridan benladi

Boshqa effektlar bilan hamkorlikda qoilaniladi. Bundan 
naqshlami, о ‘yil ish, ipakli shuialami berish uchun foydalaniladi. 
Qatlam tarkibini berilgan rang bilan bekilishi. Normal 
(Обычные) rejim asosida Color (Цветность^а quyish rejimini 
o‘zgartirishda qatlam tarkihi bo‘yalishi mumkin. Shuningdek 
qatlamli effektlar tarldbiga kiradigan teksturalar ham bo‘yalishi 
mumkin.
Qatlam tarkibini vuklangan gradiyent bilan qoplanishi

Qatlam tarkibini vuklangan uzor bilan bekitilishi qoplanishi

Tashqi yoritilishni hosli qilish. Screen (Экран) rejimi asosida. 
Tashqi reklama lovihalarida biror usulda yoritib turish uchun 
qoilaniladi. Shuningdek. ko‘p rangli fonda matnli yozuvlami 
o'qish qulay boiishi uchun qoilaniladi.
Soyalar yaratish uchun moijallangan. Multiply (Умножение) 
rejimi asosida.

Layer Style muloqot oynasi. Effektlar bilan ishlash uchun moijallangan 
Layer Style (Стиль слоя) muloqot oynasidir. Biz uning ishlashini sinovda tekshirib 
ko‘ramiz39.
1. Elektron arxivdan LessonsWpoic_13_C^oeBbie эффeкты\H20.psd faylini oching.
2. Qatlamning effektlar oynasini chaqirish uchun, quyidagi harakatlardan birini 
bajaring:

38 Евгении Тучкевич. Adobe Photoshop CS6. Мастер-класс. —  СПб.: BXV-Peterburg, 2013. ■ 
34 s.
39 Евгении Тучке*ич. Adobe Photoshop CS6 Мастер-класс. — СПб.: БХВ-Петербург, 2013. — 242 с.
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• Layers (Слои) palitrasida qatlam nomidan o'ngida sichqoncha chap tugmasini 
bosing;

• Layers (Слои) palitrasining pastki qismida joylashgan piktogrammalar 
ro'yxatidan stil yoki effektni tanlang: ochilgan ro'yxatdan effekt nomini tanlang;

• Layer (Слои) bosh menyudan Layer Style (Стиль слоя) buy rug'ini bajaring va 
ro'yxatdagi effektlardan birini tanlang.
3. Shundan so'ng Layer Style (Стиль слоя) nomli katta muloqot oynasi ochiladi 
(4.32-rasm).

Layer Style muloqot oynasi ko'plab bo'limlarga ega bo'lib, ulaming ro'yxati 
oyna chap tomonida joylashgan. CS6 versiyasidan boshlab, ulaming tarkibi to'liq bir 
xil qatlamli effektlar ketma-ketligi o'zgartirilgan. Shuning uchun ham bunday 
havotirlanmasdaa agar siz ro'yxatning yuqorisidan hammaga mashhur effekt Drop 
Shadow (Тень)ш topmasangiz, oltinchi versiyada u ro'yxatning oxiriga ko'chirilgan.

Barcha stillar- 
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4.32-rasm. Layer Style muloqot oynasi
Birinchi bo'lim, Styles (Stili), stillami tanlash va boshqarish uchun xizmat 

qiladi. Blending Options: Default (Параметры наложения: по умолчанию) 
bo'limi qatlamni qo'yish rejimi bilan ishlash uchun mo'ljallangan.

Qolgan bo'limlar qatlamning alohida effektlari uchun javob beradi. Effektlar 
Layer Style (Стиль слоя) oynasining ko'rish maydonida aks etadi. Preview 
(Просмотр) bavroqchasi o'matilganda esa hujjatning oynasida ham aks etadi. Agar 
effekt nomi yonida galochka o'matilgan boisa, u holda effekt a>ni paytda 
qo'llaniladi.

Agar effekt nomi ko'k rang bilan ajratilgan bo'lsa, u holda effekt faol 
hisoblanadi va oynaning o'ng qismida siz uning parametrlarini sozlashingiz mumkin. 
Barcha tenli (soyali) effektlar Multiply (Умножение) qo'yish rejimini qo'llashga 
qurilgan Barcha yoritgichlar Screen (Экран) rejimi bilan amalga oshadi.
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Bevel and Emboss effekti. Bu boshlovchi dizaynerlarmng sevimli effekti 
hisoblanadi. Bevel and Emboss (Тисение) qatoriga bavroqcha oinating (4.33-rasm).
1 Style (Стиль) nomli yoviladigan ro‘yxatdan siqib chiqarishning turli xillarini 
tanlanadi. Yoyiladigan ro‘yxatdan Technique (Метод) effektni yaratish metodi 
aniqlanib olinadi, Depth (Глубина) maydoni esa — siqib chiqarish darajasidir.
2. Direction (Направление) optsiyalari relefning vo‘nalishini o‘matadi: Up (Вверх) 
yoki Down (Вниз).
3. Size (Размер) parametri qivalikning eni oichamini belgilaydi. Soften 
(Смягчение) parametri relefni tekislanish darajasini belgilaydi. Qanchalik tekislanish 
kuchli boisa, relefning yon bag‘ri (qivaligi) shunchalik vumshoq boiadi.
4. Shading (Затенение) guruhida relefni yoritilish parametrlarini tartibga solib turadi.

L.'.as:._.)
! QjSfflQ
■I / »'M*W

;i *

4.33-rasm. Layer Styfle muloqot oynasi Bevel and Emboss bo'limi 
Asosiv vazifalarga qo‘shimcha ravishda Contour (Контур) va Texture 

(Тексту ра) boiimlari ishlatilishi mumkin.
Stroke effekti. Bu effekt qatlamni qismini yaratish uchun moijallangan. 

Qolgan barcha effektlami bekor qiling. Stroke (Обводка^а bayroqchani oinating 
(4.34-rasm).
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4.34-rasm. Layer Style muloqot oynasi Stroke boiim i 
Stroke (Обводка) boiimi quyidagi parametrlami o'zgartirish uchun 

moijallangan:
S  aylantirib chizishning (obvodka) eni oichami Size (Размер) oikazgich 

yordamida beriladi;
^  aylantirib chizishning holati yaqinroq ob’yektlar qirralari Position 

(Положение) ochiladigan ro‘yxatidan tanlanadi;
S  aylantirib chizishning turi Fill Type (Тип обводки) ro‘yxatidan belgilanadi: 

Color (Цвег)т olish, Gradient (Градиент) yoki Pattern (Узор)ш olish 
mumkin.
Inner Shadow effekti. Inner Shadow (Внутренная Тень) effekti soyani 

chegaradan aynan ob yektgacha shakllantiradi, buning natijasida ob'yekt fondan 
ajratib olingandek tasawur hosil boiadi.
1. Ochiladigan Blend Mode (Режим наложения) ro‘>xatda Multiply (Умножение) 
soyani qo‘yish rejimi berilgan. Yaqinida esa soya rangidagi to‘g‘riburchak 
joylashgan. Odatda soya rangi qora boiib, ammo siz uning uchun boshqa rangni ham 
olishingiz mumkin. Buning uchun namunalarga bosish va Color Picker (Палитра 
цветов) oynasida yangi rangni belgilash kerak. Masalan, qordagi sovalar ko‘k rang, 
givohlardagi sovalar esa — to'q yashil boiadi.
2. Opacity (Непрозрачность) oikazgich soyaning noshaffofligini belgilab beradi.
3. Angle (Угол) maydoni ob'yektga nisbatan qanday burchak ostida soya boiishini 
belgilaydi. Siz kiritish maydoniga qiymatni yozishingiz yoki kerakli burchakka 
avlanali sxemadagi chiziqni taxminan (kerakli qiymatga yaqin) to‘g‘rilab 
qo‘yishingiz kerak. Bu parametr ta'sir ko‘rsatishini soya koiinishida tekshirib 
ko‘ring. Use Global Light (Глобальное освещение) bayroqchasini o'matish 
hujjatning barcha qatlamlariga biriktirilgan hamma effektlarga bir xil yo'nalish 
beriladi40.

40 Евгении Тучкевич. Adobe Photoshop CS6. Мастер-класс. — СПб.: БХВ-Петербург, 2013.__246 с.
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4.35-rasm. Layer Style muloqot oynasi Inner Shadow bo‘limi
4. Distance (Смещение) maydoni ob’yekt ichida joylashgan soya masofasini 
belgilaydi.
5. Choke (Стягивание) parametri, sovaning qirralari qanchalik xira boiishini 
belgilaydi. U faqat Size (Размер) maydoniga nol bo‘lmagan qiymatlar kiritilganda 
ishlaydi. Bu parametr qancha katta boisa, kattalashgan soya qirralari shunchalik 
kichik boiadi. Maksimal qivmatda soya qirralar bo‘ylab xira emas bo ladi.
6. Size (Размер) parametri ichki soya qirrasi oichamini belgilaydi. Bu qiymat o‘sishi 
bilan qirralar yanada silliqlangan boiadi.
7. Contour (Конту р) parametri soya qirralari shaklini belgilaydi.

Inner Glow effekti. Inner Glow (Внутреннее свечение) effekti qirralar 
bo'ylab ichkarida voritishni imitatsiya qiladi yoki ob’yektlar markazidan imitatsiya 
qiladi.
1. Ochiladigan Blend Mode (Режим наложения) ro‘vxatda har doim Screen (Экран) 
rejimi o‘matilgan. Opacity (Непрозрачност) parametri yoritishning zichligini 
belgilaydi.
2. Noise (Шум) parametri yoritishning ortiqcha dogiarini aniqlaydi, uning 
qirralariga g‘adir-budirlik beradi.
3. Yoritilganlik yo‘nalishi Source (Источник) boiishi yoki Center (Из центра), yoki 
Edge (На краях) boiishi mumkin41.
4. Technique (Метод) parametri qirrani у oritilishi moiljallashda aniqlik darajasini 
belgilaydi. Agar ochiladigan ro‘yxatdan Softer (Мягкие) punkti tanlansa, effekt 
yanada yumshoq va shaffof boiadi, agar Precise (Точный) punkti tanlansa — effekt 
sezilarli yorqin boiadi.
5. Choke (Стягивание) parametri qirralaming yoritilganligi qanchalik xira ekanligini 
belgilaydi.
6. Size (Размер) parametri qirrani ichkaridan yoritilganlikning to‘shli bo‘yalishlar 
oichamini belgilaydi.

41 Евгении Тучкевич Adobe Photosliop CS6. Мастер-класс. — СПб.: БХВ-Петербург, 2013. — 247 С.
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4.36-rasm. Layer Style muloqot oynasi Inner Glow boiim i 
Satin efTekti. Bu effekt to1 la to‘plamim (складка) yoki boshqa materialni, 

suyuqliklar qoplamidagi mayda toiqin, xiralikni imitatsiva qiladi. Ko‘pchilik 
holatlarda ular boshqa effektlar bilan hamkorlikda qoilaniladi. Boshqa barcha 
effektlami bekor qiling. Satin (Глянец) bayroqchasini o mating (4.37-rasm).

i—« ...i
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4.37-rasm. Layer Style muloqot oynasining Satin boiim i 
Overlay guruhi effektlari. Ushbu turga uchta effekt tegishli hisoblanadi 

Ulaming har biri ta’sirida qatlam tarkibini tanlangan rang, gradiyent yoki uzor bilan 
qoplanadi.

Color Overlay (Наложение цвета) effektlari tasvirga bir turli tanlangan 
rangni quyish imkonini beradi. Quyishning har qanday rejimida va ixtiyoriy 
shaffoflikda boiadi. Birinchi navbatda dastur bekilishining qizil rangini tavsiva 
qiladi (4.38-rasm).
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4.38-rasm. Layer Style muloqot oynasining Color Overlay bo'limi
Gradient Overlay (Наложение градиента) effekti tasvirga gradiyentli rang 

quyish imkonini beradi. Gradiyent namunasiga sichqoncha tugmasini bosish orqali 
Gradient Editor (Редактор градиента) oynasini chaqirish va o'zingizning rangli 
aralashmangizni yaratishingiz mumkin.

Pattern Overlay (Наложение узора) effekti tasvimi uzor bilan to'ldirish 
imkonini beradi. Bu effektni qo'llash qulay va professional hisoblanadi. Ya'ni, 
sozlashning muloqot oynasidan masshtablash, qayta bo'yash va uzomi ko'chirish 
mumkin.

Bu guruh effektlarini hamkorlikda qo'llash mumkin. Agar sizni qo'llanilgan 
Pattern Overlay (Наложение узора) uzor rangi qoniqtirmasa, u holda uni qatlamli 
effekt Color Overlay (Наложение цвета) yordamida qayta bo'vash mumkin.
1. Pattern Overlay (Наложение узора) bayroqchasini o'mating. Standart birinchi 
uzor Bubbles (Пузыри)ш tanlang (4.39-rasm).
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4.39-rasm. Layer Style muloqot oynusining Pattern Overlay bo‘limi
2. Color Overlay (Наложение цвета) bayroqchasini o‘mating. Quyish rejimi Color 
(Цветоность)ш tanlang va Color Picker (Палитра цветов) oynasidan bo‘yash uchun 
yashil rangni tanlang (4.40-rasm). Yashil ko‘piklar yoki ko‘proq teriga o‘xshash 
dag‘al ko‘rinish (рептилий сочетание) oladi.

Or* w«b Colon « y»!K- *  » *

4.40-rasm. Tekstura bilan bo‘vash uchun rejimlami hamkorlikda qoilash.
Outer Glow effekti yoritilganlik — ob’yektlar va matnlarni belgilashning 

ajoyib usuli.
1. Awalgi effektlami bekor qiling. Outer Glow (Внешнее свечение) effektini 
faollashtiring.
2. Blend Mode (Режим наложения) ochiladigan ro‘vxatidan har doim Screen 
(Экран) rejimi o‘matiladi. Opacity (Непрозрачность) parametri yoritilganlikning 
zichligini belgilaydi (4.41 -rasm).

4.41-rasm. Layer Style muloqot oynasinmg Outer Glow boiim i 
3. Noise (Шум) parametri yoritilganlikda ortiqcha dogiami belgilaydi, uning 
qirralariga notekislik beradi.
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4 Technique (Метод) parametri qirralami yoritilganligini mo'ljallashda aniqlikni 
belgilaydi. Agar ochilgan ro'yxatdan Softer (Мягкий) punkti tanlangan bo'lsa, effekt 
vanada ko'proq yumshoq va shaffof bo'ladi. Agar bordiyu Precise (Точный) punkti 
tanlangan bo'Isa — effekt sezilarli vorqin bo'ladi.
5 Spread (Размах) va Size (Размер) parametriari xuddi soyalar singari ta’sir 
ko'rstadi.

MASHQ. Drop Shadow effekti bilan ishlash 
Ishning maqsadi: Drop Shadow effekti bilan ishlashga o'rgatish 
T o p s h i r iq n i  bajarish bo‘yicha metodik ko'rsabna: Drop Shadow effekti. Drop 
Shadow (Тен) effekti vordami bilan soya ob yektdan maydonga imitatsiva qilinadi 
Ob yekt fon ustidan ko'tarilgandek taassurot hosil qiladi.
1. Drop Shadow (Тен) bayroqchasini o'mating (4.42-rasm).
2. Blend Mode (Режим наложения) ochiladigan ro'yxatdan soyani yotqizish rejimi 
Multiply (Умножение) berilgan. Uning yaqinida to'g'riburchak jov lashgan bo'lib 
unda soya rangini tanlash mumkin. Aslida soya rangi qora bo'lib, ammo siz 
xohishingizga ko'ra boshqa rangni olishingiz mumkin. Buning uchun Color Picker 
(Палитра цветов) oynasida namunaga bosish va kerakli rangni belgilash mumkin. 
Masalan, qorda soyalar ko'k rang, giyohlarda esa — to'q yashil bo'ladi.
3. Opacity (Непрозрачност) o'tkazgich soyaning noshaffofligini nazorat qiladi.
4. Angle (Угол) maydoni ob’vektdan tushavotgan soyaning burchagini aniqlaydi. Siz 
tushish burchagini maydonga kiritish vo'li bilan yoki kerakli qiymatga aylanali
sxemadagi chiziqni burishingiz kerak bo'ladi. Bu parametr ko'rinishini soya 
ko'rinishidatekshirib ko'ring

4.42-rasm. Layer Style muloqot oynasining Drop Shadow bo‘limi 
Use Global Light (Глобалное освещение) bayroqchasini o'rnatish hujjatning 

barcha qatlamlariga biriktirilgan effektlariga bir xil yo'nalish beriladi.
5. Distance (Смещение) maydoni soyadan ob’vektgacha bo'lgan masofani 
belgilaydi
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6. Spread (Размах) parametri soyaning qirralari qanchalik yemirilgan (yuvilib 
ketganini) bo‘lishini belgilaydi. U faqatgina Size (Размер) maydonining nol 
qiymatidagina ishlaydi. Bu parametr qanchalik katta bo'lsa, kattalashgan soyaning 
qirrasi yuvilib ketish va noshaffofligi shunchalik kam bo'ladi. Maksimal qiymatda 
soyaqirralar bo'ylab mutlaqo yemirilmagan bo'ladi.
7. Size (Размер) parametri soya qirrasi tashqaridan o'lchamini belgilaydi. Bu 
ko'rsatkichning o'sishi bilan qirralar yanada ko'proq g'adir-budirlashgan bo'ladi.
8. Contour (Контур) parametri soya qirralari shaklini belgilaydi42.

Savol va topshiriqlar
1. Qanday usulda qatlamlar hosil qilinadi?
2. Qatlamlarga qanday effektlar qo'llash mumkin?
3. Ajratilgan qismda yangi qatlamni hosil qilishni ko'rsatib bering.
4. Brush uskunasi imkoniyatlarini sanab bering?
5. Background Eraser buyrug'i nima uchun ishlatiladi?

Test savoUari
1. Adobe Photoshop dasturida fasok va 
releflarni yaratish qaysi effekt yordamida 
amalga oshiriladi?
A) Bevel and Emboss (Тисение) effekti yordamida,
B) Stroke (обводка) effekti yordamida;
C) Inner Shadow (внутренная Тен) effekti 
yordamida;
D) Inner Glow (внутренная свечение) effekti 
yordamida:

2 Adobe Photoshop dasturida qatlamni rangli, 
gradiyentli yoki dekorativ bo'yash qaysi effekt 
yordamida amalga oshiriladi?
A) Stroke (Обводка) effekti yordamida,
B) Bevel and Emboss (Тисение) effekti yordamida;
C) Inner Shadow (Внутренная Тен) effekti 
yordamida;
D) Inner Glow (Внутренная свечение) effekti 
yordamida:

3 Adobe Photoshop dasturida soyani khkariga 
tushirish (Drop Shadow o'xshab) qaysi effekt 
yordamida amalga oshiriladi?
A) Inner Shadow (Внутренная Тен) effekti 
yordamida;
B) Stroke (Обводка) effekti yordamida;
C) Bevel and Emboss (Тисение) effekti yordamida,
D) Inner Glow (Внутренная свечение) effekti 
yordamida;

6. Adobe Photoshop dasturida qatlam tarkibini 
berilgan rang bilan bekilishi qaysi effekt 
yordamida amalga oshiriladi?
A) Color Overlay (наложение цвета) effekti 
yordamida;
B) Satin (глянец) effekti yordamida;
C) Gradient Overlay (наложение градиента) 
effekti yordamida;
D) Pattern Overlay (наложение узора) effekti 
yordamida;

7. Adobe Photoshop dasturida qatlam tarkibini 
vuklangan gradivent bilan bekitilishi qaysi 
effekt yordamida amalga oshiriladi?
A) Gradient Overlay (наложение градиента) 
effekti yordamida;
B) Color Overlay (наложение цвета) effekti 
yerdamida;
C) Satin (глянец) effekti yordamida;
IJ) Pattern Overlay (наложение узора) effekti 
yerdamida;

8 Adobe Photoshop dasturida qatlam tarkibini 
vuklangan uzor bilan bekitilishi qaysi effekt 
yordamida amalga oshiriladi?
A) Pattern Overlay (наложение узора) effekti 
yordamida,
B) Gradient Overlay (наложение градиента)

42 Евгении Тучкевич. Adobe Photoshop CS6. Мастер-класс. — СПб.: БХВ-Петербург, 2013. — 251 с.
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4 Adobe Photoshop dasturida Outer Glow 
„ ‘xshagan, ammo yomg lik ichkaridan berish 
qaysi effekt yordamida amalga oshiriladi?
A) Inner Glow (Внутренная свечение) effekti 
yordamida;
B) Inner Shadow (Внутренная Тен) effekti 
yordamida;
О  Stroke (Обводка) effekti yordamida;
D) Bevel and Emboss (Тисение) effekti yordamida;

5 Adobe Photoshop dasturida boshqa efTektlai 
bilan hamkorlik qaysi effekt yordamida amalga
oshiriladi?
A) Satin (глянец) effekti yordamida;
B) Color Overlay (наложение цвета) effekti 
yordamida;
C) Gradient Overlay (наложение градиента) 
effekti yordamida;
D) Pattern Overlay (наложение узора) effekti 
yordamida;

effekti yordamida;
C) Color Overlay (наложение цвета) effekti 
yordamida;
D) Satin (глянец) effekti yordamida;

9. Adobe Photoshop dasturida tashqi yoritilishni 
yaratish qaysi effekt yordamida amalga 
oshiriladi?
A) Outer Glow (внешное свечение) effekti 
yordamida;
B) Gradient Overlay (наложение градиента) 
effekti yordamida;
C) Color Oveday (наложение цвета) effekti 
yordamida;
D) Satin (глянец) effekti yordamida;

10. Adobe Photoshop dasturida soyalar yaratish 
qaysi effekt yordamida amalga oshiriladi?
A) Drop Shadow (Тен) effekti yordamida;
B) Outer Glow (внешное свечение) effekti 
yordamida;
C) Gradient Overlay (наложение градиента) 
effekti yordamida;
D) Color Overlay (наложение цвета) effekti 
yordamida;
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V BOB. MA’LUMOTLAR BAZASI

22-§. Ma’lumotlar bazalari va ularni boshqarish tizimlari

Tayanch tushunchalar: malumotlar bazas i, malumotlar bazas ini boshqarish 
tizimlari, maydonlar, MEMO-katta о 'Ichamli matn maydon, oddiy matn maydon, pul 
birligi nomli maydon.

Har kuni kompyuter tizimlariga katta miqdordagi ma lumotlar kiritiladi. Bu 
ma lumotlar qayerga ketadi va ular qanday qoilaniladi? Sizga ishingizda bular 
qanday yordam beradi? Agar siz marketing bo‘yicha menejer boisangiz, siz mavjud 
va qo‘shilishi mumkin boigan mijozlaming avvalgi xaridlanni o‘rganishingiz va 
tegishli tartibda tahlil qilishingiz mumkin. Bu axborotlar tovarlami sotish va xizmat 
ko'rsatishda yordam berishi mumkin. Agar siz yurist boisangiz avvalgi ishlar va 
murakkab huquqiy ma lumotlar bazalariga bogianish imkoniyatiga ega boiasiz. Bu 
axborotlar sizga ishda yutib chiqish va ni o'z mijozingiz yoki tashkilotingizni 
qutqarish imkonini beradi. Kim boiishingizdan qat’iy nazar ma’lumotlar bazasi 
sizning havotingizning ajralmas qismi bo‘ladi Axborot tizimlarining boshqa 
komponentlari singari ma lumotlar bazasi tashkilotlarga o‘z maqsadiga erishish 
uchun xizmat qiladi. Ma lumotlar bazasi rahbarlar va qarorlar qabul qiladigan 
shaxslarga o‘z vaqtida maiumotlarga asoslangan ishonchli va dolzarb axborotni 
yetkazib berish orqali tashkilot vuksalishiga olib kelishi mumkin.

Ishch Щ Familiyasi Ismi Ish.kirgan sana bo'lim nomeri ф т

005-10-632? Johns Francine 10-07-1997 257

549-77-IQGt Buckley BiU 02-17-1979 632
(yozuvltr)

098-^0-1370 Fiske Steven 0 t -0 5 -1985

COo-

Asosiy m aydonj

t ATRIBUTIAR (maydonlar) i
5 .1-rasm. M a’lumotlar bazasi

Ma lumotlar bazasi shuningdek tashkilotlarga axborotni generatsiya qilish 
evaziga avvalgi tadbirkorlik faoliyatlarini o‘rgangan holda sarf-harajatlarni 
kamavtirish, daromadni orttirish imkonini beradi. Ayrim hollarda tashkilotlar halqaro 
ma lumotlar bazasini yaratish va undan foy dalanish ustida hamkorlik qilishadi.
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Maiumotlar bazasini boshqarish tizimi (MBBT) maiumotlar bazasi bilan ishlashga 
moijallangan va boshqa amaliy dasturlar va uning foydalanuvchi si bilan ishlash 
interfeysini ta’minlash dasturlar guruhidan iborat.

Maiumotlar bazasi (MB) deganda real dunyoning konkret ob’vektlari haqidagi 
maiumotlar to'plamini tushunish mumkin. Lekin ma’lumotlar hajmi oshib borishi 
bilan bu masalalami hal etish murakkablashadi. Yuzaga kelgan muammo ob’yekt va 
maiumotlami strukturalash, ya'ni tizimga solish yo ii bilan hal qilinadd. Ob’yekt - bu 
mavjud va farqlanishi mumkin boigan narsadir. Ob yektlarga tegishli bir qator 
maiumotlar borki, ulaming to‘plami MB boiadi. Masalan. har bir akademik-litsey. 
kasb-hunar kolleji yoki oliy taiim  muassasasi - bu ob’yektlar boisa. ulardagi 
o‘quvchilar haqidagi maiumotlar to plami MBga misol boiadi

Har qanday jiddiv MBning yaratilishi uning loyihasini tuzishdan boshlanadi. 
MB loyihalovchisining asosiy vazifasi ob’yektlar va ulami tavsiflovchi parametrlami 
tanlash, maiumotlar orasidagi maiumotlami o'matishdan iborat.

MBni yaratish jarayonida, foydalanuvchi maiumotlami turli belgilar bo‘yicha 
tartiblashga va belgilaming turli birikmalari bo‘yicha zarur maiumotlami tez topish 
uchun imkoniyatlar yaratilishiga harakat qiladi. Bu ishlarni maiumotlar 
tuzilmalangan boigandagina bajarish mumkin.

5.2-rasm. MBBT
Zamonaviy MB texnologiyasida MBni yaratish, unga xizmat ko‘rsatish va 

foydalanuvchilami MB bilan ishlashiga imkon yaratish maxsus dasturiy uskunalar 
yordamida amalga oshiriladi. Bunday dasturiy uskunalar majmuasi maiumotlar 
bazasini boshqarish tizimlari (MBBT) deb ataladi.
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MBBT-MBni yaratish, uni dolzarb holatda ushlab turish, kerakli axborotni 
topishni tashkil etish va boshqa xizmat ko'rsatish uchun zarur boMadigan dasturiy va 
til vositalari majmuasidir.

MBBTga misol sifatida quyidagilami keltirish mumkin: DBASE, Microsoft 
Access, Microsoft For Pro For DOS. Microsoft For Pro For WINDOWS, Paradox 
for DOS, Paradox for WINDOWS. MB bilan ishlashga kirishishdan oldin 
ma'lumotlami tasvirlash modelini tanlab olish kerak.

U quyidagi talablarga javob berishi lozim:
- axborotni ko‘rgazmali tasvirlash;
- axborotni kiritishda soddalash;
- axborotni izlash va tanlashda qulavlik;
- boshqa bazaga kiritilgan ma’lumotdan foydalanish imkoniyatining 

mavjudligi;
- MBning ochiqligini ta'minlash (yangi ma lumotlar va maydonlar qo‘shish, 

ulami olib tashlash imkoniyatlari va hokazo).
5.1-jadvalda ma lumotlar bazalariga yondashuvning ijobiv xususiyatlari 

keltirilgan43.
5.1 -jadval. Ma lumotlar bazalariga yondashuvning ijobiy xususiyatlari

Imkoniyatlari Izoh
Improved strategic 
use o f corporate 
data

Aniq, to‘liq, yangilangan ma’lumotlar qarorlar qabul qiladigan shaxslarga 
ochiq bo'lishi mumkin. Qayerda, qachon va qay shaklda ular bunga ehtiyoj 
sezadi Ma lumotlar bazasi shuningdek tashkilot manbalarini foydalanishga 
qulay holatga olib kelib berdi.

Reduced data 
Redundancy

MBBTlarida ma lumotlar bir joyda to'planadi Bu esa disk sig‘imidan 
samarah foydalanish imkonini beradi.

Improved data 
integrity

Ma'lumotlar bazasi yagona fayldan iborat bo‘lib, ma’lumotlarga o'zgartirish 
kintilganda faylning boshqa nusxalarida (agar mavjud bo‘lsa) aks etmaydi. 
Shu sababli ham yagona fayl bilan ishlashga to‘g‘n  yondashgan holda boshqa 
fayllar mavjud boMmaydi. Ma lumotlar bazasida nechta jadval bo'lishidan 
qat’iy nazar yagona fayida saqlanadi.

Easier modification 
and updating

MBBT ma lumotlar o‘zgarishi va yangilanishini koordinatalab turadi. 
Dasturchilar va foydalanuvchilar fizik jihatdan m a’lumotlar qayerda 
saqlanavotganini bilmasligi kerak. Ma lumotlar bir marta saqlanadi va 
o'zgartiriladi

Data and program 
independence

MBBT amaliy dasturga bogiiq  emas holatda ma'lumotlami tashkil qiladi. 
Ma’lumotlar turi va joylashgan о ‘mi amaliy dasturga bog‘liq emas. Aniq bir 
ilovaga bog‘liq bo‘lmagan yangi tipdagi ma lumotlaming joriy qilinishi, bu 
ma’lumotlar fayliga mosligini qoilab-quwatlash uchun llovani qayta yozish 
talab qilinmaydi.

Better access to 
data and 
information

Aksariyat MBBTlari ma’lumotlar bazasiga osongina bog'lanish, kerakli 
ma’lumotlami ajratib olish imkonini beradigan dasturiy ta'minot hisoblanadi. 
Aksariyat hollarda foydalanuvchi kerakli ma lumotni olish uchun oddiy 
buyruqlar beradi. Yozuvlar o‘rtasida munosabatlar tadqiq qilinishi va 
ekspluatatsiya qilinishi, shuningdek ilovalar osongina birlashishi mumkin 
bo‘ladi.

Standardization of Ma’lumotlar bazasiga yagona standart yondashuv shuni anglatadiki. barcha

4j Ralph M. Stair. George W.Reynolds. Fundamentals o f Information Systems. Sixth edition. Course Technology,
Cengage Learning. USA. 2012. 118-p.
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data access amaliv dasturlar m a’lumot va axborotni olish uchun umumiy jarayonlami 
^ _________bajaradi. ________________________ ___________________

Maydonlar -  MB tuzilmasining asosiy elementlaridir. Ular ma’lum 
xususiyatlarga ega boiadilar. Har qanday maydonning asosiy xususiyati uning 
o‘zunligidir. Maydon uzunligi undagi belgilar soni bilan ifodalanadi.

Maydonning yana bir xususiyati, uning nomidir. Maydonda uning nomidan 
tashqari yana imzo xususiyati ham mavjud. Imzo-ustunning sarlavhasida aks 
ettiriladigan axborotdir. Uni maydon nomi bilan aralashtirib yubormaslik lozim 
Agar imzo berilmagan boisa sarlavhada may don nomi у ozib qo‘yiladi. Turli tipdagi 
may donlar turli maqsadlarda ishlatiladi va turli xossalarga ega boiadi.

Maydonlaming xususiyati bilan tanishib chiqamiz:
1. Oddiy matn maydoni. Belgilar soni 255 dan oshmasligi kerak.
2. MEMO-katta oichamli matn maydoni. Belgilar soni 65535dan oshmasligi 

shart. Oddiy matn va MEMO maydonida hisob ishlarini bajarib boimaydi.
3. Sonli maydon. Sonli ma lumotlami kiritishga xizmat qiladi va hisob 

ishlarini bajarishda foydalaniladi. Bu maydon 1,2,4,8 va 16 bay tli boiishi mumkin.
4. Sana va vaqt maydoni. Bu maydon sana va vaqtni bichimlangan holda 

saqlab qo‘yish imkonini beradi (01. 06. 01 20:29:59) va 8 bayt oichamga ega.
5. «Pul birligi» nomi bilan ataluvchi maydon. Bu maydondan hisob kitob 

ishlarini у uritishda foydalaniladi.
6. Hisoblagich maydoni. Bu may don 4 bayt uzunlikka va avtomatik ravishda 

maium songa oshib borish xususiyatiga ega. Ushbu maydondan yozuvlami 
nomerlashda foydalanish qulaydir.

7. Mantiqiy amal natijasini saqlovchi may don. Bu maydon «rost» (true) yoki 
«yolg‘on» (false) qiymatni saqlaydi. Maydon oichami lbayt.

8. OLE-nomi bilan yuritiluvchi maydon. Bu maydon Excel jadvalini. Word 
hujjatini, rasm, ovoz va boshqa shu kabi maiumotlarni ikkilik sanoq sistemasida 
saqlaydi. Maydon oichami lGbaytgacha boiadi.

9. Giperhavola maydoni. Bu maydon belgi va sonlardan iborat boiib, biror 
fayl yoki saytgayoi koisatadi.

10. Qiymatlar ro‘yxatidan iborat boigan maydon. Bu maydon bir qancha 
qiymatlardan iborat boigan ro yxatdan tanlangan aniq bir qiymatni saqlaydi.

Bilimlar bazasi -  bu ayrim predmet sohalan murakkab vazifaUar yechimini 
topish uchun tahlil va xulosalarni yuzaga keltiruvchi model, qoida, omillar 
(ma lumotlar) majmuidir.

Bilimlar bazasining asosiy xususiyatlari. Axborot ta’minotining aiohida 
yaxlit strukturasi ko‘rinishida yaqqol ko'zga tashlangan va tashkil etilgan predmet 
sohasi haqidagi bilim boshqa bilim turlaridan, masalan, umumiy bilimdan ajralib 
turadi. Bilimlar bazasi asosiy ek^ert tizimi sanaladi. Bilimlar fikrlash va vazifalami 
hal etish usuliga imkon beruvchi aniq ko'rinishda ifodalanadi va qaror qabul qilishni 
soddalashtirishga ko'maklashadi. Ekspert tizimining asosliligini ta'minlovchi bilimlar 
bazasi tashkilotning boiinmalaridagi mutaxassislar bilimini, tajribasini o‘zida 
mujassamlashtiradi va institutsional bilimlami (ixtisoslashganlar majmuini, 
vangilanayotgan strategiyalar, qarorlar uslublari) ifodalaydi.



0 ‘rganish
vamashq Bilimlar

qilish

Institutsiya 
viy bilimlar

5.3-rasm. Bilimlar bazasi 
Bilim va qoidalami turli aspektlarda ko‘rib chiqish mumkin:

• chuqur va yuzaki;
• sifat va miqdoriy;
• taxminiy (noaniq) va aniq;
• muayyan va umumiy;
• tavsifiy va ko'rsatma (yoi-vo'riq) beruvchi.

Foydalanuvchilar bilim bazasini samarali boshqaruv qarorlarini olish uchun 
qo‘llashlari mumkin.

Ma’lumotlar bazalarining faoliyati va strukturasi. Rasmda ma'lumotlar bazasi 
strukturasi va uning faoliyati tasvirlangan (5.4-rasm).

Mantiqiy xulosa 
bloki

Bilimlar bazasi Ekspert

5.4-rasm. Ma'lumotlar bazalarining faoliyati va strukturasi

MASHQ. Ma’lumotlar bazasini boshqarish va to‘ldirish 
Ishning maqsadi: Talabalarda ma’lumotlar bazasini boshqarish va toMdirish, 
ma'lumotlar bazasini formalar yordamida kiritish ko‘nikma va malakalarini hosil 
qilish.
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Q is q a c h a  nazariy nia’Iumotiar. MB -  ma'lumotlami saqlash uchun mo'ljallangan 
tartiblangan tuzilishdir. Ma lumotlar bazasi tushunchasi bilan ma'lumotlar bazasini 
boshqarish tizimlari (MBBT) tushunchasi bir-biri bilan chambarchas bog'liq. O'z 
vaqtida MBBT, yangi ma’lumotlar bazasi tuzilishini yaratish, ulami to'ldirish, 
tarkibli ma’lumotlami tahrirlash va namoyish etishga mo'ljallangan dasturiy vositalar 
kompleksi hisoblanadi. MBdagi ma’lumotlami namoyish etish deganda, ko'rsatilgan 
mezon asosida aks etuvchi ma'lumotlami tanlash, ulami tartiblash, bezash va 
kevinchalik chiqarish qurilmasiga uzatish yoki aloqa kanallari orqali uzatish 
tushuniladi.
MBBT funktsiyalari:

■ Ma’lumotlar bazasida axborotlar qidirish;
■ Murakkab bo'lmagan hisob kitob ishlarini bajarish;
■ Hisobotlar chop etish;
■ Ma lumotlar bazasini tahrirlash.

Ma’lumotlar bazasi bilan ishlashdagi asosiy amallar:
■ Ma’lumotlar bazasini yaratish;
■ Ma’lumotlar bazasini tahrirlash;
■ Ma’lumotlar bazasini ko'rish;
■ Ma' lumotlar bazasida axborotlar qidirish.

Ma’lumotlar bazasida saqlanayotgan axborotlar xarakteriga ko'ra faktografik 
va hujjatli, axborotlami saqlash xususiyatiga ko'ra esa markazlashgan va ajratilgan 
ko'rinishlarga ega.
Ma’lumotlar bazasini tashkil etish tuzulishiga ko'ra ular

■ relyatsion;
■ relyatsion bo'lmagan (iyerarxik va tarmoqli) ko'rinishlarga ega (5.2-jadval).

5.2-jadval. Ma'lumotlar bazasini tuzulishiga ko‘ra turlari
Relyatsion (ingliz tilidagi 
relation so'/.idan olingan 

bo'lib, munosibat ma nosini 
anglatadi)

Iyerarxik 
Ko‘p darajali tuzulishga ega 

bo‘lgan ma lumotlar 
to'plamidir (Daraxt).

Tarmoqli 
Tugunlar to ‘plami bo‘lib, 

bunda har biri hamma bilan 
bog‘langan (yo‘llar tizimi).

Relyatsion ma’lumotlar bazasi 
deb, o‘zaro bog‘langan to‘g ‘ri 

to‘rtburchakli jadval 
shaklidagi axborotlarga ega 

bo‘lgan ma’lumotlar bazasiga 
aytilladi.

Iveiarxik ma’lumotlar bazasi 
deb, quyidagi holatda 
tartiblangan axborotli 

ma’lumotlar bazasiga aytiladi: 
bunda, yozuvdagi bitta 

element asosiy hisoblanib 
qolganlari esa bo‘ysunuvchi 

ko‘rimshda bo'ladi.

Tarmoqli ma’lumotlar bazasi 
deb, vertikal 

ierarxik aloqalarga gorizontal 
aloqalar qo‘shilish natijasida 

hosil bo‘lgan ma’lumotlar 
bazasiga aytiladi va u tugun, 
satx, bog‘lanish kabi asosiy 

parametrlarga ega.
Eng sodda holda u ikki 
o‘lchovli massiv yoki 

jadvaldan iborat.

Disklardagi fayl tizimlariga 
oid shajara daraxti iyerarxik 
ma’lumotlar bazasini tashkil 

etadi.

Tarmoq modelida turli 
sathdagi elementlar orqali 

«erkin», ya’ni «har biri hamma 
bilan» ma'noli bog‘lanish 

qabul qilingan.

Sodda ma lumotlar bazasi tuzulishi. Agar ma lumotlar bazasida hech qanday 
ma’lumot bo'lmasa (bo'sh bo'lsa), u baribir to'laqonli ma'lumotlar bazasi 
hisoblanadi. Garchi bazada ma'lumotlar bo'lmasa ham lekin unda baza tuzulishi
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(maydon, uning turlari va xossalari) kabi axborotlar baribir mavjuddir. U 
ma'lumotlami kiritish usullari va bazada ulami saqlashm belgilaydi. Misol sifatida, 
kompyuterga tegishli boimagan lekin har bir kalendar kun uchun ajratilgan sahifaga 
ega boigan kundalik daftami olaylik. Garchi unda hech qanday yozuv boimasa ham 
u kundalik daftarligicha qoladi chunki u o'zining maxsus tuzilishiga (sana maydoni. 
vozuv uchun ajratilgan jovlar, maxsus belgilar va boshqalar) ega.

Ma lumotlar bazasi turli koiinishdagi ob yektlarga ega boiadi. Lekin har 
qanday ma lumotlar bazasining asosiy ob'yekti uning jadvallari hisoblanadi. Sodda 
ma lumotlar bazasi hech boimaganda bitta jadvalga egadir. Ikki oichovli 
jadvallaming tuzilishini ustunlar va satrlar, sodda maiumotlar bazasining tuzilishini 
esa maydon va yozuvlar tashkil etadi Jadval maydoni tuzilishini o'zgartirish (y oki 
xossalarini) bilan, biz maiumotlar bazasi tuzilishini o zgartiramiz va shu tariqada 
yangi maiumotlar bazasiga ega boiamiz. Maiumotlar bazasini yaratishga 
moijallangan dasturlar juda ko'p boiib, amalda Microsoft Access dasturidan 
fovdalanamiz.
Topshiriq: Конструктор rejimida jadval yaratish, forma yaratish. maiumotlarni 
saralash va tanlash amallarini bajaring.
Ishni bajarish tartibi:
1. Пуск > Все программы > Microsoft Office > Access 2013 buy rugini berish 
bilan dastumi ishga tushuring va ochilgan ov nadan Пустая база данных рабочего 
стола... tugmasini tanlash natijasida ochilgan Пустая база данных рабочего 
стола muloqot oynasining nom maydoniga Talaba nomini kiriting va Создать 
tugmasini bosing.
2. Dastur oynasi, uskunalar paneli, maiumotlarni havola etish formalari va ob’yekt 
ilovalari bilan tanishib chiqing.
3. Конструктор rejimida quyidagi maydonlarga ega boigan jadval maketini 
yarating: Familiya Ism № Guruh, Manzil, Telefon. Rasm. Izoh.
Maydonlami 1 jadvalga ko'ra nomlang.
Maydon xossalari: maydonlarga quyidagi parametrlami o‘mating.
Код Талаба: тип счетчик подпис поля - Ms, индексированное, без 
повторении.
Familiya: тип короткий текст, размер поля 50, обязательное, без пустых 
строк, индексированное.
Ism: тип короткий текст, размер поля 25, обязательное, без пустых строк. 
Guruh: тип короткий текст, размер поля 7, подпис №  Группы, маска ввода 
70 ‘М-000 voki ???-000, обязательное, без пустых строк, индексированное. 
Manzil: тип короткий текст, размер поля 200, не обязательное, не 
индексирован ное.
Mobil telefon: тип короткий текст, размер поля 8, маска ввода 00-000-00-00, 
не обязательное, не индексированное.
Rasm: тип OLE -  объект.
Izoh: тип длинный текст
Jadvalni yoping va unga Talabalar nomini bering.



Izoh: ?-beIgisi foydalanuvchi uchun biror harfni kiritishni, 0-esa sonlarni tanlangan 
kiritish niqobi (маска ввода) asosida kiritishni ta'minlaydi. Masalan, ?0'М-000 
dan IO‘M 102 yoki MO‘M 101 yoki FO‘M 105 ko‘rinishlarda, 00-000-00-00dai\ 
esa 97 12 34 ^abi foydalaning. Bundan tashqari * belgidan ham foydalanish 
mumkin. Odatda * belgidan toiaqonli matnlarni kiritish joyi uchun foydalaniladi.
4 Menyuning СОЗДАНИЕ bandi Формы guruhidan Форма tugmasi bosiladi. U 
jadvalning barcha maydonlarini havola etadi. Aniqlik uchun 10 ta talaba haqidagi 
ma'lumotlarga ega boigan formalarni yaratishni ko‘rib chiqaylik (1 ta forma, 1 ta 
talaba uchun). Bunda kiritilayotgan familiva, ba’zi ismlar va guruhlar (aniqlik uchun 
3 ta guruh nomidan foydalaning. Masalan, 101, 102 va 103) takrorlansin. Rasmni 
kiritish uchun, o‘ng tugmani bosish natijasida ochilgan kontekstli menyudan 
Вставить объект—♦Bitmap Image punktini tanlash natijasida Paint oynasi 
ochiladi. Unga tanlangan rasmni o'mating, oichamini to'g irlang va Paint dasturini 
voping. Agar o‘zgartirishlar kiritish lozim bo‘lsa u holda Конструктор rejimidagi 
jadval maketini oching va o‘zgartirishlami kiriting.
5. Menyuning СОЗДАНИЕ bandi Формы guruhidagi Мастер форм tugmasini 
bosish natijasida Создание форм muloqot oynasi paydo boiadi. Unda quyidagi 
qadamlami bajaring.
Birinchi qadam: Muloqot oynaning Таблицы и запросы maydonidan Talabalar 
nomli jadvalni tanlang va Доступные поли: darchasidagi maydon nomlarini »  
tugma yordamida Выбранные поли: maydoniga o‘tkazing hamda Далее tugmasini 
bosing.
Ikkinchi qadam: Ochilgan ikkinchi muloqot oynada в один столбец punktini 
tanlang va Далее tugmasini bosing.
Uchinchi qadam: Ochilgan uchinchi muloqot oynaning Задайте ими формы: 
darchasiga Talabalar nomini kiriting va Готово tugmasini bosing.
Конструктор rejimiga o‘ting, natijada havola etilgan oyna paydo boiadi. Unda 
quyidagi ishlarni bajaring:

■ Matn maydonlari ustunning chap tomonidan birin ketin joylashgan,
■ Rasm va izohni o‘ng tomondan birin ketin joy lashtiring,
■ Rasm va izoh maydonlari oichamini kichraytiring.
■ Rasm maydonini belgilang natijada Окно свойств darchasi 

maiumotlarining o'zgarishiga e'tibor bering. Darchaning Установка 
размеров bandiga По размеру рамки oichamini o‘mating.

6. Rasm va izohlarsiz jadval vozuvlarini ko‘rish uchun Мастер форм yordamida 
lentachali formani yarating. Buning uchun СОЗДАНИЕ bandi Формы guruhidagi 
Мастер форм ilovasini tanlang, natijada Создание форм muloqot oynasi pavdo 
boiadi. Oynaning Доступные поля: darchasidagi maydon nomlarini» tugma 
yordamida Выбранные поли: maydoniga oikazing. Выбранные поли: 
maydonidan avvaliga rasm so‘ngra izoh maydonlanni < tugma yordamida orqaga 
qavtaring va Далее tugmasini bosing. Ochilgan ikkinchi darchadan Ленточный 
bandini tanlang va Далее tugmasini bosing. Ochilgan uchinchi darchaning nom
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maydoniga Lentochkali forma nomini kiriting va Готово

Lentochkali forma
N8 Fsfilfllya ism U<? 6ui Manzil Tel.

► I la t ip o v A bror К о м -101 C h ilo nzor-6 - 25-54-91

■
16 66.

2 Ergashev m Ком-101, Toshkent 32-65-98 j

L
vllo ya tt________

3i M ansurova j Madina jKoM-102 |Chilonzor-6- 89-54-74 !

—
16-66.__________

4 Q u vo n d iq o v Alisher К о м -103 Toshkent 25-21-23
. ]

shahar щ  Ш

5 ilatipov Tu rg 'u n {К о м -103 Toshkent 14-12-45
shahar

5.5-rasm. Formaningko‘rinishi 
tugmasini bosing. Конструктор rejimi yordamida matn maydonlari enini 
to'girlang. Ya'ni ulardagi matn atroflarida ochiq joylar qolmasin.

7. Ushbu formada ma’lumotlar bazasi xarakteriga xos amallami bajaring. Amallar 
menyuning ГЛАВНАЯ bandi Сортировка и фильтр guruhida joylashgan.

A) Yozuvlar ustida saralash (Сортировка) amali. shu onda faol bo‘lgan bitta maydon 
qiymatiga ko‘ra bajariladi.
Quyidagilar bo‘yicha saralash amalini bajaring:

■ Familiyaiar bo‘yicha;
■ Guruh nomlari bo‘yicha;
■ Telefon raqami bo‘yicha.

B) Filtrlardan foydalanib vozuvlami saralash bajariladi. Saralashni bearish yoki 
tanlash shartlarini bekor qilish uchun Фильтр tugmasidan foydalaning.

Saralash blankida bir vaqtda bajariluvchi (blankning bitta satrida beriluvchi) 
shartlami yoki ayrim (Или yordamida) shartlar asosida bajariladigan shartlarni berish 
mumkin. Saralash sharti

■ ro‘yxatdan tanlash;
■ munosabat ko‘rinishida yozish;
■ mantiqiy ifoda ko rinishlarda boiishi mumkin.

Tanlashni ketma-ket bajaring:
■ Bitta guruhda taiim  oluvchi barcha talabalami (misol, 101).
■ Ikkita har xil guruhlarda taiim  oluvchi barcha talabalami (masalan, 101 ;102).
■ Ko‘rsatilgan guruhda o‘quvchi talaba, masalan, Qosimova Aziza.
■ M yoki L harflar bilan boshlanuvchi familiyali barcha talabalami. Текстовые 

фильтры guruhi Равно... punktidagi niqoblardan (maska) foydalanish 
mumkin (masalan. M* or L*).

C) Tanlash shartini berish uchun Дополнительно tugmasidan foydalaniladi. 
ГЛАВНАЯ bandi Сортировка и фильтр guruhi Дополнительно ilovasidagi
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р а с ш и р е н н ы й  фильтр buyrug'i, filtr blanki (so'rov) yordamida yozuvlami 
tanlashni bajarish imkonini beradi.
Фильтр blankiga Talabalar jadvali qo'shiladi. Фильтр uchun tanlash bajariluvchi 
maydon, maydon qiymatlari bo'yicha saralash va tanlash shartlarini berish mumkin. 
Jadval maydonidagi ma’lumotlami saralash uchun chap tugmani 2 marta bosish bilan 
blankning quyi qismiga o'tiladi. Saralash satrida ko'rsatilgan mavdon bo'yicha 
saralash usullari tanlanadi. У еловые отбора satrida maydon qiymati uchun ixtiyoriy 
shartlar qo'yiladi. Agar shartlar blankning bitta satrida yozilgan bo'lsa u holda ular 
ustma-ust qo'yiladi, ya’ni bir vaqtda bajarilishi lozim bo'ladi. Yakka tartibdagi 
shartlami yozish uchun blankning Или satridan foydalanish mumkin. Shartlami 
vozish uchun shart muhitida o'ng tugma yordamida chaqiriluvchi Построить... 
ifodalami vasovchidan fovdalaniladi. Ifodalami yasovchini chaqiring va uning oyna 
tuzilishi bilan tanishing. Matn sattrlarini taqqoslash uchun Like amalidan foydalaning. 
Masalan, Like Latipov yoki Like L*. B) punktdagiga o'xshab ketma-ketlik bilan 
ma’lumotlami saralashni bajaring. Har bir saralash natijasini Ф и л ь тр !,Ф и л ь тр 4  
nomli so'rovlar sifatida, kontekstli menyu yordamida saqlang. Bajargan ishni 
o'qituvchiga havola eting.

Savol va topshiriqlar:
1. Ma'lumotlar bazasi nima? Ma'lumotlar bazasining qanday turlari bor?
2. Ma'lumotlar bazasini boshqarish tizimi (MBBT) nima?
3. Mavdonlaming xususiyatlarini aytib bering.
4. Ma'lumotlar bazasi bilan ishlashdagi asosiy amallami izohlang.
5. Ma'lumotlar bazasi qanday tuzilishlarga ega?
6. Relyatsion, iyerarxik, tarmoqli ma’lumotlar bazasini izohlang.

Test savollari
1. Forma (shakl) nima? 6. Forma (shakl) yaratishda Автоформа:
A) bu ma’lumotlami kiritish uchun mavdonlarga табличная usuii nima?
ega bo‘lgan elektron blankadir. A) maydonlarni avtomatik ravishda jadvallar
B) tanlangan maydonlar asosida avtomatik ko‘rinishida tuzish.
ravishda formalar tuzish. B) mustaqil ravishda yangi forma tuzish.
C) maydonlarni avtomatik ravishda bitta C) tanlangan maydonlar asosada avtomatik 
ustunga joylashtirilgan holda formalar tuzish. ravishda formalar tuzish.
D) maydonlarni avtomatik ravishda lentasimon D) maydonlarni avtomatik ravishda bitta 
joylashtirilgan holda formalar tuzish. ustunga joylashtirilgan holda formalar tuzish.

2. Forma (shakl) yaratishda Конструктор 7. F om a (shakl) yaratishda Диаграмма usuli 
usuli nima? nima?
A) mustaqil ravishda yangi forma tuzish. A) diagrammalar ko‘rinishida formalar tuzish
B) tanlangan maydonlar asosida avtomatik B) mustaqil ravishda yangi forma tuzish 
ravishda formalar tuzish. C) tanlangan maydonlar asosida avtomatik
C) maydonlarni avtomatik ravishda bitta ravishda formalar tuzish.
ustunga joylashtirilgan holda formalar tuzish. D) maydonlarni avtomatik ravishda
D) maydonlarni avtomatik ravishda lentasimon diagramma ko‘rinishida tuzish. 
joylashtirilgan holda formalar tuzish.

8. Forma (shakl) yaratishda Сводная таблица
3. Forma (shakl) yaratishda Мастер форм usuli nima?
usuli nima? A) Excel jadvallari bilan solishtirish usulidan
A) tanlangan maydonlar asosida avtomatik foydalanib formalar tuzish.
ravishda formalar tuzish. B) tanlangan mavdonlar asosida avtomatik
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B) mustaqil ravishda yangi forma tuzish.
C) maydonlarni avtomatik ravishda bitta 
ustunga joylashtirilgan holda formalar tuzish.
D) maydonlarni avtomatik ravishda lentasimon 
joylashtirilgan holda formalar tuzish.

4. Forma (shakl) yaratishda Автоформа: в 
столбец usuli nima?
A) maydonlarni avtomatik ravishda bitta 
ustunga joylashtirilgan holda formalar tuzish.
B) mustaqil ravishda yangi forma tuzish.
C) tanlangan maydonlar asosida avtomatik 
ravishda formalar tuzish.
D) maydonlarni avtomatik ravishda lentasimon 
joylashtirilgan holda formalar tuzish.

5. Forma (shakl) yaratishda Автоформа: 
ленточная usuli nima?
A) maydonlarni avtomatik ravishda lentasimon 
joylashtirilgan holda formalar tuzish.
B) mustaqil ravishda yangi forma tuzish.
C) tanlangan maydonlar asosida avtomatik 
ravishda formalar tuzish.
D) maydonlarni avtomatik ravishda bitta 
ustunga joylashtirilgan holda formalar tuzish.

ravishda formalar tuzish.
C) diagrammalar ko‘rinishida formalar tuzish.
D) maydonlarni avtomatik ravishda 
diagramma ko‘rinishida tuzish.

9. Avtomatik ravishda Forma (shakl) varatish 
ketma-ketligini avtib bering'?
A) MB oynasida «Создать» tugmasini bosish 
bilan «Новая форма» muloqot oynasini ochish 
orqali.
B) MB darchasida «Открыть» tugmasini 
bosish bilan «Новая форма» muloqot oynasini 
ochish orqali.
C) MB darchasida «Форма» tugmasini bosish 
bilan «Новая форма» muloqot oynasini ochish 
orqali.
D) MB darchasida «Форма» tugmasini bosish 
bilan «Создать форма» muloqot oynasini 
ochish orqali.

10. Forma tuzibnasi necha qismdan iborat 
boMadi?
A) 3
B) 2
C) 1
D) 4

23-§. Microsoft Access MBBTda ishlash texnologiyasi 

Tayanch tushunchalar: Таблица, Форма, Отчёт, Запрос. Макрос, Модул.

Ma iumotlar bazasining asosiy elementi Таблица -  yozuvlar va maydonlar 
korinishida ma lumotlami saqlashga moijallangan ob’yekt hisoblanadi. Jadval 
maydonlar va yozuvlar uning tuzilmaviy tashkil etuvchilari hisoblanadi. Maiumotlar 
bazasining har bir jadvali uchun asosiy kalit belgilanishi kerak. Kalitning qiymati 
turli yozuvlarda takrorlanmasligi zarur. Masalan, kutubxona bazasida bunday kalit 
sifatida kitobning inventar nomeri hisoblanib, turli kitoblarda bir-biriga mos 
kelmaydi.

Форма -  maiumotlami kiritishni yengillishtirish uchun moijallangan 
ob’yekt. Bu element maiumotlami kiritishni yengillashtiruvchi maydon, ro'yxat kabi 
qismlardan tarkib topadi.

Отчёт -  maiumotlami chop etishga moijallangan ob’yekt.
Запрос -  bir yoki bir nechta jadvaldan kerakli maiumotni olish imkonini 

beruvchi ob’yekt.
Макрос -  agar MB bilan ishlashda ba’zi bir buyruqlar (amallar) ko p marta 

takrorlansa, bu buyruqlami bitta makrosga guruhlab va klaviaturadagi tugmachalar 
orqali bajarilishini ta minlash mumkin. «Makroslar» - bir qator buyruqlar majmui 
asosida hosil boigan makrobuyruqlar boiib, foydalanuvchi tomonidan jadval 
tuzishda juda qiyin hal boiadigan jarayonlami yechadi.
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«Modul» (modul) -  Visual Basic tilida yozilgan dastur protseduralari ( biron 
bir amallami bajaruvchi dastur qismi) hisoblanadi.

Biror ma’lumotlar bazasini loyihalash va yaratish uchun Microsoft Access 
dasturini ishga tushirish kerak. Buning uchun WINDOWS oynasining masalalar 
panelidagi Пуск tugmachasi ustiga sichqoncha ko‘rsatkichini olib borib chap 
tugmachasini bosamiz va Программы bo'limiga o'tib, Microsoft Office > Microsoft 
Access qismini tanlab olamiz. Пуск > Программы > Microsoft Office > Microsoft 
Access.

MBning dastlabki oynasida yuqorida sanab o'tilgan 6 ta asosiy ob'yektlaming 
ilovalaridan tashqari, yana 3 ta buyruq tugmachalari mavjud. Bular: Открыть 
(Ochish), Конструктор (Tuzuvchi), Создать (Yaratish) tugmachalaridir.

Открыть (Ochish) tugmachasi tanlangan ob’yektni ochadi. Конструктор 
(Tuzuvchi) ham tanlangan ob'yektni ochadi lekin, u ob'yektning tuzilmasinigina 
ochib, uning mazmunini emas, balki tuzilishini to'g irlash imkonini beradi. Agar 
ob’yekt jadval bo'lsa. unga yangi maydonlar kiritish yoki mavjud maydonlaming 
xususiyatlarini o'zgartirish mumkin. Создать (Yaratish) tugmachasi yangi 
ob’yektlami: jadvallar, so'rovlar, shakllar va hisobotlami yaratish uchun ishlatiladi.

Biror MBni varatishdan oldin albatta uning loyihasim ishlab chiqish lozim. 
Buning uchun MBning tuzilmasini aniqlab olish kerak bo'ladi. MBning yaxshi 
tuzilmasi talablarga mos keladigan, samarali MBni yaratish uchun asos bo'ladi.

MS Accessda MBni yaratishning ikki usuli mavjud. Ulardan biri bo'sh bazani 
yaratib, so'ngra unga jadvallar, shakllar. hisobotlar va boshqa ob’yektlami kiritishdan 
iborat. Bu usul ancha yengil va qulay boigani bilan MBning har bir elementini 
alohida aniqlashga to g'ri keladi. Shuning uchun ikkinchi usuldan ko'proq 
foydalanishadi. Unda Мастер (Usta) yordamida barcha kerakli jadvallar, shakllar va 
hisobotlarga ega bo'lgan ma lum turdagi MB birdaniga yaratiladi, so'ngra tegishli 
o'zgartirishlami bajarish mumkin. Bu boshlang'ich MBni yaratishning eng sodda 
usulidir.

MBni Мастер (Usta) yordamida yaratish
1. MS Access ishga tushirilgandan keyin paydo bo'lgan oynadan Запуск 

мастера (Ustani ishga tushirish) parametrini tanlab, OK tugmachasini bosamiz. Agar 
MB oidindan ochilgan bo'lsa yoki dastlabki muloqot oynasi yopilgan bo'lsa, 
uskunalar panelidagi Создать базу данных (М Вт yaratish) tugmachasini bosish 
kerak.

2. Sichqoncha ko'rsatkichini kerakli MBning shabloni (andozasi) ustiga 
joylashtirib, chap tugmachasini ikki marta bosish kerak.

3. Ochilgan Файл новой базы (Yangi baza fayli) muloqot oynasidagi papka 
ro'yxatidan, yaratilayotgan MBni saqlab qo'ymoqchi bo'lgan papkani tanlash, Имя 
файла (Fayl nomi) maydonida MBning nomini kiritish va Создать (Yaratish) 
tugmachasini bosish kerak.

4. Keyingi muloqot oynasida master yaratilayotgan MB qanday axborotni 
saqlashi kerakligi haqida ma’lumot chiqaradi. Ushbu muloqot oynasining quyi 
qismida quyidagi tugmachalar joylashgan:

Отмена (Bekor qilish) — masteming ishini to'xtatadi;
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Назад (Orqaga) — master ishida bitta oldingi qadamga qaytadi;
Далее (Keyinga) — master ishida keyingi qadamga oiadi:
Готово (Tayyor) — tanlangan parametrli MBni yaratish masterini ishga 

tushiradi Ushbu tugmachani bosishdan oldin MBda saqlanadigan axborot ekranga 
chiqariladi.

5. Ishni davom ettirish uchun Далее (Keyinga) tugmachasi bosiladi.
6. Ochiladigan muloqot oynasi ikkita ro'yxatdan iborat boiadi.
Ulardan biri MB jadvallari ro‘yxati, ikkinchisi — tanlangan jadvalning 

maydonlari ro‘yxatidir. Ushbu ro‘yxatda jadvalga kiritilavotgan maydonlar 
belgilangan boiadi. Odatda deyarli barcha maydonlar belgilanadi (juda kam 
ishlatiladigan maydonlardan tashqari). Maydonchalar uchun bayroqcha belgisini (‘- 
belgisi) o matish yoki olib tashlash bilan jadvalga maydonlarni kiritish yoki 
kiritmaslik mumkin. Shundan so'ng Далее (Keyinga) tugmachasini bosish kerak.

7. Masteming keyingi qadamida taklif qilinavotgan namunalardan ekranni 
jihozlashni tanlab olish vayana Далее (Keyinga) tugmachasini bosish kerak.

8. Master ishining keyingi bosqichida MB uchun yaratilayotgan hisobotlar 
korinishini aniqlash mumkin.

9. Ochilgan navbatdagi muloqot oynasi hisobotga sarlavha qo'yish va rasm 
belgilash imkonini beradi. Ular keyingi barcha hisobotlarda tegishli joyda paydo 
boiadi. Agar rasm kerak boisa Да (Ha) yozuvining oldiga bayroqcha o'rnatish 
kerak Unda Рисунок (Rasm) tugmachasini ishlatish mumkin boiadi. Bu tugmacha 
bosilganda Выбор рисунка (Rasmni tanlash) oynasi ochiladi.

10. Oxirgi oynada Готово (Tavyor) tugmachasini bosish mastemi MBni 
tuzish uchun ishga tushirib yuboradi va u avtomatik ravishda yuqorida belgilangan 
parametrli MBni yaratadi.

MBni mustaqil ravishda yaratish. Yangi maiumotlar bazasini Ustaning 
yordamisiz, mustaqil ravishda yaratish mumkin. Buning uchun MS Access ishga 
tushirilgandan keyin paydo boigan oynadan Новая база данных (Yangi MB) 
parametrini tanlab OK tugmachasini bosamiz. Agar MB oldindan ochilgan boisa 
yoki ishga tushirish oynasi yopiq boisa, uskunalar panelidagi Создать базу данных 
(MBni yaratish) tugmachasini bosish va sichqoncha ko'rsatkichini vangi MB belgisi 
ustiga olib borib tugmachasini ikki marta bosish kerak. Shundan so‘ng Имя файла 
(Fayl nomi) qatoriga baza nomini yozamiz va Создать (Yaratish) tugmachasini 
bosamiz. Natijada bo‘sh boigan MB tanasini hosil qilamiz.

Maiumotlar bazasini ochish. MBni ochishning ikki usuli mavjud. Uni Access 
MBBTni ishga tushirish jarayonida yoki u bilan ishlash jarayonida ochish mumkin.

MBni Access bilan ishlash jarayonida ochish uchun Файл menyusida Открыть 
(Ochish) buyrug‘ini tanlash kerak. Shundan so‘ng ochilgan oynadan foydalanib, 
quyidagi ishlar bajarilishi kerak:

1. Manzillar panelida yorliq ustida sichqoncha belgisini joylashtirib 
tugmachasini bosish yoki Papka (Jild) mavdonida kerakli MB joylashgan disk yoki 
jildni tanlash.

2. Jildlar ro'yxatida kerakli jild ustida ikki marta sichqoncha tugmachasini 
bosib, MB joylashgan jildni ochish.
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Agar kerakli MB topish imkoni boimasa Сервис tugmachasini bosish va 
Найти (Topish) buyrug'ini tanlash kerak. Найти (Topish) muloqot ovnasida izlash 
uchun qo‘shimcha shartlami kiritish, so‘ngra kerakli parametr ustida sichqoncha 
tugmachasini bosish kerak. MBni faqat o‘qish. yani tahrirlamasdan ko‘rib chiqish 
uchun ochganda Открыть (Ochish) tugmachasi yonidagi strelkali tugmachani bosish 
kerak va Открыть для чтения (O qish uchun ochish) variantini tanlash lozim 
Access MBBTni ishga tushirishda ekranda muloqot oynasi paydo bo ladi Buni siz 
vaxshi bilasiz. Undagi Открыть базу данных (MBni ochish) boMimini tanlash va 
taklif etilayotgan barcha mavjud MBlar ro‘yxatidan kerakli MBni sichqoncha 
tugmachasini MBning yozuvi va nomi ustida bosish bilan ochish mumkin.

Biror ma lumotlar bazasini loyihalash va yaratish uchun Microsoft Access 
dasturini ishga tushirish kerak. Buning uchun WINDOWS oynasining masalalar 
panelidagi Пуск tugmachasi ustiga sichqoncha ko'rsatkichini olib borib chap 
tugmachasini bosamiz va Программы boiimiga o4ib, Microsoft Access qismini 
tanlab olamiz.

MASHQ. Ma’lumotlar bazasida so‘rovlar va hisobotlar yaratish 
Ishning maqsadi: Talabalarda ma lumotlar bazasida so‘rovlar va hisobotlar yaratish 
ko'nikma va malakalami shakllantirish.
Topshiriq: Конструктор rejimida Access so‘rovlarini yarating.
Ishni bajarish tartibi:
1. Microsoft Access dasturini ishga tushiring va birinchi amaliy mashg‘ulotda 
yaratilgan Talaba nomli ma’lumotlar bazasini oching.
2. Sorovlaming konstruktor rejimiga kiring

Запросы bandida Создать yoki Создание запроса в режиме конструктора 
ob’yekti tugmasini tanlang. Конструктор rejimida so‘rovlar mustaqil ya ni qo‘lda 
yaratiladi. So‘rov uchun ma’lumotlar manbai, bir yoki bir necha jadval yoki so‘rovlar 
bo‘lishi mumkin. Сессия jadvalini ma’lumotlar manbai sifatida qo'shing. Бланка 
запроса nomli oyna va uning uskunalari bilan tanishib chiqing. Ma’lumotlar manbai, 
Бланка запроса oynasining yuqori qismida keltirilgan. Oynaning quvi qismi esa 
quyidagi amallarni bajarishga moijallangan:

■ So‘rovda namoyon boMuvchi maydonlami berish uchun (maydon satri va 
jadval nomi satri);

■ So‘rovdagi ma'lumotlami tartiblash usullarini berish uchun (saralash satri);
■ Tanlash shartlarini berish uchun (tanlash sharti satri);
■ So‘rovdagi ma'lumotlami guruhlash usullarini bensh uchun;
■ So‘rov maydonlaridagi ifodalami hisoblash ishlari bajarishlarini berish 

uchun.
3. Сессия jadvalining barcha maydonlarini so‘rovga kiriting. Familivalar bo‘yicha 
saralashni kiriting va buni bajarish uchun so‘rovni ishga tushuring (uskunalar 
panelidagi Выполнить tugma yordamida). Uni so‘rov maketi nomi bilan saqlang. 
So‘rovda boshlangich jadvalning barcha ma’lumotlari aks etiladi.
4. Tanlash uchun so'rovlar yarating. Har bir yangi so‘rovlami yaratish konstruktor 
rejimida bajariladi. So‘rov mazmunini anglatuvchi har bir nomli so‘rovlami saqlagan
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holda, soiov maketini istalgancha nusxalash mumkin. Quyida keltirilgan shartlarni, 
tanlash shartlariga tartib bilan joylashtiring, yaratilgan so'rovlar natijalarini ko‘ring 
va ulaming har birini mazmunidan kelib chiqqan holda saqlang. Demak, tanlang:

■ Alifboning to‘rtburchakli qavsda ko‘rsatilgan birinchi harflari bilan 
boshlanuvchi talabalar familiyalarini (Like "[A-I]*") (nomi Birinchi);

■ Bitta guruhda tahsil oluvchi talabalami (Like 102) (nomi Guruh);
■ Muayyan guruhda tahsil oluvchi talabalardan tashqari barchasini (masalan, 

Not 102) (nomi Guruhdan tashqari).
5. Mantiqiy amalli tanlash so‘rovlari. So‘rov maketini nusxalab, baho maydonidagi 
imtihonlar baholariga shartlar berish bilan tanlash so‘rovlarini yarating. Demak, 
tanlang:

■ Faqat besh bahoga o‘quvchi talabalami (nomi AMochilar);
■ To'rt va besh baholarga o'quvchi talabalami (nomi To‘rt va besh);
■ Hech boMmaganda bitta uch bahoga ega talabalami (norm Aralash). 

Parametrli tanlash so‘rovlari. Agar satrda tanlash shartining o‘miga kvadrat qavslarga 
kiritilgan chiqarish uchun matnli taklifnoma berilsa, masalan [Familiyani kiriting], u 
holda soiovni ishga tushurishda parametmi ko rsatish mumkin. Parametr -  
mavdonning ko‘rsatilgan qiymati bo‘yicha qidiriluvchi ixtiyoriy qiymatdir (misolda, 
bu familiya). Quyidagi so‘rovlarda parametr qiymatlari bo‘yicha tanlashlami 
bajaring:

■ Talaba familiyasi bo‘yicha;
■ Talaba kodi bo‘yicha.
E tibor bering. parametrli qidirishda parametr qivmatiga mos qo‘yiluvchi aniq 

moslikdan foydalaniladi.
6. So rovdagi hisoblanuvchi maydonlar. Maketning yangi nusxalariga quyidagilami 
qoshing:

■ 0 ‘rtacha ball nomli maydonda, har bir talabaning o‘rtacha ballini hisoblash. 
Bu yerda maydon xossasiga o‘rtacha ball yoziladi:

([1 baho]+[2 bahoJ+[3 baho])/3
7. So rovda guruhli amallar. Guruhlash so'rovlar konstruktori uskunalar panelidagi 
Итоги tugmasi orqali amalga oshiriladi. «Группировка» blankasi satrida, guruhlash 
bajariluvchi maydonni va guruh ma’lumotlari xulosasini chiqarish uchun 
foydalanadigan guruhli deb ataladigan funktsivalami ko‘rsatish mumkin. Guruhli 
funktsiyalar ro‘yxati bilan tanishing:

■ Har bir guruhda turli fanlardan olingan o‘rtacha baholami toping. So‘rov uchun 
Guruh, 1-imtihon, 2-imtihon, 3-imtihon maydonlarini kiriting. Bu so'rovda 
Familiya maydoni kerak emas! Guruh maydonida guruhlashdan foydalaning va 
baho nomli barcha maydonlarda Avg() guruhlash funktsiyasini ishlating. 
Yakunida Guruhlardagi o‘rtacha baholar nomi bilan saqlang.
■ Barcha talabalar kontingenti uchun fanlardan olingan o‘rtacha baholami 
toping. Bu so‘rov uchun faqat Avg() guruhlash funktsiyali baholar maydonlarini 
qo shing. Fanlardan olingan o'rtacha baholar nomi bilan saqlang.
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MASHQ. Ma’lumotlar bazasini to‘ldirish 
lshning maqsadi: Talabaiarda ma'lumotlar bazasini to'ldirish, ma'lumotlami 
formalar yordamida kiritish va ulami ko'rib chiqish ko‘nikma va malakalami
shakllantirish.
T o p s h i r iq :  MB yaratish. MBni asosiy ob’vektlari bilan tanishish. Jadval yaratish va 
to'ldirish. Jadval rejimlarini taqdim etish. Ma'lumotlar tiplari. Kiritish niqobi 
(маска). Конструктор rejimida jadval tuzilishini o'zgartirish.
Ishni bajarish tartibi: Ma lumotlar bazasini (MB) yaratish.

Пуск > Все программы > Microsoft Office > Microsoft Access 2013 yo'llami 
bosib o‘tish orqali Access dasturini ishga tushuring va unga Ma’lumotlar bazasi 
nomini bering.

Shablonlar asosida jadval yaratish.
Microsoft Access 2013 versiyasida Мастер таблиц (Jadvallar ustasi) 

imkoniyatlari nazarda tutilmaganligi uchun jadvalni oddiy shablon asosida varatamiz. 
Buning uchun menvuning Создание bandi /Шаблоны/Части приложения/ guruhini 
oching va undan Контакты ilovasini tanlang. Natijada rasmdagi muloqot oynasi 
paydo bo'ladi. Unda Да tugmasini bosing. Ovnaning chap tomonida joylashgan Bee 
объекты A... qismidan Контакты tugmasi ustida sichqonchaning o'ng tugmasini 
bosing va ochilgan muloqot darchadan Переименовать buyrug'ini tanlab unga 
“manzillar’ nomini kiriting va Enter tugmasini bosing. Endi shu nomli jadval ustida 
sichqonchaning chap tugmasini ikki marta bosing. Natijada ko‘p sonli nomli 
maydonlarga ega bo'lgan jadval ochiladi. Bu jadvalda ID, Фамилия, Имя, 
Домашний телефон, Мобильный телефон, Адрес maydonlarini qoldirib, qolgan 
keraksiz maydonlarni ustida o'ng tugmani bosish natijasida ochilgan darchadan 
Удалить поле buyrug'ini tanlash orqali o'chiring. So'nggi keraksiz maydonni olib 
tashlagandan so'ng Сохранить tugmasini bosing. Endi nomli maydonlaming 
nomlarini o'zgartiramiz. ID maydon nomini konstruktor rejimi yordamida «Oluvchi» 
nomiga almashtiring. Buning uchun ГЛАВНАЯ bandi Режим tugnaasining pastki 
qismida joylashgan strelkani bosing va Конструктор ilovasini tanlang. Natijada 
Свойства поля muloqot ovna paydo bo iadi.

Oynaning Подпись maydoni ro'parasidagi ID nomli may donning nomini uni 
belgilash yordamida «Oluvchi» nomiga o'zgartiring va сохранить tugmasini bosing. 
Jadvalni yoping vayana Все объекты A... qismidagi "manzillar" nomili jadval ustida 
chap tugmani 2 marta bosish orqali uni oching. Qolgan barcha maydon nomlarini 
uning ustida o'ng tugmani bosish natijasida ochilgan oynasidan Переименовать 
buyrug'ini tanlash orqali o'zbekcha shaklga otkazing va oxirida Сохранить 
tugmasini bosing.

Barcha kerakli o'zgartirishlami kiritdik, endi jadvalni to'ldirishni boshlaymiz. 
Shu o'rinda muhim ma’lumotni avtib o'tish lozim. E’tibor bering, oluvchi maydoni 
yo'l ochib beradigan (ключевая) va ni muhim hisoblagich maydoni hisoblanadi. Bu 
maydon, yozuvi ami kiritishni tartiblab (nomerlab) beradi. Oluvchi maydonini 
toidirish shart emas, aniqrog'i uni to'ldirib ham bo'lmaydi chunki u avtomatik 
ravishda ishlaydi. Hozircha faqat famiiiya va ism maydonlarini to'ldiring va oxirida 
Сохранить tugmasini bosing. To'ldirishda ba'zi famiiiya va ismlami takrorlanishini
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ta'minlang chunki bu takrorlanishlar Access dasturi imkonivatlaridan foydalanishda 
sizga qo‘l keladi (filtrlash ishlarini bajarish va boshqalarda).
Kiritish niqobi (Маска ввода).
Kiritish niqobi - bu qiymatlar mavdonlariga bir xil formatli ma’lumotlami kiritish 
shabloni hisoblanadi. U mavdonlarda doimiv simvollami avtomatik ravishda 
ko'rsatadi. Telefon nomeriga kiritilish niqobini o'zgartinsh uchun menyuning 
ГЛАВНАЯ bandi Режим tugmasining pastki qismidagi strelkani bosish natijasida 
ochilgan muloqot darchadan Конструктор rejimini tanlang. Natijada maydonlar 
hosil bo‘ladi. Конструктор oynasi, birinchi ustuni maydonlar ikkinchi ustuni esa 
ma lumotlar tiplariga (formatlar) ega bo‘lgan jadvaldan iborat.

1. Uy telefoni va yon telefon mavdonlariga kiritilish niqobini beraylik.
2. Kursomi uy telefoni iborasi joylashgan maydonga omating. Natijada 

«Свойства поля» darchasi paydo bo‘ladi. Kursomi «Маска ввода» maydoni 
ro'parasidagi bo sh maydongajovlashtiring va unga 000-00-00 ko'rmishdagi sonlami 
kiriting. Bu ishni yon telefon uchun ham bajaring. Faqat u joyga 00-000-00-00 
sonlami kiritish lozim Endi jadval rejimga o‘ting. Access dasturi saqlash 
to‘g‘risidagi savol bilan murojaat qiladi. U joyda ha ya’ni «Да» deb javob benng. 
Telefon nomerlami kiriting So‘nggi qiladigan ishlardan biri bu manzil mavdonlarini 
to'ldirishdan iborat. Ulami to'ldiring va Сохранить tugmasini bosing. Kichik 
hajmdagi ma lumotlar bazasi yaratildi. Endi jadvaldagi ma'lumotlarga ko‘ra saralash, 
filtrlash amallarini bajarib ko‘ring.

MASHQ. Ma’lumotlar bazasida so‘rovlar va guruhlangan hisobotlar hosil qilish

Ishning maqsadi: Talabalarda ma 'lumotlar bazasida so 'rovlar va guruhlantirilgan 
hisobotlar hosil qilish ко 'nikma va malakalarni shakllantirish.
Topshiriq: Access dasturi yordamida hisobotlar yarating. Bunda hisobotlar ustasi va 
Конструктор rejimida hisobotlar bilan ishlashlardan foydalaning.
Ishni bajarish tartibi:

1. Access dasturini ishga tushuring vayuqoridagi amaliy mashg ulotda yaratilgan 
Talaba nomli ma'lumotlar bazasini oching.

Hisobotlar, jadval va so‘rov ko'rmishdagi ma lumotlar ba2asi malumotlarini 
qog‘oz variantida namoyish etishga mo'ljallangandir. Hisobotlami Forma 
ko'rinishdan farqi shundaki u guruhlashlami bajarish va yakuniy xulosalar 
chiqarishni osonlashtiradi.

2. Мастер отчетов imkonivatlaridan foydalanib hisobotlar yaratish. Menyuning 
СОЗДАНИЕ bandi Отчёты guruhidagi Мастер отчетов tugmasini bosing. 
Ma lumotlar manbai sifatida Talabalar nomli jadvalni tanlang. So'rovga qo'shish 
uchun Guruh, Familiya, Ism, Manzil, Mobil telefon tartibida maydonlami tanlang. 
Guruhlash darajasini qo‘shmasdan, guruh tartib raqamlari, familiya, ism 
mavdonlarini o‘sish tartibida saralang. Табличный maketini solngra ixtiyoriy stilni 
tanlang va talabalar nomini bering.

Hisobot, ko'rish (просмотр) rejimida ochiladi. Korish rejimining 
Предварительный просмотр deb ataluvchi uskunalar panelining tarkibiga 
e’tiboringizni qarating.

98



Hisobotlar Конструктор rejimiga kiring va hisobot blanki mazmuni bilan 
tanishing. Unda sarlavhalar qismlari, izohlar va kolontitullarni toping. Boshqarish 
elementlari paneli ochilishiga e’tiboringizni qaiating. Bu hisobot konstruktori 
uskunalari, forma konstruktor uskunalari bilan bir xilligini anglatadi. Hisobotlami 
varatish xuddi formalami yaratishdek amalga oshiriladi. Maydon sarlavhalarining 
vuqori kolontituldagi sarlavhalar qismida hisobotning umumiy sarlavhasi joylashib. 
ular hisobotning barcha sahifalarida takrorlanadi. Quyi kolontitul qismida esa barcha 
sahifalarda qaytariluvchi hisobot sahifasining joriy sana va tartib raqami jovlashadi. 
Quyidagi elementlar qaysi tipga mansubligini ko‘ring. Sarlavhalar uchun Надпись 
elementi. ma'Iumotlami tasvirlash uchun esa Поле elementi ishlatiladi. Линия 
elementi esa yuqori kolontitul sohasini ajratib turadi.

3. Ma’lumotlarni guruhlash. Yozuvlami guruhlarga birlashtirish uchun 
menyuning Конструктор bandi Группировка н итоги guruhidagi Группировка 
buyrug‘idan foydalaniladi.
Talabalar hisobotida talabalar haqidagi yozuvlar guruh tartib raqamiga qarab 
guruhlanishi lozim. Hisobotga, guruh tartib raqamlari uchun (С разделом заголовка 
qiymatiga ko‘ra) Заголовок группы qismini qo'shish uchun shu punktdan 
foydalaning. Yuqori kolontituldan Guruh yozuvini va ma’lumotlar qismidan esa 
Guruh maydonini Заголовок группы qismiga olib o‘ting. Turli guruhlar haqidagi 
ma'lumotlaming yuqori qismidan ingichka chiziq o'tkazish bilan uni ajrating. 
Natijani Просмотр rejimida ko‘ring.

4. Hisobotlarda yozuvlami nomerlash (tartiblash). Butun hisobotda yoki 
guruhdagi yozuvlami nomerlash uchun hisobot ma’lumotlari qismiga bo‘sh maydon 
qo'shish va Данные xossalariga “=1” formulaga teng qivmatni berish lozim Сумма 
с накоплением xossasi uchun Дли группы (guruh uchun) qiymatim o'mating. 
Agar butun hisobot uchun tarkibli nomerlash (сквозная) lozim bo‘lsa, u holda 
Сумма с накоплением xossasi Для всего qiymatni olishi kerak. Ikkala 
hisobotlami (tarkibli va odatiy nomerlashni) saqlang. Natijani Просмотр rejimida 
ko'nng.

5. Мастер (hisobotlar ustasi) yordamida hisobotlar yaratish. Ma’Iumotlami 
guruhlash. Sessiya jadvali uchun hisobotni yaratishda Мастер отчётов 
imkoniyatlaridan foydalaning. So'rovga qo'shish uchun guruh, Familiya, Ism va 
uchta imtihon baholari maydonlarini tanlang. Guruhlar uchun guruhlash darajasini 
qo‘shing, awaliga familivalami so‘ngra ismlami o‘sish tartibida saralang. Pog'onali 
(Ступенчатый) maketi va ixtiyoriy stilni tanlab unga Sessiya nomini bering.

6. Hisobotda yakuniy xulosa chiqarish. Guruhlar ustida yakuniy xulosalar 
chiqarish uchun Группировка buyrug'idan foydalaniladi. Talabalar haqidagi 
yozuvlar hisobotida guruhlar nomerlari bo‘yicha guruhlashtirilgandir.

Guruh nomerlari uchun (С разделом примечания qiymatli) Примечание 
группы qismini hisobotga qo‘shing. Bundan tashqari izohlar qismiga esa Avg() 
funktsivasi yordamida har bir guruh uchun fanlardan olingan baholaming o'rtacha 
qiymatini hisoblash uchun hisoblanuvchi maydonlar qo shing. Unga “Fanlardan 
olingan o'rtacha qiymat” y ozuvini qo shing. Turli guruhlar haqidagi ma’Iumotlami
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ajratish uchun uning osti qismidan ingichka chiziq o'tkazing. Natijani Просмотр 
rejimida ko'ring.

7. Ma’lumotlami guruhlash va master yordamida hisobotlami yaratish haqida 
yakuniy xulosalar chiqarish. Master ma’lumotlami guruhlashda. avtomatik ravishda 
xulosa chiqarish imkoniga egadir. Guruh uchun guruhlashga ega boigan Sessiya 
jadvali ma’lumotlari uchun yangi hisobot yarating. Saralash qadamida Итоги... 
tugmasini bosing va “imtihonlaming o'rtacha baholarT sifatida xulosa chiqaring. 
Faqat xulosalami ko'rsating. Hisobotni xulosa nomi bilan saqlang. Natijani 
Просмотр rejimida ko'ring. Konstruktorga kiring. Yozuvlar miqdorini hisoblovchi 
maydonni o‘chiring va Avg vozuvli matnni. fanlardan o'rtacha iborasiga 
almashtiring. Ma’lumotlar muhitidagi Famiiiya mavdonini va kolontituldan ham 
famiiiya yozuvini o'chiring. Hisobot elementlari qanday joylashganini eslab qoling.

8. So'rovlarda hisobotlar yaratish. Konstruktor rejimida hisobot yaratish. 
Hisobotlar konstruktori ko'p hollarda forma konstruktori bilan o'xshashdir. Ikkala 
konstruktor bir xil elementli panellarga ega. Hisobot yaratish forma yaratish kabi 
amalga oshiriladi. Konstruktor rejimi yordamida "Guruhlar o'rtachalari” so'rovida 
hisobot yarating. Fanlar nomlari yuqori kolontitulda joylashishi kerak. Guruh nomi 
va maydoni guruhlar sarlavhasi muhitida. imtihonlar bo'yicha o'rtacha baholar esa 
ma lumotlar muhitida bo'lishi lozim. Yuqori kolontitul muhitiga sanani chiqarish 
uchun maydon joylashtiring. Ushbu maydon ma'lumotlar parametrlarini, funktsiyalar 
ro'yxatidagi Now() funktsivasi yordamida bering. Maydonning Формат parametri, 
sanani namoyish etuvchi format holatida bo'lishi lozim. Quvi kolontitulda 
menyuning ВСТАВКА bandi Номера страниц buyrug'i yordamida hisobotning 
sahifa nomerlarini joylashtiring.

9. Konstruktor rejimida barcha hisobotlami, ulardagi ma’lumotlar proportsional 
joylashishi va maydonlarda to'liq aks etishiga nisbatan tahrirlang.

Savol va topshiriqlar:
1. Jadvallar masteri yordamida jadval qanday yaratiladi?
2. Konstruktor holatida jadval yaratish qanday amalga oshiriladi?
3. SHakl nima? Uni yaratishning qanday usullari bor?
4. So'rov nima? So'rovlardan konstruktor rejimidan nima maqsadda foydalanamiz?
5. Tanlash uchun so'rovlar qanday yaratiladi?
6. Like "[А-I]*", Like 102 va Not 102 amallarini izohlang.
7. Все объекты darchasidagi maydon ko'rinishlarini aytib o'ting.
8. Hisobot deb nimaga aytiladi?
9. AvgO funktsivasi yordamida qanday amal bajariladi?
10. NowO funktsiyasi yordamida qanday amal bajariladi?

Test savollari
1. Hisobotning КодКонтакты guruhi sarlavhasi 5. Microsoft ACCESS Найти Запис (Find
niina? Record) inakrokomandasi nima vazifani
A) КодКонтакты maydonining navbatdagi bajaradi? 
qivmatiga mos har bir yozuvlar guruhining boshida A) yozuvni topish; 
paydo bo'ladi; B) kcyingi vozuvga o‘tish;
B) КодКонтакты maydonining navbatdagi C) boshqaruv elementiga o'tish; 
qiymatiga mos har bir yozuvlar guruhining ohirida D) betga o'tish,
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paydo bo'ladi; .
C) КодКонтакты maydoninmg navbatdagi 
qiymatiga mos har bir vozuvlar guruhining 
o'rtasida paydo bo'ladi;
D) КодКонтакты maydoninmg navbatdagi 
qiymatiga mos har bir yozuvlar guruhining 
ta sh q a r isida paydo bo‘ladi:

2. M akroslar oynasi qanday ochiladi?
A) MB oynasidagi Макросы qo‘shimcha 
varaqasidagi Создать (yaratish) yoki Конструктор 
tugmasini bosish orqali ochiladi;
B) MB oynasidagi Макросы qo‘shimcha 
varaqasidagi Создать (yaratish) yoki Новая 
tugmasini bosish orqali ochiladi;
C) MB oynasidagi Макросы qo‘shimcha 
varaqasidagi Новый (yangi) yoki Конструктор 
tugmasini bosish orqali ochiladi;
D) MB oynasidagi Макросы qo‘shimcha 
varaqasidagi Создать (yaratish) yoki Макросы 
tugmasini bosish orqali ochiladi;

3. Makroslar oynasi qanday qismlardan iborat?
A) Имя макроса (Makros nomi), Условие (Shart), 
Макрокоманда (Makrokomanda), Примечание 
(Izoh).
B) Имя макроса (Makros nomi), Условие (Shart). 
Макрокоманда (Makrokomanda), Примечание 
(Izoh), Колонтитули;
C) Имя макроса (Makros nomi). Условие (Shart). 
Макрокоманда (Makrokomanda), Примечание 
(Izoh), Сноски;
D) Имя макроса (Makros nomi), Условие (Shart), 
Макрокоманда (Makrokomanda), Примечание 
(Izoh), Записи;

4. Microsoft ACCESS Следующая Залнс (Find 
Next) makrokomandasi nima vazifani bajaradi?
A) keyingi yozuvga o‘tish;
B) yozuvni topish;
C) boshqaruv elementiga o‘tish;
D) betga o‘tish;

6. Microsoft ACCESS К Элементу Управления 
(Go To Control)
makrokomandasi nima vazifani bajaradi?

A) boshqaruv elementiga o‘tish;
B) keying yozuvga o‘tish;
C) yozuvni topish
D) betga o'tish;

7. Microsoft ACCESS На страницу (Go To 
Page) makrokomandasi nima vazifani bajaradi?
A) betga oiish;
B) keyingi yozuvga o'tish;
C) yozuvni topish;
D) boshqaruv elementiga o‘tish;

8. Microsoft ACCESS На Запис (Go To Record) 
makrokomandasi nima vazifani bajaradi?
A) yozuvga oiish;
B) filtr qoilash;
C) makrosni bajarish;
D) dasturni bajarish;

9. Microsoft ACCESS Применит Фплтр (Apply 
Filter) makrokomandasi nima vazifani 
bajaradi?
A) filtr qo‘llash;
B) yozuvga o‘tish;
C) makrosni bajarish;
D) dasturni bajarish;

10. Microsoft ACCESS Запуск Макроса (Run 
Macro) makrokomandasi nima vazifani 
bajaradi?
A) makrosni bajarish;
B) yozuvga o'tish;
C) filtr qoilash,
D) dasturni bajarish;

24-§. So‘rovlar va SQL -  so‘rovlar tili

Tayanch tushunchalar: Data Definition Language, Data Control Language, Data 
Manipulation Language, interaktiv rejim, kiritilgan SQL rejimi, operator, fiinktsiya.

SQL (Structured Query Language) — strukturalashgan so’rovlar tili — 
relyatsion MB bilan ishlashda qoilaniladigan sorovlar tili.

Ma’lumki, relyatsion modelning tarixi (va bilvosita SQL tarixi ham) 1970 yil 
E.F.Koddni (bu paytda u IBM korporatsiyasining San Xosedagi tadqiqot markazida 
ishlagan) maqolasi chiqqan davrdan boshlanadi. 1974) il shu laboratoriyada ishlovchi
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D. Chemberlen "Structured English Query Language" yoki SEQUEL deb nomlangan 
tilni eion qiladi. 1976 yil bu tilning qayta ishlangan SEQUEL/2 versiyasi yaratildi 
va u rasmiy ravishda SQL deb atalgan. Hozirgi kunda SQL qisqartmasini ba'zilar 
"sikvel" deb talaffuz qiladi. Biroq rasmiy ravishda u "es-kvu-el" deb o‘qilishi kerak.

SQL tili relyatsion algebra paydo boigandan keyin paydo boidi va uning 
birinchi prototipi IBM Research kompaniyasi tomonidan 70 yillar oxirida yaratilgan. 
Bu til birinchi IBM System R nomli MBBT tarkibiga kiritilgan. Keyinchalik bu til 
ko'pgina tijorat MBBT tarkibida qo ilanilgan va keng tarqalganligi sababli vaqt 
o‘tishi bilan relyatsion MBBTlarda ma’lumotlar ustida amallar bajaruvchi tillaming 
norasmiy standarti boiib qoldi. SQL tilining birinchi rasmiy standarti 1989 yil qabul 
qilingan. Ко pgina MBBTlar ushbu standartni qoilab -  quvvatlaydi. Biroq 
maiumotlar bazasi bilan bogiiq axborot texnologivalanning rivojlanishi va ba'zi 
talablaming paydo boiishi birinchi SQL standartini qayta ishlash va kengaytirishni 
taqoza etdi.

1992 yil oxirida SQL tilining yangi xalqaro standarti (SQL/92 yoki SQL2) 
qabul qilindi. Unda ham ba’zi kamchiliklar aniqlangan, biroq shunga qaramasdan 
SQL/89 ga nisbatan aniq va toiiqroq hisoblanadi. Hozirgi paytda ko‘pgina MBBT 
ishlab chiqaruvchilar o‘z mahsulotlarini SQL2 standartini qanoatlantiradigan qilib 
o'zgartirdilar.

1999 yil SQL3 deb atalgan yangi standart paydo boidi. Agar SQL1 va SQL2 
standartlari biri -  biridan miqdor jihati bilan farq qilgan boisa, SQL3 standarti sifat 
jihatlari bilan farqlanadi. SQL3ga murakkab strukturaga ega maiumotlar tipini 
ishlatish imkonini beradigan yangi maiumotlar tipi kiritilgan. Bu tipni ob’yektga 
moijallanganlik darajasi yuqori hisoblanadi. SQL tilini toiaqonli an’anaviv 
dasturlash tillari tarkibiga kiritib boimavdi. Chunki unda dastur bajarilishini 
boshqaruvchi va boshqa ko'pgina an'anaviy operatorlar yo‘q. Unda faqat 
maiumotlar bazasida saqlanayotgan maiumotlarga murojaat qiluvchi operatorlar 
mavjud.

SQL tili organish uchun juda oson:
• Bu noprotsedura til. Shuning uchun imda maiumotni qanday olish emas, balki 

qanday ma'lumot olish kerakligi ko‘rsatiladi. Boshqacha aytganda SQL tili 
maiumotlarga murojaat usulini ko'rsatishm talab etmaydi Boshqa zamonaviy tillar 
kabi SQL tili operatorlaming mustaqil formatiga ega Ya’ni operatorlami yozishda 
operatorlami alohida elementlari ekrandagi m aium  o‘rinlarda joylashishi bilan 
bogiiq emas.

• buyruqlar mgliz tilining odatdagi so'zlaridan iborat kalit so'zlardan tashkil 
topgan, masaian. CREATE TABLE (jadval yaratish), INSERT (kiritish), SELECT 
(tanlash),

yoki:
• CREATE TABLE Staff (staffNo VARCHAR(S), IName VARCHAR(15). 

salary DECIMAL(7,2));
SQL tilining vazifasi. SQL tili foydalanuvchi relyatsion maiumotlar bazasi 

bilan muloqot qilishi uchun moijallangan boiib, quyidagi 3 ta qismdan iborat:
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• Data Definition language -  m a'lum otlam i aniqlash tili. M a'lum otlar 
bazasini (jadvallarini, indekslarini va x.k.) yaratish va uning sxemasini 
tahrirlash uchun mo'ljallangan.

•Data C ontrol Language - m s'lum otlarni boshqarish tili. 
Foydalanuvchilaming m a'lumotlar bazasi ob'yektlariga murojaatini 
chegaralash operatorlaridan iborat.

•Data M anipulatio n la nguage - m a'lum otlam i qayta ishlash tili. 
M a'lum otlar bazasi jadvallariga o'zgartirishlar kiritish uchun 
raoljallangan.

5.6-rasm. SQL tili qismi an
Ma’lumotlar bazasi bilan ishlovchi ixtiyoriy til foydalanuvchiga quyidagi 

imkonivatlami yaratishi lozim:
• strukturasini to'la tavsiflagan holda ma'lumotlar bazasini va jadvallarini 

yaratish;
• ma'lumotlar ustida manipulyatsiya amallarini bajarish, masalan, jadvallardan 

ma’lumotlami kiritish, tahrirlash va o'chirish;
• oddiy va murakkab so'rovlami bajarish.

Bundan tashqari. ma’lumotlar bazasi bilan ishlovchi til yuqoridagi amallami 
bajarish uchun foydalanuvchilardan kam urinishlarini talab qilishi, hamda 
buyruqlarining sintaksisi va tuzilishini o'rganish uchun oson va tushunarli bo'lishi 
kerak. Nihoyat bu til universal bo'lishi kerak. Bu bir MBBTdan boshqasiga o'tganda 
buyruqlami bir xil strukturasi va sintaksisidan foydalanishni ta’minlaydi. SQL tili bu 
talablami barchasini qanoatlantiradi.

SQL turlari yoki rejiralari. Yuqorida ta’kidlab o'tilganidek SQL3 tili 
tarkibida hisoblash jarayonini boshqarish imkonini beruvchi IF ... THEN ...ELSE, 
GO TO, DO ... WHILE kabi buyruqlar mavjud emas. Bunday masalalar dasturiy yo'l 
bilan (dasturlash tili yoki masalalami boshqarish tili) yoki interfaol holda 
(foydalanuvchining so'rovlari asosida) amalga oshiriladi. Imkoniyati cheklanganligi 
sababli (hisoblash jarayonini boshqarish imkoniyati) SQL tili 2 ta usulda qo'llanilish 
mumkin. Birinchi usulda interaktiv ishlash nazaixia tutiladi. Bunda foydalanuvchi 
SQL operatorlarini terminaldan beradi. Ikkinchi usulda protsedurali tildagi dasturga 
SQL tili operatorlari kiritiladi.

Bu usullar ba’zi adabiyotlarda ma'lumotlar bazasi bilan ishlash texnologiyasi 
yoki rejimi yoki SQL turlari deb ataladi.

Interfaol rejimda ma'lumotlar bazasi bilan ishlashda foydalanuvchi muloqat 
rejimida ishlaydi, ya'ni SQL tilidagi so'rovni kiritadi va natijani oladi, yani so'rovni 
kiritadi va natijaga ega boiadi va h.k.

Kiritilgan SQL rejimida boshqa dasturlash tillarida yaratilgan dastur tarkibiga 
kiritiladi. Bu ma'lumotlar bazasi bilan boshqa algoritmik tillarda yaratilgan amaliy 
dasturlar orqali ishlashni ta minlaydi. Biroq bu yerda qo'shimcha dasturiy vosita 
kerak bo'ladi. U dasturlash tili bilan SQL operatorlari o'rtasidagi interfeysni 
ta minlab beradi.

DCL

DML
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Terminologiya. SQL tili yordamida ma’lumotlar bazasiga beriladigan so'rov 
deganda joriy buyruq tavsiflagan va ma’lumotlar bazasini boshqarish tizimi 
tomonidan bajarish uchun moijallangan ma lumotlar bazasi ustida bajariladigan 
buyruq tushuniladi.

So'rov SQL tili operatorlari yordamida yaratiladi. Operatorlar so zlar deb 
ataluvchi aiohida ma noli qismlardan tashkil topadi. Operatorlar sintaksisi SQL 
tilining standartida belgilab berilgan.

SQL tili relyatsion ma lumotlar bazasi bilan ishlashiga qaramasdan 
«munosabat» atamasi o‘miga «jadval» atamasi, «kortej» va «atribut» atamalari 
o‘miga «satr» va «ustun» atamalari ishlatiladi.

SQL strukturasi yoki operatorlari. SQL tili 1 jadvalda tasvirlangan 
bo‘limlardan iborat.

5.3-jadval. Ma lumotlami aniqlash operatorlari DDL (Data Definition Language —
ma’lumotlami aniqlash tili)

Operator Manosi Amal
CREATE TABLE Jadval yaratish MB da yangi jadval yaratish

DROP TABLE Jadvalni o ‘chirish MBdan jadvalni o‘chirish

ALTER TABLE Jadvalni o ‘zgartirish Mavjud jadval strukturasini o ‘zgartirishyoki 
joriy jadval uchun o ‘rnatilgan butunlik 
cheklanishlarini o ‘zgartirish

CREATE VIEW Tasvir yaratish Biror SQL -so ’rovga mos virtual jadvalni 
yaratish

5.4-jadval. Ma’lumotlami manipulyatsiyalash operatorlari Data Manipulation Language (DMP)
Operator Ma’nosi Amal
DELETE Satmi

o‘chirish
Bir yoki bir nechta qatomi o‘chiradi. Bunda bazaviy 
jadvaldan saralash shartlariga muvofiq o‘chirish amalga 
oshadi.

INSERT Satmi qo‘yish Jadvalga bitta satmi qo‘yish. Bu operatoming boshqa 
moditikatsiyalarida biror jadvalning bir necha satri yoki 
so‘rov natijasi jadvalga qo‘yilishi mumkin.

UPDATE Satmi
yangilash

Bitta yoki filtrlash shartini qanoatlantiruvchi bir necha 
ustunlaridagi bitta voki ko'proq ustunlardagi qiymatlami 
almashtirish

5.5-jadval. Data Query Language (DQL) so‘rov tili
Operator Ma'nosi Amal

SELECT Satmi tanlash Relyatsion algebraning barcha amallarini bajaruvchi 
operator bo‘lib so‘rovga mos natijaviy jadvalni hosil qiladi.

5.6-jadval Tranzaktsivalami boshqarish operatorlari
Operator Ma’nosi Amal

COMMIT Tranzaktsiyani
tugatish

Tranzaktsiyani tashkil qiluvchi ma’lumotlami qayta 
ishlovchi murakkab va o'zaro bogTangan amalami 
tugatish

ROLLBACK Tranzaktsiyani Tranzaktsiya bajarilishi natijasida yuz bergan 
bekor qilish o ‘zgarishlami bekor qilish 
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SAVEPOINT 1 ranzaktsiya MBni oraliq holatini saqlash. Bu keyinchalik shu holatga 
bajarilishida qaytish uchun zarur boiadi 
oraliq nuqta 
saqlash

5.7-jadval. Ma lumotlami boshqarish operatorlari DCL (Data Control Language) -  ma'Iumotlami

Operator Ma’nosi Amal
ALTER
DATABASE

MB ni 
o'zgartinsh

Butun maiumotlar bazasiga tegishli boigan ob’yektlar 
va cheklanishlar to‘plamini o‘zgartirish

ALTER
DBAREA

MB saqlash
sohasini
o'zgartinsh

Avval yaratilgan saqlash sohasini oczgartirish

ALTER
PASSWORD

Parolni
o‘zgartirish

Butun maiumotlar bazasi parolini o ‘zgartirish

CREATE
DATABASE

MB yaratish Barcha parametr larini ko‘rsatgan holda vangi 
maiumotlar bazasini yaratish

CREATE
DBAREA

Saqlash sohasini 
yaratish

Yangi saqlash sohasini yaratish va unda maiumotlar 
joylashtirishga ruxsat etishi

DROP
DATABASE

MaTumotlar
bazasini
o'chirish

Mavjud maiumotlar bazasini o ‘chirish (bunday amal 
bajarish vakolatiga ega boigan foydalanuvchilar uchun)

DROP
DBAREA

MB saqlash
sohasini
o ‘chirish

Mavjud saqlash sohasini o ‘chirish (agar unda joriy vaqtda 
faol maiumotlar joylashmagan boisa)

GRANT

REVOKE

Vakolat berish MB ba’zi ob’yektlari ustida bir qator amallami bajarish 
huquqini berish

Huquqdan 
mahrum qilish

Biror ob’yektga yoki ob’yekt ustida bajariladigan ba'zi 
amallami bajarish huquqidan mahrum qilish

Kopincha ustunlardagi qiymatlarning maksimal, minimal va o'rtacha 
qiymatlarini hisoblashga to‘g‘ri keladi. Masalan. o‘rtacha ballni hisoblash zarurati 
paydo bo‘ladi. Bunday hisoblashlami bajarish uchun SQL tilida maxsus agregat 
funktsiyalari mavjud:

MIN -  ustundagi minimal qiymat;
MAX -  ustundagi maksimal qiymat;
SUM -  ustundagi qiymatlar yigindisi;
A V G - ustundagi qiymatlarning o‘rtachasi;
COUNT -  ustundagi NULLdan farqli boigan qiymatlar miqdori.
Quyidagi so rov talabalar imtihonlarda olgan ballarining oilachasmi amqlaydi. 
SELECT AVG(mark) FROM mark st 

SQL tilida maiumotlar turlari. SQL tilida maiumotlarning quyidagi asosiy 
turlari ishlatilib, ulaming formatlari har xil maiumotlar bazasini boshqarish tizimlari 
uchun farq qilishi mumkin (5.8-jadval):

5.8-jadval. SQL tilida ma iumotlar turlari 
tun qiymati

INTEGER Butun son (odatda 10 tagacha qiymatli raqam va ishora)
SMALLINT Qisqa butun (odatda 5 tagacha qiymatli raqam va ishora)
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DECIMAL(p,q) o ‘nli son. p  raqam va ishoradan iborat (0<p<16)
FLOAT haqiqiy son 15ta qiymath raqam va butun darajadan iborat
CHAR(n) uzunligi o'zgarmas, n ga teng bo'lgan simvolli qator (0<n<256)
VARCHAR(n) uzunligi o'zgaruvchi, n simvoldan oshmagan simvolli qator
DATE sana (yy/mm/dd)
TIME vaqt (hh.mm.ss)
DATETIME sana va vaqt kombinatsiyasi
MONEY pul birligi simvoli ($, ru b ,...)

Jadvallar yaratish va ularga cheklovlar kiritish. Jadvallami yaratish. 
Jadvallar CREATE TABLE buyrug‘i bilan yaratiladi. Bu buyruq qatorlarsiz bo‘sh 
jadval yaratadi. U jadval nomini, ma’lum tartibda ko'rsatilgan ustunlar nomlari ketma
-  ketligi, ma'lumotlar turlari va ustunlar o‘lchovini aniqlavdi.

CREATE TABLE buyrug‘ining umumiy yozilishi:
CREATE TABLE <jadval nomi>

( <ustun nomi> <malumot turi>[(<ustun oichovi>)J,
<ustun nomi> <ma’lumot turi>[(<ustun o'lchovi,...);

Jadval yaratishda va ular ustida ish yuritishda quyidagi 2 ta jadvaldan iborat 
ma'lumotlar bazasini misol sifatida qaraymiz.

Sotuvchilar (Salepeople):

Snum Sname City Comm
11 Anvar Samarqand 0.12
12 Baxtiyor Toshkent 0.13
14 Sarvar Toshkent 0.11

SNum -  har bir sotuvchi unikal nomeri,
SName -  sotuvchi nomi,
City -  sotuvchi manzili (shahri),
Comm -  sotuvchilaming o‘nli shakldagi komission foydasi.

Buvurtmachilar (Customers):
5.10-jadval. Jadval yaratishda va ular ustida ish yuritishda jadvalga misol 

Cnum С name City Rating SNum
21 Azim Samarqand 100 11
22 Mo'min Toshkent 200 13 

Sardor Toshkent23 200 12

CNum -  har bir buyurtmachi unikal nomeri;
CName -  buyurtmachi nomi;
City -  buy urtmachi manzili (shahri);
Rating -  buyurtmachining boshqalardan ustunlik darajasini ko‘rsatuvchi kod; 
SNum -  shu buyurtmachiga tayinlangan sotuvchi nomeri.

Misol uchun sotuvchilar jadvalini yaratish:
CREATE TABLE Salepeople

( SNum integer, SName char(10), City char(10), Comm decimal);
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Cheklovlarni kiritish. Jadvalni yaratayotganda (yoki uni o'zgartirayotganda), 
maydonlarga kiritilayotgan qiymatlarga cheklovlar o‘matish mumkin. Bu holda SQL 
cheklovlarga to‘g‘ri kelmaydigan hamma qiymatlami rad etadi.

Maydonga bo‘sh (NULL) qiymatlar kiritilishining oldini olish uchun CREATE 
TABLE buyrug'ida NOT NULL cheklovi ishlatiladi. Masalan, birlamchi kalitlar hech 
qachon bo‘sh boimasliklari kerak, shuning uchun Salepeople jadvalini quyidagicha 
yaratish mumkin:

CREATE TABLE Salepeople 
(Snum integer NOT NULL,

Sname char(10), city char( 10), comm decimal);
Ko'p hollarda ustunga kiritilgan qiymatlar bir-biridan farq qilishi kerak boladi. 

Agar ustunga UNIQUE cheklovi o'matilsa, unda ustunga qiymat kiritishga urinish 
rad etiladi. Bu cheklov bo‘sh bo‘lmaydigan (NOT NULL) deb e'lon qilingan 
maydonlarga qoilaniladi. Masalan:

CREATE TABLE Salepeople
(SNum integer NOT NULL UNIQUE,

Sname char(10), city char(10), comm decimal);
Jadval cheklovi UNIQUE maydonlar guruhiga ham omatilishi mumkin. Bu bir 

necha maydonlar qiymatlari kombinatsivasi unikalligini ta’minlaydi.
Maydon qiymatlarini tekshirish (CHECK cheklovi).
CHECK cheklovi jadvalga kiritilayotgan maiumot qabul qilinishidan oldin 

mos kelishi lozim boigan shart kiritishga imkon beradi. CHECK cheklovi CHECK 
kalit so‘zi ko rsatilgan maydondan foydalanuvchi shartli ifodadan iboratdir. Misol 
uchun Salepeople jadvali Comm ustuniga kiritilayotgan qiymat 1 dan kichik boisin. 

CREATE TABLE Salepeople
( SNum integer NOT NULL PRIMARY KEY,

SName chai{ 10) NOT NULL UNIQUE,
City char(10),
Comm decimal CHECK ( Comm < 1 ));

CHECK cheklovidan maydonga maium qiymatlarini kiritishdan himoya qilib, 
xatolar oldini olish uchun foydalanish mumkin. Masalan, mahsulotni sotish 
shahobchalariga ega boigan shaharlar faqat Toshkent, Samarqand. Buxoro va 
Abdijon boisin.

CREATE TABLE Salepeople 
(SNum integer NOT NULL PRIMARY KEY,
SName char(10) NOT NULL UNIQUE,

City char(10) CHECK (City IN (Toshkent1,'Andijon','Buxoro1, "Samarqand )), 
Comm decimal CHECK ( Comm < 1 ));

CHECK jadval cheklovi sifatida kelishi mumkin. Bu shartga bir necha maydon 
kiritishga imkon beradi. Masalan:

CREATE TABLE Salepeople
( SNum integer NOT NULL PRIMARY KEY,

SName char< 10) NOT NULL UNIQUE,
City char(10),
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Comm decimal,
CHECK (Somm < . 15 OR City = 'Andijon’));

Ko‘zda tutilgan qiymatlarni o'rnatish. Biror bir maydon uchun qiymat 
ko'rsatmagan holda jadvalga satr qo‘shish kerak bo'lsa, SQL bunday maydonga 
kiritish uchun ko'zda tutilgan qiymatga ega bo’lishi kerak, aks holda buyruq rad 
etiladi. Eng umumiy ko'zda tutilgan qiymat NULL qiymatdir. CREATE TABLE 
buyrug'ida ko'zda tutilgan qiymat DEFAULT operatori orqali, ustun cheklovi 
sifatida ko'rsatiladi. Masalan:

CREATE TABLE Salepeople
( SNum integer NOT NULL PRIMARY KEY,

SName char(10) NOT NULL UNIQUE,
City char(10) DEFAULT ’Samarqand1,
Comm decimal CHECK ( Comm < 1 ));

4. Maydonlar qiymatlarini kiritish, o‘chirish va o'zgartirish 
Jadvallarni o'chirish. Faqat bo‘sh jadvalni o'chirish mumkin. Jadvalni o'chirish 

buyrug'i quyidagi ko‘rinishga ega:
DROP TABLE <jadval nomi>; Masalan: DROP TABLE Salepeople; 

Jadvalni уuratilgandan so'ng o'zgartirish. Jadvalni o'zgartirish uchun ALTER 
TABLE buyrug idan foydalaniladi. Bu buymqda jadvalga yangi ustunlar qo'shish, 
ustunlami o'chirish, ustunlar kattaligini o'zgartirish, hamda cheklovlarni qo'shish va 
olib tashlash imkonivatlariga ega

Jadvalga ustun qo'shish buyrug'i:
ALTER TABLE <jadval nomi> ADD <ustun nomi>

<ma’lumot turi> <o'lchami>;
Masalan:
ALTER TABLE Salepeople ADD Phone CHAR(7);

Qiymatlarni kiritish.
Hamma satrlar SQLda INSERT buyrug'i yordamida kiritiladi. INSERT 

quyidagi formatga ega:
INSERT INTO <table name | view name> [(column |,column]...)] 

VALUES ( <value> [,<value>]... );
Masalan, sotuvchilar jadvaliga yangi satr kiritish uchun quyidagi buyruqdan 

fovdalanish mumkin:
INSERT INTO Salepeople VALUES (И, 'РееГ, ’Toshkent’, .12);
Ustun nomlarini ko'rsatish ham mumkin. masalan:
INSERT INTO Salepeople (Sname, Comm, SNum)

VALUES ('Peel', .12, 11);
Bu yerda e’tibor berilsa City ustuni tashlab yuborilgan, chunki unga ko'zda 

tutilgan qiymat kiritiladi.
Satrlarni o'chirish. Satrlami jadvaldan DELETE buyrug'i bilan o'chirish 

mumkin. U alohida qiymatlarni emas faqat satrlami o'chiradi. DELETE quyidagi 
formatga ega:

DELETE FROM <table name | view name> I WHERE search-condition];

108



Masalan, sotuvchilar jadvalidagi hamma satrlami o‘chirish uchun, quyidagi 
shartni kiritish mumkin: DELETE FROM Salepeople;

Ma’lum satrlami o‘chirish uchun shartlardan foydalaniladi. Masalan. jadvaldan 
Mo‘min sotuvchini o‘chirish uchun uning nomerini shartda berish kerak:

DELETE FROM Salepeople WHERE SNum = 13;
Maydon qiymatlarini o'zgartirish. O'zgartirish UPDATE buyrugi yordamida 

bajariladi. Bu buyruqda UPDATE ifodasidan so'ng jadval nomi va SET ifodasidan 
so‘ng ma’lum ustun uchun o^gartirish ko‘rsatiladi. UPDATE ikki formatga ega 
Ulardan birinchisi:

UPDATE <table name | view name>
SET column = expression [, column = expression] ...
[WHERE search-condition] 

bu yerda expression - bu ustun | ifoda | konstanta | o'zgaruvchi.
Ikkinchi variant:

UPDATE <tablename>
SET column = expression,...
[ FROM table-list ]
[ WHERE search-condition ]

Masalan, hamma buyurtmachilar bahosini 200ga o‘zgartirish mumkin:
UPDATE Customers SET Rating = 200;

Ma’lum satrlami o‘zgartirish uchun DELETEdagi kabi shartlardan foydalanish 
kerak. Masalan, Anvar (SNum=l 1) sotuvchining hamma buyurtmachilari uchun bir 
xil o'zgartirish quyidagicha kiritiladi:

UPDATE Customers SET Rating = 200 WHERE SNum =11;
SET vergul bilan ajratilgan ixtiyoriy sondagi ustunlarga qiymat tayinlashi 

mumkin. Masalan:
UPDATE Salepeople SET SName -Sarvar1, City-Toshkent\ Comm=. 10 

WHERE SNum = 14;
UPDATE buymg'ining SET jumlasida ifodalami ham ishlatish mumkin. 

Masalan: UPDATE Salepeople SET Comm = Comm * 2;
SELECT maiumotlami tanlash operatori 

Maiumotlami tanlash SELECT operatori yordamida bajariladi. Bu SQL 
tilining eng ko‘p qoilaniladigan operatori hisoblanadi. SELECT operatorini 
sintaksisi quyidagicha:
SELECT [ALL/DISTINCT] <atributlar ro‘vxati>/*
FROM <jadvallar ro'yxati >
[WHERE <tanlash sharti >]
[ORDER BY < atributlar ro‘vxati >]
[GROUP BY < atributlar ro‘vxati >]
[HAVING <shart>]
[UNION< SELECT operatorli ifoda>]

Kvadrat qavslarda operatomi yozishda qatnashishi shart boimagan elementlar 
ko‘rsatilgan. ALL kalit so‘zi natijaga shartni qanoatlantiruvchi barcha satrlar, 
shuningdek takrorlanuvchi satrlar ham kirishini bildiradi. DISTINCT kalit so'zi
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natijaga takrorlanuvchi satrlar kiritilmasligini bildiradi. Keyin boshlang'ich 
jadvaldagi atributlar royxati ko'rsatiladi. Bu atributlar natijaviy jadvalga kiritiladi. * 
simvoli natijaviy jadvalga boshlang‘ich jadvalning barcha atributlari kiritilishini 
bildiradi.

Operatorda qatnashishi shart bo'lgan so'zlardan FROM so‘zi hisoblanadi. Bu 
sozdan keyin tanlov bajariladigan jadvallar nomi ko'rsatiladi.

Tanlash ifodasida WHERE kalit so'zidan key in jadval satrlarini tanlab olish 
sharti ko'rsatiladi. Bunda natijaviy jadvalga WHERE ifodasidagi shart rost qiymat 
qabul qiladigan satrlar kiritiladi.

ORDER BY kalit so‘zi natijaviy jadval satrlarini ko‘rsatilgan ustunlar ro‘yxati 
bo'vicha tartiblash amalini bildiradi.

GROUP BY kalit so'zidan keyin guruhlanadigan atributlar royxati 
ko'rsatiladi.

HAVING ifodasida har bir guruhga qo‘yiladigan shartlar ko‘rsatiladi. (GROUP 
BY va HAVING kalit so‘zlari keyinroq tushuntiriladi).

FROM, WHERE va ORDER BY kalit so‘zlan SQL tilining qolgan 
ma lumotlami manipulyatsivalash operatorlarida ham shu tarzda ishlatiladi.

So rovlar yaratishni aniq misol uchun ko‘rib o'tamiz (5.7-rasm).

PK id_st

surname

exam_st

PK id_ex

subject
date

nark_st

id ex
PK id st

mark

5.7-rasm. So'rov yaratishga misol

Student
id_st Surname

1 Mingboyev
2 Baxodirov
3 Majidov 

m arkst
id_ex

2 
3

5.11-jadval. So‘rov yaratishga misol
exam st
id ex Subject Date

1 Matematika
2 Fizika

4.10.2017
11.10.2017

3 Informatika 18.10.2017

id_st Mark
2 3
1 2
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1 1 4
3 2 5
2 1 3 
1 2 2
2 3 4 
1 3 5
3 3 3

Barcha talabalar ro‘yxatini tanlash va tasvirlash.
SELECT *
FROM student 
yoki
SELECT id_st, surname 
FROM student

Agar ushbu so'rovga ORDER BY surname ifodasi qo‘shilsa, u holda ro‘yxat 
familiya bo‘vicha tartiblanadi. Odatda tartiblash o'sish bo‘yicha bajariladi. Agar 
kamayish bo‘yicha tartiblash kerak bo‘lsa, u holda oxirgi ifodadagi atribut nomidan 
kevin DESC so‘zi qo‘shiladi

«1 » kodli talaba olgan baholar ro yxatini tanlab olish va tasvirlash 
SELECT id_st, mark 
FROM mark_st 
Where id_st = 1

Imtihonlarda kamida bitta 2 yoki 3 baho olgan talabalar kodini tanlab olish. 
WHERE so‘zidan kevin solishtirish amallarini (<, >, =, о  va h.k.) va mantiqiy 

operatorlar qatnashgan ifodalami joylashtirish mumikin.
SELECT idjjt, mark 
FROM mark_st
WHERE ( MARK >= 2 ) AND ( MARK <= 3 )

SQL tilida shart ifodalarini tuzish uchun solishtirish va mantiqiy 
operatorlardan tashqari yana bir qator maxsus operatorlar qoilaniladi. Bu operatorlar 
dasturlash tillarida mavjud emas (5.12-jadval).

5.12-jadval. Dasturlash tillarida mavjud emas operatorlar 
Operator Vazifasi __

IN
BETWEEN 

LIKE 
IS NULL

biror qiymatlar to‘plamiga tegishliligini tekshirish; 
biror qiymatlar diapozoniga tegishliligini tekshirish; 
na'muna bilan mosligini tekshirish; 
qiymat mavjud emasligini tekshirish.

IN operatori biror qiymatlar to‘plamiga tegishlilikni tekshirish uchun 
ishlatiladi.

Quyidagi so‘rov oxirgi keltirilgan misoldagi so‘rov natijalarini beradi 
(imtihonlarda kamida bitta 2 yoki 3 baho olgan talabalami identifikatorini tanlab 
oladi)
SELECT id st, mark 
FROM mark st
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WHERE mark IN (2,3)
Xuddi natijani BETWEEN operatoridan foydaianib olish mumkin:

SELECT id_st. mark 
FROM markjst
WHERE mark BETWEEN 2 AND 3

Familiyalari A harfi bilan boshlanuvchi talabalar ro‘yxatini tanlab olish.
Bunday holatda LIKE operatoridan foydalanish qulay hisoblanadi. LIKE 

operatori faqat simvolli maydonlar uchun qoilaniladi va maydon qiymati operatorda 
ko‘rsatilgan namunaga mosligini tekshirish imkonini yaratadi. Namuna quyidagi 
maxsus simvollardan tashkil topadi:

_(tagiga chizish belgisi) -  bitta ixtiyoriy simvolni bildiradi;
% (foiz belgisi) -  ixtiyoriy miqdordagi simvollar ketma -  ketligini bildiradi. 

SELECT id_st, surname 
FROM student
WHERE surname LIKE 'A%'

Ko‘pincha ustunlardagi minimal, maksimal yoki o‘rtacha qiymatlami 
hisoblashga to“g ri keladi. Masalan, keltirilgan jadvallarda o'rtacha bahoni hisoblash 
mumkin. Bunday hisoblashni bajarish uchun SQL tilida maxsus agregat 
funktsiyalari mavjud (5.13-jadval):

5.13-jadval. SQL tilining maxsus agregat timktsiyalar 
Funktsiya Vazifasi

MIN() ustundagi minimal qiymat;
MAX() ustundagi maksimal qiymat;
SUMO ustundagi qiymatlar уig'indisi;
AVG() ustundagi qiymatlami o’rtachasi;

COUNT() ustundagi NULLdan farqli qiymatlar miqdori.

Quyidagi so‘rov talabalar olgan baholaming o‘rtachasini hisoblaydi.
SELECT AVG(mark)
FROM mark_st

Albatta, agregat funktsiyalarini WHERE so‘zi bilan birgahkda qoilash 
mumkin. Quyidagi so iov  100 kodli talabaning imtihonlarda olgan baholarining 
o‘rtachasini hisoblavdi:
SELECT AVG(mark)
FROM mark st 
WHERE i ds t  =100

Navbatdagi so rov 10 kodli talabaning o‘rtacha bahosini hisoblaydi:
SELECT AVG(mark)
FROM mark st 
WHERE id_ex = 10

SQL tili ko‘rib oiilgan mexanizmiga qo‘shimcha ravishda agregat 
funktsiyalami to la jadval uchun emas, balki guruhlangan qiymatlar uchun qoilash 
imkonini beruvchi vosita mavjud. Buning uchun SQLda maxsus GROUP BY 
konstruktsiyasi mavjud boiib unda ko‘rsatilgan ustun qiymatlari bo‘yicha guruhlash
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amalga oshiriladi. Masalan, har bir talabani imtihonlarda olgan baholarining 
o‘rtachasini aniqlash mumkin. Buning uchun quyidagi soTov beriladi:

SELECT id_st, AVG(mark)
FROM mark st 
GROUP BY id_st
Bu imkonivat ham odatdagidek WHERE ifodasi bilan birgalikda qo'llanilishi 

mumkin. Bu so‘rovni bajarishda MBBT avval jadvaJdan WHERE ifodasidagi shartni 
qanoatlantiruvchi satrlami tanlab oladi, keyin tanlangan satrlami guruhlash va 
agregatlash amalini bajaradi.

Quyidagi so‘rov har bir talabaning 100 kodli imtihondan olgan baholarining 
obrtachasini aniqlaydi.
SELECT id_st, AVG(mark)
FROM markjst 
WHERE id_ex = 100 
GROUP BY id_st

Ko‘rib turganimizdek guruhlash bittadan ko‘p maydon bo‘yicha bajarilishi 
mumkin. GROUP BY sektsiyasiga ega boigan so‘rovlar uchun quyidagi muhim 
cheklanish mavjud: bunday so rovlar natijasi tarkibiga guruhlash bajarilgan ustunlar 
va agregatlash natijasiga ega boigan ustunlar kiradi.

Savol va topshiriqlar
1. SQL tilining SELECT tanlash operatori.
2. SELECT tanlash operatorining sintaksisi.
3. SELECT operatorining WHERE ifodasi shartini yaratishda solishtirish 
operatorlari bilan birgalikda ishlatiladigan maxsus operatorlar.
4. IN, BETWEEN, LIKE, IS NULL operatorlarim ta'riflang va misollar keltiring.
5. SELECT operatori yordamida bir nechta jadv allardan ma’Iumotlami tanlash.
6. SQL tilining INSERT ma’Iumotlami kiritish operatori.

Test savollari
1. SQL (Structured Query Language) nima? 7. SQL tilida kiritish (qo'yish) qaysi buyruq
A) strukturalashgan solovlar tili; yoi-damida amalga oshiiiladi?
B) gipermatnlami belgilash tili; A) INSERT;
C) yuqori dasturlash tili; B) CREATE TABLE;
D) maiumotlar bazasini boshqarish tizimi; C) TABLE;

D) SELECT;
2. SQL tili qachon va kim tomonidan e’lon
qilingan? 8. SQL tilida tanlash qaysi buyruq yordamida
A) 1974 yil D.Chemberlen tomonidan; amalga oshiriladi?
B) 1970 yil E.F.Kodd A) SELECT;
C) 1974 yil E.F.Kodd B) CREATE TABLE;
Dj 1972 yil D.CHemberlen tomonidan; C) TABLE;

D) INSERT;
3. SQL tilining SEQUEL/2 versiyasi qachon
yaratilgan? 9. DDL qanday til?
A) 1976 yil; A) Data Definition Language - ma'Iumotlami
B) 1972 yil; aniqlash tili. Ma’lumotlar bazasini (jadvallarini,
C) 1974 yil; indckslarini va h.k.) yaratish va uning sxemasini
D) 1971 yil; tahrirlash uchun moijallangan;

B) Data Definition Language - malumotlami 
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4. SQL tilining SQL2 standard qachun 
yaradlgan?
A) 1992 yil;
B) 1972 yil;
C) 1976 yil;
D) 1971 yil;

5. SQL tilining SQL3 standard qachon 
varatilgan?
A) 1993 yil;
B) 1992 yil;
C) 1976 yil;
D) 1971 yil;

6. SQL rilida jadval yaratish qaysi buyruq 
yoi-damida amalga oshiriladi?
A) CREATE TABLE;
B) TABLE;
C) INSERT;
D) SELECT;

boshqarish tili. Foydalanuvchilaming ma lumotlar 
bazasi ob’vektlariga murojaatini chegaralash 
operatorlaridan iborat;
C) Data Definition Language - ma’lumotlami qayta 
ishlash tili. Ma’lumotlar bazasi jadvallariga 
o'zgartirishlar kiritish uchun moMjallangan;
D) Data Definition Language - giper matnlarni 
belgilash tili;

10. DCL qanday til?
A) Data Control Language - ma'lumotlami 
boshqarish tili. Foydalanuvchilaming ma’lumotlar 
bazasi obyektlariga murojaatini chegaralash 
operatorlaridan iborat;
B) Data Control Language - ma’lumotlami aniqlash 
tili. Ma’lumotlar bazasini (jadvallariru. indekslarini 
va h.k.) yaratish va uning sxemasini tahrirlash 
uchun mo'ljallangan;
C) Data Control Language - ma’lumotlami qayta 
ishlash tili. Ma’lumotlar bazasi jadvallariga 
o'zgartirishlar kiritish uchun mo'ljallangan;
D) Data Control Language - giper matnlarni 
belgilash tili;

25-§. Tarjima qiluvchi dasturlar

Tayanch tushunchalar: tarjimon dastur, Magic Gooddy, ABBYY Lingvo, Lug ‘at 3.0, 
tarjimon saytlar.

Ozbekiston Respublikasi birinchi Prezidentining 2012 yil 10 dekabrdagi «Chet 
tillami o‘rganish tizimini vanada takomillashtirish chora-tadbirlari to‘g‘risida»gi PQ- 
1875 son qarorida belgilangan vazifalar ijrosini ta’minlash, chet tillarini o‘qitish va 
o'rganish jarayonlari samaradorligini oshirishga xizmat qiluvchi zamonaviy 
metodikalar, ilg‘or tajribalami ommalashtirish, bakalavriat va magistratura 
talabalarining chet tillami o‘rganishga boMgan qiziqishlarini yanada orttirish hamda 
professor-o qituvchilar kasbiy mahoratini rivojlantirish maqsadida qator ishlar 
amalga oshirilmoqda. Jumladan. chet tillari bo‘vicha o‘quv adabiyotlaming chop 
etilishi, elektron darsliklar, elektron qoMlanmalar, elektron lug‘atlar va turli dasturiy 
vositalar varatilishi ham ana shunday maqsadlami ko'zlaydi. Dunyo bo'vicha chet 
tillarini o'rgatishga qaratilgan ko'plab o'rgatuvchi dasturlar va lug'at dasturlari ishlab 
chiqilmoqda va ulardan keng foydalanilmoqda.

ABBYY Lingvo -  taijimon dasturi Windows. Windows Mobile, Symbian OS, 
Mac OS X, iOS, Android operatsion tizimlarida ishlashga moMjallangan Rasmiy 
sayti www.lingvo.ru. ABBYY Lingvo — oilasi elektron va (1989 vildan) nashriv 
(2007 yildan) lug‘atlar ko'rinishida boiadi. Dastumi x5 versiyasini 31 mav 2011 
vilda Rossivaning ABBYY kompanivasi ishlab chiqqan. Dastuming lug‘atlar Ьгцгш 
8,7 milliondan ortiqni tashkil qiladi.
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Awarv

L i n S w J l
__________ nor.»*, ***.

5.8-rasm Lingvo dasturi oynasi
ABBYY Lingvo dasturning avrim lug'atlarida (ingliz, nemis va frantsuz) 

ko‘plab so'zlarga professional suxondonlar tomonidan tovush berilgan. Dastur 
tarkibiga yangi so'zlami eslab qolishga yordam beradigan Lingvo Tutor o‘rgatuvchi 
moduli ham Uradi. Dasturning ABBYY Lingv o x5 versiyasi 20 tilda so‘zlami taijima 
qilib beradi. Ular: ingliz, nemis, frantsuz, ispan, italyan. portugal, xitoy, turk, ukrain. 
lotin, venger, grek, daniya qozoq, niderland, norvegiya, polyak, tatar, fin tillari.

PROMT — bu kompyuteming maxsus taijimon dasturi bo‘lib, uning 
v ordamida bitta tildagi matnni ikkinchi tilga tarjima qilish mumkin. PROMT -  bu 
xorijiy tillardagi matnlar bilan samarali ishlash uchun mo‘ljallangan boiib, ingliz va 
yana 15 ta tildan avtomatik taijima qilish yechimini beradi. Barcha zamonaviy 
intellektual texnologiyalar asosida katta ma lumotlar bazasidan bilimlami ajratib 
olish imkonini beradi.

Dasturning iPhone/iPad qurilmalarida taijima qilish uchun mobil ilovalari 
tijorat va xususiy foydalanuvchilar uchun mo'ljallangan. Shuningdek dasturda hujjat 
almashinuv tizimlari va turli saytlar bilan muvofiqlik mavjud.

Dasturning rasmiy nomi PROMT Standart. Bugungi kunda bu eng mashhur va 
mavjud analoglari orasida eng ko‘p funktsiyali taijimon-dastur hisoblanadi. 
Dasturning oxirgi versiyalarida quyidagi imkoniyatlar paydo bo'ldi:

- PROMT taijimoni bu sizning pochtangizga kelgan Microsoft Outlook 
dasturidagi xatlami mustaqil ravishda taijima qiladi.

- Dasturning yana bitta katta imkoniyati pdf, .rtf. formatlaridagi kitoblar va 
boshqa hujjatlami taijima qilishdir. Qisman belgilangan yoki to‘liq matnni taijima 
qilish mumkin.

- PROMT Standart dasturi shunday qurilganki uning yordamida taijima qilingan 
matnni deyarii qayta ishlash va tuzatish talab qilinmaydi.

PROMT Standart dasturi rus tili, ingliz tili, nemis tili, frantsuz tili, ispan tili va 
italyan tili.

PROMT Professional quyidagilar uchun tavsiya qilinadi:
• Microsoft Office 2000-2010 (Word. Excel, Outlook, PowerPoint) va Adobe (Adobe 
Acrobat, Adobe Professional) ilovalaridagi hujjatlami taijima qilish uchun.
• Internet Explorer va Mozilla Firefox brauzerlaridagi intemet-manbalarini taijima 
qilish.
• foydalanuvchi tomonidan kiritilgan qo shimchataijimalarni kiritish imkoniyati.
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• ICQ, QIP, Skype, Windows Live Messenger xabarlarini tarjima qilish
• ixtisoslashgan yoki sohaJarga oid terminlardan tarkib topgan matnlar bilan ishlash.

PROMT dasturi bilan ishlashning qulayligiga quyidagilar kiradi:
- Microsoft Office paketiga moslashadigan interfeys;
- tarjima vaqtida formatni saqlab qolish;
- taijima qilingan matnni RTF va TXT formatlarida saqlash;
-joriy matnni tilini avtomatik ravishda aniqlash;
- qulay rejim «barcha ovnalar yuqorisida»;
- matnni almashinuv buferida avtomatik taijima qilish;

Magic Gooddy-2 —PROMT kompanivasi mahsuloti hisoblanadi. Ingliz-rus- 
ingliz multimediyali interfevsga ega oddiv taijimon dastur bo iib. xatto umuman 
tayvorlanmagan foydalanuvchilar ham ishlatsa bo iadi. Dastur ishga tushgandan 
so ng Magic Gooddy qahramoni chiqib keladi. O'zining lug'at bazasida 800 mingdan 
ortiq so‘z mavjud. Undan tashqari o'г  shaxsiv lug‘atingizni yaratishingiz ham 
mumkin. Shuningdek dasturda tovushli buyruqlar tizimi mavjud. Dastur nafaqat 
taijima qilish, balki ingliz tilini o‘rgatish imkonini ham beradi._________

S г.’-/- Г ДОЧд вил Г40СРМ ABtaCT** )
i*.; 4§э

m i  '
C>»

0$ 5»)

5.9-rasm. Magic Goody dasturi oynasi 
Magic Gooddy 2.00 dasturi imkonivatlari:

• Matn fragmentini bir onda taijima qilib beradi.
• Muhamrda matnni taijima qiiishning ikkita oynasi mavjud: joriy matn uchun, 
taijima uchun.
• Quyidagi formatlardagi hujjatlami ochish imkonini beradi: Microsoft Word (DOC), 
Rich Text Format (RTF), HTML va TXT.
• Tarjimani RTF yoki TXT formatlaridagi fayllarda saqlash.
• MS Outlookni qo‘llagan holda xatni tayyorlash va elektron pochta bo‘vlab 
jo ‘natish.
• Taijima vaqtida formatni saqlash.
• Foydalanuvchining shaxsiv lug'atlarini yaratish va to ldirish.
• Zahiralangan so‘zlar ro‘yxatini tuzish.
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Lug‘at 3.0 - o‘zbek tilidsai rus tiliga, rus tilidan o'zbek tiliga taijimon dasturi 
hisoblanadi. Dastur birinchi tilda kiritilgan so'zning ikkinchi tildagi ma nolarini 
chiqarib beradi. Bu imkoniyat nafaqat taijima qilishda balki ikkinchi tilni o'rganishda 
ham juda keng qo'llaniladi. U “SPELLS” firmasi tomonidan 2003 yilda ishlab 
chiqilgan Tarjima qilish uchun va horijiy tillami o'rganish uchun ko‘plab dasturiy 
vositalar borki, ulardan foydalangan holda nafaqat so‘z taijimasi. balki tolaqonli 
matnlarni ham taijima qilish mumkin. So‘zlaming talaffuzlarini eshitish, suhbatlarni 
ko‘rish va eshitish, transkriptsiyalarini ko'rish mumkin. Shu kabi imkoniyatlami 
amaliy dasturiy vositalardan tashqari Internet saytlari ham bajaradi. Bu esa on-line 
rejimda matnlarni taijima qilish bilan birga horijiy tillami o'rganish imkonini ham 
beradi. Ana shunday saytlardan biri http://solver.uz. Sayt rus tilidan o'zbek tiliga, 
o'zbek tilidan rus tiliga, o'zbek tilidan ingliz tiliga, ingliz tilidan o'zbek tiliga on-layn 
tarjima qiladigan sayt hisoblablanadi. http://www.translate.uz -  yuqori sifatli tarjimon 
sayt hisoblanadi.

Milliy elektron tarmoqlari nafaqat informatsion xarakterdagi bo'lishi yoki 
ma’lumotlami qidirishi, ko'chirib olish bilan cheklanmasdan balki xorijiy tillami 
o'rganishda, mavjud matnlarni yoki internet tarmogidan olingan matnlarni taijima 
qilishda ham foydalanish mumkin. Uz-Translations (www.uz-translations.iiz) tizimi 
ana shunday tarmoqlardan bo'lib o'zbek, rus, ingliz, nemis, ispan, arab. hind tillari 
kiritilgan matnni boshqa bir tilga taijima qilish imkonini beradi. Tizimning Xabarlar, 
Forum Wiki, Blog, Reklama, Qidiruv, Yordam qismlari mavjudki u 
foydalanuvchilarga yanada qulaylik yaratadi. Tizimdan to'laqonli foydalanish uchun 
ro'yxatdan o'tish talab qilinadi. Bu tizimdan esa xorijiy tillami o'rganishda yoki 
xorijiy mamlakatlar savtlaridan olingan matnlarni taijima qilishda foydalaniladi.

5 .10-rasm. Uz-Translations sayti oynasi

Ta’limiy savtlami o'quv jaray onida qoilash o'qituvchilami o'z ustida ko'proq 
ishlashga (o'quv materiallarini tayyorlash: ma’ruza, seminar, amaliy mashg'ulotlarga 
doir nazariv materiallar tayyorlash, tajriba ishlariga doir materiallami to'plash, tahlil 
qilish, dars jarayoniga tegishli ob'yektlar uchun imitatsion modelidan foydalanish, 
mavzular bo'yicha savol-javoblar va boshqa materiallami tayyorlash) undasa, 
talabalaming darsga qiziqishini, faolligini oshishi, aqliy rivojlanishi vaongli ravishda 
munosabatda bo'lishga undaydi. Bunda ta’lim sifati vaxshilanadi, o'qitish 
samaradorligi oshadi. O'quv muassasalar uchun yaratilgan saytlarda eng muhim 
fanlarning eng yaxshi ma'ruzalari, darsliklari, qo'llanmalari chop qilinmoqda. 
O'qituvchilar bu ma lumotlardan o 'z darslarida asos sifatida fovdalanishlari mumkin.
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Intemetsiz ta lim esa fan-texnikaning eng so‘nggi yutuqlaridan xabarsiz qolishga olib 
keladi.

Mashhur qidiruv tizimi Google (цлулу.google.com) ham foydalanuvchilari 
uchun taklif qilgan bepul xizmatlari orasida taijima qilish imkoniyatini taqdim qiladi. 
Bu imkonivat dunyoning yuzdan ortiq tilida kiritilgan matnni boshqasiga taijima 
qilish imkonini beradi. Buning uchun Google saytiga kirgandan keyin xizmatlar 
ro'yxatini ochib. undan tarjima xizmatiga o'tiladi (Переводчик) (5.1 1-rasm).

Гкмта J g J J J

Google
\ r  н а  Ijyct.4!

9
ОЙ 5*«3y*

a
YocTube

м с

s7
Мой а»*зу*т Поиск Карты

t i ~
VocTobe Play Иовогчи

u Googlu Мне погюз'/т?
П хта  Калв*<д.*р*

®  *  Лг I
Google Пвревсджг Фтто

5.11-rasm. Google xizmatlar oynasi 
Unda ochilgan oyna ikkita qismli maydondan iborat bo‘lib, chap tomondagi 

maydonga taijima tili tanlangan holda taijima qilinishi kerak bo‘lgan matn kiritiladi. 
0 ‘ng oynada esa taijima qilinishi kerak bo'lgan tilni tanlab Перевести tugmasi 
bosiladi. Shundan so'ng o'ng tomondagi oynada tanlangan tildagi taijimasi paydo 
boladi (5.12-rasm).
Go gle

Переводчик

вигАмйсимя русским ченщцмй Овргделить язык иМЛШККЦЯ уЦМЙИСкМЙ

Змцнов тймт i»n»* здре- а&'угАРМ гт г ,  пеие-йд*№ д »

5.12-rasm. Google tizimi tarjima oynasi 
Tizimdan foydalangan holda matnlami boshqa tilga taijima qilish va shu orqali 

til o'rganish ham mumkin. Tizimning so'zlar bazasi juda katta bo‘lib, biroq lug‘at
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bazasida uchramavdigan so'zlami tarjima qila olmaydi. Bunday holatda boshqa 
tarjimonlar singari so‘zning kiritilgan holatini qoldiradi.

Savol va topshiriqlar
1. Lingvo dasturi imkonh atlarini ay ting?
2. Promt dastun imkonivatlarini ayting?
3. Magic Gooddy dasturi imkoniyatiarini ayting?
4. Google tizimining tarjima imkoniyatlarini aytib bering?

Test savollari
1. ABBYY Lingvo dasturi qaysi operatsion 
tizim lard a ishlaydi?
A) Windows, Windows Mobile, Symbian OS, Mac
OS X, iOS, Android;
B) Windows, Windows Mobile, Symbian OS, 
Lenux, iOS, Android,
C) Window's, Windows Mobile, Symbian OS, Unix, 
iOS, Android;
D) Windows, Windows Mobile, Symbian OS, MS 
DOS, iOS, Android;

2. ABBYY Lingvo dasturi yaratuvchilarining 
rasmiy sayti qaysi?
At www.lingvo.ru;
B) www.abbwliagvo ru;
C) www ling vouz.
D) wwwlingvo.com;

3. ABBYY Lingvo dasturi yaratuvchisi kim?
A) Rossivaning ABBYY kompaniyasi;
B) Gruziyamng ABBYY kompaniyasi;
C) О 'zbekistonning ABB YY kompaniyasi;
D) Oozog'istonning ABBYY kompaniyasi;

4. Magic Gooddy dasturming bazasida qancha 
so‘z bor?
A) 800 mingdan ortiq;
B) 850 mingdan ortiq;
C) 900 mingdan ortiq;
D) 950 mingdan ortiq;

5. PROMT dasturi tarjima qilingan matnni 
qanday formatlarda saqlash imkonini beradi?
A) rtf. txt
B) pdf
C) doc;
D) html;

6. PROMT dasturining rasmiy nomini topmg?
A) PROMT Standard;
B) PROMT Office;
C) PROMT Oficial;
D) PROMT Home;

7. Quyidagi saytlardan qaysi biri keng 
masslitabli tarjima imkoniyatiga ega?
A) www.gooBle.com;
B) www.transo.com;
C) www.vahoo.com;
D) wwwr;vandex.ru:

8 Lug at 3.0 dasturi qachon va kim tomonidan 
ishlab chiqilgan?
A) «SPELLS» firmasi tomonidan 2003 yilda;
B) «SPELLS» firmasi tomonidan 2013 yilda;
C) «Lug‘at» firmasi tomonidan 2003 yilda;
D) «Lug‘at» firmasi tomonidan 2013 yilda;

9 Magic Gooddy dasturi qaysi kompaniya 
mahsuloti hisoblanadi?
A) Promt;
B) Magic Gooddy,
C) Translate;

D) Gooddy,

10. ABBYY Lingvo x5 vei-siyasi nechta tilda 
taijima qiladi?
A) 20;
B) 5;
C) 8;
D) 16;
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26-§. Ma'lumot tipini o‘zgartiruvch dasturlar 

Tayanch tushunchalar: format, konvertor dastur, video Iconvertor, audio konvertor.

Raqamli ma’lumotlar bilan ishlashda ko'pchilik hollarda ulami mazmunan 
saqlagan holda boshqa formatlarga o'tkazishga to'g'ri keladi Bu esa o'z navbatida 
bu mazmundagi raqamli ma'lumotdan boshqa dasturlami qo'llagan holda ijro qilish 
va hatto tahrirlash imkonini beradi. Masalan, PDF formatidagi hujjatni Word 
formatlariga o'tkazish natijasida faqat o'qish uchun mo'ljallangan faylni endi Word 
dasturida tahrirlash va o'zgartirishlar kiritish mumkin bo'ladi. Bu ikkala mashhur 
format hujjatlarini o'zaro konvertatsiva qilishga doimo talab yuqori bo'lgan. PDF 
singari DOC hujjatlari ham ofislaming standarti hisoblanadi va deyarli barcha ofis 
kompyuterlaridan Word dasturi va PDF hujjatlami ko'rish uchun dastur o'rnatilgan. 
Biroq gohida bu formatlarning biridan ikkinchisiga o'tkazishga zarurat paydo bo'ladi. 
Konvertor dasturi faqatgina PDF formatidan Word formatlariga o'girib berish 
yo'nalishida ishlaydi. Ya’ni konverter dasturi PDF fayldagi hujjatni DOC matniga 
(shriftlan va stil bilan birga), kartinkalar, jadvallar, grafiklar va boshqa elementlami 
o'tkazib beradi. Bu esa faqat o'qish uchun mo'ljallangan PDF faylni endi Word 
dasturida aynan o'zidek qilib ochish va unga o'zgartirish kiritgan holda qayta saqlash 
imkonini beradi. Turli konvertorlar bu ishni turli aniqlik darajasida amalga oshiradi. 
Konvertatsiya jarayonini to'liq hujjat uchun yoki shuningdek alohida betlar va bet 
qismlari uchun amalga oshirish mumkin.

Gohida, video fayllar qattiq diskda juda ko'p joyni band qilib qo'yadi 
(masalan, bevosita kameradan yuklangan video) va bizdan uni kichraytirish talab 
qilinadi. Shuningdek, mobil qurilmaga videoni yuklash (playerlar, smartfonlar) ham, 
fayl o'lchamini kichiklashtirishsiz amalga oshmaydi. Avniqsa, yuqori sifat kichik 
monitorda sezilmavdi ham. Bunday holatiarda videoni sifatli kodek yordamida qay ta 
ishlash butun fayida sifatini saqlagan holda o'lchamini sezilarli darajada 
kichiklashtirishi mumkin. Videoni siqish uchun mavjud ko'psonli tekin 
konvertorlardan biridan foydalanish mumkin.

FLAC -  bu Free Lossless Audio Codecdan abbreviatura hisoblanadi. Bu 
format audio ma'lumotlami sifatini yo'qotmasdan siqib berish uchun ishlatiladi. Bu 
formatning asosiy ustunligi shundaki, kodek tekin hisoblanadi va har qandav ijro 
dasturi bilan o'zaro moslasha oladi. Biroq, bunday paytda bunday formatdagi 
fayllami shaxsiy kompyuterda ijro qilish muammo hisoblanmaydi. Portativ 
qurilmalar uchun yanada kengroq tarqalgan format kerak bo'lishi mumkinki, bunday 
formatlami faqatgina konverterlar yordamida olish mumkin. FLAC formatini MP3 
formatiga aylantirish uchun bir qancha dasturlar mavjud.

Konvertorlar bir nechta formatdagi fayl bilan ishlashi mumkin. Ya’ni dastlabki 
o'zgarishi kerak bo'lgan format ham va so'nggi hosil bo'ladigan fayl ham bir necha 
hil formatda bo'lishi mumkin. Masalan, video konvertor bir nechta video favlni olgan 
holda boshqa bir nechta video fayldan biriga aylantirib bera oladi degani. Boshida 
konvertatsiya qilish ro'yxatiga treklami qo'shish (odatda oddiy sichqoncha 
yordamida surish yo'li bilan), keyin esa formatni tanlab olish va qayta ishlash
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iarayonini boshlash kerak. Ko'plab konverterlar paketli rejimda qayta o'zgartirishni 
qoiiab-quvvatlaydi (bir nechta fayl birin-ketin). Undan tashqari, bitreyt, chastota 
kabi parametrlami sozlash audio sifatini va so'nggi faylni o'lchamini aniqlashga 
imkon berdi.

Konverterlar oson fovdalaniladigan toifadagi dasturiy ta’minot guruhiga kiradi. 
Hatto murakkab sozlamalami ham oldindan o'matilgan profillar yordamida tezda 
qo'llash mumkin. Profillar juda qulay bo'lib ularda aniq bir portativ qurilma uchun 
ma lum sozlamalar joy olgan (iPod, iPhon, Android-devayslar va boshqalar). Bu 
to'plamda shunday dasturlar to'planganki rasm fayllarini PDF formatga konvertatsiya 
qilib beradi. PDF hujjatlami uzatishning standarti hisoblanib, ko'pincha hujjatlami 
shu formatga konvertatsiya qilish zarurati paydo bo'ladi.

JPGdan PDFga avlantirish konverterlari fayllami paketli qayta ishlashni 
qoiiab-quvvatlaydi, bu esa birdaniga minglab rasmlami qayta ishlash imkonini 
beradi. Tasvir sifatini o'zgartinsh mumkin. Shuningdek, olinadigan PDF favlning 
parametrlarini sozlash mumkin. Bunday konverterlar bilan ishlash juda oson. 
Birinchidan fayllami import qilish kerak. Buni fayl va papkalami ko'rish muloqoti 
orqali yoki dasturda fayllami oddiy surib kelish yo'li bilan amalga oshiriladi. Kevin 
zarur konvertatsiya qilish sozlamasi qo'yiladi va qayta ishlash jarayoni ishga 
tushiriladi. Ayrim konverterlar nafaqat JPG va balki boshqa tasvir formatlarini ham 
qo' llab-quvvatlaydi.

PDF fayllami Excel formatiga konvertatsiya qilish Microsoft Office bilan 
ishlashda fayl tarkibiga qulay tarzda bog'lanish imkonini beradi. Odatda Excel 
jadvali uchun konvertatsiya qilishning so'nggi formati bo'lib XLS fayli hisoblanadi, 
biroq ayrim ilg'or konverterlarda XLSX formatida ham fayl olish imkonini beradi. 
Bu turdagi aksariyat konverterlar PDF faylida joylashgan elementlaming asl 
joylashish holatini saqlab qoladi va buzilmagan tuzilishdagi sahifani taqdim etadi. 
PDFdan Excel dasturiga konverterlar bir vaqtda bir nechta fayllar bilan ishlashga 
imkon beradi. Bunda bir nechta PDF hujjatni bitta Excel hujjatga birlashtiradi. 
Konvertatsiya qilishdan oldm siz matnni, tasvimi, jadvalni va boshqalami qayta 
ishlash optsiyalarini ko'rsatishingiz mumkin Masalan, agar sizga PDF fayllardagi 
kartinkalar kerak emas bo'lsayu, biroq faqat matnli ma lumot muhim bo'lsa, siz 
so'nggi XLS fayldan kartinkalami ko'chirishni chiqarib tashlashingiz mumkin.

Bunga o'xshash dasturlarda ishlash hatto yangi foydalanuvchilar uchun ham 
ko'pchilik uchun qiyinchilik tug‘dirmaydi. Ish qadamba-qadam olib boriladi: dastlab 
fayllami import qilish kerak, keyin optsiyalami boshqarish, formatni tanlash, qolgan 
hamma ishni dastuming o'zi amalga oshiradi.

Portable Document Format formati PDF formati singari ko'proq tanilgan. 
Shuningdek bitta fayida eng zo'r tarzda matn, 2D grafika va formatlash 
elementlaridan tarkib topgani bilan u afzal hisoblanadi. Biroq bu formatning 
mashhurligi bilan birga uni boshqa formatlarga o'tkazib berish uchun ko'plab 
konverterlar paydo bo'ldi. Ulardan fovdalangan holda PDF fayllami rasmga turli xil 
MS Office hujjatlanga va boshqa ayrim formatlarga aylantirish mumkin. Barcha 
konverterlar foydalanishga qulay bo'lib, faqatgina konvertatsiya qilish bilan 
cheklanmasdan, balki ularga o'zgartirish kiritish imkonini ham beradi. Masalan, rasm
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formatiga konvertatsiva qilishda siz yorqinlik, kontrast, karlinka oichami va boshqa 
shu kabi parametrlami sozlashingiz mumkin. Shuningdek ko'p varoqli PDF 
hujjatlami ham konvertatsiva qilish mumkin. Siz Word dasturining matnli hujjati 
yoki taqdimotga ega bo‘lib turib qulay tarzda PDF huj jat yaratishingiz mumkin. MS 
Office hujjatlarini, xususan DOC formatini mashhur PDF favllariga aylantirish -  juda 
ko p talab qilinadigan vazifa hisoblanadi. DOC hujjatlarini PDF hujjatlariga 
aylantirishning bir nechta usuli mavjud. Birinchi usuli - konverterlar, ikkinchi -  chop 
etish funktsiyasi orqali PDF hujjatlarini yaratishi mumkin boigan dasturlash. 
Konvertatsiya qilishning ikkinchi usuli DOC formatli hujjatlami PDF formatiga 
konvertatsiva qilishda bunday dasturlar unchalik ham standart yondashuv 
boimasada, biroq u birinchi usulga qaraganda qulay hisoblanadi. Odatda konverterlar 
konvertatsiya qilish parametrlarini sozlashga imkon beradi. Masalan. siz DOC 
hujjatning har bir betini aiohida PDF hujjatga o‘girishingiz mumkin, yoki sahifaning 
aniq betini ko‘rsatishingiz, shuningdek konverter orqali matn shrifti va uning stilini 
o‘matishingiz mumkin. Hujjatning muallifi va yaratilgan sanasi haqidagi 
ma lumotlami qo‘shish mumkin. PDF hqjjatlar yaratuvchi dasturlar Word dasturi 
bilan ishlash uchun juda qulay hisoblanadi. Bunday dasturlaming ishlash printsipi 
shundan lboratki. ular tizimga virtual printerlar o'matadiki, hujjatni chop etishga 
vuborish o‘miga aynan shu buyruq ostida PDF fayllami yaratadi. Har qanday 
dasturdagi va hujjat ko‘rinishidagi fayllami chop etish funktsiyasini qoilab- 
quvvatlaydi. Shu tarzda MS Word dasturida ishlovchi foydalanuvchi o ‘z ishini oddiy 
v o i  bilan chop etishga vuborib, dasturda o‘matilgan virtual printemi tanlab PDF 
hujjat olish mumkin boiadi. Docx elektron hujjatlar yaratish uchun moijallangan 
eng vosh va eng ilg‘or format hisoblanadi. Bu -  Microsoft kompaniyasining Open 
XML seriyasidagi yangi ishlanmalaridan biri boiib, eng mashhur va ko'p ishlatish 
uchun moijallangan Microsoft Word ofis ilovasi hisoblanadi. docx formati o‘zida 
zip-arxivni taqdim qilib (faylni oichamini kichraytirish uchun), qu>idagilardan tarkib 
topadi: XML ko‘rinishidagi matn, jadval maiumotlari, maxsus simvollar, grafika va 
boshqa ko'plab malumotlami birlashtiradi. Bunday format bilan foydalanuvchida 
yetarlicha keng imkoniyatlar paydo boiadi. Bunga qo shimcha ravishda u bilan 
ishlaydigan barcha zamonaviy ilovalar yetarlicha tez va yanada to‘g‘ri ishlavdi. Biroq 
bu formatning bitta kamchiligi bor. Ayrim ofis ilovalarining eski versiyalari 
(masalan, Microsoft Office 2003), shuningdek elektron kitoblar hujjatlami o‘qish 
uchun dasturlar u bilan ishlay olmasligi mumkin. Bu maqsadlarda ixtisoslashgan 
utilitlar mavjudki, joriy fayllami sizga qulay formatga o'zgartirish uchun qodir. Ular 
bilan siz har qanday faylni ocha olasiz. Misol uchun docx konverterlari bunday 
fayllami osongina pdf universal formatiga, odatiy doc formatiga yoki hatto fb2 
formatiga aylantirib berishi mumkin.

AVI. Ushbu dastur to‘plamidan siz juda kerakli qoilash uchun oddiy va toiiq  
funktsiyali utilitni tanlashingiz va tekinga ko‘chirib olishingiz mumkin. Ulaming 
ко pchiligi birdaniga bir nechta formatlami qoilab-quvvatlaydi. AVI formati uchun 
tekin konverterlar to'plami hisoblanadi. Konverterlar ishlash tezligi va videoni 
o'zgartirish uchun qoilaniladigan kodeklari bo'yicha farq qilishi mumkin. Agar siz 
bitta konverterdan qoniqmasangiz -  boshqa tekin konvertemi sinab ko‘ring. Chunki
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boshqasining tezligi va ishlash sifati yuqori boMishi mumkin. Ayrim konverterlar 
nan AVI formatni boshqa belgilangan formatga aylantirish uchun yaratilgan. 

Bunday tor ixtisoslashgan dasturiaming yaxshi tomoni bitta vazifaga qaratilgan holda 
ular bu vazifani ko‘p funktsiyali uskunalarga qaraganda yaxshi bajaradi. Bunday 
konverterlardan foydalangan holda siz faqat bir juft formatlar bilan ishlaysiz. 
Ko pincha tekin AVI konverterlar videoni qayta ishlash uchun qo'llaniladigan 
kodeklami almashtirishga imkon berib, shuningdek bitreyt singari, kartinka tomonlari 
o‘ rtasidagi munosabat, tovush sifati, kartinka oichami, video sifati va boshqa 
parametrlami sozlashga imkon beradi. Ya ni siz video fay lning sifati xususiyatini 
sozlashingiz mumkin. Shuningdek, formatlami o‘zgartirish uchun dasturlar faqatgina 
konvertatsiya qilish uchun emas balki oddiy tahrirlash operatsiyalarini: favllami 
qirqish va birlashtirish funktsivalariga ham ega bo iishi mumkin.

Qator konverterlar mavjudki ular mobil qurilmalarda fayllami ko‘rish uchun 
v o ‘naltirilgan. Bunday dasturlar sozlamalarida iPod, iPhone va boshqa qurilmalar 
uchun oldindan o‘matilgan proftllar mavjud. Siz rasm o‘lchamini va butun favlni o‘z 
mobil qurilmangiz uchun sozlashingiz mumkin.

DWG -  bu SAPR-lovihalanda qo'llaniladigan eng mashhur format 
hisoblanadi. Bu formatnmg mashhurligi uning eng mashhur CAD-dasturlami 
to‘g ‘ridan-to‘g ‘ri qo‘llab-quwatlashi bilan izohlanadi. Shuningdek, ular o‘zida 2D, 
3D loyihali ma'Iumotlami saqlashi uchun xizmat qilishi mumkin. Qachon 
foydalnuvchi DWG formati bilan ishlasa ko‘pincha uni PDF hujjatiga aylantirish 
xohishi pavdo bo‘ladiki. bunda loyihani hamkorlarga yoki hamkasblarga uzatish 
uchun bundan holatlarda ma’lumotlarga bog'lanishni soddalashtirish talab qilinadi. 
DWG fayllami PDF hujjatlarga aylantirish uchun biz universal yechimlami taklif 
qilamiz. Ikki toifa dasturlar mavjud: DWG fayllami ko'rish uchun dasturlar va 
hujjatni chop etish funktsiyasi orqali PDF fayllami yaratuvchi virtual printerlar 
dasturi. Bu usul ikkala ilovani ham o‘matishni talab qiladi. DWG chizmalami ko‘rish 
dasturlarini o ‘matib, siz bu chizmalami ko‘rishingiz va darhol ulami PDF formatida 
saqlab olishingiz mumkin. Favlni PDF formatida saqlash uchun chizmani chop 
etishga buyruq berish va PDF faylni yaratish uchun avvaldan o‘matilgan virtual 
printemi tanlash kerak. Siz tomoningizdan ko'rsatilgan papkada sizning loyihangiz 
bilan PDF fayl hosil boMadi. Shu tarzda siz ma lum dasturlarni o‘matishingiz kerak 
bo‘ladi. MasaJan. DWG TrueView Q PDFCreator yoki Free DWG Viewer Q BullZip 
PDF Printer

Android bazasidagi smartfon va telefonlar uchun video konvertatsiya qilish 
murakkab vazifa emas. Bu to'plam das turlari sizning mobil qurilmangiz ekranida 
yaxshiroq sifatda aks etishi uchun videoni o‘zgartirishga yordam beradi. A)rim 
konverterlar Android tizimidagi aniq bir qurilmalar uchun maxsus tarzda videoni 
okzgartirishga imkon beradi. Boshqalari esa faqat mos keladigan formatni tanlash 
(MP4, 3GP va boshqalar) va smartfon uchun mos keladigan parametrlami o‘matish 
imkonini beradi.

Free Video to Android Converter va Sony Ericsson Media Studio singari 
dasturlar foydalanuvchiga o lzining telefon modelini tanlash imkonini beradi. Bunday
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imkoniyat ko plab ichki profillar vositasida tashkil qilingan bo'lib, ulaming har birida 
aniq bir telefon uchun kerakli sozlamalar to‘plangan.

Altemativ konverterlar sifatida Mobile Media Converter, XviD4PSP va 
boshqalar kabilami keltirish mumkin. Ular video formatini, kartinka proportsiyasini, 
kartinka o'lchamini tanlash, “sifat G' fayl o'lchami" munosabatlarini boshqarish, 
kodek tanlash va hatto videoni qirqish imkonini beradi. Android tizimidagi telefonlar 
va smartfonlarda konvertatsiya qilishning ko'plab dasturlari tekin hisoblanadi. Canon 
raqamli fotokamerasi yordamida olingan barcha fotografivalar fayida CR2  
kengavtmasi bilan saqlanadi. Bu favllar kamera matritsalari bilan bevosita olingan 
tasvirlardan tarkib topib. ular birorta ham qay ta ishlashga duch kelmagan boiadi. 
Bunday rasmlami foydalanuvchi kompyuterga otkazgandan keyin foydalanuvchi 
ulami mashhur grafik formatlarga konvertatsiya qilishi kerak boiadi. Bu esa unga 
keyinchalik chop etish va tahrirlash imkonini beradi. CR2 tasvirni qayta ishlash 
uchun RAW formatlami qoilab-quvvatlaydigan muharrirlar yoki konverterlaming 
biridan foydalanishi kerak bo'ladi. Universal konverterlar mavjud bo'lib, ular ko'p 
sonli formatlami qoiiab-quvvatlaydi. Undan tashqari, CR2 fayllami konvertatsiya 
qilish uchun siz to laqonli muharrirlardan biridan foydalanishingiz mumkin. Ular 
nafaqat rasm fayilarini kerakli formatda saqlash. balki kerakli qiyofa o'zgartirishni 
ham amalga oshirish imkonini beradi. Masalan, siz kontrastni, rasm yorqinligini va 
hatto rasmga effektlar berishingiz mumkin. Undan tashqari, agar sizda Adobe 
Photoshop darajasidagi grafik muhamr bo'lsa, u holda ulami ham shu tarzda CR2 
kengaytmali fotografiyalami ochish uchun qo'llashimiz mumkin.

CDR - CorelDRAW dasturi tasvirlan uchun qoilaniladigan Corel firmasining 
formati hisoblanadi. Biroq CDR hamma yerda qo ilaniladigan format emasligi uchun 
ko'pchilik foydalanuvchilar bu formatni ko'proq mashhur formatlarga aylantirishga 
ehtiyojlari mavjud. CorelDRAW dasturining o'zida va tekin konverterlarda ham 
CDR loy ihasini yanada mashhurroq formatlarga aylantirish mumkin.

XnVievv Full va IrfanVievv -  bu dasturlar konverter va muharrir dasturi ami ng 
birgalikda ishlab chiqilgani hisoblanadi. Ya'ni, siz ko'plab fayl formatlarini 
ochishingiz, ko'rishingiz, ulami yanada sizga mos keladigan boshqa formatlarda 
saqlashingiz, shuningdek tahrirlashingiz ham mumkin. Bu formatlar ko'p sonli 
formatdagi tasvirlami, shu jumladan CDR formatini ham qo'llab-quvvatlaydi. 
Inkscape -  vektorli grafika muharriri hisoblamb, Adobe Illustrator va CorelDRAW 
dasturlarining bepul analogi hisoblanadi. Uning yordamida siz CDR formatlami 
ko'rishingiz va bu fayllami boshqa formatlarga konvertatsiya qilishingiz mumkin.

Konvertor -  bu formatlami o'zgartirish uchun universal dastur bo'lib, biroq 
tasvimi tahrirlash uchun filtrlarga ega.

MIDI -  elektron musiqa uskunalari orasida ma lumot almashinish uchun 
varatilgan format hisoblanadi. MIDI formatlami boshqa formatlarga yoki teskarisini 
qilish uchun bir nechta konverterlami qo'llash mumkin.

Audio konverterlar -  bu yetarlicha sodda dasturlar bo'lib, unda nafaqat 
formatlami almashtirish, balki fayl xususivatlarini ham o'zgartirish mumkin. Undan 
tashqari, konverterning o'ziga xos jihati bu ko'plab fayllami paketli rejimda 
konvertatsiya qilish imkoniy at hisoblanadi. MIDI fayllar qo'shilgandan keyin siz
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vangi formatni olishingiz (masalan MP3) va shuningdek bitreyt, chastotani va boshqa 
ay rim parametrlami o‘zgartirishingiz mumkin. Kevin esa faqat faylni konvertatsiya 
qilishga jo ‘natish kerak. Shunday konverterlar mavjudki ular teskari tartibda 
o‘zgartirishga qodir. Masalan WAV, MP3 va boshqa formatlardan MIDI fayllar 
varatish. Konverterlangan MIDI fayllar aniq bir uskunani sadosidan taifkib topadi.

Agar sizga video faylingizni AVI formatga o‘girishingiz kerak boisa u holda 
buning uchun ko‘plab konverter dasturlar mavjud. Video-konverter murakkab dastur 
hisoblanmaydi va uni ishlatish uchun maxsus bilim va ko'nikmalar kerak ham emas. 
Dastur ishga tushgandan kevin siz kerakli fayllami ro‘vxatga olib tashlashingiz kerak 
boiadi. Kerakli format va sozlash tanlangandan kevin konvertatsiya qilish jarayonini 
boshlash mumkin boiadi. Sozlama bu yerda yuqorida aytilganidek bu yangi hosil 
qilinavotgan faylning parametrlari hisoblanadi: bitrevt, sifati. kartinka tomonlarining 
munosabati, audio oqim bitreyti (inglizcha bitrate so‘zidan olingan boiib —  
multimediyali kontentni bir sekundli qismini saqlash uchun qoilaniladigan bitlar 
soni) va boshqalar.

Ko'plab konverterlar oldindan belgilangan (o‘matilgan) profillarga ega boiib  
ular turli maqsadlar uchun sozlamalar to'plamidan iborat. Shu bilan birga, kerakli 
parametrlami olish uchun siz kerakli sozlamalarga ega profilni olishingiz kerak. 
Bular smartfonlar uchun profillar boiishi mumkin. Belgilangan formatlar uchun 
profillar boiishi mumkin. Dasturning shu to‘plamida siz DBF (ma lumotlar bazasi 
fayli) fayllami ko‘rish va konvertatsiya qilish vositalarini topasiz. Bu fayllar o ‘zida 
maiumotli elektron jadvallami taqdim qiladi va ular XML, XLS, SQL, CSV va 
boshqalar kabi formatlarga avlantirilishi mumkin. Konverterlar qadamba-qadam 
master printsipi bo‘yicha va qoilashda oddiylik printsiplari bo'yicha qurilgan. 
Foydalanuvining bor yo‘g ‘i qiladigan ishi -  bu DBF faylni provodnik orqali qo'shish, 
kevin esa sozlama va so‘nggi formatni tanlash va o'zgartirishni ishga tushirish kerak. 
Muharrirlarga keladigan boisak, u holda siz faqatgina DBF formatidagi elektron 
jadvalni ochishingiz va urn boshqa formatda saqlashingiz mumkin. Shuningdek 
muharrirlar jadvaldan tezda va samarali tarzda ma lumotlami qidirish va maydonlar 
qiymatlarini o‘zgartirishgaimkon beradi.

PPT -  taqdimot formati boiib, Microsoft kompanivasi tomonidan ishlab 
chiqilgan va PowerPoint dasturi uchun asosiy format hisoblanadi. Bu dastur 
to‘plamida taqdimotni boshqa multimedia -  kontentga aylantirib beruvchi 
konvertatsiya qilish vositalari to‘plangan. Foydalanuvchilar ko‘p slaydli taqdimotni 
ko'p sabablarga ko ra video, flash-roliklar yoki PDF hujjatlari fayliga avlantirishga 
harakat qiladi. Ushbu dasturdan siz aynan shu maqsadlarda foydalanishingiz mumkin. 
Konverterlar taqdimotning barcha elementlarini sinchkovlik bilan ko‘chiradi: tasvir, 
animatsivalar. slaydlar orasidagi oiishlar, matn, jadvallar va boshqalar. Boshqa 
dasturlarda boigani kabi taqdimotni video formatiga oikazishda ham siz so‘nggi 
fayl parametrlarini sozlashingiz mumkin. Odatda bunday parametrlarga kartinka 
oichami, kartinka tomonlari munosabatlari, sifati va boshqalami aytish mumkin. 
Gohida kodeklami tanlash mumkin boiadi. Bu konverter bilan ishlash ham uncha 
murakkab emas. Avval taqdimot fayli olinadi, kevin esa sozlamalami o ‘matish, 
qolgan amallami esa dasturning o'zi amalga oshiradi.
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Ko pincha HTML hujjatlardan PDF fayl yaratishga to'g'ri keladi. Bu esa har 
qanday internet sahifani PDF hujjatida saqlab keyinchalik elektron pochtadan 
jonatish yoki hamkasblarga yoki do‘stlarga har qanday usul bilan uzatish. HTML 
sahifalami PDF hujjatga aylantirish uchun sodda dasturlardan biri doPDF va 
PDFCreator hisoblanadi. Ular har qanday boshqa formatlardan shu jumladan HTML 
fayhdan ham PDF favlni yaratishi mumkin. Bu utilitlar ham kompyuterga virtual 
printer singari o‘matiladi. PDF hujjatni varatish jarayoni esa favlni chop etishga 
yuborish bilan tugallanadi. Faylni chop etish muloqot oynasini oching va printerlar 
orasidan dastuming virtual printerini tanlang, kev in esa siz ko‘rsatgan papkada PDF 
hujjat yaratiladi.

iPad bir nechta formatdagi videoni qoilab-quvvatlaydi va gohida videoni 
planshetda ko'rish uchun konvertatsiya qilish talab qilinmaydi. iPad ekranida videoni 
mumkin qadar yaxshi koiinishi uchun maxsus konverterlar yordamidan foydalanish 
kerak. Faqatgina bunda ayni shu planshet sozlamalariga ega profillar mavjud boiishi 
kerak.

Agar video planshetda umuman ijro qilmasa u holda uni MPEG4 formatiga 
konvertatsiya qilish kerak va buning uchun shu formatni qoilab-quvvatlaydigan har 
qandav konverterdan foydalanish kerak. Free Video to iPad Converter -  video 
formatlami o‘zgartirish uchun tekin dastur hisoblanib, 30 dan ortiq formatlarni import 
qilish mumkin. Shuningdek ImTOO iPad Video Converter dasturi ham ko‘p sonli 
formatlami qoilab-quvvatlaydi va videoni H.264 formatiga eksport qilgan holatda 
yuqori sifatli videolar bilan ishlash imkonini beradi. Videoni konvertatsiya qiiishning 
tekin dasturlari orasida Hamster Free Video Converter va Freemake Video Converter 
dasturlari ham mavjud. Bu dasturlar iPadlar uchun keng ixtisoslashgan hisoblanadi.

AVCHD (Advanced Video Coding High Definition) - bu yuqori sifatli videoni 
yozdirish va ijro qiiishning mashhur formati hisoblanadi. Bu format ayrim ijrochi 
dasturlarga mos kelmaydi, shu sababli foydalanuvchi lar uni vanada muvofiqroq 
formatga konvertatsiya qilish uchun harakat qiladilar. Bu formatni muvofiq formatga 
0‘girish uchun sizga mos keladigan konverter zarur boiadi. Any Video Converter 
Free, MediaCoder va Total Video Converter -  singari uskunalarga diqqatingizni 
qarating. Bular amaliyotda sinab ko'rilgan ajoyib konverter dasturlar hisoblanadi. 
Dastur o‘matilgandan kev in ishga tushiriladi va unga kerakli fayllami import qilish, 
natijaviy fayl parametrlarini sozlash va yangi formatdagi faylni olinadi. AVCHD 
video -  bu yuqori sifatli video boiib, uning sifatini yo‘qotmaslik uchun yaxshi 
kodeklar kerak boiadi. Ko'pincha qo shimcha K-Lite Codec Pack Full kodeklar 
paketini omatish talab qilinadi.

DjVu so‘zi frantsuz tilida "deja vu" so‘zidan olingan boiib (nimaniki ko rgan 
boisangiz ma'nosini bildiradi). Bunday kengaytmali fayllar skanerlangan 
hujjatlardan tarkib topadi. Bu format skanerlangan fayllami saqlash uchun 
moijallangan boiib, PDF hujjatlarga nisbatan kam joy egallavdi. DjVu elektron 
kitoblar varatuvchilari orasida katta mashhurlikni q oiga kiritdi, biroq bu format bilan 
ishlash uchun maxsus dastur zarur boiadi. Shu sababli DjVu formatlari uchun 
konverterlar ham juda mashhur hisoblanadi. Bu to plamda nafaqat butun hujjatni 
konvertatsiya qilish, balki faqat kerakli betlami eksportlash imkoni ham mavjud.

126



Elektron hujjatlar konverterlari odatda grafik muharrirlaming ayrim funktsiyalarini 
o'z ichiga olib, nafaqat konvertatsiya qilish balki formatni kerakli tarzda o'zgartirish 
imkonini beradi. Masalan, siz kerakli betni konvertatsiya qilishdan oldin ko‘rib 
oiishingiz. sifatini. yorqinligi, kontrast va gammasini o'zgartirish mumkin. 
Shuningdek hujjatni aylantirish imkonini ham beradiki, bu imkoniyat teskari tartibda 
skanerlangan hujjatlami o'girib o'qish imkonini beradi. Ayrim ilovalar filtrlar 
qo'llagan holda turli xil effektlarni biriktirish imkonini beradi. DjVu formatini 
konvertatsiya qilish uchun dasturlar murakkab emas bo'lib, foydalanuvchi birinchi 
murojaatdayoq tezda o'rganib, o'zlashtirib olish va hujjatlar bilan ishlash imkonini 
beradi.

AMV (Anime Music Video) -  bu multimediali format bo'lib, anime-videoni 
musiqa bilan vozish uchun qo llaniladi. Odatda bunday video animatorlar va fanatlar 
tomonidan ishlab chiqiladi va shu sababli AMV formati keng tarqalinagan va har 
doim ham ijrochi dasturlar tomonidan ishlatib bo'lmaydi. Kompyuterda yoki mobil 
qurilmalarda bunday roliklami ko'rish uchun formatni konvertatsiya qilish kerak 
bo'ladi.

Videoning AMV formatlari uchun konverterlar juda kam, biroq mavjud. Agar 
siz shaxsiy kompyuteming AVI, WMV va boshqa mashhur formatlardagi roliklami 
o'zgartirishni xohlasangiz, u holda yaxshisi AVS Video Converter yoki 
FormatFactoiy singari dasturlardan foydalanish kerak. Formatni o'zgartirishga 
kirishishdan oldin faylni dasturga import qilish, natija fayliga vo'l ko'rsatish va 
kerakli sozlashni berish kerak. Sozlamalar orasida siz video-kodek, freym (kartinka) 
o'Ichami, bitreyt, audio oqim semplreyti (potok haqidagi axborot) singari 
parametrlami topishingiz mumkin.

TXT hujjatlami PDF formatiga konvertatsiya qilish bu ko'p talab qilinadigan 
vazifa hisoblanib, uni yechish maxsus dastur yordamida amalga oshiriladi. PDF 
hujjatlami Adobe Acrobat singari dasturlarda yaratish juda qimmatga tushadi, chunki 
bunday dasturlar pullik hisoblanadi. Shu sababU tekin dasturlardan foydalanish 
maqsadga muvofiq. Ayni paytda bir nechta funktsional dasturlar mavjudki ulardan 
foydalangan holda har qanday formatdan shu jumladan TXT formatdan ham PDF 
formatni yaratish imkonini beradi. Bu dastuming ham ishlash printsipi virtual 
printerlami tizimga o'matishga asoslanadi va shu tarzda faylni o'zgartiradi.

RAW formati uchun konverterlar odatda tahrirlash funktsiyalarini qo'llab- 
quvvatlagani uchun faylni formatini o'zgartirish vaqtida fotografiyada mavjud 
defektlami tuzatishmgiz mumkin. Bunday turdagi dasturlar turli effektlarni 
biriktirish, yorqinlikni o'zgartirish, rang gammasini, to'yinganligini va fotoning 
boshqa parametrlarini o'zgartirish imkonini beradi. Agar sizda ko'p rasm bo'lsa, u 
holda siz paketli konvertatsiya qilish dasturlarini topishingiz kerak. RAW-tasviri 
nomi ostida quyidagi kengaytmali fayilar tushuniladi: .dng - Adobe; 3fr - Hasselblad: 
,anv,.srf,.sr2 - Sony; bay - Casio; crw,.cr2 - Canon; dcr,.kdc - Kodak; erf - Epson: 
mef - Mamiva; mrw - Minolta; ,nef,.nrw - Nikon; orf - Olympus; .raf - Fujifilm; 
raw rwl dng - Leica; raw, rw2 - Panasonic; r3d - Red One; ptx,.pef - Pentax; .srw

- Samsung; ,x3f - Sigma.
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SWF (Small Web Format yoki Shockwave Flash qisqartmasi) - bu 
multimediali konteyner boiib, ko'pincha videoni web-sahifaga joylashtirish uchun 
ishlatiladi. Aslida SWF fayllan Flash dasturining namoyish fayli boiib, juda ham 
kam uchraydi. Intemetdan tashqari bu format animatsiyalar ko‘rinishida ham juda 
ko'p ishlatiladi. SWF videoni nisbatan mashhurroq formatga konvertatsiya qilish 
uchun quyida keltirilgan dasturlardan biridan fovdalanishingiz mumkin. Bu kabi 
dasturlar bilan ishlash hatto yangi foydalanuvchilar uchun ham qiyinchilik 
tug'dirmaydi. Hammasi qadamba-qadam bajariladi. Zarur videoni konverterga 
yuklaganingizdan kevin siz aylantirmoqchi boigan yangi formatni tanlash, 
sozlamalami o'matish va konvertatsiya qilishni boshlash. Dasturning sozlamalarida 
boshqa dasturlar singari bitreyt, freymreyt, video sifati, konvertatsiya qilish uchun 
kodek va boshqa parametrlami kiritish mumkin. Turli sozlamalami soddalashtirish 
uchun ishlab chiquvchilar videoning parametrlarini tezda aniqlab olish uchun 
profillar kiritgan.

3GP -  bu asosan mobil tarmoqlarda qoilaniladigan 3G standarti 3GPP 
fay llari uchun kengaytma boiib, o'zida multimediali konteynerlami taqdim qiladi. 
Biroq ko'plab telefonlar aloqa standartidan qat’iy nazar bu format favllarini audio va 
video ma’lumotlami yozdirish va ijro qilish uchun qoilavdilar. 3GP fayilari 
ko'pincha shaxsiy kompyuterlarda ijro qilish uchun multimedia formatlariga 
konverterlanadi. Undan tashqari agar siz teskari konvertatsiya qilishni xohlasangiz, 
ya’ni shaxsiy kompvuterdan 3GP formatiga o‘tkazmoqchi boisangiz ham bu 
muammoni yechish uchun ham dasturlar mavjud. 3GP fayllar juda kichik oichamda 
boiishi ulaming eng yuqori sifatda emasligini anglatadi. 3GP konverterlar natijaviy 
faylni bitrevt, freymreyt, kartinka oichami, chastota kabi boshqa qator parametTlar 
bilan sozlash mumkin boiadi. Ulaming barchasi birga fayl oichami va video sifati 
o'rtasida balansni shakllantiradi. O'z sozlamalari bilan oldindan omatilgan profillar 
qiziqarli boiishi mumkin. Chunki ularda turli maqsadlar uchun moijallangan 
sozlashning konfiguratsiyalari to'plangan. Har qanday konverteming interfeysi dastur 
bilan intuitiv tarzda ishlash imkonini beradi. Sodda qilib aytganda siz dastumi tez 
o'zlashtirasiz va kerakli operatsiyani bajarishingiz mumkin.

MP4 -  bu video formati ko'pincha mobil qurilmalarda qoilaniladi. Bunday 
formatdagi fayllar video va audio oqimlardan tarkib topishi mumkin. MP4 fayllami 
boshqa video formatlarga konvertatsiya qilish uchun ko‘plab turli xil konverterlar 
yordamidan foydalaniladi. Video konverterlar, odatda birdan bir nechta fayllami birin 
ketin o‘zgartirish imkonini beradi. Shu bilan birga natija faylini sifatini sozlash va 
uning fayli oichamini aniqlash imkonini beradi. Shuningdek, ayrim dasturlar video 
faylni audio faylga va ni videodan audio yoiakni ajratib olgan holda faylga saqlash 
imkonini beradi. MP4 konverterlarini qoilash har qanday darajadagi kompyuter 
tayvorgarligidan oigan foydalanuvchilar uchun murakkablik tug'dirmaydi. Bu toifa 
dasturlari murojaat qilish uchun sodda hisoblanadi. Videoni qo'shish esa yuqorida 
aytilgan misollardagidek ikki yo‘1 bilan amalga oshiriladi. Faylni ochish y o i i  bilan 
va faylni sichqoncha chap tugmasi yordamida surib kelish orqali. MP4 formati 
kompyuterlarda va mobil qurilmalarda ham yetarlicha mashhur hisoblanadi. Bu
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format Etot format iPhone, iPad va iPodlarda asosiy video format sifatida tanlangan. 
U hatto Android-qurilmalarda ham keng qo‘ llab-quvvatlanadi

Bundan tashqari MP3 formati uchun ham audio-konverterlar mavjud boiib, 
ular ham aynan bitrevt, chastota, kanallar, audio-kodeklar, natija faylining 
parametrlarini va boshqa ayrim parametrlami sozlash imkonini beradi. Shuningdek 
bunday dasturlarda turli xil formatlar uchun oldindan o'matilgan profillar mavjud 
boiadi. Agar siz ko'p audio faylni boshqa formatga oikazishingiz kerak boisa u 
holda siz paketli konvertatsiya qilishni qoilab-quvvatlaydigan dasturlardan
foydalanishingiz kerak.

Savol va topshiriqlar
1 . Konvertor dasturlar tasnifmi ayting?
2. Video konvertorlar va ularning imkoniyatlarini ayting?
3 . Audio konvertorlar va ularning imkoniyatlarini ayting?
4. Matnli formatlami pdf formatlariga oikazuvchi dasturlar imkoniyatlarini ayting?
5. HTML hujjatlardan PDF fayl yaratish dasturlarimng imkoniyatlarini ayting?

L Audio ma’luiaotlarni sifatini yo'qotmasdan 
siqib beruvchi dasturni aniqlang?
A) FLAC;
B) Free Video to Android Converter,
C) AVI;
D) DWG;

2. Aniq bir telefon uchun kerakli sozlainalarni 
beruvchi dasturni aniqlang?
A) Free Video to Android Converter,
B) FLAC;
C) AVI;
D) DWG;

3. Oddi} va to‘liq funktsiyali utilitni tanlashingiz 
va tekinga ko'chirib olib beruvchi dastui-ni 
aniqlang?
A) AVI;
B) Free Video to Android Converter,
C) FLAC;
D) DWG;

4. Konverter va muharrir dasturlarning 
birgalikda ishlab chiqilgan dasturni aniqlang'?
A) Xn View Full,
B) AVI;
C) Free Video to Android Converter,
D) FLAC;

5. Quyidagi formatlardan qaysi biii SAPR- 
loyihalarida qo'llaniladigan eng mashhur 
hisoblanadi?
A) DWG
B) MIDI

Test savollari
7. Quyidagi formatlardan qaysi biri sifatli 
videoni yozdirish va ijro qiiishning mashhur 
formati hisoblanadi?
A) AVCHD
B) MIDI
C) DWG
D) DjVu

8. Quyidagi formatlardan qaysi biri 
skanerlangan favllarni saqlash uchun 
mo‘ljallangan format hisoblanadi?
A) DjVu
B) AVCHD
C)MIDI
D) DWG

9. Quyidagi formatlardan qaysi biri anime- 
videoni inusiqa bilan yozish uchun 
qo'llaniladigan format hisoblanadi?
A) AMV
B) AVCHD
C) MIDI
D) DWG

10. Quyidagi formatlardan qaysi biri bu 
multimediali konteyner bo'lib, ko‘pincha 
videoni web-sahifaga joylashtirish uchun 
ishlatiladigan format hisoblanadi?
A) SWF
B) AVCHD
C) MIDI
D) DWG
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C) AVCHD
D) DjVu

6. Quyidagi fonnatlardan qaysi biri elektron 
musiqa uskunaiari orasida ma’lumut 
alinashinish uchun yai-atilgan format 
hisoblanadi?
A) MIDI
B) DWG
C) AVCHD
D) DjVu
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VI BOB. KOMPYUTER TARMOQLARI

27-§. Kompyuter tarmoqlari va ularning turlari

T a y a n c h  tushunchalar: server, kompyuter tarmog'i, lokal tarmoq, mintaqaviy 
tarmoq, global tarmoq. LAN, CAN, WAN, MAN, GAN, PAN.

Kompyuter tarmoqlarining paydo bo‘lish sabablaridan biri resurslardan 
hamkorlikda foydalanish, alohida kompyuter imkoniyatini kengavtirishdir. Tarmoq 
orqali foydalanuvchilar bir vaqtning o'zida bir xil ma lumot va fayl nusxalari. amaliy 
dasturlar bilan ishlashi mumkin. Bu holat axborot tashuvchilardagi joyni tejavdi. 
Bundan tashqari, printer, skaner, modem, lazer disklar majmuining birgalikda 
ishlatilishi qo'shimcha chiqimning oldini oladi.

Telekommunikatsiyalar aloqa uchun signallami elektron uzatish vositasi 
hisoblanadi. Bu uzatishda tashkilotlar o'zlarinmg jarayonlari va vazifalarini 
bajarishni tashkil qilish ishlari kompy uter tarmoqlari yordamida sifatli va samarali 
tashkil qilinadi. Telekommunikatsiyalar simli, simsiz va sun’iy vo'ldosh aloqasi 
orqali tashkil qilinishi mumkin. Associated Press 1920 yillarda 
telekommunikatsiyaning birinchi foydalanuvchilaridan edi. Unda yangiliklami 
AQSH bo'ylab 103000 mildan uzoqqa jo'natib bergan. Shuningdek, 10000 mil 
kabellami okean orqali tortilgan. Bugunda esa telekommunikatsiyalar butun 
dunyodagi katta va kichik tashkilotlarda, jismoniy shaxslar tomonidan keng 
qoilanilmoqda. Telekommunikatsiyalar yordamida odamlar uyda, ishxonada va hatto 
sayohatda yurib ham ishlashi mumkin bo'ladi. Bunday yondashuv y ordamida o‘z 
ishingizni dunyoning AQSH, Xitoy yoki boshqa ixtivoriy telekommunikatsiyalar bor 
davlatiga jo'natish mumkin bo'ladi. Binoda kompvuterlar va qurilmalami tarmoqqa 
ulash butun mamlakatda yoki butun dunyoda elektron aloqani tashkil qilish imkonini 
berdi.44

Tarmoqdan foydalanganda axborotni saqlash ishonchliligi ortadi, chunki juda 
oddiy usulda qimmatli axborotlami qayta nusxalash mumkin va alohida 
foydalanuvchilar o'rtasida axborot almashish yengillashtiriladi. Bugungi kunga kelib, 
ayniqsa ta’lim faoliyatida, tarmoq (ko'p foydalanuvchi) dastur mahsulotlaridan keng 
foydalanilmoqda. Ular foydalanuvchilar so'rovini mujassamlashtiradi. bir vaqtning 
o'zida axborotdan foydalanish imkonini beradi.

Apparat qurilmalari va tarmoq dastur ta’minoti orqali o'zaro bir-birlari bilan 
hamohang ishlay oladigan kompyuterlar majmuiga tarmoq deyiladi. Shuningdek, 
kompyuterlaming o'zaro axborot almashinuvini taminlovchi qurilmalar majmuiga 
deb ham aytish mumkin. Tarmoqlami turli me’vyorlarga ko'ra sinflarga ajratish 
mumkin. Bular:

O'tkazish qobiliyati. ya’ni ma'lumotlami tarmoq uzatish tezligiga muvofiq:
■ past 100 Kbit/s gacha;

14 Ralph M. Stair, George W. Reynolds Fundamentals o f  Information Systems. Sixth edition. Course Technology,
Cengage Learning. USA. 2012. 12-p.
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■ cfrta 0,5-10 Mbit/s gacha;
■ yuqori 10 Mbit/s dan ortiq.

Uzoq kommunikatsiya tarmoqlari bilan ishlash tezligi, ulaming fizik 
oichoviga muvofiq:

■ LAN ( Local-Area Network) lokal tarmoq (bir ofis, bino ichidagi aloqa);
■ CAN (Campus-Area Network) - kampus tarmoq, bir-biri bilan telefon yoki 

modemlar bilan ulanish, ammo yetarlicha bir-birlaridan uzoqda joylashgan 
kompyuter lokal tarmoq;

■ MAN (Metropolitan-Area Network) katta tezlik bilan aloqa uzatish (100 Mbit/s) 
imkoniyatiga, katta radiusga (bir necha o‘n km) axborot uzatuvchi kengaytirilgan 
tarmoq;

■ WAN (Wide-Area Network) keng masshtabli (mintaqaviy) maxsus qurilma va 
dasturlar bilan ta'minlangan aiohida tarmoqlami birlashtiruvchi yirik tarmoq;

■ GAN (Global-Agea Network) global (xalqaro, qit alararo) tarmoq;
■ tarmoq tugunlari turi bo‘yicha (tugun - hisoblash tarmoqlari va ulaming aiohida 

elementlari ulangan joyi). Boshqacha aytganda tugunga shaxsiy, mini va katta 
kompyuterlar, aiohida tarmoq ham kiradi. Masalan, umumiy foydalanish 
tarmoqlaridagi aiohida kompyuterlar (boshqachasiga ulami stantsiyalar deb ham 
vuritishadi) tugunlarga misol boia oladi. Unchalik katta boimagan aiohida tarmoqlar 
kampus tarmogi uchun tugun bo ladi.

■ PAN (Personal Area Network) -  shaxsiy hudud tarmogi. Shaxsiy xonadonlar 
hududida tashkil qilinadigan tarmoq.

Tugunlar munosabatiga ko'ra:
■ bir xil rangli (peer-to-peer), uncha katta boimagan, bir xil mavqega ega 
kompyuterlar (bu yerda hamma kompyuterlar ham mijoz, yani tarmoqning oddiy 
foydalanuvchisi, ham server, ya’ni tarmoq fovdalanuvchilariga xizmat ko'rsatishni 
ta’minlovchi boiishi mumkin);
■ yoyilgan (Distributed) tarmoqlar. Bunda serverlar tarmoq fovdalanuvchilariga 
xizmat ko‘rsatadi, biroq tarmoqni boshqarmaydi;
■ server (Server based) yoki markazlashgan boshqarishga ega tarmoqlar. Bu yerda 
tarmoqning bosh elementi serverdir. Qolgan tugunlar serverning resurslaridan 
foydalanishi mumkin (masalan, Novell NetWare, Microsoft LAN Manager va 
boshqalar).
■ tarmoq operatsion tizimlarini ishlatish bo‘yicha (tarmoq ОТ):
■ gomogenli - hamma tugunlarda bir xil yoki yaqin operatsion tizimlardan 
foydalaniladi (masalan, WINDOWS ОТ tarmogi);
■ geterogenli - bir vaqtning o'zida bir nechta tarmoq operatsion tizimlari ishlatiladi 
(masalan, Novell NetWare va WINDOWS).

Tarmoq xizmati. Tarmoqda bir necha xil serverlar boiishi mumkin 
Kompyuter tarmog‘i o'z mijozlariga qanday xizmatlar turkumini taklif etishi, 
ulaming xizmati qanday bo iishi juda muhimdir. Ular bilan tanishamiz:
■ fayl - server - mijozga axborot saqlash qurilmalarida saqlanuvchi favilardan 
foydalanish imkonini beradi. Bunda server barcha ishchi stantsiyalaridan fayllarga
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kirish imkonini berishi zarur. Bimda bir vaqtning o'zida turli stantsiyalardan bir xil 
so‘ rov kelganda, axborotlami himoya qila olish vazifasi ijobiv hal etiladi;
■ print - server umumiy holda ko'pgina mijozlarga bir nechta printer orqali xizmat 
ko'rsatishni ta’ minlaydi. Bunda server chop etiluvchi axborotlami qabul qila olishi va 
ulami navbati bilan chop etishga chiqarishi kerak;
■ faks - server-mijozlarga faks-modem telefon tarmoqlari bilan mujassam tarmoqli 
xizmat ko'rsatishni ta'minlaydi. Bu go‘voki axborot chiqarishga o ‘xshaydi (printer 
kabi). Faks-server olgan faksimil xabarlar alohida tarmoqda qayta ishlanadi. Bundan 
tashqari, tarmoqda quyidagi xizmatlar boiishi mumkin:
■ elektron pochta (E-mail) - mijozlar o‘rtasida ular bir-birlaridan qancha uzoqlikda 
joylashganligidan qat’iy nazar, axborot almashishni ta’minlaydi. Bu yerda jaravon 
xuddi oddiy pochta kabi kechadi. Elektron xat o'z manziliga ega Uni jo‘natuvchi 
desak, qabul qiluvchi ham o'z manziliga ega. "Xat" pochta qutisiga tashlanadi (ya’ni 
pochta serveri) va pochta serverlar tizimi yordamida qabul qiluvchi pochta qutisiga 
vetkaziladi. ya’ni bu yerda uzatuvchi va qabul qiluvchining maxsus kataloglari 
mijozga xizmat qiluvchi kompyuterda joylashtirilgan boiadi. Shu tariqaxatlar fayllar 
sifatida uzatiladi. Ohang, tovush kartalari yoki ovozli modemlar xatto tovushlami 
ham uzatish imkonini beradi;
■ bevosita muloqot (Chat), bunda aniq vaqtda maxsus dastur ta’minoti yordamida 
ikki yoki undan ortiq mijozlar o ‘zaro axborot almashinishi tushuniladi, ya'ni bir 
kompyuter klaviaturasida terilgan axborotlar ayni vaqtning o‘zida boshqa kompyuter 
ekranida pavdo boiaveradi. Raqamli videokameralar, tovushli kartalar. mikrofonlar, 
multimedia vositalarini qoilaganda, videokonferentsiyalar o‘tkazish imkoniyati 
tugiladi. Bunday holatlarda kompyuterlar vuksak unumdor va tarmoqning oikazish 
qobiliyati kuchli boiishi lozim.

6. 1-jadvalda telekommunikatsiyaning bir nechta umumiy apparat qurilmalari 
va ularning bajaradigan vazifalari keltirilgan45.

6 .1-jadval. Telekommunikatsiyaning apparat qurilmalari
Quriima Vazifagi

Modem
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Kompyuterda saqlanayotgan raqamli shakldagi maium otni telefon simining 
analog signaliga aylantirib beruv chi quriima hisoblanadi.

Fax modem Faksimal quriima standart telefon liniyasi orqali matnli, grafikli, fotografiyali va 
boshqa raqamli fayllami jo ‘natish imkomni beradi Faks-modem juda mashhur 
quriima hisoblamb, o ‘zida modemli faksni olib, fovdalanuvchiga kuchli 
kommunikatsiya uskunasini taqdim qiladi.

Multiplexer Uzoq aloqalarda qimmat turadigan haiajatlami tejash uchun bir nechta 
telekommunikatsion signallami bitta muhitda uzatish imkonini beradigan quriima 
hisoblnadi.

PBX Bino ichida va tashqi liniyalarda tovushlami boshqarish va ma’Iumotlami uzatish 
aloqa tizimi hisoblanadi. Mini ATS tizimini va unga ATSni bog‘lash orqali yuzlab 
telefon liniyalarini bog‘lash uchun qo‘llaniladi.

Front-end
processor

Ko‘plab odamlarga kompyuter tizimida xizmat ko‘rsatish va boshqarish uchun 
moijallangan ixtisoslashgan kompyuter hisoblanadi.

Switch Barcha kompyuterlar o ‘rtasida aloqa liniyasini o ‘zgartiruvchi quriima. Buni real

45 Ralph M. Stair, George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology,
Cengage Learning. USA. 2012 168-p.



vaqt ichida amalga oshiriladi. Shuningdek ular signallar susaygan holatlarda~ 
takrorlovchi rolini ham o ‘ynavdi Tarmoq kommutatori —  qurilma kompvuter 
tarmog'ining bu yoki bir nechta segmentidagi bir qancha tugunlariru bog'lash 
uchun m o‘ljallangan.

Bridge Bir xil bayormomalami qo‘llagan holda bir lokal taxmoqni boshqasiga ulash uchun 
ishlatiladi

Router Yirik lokal tarmoqlarini tashkil qilish uchun qo‘llamladigan qurilma. Ular 
malumotlar paketini aynan belgilangan IP-manzillarga jo ‘natish imkonini beradi

Lokal va global tarmoqlarning xususiyatlari. World Wide Web - global 
axborot tizimi.

Global tarmoqlar, ma’lumki, yirik shaharlar. mamlakat, qifalami qamrab 
oladi. Lokal tarmoqlar esa yetarlicha kichik maydonni o‘z ichiga oladi. Ular 10, 100, 
1000 metr chamasi radiusda 1000 nafarga yetar-yetmas mijozlarga xizmat qilishga 
mo‘ljallanadi. Bunday hajm LKT 10 Mbavt/s va undan ortiq tezlanishda ishlash 
imkonini beradi. Odatda lokal kompyuter tarmog'i ishchi stantsiyalar (IS) va maxsus 
kompyuterlami (fayl, print serverlari va boshqalar) o'zaro kabel bilan bogiashdan 
iborat. Ular o'z navbatida tarmoq adapterlari yordamida (tarmoq kartalari) maxsus 
platalar orqali kompyuteming tizimli platalarini kenga>1 iradi. Aiohida tugunlami 
tarmoqda ulash usullari tarmoq topologivasi deviladi. Odatda uchta topologiva 
qo‘llaniladi:

Umumiy shina. Bu holda lokal tarmoqdagi barcha kompyuterlar bitta aloqa 
chizigiga parallel bogianadi. Bunday shinalami boshqarish ham aiohida ham 
markazlashgan boiishi mumkin. Markazlashgan boshqaruvda tarmoqqa maxsus 
kompyuter-server ulanadi, uning vazifasi tarmoqda axborotni uzatishni boshqarishdir. 
Aiohida boshqaruvda hamma kompyuterlar bir xil maqomga ega ular mustaqil 
maiumotlami uzatish kanalini boshqaradi.

Halqa. Bu holatda barcha kompyuterlar yopiq halqasimon, ketma-ket 
bogianadilar. Bunda xabar birin-ketin kompyuterdan-kompyuterga uzatiladi. 
Xabami uzatgan kompyuter yana o^sha xabami qayta qabul qilmaguncha, jarayon 
davom etaveradi.

Yulduzcha. Yulduzcha topologiyaga ega tarmoqlar markaziy tugunga ega 
(kommutator yoki kontsentrator). Mazkur markaziy tugunga barcha qolgan 
kompyuterlar ulanadi. Dastlab uzatilgan xabar ana shu qurilmaga kelib tushadi. so‘ng 
boshqa kompyuterlarga uzatiladi.

Bogiash uchun qoilaniladigan kabellar uzatish muhiti deb yuritiladi. Masalan:
■ koaksial kabellar (coaxial cable), ular televizion antenna kabeliga juda o xshash;
■ juftli o'ram (tvisted pair) telefon simini eslatadi;
■ optik tolali kabel (fiber-optic cable). Eng ishonchli va tez, shu bilan birga juda 

qimmat kabel turi.
Tarmoqda kompyuterlami ulash uchun qalin (INTERNET yo‘g‘on simi -global 

tarmoqlar uchun) voki ingichka koaksial simlar (ETHERNET-lokal tarmoqlar 
uchun), oialgan juftlik (toking ring -  витая пара) va optik tola (dastlab shishadan, 
hozirda esa plastik tola) simian ishlatilishi mumkin.
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Lokal tarmoqlaming qo‘llanish sohasi juda keng. Bunga ofis ishlarini 
vtomatlashtirish, korxona boshqaruv tizimlari, loyihalami avtomatlashtirish 

texnologik jarayonlari va robototexnika komplekslari, bank va axborot tizimlari. 
elektron pochta tizimlarini boshqarish kiradi.

W IN DO W S О Т  lokal tarmog‘i bugungi kunda sozlash va ishlatish uchun juda 
aulavligini albatta e’tirof etish kerak. Tarmoq bilan ishlashdan avval, agar Sizning 
kompyuteringiz lokal tarmoqqa ulanmagan bo'Isa, sozlash ishlari olib boriladi. 
Komp>nter tarmoqda ishlashi uchun uni sozlash jarayoni quyidagicha: avvalo 
kompyuterda tarmoq plata (karta) borligiga ishonch hosil qilish daricor. Yuqorida 
keltirilgan simlar orqali va maxsus HUB (Switch) qurilmasidan foydalangan holda 
kompvutemi tarmoqqa ulash. HUBlar xonadagi kompvuterlami bir-biri bilan 
bog'lash uchun kerak bo'Isa Switchlar binolar orasiga qo'yiladi.

Tarmoqda ishlovchi har qanday kompyuter o ‘z nom va ishchi guruhiga ega 
bo'lishi kerak. Boshqa tarmoq ishtirokchilari unga shu nom bilan murojaat qilishlari 
mumkin (fayl va papka xabar jo'natish).

INTERNET global tarmog‘i. Abonent tizimlarining hududiy joylashuviga 
qarab kompyuter tarmoqlarini 3 turkumga ajratish mumkin:
■ Lokal tarmoqlar (LAN-Local Area Network) - bir xonadagi, bmodagi. uncha 
katta bo'Imagan hududdagi kompyuter tarmoqlari (2,5 kmgacha bo'lgan masofada 
birlashtirilgan kompyuterlar);
■ Mintaqaviy kompyuter tarmog'i - bir-biridan ancha uzoqda joylashgan 
kompyuterlar va lokal tarmoqlami o‘zaro bog'laydi. U katta shahar, iqtisodiy mintaqa 
va alohida mamlakat doirasidagi abonentlami o'z ichiga olishi mumkin;
■ Global tarmoqlar turli mamlakatlar yoki qit’alarda joylashgan abonentlami 
birlashtiradi.

Global, mintaqaviy va lokal kompyuter tarmoqlarining birlashuvi ko'ptarmoqli 
iyerarxiyani tashkil etib, umumjahon axborot resurslarini birlashtirish va ulardan 
jamoaviy ravishda foydalanish imkoniyatlarini yaratadi.

Hozirgi kunda dunyoda ko'plab kompyuter tarmoqlari ishlab turibdi. Dastlabki 
kompyuter tarmog'i - ARPANET (Advenced Researsh Projects Agency Network)- 
AQSHning mudofaa vazirligi tomonidan 1969 yili ishlab chiqilgan. U kevinchalik 
boshqa kompyuter tarmoqlari bilan birlashtirilib INTERNETning bir qismi sifatida 
ishlatila boshlandi
INTERNET - international network - yagona standart asosida faoliyat ko'rsatuvchi 
jahon global kompyuter tarmog'i. Internet xizmati internet provayderian yordamida 
aloqa kanallari-telefon tarmog'i, kabelli kanallar, radio va sun'iy vo'ldosh aloqa 
tizimlaridan foydalanish orqali amalga oshiriladi. Hozirda Intemetga dunyoning 150 
dan ortiq mamlakatlaridagi millionlab kompyuterlar ulangan. Har oyda tarmoq 
miqdori 7-10%ga ortib bormoqda 2012 yilda dunyoda 2,3 milliard internet 
foydalanuvchmi tashkil qilib, bu insoniyatning 32 foizini tashkil qilgan bo'lsa 2017 
yilda dunyoda internet foydalanuvchilar soni 3,6 milliarddan ortib ketishi kutilmoqda 
Bu esayer shari ahohsimng 48 foizdan ko'prog'ini tashkil qiladi.

Bugungi kunda Internet 50000 dan ortiq alohida tarmoqlami bog'laydi. Ular 
turli zamonaviy axborotlami taklif etib kelmoqdalar. Masalan, Nyu-York fond biijasi
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aktsiyalari kotirovkasini Massachusets texnologiya institutida ко rib chiqish mumkin 
Usenet tizimi yordamida global muammolami bahslashib, muhokama qilish mumkin 
Yahoo yoki Yandex qidiruv tizimi orqali sizga kerakli axborot tez va soz topiladi 
Masalan, oddiy tovarlar narhidan boshlab. teatr repertuarigacha axborot olish 
mumkin. Internet tarmog'i orqali bugungi kunda kundalik ro'zg'or handlari amalga 
oshirilmoqda.

Elektron nashr, kutubxona tizimlari esa juda ommaviylashib ketdi. Ular yirik 
kutubxona va nashriyotlami o'zaro bog'laydi. Biroq elektron pochta esa eng ko'p 
ommalashdi. Bu tizim bir zumda dunyoning xohlagan burchagiga xabar vetkaza 
oladi.

Intranet-intemet texnologiyasi, dasturiy ta'minoti va bayonnomalari asosida 
tashkil etilgan. hamda ma lumotlar bazasi va elektron hujjatlar bilan jamoaviy 
ravishda ishlash imkonini beruvchi korxona yoki kontsem miqyosidagi yagona 
informatsion muhitni tashkil etuvchi kompyuter tarmog'i.

WWWda axborotlarga kirish, qidirish, WWWga axborotlami joylashtirish. 
IRC, ICQ (Intemetda muloqot).

Internet xizmatlari deganda tarmoqdagi xizmatlar tushuniladi. Ular 
quyidagilardan iborat:

■ WWW - Grafik, audio va video materiallami o'z ichiga olgan gipermatnli 
hujjatlami ko'rish va topish.

■ telnet - kompvuterga uzoqdan bog'lanish.
■ ftp - fayllami uzatish.
■ e-mail - xabarlami uzatish.
■ Usenet - elektron e ’lonlar taxtasi, telekonferentsiyalar.
■ gopher - matnli hujjatlami topish va ko'rish.
■ IRC -  xizmati (Internet Relay Chat). Bu xizmat real vaqt mobaynida bir 

nechta kishilami o'zaro to'g'ridan-to'g'ri muloqot qilish imkoniyati bilan 
ta’minlaydi.

■ ICQ xizmati. Bu xizmat intemetga ulangan (avni vaqtda) kishining IP- 
tarmoqdagi adresini izlab topishga mo'ljallangan.

■ WWW - Intemetning eng ommabop xizmat turidir. Unga ulanish uchun 
kompyuter bilan modem vetarlidir. Shuning uchun butun dunyo tarmog'i butun olam 
axborotlar bazasi-kutubxonaga aylanib qoldi va u dunyoga yoyildi. WWWda 
ma’lumotlar sahifalarda joylanadi. WWW sahifalari soni oxirgi 3 yilda yuz 
milliondan oshib ketdi. Bu sahifalar egasi kim? Ular yirik korporatsiyalar yoki kichik 
korxonalar, universitet va maktablar, tashkilotlar, jumal va gazetalar yoki oddiy 
shaxslardir. Bu sahifalarda turli-tuman ma lumotlar joylanadi. Hozirgi kunda WWW 
axborot olishning va tarqatishning eng qulay usulidir.

World Wide Web xizmati (WWW). Bu xizmatni odatda Internet bilan 
tenglashtiradilar. Aslida WWW xizmati - bu Intemetning ko'p tarmoqli xizmatlaridan 
biridir. World Wide Web - bu Web-serverlarda saqlanavotgan va o'zaro boglangan 
millionlab elektron hujjatlaming yagona ma lumotlar fazosidir. Web-fazoning 
alohida olingan hujjatlari Web-sahifalar (Web-страницы) deb yuritiladi. Web- 
sahifalaming ma lum mavzuga birlashtirilgan guruhlarini Web-tugunlar (Web-uzel)
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Id Web-sayt yoki oddiy sayt deb yuritiladi. Bitta Web-server yetarli darajada ko‘p 
dami o'zida mujassamlashtirishi mumkin. Ularning har biriga odatda serveming 

aattiq diskida alohida katalog ajratiladi.
Terminalli rejim. Tarixan kompyutemi masofadan turib boshqarish xizmati 

Telnet bilan bogiiq  Masofadagi kompyuter ishini kerakli bayonnoma xizmati orqali 
boshqarish konsolli yoki terminalli boshqarish deb yuritiladi. Intemetda Telnetdan 
texnik ob’yektlami masalan, teleskop, videokamera, sanoatdagi robotlami masofadan 
turib boshqarishda foydalaniladi.

Elektron pochta (E-mail). Bu xizmat turi ham dastlabki elektron xizmatlardan 
hisoblanadi. Intemetda uni ta’minlash uchun maxsus pochtali serverlar ishlatiladi. 
Shu narsaga e’tibomi qaratmoq kerakki, serv er deganda maxsus ajratilgan kompyuter 
tushunilmaydi. Elektron pochtani olish yoki yuborish uchun sizning 
kompyuteringizda biror amaliv dastur o‘matilgan boiishi mumkin. U xabarlar 
varatish, tahrirlash, oluvchi yoki oluvchilami ko'rsatish. Ularning dektron pochta 
manzillarini ko'rsatish, xabarga fayllami biriktirish imkoniyatlarini beradi. 
Shuningdek ular siz uchun pochta qutisini ta’minlaydi, elektron pochtadan xabarlar 
olish vajo'natish, pochtajo'natmalanni saqlash kabi imkoniyatlami beradi46.

Telekonferentsiya xizmati elektron pochta xizmatining har tomonga tarqatish 
xizmatiga o'xshab ketadi. Telekonferentsiya xizmatida xabar bitta muxbirga 
vuborilmav, balki bir guruh muxbirlarga uzatiladi (bunday guruhlar 
telekonferentsiyalar yoki yangiliklar guruhi defo aytiladi). Yangiliklar guruhi 
uzatilayotgan serverdan boshqa hamma serverlargajo‘natiladi. Bu jarayon vaqti-vaqti 
bilan takrorlanib turiladi. Har bir serverga tushgan xabar chegaralangan vaqt 
mobavnida (odatda bir hafta) saqlanadi. Ushbu davr mobaynida xohlovchilar xabarlar 
bilan tanishish imkoniyatiga ega boiadilar. Bir sutka ichida hamma tomonga 
tarqatilgan xabarlar butun yer shariga tarqaladi. Kevinchalik bu xabarlar asta-sekin 
o‘chiriladi, chunki serverga ushbu xabarlar qayta jo‘natilmavdi. Har kuni dunyo 
miqyosida millionga yaqin xabarlar tarqatiladi. Ularning orasidan kerakli xabarlami 
topib olish amaliy jihatdan mumkin emas. Shuning uchun, telekonferentsiya tizimi 
mavzular guiuhiga boiingan. Hozirgi vaqtda dunyoda yangiliklar mavzularining 
50000ga yaqin guruhi mavjud. Yangiliklar guruhidan foydalanishning asosiy ma nosi 
shundaki, butun dunyo bo vicha shu sohaga taalluqli mutaxassislarga murojaat qilib 
savol berish va kerakli javobni yoki maslahatni olish mumkin. Bu yerda albatta shu 
narsaga e’tibor berish lozimki, benlayotgan savolning mazmuni 
telekonferentsivaning mavzusiga taalluqli boiishi kerak. Ko'pgina yuqori malakali 
mutaxassislar (konstruktorlar, muhandislar, olimlar, shifokorlar, pedagoglar, 
huquqshunoslar, yozuvchilar dasturlovchilar va boshqalar) doimiy ravishda o'zlariga 
taalluqli telekonferentsiya mavzularini ko‘rib boradilar. Bunday ko'rinishda 
ma’lumotlarm olish maiumotlar monitoringini tashkil qilish deviladi. Yangiliklar 
guruhidagi katta hajmdagi xabarlar monitoringini tashkil qilish masalani 
murakkablashtirib yuboradi Shu sababli ayrim guruhlarda keraksiz ma’Iumotlami 
va'ni telekonferentsiyaga aloqasi boimagan ma lumotlami tushirib qoldirish

46 V. Rajaraman Introduction to Information technology (second edition) PHI bearing Private Limited. India, 2014.
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imkoniyati mavjud. Bunday konferensiyalami moderatsiyalanuvchan 
(moderiruemumi) deb yuritiladi. Moderator sifatida mas'ul kishi yoki ma lum bir 
kalit so‘zlar bilan filtr qiladigan maxsus dastur ishlatilatishi mumkin. Bu xolni 
avtomatli moderatsiya dey iladi.

Telekonferensiyalar xizmati bilan ishlash uchun mijozlarga moijallangan 
maxsus dasturlar mavjud. Masalan, Microsoft Outlook Express telekonferensiyalar 
xizmati bilan ishlash imkoniyatiga ega. Bu dastur bilan ishlash uchun elektron aloqa 
xizmati kabi uning kerakli parametrlarini yuklash va yangiliklar guruhi serveri bilan 
o‘zaro aloqani ta'minlash kerak.

FTP (File Transfer Protocol - fayllami uzatish bayonnomasi). Internet 
xizmatlarining orasida fayllami qabul qilish va uzatish ancha katta foizini tashkil 
etadi. Dastur fayllarini, katta hajmdagi hujjatlami (masalan, kitoblami) hamda arxiv 
maiumotlarni fayllar ko‘rinishida uzatishga zarurat tug'iladi. FTP xizmati dunyo 
tarmog ida o'zlarining serverlariga ega boiib, unda arxiv koiinishidagi ma lumotlar 
saqlanadi.

FTP bayonnoma server va mijozlar o‘rtasidagi ikkita TCP bogianishlar bilan 
bir vaqtda ishlaydi. Birinchi qo‘shilma bilan ma lumotlar uzatiladi. Ikkinchi 
qoshilma bilan maiumotlarni boshqarishda foydalaniladi. FTP bayonnoma serverga 
murojaat qilgan mijozning qayd etish vositasini ham taklif qiladi. Bu usul bilan 
odatda tijorat serverlari va chegaralangan serverlar o‘zlarida qayd etilgan mijozlarga 
foydalanuvchining ismini va u bilan bogiiq parolni kiritishini talab qiladi. Ammo o‘n 
minglab FTP serverlar mavjudki, ular anonim ko‘rinishda o‘zlarining xizmatini taklif 
etadi. Bu holda foydalanuvchilar ism sifatida anonymous so‘zini va parol sifatida 
elektron aloqa xizmatini kiritishlari kifoya. Ko'p holatlarda FTP xizmati buni 
avtomatik ravishda bajaradi.

IRC xizmati (Internet Relay Chat). Bu xizmat real vaqt mobaynida bir nechta 
kishilami o‘zaro to‘g‘ridan-to‘g‘ri muloqot qilish imkoniyati bilan ta’minlaydi. 
Ayrim hollarda IRC xizmatini chat-konferensiya yoki oddiy chat deb ham aytadilar. 
Telekonferentsiyalardan farqli oiaroq chat-konferentsiyalarda muloqot bitta aloqa 
kanali doirasida amalga oshirilib, unda bir nechta odamlar ishtirok etishi mumkin. 
IRC xizmatini qoilab-quvvatlaydigan serverlar va tarmoqlar bilan ishlaydigan bir 
qancha imtiyozli mijozli dasturlar mavjud. Ulardan eng imtiyozlilaridan biri - 
mIRC.exe dasturidir.

ICQ xizmati. Bu xizmat intemetga ulangan (ayni vaqtda) kishining IP- 
tarmoqdagi manzilini izlab topishga moijallangan. Ko'pgina foydalanuvchilar 
doimiy IP-manzilga ega emaslar. Shuning uchun ushbu xizmatga zaruriyat tugilgan. 
Bu xizmatdan foydalanish uchun uning markaziy serverida (http://wvwv.i cq. com) 
qayd qilinish va shaxsiy nomer UIN (Universal Internet Number) olish kerak. Bu 
nomemi o‘zining hamrohiga uzatish mumkin. Bu holda ICQ xizmat Intemet-peydjer 
ko‘rinishidagi xizmat turini bajaradi. UIN nomemi bilgan holda uning IP-manzilini 
bilmasangiz ham uning markaziy server xizmati orqali unga hamroh bilan ulanish 
uchun xohish borligi haqidagi xabarini junatish mumkin.
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1 Kompyuter tarmog'ining arxitekturasi haqida so‘zlab bering?
2 Tarmoq tizimining modeli va bayonnomalari nima?
3 Lokal va global tarmoqlar qanday xususivatlarga ega?
4 World Wide Web nima?
5 WWWda axborotlarga kirish, qidirish, axborotlami jovlashtirish qanday amalga
oshiriladi?
6 Internet xizmatlari va ulaming turlarini sanab о ting?

Savol va topshiriqlar:

Test
1. Mahalliy tarmoq . .
A) kichik bir hududda joylashgan abonentlami 
birlashtiradi
B) bitta respublika hududida joylashgan 
abonentlami birlashtiradi
C) turli mamlakatlarda joylashgan abonentlami 
birlashtiradi
D) turli mamlakatlarda joylashgan abonentlami 
birlashtiradi

2. Barcha kompyuterlar HUB orqali bogMangan 
bo’Lsa, bunday bog'lanish qanday ataladi?
A) yulduzsimon
B) shinali
C) xalqasimon
D) bunday bog'lanishga nom berilmagan

3. Axboriy ma'lumotni bir ko'rinishdan ikkinchi 
sifat jihatidan yangi ku‘rinishga keltirish, 
axborotni yig'ish. qayta ishlash va uzatishning 
usul va vositalari majmuasidan foydalanish 
jarayoni nima deb ataladi?
A) axborot tizimi
B) axborot texnologiyasi
C) dasturiy ta'minot
D) axboriy jarayon

4. Lokal tarmo(|qa kompyuterni ulash uchun 
nimadan foydalanish mumkin?
A) Tarmoq kabellari
B) Telefon kabelidan
C) Modemdan.
D) Mobil telefondan

5. Mintaqaviy tarmoq . . .
A) kichik bir hududda joylashgan abonentlami 
birlashtiradi
B ) bitta respublikada joylashgan abonentlami 
birlashtiradi

savollari
C) katta hududda joylashgan abonentlami 
birlashtiradi
D) turli mamlakatlarda joylashgan abonentlami 
birlashtiradi

6. Tarmoqda mavjud bo‘lgan kompyuterlar bir 
to‘g‘ri chiziq bo'yicha ulangan bo‘Isa bunday 
bo‘g‘lanish nima deb ataladi?
A) shinali
B) halqasimon
C) yulduzsimon
D) yulduzsimon. xalqali

7. Kommunikatsiya qachon paydo bo'ladi?
A) ehtivoj paydo bo‘lganda;
B) laqat axborot olishda;
C) faqat axborot berishda;
D) kompyuterda ma’lumot olishda;

8. Tarmoqning texnik vositalari keltirilgan 
javobni toping?
A) telefon tiniyalari. axborot uzatish kabellari;
B) server kompyuter.
C) HUB (kontsentrator), svitch, modem, axborot 
uzatish kabellari, server, tarmoq kartalari:
D) axborot uzatish kabellari, server kompyuter, 
kompyutertar;

9. Tarmoqlar qanday ko‘rinishlarda bo'ladi?
A) aslida faqat lokal bo'lib, ulami birlashishidan 
boshqa tarmoqlar kelib chiqadi;
B) lokal va mintaqaviy,
C) bir rangli va belgilangan serverli;
D) lokal va global;

10. Kompyuter taimog'i turlari keltirilgan 
javobni toping?
A) bir rangli va ko'p rangli;
B) asosan lokal va mintaqaviy bo'ladi;
C) intranet va internet;
D) Lokal, mintaqaviy, global
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28-§. Internet tarmog‘i va uning tashkil etilishi 

Tayanch tushunchalar: Internet, sayt, elektron aloqa, mijoz, shlyuz, URL, domen.

Internet - bu minglab lokal va mintaqaviy kompyuter tarmoqlarini bir butun 
qilib birlashtiruvchi butun dunyo kompyuter tarmog'i. Internet dunyodagi eng yirik 
kompyuter tarmogi hisoblanib. u o‘zida minglab ozaro bogiangan tarmoqlami 
birlashtiradi va ulaming o‘zaro axborot almashinuvini ta'minlab beradi. Maktablar, 
kollejlar, litseylar, universitetlar va boshqa turli tashkilotlar ham intemetni 
qoilaydigan tashkilotlarga misol boiadi. Masalan, Beth Israel Deaconess Medical 
Center markazi patsiyentlarga vaxshi xizmat ko rsatishni ta’minlash maqsadida 
internet savtlami qoilaydilar Shifokorlar har ovda shifoxona saytini ishlatgani uchun 
oylik haq toiaydi. Ko‘pincha odamlar va tashkilotlar muhim ilovalarga kirish va 
yetkazib berish uchun, yirik ma lumotlar bazasidan foydalanish uchun, biznes- 
tahlillar oikazish uchun, shuningdek turli xil hisobotlar olish uchun qoilashadi47

Internet 1969 yilda AQSH Mudofaa vazirligining istiqbolli tadqiqotlar 
agentligi (Advensed Research Projects Agency, ARPA)ga mamlakatdagi barcha 
harbiy (ilmiy tadqiqot va o‘quv) muassasalardagi kompyuterlami birlashtiruvchi 
yagona tarmoq yaratish topshirilgan edi. Bu tarmoq (ARPA Net) harbiy 
mutaxassislarga axborot almashishga yordam ko‘rsatishga moijallangan edi.

Uni yaratishda foydalanuvchilaming tizimga kirish imkonini, boshqa 
kompyuterlardagi dastur lam j ishlatish. fayl va xabarlami elektron aloqa orqali uzatish 
va boshqalar nazarda tutilgan. Eng asosiysi, tizimni ishlab chiqaruvchilar oldiga 
ishonchli. ayrim kompyuter yoki aloqa kanallari ishdan chiqqanda ham o'z ish 
qobiliyatini saqlab qoluvchi, o‘ta chidamli tarmoqni yaratish masalasi qo‘yilgan edi.

ARPA Net tarmogining rivojlanishi bilan turli tarmoqlami o'zaro bogiash, 
va’ni yagona tarmoq yaratish muammosi yuzaga keladi. Bunday standart 1974 yilda 
varatildi. 1983 yilda esa AQSH Mudofaa vazirligining ARPA Net shaxobchalaridagi 
barcha mashinalarida ishlab chiqilgan standartlardan foydalanish haqida buvruq 
chiqarildi. Bu standartlami ishlatish uchun esa o‘sha paytlarda keng tarqaJgan 
operatsion tizim UNIX ishlatildi.

1986 yilga kelib AQSH Milliy fanlar fondi tomonidan o‘zining oltita 
superkompvuterli markazini birlashtirish uchun tayanch tarmoq varatildi. Bu tarmoq 
juda quvvatli va yuqori sifatli qurilmalar va AQSH Mudofaa vazirligi tomonidan 
belgilangan standartlarga asoslangan edi. 1992 yil NSF kompaniyasi ana shu tayanch 
tarmoqni boshqarishiga kelishib olindi. Ana shu vaqtdan boshlab Internet nafaqat 
davlat (o'quv va ilmiy) muassasalarida, shuningdek, tijorat maqsadlarida ham 
ishlatila boshlandi. Internet asta-sekin AQSH chegaralaridan chiqib boshqa 
mamlakatlarga, dastlab Evropa keyinchalik Osivo, Afrikaga ham tarqaldi. Bugungi 
к unda Internet haqiqatan ham dunyoviy tarmoqqa aylangan.

Intemetning axborotli qismi Internet tarmogida mavjud boigan turli elektron 
hujjat, grafik, rasm, audioyozuv, video-tasvir va boshqa ko‘rinishdagi axborotlar

47 Ralph M. Stair. George W.Reynolde. Fundamentals o f  Information Systems. Sixth edition. Course Technology,
Cengage Learning. USA. 2012. 13-b.
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majmuidan tashkil topgan. Ular butun tarmoq bo'ylab taqsimlanishi mumkin. 
Masalan, siz kompyuteringizda o'qiyotgan elektron darslikning matni bir manbadan. 
undagi rasmlar va tovush ikkinchi manbadan, videotasvir va izohlar uchinchi 
manbadan yigilishi mumkin. Shunday qilib, tarmoqdagi elektron hujjatni o'zaro 
moslashuvchan giper bogianishlar orqali bir necha manbalar majmuasi ko'rinishida 
tashkil etish mumkin. Natijada millionlab o zaro bog'langan elektron hujjatlar 
majmuasidan tashkil topgan axborot muhiti hosil boiadi.

Internet tarmog‘ining mohivatini tushunish uchun uning mantiqiy tuzilishini 
tushunish kerak. Ushbu mantiq, bilan tanishib chiqamiz.

Ma’lumki, avtomobildan foydalanganda transport turlari uchun belgilangan 
qonun-qoidalarga riova qilish shart. Xuddi shunday Internet xizmatidan 
foydalanuvchilar uchun ham hammaga bir xil bo'lgan kompyuterda ma’Iumotlami 
uzatish tartibini belgilovchi yagona qoidalar majmui belgilangan.

Ikki kompyuter orasida ma'Iumotlami uzatish tartibi va formatini belgilovchi 
qoidalar majmui bayonnoma (protokol) deb ataladi.

Masalan. http, ftp va boshqalar bayonnomaga misol bo‘la oladi. Tarmoqda 
ishlash uchun berilgan bayonnomaga mos holda ma'Iumotlami uzatish imkonini 
beradigan maxsus dastur ta’minotiga ega boiishi kerak. Bunday dasturlar 
bayonnomalami amalga oshirish deyiladi. Ular operatsion tizimda joylashtirilgan 
boiishi yoki alohida amaliy dasturlar paketi sifatida yaratilishi mumkin. Hozirgi 
zamon operatsion tizimlarining barchasi intemetda ishlashni ta’minlovchi asosiy 
bayonnomalarga ega

Intemetda axborotni paketli uzatish tamoyilidan foydalaniladi. Endi axborotni 
paketli uzatish mazmuni bilan tanishib chiqamiz.

Internet va unda ishlashni tasawur qilish uchun telefon tarmogini eslashingiz 
mumkin. Chunki telefon tarmogida ham shunga o'xshash aloqa kanali ishlatilib, bir 
necha daqiqada dunyoning xohlagan nuqtasi bilan bogianish mumkin. Albatta. bu 
o‘xshatish shaklan bir xil boisada. ish printsipi bo‘yicha katta farq qiladi. Ya’ni. 
telefonda gaplashish paytida stansiyalar orasidagi kanal to ia  band boiadi. Bu 
kanaldan telefon qiluvchi va uni eshituv chidan boshqa hech kim foydalana olmaydi. 
Agar telefon stansivasining barcha kanallari band boiib qolsa, bu kanalda 
gaplashayotgan abonentlar bilan ham bogianish mumkin boimay qoladi. Ko‘rinib 
turibdiki, bu tamovilda ishlaydigan kanallardan foydalanish kompyuter tarmogida 
samara bermavdi. Taqqoslashning qulavrogi sifatida oddiy aloqa xizmatini olish 
mumkin. Bunda ixtiyoriv sondagi maiumotlar ixtiyoriv vo'nalishda uzatiladi. Gazeta 
va jumallar to'plami boiaklab uzatiladi. Intemetda ham shunday xususiyatdan 
foydalaniladi.

Maiumotlaming qismlarga boiinishi - paketlar deb ataladi.
Paketda xususan, maiumotlar bilan birga uni berilgan manzilga to‘g ‘ri 

yetkazish imkonini beruvchi boshqaruv axboroti (masalan, qabul qiluvchining 
manzili) ham beriladi.

Axborotni uzatish jarayonida, xuddi oddiy aloqa kabi ba’zi xabarlar 
belgilangan manzilga yetib bormasligi (yo'qolishi), ba'zi birlari esa oddiy aloqada 
ro‘y bermaydigan holda ya'ni bir necha nusxada yetkazilishi mumkin.
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Internet tarmoginmg samarali ishlashi uchun mavjud axborotni qanday qilib 
paketlar holatida uzatish va vetkazilgan axborotni qayta tiklash hamda bo'laklangan 
paketlami foydalanuvchiga qanday vetkazish kerakligi muammosini hal qilish lozim 
bo'ladi.

Bu muammolami hal qilish uchun TCP (Transmission Confrol Protokol —  
ma lumotlami uzatishni boshqarish) va IP (Internet Protokol —  tarmoqlararo o'zaro 
bogianish) bayonnomalari yaratildi. Bu bavonnomalar Internet tuzilmasini 
aniqlovchi asosiy bayonnomalar bo'lib xizmat qiladi.

Odatda ular qiya chiziq (/) bilan ajratilib. TCP / IP ko'rinishida yoziladi. 
Ammo ulami yozish paytida bu bayonnomalar kompyuter tarmog'ida ma’lumotlami 
uzatishning turli xil yo'nalishlarini bildiruvchi ikkita turlicha bayonnoma ekanligini 
unutmaslik kerak.

Endi Internet bilan bog'liq bo'lgan boshqa qator tushunchalar bilan tanishamiz.
HTML (Hyper Text Markup Language —  gipermatn belgilash tili) WWW 

tizimi uchun hujjat tayvorlashda ishlatiladi. HTML buyruqlari (teglari) orqali 
matnlaming shaklini istagancha o'zgartirish, ya'ni matnning ma’lum bir qismini 
ajratib olib, boshqa faylga yozish, rangli tasvirlami qo'yish mumkin. U boshqa 
hujjatlar bilan bog'lavdigan gipermatnli aloqalarga ega

WWW — jahon o'rgimchak to'ri - aloqa tarmog'i tizimida ma lumotlar 
gipermatnli hujjatlar shaklida olinadi. Gipermatn boshqa matnli hujjatlarga yo'l 
ko'rsatuvchi matndir. Bu esa boshqa matnlarga (matnlar qaysi mamlakatning 
serverida turishidan qat’iy nazar) tezda o'tish imkoniyatini beradi. Matnlar bilan bir 
qatorda WWW hujjatlarida multimedia ma'lumotlarini ham ko'rish mumkin. 
Matndan tashqari boshqa shakldagi ma’lumotlami ham beruvchi hujjatlar gipermedia 
hujjatlari deyiladi.

Sayt —  grafika va multimedia elementlari joylashtirilgan gipermedia hujjatlari 
ko'rinishidagi mantiqan butun axborot hajmidir.

Elektron aloqa. E-mail bu ma’lum elektron manzilda axborotni elektron usulda 
uzatish vositasidir. Elektron aloqa tushunchasi oddiy aloqa tushunchasiga 
o'xshashdir. Haqiqatan ham E-mail orqali xat jo'natishda, siz oddiy xatdagidek 
satrlami to'ldirasiz, ya ni, yuboriladigan manzil yoziladi (faqat barcha nomlar va 
manzillar elektron xatda bo'ladi). Siz xatni nusxalash orqali bir necha manzillarga 
jo'natishingiz, hatto xatga faylni qo'shib yuborishingiz mumkin va xokazo.

Elektron pochtani paydo bo'lish tarixi. 1968 yilda AQSH mudofaa Vazirligi 
tashabbusi bilan Bolt Beranek and Newman (BBN) kompaniyasiga ARPAnet 
tarmog'ida maxfiy loyihani amalga oshirish bo'yicha topshiriq beriladi. Rey 
Tomlinson BBN kompaniyasida oddiy kompyuter muhandisi bo'lib, u SNDMSG 
("send message" so'zlaridan) loyihasi dasturi ustida ishlar edi. Uning dasturi faqat 
BBN kompaniyasi ichida dasturchilar va tadqiqotchilar o'rtasida bir-biriga xabar 
jo'natish imkonini berar edi. Unda ARPAnet tarmog'i orqali fayl uzatish imkoniyati 
mavjud edi

Birinchi matnli xabar almashishni Tomlinsongacha Stenfordlik Dug Engelbart 
varatgan. Rey esa unga pochta konverti ko'rinishini berib,

□«qayerga»,
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С «kimga»
□«xat matni» grafalarini kiritdi.
Shuningdek har bir kompyuterga virtual pochta qutisini kiritishni yaratadi. 

Ungacha esa butun lokal tarmoq umumiy pochta qutisidan foydalangan.
Rev Tomlinson tomonidan qo'yilgan navbatdagi qadam bu - @ simvolimng 

kiritilishi b o id i (ushbu simvol "et" deb 0 ‘qilsada, ammo rus foydalanuvchilar 
tomonidan uni "собачка"- «kuchukcha» termini bilan atashadi).

Bu simvol foydalanuvchi pochta qutisi manzili va lokal tarmoqdagi mashina 
manzili o ‘rtasidagi ajratuvchi sifatida kiritiladi.

Rev Tomlinsonning aytishiga qaraganda u bu simvolni foydalanuvchi boshqa 
xostda, lokal tarmoq esa boshqa xostda ekanligini ajratib ko‘rsatish uchun olingan 
xolos.

Lourens Roberts (Law rence G. Roberts) tomonidan dasturning yetarlicha jiddiy 
qayta ishlanishidan keyingina bizga bugun tanish boigan ko‘rinishga keldi.

Roberts barcha xatlami royxatini ko‘nsh. keraklisini tanlab o‘qish, aiohida 
faylda xatni saqlash, boshqa adresatga o‘tish va javobni avtomatik tayvorlash 
imkoniyatlarini kiritdi.

Elektron pochta xizmati va uning afzalliklari
• Internet-xalqaro tarmog'ining asosini Electronic mail (E-mail) - Elektron 

pochta xizmati tashkil qiladi.
• Elektron pochta xuddi odatdagi pochtadek bo‘lib, faqat bunda xatni 

qog‘ozga emas. balki kompyuter klaviaturasidan harf va so‘zlami terib, elektron 
signallaming malumtartibdagi ko'rinishigakeltiradi.

• Elektron pochta maxsus dastur boiib, uning yordamida dunyoning 
ixtiyoriy joyidagi elektron manzilga xat, hujjat, ya'ni ixtiyoriy faylni tezda (bir necha 
soniyalarda) jo'natish va qabul qilib olish mumkin.

• Bundan tashqari ma’lum talablar mavjud, ya’ni bunda xat jo‘natayotgan 
foydalanuvchi va qabul qilavotgan foydalanuvchi ham Internet tarmog‘iga ulangan 
kompyuterga murojaat qilish imkoniyatiga ega boiishi kerak.

Xabar va pochta qutisi tushunchalari
• Xabar, umuman olganda foydalanuvchi pochta orqali yuborishi kerak 

bo‘lgan maiumot hisoblanib va oldindan boshqa dasturda tayyorlanadi, keyin 
elektron pochta orqali jo ‘natiladi;

• Pochta qutisi -  bu foydalanuvchi uchun elektron pochta xizmatini taqdim 
etuvchi kompyuterda qayd qilingan nomdir;

• Ushbu nom kompyuter xotirasida papka ko‘rinishida shakllantiriladi va u 
o‘zida kiruvchi va chiquvchi xabarlami vaqtinchalik saqlaydi.

• Elektron pochta manzili (___  @ _______ ■ _);
Elektron pochta manzili
Xabarlami uzatish
Spam va spamlaming turlari
• «Spam» termini yangi mazmunda jonga teguvchi elektron tarqatmalar yoki 

pochta chiqindilari degan ma'noni anglatadi;
• Spam quy idagi turlarga boMinadi:
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-  Anonim: barcha kcfpincha aynan yashirin yoki qalbakilashtirilgan qayta 
aloqa manzili ko'rsatilgan avlomatik tarqatmalardan jabrlanadi.

-  Ommaviy: ushbu tarqatmalar aynan ommaviy va faqatgina shular spamerlar 
uchun haqiqiy biznes hamda foydalanuvchilar uchun haqiqiy muammo hisoblanadi.

-  So ralmagan: imzolangan tarqatmalar va konferentsiyalar bizning 
tushunchamizga kirmasligi kerakligi yaqqol tushunarli. Har bir elektron pochta 
xizmati o'zining foydalanuvchilariga spamdan himoyalanish vositalarini taklif 
qilishadi.

Xalqaro pochta xizmatlari
• Elektron pochta orqali maiumot yuborish uchun ikki usul keng tarqalgan:
-  bepul elektron pochta xizmati deb yuritilib, undan foydalanish uchun 

Intemetda ma’lum bir Web-sahifalari mayjuddir.
-  Microsoft Exchange dasturi. Bu dastur yordamida lokal hisoblash tarmogi 

yoki alohida kompyuterda xalqaro pochta xizmatlari web-sahifalami chaqirmasdan 
xabarlami to'g'ridan-to'g'ri kompyuterga yuklab olish yoki yuborish imkoniyatini 
beradi. Elektron pochtadan foydalanish va elektron xabarlami almashish madaniyati:

□ Pochtangizni tez-tez o'qib tunng
J Xatda albatta sarlavha ko'rsatish zarurdir

-I Xatingizni oluvchini biling va hurmat qiling 
i Xatni xatosiz yozing

l I Xabami qisqa yozing
□ 0 ‘z xatingizni boshqa manzillarga ko‘chirilishidan saqlaning
1 Kerak boimagan taqdirda o‘z xatingizda javob va so'rovlar yoilamang

□ So‘rovlarga to iiq  javob bering
Elektron xatni jo ‘natishdagi ishlar ham oddiy xatni jo'natishga o'xshaydi. Siz 

aloqa serveri bilan bogianib, xatni «aloqa boiimiga olib borasiz». Keyin aloqa 
serveri xatni manzillar serveriga uzatadi. U yerdan manzili ko‘rsatilgan kishi xatni 
olib ketishi mumkin.

Elektron aloqa orqali ixtivoriy maiumotlar: matn, chizma, sxema, diagramma, 
rasm, jadval, musiqa va boshqalami uzatish mumkin Ma’lumotlar ko'rsatilgan 
manzilga bir zumda yetkaziladi. Ma’lumot oluvchi boimagan vaqtda aloqa qutisiga 
ma lumotni qayta-qayta uzatish va saqlash imkoniyati mavjud.

Elektron aloqa hujjati manzil bo‘yicha voilash qoidalariga bo‘ysunishi va aniq 
oichamlarga ega boiishi zarur. Elektron aloqa quyidagi vazifalami bajaradi:

• hujjatlami kiritish va ulami chiqarish;
• hujjatlami aloqa qutisiga uzatish;
• xatolami tekshirish va to'giilash;
• dastlab jo ‘natish qurilmalarini qoilash va qabul qilinganligini ta’kidlash;
• foydalanuvchilar bilan ishlash.
Elektron aloqa xatni axborot tarmoqlari orqali foydalanuvchiga yetkazishni 

ta’minlavdigan muhim tarmoqli aloqadir.
Xatni elektron aloqa yordamida uzatishda manzilning uch xil turidan 

foydalanish mumkin:
• shaxsiy — hujjatni bir kishiga (manzilga) yuborish uchun:
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, gunihiy — hujjatni bir guruh oluvchilarga yo'llash uchun;
. umumiy — hujjatni axborot tarmog'idan foydalanuvchilaming hammasiga

uzatish uchun.
Shaxsiy manzillardan xat, hisobotlami vakka abonentlarga jo'natishda 

fovdalaniladi. Yo'riqnoma ko'rsatma yoki xabamomalami uzatishni guruhiv 
manzillar bo'yicha amalga oshirish qulay. Umumiy manzildan qonunlar, tarmoqning 
ishi haqidagi ma lumotlar, tarmoqning yangi imkoniyatlari haqidagi xabarlami 
uzatishda foydalaniladi.

Oddiy elektron aloqaning muhim bir kamchiligi bor, ya’ni hujjatni jo'natuvchi 
va qabul qiluvchi kompyuterlar bir vaqtda ishlab turgan bo'lishi kerak. Hozirgi 
tarmoqlarda millionlab kompyuterlar ishlab turibdi. Ulaming har biri 
foydalanuvchiga qulay vaqtda ishlaydi. Agar foydalanuvchi o'z joyida bo'lmasayoki 
boshqa ish bilan band bo'lsa, xatni uzatish mumkin bo'lmaydi. Bundan tashqari 
kompyuterlar 24 soat uzluksiz ishlamasligi, buzilishi, mahalliy vaqtning farq qilishi 
ham bor. Shu sababli elektron aloqa tuzilishiga bir yoki bir nechta aloqa bo'limi 
kiritiladi.

Elektron aloqaning bunday tuzilishida barcha xatlar aloqa bo'limi vazifasini 
bajaruvchi ma’lumotlar bazasiga jo'natiladi va unda saqlanadi. So'ngra xatlar aloqa 
bo‘limidan manzillariga jo'natiladi. Katta axborot tarmoqlarida bitta aloqa 
bo‘limining bo'lishi yetarli emas. Bu ma lumot uzatish kanalining zo'riqishiga olib 
keladi. Shuning uchun bunday tarmoqlarda bir nechta aloqa bo'limi tashkil etiladi. Bu 
holda kompyuter foydalanuvchidan xatni olgandan so'ng, uni eng yaqin aloqa 
bo limiga jo'natadi. Zarurat boisa, aloqa bo'limlari xatni bir-biriga jo'natadi. 
Tarmoqda kerakli sondagi aloqa bo limining bo'lishi elektron aloqaga ketadigan 
harajatni ancha iqtisod qilishga olib keladi. Bundan tashqari, foydalanuvchilar aloqa 
bo'limlari bilan, shuningdek, bir-biri bilan tez aloqaga chiqish imkoniyatiga ega 
bo'ladi.

Aloqa bo'limi elektron aloqada xatlami tez va sifatli yetkazishni 
taminlaydigan barcha vazifalami amalga oshiradi. Bunday vazifalar qatoriga 
quyidagilar kiradi:

• axborot uzatish seanslarini boshqaradi;
• uzatilgan xatlardagi xatoliklami tekshiradi va ulami to'g'irlaydi;
• xatlami talab qilingimcha saqlaydi;
• foydalanuvchiga xat kelganligi haqida ma’lumot beradi;
• foydalanuvchiga hujjatni uzatadi;
• xatlami ro'yxatga oladi va uning hisobini olib boradi;
• aloqa bo'limi va abonentlar manzilini saqlovchi malumotnoma ishini 

qo' llab-quvvatlay di;
• axborotlami saralash, xatlar so'ralganda parolni talab qilish (bir nechta 

manzil bo'yicha yuborilganda), hujjatlaming nusxasim olish kabi xizmat amallarini 
bajaradi.

Elektron aloqa ishlashi uchun maxsus bayonnomalar yaratilgan.
Hozirgi kunda quy idagi bayonnomalar qo'llanilmoqda:
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POP3 (inglizcha Post Office Protocol Version 3) —  aloqa xizmatining 
bayonnomasi (bu bayonnoma eski boisa-da, hozirgi kunda ham ishlatilmoqda);

SMTP (Simple Mail Transfer Protocol) — ma’lumotlami uzatishning sodda 
bayonnomasi;

IMAP (Internet Message Access Protocol) — maiumotlarga kirish — Internet 
bayonnomasi. Bu yangi bayonnoma elektron aloqaning HTML formatini qollab 
turishni ta’minlaydi va bu o‘z navbatida nafaqat matnli, hatto multimediali axborotlar 
bilan ishlashga imkoniyat beradi.

Elektron aloqa hech qachon oddiy aloqa va telefonning o‘mini bosa olmaydi. 
Lekin u kommunikatsiyaning imkoniyatini kengaytiradi. Elektron aloqa tizimlarining 
ko'pchiligi elektron xatlami 100 ta manzilga ham bitta manzilga yuborgandek oson 
jo ‘natadi. Buning uchun elektron aloqa manzili ro‘yxati yoki hisob nomerlarini tuzib, 
unga nom berish va xatni kompyuter tizimiga yuklash zarur. Shundan keyin 
kompyuter xatning nusxasini го'у xat da ko‘rsatilgan elektron aloqa qutisiga avtomatik 
ravishda yo‘llaydi.

Elektron aloqa orqali xat jo‘natish uchun uni matnli fayl ko‘rinishida 
tayyorlash va Internet standartiga mos holda rasmiylashtirish kerak. Xatni elektron 
aloqa orqali jo'natishning umumiv formati sarlavha va bevosita ma’lumot uchun 
mo'ljallangan ixtiyoriy matn fayli, rasm yoki dasturdan iborat boiadi.

Elektron xatning standart sarlavhasi quyidagi ko‘rinishda boiadi:
From: jo ‘natuvchi manzili.
To: qabul qiluvchi manzili.
Cc: jo'natishning boshqa manzillari.
Subject: maiumot mavzusi.
Internet tarmogldagi aloqa manziliga misol:
tdpuffiumail.uz
Bu yerdagi «tdpu» —  elektron aloqa qutichasi egasining nomi, mail —  aloqa 

serverining manzili (tashkilot) va «uz» —  davlat, ya’ni geografik hududni anglatadi.
Hozirgi kunda axborot tarmogidan foydalanish an’anaviv tus olgan. Bugungi 

kunda milliv axborot tizimini shakllantinsh jarayonida Internet va boshqa global 
axborot tizimlaridan keng foydalanish, ayniqsa muhim ahamiyatga ega. Darhaqiqat, 
kundalik turmushda bilish zarur boigan axborotlaming ko;pligi, ulami topish, olish 
va fovdalanishni rejalashtirishni talab qiladi. Ya'ni, qanday turdagi axborotlarni 
gazeta, jumal, televidenie yoki radiodan va qanday axborotlarni boshqa manbalardan, 
masalan, Internet yoki elektron pochtadan olishimiz mumkinligini belgilab olishimiz 
kerak. Foydalanuvchi web-sahifalarini internet provayderi serverida joylashtirish va 
joriy qilish amali xosting deb ataladi. Xosting so‘zi to ia  qonli ikki tomonlama aloqa 
bilan ta minlangan tarmoqdagi kompyutemi bildiruvchi xost so‘zidan olingan.
Xosting xizmati quyidagi imkoniyatlami taqdim etishi zarur:

□  axborot makoni;
□  internet kanalining oikazish qobiliyati (kengligi);
□  fayllami boshqarish usullari;
□  standart skriptlar to‘plami;
□  server tomonida dasturlash mumkinligi;
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□  serverda ma’lumotlar bazalaridan foydalanish;
□  bir yoki bir necha pochta qutilarini tashkil etish;
□  uzluksiz elektr energiyasi bilan ta’minlash.

Internet tizimidan foydalanish uchun eng avvalo, bu axborot tarmog‘iga 
ulanish lozim. Quyida bu tarmoqqa ulanish va undan foydalanish tartib qoidalarini 
ко"rib chiqamiz.

Kompyuterlar bir-biri bilan qanday bogianadi, degan savol tugilishi mumkin. 
Intemetga bogianishning bir nechta usuli mavjud. Bog'lanish turlari o ‘zaro 
imkoniyatlari va malumotlami uzatish tezligi bilan farqlanadi. Bogianish imkoniyati 
va tezligi intemetdan foydalanish narxini belgilaydi. Sifat va tezlik oshishi bilan narx 
ko'tariladi. Bogianish turlarini narxining pasayishi tartibida quyidagicha keltirish
mumkin:

1. To'g'ridan-to'g'ri bogianish.
2. SLIP va PPP yordamida bogianish.
3. «Chaqiruv» asosida bogianish.
4. UUCP yordamida bogianish. Bu usullaming mazmuni bilan tanishib 

chiqamiz. To'g'ridan-to'g ri bogianish usuli tarmoqning barcha imkoniyatlaridan 
to iiq  foydalanishga imkon beradi. Bunda foydalanuvchi uchun alohida tarmoq 
ajratiladi va buni provayder ta'minlaydi.

Bunday bogianishda kompyuteringiz server sifatida ishlaydi va bu 
bogianishning eng sifatli usuli hisoblanadi. Siz server —  kompyuter yordamida 
mahalliv tarmoqdagi kompyuterlami intemetga bogiashingiz mumkin. Bunda 
maiumotlami uzatish tezligi 10 Mb/sekundga teng boiadi.

To‘gridan-to‘g'ri bogianishni Radio Ethernet orqali ham amalga oshirish 
mumkin. Bunday bogianish radiokanal bogianishdir. Bu bogianish radioantennalar 
yordamida amalga oshiriladi va tarmoq simlarining zarurati boimaydi. Shu bois, bu 
bogianish uzoq masofalarda ham aloqani ta’minlaydi (provavdergacha boigan  
masofa 50 kmgacha boiishi mumkin). Maiumotlami uzatish tezligi 11 
Mbit/sekundga yetadi. Sarkor —  Telekom provayderi shu usuldan foydalanadi.

SLIP va PPP orqali bogianish oddiy telefon tarmoqdarida standart modem 
yordamida ishlovchi Internet dasturiy taminotidir. Bunda siz oddiy telefon 
tarmogidagidek ishlaysiz. Ish seansini tugatgandan so‘ng telefon tarmog‘ini 
bo‘shatasiz va unda boshqa foydalanuvchi ishlashi mumkin boiadi. Bunday 
bogianishning yutug‘i shundaki, ular intemetga to‘g‘ridan-to‘g‘ri kirishga imkon 
beradi. Telefon linivalan bo ylab IP-xabarlami uzatish imkonini beradigan ikkita 
bayonnoma mavjud. Bu SLIP (Serial Line Internet Protocol -  ketma-ket kanal uchun 
tarmoqaro bayonnoma) va PPP (Point-to-Point Protocol - "nuqta-nuqta" bayonnoma) 
bayonnomalari. SLIP -  eski bayonnoma, PPP esa -  bir muncha zamonaviy, biroq 
barqaror.

Chaqiruv asosida bogianish Intemetga kirishga imkon beradi. Bunda 
foydalanuvchi mantiqiy nom va parol yordamida intemetga to'g ridan-to'g'ri kirib 
ishlash imkonivatiga ega boiadi. Bunday tarmoqdan bir nechta foydalanuvchi 
foydalanadi va shuning uchun tarmoqning tezligi sustroq boiadi. Internet bilan 
bogianish davomida uning imkoniyatlaridan mumkin qadar toiaroq foydalanish
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lozim. Chaqiruv bo'yicha bog'lanishni o'matish juda oddiydir. Bu usulning narxi 
pastroq boMganligi tufayli undan foydalanuvchilar ko‘pchilikni tashkil qiladi. Bu 
usulda xonadonlardagi kompyuterlami ham intemetga ulash va foydalanish qulay. 
Chaqiruv asosida bog'lamshning sifatli usuli ISDNdir.

ISDN (Integrated Service Digital Network) — bu raqamli telefon tarmog'idir. 
U odatdagi telefon tarmog'idan maMumotlami uzatish tezligi bilan farq qiladi. Bu 
tezlik telefon tarmog‘iga qaraganda 4,5 barobar oshadi va 120 Kbit/sekundni tashkil 
etadi. ISDNning narxi boshqalariga nisbatan baland.

UUCP yordamida bog‘lanish. UNIX operatsion tizimi UUCP deb ataluvchi 
xizmatdan foydalanadi va ma'lumotlami standart telefon tarmog'i orqali uzatish 
imkonini beradi. UUCP faqat fayllami bir tizimdan boshqasiga uzata oladi. Internet 
aloqa bo'limi va USENET bilan ishlashga imkon beradi. Bu bogianish uchun ham 
telefon tarmog'i va modem zarur bo'lib, UNIX dasturining zarurati yo'q.

Internet tarmog'iga millionlab kompyuterlar ulangan. NEC Research Institute 
ma'lumotlariga qaraganda hozirgi kunda intemetda 1 milliard 600 milliondan 
ko'proq Web ilovalar mavjud. Har sekundda o‘rtacha 25 ta yangi sahifa qo'shiladi. 
Tabiiyki, bunday «axborotlar dengizi»da kerakli ma’lumotni izlashni o'rganish 
lozim Tarmoq haqidagi eng yangi axborotni faqat tarmoqning o'zidan olishingiz 
mumkin.

Internet provayderini tanlashda intemetda ishlash tezligi va sifati provayderga 
bogiiq ekanini inobatga olish kerak. Shu bois provayder tanlashda quvidagilarga 
e’tibomi qaratish maqsadga muvofiq:

• provayder qanday tarmoqdan foydalanadi;
• qaysi tarmoq bilan ma lumot almashadi. tarmoqning ma lumotni o tkaza 

olish qobiliyati;
• elektron aloqa xizmati ko rsatilishi;
• aloqa tezligi va sifati, modemga telefon qila olish qobiliyati, provayder 

modemi turi;
• bogianish va ma'lumotlami uzatish tezligi;
• texnik xizmat ko'rsatish;
• qo'shimcha xizmatlar ro'yxati va ulaming bahosi.
Ushbu jihatlari bilan sizga ma qul provayderga kompvuteringizni tarmoqqa 

ulash taklifi bilan chiqasiz. Respublikamizda 1997 vildan Internet xizmatini 
ko'rsatuvchi qator provayderlar o‘z ishini boshlagan. Potrebitel.uz guruhidagi 
muhokamalarga ko'ra 2016 yil yanvardan 2017 yil fevralgacha muhokamalar 
bo'yicha reytingda. Turon Telecom, Sarkor, Uzonline provayderlar yetakchilikni 
qoiga kiritgan (6 . 1-rasm).

Endi intemetga oid ba'zi tushunchalaming mazmuni bilan tanishib chiqamiz.
Mijoz —  server resurslaridan va xizmatidan foydalanuvchi kompyuter yoki 

dastur. Xuddi server kabi bir kompyuterda bir vaqtda bir nechta mijoz ishlashi 
mumkin.

Shlyuz — bavonnomani bir turdagi muhitdan ikkinchi turdagi muhitga 
o'tkazuvchi tarmoq qurilmasi. Kompyuter Intemetga bog‘langanda shlyuzdan 
foydalaniladi.
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Proxy—  bir nechta kompyuteming intemetga ulanishini ta'minlovchi tizim  
Proxy server odatda ko'p ishlatiladigan resurslami saqlash imkoniyatiga ega

Turon 
Sarkor 

Uzoniine 
TPS 

Comnet 
EVO 
ISTV 

Netco 
Sharq Telekom 

Fibernet 
Gals telecom 

Beeline 
ARS-inform 

Cron telecom 
Free link 

Uzmobile 
Sonet 

Nano Telecom 
Sky Line 

Saiom Telecom 
Net City 
Uzscinet

6 .1-rasm. Provayderlami Potrebitel.uz guruhi muhokamasidagi reytingi 
URL - intemetga murojaat qilishning eng oddiy va qulay usuli bo‘Iib, u 

manzilni ifodalaydi. URL manzilidan ixtiyoriy foydalanuvchi bir vaqtning o‘zida 
foydalanishi mumkin. URLni toliqroq tushunish uchun bir misolni ko‘rib chiqamiz: 

http ://vvww.youthcenter. com/index html 
Bu URL manzil tarkibiv qismlari quyidagicha:
http —  resursdan foydalanishda gipermatn bayonnomasi ishlatilayotganligini 

bildiradi.
www.youthcenter.com —  maiumot joylashgan Internet sahifa nomini 

bildiradi.
index.html — faylning kompyuterdagi to‘la nomini bildiradi. Ko‘pchilik www 

sahifalar nomlanishi shu sxemaga mos keladi. Ba’zan http, ftp yoki gopher turidagi 
resurslarga murojaat qilinganda, faylning to liq nomi bir qiya chiziq bilan 
tugallanadi. Bu aniq faylga emas, balki belgilangan katalog ichiga murojaat 
qilinganda sodir bo ladi. Bu manzilga murojaat qilinganda, kompyuter mazkur 
katalog va faylga mos standart indeksli fay Ini beradi. httpning standart indeksli fayli 
odatda index.html (yoki index.htm) deb ataladi.

Faraz qilaylik, intemetda biror sahifani ochib ko‘rmoqchisiz. Sahifa manzilini 
kiritasiz va uni ochasiz. Qanday qilib sahifa bir necha daqiqada kompyuteringiz 
ekranida paydo boMadi. Bu sahifalami topish uchun sizning WWW ko‘rish
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dasturingiz URLdan qanday farqlanadi? Sahifani topish uchun dastur provavderda 
joylashgan domen nomJari xizmati dasturlar majmuidan foydalanadi. U DNS deb 
ataladi va intemetni kompyuteringizga o‘matganda kiritiladi. Netscape Windows 
bilan ishlavotganda sizning TCP/IP bayonnomangiz bu domen nomini sizning 
serveringizga uzatadi. Har bir domen nomi takrorlanmas !boiib, uning birinchi 
darajali domeni eng oxirida yoziladi Masalan, www.tdpin.uz. Birinchi darajali 
domenlar ikkiga bo'linadi:

1. Geografik domenlar (6.2-jadval):
6.2-jadval. Geografik domenlar

domen izoh
uz 0 ‘zbekiston
kz Qozog'iston
tj Tojikiston
it Italiya
fr Frantsiya
ru Rossiva
us Amerika Qo‘shma Shtatlari
uk Buyuk Bntaniva
de Germaniya
tr Turkiva
ca Kanada
cn Xitoy
fi Finlyandiya
il Isroil
Pi Polsha
se Shvetsiya
za Janubiy Afrika Respublikasi

2. Tashkilot domenlari: bunday domenlar nomi ko‘pincha com. edu yoki org 
bilan tugaydi. Ularning ommaviy tus olganlaridan misol sifatida quyidagilami 
keltiramiz48 (6.3-jadval):

6.3-jadval. Tashkilot domenlari
domen izoh

som tijorat tashkilotlari uchun ishlatiladi
edu o‘quv muassasalari uchun ishlatiladi
gov davlat muassasalari uchun ishlatiladi
net Internet xizmati provayderlarida ishlatiladi
org notijorat tashkilotlari uchun ishlatiladi
int xalqaro ma'lumotlar uchun ishlatiladi
mil harbiy muassasalar uchun ishlatiladi

mobi smartfonlar uchun mobil-moslashgan saytlar

48 Ralph M. Stair. George W.Reynolds. Fundamentals oflntorm ation Systems. Sixth edition. Course Technology,
Cengage Learning. USA. 2012. 175-p.
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Intemetda ishlash yoki undan foydalanish uchun brauzer dasturlaridan 
foydalaniladi. Brauzer -  bu Internet resurslari va ma'lumotlaridan foydalanishni 
ta minlovchi dastur bo'lib, uning quyidagi turlari mavjud (6.4-jadval):

№ Brauzer
nomi:

Imkoniyatlari

1. Opera 10.63 Opera Software kompaniyasi dasturidir. Bu dastur 43 tildagi 
foydalanuvchilar uchun mo'ljallangan b oiib , Windows, Linux va Mac 
operatsion tizimlarida ishlaydi.

2. Mozilla
Firefox

Mozilla Firefox - tezkor, ko‘p funktsiyali brauzer dasturi. Firefox dasturida 
bir oynada bir nechta sahifani ochish mumkin. Shuningdek, siz giper 
havolalami shu sahifani (siz ayni paytda ko‘rib turgan sahifani) tark 
etmasdan turib ochish imkonivatiga ega bo‘lasiz. Brauzer web standartlami 
juda yaxshi qo'llab, unda juda qulay interfeys mavjud va o ‘zida qidiruv 
paneli (Google va boshqalar) joylashgan.

3. Google
Chrome

Google Chrome -  bu brauzer, murakkab texnologiyalami та sodda 
dizaynni birlashtirgan va bu esa Intemetda ishlashni tezlashtiradi va 
xavfsizligini oshiradi.

4. Apple Safari Apple Inc. kompaniyasining brauzer dasturi hisoblanadi. Dastlab dastur 
Mac OS operatsion tizimi uchun ishlab chiqilgan edi. Dasturda ko‘p 
oynalik interfeys mavjud bo‘lib, unda xavfsizlik uskunalari bilan 
boyitilgan.

5. Maxthon Internet-brauzer dasturi. Maxthon web-sahifalami ko‘p oynali rejimda 
ko'rish imkonini beradi. Dastuming asosiy xususiyatlaridan bin ko‘p sonli 
bog‘lamshlar imkoniyati mavjud.

6. Avant
Browser

Bu brauzer ham ko‘p oynali rejimda ishlaydi. Ya’ni asosiv ovna ichida 
ko‘plab oynalami ochish imkoniyati mavjud. Avant Browser dasturida 
sichqoncha tugmasini bir bosish bilan grafiklar, video, tovushlar va Flash 
animatsiyalarni yuklashni taqiqlash yoki aksincha ruxsat berish imkoniyati 
ma\jud.

7. Netscape
Navigator

Dastur o'zining oddiy va yengil sozlanadigan foydalanuvchi interfeysi 
bilan va tezkorligi, ishlashga qulayligi hamda web-sahifalami ko‘rishni 
boshqarish imkoniyatlari kengaytirilgan.

Har bir foydalanuvchiga Internet tarmog’i orqali o'ziga kerakli bo'lgan 
ma lumotlami oson va tez qidirib topishi uchun axborotning parametrlari bo‘yicha 
qidirish taklif qilinadi. Ular quyidagilardan iborat:

S  Ma’lumotlami uning tili bo'yicha qidirsh;
S  Ma’lumotlami uning turi (matn, rasm, musiqa, video) bo‘yicha qidirish;
S  Ma’lumotlami uning joylashgan mintaqasi bo‘yicha qidirish;
S  Ma'lumotlami uning joylashtirilgan sanasi bo'yicha qidirish;
S  Ma’lumotlami uning joylashgan Internet zonasi bo‘yicha qidirish;
S  Ma’lumotlami xavfsiz qidirish.

Net Market Share kompaniyasining 2016 yil mavdagi ma’lumotiga ko‘ra 
qidiruv tizimlarining qoilanilishi ko'rsatkichi quvidagi tartibda bo'lgan:

□  Gooele —  75.97 %:
□  Bing— 8,28%;
□  Baidu — 7,54%;
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□  Yahoo —  6,56 %;
□  AOL —  0.10%:

MASHQ. Internet tarmog‘ida ma’lumotlarni izlash va saqlash
Ishning maqsadi: Talabalarda Internet tarmog‘ida ma lumotlami izlash va saqlash,
elektron pochta xizmati dan foydalanish ko'nikma va malakalarini shakllantirish.
1 topshiriq: Axborotlarni qidirislh.

1. Google Chrome brauzer oynasini (y oki kompvuteringizga o'matilgan boshqa 
brauzer) oching.

2 . Google.ru axborot-qidiruv tizimini yuklang va uning manzil satriga URL 
http://www.google.ru iborasini kiriting.

3. Buyuk alloma Muxammad A1 Xorazmiy haqidagi ma’lumotlami qidirish talab 
etiladi. Buning uchun qidirish satriga ’Muxammad A1 Xorazmiy” iborasini 
kiriting va Поиск (Qidirish) tugmasini bosing.

4. Natijada qidirilayotgan ma’lumot qayerda jovlashganligini aks etuvchi 
manzillar ro‘yxatiga ega bo‘lamiz.

5. Royxatdan kerakli mavzu tanlanib, uning ustida sichqonchaning chap tugmasi 
bosiladi. Natijada ma’lumot joylashgan oyna ochiladi.

6 . Microsoft Word dasturiga ma’lumot nusxasini ko‘chiring. Buning uchun 
ma lumotni chap tugma yordamida yurgizish yo‘li bilan belgilang va o ‘ng 
tugmani bosish natijasida ochilgan muloqot darchadan Копировать 
buyrug‘ini tanlash yordamida nusxasini oling va Word dasturiga klaviaturadagi 
Ctrl+V tugmalar majmuini tanlagan holda joylashtiring.

7. A1 Xorazmiy rasmini toping va uni kompyuterga saqlang. Buning uchun rasm 
ustida o‘ng tugmani bosing, ochilgan muloqot darchadan Сохранить 
изображение как... buy rug'ini tanlang va faylni saqlovchi papkani 
ko‘rsating.

2-topshiriq: Pochta qutisini yaratish.
1. http://mail.ru savtiga kinne.
2. Mail.ru saytida shaxsiy pochta qutisini yaratish uchun ro'vxatdan o'tish lozim. 

Регистрации в почте murojaatni tanlash natijasida anketali sahifaga 
ko‘zingiz tushadi.

3. Rasmivlashtirish sahifasida o‘zingizni shaxsiy ma’lumotlaringizni kiriting, 
ya’ni pochta qutisi uchun nom (kelgusidagi sizning elektron manzilingiz e- 
mail). Nom lotin alifbosi harflaridan, sonlardan, (“_“) tagiga chizish belgisi, (“- 
“) minus yoki (“.”) nuqtadan tashkil topgan bo‘lishi mumkin. Nom (“_ “) ostiga 
chizish belgisi, (“-“) minus yoki (“.”) nuqtadan boshlanishi mumkin emas. Siz 
mail.ru, inbox.ru, iist.ru yoki bk.ru domenlardan birini tanlashingiz 
mumkin.

4. Yaratilay otgan pochta qutisi uchun parol (kalit so‘z) o‘ylab toping. Uni ikki 
marta kiriting. Eslab qoling, parol berishda kirill alifbosidan foydalanib 
bo4maydi. Bundan tashqari, juda sodda parolni ham tanlamang chunki uni 
topib olish natijasida sizning pochta qutingizdan foydalanish imkoni tug iladi.
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5 Esdan chiqarilgan paroini tiklash imkoniyatiga ega boiish uchun. mobil 
telefon raqamini yoki maxfiy savolni (yoki uni taqdim etilgan ro‘yxatdan 
tanlash) ko‘rsatish y o ii  bilan savolga javob bering. Bu verda, boshqalarga 
savolga javob topish oson boimasligiga e’tibor bering va siz uchun ham u 
savolni esdan chiqarishingiz qiyin bo'lsin. Maxfiy savolga to‘g ‘ri javob 
berilgandan keyin sizga yangi parol o*matish taklif etiladi.

6 . Yangi elektron manzilni ro yxatdan o‘tkazish jarayonini yakunlash uchun, 
Зарегистрироваться tugmasini bosing.
Anketani to‘g‘ri toMdirish natijasida siz pochta qutingizga уоЧ ochasiz. Undagi 

salom xatga e’tiboringizni qarating, chunki u joyda pochtaning asosiy imkoniyatlari 
haqidagi ma’lumotlar keltirilgan.

Savol va topshiriqlar
1. Internet tarmog'idan Amir Temur haqidagi ma'Iumotlami va ularning rasmlarini 
toping. “Temur tuzuklari” nomli kitobni yuklab oling.
2 . Internet tarmog‘idan Informatikadan vangi ma’Iumotlami toping va yuklab oling.
3. Internet tarmog'idan Informatikada modulli o ‘qitish mavzusidagi ma’Iumotlami 
toping. Ulami yuklab oling.
4. Nizomiy nomidagi TDPU saytiga kiring va unda yangiliklar bilan tanishing.

Test savollari
1. Internet bu - . . .
A) biror tuman, viloyat yoki respublika 
miqyosidagi kompyuterlami o ‘zida 
mujassamlashtirgan tarmoqdir
B) bir binoda yoki bir-biriga yaqin bmolaida 
joylashgan kompyuterlarda o‘zaro axborot 
almashish imkonini bcruvchi tarmoq hisoblanadi
C) dunyoning ixtiyoriy davlatidagi kompyuterlami 
o‘zida birlashtirish imkoniyatiga ega boMgan 
tarmoqdir.
D) dasturiy ta’minoti va bayonnomalari asosida 
tashkil etilgan, elektron ma iumotlar bazalari bilan 
jamoa bo‘lib ishlash imkonini beruvchi korxona 
yoki tashkilot yangi axborot muhitini tashkil 
etuvchi kompyuter taimog‘idir

2. World Wide Web deganda nimani 
tushunamiz?
A) xalqaro o‘rgimchak to‘ri
B) xalqaro aloqa tarmog'i
C) xalqaro pochta tarmog‘i
D) ma’lumotlar bazasi

3. Web-sayt nima?
A) Web-sahifalar to‘plami;
B) Intemetdagi manzil;
C) Web sahifadagi matn
D) Ma’Iumotlami boshqarish

4. Web-brauzerning asosiy vazifalari qaysilar?
A) Web-sahifani xotiraga vuklash va ko‘rish,

6. Quyidagilardan qaysi bbi qidiiuv tizimi 
emas?
A) www. google ru
B) WWW, rambler m
C) www.resurs ru
D) www.mail.ru

7. Quyidagilardan qaysi biri elektion pochta 
manzilini belgilovchi bcigi?
A)
B) www
C) com
D) http

8. Internetning qaysi xizmati joriy vaqtda bir 
nechta insonning muloqot ini ta'minlavdi?
A) Chat
B) www
C) E-mail
D) Telekonl'erensiya

9. Intemetda qaysi bayonnoma tayanch 
hisoblanadi?
A) TCP/IP
B) HTTP

C) HTML
D) TCP

10. Internetga ulangan kompyuterda albatta ... 
mavjud bo'ladi
A) IP-adres
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saqlash. chiqarisli, В ) W eb-server
B) Web-sahifani xotiraga vuklash va ko‘rish. C) Domen nomi 
chiqarish; D) Uy web-sahifa
C) Web-sahifani saqlash, chiqarish
D) Sahifani tahlil qilish

5. Internet Explorerni necha usulda ishga 
tushirishingiz niunikin?
A) 2
B) 4
C )3
D )5

29-§. Mobil aloqa texnologiyalari

Tayanch tushunchalar: so ‘zlashuv, uyali telefonlar. smartfonlar, peydjerlar, 
cho'ntak shaxsiy kompyuterlari, kommunikatorlar, iPhone, Internet planshetlar, 
mobil aloqa muhiti, mobil Internet, SMS, MMS.

Elektron va mobil tijorat hamda korporativ tizimlar hayotimizning ko‘plab 
jabhalarini qamrab oldi. Ulaming asosiy xususiyatlardan biri kompaniya o‘z 
mijozlari, yetkazib beruvchi lari, davlat organlari va boshqa hamkorlari bilan qanday 
tarzda ozaro aloqada boMishi hisoblanadi. Natijada ko‘plab tashkilotlar bugun 
intemetda o‘z tijoratlarini yaratish imkoniyatlarini o lrgangan holda unga korporativ 
tizimlarini o ;zaro bog‘lash ustida ishlamoqdalar Ishning natijali ketishi uchun 
tashkilotning barcha a'zolari bu jarayonlarda faol ishtirok etishi kerak boMadi. 
Xodimlar mijozlarga xizmat kobrsatish sifatini vaxshilash uchun korporativ tizimni 
qoilashni hisobga olishi maqsadga muvofiq. Moliya sohasidagi analitiklar firma 
faolivatini boshqarish va nazoirat qilish uchun zarur ma‘lumotlami to‘plash va 
vetkazish uchun korporativ tizimni qanday qoilash kerakligim bilishi kerak. 
Zamonaviy tashkilotning xodimi sifatida siz elektron tijorat va korporativ 
tizimlaming o‘mini bilishingiz muhim sanaladi va ularni tashkil qilishda xatoliklarga 
у o*I qobymaslikka harakat qilish kerak. Bunga qo‘shimcha ravishda m- 
kommertsiyalaming qo‘shilishi bu muammo va imkoni) atlaming yangi o‘lchamlarini 
keltirib chiqaradi.

Mobil qurilmalar deganda vengil, 0‘lchami katta bolmagan (cho‘ntak) 
qurilmalar tushunilib, ular simsiz texnologiyalar yordamida aloqa tarmoqlariga 
avtonom ulanish imkonini beradi. Ayni paytda foydalanuvchilarga turli xil vazifalami 
vechish uchun mobil qurilmalaming keng qamrovi mavjud. Ular oddiy arzon mobil 
telefonlardan boshlab toki professional cho'ntak shaxsiy kompvuterlari va 
smartfonlargacha qamrab oladi. Mobil qurilmalar tasnifi. Mobil qurilmalaming 
asosiy toifalari49: uyali telefonlar, smartfonlar, peydjerlar, cho‘ntak shaxsiy 
kompyuterlari, kommunikatorlar, Internet planshetlar (6.2-rasm).

*9 Соколова В.В. Разработка мобилных приложений: учебное пособие / Томский политехнический 
университет. -  Томск: Изд-во Томский политехнический университета. 2011 7—С.



CHSHK Telefon

/

V

Kommunikator Smanfon

6.2-rasm. Mobil qurilmalar ven diagrammasi
Mobil aloqa vositalari
Smartfon (smartphone) inglizchadan taijima qilinganda “aqlli telefon” ma’nosini 
anglatadi. Funktsionalligi jihatidan cho'ntak shaxsiy kompyuteriga yaqin bo'lgan 
mobil telefon.
iPhone - to‘rt diapazonli multimediyali smartfonlar guruhi. iPhone o'zida telefonning 
asosiy vazifalaridan tashqari kommunikator va internet planshetlaming asosiy 
funktsiyalarini ham qamrab olgan.
Internet planshetlur -  bu maxsus mobil qurilma bo'lib. shaxsiy kompyuteming 
klassik namunasidir. Planshetlar faqatgina ekrandan tashkil topgan bo'lib, boshqa 
qo'shimcha qurilmalar (sichqoncha, klaviatura) virtual ko'rinishda tashkil etilgan. 
Kommunikator—  cho'ntak kompyuteri, telefon, modem va boshqa simsiz aloqa 
vositalarining kommunikatsion imkoniyatlarini o'zida qamrab olgan mobil qurilma 
hisoblanadi.

Kommunikatorlar o ’zida zamonaviy ildam odamlarga zarur ikki jihatm qamrab
oladi:

❖ Aloqa va cho'ntak kompyuteri.
♦J* Asosiy afzalligi — endi bu imkoniyatlar bitta korpusda jamlangan bo'lib har 

doim foydalanuvchining qo'l ostida bo'ladi. Matn bilan ishlashda cho'ntak shaxsiy 
kompvuteridan tashqari barcha mobil qurilmalami ortda qoldirib, to'laqonli 
klaviaturaga ega Kommunikatorlar barcha zarur bog’lanishlami qo'llab-quvvatlashi 
tabiiy xol: Wi-Fi, GPRS, GSM, Bluetooth, 3G.
Peydjerlar -  foydalanuvchilar o'rtasida qisqa matnli xabarlami almashish uchun 
zarur qurilma.
Cho‘ntak shaxsiy kompyuteri — bu ixcham qurilma bo'lib, operatsion tizim 
o'matilgan bo'ladi va unda amaliy dasturlami o'matish va ishlash imkonini beradi. 
Mobil telefon — mobil aloqada foydalaniladigan telefon apparati turi. Hozirgi kunda, 
mobil telefon klaviatura va ekranga ega bo’lib asta-sekin kompyuter, faks apparati, 
telefon apparati, qavdlar kitobchasi va boshqa bir qancha vazifalarini bajaruvchi ko'p 
maqsadli abonent tizimiga aylanmoqda
Mobil aloqa muhiti — tayanch stansiyalar va bir guruh abonentlar tizimidan iborat 
bo’lib, abonentlaming bir-birlari bilan o'zaro axborot almashinuvini ta’minlovchi 
texnik vositalar majmuasi.
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Uyali telefon asosiy vazifasi uyali tarmoqlar vositasida tovushli aloqa xizmatini 
taqdim qilishdan iborat. Uyali telefonlar ham operatsion tizimlar tomonidan 
boshqariladi. Faqatgina bunday operatsion tizimlar amaliv dasturiy vositalar uchun 
mo'ljallanmagan. Ayni vaqtda uyali telefonlar mobil qurilmalar bozorida eng ko‘p 
qo'llaniladigan simsiz quriima hisoblanadi. Ayrim Evropa mamlakatlarida 
aholisining 75 %dan ko'prog‘i mobil telefonlarga ega Aksariyat hollarda tovushli 
aloqa maqsadlarida qo‘llanalib, ma'lumot uzatishning simsiz bavonnomasi pay do 
bo iishi bilan (WAP) va matnli xabarlar almashish hamda boshqa imkoniyatlari bilan 
keng tarqalib ketdi.

Mobil aloqa xizmati operatorlari -  abonentlar (mijozlar) uchun mobil aloqa 
xizmatlarini taklif qiluvchi tashkilotdir. Operatorlar vazifasiga radio chastotadan 
foydalanish va xizmat ko'rsatish uchun kerakli hujjatlami olish, о zining mobil 
tarmog‘ini tashkil qilish, foydalanish, xizmat shartlarini ishlab chiqarish, xizmat 
to‘lovlarini yig'ish va texnik xizmat ko'rsatish kiradi. Hozirgi paytda O'zbekiston 
hududida 5 ta mobil aloqa operatori xizmat ko'rsatmoqda bular: UMS. Beeline, 
Ucell, Perfectium Mobile, Uz Mobile.

Mobil aloqa xizmatlari. So‘zlashuv — telefon raqami terilganda joriy mobil 
operator tayanch stansiyaning antennasi chaqiravotgan va chaqirilavotgan 
abonentlarni aniqlaydi. Shundan so‘ng ushbu axborot qayta ulagichga (kommutator) 
yuborilib ikkita abonent bog'lanadi va ushbu abonentlar orasida so'zlashuv 
(ma’lumot almashinish) amalga oshiriladi.
Mobil Internet -  harakatdagi abonentlar uchun mobil aloqa tarmoqlari orqali Internet 
resurslaridan foydalanish texnologivasi. Mobil Intemetning qulayligi shundan 
iboratki, bunda foydalanuvchining qayerda va qanday holatda bo'lishidan qat’iy 
nazar u mobil aloqa tarmog‘i orqali Internet xizmatlaridan foydalanishi imkoniyatiga 
ega bo'ladi.
Mobil pochta - Internet resurslaridan foydalangan holda abonentning mobil telefoni 
orqali shaxsiv elektron pochta xizmatidan foydalanish imkoniyati dir.
Mobil aloqa vositalari yordamida axborot almashish
Bluetooth -  kichik qamrov doirasiga ega boMgan simsiz aloqa texnologiya Tarmoq 
qurilmalari orasidagi o‘zaro muloqotni va ularning Intemetga ulanishini 
yengillashtiradi.
SMS (Short Message Service) -  qisqa xabarlar xizmati. Mobil aloqa tarmoqlarida 
abonentlaming bir-birlariga qisqa matn xabarlarini uzatish va qabul qilish xizmati 
hisoblanadi50.
MMS (Multimedia Messaging Service) -  GPRS texnologiyasiga asoslangan 
multimedia xabarlarini almashish xizmati. Xizmat rangli rasm, fotosurat, musiqa va 
hatto videoroliklami uzatish va qabul qilish imkonini beradi.

Mobil telefonlardan foydalanish va axborot almashish madaniyati. Mobil 
telefonlar va boshqa mobil aloqa vositalaridan fovdalanganda so‘zlashish 
madanivatiga. xabarlami yozish va elektron pochtadan foydalanish etikasiga hamda

50 Соколова B.B. Разработка мобилных приложений: учебное пособие / Томский политехнический 
университет. -  Томск: Изд-во Томский политехнический университета, 2011. 1 4 -С.
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telefon apparatidan foydalanish qoidalariga rioya qilish zarur telefon orqali nojo‘ya 
so'zlam i gapirish, turli nojo'ya xabarlarni jo'natishdan saqlaning.

Mobil telefon va mobil aloqa muhiti. Mobil telefon -  mobil aloqada 
foydalaniladigan telefon apparati turi. Hozirgi kunda, mobil telefon klaviatura va 
ekranga ega boiib asta-sekin kompyuter, faks apparati. telefon apparati, qavdlar 
Icitobchasi va boshqa bir qancha vazifalami bajaruvchi ko'p maqsadli abonent 
tizimiga aylanmoqda. Bugungi kunda ko'plab vazifalami shaxsiy kompyuterlardanda 
ixcham mobil qurilmalar bajarib kelmoqda. Qator funktsional vazifalami bajarish 
bilan birga mobil qurilmalardan masofaviy o'qitishni tashkil qilishda ham shaxsiy 
kompyuterlar singari o'ziga xos qulayliklarga ega. Oxirgi vaqtlarda masofaviy 
o’qitish tizimini rivojlantirishning yo'nalishlaridan biri sifatida mobil o'qitish 
(mobile learning yoki nvleaming) qabul qilingan boiib, unda taiim  mobil telefonlar, 
smartfonlar va cho'ntak shaxsiy kompyuterlan orqali amalga oshiriladi. Bu 
texnologiya elektron o'qitishni (e-leaming) rivojlantirishning navbatdagi bosqichi 
hisoblanadi. M-Leaming texnologiyasi masofaviy o'qitish tizimi bo'lishini talab 
qiladi va aynan shunga asoslanadi. U o'z ichiga o'quv materiallariga bog'lanish va 
turli mobil qurilmalaming xizmatlaridan shuningdek web-sahifalarga bog'lanish 
imkoniyatlarini ta’minlaydigan tizimostilarini qamrab oladi.

Mobil o'qitishning paydo bo'lishi o'tgan asrga borib taqaladi. O'tgan 
asming 70-yillarida Alan Key (Alan Kay) taiim  maqsadlari uchun kitob 
oichamidagi kompy uter g'oyasini taklif etdi. Qurilma dinamik kitob deb nomlanib. 
o'quv maqsadlarini dinamik modellashtirish imkonini beradi, birinchi tarmoqli 
avtomatlashgan ish jovi hisoblanar edi51. 1990-yillarda PalmOS operatsion tizimli 
cho'ntak shaxsiy kompyuterlari paydo bo'lishi bilan talabalar uchun bunday muhitda 
mobil o'qitishni baholash va rivojlantirish yo'lidagi loyihalar avjiga chiqa boshladi. 
Birinchi cho'ntak shaxsiy kompyuteri “cho'ntak elektron organayzeri” deb nomlanib, 
dastlab matnni ko'rsatish uchun faqat uchta yo'lak mavjud edi xolos. Ayni vaqtda 
mobil o'qitish va shuningdek mobil boshqaruv texnologiyalari masofali o'qitish va 
elektron boshqaruvni rivojlantirishning istiqbolli yo'nalishlaridan hisoblanadi. Mobil 
aloqa texnologiyalarini qo'llashga e tiboming bu darajada ortishiga alohida bir sabab 
borki, u ham bo'Isa ulaming tarqalish sur'ati intemet-texnologiyalari rivojlanish 
sur'atidan ko'ra sezilarli darajada ortib bormoqda. Qator xorijiy mamlakatlarda bu 
kabi texnologiyalami tajriba-sinov rejimida kiritilishi o'zining ijobiy natijasini 
berganligini kuzatish mumkin. Jahonning yetakchi mamlakatlari axborot jamiyatini 
barpo qilishda hukumat tomonidan aholiga sifatli xizmatlami ko’rsatishda aloqani 
tezligi va tezkorligini kafolatlaydigan texnologiyalar yordamida amalga oshirishni 
mo'ljallamoqda. Bu borada ham mamlakatimizda ulkan natijalar qo'lga kiritilmoqda. 
Dunyoda mobil telefonlardan foydalanuvchilaming umumiy soni 7,5 mlrd. kishini 
tashkil qilsa unda Internet foydalanuvchilari soni - 3 mlrd. kishini tashkil qiladi 
(2014 yilning oxiri). O'zbekistonda ham bu ko'rsatkichlar tez sur’atlar bilan 
o'sayotganini ko'rishimiz mumkin. Internet foydalanuvchilari soni 12 milliondan

51 Системы мобильной свети: Учебное пособие для b v j o r  В.11. Ипатов. В.К. Орлов, И М Самойлов.
В.Н. Смирнов: под. ред. В II. Ипатова. —  М. Горячая лнния-Телеком. 20U3 —  272 е., ISBN 5-93517-137-С.
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ortgani, mobil aloqa abonentlari esa 22 milliondan ortganini ko'rishimiz mumkin 
(2015 yil sentyabr)52.

Mobil quriima individual va har doim foydalanuvchisi bilan birggi 
hisoblanadi. Shu sababli ham mobil xizmatlardan har joy da va har qanday vaqtda 
foydalanish mumkin boiadi. Bu xususivat esa texnologiyaning kelajakda rivojlanish 
sur'atlarini yanada ko‘tarilishini kafolatlaydi deb qarash mumkin.

Mobal texnologiyalami taiimda qo‘llash oliy ta'lim muassasalari 
faoliyatidagi ustuvor yo‘na!ishlardan hisoblanadi. Ammo bugungi kunda mobil 
o‘qitish formatidagi masofaviv kurslami ishlab chiqish va joriy qilish tajribasining 
ommalashtirilishi sust amalga oshmoqda. Shuningdek, bu kabi kurslami yaratish va 
ular asosida ta limni tashkil qilisSi bo'vicha uslubiv ko rsatmalar ham yetarli darajada 
emas. Bu borada faqatgina sanoqli tijorat kurslari faoliyat ko‘rsatayotganini avtib 
o‘tish mumkin. Ixcham mobil qurilmalar kun sayin ko'p funktsiyali boiib borishi 
mobil texnologivalarda masofaviy ta'limning rivojlanishi sari olib keladi. Bugunda 
mavjud mobill qurilmalar statsionar kompvuterlardan ko'ra rang-barang va qiziqarli 
ixtisoslashgan va umumiy vazifalami bajaruvchi dasturlar bilan boyitilib bormoqda. 
Mobil telefonlar endi telefonlar, kompyuterlar, kalkulyatorlar, tashkillashtiruvchilar, 
kalendarlar, kameralar, kompaslar, chizish uskunalari, audio va video ijrochilar, 
Internet xizmatlari, e-mail mijozlari, elektron kitob va boshqa texnika va vositalar 
o‘mida ishlayotganini ko'rishimiz mumkin. Bugungi kunda jamiyatning har bir 
a'zosi kamida bir mobil qurilmaga ega bo‘lib. ular internet tarmog'iga bog‘lanish 
imkoniyatiga ega Mobil texnologiyalaming rivojlanishi bilan avni ahodining mobillik 
darajasi ko tarilishi axborotga boigan tezkor bogianish ehtivojini ortishiga olib 
keldi.

Mobil o'qitish aslida elektron va masofaviy o'qitish bilan mustahkam 
bogiangan boiib, ulardan farqli jihati mobil qurilmalaming qoilanilishida 
hisoblanadi. Mobil o'qitishning quyidagi uchta toifalarini ajratib ko'rsatish 
mumkin53:

• Texnologik mobil o'qitish (Technology-driven mobile learning) —  avrim 
aniq texnologik innovatsiyalar Traxler John. Current State of Mobile Learning. 
International Review on Research in Open and Distance Learning (IRRODL) 8, no.
2. 2007.

• Miniatyura shaklidagi, ammo ixcham (portativ) elektron o'qitish 
(Miniature but portable e-leaming).

• Auditoriya bilan bog iangan o'qitish (Connected classroom learning).
Mobil o'qitish (Mobile learning yoki M-leaming) -  bu WAP (Wireless

Application Protocol—  simsiz maiumot uzatish bavonnomasi) yoki GPRS (General 
Packet Radio Service—  umum foydalanishning paketli radioaloqasi) 
texnologiyalami qoilagan holda mobil qurilmalarda (mobil telefon, smartfon va 
cho'ntak shaxsiv kompyuteri) bilimlami uzatish jarayonidir. Tanlangan quriima

52 httPi' eeitt.uz - O'zbekciton Respublikasi Axborot texnolugivalari vu koinmunikatsiyalarini rivojlantuish 
vazirligi rasmiy sayti.
53 Горюнова Л.В. Мобильность как принцип модернизации высшего педагогического образования // Известия 
Южного федерального университета. Педагогические науки. 2013. № 6. С. 031-036.
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ordamida intemetga chiqish, materiallami ko'chirish, forumlarda savollarga javob 
berish yoki test topshirish imkoniyatlarini beradi. Unda katta hajmli materiallar 
telefonga yoki shaxsiy kompy uter orqali xotira kartasiga yuklanib olinadi. M-leaming 
maqsadi -  o ‘quv jarayonini moslashuvchan, samarali, hamma kira oladigan qilishdan 
iborat.

M obil o'qitish tizimi bu didakatik, texnik. axbony va tashkiliy yondashuvlar 
majmui bo‘ lib, ochiq masofaviy ta'lim tamoyillarini amalga oshiradi. Mobil o ‘qitish 
tizimi funktsional jihatdan quyidagi tizim ostilami taqdim qiladi:

• mobil o‘qitish o‘quv jarayonini boshqarish funktsiyalari yordamida o ‘quv 
rejalari, dars jadvallari, kurslaming o‘quv metodik taminoti, bilimlami nazorat 
qilish imkoniyatlarini yaratadi;

• ma’murlik-boshqaruvga oid funktsiyalar manbalar, loyihalar, aloqalami 
boshqarish, o ‘quv ma’lumotlar bazasini yuritish;

Mobil qurilmalaming imkoniyatlari juda keng boiib undan shaxsiy 
kompyuter singari zarur amaliy dasturiy ta minotni o‘matgan holda o'z oldimizdagi 
mummolami hal etishimiz mumkin. Shu sababli mobil o ‘qitish muhitini ular 
tomonidan bajariladigan funktsiyalariga ko‘ra quy idagicha tasniflash mumkin:
a) mobil kontentni (mobil darslik, elektron kitob, mobil lug‘at. interfaol taijimon, 
mobil televideniva texnik ta minoti, mobil ekskursiva on-line-taqdimot. mobil 
ma’lumotnoma) oiganish uchun mobil muhit;
b) tahsil oluvchilar bilan mobil muloqot uchun muhit (mobil chat, mobil elektron 
pochta, mobil video konferentsiya aloqasi, mobil forum, mobil blog);
v) bilimni mobil nazorat qilish uchun muhit (SMS- testlash muhiti; SMS-so‘rov 
muhiti, ovoz berish; mobil forum va chatda so‘rov muhiti; cho‘ntak shaxsiy 
kompyuter, smartfon va kommunikatorlarda mobil testlash muhiti; mobil internet 
qurilmalari uchun bilimni testlash muhiti);
g) malaka va ko'nikmalami shakllantirish uchun mobil muhit (mobil o‘yin va 
simulyatsiva; mobil trening, mobil guruhli loyiha mobil tadqiqot); 
d) mobil o‘qitishni qo‘llab-quvvatlash muhitida - mobil o ‘qitish jarayonida og‘zaki. 
ko‘rgazmali va amaliy metodlar qo‘llaniladi54.

Og‘zaki metodlar (hikoya, tushuntirish, suhbat, munozara ma’ruza, 
maslahat, kitob bilan ishlash) audio, video, grafikli parchalar, gipermatn, gipermedia, 
media ma’ruza slayd-ma'ruza, tabiiy yoki yozdirilgan tovush, bloglar, forumlar, 
chatlar, video konferensiyalar ko‘rinishida taqdim qilinadi.

Mobil o‘qitishning ko‘rgazmali metodlari media ma’ruza video parcha 
matn, gipermatn, gipermedia interfaol xaritalar, chizmalar, interfaol sxemokurslar, 
interfaol kompyuter praktikumlari, diagrammalar, interfaol va sensorli doskalar, 
grafik planshetlar orqali amalga oshiriladi.

Amaliy metodlar (mashqlar, laboratoriya va amaliy ishlar, hisoblash 
topshiriqlari) interfaol xaritalar, diagramma, chizma, kompyuter praktikum, interfaol 
testlar, kompyuter trenajyorlari, simulyatorlar, kompyuter o'yinlari. virtual 
ekskursiyalar orqali amalga oshirilishi mumkin.

54 t'Горюнова JI.B. Мобильность как принцип модернизации высшего педагогического образования // Известия 
Южного федерального университета. Педагогические науки. 2013. Ms б. С. 031-036.
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Mobil o'qitishda auditoriya ishining quyidagi shakllari qollaniladi:
- umumiy (individual, juftli, guruhlijamoaviy, yoppasiga);
- ichki (amaliy, aralash, nazorat);
- tashqi (o'yin, yakka va hamkorlikdagi loy ihali faoliyat, mustaqil ish va boshqalar).

Mobil o'qitishda auditoriyadan tashqari ishlar shakllari boiib, forum, chat, 
blog, audio va videokonferentsiya sohalarga oid o'yin, kompyuter ovini, manbalami 
hamkorlikda loyihalash va tahrirlash, o‘quv manbalariga havolalar yaratish va 
saqlash, interfaol taijima, ovoz berish, bilimni kompyuterli nazorat va boshqalar.

Taiimda mobil texnologiyalaming joriy qilinishi talabalaming o ‘quv 
manbalariga erkin bogianish, o'quv binolaridan olislarda taiim  olish, mustaqil 
taiimni rivqjlantirish, imkoniyatlari cheklangan odamlar ta’lim olishi, shaxsiy 
kompyuterga ega boiish talabidan xoli boiish, ananaviy o’quv adabiyotlar 
yetishmovchiligi muammolaridan xoli boiish, o'quv material larining 
foydalanuvchilar (talaba yoki o'quvchilar) orasida simsiz texnologivalardan (WAP, 
GPRS, EDGE. Bluetooth, Wi-Fi) fovdalangan holda osongina va tezkor tarqalishi, 
shuningdek multimediali formatda taqdim qilingan axborot o'quv materialni vaxshi 
o'zlashtirilishi va esda qolishiga o'quv jarayonigaqiziqishni orttiradi.

Savol va topshiriqlar
1. Pochta qutisi nima? Pochta server nima?
2. Mobil aloqa xizmati operatorlari nima?
3. Mobil telefon nima?
4. Cho'ntak shaxsiy kompyuteri nima?

Test savollari
1. Smartfon (smartphone) nima? D) cho‘ntak kompyuteri va telefon, modem va
A) inglizchadan taijima qilinganda "aqlli telefon” boshqa simsiz aloqa vositalarming kommunikatsion 
ma’nosini anglatadi. Funktsionalligi jihatidan imkoniyatlarini o‘zida qamrab olgan mobil qurilma 
cho‘ntak shaxsiy kompyuteriga yaqm boMgan hisoblanadi.
mobil telefon.
B) to‘rt diapazonli multimediyali smartfonlar 5. Pevdjerlar nima?
guruhi. iPhone o ‘zida telefonning asosiy A) f'oydaSanuvc hilar o’rtasida qisqa matnli
vazifalaridan tashqari kommunikator va internet xabarlami almashish uchun zarur qurilma.
planshetlaming asosiy funktsiyalarini ham qamrab B) bu ixdham qurilma bo‘lib, operatsion hzim
olgan o‘matilgan bo'ladi va unda amaliy dasturlami
C) bu maxsus mobil qurilma bo‘lib, shaxsiy o ‘rnatish va ishlash imkonini beradi 
kompyuteming klassik namunasidir. Planshetlar C) mobil aloqada foydalamladigan telefon apparati 
taqatgina ekrandan tashkil topgan bo‘lib, boshqa turi.
qo‘shimcha qurilmalar (sichqoncha, klaviatura) D) tayanch stantsiyalar va bir guiuh abonentlar
virtual ko'rinishda tashkil etilgan. tizimidan iborat bo‘lib, abonentlarning bir-birlari
D) eho‘ntak kompyuteri va telefon, modem va bilan o ‘zaro axborot almashinuvini ta’minlovchi 
boshqa simsiz aloqa vositalarining kommunikatsion texnik vositalar majmuasi. 
imkoniyatlarini o ‘zida qamiab olgan mobil qurilma
hisoblanadi. 6. Cho'ntak shaxsiy kompyuteri nima?

A) bu ixdham qurilma bo‘lib, operatsion tizim
2. iPhone nima? o ‘matiigan bo‘ladi va unda amaliy dasturlami
A) to‘rt diapazonli multimediyali smartfonlar o ‘matish va ishlash imkonini beradi.
guruhi. iPhone o‘zida telefonning asosiy B) foydalanuvchilar o ‘rtasida qisqa matnli
vazifalaridan tashqari kommunikator va internet xabarlami almashish uchun zarur qurilma.
planshetlaming asosiy funktsiyalarini ham qamrab C) mobil aloqada foydalaniladigan telefon apparati
olgan turi.
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R) inglizchadan taijima qilinganda “aqlli telefon" 
m a’nosini anglatadi. Funktsionalligi jihatidan 
cho 'n tak  shaxsiy kompyuteriga yaqin boigan 
m obil telefon.
О  bu maxsus mobil quriima bo lib, shaxsiy 
kom pyutem ing klassik namunasidir. Planshetlar 
faqatgina ekrandan tashkil topgan boiib, boshqa 
qo'sh im cha qurilmalar (sichqoncha, klaviatura) 
virtual ko'rinishda tashkil etilgan.
D) cho'ntak kompyuteri va telefon, modem va 
boshqa simsiz aloqa vositalarimng kommunikatsion 
imkoniyatlarini o ‘zida qamrab olgan mobil quriima 
hisoblanadi.

3. Internet planshet nima?
A) bu maxsus mobil quriima bo‘lib, shaxsiy 
kompyuterning klassik namunasidir. Planshetlar 
faqatgina ekrandan tashkil topgan boiib, boshqa 
qo‘shimcha qurilmalar (sichqoncha klaviatura) 
virtual ko‘rinishda tashkil etilgan.
B) to‘rt diapazonli multimediyali smartfonlar 
guruhi. iPhone o‘zida telefonning asosiy 
vazifalaridan tashqari kommunikator va internet 
planshetlarning asosiy funktsiyalarini ham qamrab 
olgan.
C) inglizchadan tarjima qilinganda “aqlli telefon” 
ma’nosini anglatadi. Funktsionalligi jihatidan 
cho‘ntak shaxsiy kompyuteriga yaqin bo'igan 
mobil telefon.
D) cho‘ntak kompyuteri va telefon, modem va 
boshqa simsiz aloqa vositalarining kommunikatsion 
imkoniyatlarini o ‘zida qamrab olgan mobil quriima 
hisoblanadi.

4. Kommunikator nima?
A) bu maxsus mobil quriima bo‘lib, shaxsiy 
kompyuteming klassik namunasidir. Planshetlar 
faqatgina ekrandan tashkil topgan boiib, boshqa 
qo‘shimcha qurilmalar (sichqoncha, klaviatura) 
virtual ko*rinishda tashkil etilgan.
B) to‘rt diapazonli multimediyali smartfonlar 
guruhi. iPhone o‘zida telefonning asosiy 
vazifalaridan tashqari kommunikator va internet 
planshetlarning asosiy funktsiyalarini ham qamrab 
olgan.
C) inglizchadan taijima qilinganda “aqlli telefon” 
ma’nosini anglatadi. Funktsionalligi jihatidan 
cho'ntak shaxsiy kompyuteriga yaqin boigan 
mobil telefon.

Dj tayanch stantsiyalar va bir gumh abonentlar 
tizimidan iborat bo‘lib. abonentlarning bir-birlari 
bilan o'zaro axborot almashinuvini ta’minlovchi 
texnik vositalar majmuasi.

7 . Mobil telefon nima?
A) bu ixcham quriima bo‘lib, operatsion tizim 
o'matilgan boMadi va unda amaliy dasturlami 
o‘rnatish va ishlash imkonini beradi.
B) foydalanuvcliilar o‘rtasida qisqa matnli 
xabarlarni almashish uchun zarur quriima.
C) mobil aloqada foydalaniladigan telefon apparati 
turi
D) tayanch stantsiyalar va bir guruh abonentlar 
tizimidan iborat bo‘lib, abonentlaming bir-birlari 
bilan o‘zaro axborot almashinuvini ta’minlovchi 
texnik vositalar majmuasi.

8. Mobil aloqa muhiti nima?
A) tayanch stantsiyalar va bir guruh abonentlar 
tizimidan iborat boiib, abonentlarning bir-birlari 
bilan o‘zaro axborot almashinuvini ta’minlovchi 
texnik vositalar majmuasi.
B) bu ixcham quriima boiib, operatsion tizim 
o’matilgan boiadi va unda amaliy dasturlami 
oinatish va ishlash imkonini beradi.
C) foydalanuvchilar oilasida qisqa matnli 
xabarlami almashish uchun zarur quriima.
D) mobil aloqada foydalaniladigan telefon apparati 
turi.

9. Mobil Internet nima?
A) harakatdagi abonentlar uchun mobil aloqa 
tarmoqlari orqali Internet resurslaridan foydalanish 
texnologiyasi.
B) internet resurslaridan foydalangan holda 
abonentning mobil telefoni orqali shaxsiy elektron 
pochta xizmatidan foydalanish imkoniyati.
C) kichik qamrov doirasiga ega boigan simsiz 
aloqa texnologiyasi.
D) qisqa xabarlar xizmati.

10. Mobil pochta nima?
A) internet resurslaridan foydalangan holda 
abonentning mobil telefoni orqali shaxsiy elektron 
pochta xizmatidan foydalanish imkoniyati.
B) harakatdagi abonentlar uchun mobil aloqa 
tarmoqlari orqali Internet resurslaridan foydalanish 
texnologiyasi.
C) kichik qamrov doirasiga ega boigan simsiz 
aloqa texnologiyasi.
D) qisqa xabarlar xizmati.
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VII BOB. WEB-DIZAYN ASOSLARI

30-§. Web -  sahifa yaratish texnologiyalari

Tayanch tushunchalar: HTML, dastur lash til lari, vizual loyihalash dastur lari, 
murakkab web-sahifalarni yaratish uchun maxsus dasturlar, teg, atribut, qiymat.

Web-saytlar yaratuvchi dasturlar quyidagi guruhlarga ajratish mumkin:
1. Matn muharrirlarida (Bloknot, Word PAD. Microsoft Word) gipermatnlami 
belgilash tili kodlarini kiritish orqali;
2. Dasturlash tillari orqali (PHP, Java Script, Perl, ASP va boshqalar);
2. Vizual loyihalash dasturlari (Microsoft FrontPage, HoTMetal Pro);
3. Murakkab web-sahifalarni yaratish uchun maxsus dasturlar (HomeSite, 
Dreamweaver va boshqalar);

HTML tiliga dastlab 1989 yil Jenevada Tim Bemers-Li tomonidan asos 
solingan. Uning:

1.2 versiyasi 1993 yil iyunda;
2.0 versiyasi 1994 yilning yozida;
3.0 versiyasi 1995 yilda ishlab chiqilgan;
4.0 versiyasi 1997 yilda ishlab chiqilgan;
5.0 versiyasi 2014 yilda ishlab chiqilgan.
Bizga ma’lumki, har qanday murakkablikdagi web-saytlar HTML tiliga 

asoslangan boiib, bu tilni bilmasdan turib toiaqonli web-saytlar yaratib boimaydi. 
Endi HTML tilining asoslari bilan tanishib chiqamiz.

HTML (Hyper Text Markup Language) - giper matnlami belgilash tili degan 
ma noni anglatadi. HTML web-sahifalar uchun dastur yozishning standart tili 
hisoblanadi. HTML, World Wide Web konsortsiumi tomonidan belgilangan 
(aniqlangan) va ko‘p sonli o4zgarishlardan so ng bugungi ko'rinishi ishlab chiqilgan. 
Ayni paytda uning beshinchi HTML5 qayla ishlangan versiyasi keng qoilanilmoqda. 
HTML, matnni, shrift xususiyatlarini, abzatsni formatlash, sahifa maketi, rasmni 
joylashtirish, giperhavolalar va boshqa sahifada uchraydigan ob'yektlami brauzer 
dasturiga qanday aks ettirishni belgilab beradi. HTML teglami qoilaydi. Bu teglar 
brauzerga matn yoki grafikani qanday shakllantirishni yetkazib beruvchi vosita 
hisoblanadi. Masalan, sahifadagi matnlami sarlaA’ha sifatida, ro‘yxat sifatida yoki 
oddiy matn sifatida. Web-sayt yaratuvchilari sahifani HTML-teglari yordamida 
belgilash y o ii  bilan yaratadilar. HTML -  web-sahifada matn, tasvir va boshqa 
maiumotlarni qanday' ko‘rinishdajoylashtirilishini belgilovchi vosita5S.

HTML tili 1989 yilda Jenevada Tim Bemers-Li (Tim Bemers-Lee) tomonidan 
varatilgan. Keyinchalik Tim Bemers-Li «Internet otasi» nomiga sazovor boigan. 
HTML tili dasturlash tili emas, faqat Web-sahifa yaratish uchun moijallangan. Web-

s} Ralph M. Stair. George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology,
Cengage Learning. USA. 2012. 182-p.
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sahifada biror ma'lumotlami qayta ishlash algoritmlarini o ‘matish uchun Java tilida 
tuzilgan dasturlardan foydalaniladi.

HTML tili web-sahifa yaratish uchun standart til hisoblansada. avrim boshqa 
V^eb-standartlar HTML bilan qariyb teng muhimlikni kasb etmoqda. Ularga 
Extensible Markup Language (XML), stillaming kaskadli jadvallari (CSS) va 
Wireless Markup Language (WML)tillarini misol qilib aytish mumkin. Extensible 
Markup Language (XML) tili web-hujjatlar uchun belgilash tili hisoblanib, 
tuzilmalangan axborotdan shu jumladan (so'z va kartinkalardan) tarkib topadi. XML 
tili oldindan belgilangan teglar to‘plamiga ega emas. HTML yordamida masalan. 
<HL> tegi har doim birinchi darajali sarlavhani anglatadi. Mazmun va formatlash 
ham shu HTML hujjatda tarkib topadi. XML web-hujjatlar web-sahifaning tarkibiy 
mazmunidan iborat bo ladi. Tarkibiy mazmunga tegishli formatlashlar sahifaning 
stilida bo'ladi. XML tilida bir nechta o‘ziga xos koisatmalar quyidagi tarzda boiadi. 
<kitob>
<bob> Apparatli vosita <УЬоЬ>
<mavzu> Kiritish qurilmasi </mavzu>
<mavzu> Qayta ishlash va maiumotlarni saqlash qurilmasi </mavzu>
<mavzu> Chiqarish qurilmasi </mavzu>
</kitob>
Stillaming kaskadli jadvali (CSS) o'zida fayl yoki HTML-faylning qismini taqdim 
qilib, u web-sahifada mazmunni visual tarzda taqdim qilishni belgilaydi. CSS 
qoilash shunisi bilan qulayki, sahifa tashqi ko'rinishini har bir HTML tegda emas 
balki bir marta texnik detallami bir marta belgilanadi. Masalan, XML tarkibining 
avvalgi tashqi ko‘rinishi quy idagi stillar jadvalidan tarkib topishi mumkin. Bu stillar 
jadvali asosiy nomi Hardware ekanligini anglatadi va web-sahifada katta Arial shrift 
bilan beriladi. Shuningdek "Apparatli vosita" qalin ko‘k shrift bilan ajraladi. "Kiritish 
qurilmasi" nomi kichik Arial shrift bilan va egilgan qizil matn bilan ifodalanadi.
Bobi: (shrift oichami: 18 pt: rang: ko‘k. shrift: qalin;
Displey: blok; shriftlar: Arial;
Yuqorigi chegara: lOpt; Chap chegara: 5pt)
Mavzu: (shrift oichami: 12pt; rang: qizil; shrift stili: kursiv; displey: 
blok: shriftlari: Arial; 
chap chegara: 12pt)

XML web-kontentni tashkil qilish uchun va maiumotlarni oson topiladigan 
qilish uchun fovdali hisoblanadi. Ko'plab web-savtlar CSSni dizavnni belgilash va 
web-sahifaga bezash kiritish uchun qoilaniladi. Bunda HTML esa kontent (XML) 
bilan dizaynni (CSS) birlashtirish uchun ishlatiladi. 7.1-rasmda web-dizaynga 
modulli yondashuv keltirilgan boiib, vizual dizaynni mazmunga ta'sir etmasdan 
o‘zgartirishga yoki vizual dizaynga ta’sir etmasdan mazmunni o‘zgartirishga imkon 
beradi (7 .1-rasm)56.

56 Ralph M. Stair, George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology,
Cengage Learning USA. 2012. 182-p
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XML fayl 
- kontent

CSS fayl
- S hriftta r 
• Ranglar 
■ Joylashuv

XHTML fayl 
CSS+XML

7.1-rasm. Web-dizaynga modulli yondashuv 
Ushbu ma’lumotlardan foydalanib. ico‘zda tutilgan asosiy maqsad - HTML 

haqida asosiy tushunchalami misollar yordamida tushuntirib berish, HTMLnmg bir- 
oz qiy in bo'lgan elementlari hisoblanmish jadval tuzish, freymlardan foydalanish va 
sahifaga tasvirlami joylashtirish, sahifalami bir-binga faol havolalar orqali bog'lash 
usullarini ko'rsatib berishdan iborat.

Teg tushunchasi. HTML sahifa -  bu oddiy matn fayl bo‘lib, HTML 
kengavtmasiga ega. HTML sahifani yaratish uchun maxsus dastur shart emas. Har 
qanday matn muharriri yordamida HTML sahifa yaratish mumkin. Ana shunday matn 
tahrirlovchi oddiy dasturlardan biri bo'lgan Notepad (Блокнот) standart holatda 
Windows muhitida mavjud. HTML sahifaning asosiy elementlari dan biri bo'lgan 
teglar haqida dastlabki tushunchalar bilan tanishib dhiqamiz.

HTML teg: bu HTML hujjatdagi turli elementlami (matn, tasvir va boshqalar) 
web-sahifada qanday ko'rinishda aks etishi lozimligini brauzerda ko'rsatuvchi 
buy ruqlar. Teglar ma’lum o'lcham va vazifani bajaruvchi buy ruqlardir. Teg quyidagi 
ko'rinishda bo'ladi:
<TEG> hujjat elementi </TEG>

Ko'rib turganingizdek teglar < > uch burchaksimon qo'shtimoq (burchak qavs) 
ichiga olib yoziladi. Uchburchaksimon qo'shtimoq ichiga Teg nomi va uning 
o'lchamlari yoziladi.

Siz varatgan ilk HTML sahifa asosida HTML hujjat asosiy strukturasini tahlil 
qilamiz. Kompyuter xotirasiga saqlangan HTML hujjatni Notepad yordamida oching. 
Har qanday HTML hujjat ichki qismi quy idagilardan tashkil topgan bo'ladi:
<HTML>
bu teg HTML hujjatni ochish (boshlash) uchun xizmat qiladi va u HTML hujjatning 
birinchi ochuvchi va oxirgi yopuvchi teg hisoblanadi. Boshqacha aytganda web 
sahifaning boshlanish va tugash chegarasini ifodalavdi. Uning yagona vazifasi, 
mazkur hujjatni ochayotgan dasturga bu fayl HTML hujjatlari haqida axborot 
berishdan iborat.
<HEAD>

HEAD tegidan so'ng HTML hujjatning tizimli axborotlari haqida ma’lumot 
beradi. Bizning misolimizdagi yagona tizimli axborot - TITLE tegi hisoblanadi.
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<TITLE>
Bu teg ochuvchi teg <HEAD> va yopuvchi teg </HEAD> orasida voziladi. 

Ochuvchi va yopuvchi TITLE orasida kiritilgan axborot siz yaratayotgan hujjat 
nomini anglatadi. Siz kiritgan nom brauzer dasturi tomonidan va intemetdagi qidiruv 
tizimlari tomonidan ishlatiladi. Biz keltirilgan misolda «Eng sodda ko‘rinishdagi 
HTML sahifa!» matni brauzer dasturi yuqori qismida va'ni sarlavha satrida namoyish 
etiladi.
<BODY>
BODY ochuvchi va yopuvchi teglari orasida yozilganlaming barchasi sizning HTML 
hujjatingizning tanasi hisoblanadi. Agar siz ushbu teg orasiga matn yozsangiz yoki 
tasvir kiritsangiz - bulaming barchasim brauzer ekranda namoyish etadi.

Har qanday HTML hujjat quyida keltirilgan tartibdayozilishi shart:
<HTML> HTML hujjat boshi

<HEAD> Hujjat nomlanishining boshlanishi
<TrrLE>...<TITLE> HTML sahifa nomi (sarlavhasi)
</HEAD> Hujjat nomlanishining yakunlanishi
<BODY BGCOLOR-4vhite”> Hujjat tanasining boshlanishi

</BODY> Hujjat tanasining yakunlanishi 
</HTML> HTML hujjat vakuni

HTML sahifaga tasvir joylashtirish. Internet bilan ishlovchi dasturlar tasvirlami 
(grafik elementlami) ochish imkoniga ega bo‘lishi bilan intemetda mavjud 
sahifalaming deyarli barchasi tasvirli axborotlami nashr eta boshladi. Siz yaratgan 
web-sahifa qiziqarli va chiroyli dizayn asosiga qurilgan bo'lsa uning o‘quvchiIari 
soni shubhasiz ortadi. Tasvirlar yordamida harakatlanuvchi tugmalar va Gif 
animatsiyalami kiritish mumkin. Biroq tasvirlar bilan ishlashda ularni hajmi va 
formatiga e tibor berish kerak. Hozirgi paytda intemetga joylashtirilayotgan deyarli 
barcha sahifalarda ishlatilayotgan tasvirlar formati *.JPEG yoki *.GIFni tashkil etadi. 
Bunga asosiy sabab, bu formatdagi tasvirlar hajmi juda kichik. Bu formatdagi 
tasvirlar ishlatilganda web-sahifa hajmi ortib ketmaydi v a sizning web-sahifangizdan 
foydalanuvchi sahifani intemetda ochilishini uzoq vaqt kutmaydi.

Agar siz boshqa formatdagi tasvirlardan web-sahifani bezashda foydalansangiz 
uning hajmi ortib ketadi va undan foydalanuvchilarga sahifani ochishda muammolar 
keltirib chiqaradi. Web-sahifani bezatishda uning dizayniga ’".GIF formatdagi 
tasvirlardan foydalaning. Boshqa maqsadlarda * JPEG dan fovdalanishingiz mumkin. 

<img> tegini qoilash qoidalari 
<IMG> tegi bilan bog‘liq boigan, quyida keltirilgan asosiy qoidalar bilan 

tanishib chiqing va o‘z sahifangizni yaratishda ushbu qoidalarga doim rioya qilishga 
harakat qiling.
• Tasvir nomi va joylashgan o‘rnini yozganda harflarning bir hilda bo'lishini 
ta’minlash katta ahamiyatga ega. Tasvir joylashgan papka nomi va tasviming 
nomini kiritganda harflami bir xilda yozilishi shart. Biror-bir harfni tushirib qoldirish 
yoki xato yozilishi tasvimi ochishda xatoliklami keltirib chiqaradi.
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■ Tasvir yoki papka nomini kiritganda probel ishlatmang. Web-sahifani 
yaratayotganingizda fayllar yoki papkalar nomini kiritganda probel (bo'sh joy) 
ishlatmang. Agar siz kiritgan nom ikki yoki undan ortiq so'zlardan iborat bo‘lsa, 
probel o'mida (pastgi chiziqcha) ishlatishingiz mumkin. Masalan, 
.. ./Chet_elga_sayohat/Ispaniy a/Malaga_ 01 .jpeg
• Intemetda ishlatiluvchi tasvir formatlari. Hozirgi paytda intemetda ikki xil 
formatdagi tasvirlar keng qo'llanilib kelinmoqda Bu formatlar: GIF (bu formatdagi 
tasvirlar *.gif kengaytmasiga ega) hamda JPEG (bu formatdagi tasvirlar esa * jpg 
yoki "'.jpeg qasqartmasiga ega). Siz ham ushbu formatdagi tasvirlardan fovdalaning. 
Boshqa formatdagi tasvirlami aksariyat brauzerlar ocha olmaydi.
• Har doim WIDTH va HEIGHT oMchamlarini kiritishga harakat qiling. Bu 
sizning web-sahifangizni ochilishini tezlashtiradi va tasvirlami asl o'lchamda 
bo'lishini ta minlaydi.
• Tasvir hajmini sun’iy kichraytirish. WIDTH va HEIGHT orqali tasviming real 
o‘lchamlarini kichraytirish mumkin. Ammo bu usuldan iloji boricha kamroq 
foydalanish kerak. Masalan,
<IMG S R C -’ 1 jpg” WIDTH=”400” HEIGHT=”320‘ BORDER=”2”>

HTMLda teglami ishlatish shartlari. Siz HTMLda teg tushunchasi haqida 
qisqacha tushunchaga ega bo'lgansiz. HTML teglami ishlatganda ulami to‘g ‘ri 
yozish muhim ahamiyatga ega. Quy ida tegiami to'g'ri yozish va ishlatish shartlari 
haqida so‘z yuritamiz. Bu borada quyidagi qoidalar mavjud:

• Barcha teglar uch burchakli qo'shtimoq ichida yoziladi '<TEG>'.
Ochuvchi teg - uchburchakli burchakli qo'shtimoq, teg nomi va uning

qo'shimcha o‘lchamlari (zarur bo'lgan taqdirda). Yopuvchi teg - uchburchakli 
qo'shtimoq, V belgisi va teg nomi.

• Probel orqali yoziluvchi teglar o‘Ichanilari.
Teg nomidan so'ng uning qo'shimcha o'lchamlari bo'lishi mumkin. Barcha 

o'lchamlar probel orqali ajratib yoziladi. Bitta harf hajmidagi bo'sh joy qoldirilish 
HTMLda probelni anglatadi.

<TEG 1 - o'lcham = yuklatilgan vazifa 2 - o'lcham = yuklatilgan vazifa...>
• Qo‘shtirnoq ichida yoziluvchi yuklatilgan vazifalar ma’nosi.
Ma lum vazifani bajaruvchi buyruqlar tenglik belgisidan so'ng qo'shtimoq 

ichida yoziladi. Agar probel ishlatilmagan taqdirda qo'shtimoqni tushirib qoldirish 
mumkin. <FONT SIZE=2 FACE-'Times Roman"> Har hil xatoliklar kelib chiqishini 
oldini olish uchun qo'shtimoqlami ishlatish maqsadga muvofiq.

• Aksariyat teglar yakunlash buyrug'ini talab qiladi.
Agar siz tegni yopmagan taqdiringizda aksariyat hollarda xatolik kelib 

chiqmaydi. Ammo ochilgan teg o'lchamlari butun hujjatga ta'sir qiladi. Jadval ichida 
yopilmagan taqdirda bu xatolikni keltirib chiqarishi mumkin. Bu haqda jadvallar 
tuzish bo'limida so'z yuritamiz.

• Teglarni yopish qoidasi
Har doim teglami qat iy tartibda rioya qilgan holda yoping. Birinchi navbatda 

eng oxiri ochilgan teg yopiladi va shu tariqa navbati bo'yicha barchasi yopiladi. 
<TEG1> <TEG2> <TEG3> ... </TEG3> <^TEG2> </TEGl>
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• Teg harflar yozish shartlari.
HTML hujjatda teglami katta yoki kichik harflar bilan yozilishi hech qanday 

ahamiyatga ega emas. Hamma teglami katta yoki kichik harflar bilan yozishingiz 
mumkin. Hattoki mana bunday <tegx/T eg>  Sizga maslahatimiz: barcha teglami bir 
xil shaklda yozgan ma’qul.

• Teg oichamlarini yozish tartibi qanday boiishi ahamiyatsiz.
Teg tarkibidagi oichamlar qanday tartibda yozishingiz hech qanday 

o‘zgarishlarga sabab boimay di. Quy idagi ikki variant ham toig ‘ri:
<TEG 1-oicham = yuklatilgan vazifa. 2 -  o‘lcham = yuklatilgan vazifa. 3 -  

oicham = yuklatilgan vazifa >
<TEG 3 -  oicham = yuklatilgan vazifa. 1 -  o'lcham = yuklatilgan vazifa. 2 -  

oicham = yuklatilgan vazifa>
Eslatma: har qanday HTML sahifa fayl nonti.HTML yoki fayl nomi.htm 

kengaytmasiga ega boiadi. Faylni kompyuter xotirasiga saqlagach, uni brauzer 
dasturlari yordamida ochishingiz mumkin. Brauzer dasturlari internet ishlashini 
ta'minlovchi maxsus dasturlar hisoblanadi. Gipermatnni o‘qish, web-resurslarda 
navigatsiyalash va ko rib chiqish dasturi. Web-brauzeri gipermatnlami o'qishdan 
tashqari, to\nshni va video maiumotlarni qaytadan chiqarish, ya'ni, gipermediani 
qayla chiqarish, tarmoqning boshqa kompyuterlari bilan ulanishni o‘rnatish va ularda 
ishlavotgan serverlarga web-hujjatlarga so‘rovlami yuborish, tarmoqning boshqa 
foydalanuvchilari bilan muloqot tashkil qilish va uni quvvatlash kabi qo'shimcha 
imkonivatlarga ega boiishi mumkin. Eng ommaviy tarqalgan web-brauzerlarga misol 
qilib Internet Explorer, Opera, Avant Brauzer, Mozilla kabi dasturlami avtishimiz 
mumkin

Bizga maiumki yaratilgan web sahifalami ishlatib koiishda o'zimiz bilgan 
yoki bilmagan holda brauzer dasturiga murojaat qilamiz. Ana shu paytda yaratilgan 
web-sahifani ochish uchun uning fayli ustida sichqonchaning chap tugmasini ikki 
marta ketma-ket bosish yetarli. Bundan tashqari avval brauzer dasturini (Internet 
Explorer) ishga tushirib olib, keyin esa File > Open buyrugini berish orqali ham 
faylni ishga tushirish mumkin. Hammamizga maiumki, web sahifani yaratish vaqtida 
uning qanday dizavnda chiqay otganini ko‘rish uchun biz brauzer dasturlariga qayta -  
qayla murojaat qilamiz. Ayrim professional dasturlarda (Dreamweaver va boshqalar) 
natijani ko‘rish uchun to‘g kridan-to‘g ‘ri maxsus tugma bosiladi. Bunda to‘g ‘ridan- 
to‘g‘ri belgilangan brauzerda sahifa yuklanadi.

Giperhavola -  web-hujjatlami bir-biriga bogiash. Web-sahifaga tasvir 
joylashtirishni o'zlashtirib olganingizdan so‘ng, endigi navbatda havolalar haqida 
tushuncha olishning ayni mavrudi. Havolalar tufayli internet hozirgi mavqeiga 
erishdi. Havolalar yordamida ikki va undan ortiq (cheksiz) web-sahifalarni bir-biriga 
bogiashingiz mumkin. Havola rus tilida «ссылка» deb ataladi. Havolaga bosish 
orqali siz ikkinchi sahifani ochishingiz mumkin. Havolalar yordamida web-sahifangiz 
uchun menyu tuzishingiz mumkin. Havolalar sizning web sahifangizdan 
foydalanuvchini sahifa bo ylab tom ma'noda sayohat qilishi imkonini beradi va unga 
to'g‘ri yo‘lni ko‘rsatib turadi.
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Havola - bu HTML hujjatning boshqa HTML hujjat bilan bog lovchi qismj! 
Unga kursomi bosishingiz bilan ikkinchi HTML hujjat ekranda namoyon boiadi 
Shuningdek, havoladan (agar siz yaratgan bir sahifada juda ham ko‘p matn kiritilgajj 
boisa) bitta sahifa ichida boshqa HTML hujjatni ochmasdan turib ham foydalanish 
mumkin. Sizga maslahatimiz, agar bitta sahifaga joylashtirmoqchi boigan matn juda 
ham koLp boisa, uni iloji boricha turli boiaklarga boigan holda bir nechta HTML 
faylga joylashtiring. Shunday qilsangiz, web sahifadan foydalanish oson kechadi.

Navbatdagi sahifalar bilan tanishib chiqqach siz havolalarni ishlatish usullarini 
va havola tuzish uchun qanday HTML teglardan foydalanish zarurligini bilib olasiz.

Havolalarni ta’sir doirasi va ulami qavsi sahafa bilan bogiash vazifasini <A> 
ochuvchi hamda <JA> yopuvchi teglari orasida belgilanadi. Ushbu teglar orasida 
uning oichamlari va kalit so‘z joylashtiriladi.

Ushbu iteg orasida nimalami joylashtirish mumkin? Deyarli hamma narsani. Bu 
matn, tasvir, jadval va hatto harakatlanuvchi tasvir ham boiishi mumkin. Masalan,

<A HREF-'pictures.html">Bu sahifada mening hayotim bilan bogiiq tasvirlar 
joylashgan.</A>

Natija mana bunday ko'rinishda boiadi:
Bu sahifada mening havotim bilan bogiiq tasvirlar joylashgan.

Bu sahifada mening havotim bilan bogiiq tasvirlar iovlashgan. so'zini 
bosishingiz bilan pictures.html sahifasi ekranda namoyon boiadi. <A> tegining 
qo‘shimcha oichami boigan HREF sizni pictures.html sahifasiga olib boradi.

Tasvirlami havola sifatida namoyon etish uchun <A> va </A> teglari orasida 
<IMG> tegi yordamida tasvir nimani qo'yish va u joylashgan papkaga yoin i 
ko'rsating.
<A HREF="pictures.html"> <IMG SRC-'img/photojpg" W IDTH -'100" 
HEIGHT-'100" A L T -‘Mening foto galereyam"> </A>

Havolalar - <A> tegining qo‘shimcha buyruqlari tasnifi 
Boshqa HTML teglari kabi <A> tegining ham qo‘shimcha buyruqlari mavjud. 

Quyida ushbu buyruqlaming tasnifi keltirilgan.
HREF. Bu buyruq yordamida havola qilinishi lozim boigan HTML hujjat 

nomi va uning joylashgan joyi belgilanadi. Bu buyruq <IMG> tegining SRC buyrugi 
kabi bir xil vazifani bajaradi. <IMG> tegining SRC buyrugi yordamida tasvir nomi 
va u joylashgan papkaga y o i  koisatilsa, HREF yordamida HTML hujjat nomi va u 
joylashgan papkaga y o i  tasvirlanadi.

TARGET. Bu buyruq HTML hujjatni aynan o‘sha oynada yoki alohida oynada 
yoki qaysi freymda ochilishini belgilaydi. TARGET buvrugining qo‘shimcha 
oichamlari:
_blank -  brauzerda siz ishlab turgan oynadan tashqari yangi oynada havolada 
ko‘rsatilgan hujjatni ochish.
_top - web sahifada freymlar ishlatilgan boisa, havolada ko‘rsatilgan hujjatni faol 
oynada freymlar strukturasini buzgan holda ochadi. Ochilgan oynada freym 
alomatlari mavjud boimaydi (freymlar haqida batafsil maiumotni «Freymlar bilan 
ishlash boiim im i o'qishingiz mumkin).
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rent .  havolada ko'rsatilgan hujjatni avval ochilgan oynada ochiladi. 
s e l f  -  havola qaysi freym yoki freymdan holi sahifada ishlatilgan bo‘lsa aynan o‘sha 

sahifada ochadi.
cA HREF="pictures.html" TARGET=”_blank">Bu sahifada</A> mening 

havotim bilan bog‘liq tasvirlar joylashgan. <BR> Bu sahifada siz <A 
H^EF="about.html" TARGET-’_top"> men haqimda </A> qiziqarli ma’lumotlami 
o‘qishingiz mumkin.

Natija mana bunday ko'rinishda bo'ladi:
Rn sahifada mening havotim bilan bog'liq tasvirlar joylashgan. Sahifada siz 

mpn haaimda qiziqarli ma’lumotlami o‘qishingiz mumkin. Ushbu havolalardan biriga 
bosib. siz havolada belgilangan HTML hujjatdagi ma’lumotlami o‘qishingiz 
mumkin.

Havolalar yordamida nafaqat boshqa HTML hujjatni ochish, balki mavjud bir 
hujjat ichida ham ichki havolalami qo'llash mumkin. Agar siz varatayotgan 
sahifadagi matn haddan tashqari ko‘p bo4sa va uni mavzu bo‘yicha bo‘lishi imkoni 
mavjud bo‘lmagan taqdirda siz sahifa ichiga ma lum kalit so‘zlardan foydalanib 
havolalar menyusini yaratishingiz mumkin. Bunday ichki havolalar menyusi 
sahifadagi matnni o'qish jarayonini tezlashtiradi va o‘quvchi o‘zi uchun kerakli 
ma’lumotni butun matn ichidan topib olishi oson kechadi.

Ichki havola <A> tegining NAME buyrugl yordamida amalga oshiriladi.
NAME. <A> tegi tarkibida yoziladi va HTML hujjatdagi matn tarkibidagi 

ma’lum kalit so‘zga bogManadi.
HTML hujjatning biror-bir joyiga havola qilish uchun havola qilinayotgan 

nuqtani <A> tegining NAME buvrug'i yordamida belgilab olish zarur. Masalan. 
sahifa vakunidan uning boshiga qaytish uchun HTML hujjat boshlanishida quy idagi 
kodni yozamiz:

<A NAME="Top of Page"x/A>
So‘ngra sahifa yakunida matn vakun topgan joy dan so‘ng mana bu kodni 

teramiz:
<A HREF="#Top of Page">Yuqoriga qaytish</A>

Agar siz sahifani brauzerda ochib «Yuqoriga qaytish» havolasi ustida kursomi 
bossangiz, brauzer yana matn boshiga «#Top of Page» nuqtasiga qaytadi. "#Top of 
Page" havola murojaat qilayotgan nuqta nomi. Teg kodlarini terishda xatolikka yo‘l 
qo‘vsangiz, bu katta xatolik emas. Faqatgina havola ishlamaydi xolos.

Shuningdek, ichki havolani boshqa HTML favldagi matnning biror bir 
nuqtasiga ham bog lash mumkin. Aytaylik sayohat.HTML Frantsiva bo‘limiga 
murojaat qilish lozim. Buning uchun quyidagi usuldagi kod yoziladi:

<A HREF="savohat.html#Frantsiya"> Frantsiyaga savohat </A>
Yuqoridagi misoldan ko‘rinib turganidek, avval HTML hujjat nomi (agar u 

boshqa papkada joylashgan bo‘lsa, u holda fay lga bo‘lgan yo‘l. papka nomi) kiritiladi 
va # simvolidan so'ng havola murojaat qilayotgan nuqta nomi yoziladi.

Navbatdagi misolda HTML teglar qanday vozilganiga e’tibor bering:
<HTML>
<HEAD>
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<TITLE>Evropa bo'ylab savohat </TITLE>
</HEAD>
<BODY>
<P ALIGN="center"> <B>Evropa davlatlari bo‘ylab sayohatdan olgan 
taassurotlan m<VBx/P>
<ANAM E-'Top of Page"x/A>
< P x A  HREF- 1 # Germany'' xB>Germ anivа<УВх/A x /P  >
< P x A  H REF="#Italy"xB>Italiya</Bx/Ax/P>
< P x A  HREF-'#French"xB>Frantsiya</B></A></P>
<P>Kirish</P>
Matn Matn Matn Matn Matn Matn Matn Matn Matn Matn<BR>
Matn Matn Matn Matn Matn Matn Matn Matn Matn Matn<BR>
<PxBxANAM E-''Germany">Germaniya</A> </B> </P>
<P>Matn Matn Matn Matn Matn Matn Matn Matn Matn Matn</P>
<P>Matn Matn Matn Matn Matn Matn Matn Matn Matn Matn</P>
< P x A  HREF-'#ToP of Page">Yuqoriga</Ax/P> 
<PxANAM E="Italy"xB>Italiya</Bx/A></P>
<P>Matn Matn Matn Matn Matn Matn Matn Matn Matn Matn</P>
<P>Matn Matn Matn Matn Matn Matn Matn Matn Matn Matn</P>
< P x A  HREF="#Top of Page">Yuqoriga</Ax/P>
< P x A  NAM E="French"xB>Frantsiya</Bx/Ax/P>
<P>Matn Matn Matn Matn Matn Matn Matn Matn Matn Matn</P>
<P>Matn Matn Matn Matn Matn Matn Matn Matn Matn Matn</P>
< P x A  HREF="#Top of Page">Yuqoriga</Ax/P>
<7BODY>
<7HTML>

Havolalaming qo'shimcha imkoniyatlari. Havolalami nafaqat HTML fayl 
yoki hujjat ichidagi kalit so‘zga. balki FTP serverlarda saqlanayotgan fayllar va E- 
mail (elektron pochta)ga ham o‘matish imkoniy ati mavjud.

FTP havolalar. FTP serverlarda saqlanadigan fayllami yuklash uchun, FTP 
havolalar tuziladi. FTP serverlarda turli fayllar yoki dasturlar internet orqali yuklash 
uchun saqlanadi. Aytaylik siz o‘z sahifangizda biror - bir qiziqarli dastur, tasvir yoki 
musiqa haqida ma lumot vozdingiz va uni yukiab olish uchun fayl saqlanayotgan 
FTP server manzilini havolada ko‘rsatmoqchisiz. U holda fayl joylashgan FTP 
serverga havola quyidagi tarzda ifodalanadi:
<A HREF="f1tp://ftpsitename.com/programs/program.exe"> Faylni yuklash</A>

Faylni yuklash. Faylni yuklash so‘zi ostida kursorni bosish bilan, brauzer 
dastumi foydalanuvchi kompyuteriga saqlash yoki ochish haqidagi axborotni 
chiqaradi.

E-MAIL havola. E-mail (Elektron pochta) manzillami faollashtirish uchun 
havola tuzish mumkin. E-mail manzil ko'rsatilgan havolani bosish bilan kompyaiterga 
o'matilgan elektron pochtalar bilan ishlovchi dastur faollashadi va unda havolada 
ko'rsatilgan elektron pochta manzili ko'rsatilgan yangi oyna hosil bo'ladi va siz 
ko'rsatilgan manzilga xat jo'natishingiz mumkin.
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E-mail manzilni havola sifatida belgilash uchun HREF buyrug i o'mida 
mailto: elektron pochta manzili yoziladi. Misol uchun:
Mening <A HREF-'mailto: tsamar@mail.ru’1> elektron pochtamga</A> ushbu 
darslik haqidagi fikr - mulohazalaringizni yozing!

Natija mana bunday ko'rinishda bo'ladi:
Mening elektron pochtamga ushbu darslik haqidagi fikr- mulohazalaringizni 

yozing!
Havolalar yozishning asosiy qoidalari. Quyida havola tuzishda bilishingiz 

lozim boigan oddiy qoidalar yozilgan. Ulami diqqat bilan o‘qib chiqing va eslab 
qolishga harakat qiling. Havola tuzishda bu qoidalarga amal qilsangiz, siz tuzgan 
havolalar xatoliklarsiz ishlaydi.
• Harflarning bir xilda yozish va fayl yoki papka nomini to‘g‘ri ko*rsating.
Havola tuzilganda eng katta e ’tibomi siz murojaat qilmoqchi boigan faylga olib 
boruvchi y o i  aniq va to'g ri ko'rsatilishi lozim. Bunda papka va fayl nomiga katta 
e’tibor qarating. Ulaming nomida arzimagan xatolikka y o i  qo‘ysangiz havola 
ishlamaydi. Aytaylik biror-bir harfni tushib qolishi yoki bosh harf o‘miga kichik harf 
bilan yozilsa xatolik yuz berishi muqarrar. Shu bois, havola tuzishda aniqlik katta 
ahamiyatga ega
• Fayl va papka nomini kiritganda probel ishlatmang. Web sahifa yaratish 
jarayonida fayl va papkalami nomi ikki va undan ortiq so'zdan iborat boisa so'zlar 
orasida va oxirida probel ishlatmang. Probel ishlatilgan fayl yoki papkaga havola 
murojaat qilganda xatolik sodir boiadi.
• Kalit so‘zlarga havola tuzish. Biror hujjat ichidagi kalit so*zga havola tuzganda 
eng avvalo kalit so'zni <A> tegining NAME buyrugi yordamida belgilab olish 
lozim So'ngra shu tegning HREF buyrugi orqali u joylashgan fayl nomi (agar kalit 
so'z boshqa favlda joy lashgan boisa) va kalit so‘z manzilini ko'rsating HREF=«fayI 
nomi.HTML# kalit solz».
• FTP server va E-MAIL uchun maxsus havola FTP serverda joylashgan faylga 
havola tuzganda ’FTP://’ bilan boshlanuvchi manzilni yozing. E-MAIL havola 
tuzganda esa "mailto: e-mail manzifni yozing.

Matn tahrirlash o‘zlashtinb olishingizni osonlashtirish uchun uni ikkiga boiib  
tushuntirishni lozim topdik. Ulaming har biri matn tahrirlashda ishlatiladigan HTML 
teglami batafsil tahlili misollar yordamida aks ettirilgan.

• Matnning alohida boiaklarini tahrirlovchi teglar;
• Matnning yirik boiaklarini tahrirlovchi teglar;
Matnning alohida boiaklarini tahrirlovchi teglar. Quyida tasnifi keltirilgan 

barcha matn tahrirlash uchun ishlatuvchi teglar ochilgandan so'ng ulami yopish shart. 
Ochilgan tegning ta'sir doirasi u yopilgunga qadar davom etadi. Agar siz tegni 
vopishni unutsangiz, uning ta sir doirasi hujjat oxirigacha davom etadi. Barcha 
teglash quyidagi tartibda yoziladi: <TEG lxTE G 2> Kerakli matn 
</TEG2x7TEGl>. Har doim eng oxiri ochilgan tegni birinchi boiib vopishni 
unutmang.
<B> Kerakli matn </B>
Bu teg orasida yozilgan matn qalin harflar bilan belgilanadi.
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<1 >Kerakli »iatn<J I>
Matn o‘ng tomonga egiltirib yoziladi.
<BIG>Kerakli matn</BIG>
Matnni kattalashtirish. Yozilgan matn boshqalariga nisbatan kattalashtirilgan harflar 
bilan belgilanadi.
<SMALL>KerakIi matn</SMALL>
Matnni kichraytirish. Yozilgan matn boshqalariga nisbatan kichiklashtirilgan holda 
belgilanadi.
<S T RIKE > Kerak 1 i matn</STRIKE>
Teg orasida yozilgan matn ustidan chiziq tortiladi.
<STRONG>KerakIi matn</STRONG>

Matn ichidagi ayrim so'zlami kuchli zyratib ko'rsatish uchun ishlatiladi.
Kerakli <SUB>nutn</SUB>

Ko‘rinib turganidek bu teg orasida kiritilgan matn, matn chizig‘idan pastda 
kichik harflar bilan yoziladi (indeks).
Kerakli <SUP>nu,n</SUP>

Yuqorida keltirilgan tegning teskari shakldagisi boiib, u matnni yuqorida 
kichik harflar bilan vozilishini ta’minlaydi (daraja).
<U>Kerakli matn</U>

Yozilgan matn ostida chiziq tortiladi. Bu teg yordamida ayrim so‘zlami 
belgilab ko‘rsatish mumkin.
<CENTER>

Kerakli matn
</CENTER>

Bu teg kiritilgan matnni sahifa o‘rtasida boiishini ta'minlaydi. Agar bu teg 
jadval ichida qoilansa, u holda bu jadval katakchasi ichidagi matnga ta’sir etadi. Bu 
tegni jadval ichida qoilash usullari haqida jadvallar bilan ishlash boiimida 
tushuntirib o‘tamiz.
<BR>

Bu teg matn qatorlarini surish uchun xizmat qiladi. Ma lum jumladan so'ng 
ikkinchi jumlani yangi qatordan boshlamoqchi bo lsangiz, jumla so‘ngida ushbu 
tegni yozing.

Endi hech boimaganda bitta qolshimcha buyruqqa ega boblgan teglar bilan 
tanishib chiqamiz.
<FONT>Kerakli matn</FONT>

Bu teg harfning qo shimcha o‘lchamlarini belgilash uchun ishlatiladi. Quyida 
ushbu tegning eng ko‘p qo‘llaniladigan qo‘shimcha buyruqlari bilan tanishib 
chiqamiz:

SIZE. Harf o‘lchamini belgilashda qo‘llaniladi. Matndagi harflar oichamini 1 
dan boshlab xohlagan son bilan belgilash mumkin.

Masalan. <FONT SIZE=5>Salom!</FONT> Bu mening web sahifam. <FONT 
SIZE=2>(Izoh)<yFONT>

Bundan tashqari siz SIZE oMchamlarini plvus + va minus - bilan ham 
belgilashingiz mumkin. Bu usul qo'llanganda harf oichami ishlatilayotgan harfga
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• hatan katta yoki kichik belgilanadi Misol uchun siz 3 ga teng kattalikdagi harfdan 
f^dalanavotgan bo'lsangiz, SIZE=«+2» harf o'lchami SIZE=«5»ga. SIZE=«-1» 
o°lchami esa SIZE=«2»ga teng bo'ladi.

COLOR- Bu buyruqdan so'ng rang nomi yoki rangni belgilovchi olti xonali 
lotin harflari hamda raqamli kod kiritiladi va shu tariqa harf rangi belgilanadi. Turli 
brauzerlar turli rang nomlarini belgilay oladi. Pastda keltirilgan jadvalda ranglar nomi 
vozilgan Rang nomlari ingliz tilida kiritiladi. Rang nomi va ko rinishini vodlab 
olishingiz uchun ulaming har birini nomi o'sha rangda belgilangan. Bu ranglami 
Netscape Navigator va Internet Explorer navigatorlari muammosiz taniydi va o'qiy
oladi.

Rangni belgilovchi lotin alifbosi va raqamli kod *#’ simvol bilan boshlanadi. 
Raqamlardan 1 dan 9 gacha yoki A dan F gacha bo'lgan lotin harflarini ishlatish 
mumkin. Rang kodi qanday bo'lishi dan qaf iy nazar u RGB (RED -  qizil, GREEN -  
vashil, BLUE -  ko'k) ranglar tizimida aks ettiriladi. Rangni belgilash uchun uchta 
rangni bir-biriga qo'shish lozim. Har bir rang ulushini 0 dan 255 gacha bo'lgan 
miqdorda belgilanadi Misol uchun toza qizil rangni belgilash uchun qizil rang 
miqdorini 255 ga, yashil va ko'k ranglar miqdorini esa 0 ga tenglashtirish lozim va bu 
mana bunday yoziladi <FONT COLOR=#FFOOOO>. Olti xonali alifboli - raqamli 
kodini qo'llash juda ham qiy in. Shu bois bizning rangni kodini belgilab beruvchi 
jffkalimizdan foy dalanishingiz mumkin.

FACE. Matnni qanday shriftda yozilishini belgilash uchun shrift nomi 
keltiriladi. Shrift nomi kompyuterda o'matilgan bo'lishi kerak yoki umumiy 
ishlatiladigan shriftlardan foydalanish mumkin. Agar siz qo'llagan shrift 
foydalanuvchining kompyuterida topilmagan taqdirda brauzer standart shriftni 
tanlaydi. Masalan:
<FONT FACE=«Arial»>Salom!</FONT>
<FONT FACE=«Times New Roman, Arial. Courier New»>Bu mening web 
sahi fam. </FONT>

Siz har doim <FONT> tegining FACE atributini tanlaganingizda, standart 
shrift turlaridan foydalaning. Misol uchun Windows muhitida ishlovchi barcha 
kompyuterda o'matiladigan standart shriftlar quyidagilardan iborat:

Windows: Arial, Arial Black, Arial Narrow, Courier, Courier New, 
Garamond. Helvetica, Times, Times New Roman.

Aytayiik siz Times va Times New Roman shriftining boshqacha turini tanlagan 
bo'lsangiz, u holda foydalanuvchi kompyuterida bu shrift o'matilmagan bo'lsa, 
brauzer siz tanlagan shriftni standart Times New Roman shriftiga almashtiradi.

Matnning yirik boMaklarini tahririovchi teglar. Endi siz bilan matndagi 
yirik bloklar va hoshiyalarni tahririovchi teglar va ulaming qo'shimcha 
buyruqlarining ishlash tartibini o'rganib chiqamiz.

<PLAINTEXT>. Ushbu tegdan so'ng kiritilgan barcha HTML teglaming ta’sirini 
butunlay kesadi va ular xuddi ekranda ko'rsatilishi lozim bo'lgan matn kabi aks etadi. 
Bu teg boshqa teglardan tubdan farq qiladi va uni vopish shart emas. Agar matnda 
ayrim HTML teglami ekranda brauzer aks ettirishini xohlasangiz bu tegdan 
foydalanishingiz mumkin. Biroq yuqorida aytganimizdek bu tegdan so'ng matnni
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HTML teglar yordamida tahrirlash mumkin emas. Chunki ulami brauzer xuddi oddi 
mam kabi tushunadi. Agar siz </PLAINTEXT> tegini kiritgan taqdiringizda ham bu 
<PLAINTEXT> ta’sir doirasini cheklay olmaydi. Web sahifangizda HTML teglar ;̂ 
matn shaklida aks ettirmoqchi boisangiz, u holda burchakli qavs '<’ o‘mida &Lt 
simvolini qoilang.
<ADDRESS>
Kerakli matn 
</ADDRESS>

Teg o‘z nomi bilan manzillami belgilash uchun ishlatiladi. Bu teglar orasida 
yozilgan manzilni har qaysi brauzer o ‘zi xohlagan tarzda namovish etadi. Teg 
vopilganidan so n g  kiritilgan matn yangi satrdan boshlanadi.
<BLOCKQUOTE>
Kerakli matn 
</BLOCKQUOTE>

Bu teg matndagi paragraf va satrlami belgilash uchun qo‘llanadi.
<H1>, <H2>, <H3>. <H4>, <H5> va <H6>
vuqoridagi oltita teg sarlavhalami belgilash uchun qoilaniladi. Sarlavhalar qalin 
harflarda voziladi. Bu teglaming bir-biridan farqi ularning oichamlanda. 1 dan 6 
gacha boigan sonlar sarlavha oichamlanm katta-kichikligini quyida keltirilgan 
tartibda belgilaydi:
Sarlavha HI 
Sarlavha H2 
Sarlavha H3 
Sarlavha H4 
Sarlavha H5 
Sarlavha H6 
<P>
Kerakli matn 
<УР>

Bu teg paragraflami belgilaydi. Paragraf boshi va oxirida bo‘sh qator qoldiradi. 
ALIGN. <P> tegining qo'shimcha buyrugi boiib  u papagraf ichida yozilgan matnni 
tekislash uchun ishlatiladi. Bu buyruqning qo'shimcha oichamlari ALIGN -  LEFT 
(matnni chap burchakdan tekislaydi), RIGHT (obng tomonga tekislaydi), CENTER 
(sahifa markaziga tekislaydi) va JUSTIFY (matnni sahifa eni bo‘ylab tekislaydi). 
JUSTIFY ishlatilganda brauzer matnni chap va o‘ng tomon bo‘ylab bir xilda tekislab 
chiqishga harakat qiladi. Bu jarayonda so'zlar orasi cho'zilib ketishi ham mumkin. 
<PRE>
Kerakh matn 
</PRE>

Bu teg yordamida siz matnni qandav kiritgan boisangiz shunday ko‘rinishda 
boiishi ta’minlanadi. Quyida keltirilgan ikki misolda buni yaqqol ko'rish mumkin. 
<PRE> tegidan tashqarida yozilgan matnda probel necha marta ishlatilishidan qat’iy 
nazar u bittaga hisoblanadi. <PRE> tegi tarkibida kiritilgan matn qanday boisa  
shundayligicha ekranda ko‘rinadi.

174



Hujjat asosiy qismini tahrirlash. Bu bo‘limda hujjat tanasini belgilab 
chi <BODY> tegi va uning qo'shimcha buyruqlari haqida so‘z boradi. 

bRODY> tegini oldingi boiimlarda qisqacha tanishtirib o‘tgan edik. Bu teg bevosita 
utM L huijatni ekranda ko‘rinishi lozim bo‘lgan matn. tasvir va boshqa elementlami 

‘ ichiga qamrab oladi. <BODY> ochuvchi hamda </BODY> vopuvchi teglari 
° Z ida barcha muhim elementlar joylashadi. Bu tegning qanday qo'shimcha 
b u v ru q la rin i quyida birgalikda ko'nb chiqamiz.

BGCOLOR. Sahifaning orqa foni rangini belgilash uchun ishlatiladi. Bunda 
—turning ingliz tilidagi nomi yoki harf va sonlardan iborat kod qo‘llaniladi.

BACKGROUND. Sahifaning orqa foni uchun qo‘llaniluvchi tasvir nomi va u 
ivlashgan papkagayo‘lni korsatishda qo llaniladi Tasvirjoylashgan papkagayo‘lni 

k o  rsatish haqidagi ma’lumotlami «HTML sahifaea tasvir iovlashtirish» boiimida
o‘qishingiz mumkin.

TEXT. Higjatda yozilgan matn harflarini qanday rangda boiishini rang 
kodlarini kiritish orqali belgilab beradi. Agar siz ushbu tegni ishlatmagan 
taqdiringizda matn rangi qora rangda bo‘ladi.

LINK Bu buyruq qoilanilgan sahifadagi havola rangi teg oichamlarida qaysi 
rang kodi yoki nomi berilgan bo'lsa, o‘sha rangda ekranda namoyon bo‘ladi.

VLINK. Bu buyruq yordamida ishlatilgan havolalami belgilab ko rsatish 
uchun qo‘llaniladi. Siz foydalanuvchilar adashib ketmasligi va havolada ko‘rsatilgan 
sahifaga qayta kirmasligi hamda hali qo‘llanilmagan havolalami qoMlanilgan 
havolalardan ajratib ko‘rsatish uchun ishlatishingiz mumkin.

ALINK Bu bu>Tuq kursor yordamida tanlangan \ a sichqoncha chap tugmasi 
bosilgan paytda havola rangini o'zgartirish uchun ishlatiladi. Siz hozir o‘qigan 
sahifada <BODY> tegining barcha qo'shimcha buyruqlari quyidagi tartibda 
qo‘llaniladi.
<BODY BGCOLOR = «#003399» TEXT = «black» LINK = «blue» ALINK = «red» 
VLINK = «#006666 »>

Ro‘yxatIar tuzish. Sahifada matndagi avrim elementlami ro‘yxatlangan 
tartibda yozish qiyin emas va bundan tashqari oquvchi matn bilan tanishib chiqishida 
qulayliklar yaratib beradi. Siz xuddi Microsoft Word matn muharririda ro‘vxatlami 
qanday tuzsangiz xuddi shu ko'rinishda HTML hujjatda ham maxsus teglar 
yordamida belgilash imkoniga egasiz. Bu bo‘limda ro^vxatlangan tartibda matnni 
kiritish usullari bilan tanishib chiqamiz:
<RO YXATNI OCHUVCHI TEG>
< Ro'yxat elementining tegi > Matn
< Ro‘yxat elementining tegi > Matn
< Ro‘yxat elementining tegi > Matn 
<J RO‘YXATNI YOPUVCHI TEG >
Tartiblangan ro‘yxat:
1. Ro‘vxat elementi 1
2 . RoSocat elementi 1
3. Ro'yxat elementi 1
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Tartiblanmagan ro'yxat:
• Royxat elementi 1
• Ro‘yxat elementi I
• Ro‘yxat elementi 1

Matn ro'yxatini belgilovchi teglar tarkibida siz HTMLning boshqa matn 
tahrirlash uchun qoilaniluvchi teglarini ishlatishingiz mumkin.

Ro‘yxatlar tuzish -  ro‘yxatni tartiblash. Matn bo'laklarini tartiblashda 
sonlar yoki harflar bilan belgilash mumkin. Shuningdek ayni jarayonda simvollardan 
ham foydalanish imkoni mavjud. Bu haqda kevinroq to‘xtalib o4amiz.

Matn bo‘laklarini tartiblashda <OL> ochuvchi va </OL> vopuvchi teglaridan 
foydalaniladi. Ushbu teglar ichida tartiblanuvchi matn oldiga <LI> buyrug i yoziladi. 
<OL> tegining yagona qo shimcha o lchami TYPE boiib, u tartiblovchi belgi 
ko'nnishini aniqlab beradi.

Arab raqamlari bilan belgilash:
<OL TYPE=1>
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</OL>
Natija:
1. Matn 1
2. Matn 2
3. Matn 3

Rim raqamlari bilan belgilash (bosh):
<OL TYPE=I>
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
<70L>
Natija:

I. Matn 1
II. Matn 2

III. Matn 3
Rim harflari bilan belgilash (ldchik):

<OL TYPE=i>
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
<JOL>
Natija:

i. Matn 1
ii. Matn 2

iii. Matn 3

176



Bosh harfalari bilan belgilash:
<OL TYPE=A>
<LI> Matn 1 
<LI> Matn 2 
cLl> Matn 3 
<JO L>
Natija:
A. Matn 1
B. Matn 2
C. Matn 3

Kichik harflar bilan belgilash:
<OL TYPE=a>
<LI> Matn 1 
<LI> Main 2 
<LI> Matn 3 
</OL>
Natija:
a. Matn 1
b. Matn 2
c. Matn 3

Ro‘yxat tnzish -  tartiblanmagan ro‘yxat. Tartiblanmagan ro yxat tuzishda 
<UL> va </UL> yopuvchi teglaridan foydalaniladi. Ro‘yxat ichidagi tartib <LI> 
buyrug i bilan belgilanadi. <UL> tegi uchun ham TYPE o‘lchami ishlatiladi. TYPE 
oichami 3 xil turdagi ro’yxat kirita oladi:

Doirasimon belgi yordamida tartiblash:
<UL TYPE=circle>
<L1> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>
Natija:
о Matn 1
о Matn 2
о Matn 3

Nuqtasimon belgi yordamida tartiblash:
<UL TYPE=disc>
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>
Natija:
• Matn 1
• Matn 2
• Matn 3
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To‘g‘ri to'rtburchaksimon belgi yordamida tartiblash:
<UL TYPE=square>
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>
Natija:
• Matn 1
■ Matn 2

■ Matn 3
Ro‘yxat tuzish -  aniqlashtiruvchi ro‘yxatlar. Aniqlashtiruvchi ro vxat va 

uning izohidan iborat matnni tartibli tuzish uchun bir-necha teglar ishlatiladi. 
Aniqlashtiruvchi ro‘yxatni <DL> ochuvchi va </DL> yopuvchi tegi yordamida 
amalga oshiriladi. Aniqlashtiruvchi ro‘yxat nomi <DT> tegidan so'ng yoziladi va uni 
izohlovchi matn esa <DD> tegidan solng kiritiladi. <DL> tegi qo‘shimcha 
o‘lchamlarga ega emas.

Aniqlashtiruvchi ro‘yxat:
<DL>
<DT> Aniqlashtiruvchi asosiy so‘z yoki jumla 
<DD> Izoh beruvchi matn
</DL>

Jadval tuzish. Jadval tuzish -  HTML bo‘yicha o‘zlashtirish qiyin bo‘lgan 
bo limlardan biri. Shu bois bu bo'limni jadval tuzishni eng sodda usullaridan 
boshlaymiz. Web sahifani mukammal darajada yairatishni xohlasangiz, unda jadval 
tuzishni chuqur o‘rganib olishingiz kerak. Qisqa qilib aytganda jadvallar yordamida 
sahifani o'zingiz xohlagan tarzda boshqara olishingiz mumkin. Jadval ichiga nafaqat 
matn, balki tasvir va boshqa elementlami tartibli joylashtirish mumkin.

Jadval tuzish -  umumiy qoidalar. Jadval tuzishda ishlatiladigan teglami 
tasniflashdan awal, oddiv jadval tuzish sxemasi bilan tanishib chiqsak. Har qanday 
jadval quy idagi sxema bo'vicha tuziladi:
<JADVALNI OCHUVCHI TEG>
<JADVAL QATORINI OCHUVCHI TEG>
<JADVAL BOLAGINI OCHUVCHI TEG>
Matn, tasvir yoki jadval
</JADVAL BO LAGINI YOPUVCHI TEG>
</JADVAL QATORINI YOPUVCHI TEG>
</JADVALNI YOPUVCHI TEG>

Har qanday jadvalda qatorlar va ustunlar mavjud boMadi. Jadvalning 
bo‘lakchalarida esa axborot kiritilishi mumkin. Yuqorida keltirilgan misoldan 
ko^rinib turibdiki. bitta ustun. bitta qator va bitta katakchadan iborat jadvalni tuzish 
uchun jadval ochiladi va yopiladi. Agar bitta ustundan iborat va bir nechta qatomi o‘z 
ichiga olgan jadvalni tuzish uchun. jadval qatorini ochuvchi va yopuvchi teglar 
orasiga bir nechta jadval katakchalarini ochuv chi va yopuv chi teglarini kiritish lozim.
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Oddiy jadvallar tuzish. JadvaJ tuzish usullarini tushunib olish uchiin dast 
gvval eng oddiy jadvalni tuzishni organamiz. Biz tuzmoqchi boigan jadval uchta 
ustundan iborat boiadi va har bir ustunda 3 dona katakchalar o‘rin oladi. Jadvahiing 
birinchi ustunini «Mahsulot», ikkinchisini esa -  «Rangi», uchinchisini «Narhi» deb 
nomlaymiz. Biz tuzgan jadval mana bunday ko‘rinishda boiadi:

_____________________ ____________________________________________________ 7.1-jadval.
Mahsulot Rangi Narhi (so‘m)

Oalam Qora 100
Qalam ochgich Qora 500

Endi ushbu jadvalni tuzishda qanday HTML teglardan foydalanilganligini 
ko‘rib chiqamiz:
<TABLE>
<TR>
<TD>Mahsulot</TD>
<TD>Rangi</TD>
<TTD>Naihi(so‘m)</TD>
</TR>
<TR>
<TD >Q al am</TD >
<TD>Qora</TD>
<TD>100</TD>
</TR>
<TR>
<TD>Qalam ochgichi</TD>
<TD>Qora</TD>
<TD>500</TD>
</TR>
</TABLE>
Jadvalni ochuvchi teg
1 - qatomi ochuvchi teg
1 - Jadval bo'lagini ochuvchi vayopuvchi teg
2 - Jadval boiagini ochuvchi vayopuvchi teg
3 - Jadval boiagini ochuvchi va yopuvchi teg
1 - qatorni yopuvchi teg
Jadvalni yopuvchi teg

Misolda ko‘rinib turibdiki. jadvalni <TABLE> va </TABLE> teglari 
yordamida ochiladi va yopiladi. Qatorlar uchun <TR> va </TR> teglari qoilaniladi, 
<TD> va </TD> teglari esa jadval ustunlarini (katakchalarini) belgilash uchun 
ishlatiladi.

Jadval chizish. Murakkab jadvallar tuzishni boshlashdan avval <TABLE>, 
<TR> va <TD> teglariga qisqacha tasnif berib o‘tamiz. Mazkur uchta teg bilan 
qo'llaniladigan bir xildagi o‘lchamlar mayjud bo'lib, faqatgina ulaming farqli 
tomoni, ulaming ta'sir doiralarining chegaralanishida.
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BGCOLOR. Tegining yordamida jadvalning orqa fonida qandav rang 
qollanilishi belgilanadi.

BACKGROUND. Jadvaldagi boiakcha foni sifatida berilayotgan tasvimi 
joylashgan joy va uning nomini belgilash uchun ishlatiladi. Agar siz bu o‘lchamni 
<TABLE> tegidan so ng qo‘llasangiz, u holda siz tanlagan tasvir jadvaldagi har bir 
kataklar foni sifatida qoilaniladi. <TR> tegidan so'ng qoilanilganda, mazkur 
qatorda joylashgan hamma katakchalar uchun, <TD> tegidan so ng qoilanilganda 
esa aniq biror katakchagacha fon o‘matiladi.

WIDTH. Jadval enining oMchami (umumiy jadval uchun xos). Bu oicham 
bilan jadvaldagi ma’lum bir ustuncha yoki boiakning kengligini piksel yohud foiz 
oMchamida belgilash mumkin. Bu oicham <TABLE> yoki <TR> tegi bilan 
qoilanilgan taqdirda ham bir xil ko'rinishdagi, ya’ni siz bergan o'lchamlami hisobga 
olgan holda jadval enining kengligini belgilaydi. Shuni doim )odda tutish lozimki, siz 
bu o lchamdan foydalangan holda jadval enining kengligini belgilaganingizda bir 
xildagi oichov turidan foydalanishingiz maqsadga muvofiq. Agar siz jadval 
kengligini piksellarda belgilasangiz (misol uchun WIDTH=100), boshqa oMchovlar 
ham pikselda belgilanishi lozim Agar jadval kengligi foizlar hisobida berilsa (misol 
uchun WIDTH=50%), boshqa oichovlar ham foiz hisobida berilishi lozim. Ayni 
hollarda brauzer siz yaratgan jadvalni ekranning teng yarmi, ya’ni 50% ga 
joylashtiradi.

HEIGHT. Jadvalning qator yoki katakchalaming balandligi o‘lchovlarini 
piksellar yoki foiz hisobida belgilash uchun qo‘llaniladi.

BORDER. Jadval ustuni va qatorlari kesishmalarini belgilovchi chiziqlami 
qalinligini piksellar hisobida belgilash uchun qoilaniladi. Agar jadval chiziqlarini 
nolga teng qilib belgilansa BORDER (BORDER=0) chiziq (border) brauzerda 
korinmaydigan bo'lib qoladi.

ALIGN. Jadvalning ekranga nisbatan joylashish o‘mini belgilay di. Agar jadval 
ichida qo‘shimcha jadval tuzilgan boisa. u holda ichki jadvalga bu o‘lcham 
kiritilganda, ichki jadval joylashishi o'mi tashqi jadvalga nisbatan belgilanadi. 
ALIGNning quyidagi qo‘shimcha oichamlari mavjud: ALIGN - center (jadvalni 
markaz bo‘ylab joylashtirish), left (chap burchak bo ylab joylashtirish) va right (o'ng 
burchak bo ylab joylashtirish).

CELLPADDING. Border enining kengligini piksellar yordamida kengaytirish 
yoki toraytirish.

CELLSPACING. Jadvaldagi katakchalar chegara enining piksellar yordamida 
kengaytirish yoki toraytirish.
Misol:
<TABLE BORDERS WIDTH=100% CELLSPACING=5 
CELLPADDING=5 BGCOLOR=blue>
<TR BGCOLOR=> ellow>
<TD>Mahsulot</TD>
<TD >N arh l </TD >
</TR>
<TR BGCOLOR=white>
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<^>Qalam</rD>
<TX )>100 so‘m</TD>
</TR>
</TABLE>
<TR> va<TD>

ALIGN. Jadvaldagi har bir katakchanmg ichidagi elementlarni gorizontal 
tarzda tartiblash uchun qo'llaniladi. Uning mavjud qiymatiari quyidagilardan iborat: 
left (chap tomonga tekislash), right (o‘ng tomonga tekislash) va center (markaz 
bo‘vlab tekislash).

VALIGN. Jadvaldagi har bir katakchaning ichidagi elementlarni vertikal 
t a r z d a  tartiblash uchun qoilaniladi. Uning ma\jud o lchamlari quyidagilardan iborat: 
.  top (katakning yuqori qismiga nisbatan), middle (vuqori va quyi qismiga nisbatan 
markazga tekislash).

Jadval tuzish qoidalari. Bu sahifada jadval tuzish jarayonida siz amal 
qilishingiz lozim boigan eng asosiy qoida va maslahatlar keltirilgan.
. <TABLE>, <TR> va <TD> teglarini tartibiga rioya qiling

Har doim jadval tuzish sxemasini buzmaslikka harakat qiling. Avval aytib 
o‘tilgandek eng avvalo jadvalm oching va so ngra jadval qatorlari va ustunlarini 
tuzing va eng oxirida jadvalni yoping. Ushbu tartib buzilgan taqdirda turli xatoliklar 
kelib chiqishi mumkin.
• <TABLE> tegini jadval so‘ngida yoping

Agar <TABLE> tegini yopmasangiz kutilmagan xatoliklar vujudga keladi. 
Masalan, Netscape Nav igator siz tuzgan jadvalni ekranda umuman ko rsatmavdi.
• Ustunda joylashgan qatorlar soni

Har bir qatorda kataklaming soni bir xilda bo lishiga e'tibor bering. Bu 
tartibga, agar siz ay rim kataklarga hech qanday axborot kiritmagan taqdiringizda ham 
ulami yaratish lozim. Bunday holatlarda bo‘sh katakchalami mana bunday 
ko‘rinishda yozish lozim: <TD>&nbsp;</TD>. '&nbsp;‘ simvoli brauzerga mazkur 
katakda hech qanday axborot mavjud emasligi (bo sh joy) haqida xabar beradi. Agar 
ushbu simvol yozilmagan taqdirda brauzer bu katakni aks ettirmaydi va <TD> tegida 
BGCOLOR buy rug 4 ishlatilgan taqdirda fon rangi ifoda etilmaydi va xatolik yuz 
beradi.
• Har bir jadval tegini yangi qatorda yozing
Jadval tuzishda adashib ketmaslik uchun har bir jadval qatori, ustuni va katakchalar 
belgilanganda ulami bir-biridan ajratib vozishga harakat qiling. Quyida ana shu 
holatga misol keltirilgan.
<TABLE>
<TR>
<TD>... </TD>
<TD>... </TD>
< T D > ... < /T D >
</TR>
<TR>
<TD>... </TD>
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<TD>... <vTD>
<TD>... </TD>
</TR>
<7TABLE>

Ushbu qoidalarga rioya qilsangiz jadval tuzishda turli qiyinchiliklarga duch 
kelmaysiz hamda siz tuzgan jadvallarda xatoliklar bo‘lmaydi.

Murakkab jadvallar tuzish. Oddiy jadval tuzish usullarini o‘rganib oldingiz. 
<TD> tegining hali siz bilmagan ba zi qiziq oichamlari mavjud bo‘lib ulami 
qo‘shish orqali ajovib natijalarga erishish mumkin. Aytaylik siz quyida keltirilgan 
jadvalga o‘xshash jadval tuzmoqchisiz (7.2-jadval).

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _______________________  7.2-jadval
№ Mahsulot nomi Narhi (so;m)
1 Qalam 100
2 Ruchka 150
3 Daftar 400
Jami: 650 so‘m

Etibor bergan boisangiz jadvalning sobngidagi qator boshqalaridan farqli 
oMaroq bitta katakchadan iborat. Biz awal aytib otganimizdek jadvaldagi barcha 
kataklar soni bir xil emas. Bu misolda oxirgi qatordagi uchta kataklar bir-biri bilan 
birlashtirilgan xolos. Buni <TD> tegining COLSPAN buyrug‘i yordamida amalga 
oshirish mumkin.

COLSPAN. Jadvaldagi bir qator yoki ustundagi bir nechta kataklami 
birlashtiradi. Bu buyruq oUchamiga siz nechta katakchani birlashirmoqchi bo‘lsangiz, 
ulaming sonini kiritishingiz lozim. Quyida biz yuqoridagi jadvalda bu usul qanday 
amalga oshirilganini ko‘rsatib beruvchi misol keltirayapmiz. Bu misolda jadvalning 
aynan COLSPAN buyrug‘i qo’llanilgan qismigina yozilgan:
<TR>
<TD COLSPAN=3 BGCOLOR=red>
<FONT COLOR=white>Jami: 650 so'm</FONT>
</TD>
</TR>

Freymlar bilan isblash imkoniyatlari. Freym - brauzer oynasidagi mustaqil 
to‘g‘ri to‘rtburchak shaklidagi maydon bolib, u o‘z ichiga boshqa alohida mustaqil 
HTML hujjatlami birlashtira oladi. Endi siz har bir oynasida alohida mustaqil HTML 
hujjatlami ochish imkonini beruvchi freymlami tuzish usullari bilan tanishib chiqasiz. 
Freymlar brauzerdagi yangi ovna emas, balki bu alohida oyna yoki ramka bo‘lib, u 
brauzeming ochilib turgan oynasi ichida aks ettiriladi. Bu boMimda, bir freymdan 
ikkinchi freymlami bir-biriga havolalar yordamida bog‘lash usullarini tahlil qilib 
chiqamiz.

Freymlar tuzish. Siz intemetdan foydalanish jarayonida frey mlar ishlatilgan 
web-sahifani ko‘rgansiz. Bu sahifada uchta freymdan foydalanilgan. Ko‘rib 
turganingizdek bu sahifa uchta freymdan iborat ustunlarga boiingan. Chap ustunda 
joylashgan freymda navigatsion menvu, yuqoridan o ngdagisida reklama va o‘ngdan
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freymda esa web sahifa asosiy matni o‘rm oladi. Chap ustunda joylashgan 
havolalarga bosish bilan, havolalari hujjat o‘ngdan pastda joylashgan freymda
ochiladi.

Ushbu freymlar qo‘llanilgan sahifanmg umumiy tuzilishini ko‘rib chiqsak: 
<FRAMESET> - freymlar tuzilishini belgilovchi ochuvchi teg (freymset)
<FRAME> - birinchi freym 
<FRAME> - ikkinchi freym 
</FRAMESET> - freymsetni yopuvchi teg

Sxemada koiinib turgamdek, har gal <FRAMESET> tegi yordamida freymlar 
tuzilishini belgilash lozim. Shundan so‘ng bevosita freymlar <FRAME> tegiga 
navbat keladi. Oxirgi navbatda </FRAMESET> freymset yopuvchi teg voziladi.

Hozircha bu oddiy sxemani eslab qoling. Murakkab freymlar qoilanilgan 
sahifaJar haqida ushbu boiimda keyinroq maiumot beriladi.

Freymlar - oddiy misol. Freymlar bilan ko'rsatilgan oddiy misolni korib 
chiqamiz. Ishni boshlashdan oldin, oddiy HTML formatida ikkita hujjat yarating. 
Birinchi hujjatga "Freym-l" ikkinchisiga esa "Freym-2" deb vozing va ulami 
freml.HTML va frem2 HTML deb nomlang. Bu ikkita fayllar bizning misolimizda 
ikki freymlar uchun asosiy manba boiib xizmat qiladi. Endi esa HTML formatida 
keyingi hujjatni yarating.
<HTML>

<HEAD>
<TITLE>freymlar</TITLE>
</HEAD>
<FRAMESET CC)LS=200,*>
<FRAME NAME=left SRC=framel.HTML>
<FRAME NAME=right SRC=frame2.HTML>
</FRAMESET>
<NOFRAMES>
Sizning brauzeringiz freymlami tushunmaydi.
<TNOFRAMES>
</HTML>

Demak siz ham o'zingizning birinchi sahifangizni freymlar yordamida 
varatdingiz. Endi shu yaratgan sahifangizni frameset.HTML deb nomlab oldin 
yaratilgan framel.HTML va frame2.HTML fayllar turgan papkada saqlang va 
frameset.HTML faylini o‘z brauzeringizda oching.

Birinchi navbatda, e'tibor bergan boisangiz HTML formatidagi freymlardan 
iborat sahifada <BODY> tegi mavjud emas. Bu esa juda muhimdir. Agar siz 
<BODY> tegini ishlatsangiz u holda, hamma <FRAMESET> va <FRAME> teglari 
brauzeringiz tomonidan o‘chiriladi. Undan tashqari <NOFRAMES> tegi shunda}' 
holatga moijallangan-ki, bu holatda sizning brauzeringiz freymlami qoilab- 
quvvatlamaydi.
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MASHQ. HTML tiliga kirish, uning asosiy elementlari 
Ishning maqsadi: Talabalami HTMLga kirish, uning asosiy elementlari, teg 
tushunchasi bilan tanishtirish
Qisqacha nazariy ma’lumotlar. Intemetning WWW xizmati asosan web-sahifalarga 
bog'liq ekan, ular qanday yaratiladi? - degan savol tug'ilishi tabiiy. Web-sahifalar 
odatda HTML tilida yaratiladi.

HTML (Hyper text Markup Language), so^zlaming qisqartmasi boMib 
gipermatnli belgilar tili ma'nosini anglatadi.

Gipermatn -  biror matn orqali o‘zga ma’lumotlarga murojaatni taminlaydi.
Belgilar -  sahifadagi malumotlaming (matn, rasm, jadval...) qanday 

formatda namoyon bo‘lishini belgilash imkonini beruvchi, kodlar sifatida kiritilgan 
belgilar ketma-ketligidir.

HTML tilining buvruqlari «<» va «>» belgilar orasiga yoziladi va deskriptor 
yoki teg deb vuritiladi. HTML tilida saqlangan faylga .htm yoki html kenga>1ma 
beriladi. HTML hujjatni web-brauzerlar yordamida xotiraga yuklasa, u ekranga vveb- 
sahifa ko^rinishda pavdo bo‘ladi.
HTML tilining asosiy qoidalari:
1. HTML tilidagi istagan harakat teglar bilan aniqlanadi. Bitta teg (chap) harakatning 
bosh qismida, ikkinchisi esa, (o‘ng) oxirida turadi. Yakka ishlatiladigan teglar ham 
mavjud.
2. Brauzer darchasidagi burchakli qavs ichiga jovlashtirilgan istagan teg yoki boshqa 
ko‘rsatma tashqariga chiqarilmaydi va HTML-fayl uchun ichki buyruq hisoblanadi.

HTML qoidalariga ko‘ra, yopuvchi (o‘ng) teg xuddi ochuvchi (chap) teg 
singari yoziladi, lekin teg nomi oldiga «/» (to‘g‘ri slesh) simvoli qo‘shib qo'yiladi. 
Qo‘shaloq teglar orasidagi yagona farq shundaki, yopuvchi teglar parametrlardan 
foydalanmaydilar. Har qanday Web-sahifa <HTML> tegi bilan boshlanadi. Bu tegni 
qabul qilgan brauzer hujjatni HTML tilida varatilgan Web-sahifa sifatida qabul 
qiladi. Yaratilgan sahifa </HTML> tegi bilan yakunlanadi. Web-sahifalar ikki:

■ sarlavha qismi;
■ sahifa tanasidan tashkil topadi.
Sarlavha qismi <HEAD> va </HEAD>, tana qismi esa <BODY> va </BODY> 

teglar orqali belgilanadi.
Sarlavha qismida <TITLE> va </TITLE> teglan orqali sarlavha matni 

kiritiladi. Bu matn brauzerda sarlavha satrida namoyon boiadi.
Masai an:
<html> Ushbu teglar orqali yozilgan
<head> qoidalar Web-saliifaning HTML-kodi
<title> Birinchi qadam </title> deb yuritiladi. Mazkur Web-«ahifaning
</head> kodi matn muharririga (Notepad)
<bod>> Mening birinchi Web-sahifam kiritilib, saqlash amalini bajarishda fayl 
<br> Xush kelibsiz! nomi bilan Web-hujjat kengaytmasi
<7bodv> ( htm yoki html) belgilanadi.
</html>
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Bu usulda saqlangan hujjat brauzerda paydo bo'ladi. Web-sahifam ko^rib 
chiqib, unga o‘zgartirishlar kiritish uchun kodli faylga o'tish lozim bo'ladi. Kiritilgan 
o ‘zgartirishlar natijalarini ko‘rish uchun esa saqlash amali bajarilishi va F5 tugma 
(yoki Обновить buyrug‘i) orqali Web-sahifayangilanishi mumkin.
HTML teglari va teg atributlari.

Ochiluvchi teglar ko'p hollarda tarkibida malumot formatlari, stillari. 
joylashishlarini belgilovchi atributlarga ega bo‘ladi. Atributlar-tegdagi kalit so‘zlar 
bo'lib, ular o‘zaro probel bilan ajratib yoziladi. Aksariyat atributlar qiymatlami 
ko‘rsatishni talab qiladi. Bu qiymatlar qo‘shtimoq belgisi bilan yozilib, atributlar 
bilan «=» belgi yordamida ajratib yoziladi.
Umumiy tuzulishi: <teg atribut=”Qiymat”>
Masalan:
<p align-'center”> sarlavha matni <Ур> - bu yerda align= "center” sarlavhaning 
markazdajoylashishini ta'minlaydi.
<Body bgcolor=’'Blue’> umumiy sohaga rang berish </Body>.
HTML belgilash tilining barcha teglari ro‘yxati.

Quyida keltirilgan teglami tushunishni osonlashtirish maqsadida. teglardan 
keyin ular haqidagi ma’lumotlami kengaytiruvchi izohlar beriladi. Masalan.
HTML5 tegi - HTML5 tasnifidagi yangi teg hisoblanadi.
Eskirgan teg - HTML5 tasnifida ishlamaydigan teg.
Nostandart teg - Hech bir tasnifda keltirilmagan lekin ulardan ba zi brauzerlarda 
foydalanish mumkin.
HTML5 yoki XHTML uchun yangi elementlar va atributlar qo'shimcha qilingan deb 
ham aytiladi va uning spetsifikasi 2009 yildan muomalaga kiritilgan bo‘lib, u 
haqidagi ma’lumotlami W3C saytidan olishingiz mumkin.

HTML5 foydalanuvchi uchun keng imkonivatlar taklif etib, web ilovalar va 
interfaol saytlami yaratish jarayonini osonlashtiradi.

Bundan tashqari HTML5 multimedia xarakteridagi ma’lumotlami web 
ilovalarga qo'shish uchun qo'shimcha elementlarga ham egadir HTML5 muhitidagi 
yangi teglami Firefox va Chrome brauzerlarining yangi versiyalari tanib olish 
imkoniga ega.
Izoh kiritish tegi. Web-sahifalaming HTML-kodlari tushunarli bo‘lishi uchun izoh 
kiritib borish tavsiva etiladi. Izohlar < ! > tegi bilan boshlanib </ > tegi bilan 
yakunlanadi. Bu teglar orasidagi ma lumot brauzer oynasida namoyon bo‘lmavdi. 
<marquee> matn <7marquee> teglari orasiga kiritilgan matn harakatlanuvchi satr 
sifatida paydo boMadi. U quyidagi atributlarga ega:

■ bgcolor-harakatlanuvchi satr fonining rangi;
■ height-satr balandligi;
■ width-satr eni.

Shuning bilan birga harakatlanuvchi satrga boshqa atributlami masalan, hspace. 
vspace va alignlami berish mumkin.
<marquee height=”10" width="270" loop="2"> harakatlanuvchi satr </marquee> 
loop atributi harakatlanuvchi satr, necha marta harakatlanishini anglatadi. Misoldagi, 
loop-'2" demak harakatlanuvchi satr ikki marta harakatlanishini anglatadi.
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■ Behavior, satr o‘zini qay holatdatutishini anglatadi.
behavior="scroU" (slide, alternate). Scroll - odativ aylanishni anglatadi.
■ Slide - yakunida to‘\tash orqali harakatlanish ya’ni harakatlanuvchi satr, satr 

oxirigacha harakatlanib yakunda to‘xtaydi. Agar behavor="slide" bilan loop 
parametri birgalikda ishlatilsa u holda belgilangan marta harakatlanib yakunida satr 
oxirida to'xtaydi.

■ Alternate atributi harakatlanuvchi satming chegaradan chegaragacha 
harakatlanishini ta minlaydi.

■ Scrollamount atributi esa harakatlanuvchi satrga tezlik o‘matadi. U 1 dan lo 
gacha qiymatlami oladi. Demak. scrollamount=" I" eng kichik tezlikni anglatadi. 
Direction harakatdagi satrga vo‘nalish beradi (7.3-jadval).

7.3-jadval. Direction yo nalishlari
direction-'left" Chapga harakat direction- 1 up" Yuqoriga harakat
direction="right" 0 ‘ngga harakat direction=”do\vn" Pastga harakat

<body bgcolor -Vellow" > fonga rang berish </body>
COLOR atributi qiymatlari (ranglar): ranglar nomlari orqali yoki boshqa formatlarda 
berilishi mumkin. HTML tilida ranglardan nomi orqali foydalanish ham mumkin 
(7.4-jadval).

7.4-jadval. HTML tilida ranglarnmg nomlari
Red Orange Yellow Green DeepSk>'Blue Blue
Qizil Apelsin Sariq Yashil Moviy

Purple DarkRed DarfcOrange Gold DarkGreen LightSkyBlue
To‘q qizil T o‘q apelsin Oltin To'q Och

DarkBlue Indigo DarkOrchid Grav DeepPink LightGrey
To‘q To‘q Och

LightGreen LightPink Black White Lime WhiteSmoke
Och Och Oq

MASHQ. HTML tilida jadvallar hosil qilish 
Ishning maqsadi: Talabalarda HTML tilida jadvallar hosil qilish, jadvallar ko‘rinishi 
va boshqarish jarayonlari. Jadvalning ustun va satr teglariga doir tushunchalami hosil 
qilish.
Qisqacha nazariy ma'lumotlar. HTML tilida ma'Iumotlami tartiblashning eng 
yaxshi vositasi bu jadval hisoblanadi. Turmush tarzida u yoki bu ko'rinishdagi 
masalalarni yechishda biz ko‘p holda turli ko rimshdagi jadvailarga duch kelamiz. 
Lekin jadval HTML tilida ma’Iumotlami shakllantirishni qulay vositasi bilangina 
chegaralanib qolmaydi. Hozirgi kunda jadval. tuzilishi jihatidan turli HTML 
elementlami qabul qiluvchi ko‘p sonli elektron hujjatlaming asosi hisoblanadi. Jadval 
dastlab ma’Iumotlami vizual ko*rish usuli sifatida tanlangan bo‘lib, hozirda HTML 
tuzilishini boshqarish kabi muhim funktsiyani bajaradi. Ma'Iumotlami jadvalga 
joylashtirishna qulayligiga shubha yo‘q lekin ma’Iumotlami tartibilovchi boshqa 
vositalardan (masalan, ro'yxatlar) ustunligi, uning ixtiyoriy HTML hujjatning asosiy 
tuzilmali elementi sifatida hisoblanishidadir. Xulosa qilib shuni aytish mumkinki.



advalning birinchi darajali vazifasi bu ma'lumotlami qulay tarzda tasavvur qilish 
imkonini berishi hisoblanadi.

Oddiy jadvallar tuzish. HTML tuzilmali jadvallar. ko‘p sonli turli 
ko‘rinishdagi teg va atributlami qabul qiladi. Ulaming ba’zilari keng ommalashgan 
bo’lib ba’zilaridan esa kam holatda foydalaniladi Jadvalning asosiy teg va yopuvchi 
tegga ega bo‘lgan <TABLE> hisoblanadi. Umumiv holda <tablex/table> 
ko‘rinishga ega. Bundan tashqari jadval albatta satr va ustunlardan (katakcha) tashkil
topadi.

4- < trx /tr>  jadval satri;
4- < tdx/td>  esa jadval ustunim (katakcha) anglatadi.

E’tiboringizga ikkita satr va uchta ustunli, katakchalari esa turli ranglarga bo‘yalgan 
jadval havola etilavapti.

Jadval chegaralari berilmagan, shumng uchun siz ulami ko‘rmayapsiz. Shu jadvalni 
hosil qilishni ko‘rib chiqaylik.
<table>
<trx/tr>
< trx/tr>
</table>

Demak, sezgan bo‘lsangiz avvaliga satrlarni havola etdik. Keltirilgan misolda 
ulaming soni ikkita. Endi har bir satr uchun uchtadan ustun (katakcha) qo‘shamiz. 
<table>
<tr>
<tdx/td>
<td></td>
<td></td>
<J\x>
<tr>
<td></td>
<td></td>
<td></td>
<Лг>
</table>

Izoh: Web sahifada jadval yaratish uchun avvalo kerakli o‘lchamdagi jadvalni 
qog‘ozga chizib oling. Bu sizga jadvalni yaxshi anglab olishingizni va eng asosiysi 
xato qilmaslikga yordam beradi. Hosil bo‘lgan karkasni toidirishni ko'rib chiqaylik. 
<table>
<tr>
<td>lxl</td>
<td>lx2</td>

7.5-jadval.

2
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<td> 1x3 </td>
<7tr>
<tr>
<td>2xl</td>
<td>2x2</td>
<td>2x3</td>
<Vtr>
</table>

lxl yozuvdagi birinchi son jadvaldagi birinchi satmi, ikkinchi son esa birinchi 
katakchani (lxl-birinchi satr, birinchi katakcha) anglatadi. Qolganlarini ham shu 
mazmunda tushunish kerak. Mantiqan biz quyidagi ko‘rinishga ega boidik: 
lx l 1x2 1x3 
2x1 2x2 2x3

Yuqoridagi rasm ko'rinishda havola etilgan jadvaldagi ko'k va sariq ranglami 
tashkil etishni ko‘rib chiqaylik. Oldingi amaliy mashg‘ulotdan ma’lumki, fonlar 
bgcolor="fon rangi" atributi orqali beriladi. Fonlami jadval uchun turli ko rinishlarda 
berish mumkin masalan, butun jadval uchun, bitta satr uchun, katakcha uchun va 
hokazo. Lekin bizning misolda har bir katakcha uchun alohida fon berish lozim U 
quvidagicha bajariladi:

<table>
<tr>
<td bgcolor="#FFCC33">lxl<ytd>
<td bgcolor="#336699">lx2<ytd>
<td bgcolor="#FFCC33">lx3</td>
</tr>
<tr>
<td bgcolor="#336699">2xl</td>
<td bgcolor="#FFCC33">2x2</td>
<td bgcolor="#336699">2x3</td>
</tr>
</table>

Natijani kompyuterda tekshirib ко‘ring.
Qatorga fon o‘matish uchun, bgcolor atributini <tr> tegga nisbatan ishlatish 

lozim. Ya’ni, <tr bgcolor="#FFCC33"> kabi.
Agar barcha jadval uchun fon berish lozim bo‘lsa u holda bgcolor atributini 

endi <table> tegiga nisbatan qo‘llash lozim. <table bgcolor="#FFCC33">.
Jadvalga berilgan fondan qat’iy nazar, siz fonli jadvaldagi qator yoki 

katakchalar uchun boshqa alohida fon qo‘llashingiz mumkin. Natijada fon berilgan 
qator yoki katakcha, jadval fonidan farqli, qo‘llanilgan fon asosida paydo bo'ladi. Bu 
amalni mustaqil bajaring. Esingizda bo‘Ilsa biz chegarasiz jadvalni yaratishni 
ko‘zlagan edik. Agar chegarali jadval yaratish lozim bo‘lsa u holda border-’chegara 
o‘lchami", (masalan chegara oMchamini ’*1” kabi olish mumkin) tegidan 
fovdalanishingiz mumkin. Navbat jadval katakchalariga (eni, bo‘yi bo‘yicha) 
o lchamlar berishdan iborat. 0 ‘lchamlar height va width atributlari yordamida

188



beriladi. Bu oMchamlami butun jadvalga, bitta qatorga yoki katakcha (ustun) uchun 
qo‘llashingiz mumkin bo'lib, ular piksel yoki foizlarda beriladi. Aniqlik uchun 
katakchalarga ulaming balandligi va enini pikselda berishni ko‘rib chiqaylik.

<table>
<tr>
<td height="35" width="50" bgcolor="#FFCC33"> lx l </td>
<td \vidth="50" bgcolor="#336699"> 1x2 </td>
<td width-’50" bgcolor="#FFCC33"> 1x3 </td>
</tr>
<tr>
<td height="35" width="50" bgcolor="#336699"> 2x1 </td>
<td w idth-'50" bgcolor="#FFCC33"> 2x2 <Vtd>
<td width="50" bgcolor="#336699"> 2x3 </td>
<ytr>
</table>
Natijani kompvuterda tekshirib ko‘ring. Endi faqat jadval ichidagi ma’lumotlami 
tekislash qoldi xolos.
E’tibor bering! Yuqoridagi fikrlami jadval kesimida bayon etdik. Web sahifa 
yaratishda siz albatta uning bosh va tana qismlarini qo llagan holda natijaga erishasiz. 
Ya’ni oxirgi ko‘rinish taxminan quyidagicha bo'lishi lozim:
<html>
<head>
<title> jadval </title>
</head>
<body>
<table>
<tr>
<td height="35" \\idth="50" bgcolor="#FFCC33"> <center> lx l </center> </td>
<td width="50" bgcolor="#336699"> <center> 1x2 </center> </td>
<td width="50" bgcolor="#FFCC33"> <center>lx3 </center> </td>
<7tr>
<tr>
<td height="35" width="50" bgcolor="#336699"> <center> 2x1 </center> </td>
<td width="50" bgcolor="#FFCC33"> <center> 2x2 </center> </td>
<td w idth-’50" bgcolor="#336699"> <center> 2x3 </center> </td>
</tr>
</table>
</body>
</html>

MASHQ. HTML tilida rasmlar qo‘yish teglari 
Ishning maqsadi: Talabalarda HTMLda rasmlar hosil qilish. rasmlar atrofiga 
matnlar va jadvallar joyiashtirish, rasmlarga giperhavola qo‘yishga doir 
tushunchalarni hosil qilish.
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Qisqacha nazariy ma’lumotlar. Web sahifaga rasm o4matish va rasm ustida 
amallar bajanshni ko‘rib chiqaylik. Oldingi amaliy mashg‘ulotdan ma'lumki rasm 
yakka teg hisoblanuvchi img orqali omatiladi. Agar rasm web-sahifa bilan bitta 
papkada joylashgan bo‘lsa u holda rasmni sahifada quyidagicha namoyon qilish 
mumkin:

4  <img src-'rasm.jpg">. Bu yerda src manba ma’nosini anglatadi, "rasm.jpg" 
esa o'rnatiluvchi rasmli fayl nomi yoki manzili.
Rasmjpg fayldagi rasm so‘zi o‘miga boshqa nomni ishlatishingiz mumkin. 

Muhimi qo‘shtimoqlar orasidagi qism, rasmga yo‘l murojaatini anglatishini tushunib 
olish lozim. Agar hujjat papkadagi rasm nomli icihki papkada joylashgan bo‘lsa u 
holda murojaat quyidagi korinisihga ega bo iadi:

■ <img src="rasm/rasm.jpg">
■ Agar rasm bir pog'ona yuqoridagi papkada joylashgan boisa, u holda murojaat 

quyidagi ko'rinishga ega bo iadi:
■ <img src="../rasm.jpg">
■ Agar rasm boshqa joyda, masalan boshqa savtda joylashgan bo‘Isa u holda 

unga murojaat yo‘li to‘liqligichako“rsatilishi lozim. Masalan,
■ <img src="http://www.homepage.ru/rasm/rasm.jpg">

Yana bir muhim ma lumot: RASM.jpg, rasm JPG, rasmjpg va RASM.JPG 
fayl nomlari o'xshash bo‘lsada lekin ular turli fayllar nomlari hisoblanadi. Shuning 
uchun registmi hisobga olish esingizdan chiqmasin.
<html>
<head>
<title> Registon </title>
</head>
<body text="#336699" bgcolor="ammajon">
<div align-'center">
<H3> Registon bobylab sayohat </H3>
<br>
<font color="#CC0000"> Xush kelibsiz!</font>
</div> <p align-‘justify">
<img src="Registon ansambli.jpg" HEIGHT=,,80" WrDTH="120">
Registon ma> doni-tarixda shahaming ilm-fan, siyosiy va diniy markazi bo‘lgan. 
<b>Registon</b> so‘zi <b>qumloq</b> joy degan ma:noni anglatadi. 0 ‘rta asrlarda 
hamma katta shaharlarda markazlar Registon deb atalar edi. Shu nomdagi mavdonlar 
Buxoro, Shaxrisabz va Toshkentda ham bo'lgan. Samarqanddagi maydon esa o'rta 
osiyodagi eng mahobatli va taqsinga sazovor maydonlardan biridir.
<Jp>
</body>
</htmi>

Endi matn rasmni to‘liq qamrab olishini ko‘rib chiqaylik. Buning uchun 
to‘g‘rilash imkonini beruvchi align atributidan fo\'daJanamiz. <img src="Registon 
ansambli.jpg" align="left"> Bunda rasm ekranning chap tomonida joylashib matn esa 
uni o‘ng tomonidan atroflab o‘tadi. Teskarisini bajarish uchun left so'zining o‘miga
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right parametridan foydalanish lozim, ya'ni <img src-'Registon ansambli.jpg" 
align="right"> bnnda, matnni to'g'rilash uchun quyidagi holatlarga e tibor berish 
lozim:

■ Matnni rasm pastki chegarasi bo‘yicha tekislash;
<img src="Registon ansambli.jpg" align-'bottom">

■ Matnni rasm markazi bo'vicha tekislash;
<img src-'Registon ansambli.jpg" align-'middle">

■ Matnni rasm yuqori chegarasi bo‘yicha tekislash.
<img src-'Registon ansambli.jpg" align-'top">
<img> tegi uchun, align atributidan tashqari vana bir necha atributlami kiritish 
mumkin:

• <img s rc - ’Registon ansambli.jpg" vspace="10">:
■ <img src="Registon ansambli.jpg" hspace-'30">;
■ <img src-'Registon ansambli.jpg" alt="rasm">;
■ <img src-'Registon ansambli.jpg" title-'Registon ansambli">;
■ <img src-'Registon ansambli.jpg" width- 1 100">;
■ <img src-'Registon ansambli.jpg" height="200">;
■ <img src-'Registon ansambli.jpg" border="5">.

Bu punktlar uchun qisqacha izoh.
Vspace atributi, vertikal holat bo'yicha matn va rasm orasiga masofa (pikselda) 
joriy etadi.
Hspace atributi, gorizontal holat bo‘yicha matn va rasm orasiga masofa joriy etadi. 
Alt parametri, rasm o'miga qisqacha izoh berishni ta’minlaydi. Agar alt parametri 
qoilanilmasa u holda rasm to‘g4risidagi ma lumot namovon bo'lmaydi. Esingizda 
tuting, rasm o'rnidagi ma lumot albatta bo‘lgani ma'qul. Title atributi, sahifaga 
o‘matilgan rasmga izoh berishni ta minlaydi. Buning uchun rasm ustiga sichqoncha 
ko‘rsatkichini olib borib, qisqa muddat ushlab turilsa. rasm haqidagi ma’lumot paydo 
bo‘ladi. Width atributi yordamida, rasm eni ko‘rsatiladi. Agar rasm eni ko‘rsatilmasa 
u holda rasm o'zining real kattaligi bo‘yicha paydo bo'ladi. Height atributi 
yordamida esa, rasm bo‘yi ko'rsatiladi. Xuddi width atributi singari uni ham 
ko'rsatilmasa ham bo ladi.
Border atributi yordamida, rasm uchun ramka (chegara) o‘matish mumkin. Rasm 
ramkasini ko'rsatmasa ham bolladi. Lekin ko‘p hollarda ramkali rasm ishlatiladi. 
Shunga qaramay ramka qo‘llamoqchi bo‘lmasangiz u holda border atributiga ”0'' 
qiymat bering. Ya’ni, border="0".

Malumki teg atnbutlarini bir vaqtda birin-ketin qo‘llash mumkin. 
Chalkashliklami oldini olish uchun, quyida kehirilgan holda rasm uchun atributlami 
qoMlashni havola etdik:
<img src="Registon.jpg" align="left" hspace="30" vspace="5" alt="Registon 
ansambli1’ title="Registon ansambli">
Demak rasm ekranning chap tomonidan namovon bo*lib, matn esa uni o‘ng 
tomonidan qamrab oladi. Gorizontal holda matngacha masofa 30 piksel, vertikal 
holda esa 5 pikselni tashkil qiladi. Rasm ustiga sichqoncha ko‘rsatkichi olib borilsa u 
holda “Registon ansambli” iborasi paydo bo ladi.
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Shunday qilib yakuniy ko‘rinishni havola etsak ham boiadi:
<head>
<title> Registon </title>
</head>
<body text="#336699" bgcolor="ammajon">
<div align-'center">
<H3> Registon bo ylab sayohat </H3>
<br>
<font color="#CC00()0"> Xush kelibsiz!<v'fontx/div>
<p align-'jus!tify ">
<img src-'Registon.jpg" HEICHT="100" WIDTH="150M align="lefr hspace="30" 
vspace="5" alt^'Registon ansambli" title-'Registon ansambli">
Registon maydoni-tarixda shaharning ilm-fan, siyosiy va diniy markazi bo‘lgan. 
<b>Registon</b> so zi <b>qumloq</b> joy degan ma'noni anglatadi. O rta asrlarda 
hamma katta shaharlarda markazlar Registon deb atalar edi. Shu nomdagi maydonlar 
Buxoro, Shaxrisabz va Toshkentda ham boigan. Samarqanddagi maydon esa o‘rta 
osiyodagi eng mahobatli va taqsinga sazovor maydonlardan bin edi.
<Jp>
</body>
</html>
Havola o‘matish.

Sahifa bir necha hujjatlardan tashkil topgan bolishi mumkin. Ulardan biri 
ya’ni asosiysini odatda standart bo‘yicha index.html kabi nomlanadi Qolganlarini esa 
turlicha masalan. (photos.html. about_me.html, my_pets.html. friends.html, 
gh516hgd.html) kabi nomlash mumkin boiib, ular bitta papka yoki turli papkalarda 
joylashishi mumkin. Murojaatlar yordamida bu hujjatlami bir-biri bilan bogiashni 
ko‘rib chiqaylik. Murojaatni. asosiy sahifadan boshqa sahifaga o‘tish va aksincha 
orqaga qaytishga ham qo‘llash maqsadga muvofiqdir. Boshqa hujjatlarga murojaatni 
matn (matn parchasi, so‘z) va rasmga nisbatan qoilashimiz mumkin. Buning uchun 
avvalo yangi hujjat yaratib olishimiz lozim. Aniqlik uchun yaratilayotgan hujjatga 
Samarqand.html nomini beraylik. Samarqand.html nomli hujjat ham asosiy hujjat 
index.html bilan bitta papka joylashishini unutmang. Samarqand.html nomli hujjat 
mazmuniga kelsak uni qay tartibda yaratish sizga havola. Avtaylik u rasmlar 
to‘plamidan aniqrog‘i, Samarqand shahrining diqqatga sazovor jovlari rasmlaridan 
tashkil topgan bo‘lishi mumkin. Murqjaat quyidagicha tashkil etiladi:
<a href-'Samarqand.htmr>Registonni ko rish </a> Bu yerda. < ax /a>  rasm yoki 
matnga olmatilgan murojaatni tashkil etuvchi teg hisoblanadi;
Samarqand.html murojaat etilayotgan sahifa nomi;
Registonni ko‘rish iborasi esa asosiy sahidagi murojaat o‘matilgan matn parchasidir. 
Murojaat ko‘rinishlari:

■ <ahref="Samarqand.htmr>Registonni ko rish</a>;
■ <a href="photos/Samarqand.html">Registonni ko rish </a>;
■ <a href=,,http://www.homepage.ru/Samarqand.html"> Registonni ko‘rish <Ja>.

192

http://www.homepage.ru/Samarqand.html


Rovxatdagi birinchi holatda, ikkala hujjat ham bitta papkada joylashgan. 
Ikkinchi holatda, hujjat /photos papkasida va uchinchi holatda esa kerak bo‘lgan 
hujjat joylashgan http://www.homepage.ru savtiga murojaat ko'nnishi aks etilgan. 
Dastlabki ikki holatni nisbiy yoilar. uchinchi holat esa absolvut ya’ni yo‘l 
toiiqhgicha ko'rsatilgan deviladi. Hujjatdagi barcha murojaatlar uchun turli ranglami 
qo'llash mumkin:

■ Link-oddiy (faol boMmagan) murojaat rangi;
■ alink-faol (tanlangan) murojaat rangi;
■ vlink-qayd qilingan (ishlatib boiingan) murojaat rangi;

<bodv text="#336699" bgcolor="#000000" link="#3 39999" alink=,,#339999" 
vlink="#339999">
Hujjatdagi barcha mamlar ranglari singari. murojaatlar ranglarini ham <body> 
tegining tarkibiga qayd etiladi. Yuqoridagi ro‘yxatda barcha murojaatlar turlari uchun 
bir xil rang qo'lladik. Ular har xil boiishi ham mumkin. Bum qo'llash o'zingizga 
havola. Shunday qilib murojaat ranglari va murojaatni o‘zi quyidagicha boMishi 
mumkin:
<head>
<title> Registon </title>
</head>
<body text="#336699" bgcolor="ammajon" link="red" alink="blue" 
vlink="#339999">
<div align-'center">
<H3> Registon bo ylab sayohat </H3>
<br>
<font color="#CCOOOO"> Xush kelibsiz! </font>
</div> <p align-'justifv">
<img src-'Registon.jpg" HEIGHT="100" WIDTH="150" align="Ieft" hspace="30" 
vspace="5" alt="Registon ansambli" title="Registon ansambli">
Registon maydoni-tarixda shahaming ilm-fan, siyosiv va diniy markazi bo‘lgan. 
<b>Registon</b> so'zi <b>qumloq</b> joy degan ma’noni anglatadi. O rta asrlarda 
hamma katta shaharlarda markazlar Registon deb atalar edi. Shu nomdagi maydonlar 
Buxoro, Shaxrisabz va Toshkentda ham bo‘lgan. Samarqanddagi ma) don esa o‘rta 
osiyodagi eng mahobatli va taqsinga sazovor maydonlardan biri edi. <a 
href-'Samarqand.html"> Registonni ko‘rish </a> ishtiyoqida butun dunyo say> ohlari 
tashrif buvuradi 
</p>
</body>
</html>
Ish yakuniga vetdi. uni o‘qituvchiga havola eting.

MASHQ. HTML tilida gipermatn joylashtirish teglari 
Ishning maqsadi: Talabalarda HTMLga gipermatn joylashtirish teglari, gipermatn 
turlari, atributlari, gipermatnli mundarija hosil qilishga doir tushunchalami hosil 
qilish.
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Qisqacha nazariy ma’lumotlar. Kitoblar o'qiyotganimizda, muallif, u yoki bu 
ko'rinishdagi mavzuni voritish uchun, boshqa bo'lim yoki boshqa manbaga murojaat 
qilganiga guvoh bo'lamiz. Internet tarmog'ida mazmun jihatidan o'xshash va avni bir 
foydalanuvchi auditoriyasiga mo'ljallangan ko'plab elektron hujjatlar 
joylashtirilgandir. Gipermatnli murojaat yordamida bir HTML-hujjatni boshqasi bilan 
bogiash lmkoniyati mayjudligi tufayli, boshqa hujjatlarga o'tish amalga oshiriladi. 
Aslida, har qanday gipermatnli murojaat-brauzer oynasidan darhol otiluvchi global 
tarmoqdagi manzil ko'rsatkichidir.
Giperhavola tuzilishi.

Har qanday giperhavola, murojaat ko‘rsatkichi va murojaat etilayotgan manba 
manzilidan tashkil topadi. Oddiy matnni giperhavoladan ajratib olish juda oson, chunki 
giperhavola omatilgan matn ustiga sichqoncha ko'rsatkichi olib borilsa u ko'rsatkich 
barmoqli qo'l shaklga o tib matnning o'zi esa tagiga chizilgan holda joylashadi.

■ Murojaat ko'rsatkichi sifatida matn (so'z, gap va butun sahifali matn ham) va 
grafik tasvirlar qatnashishi mumkin. Bundan tashqari grafik tasvir bilan matnni 
birgalikda ishlatilsa ham bo'ladi.

■ Murojaat ko'rsatkichi <A> teg orqali tavsiflanib, o'tish manzili esa qiymati u 
yoki bu ko'rinishdagi internet manba bo'lgan HREF parametri hisoblanadi.
Bu teg o ‘z vaqtida yopiluvchi tegga ega bo'lib, u </A> ko'rinishga ega.
Oddiy giperhavolaga misol.
<html>
<head>
<title> Oddiy giperhavolaga misol </title>
</head>
<body bgcolor="#FFFFFF" text="black" link="#FFOOOO" 

alink=“#FFOOOO" vlink="blue">
<font color="gra} " size="6"> Adobe Photoshop</font>
<HR color="#003366" width="90%" align="left">
<p> <font face="Tahoma", "Verdana" size="4">
Hozirgi kunda mashhur va keng tarqalgan grafik muharrirlardan biri, rastrli 

grafika bilan ishlovchi Adobe Photoshop dasturi hisoblanib u <A HREF= 
"http://www.adobe.com/"> <b>Adobe Systems</b> </A> korporatsiyasi tomonidan 
ishlab chiqilgandir. Hozirgi kundagi uning oxirgi ko'rinishlaridan (versiyasi) biri CC 
(2017) hisoblanadi. </font> </p>

</body>
</html>
Agar murojaat ko'rsatkichi grafik tasvirdan iborat bo'lsa, u holda <A> tegning 

ichki qismida gipermatnli murojaat vazifasini bajariluvchi rasmga yo'l ko'rsatiladi. 
Ko'rsatkichi grafik tasvirdan iborat bo'lgan giperhavolaga misol.

<html>
<head>
<title> Ko'rsatkichi grafik tasAardan iborat bo'lgan giperhavolaga misol 

</title>
</head>
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<body bgcolor="#FFFFFF" text="black" link="#FFOOOO" 
aiink="#FFOOOO" vlmk="blue">

<p align-'center">
<A HREF="http://ww\v.adobe.com">

, <img src="http://www adobe com/images/adobe.gif' \vidth="24” height="31" 
alt="Adobe Systems" border="0"> </A>
<Jp>
<ybody>
</html>
E’tibor bering, tasvir chegarasi atributi Bordeming qiymati 0 ga teng. Chunki, 

uning boshqa qivmatlanda tasvimi murojaat ko'rsatkichi sifatida izohlab, uning 
chegarasiga ramka o'matiladi. Agar bitta murojaat tuzilishiga matn va grafik 
ob’yektni birgalikda birlashtirilsa u holda HTML-kod quyidagi ko'rinishni oladi. 

Matn va grafik ob'yektni birlashmasidan iborat bo lgan giperhavolaga misol. 
<html>
<head>
<title> Matn va grafik ob'yektni birlashmasidan iborat bolgan giperhavolaga 

misol </title>
</head>
</head>
<bodv bgcolor="#FFFFFF" text="black" link=M#FFOOOO" 

alink="#FFOOOO' vlink="blue">
<font color="gray" size="6"> Adobe Photoshop<7font>
<hr color="#003366" w idth-'90%" align="left">
<p> <font face="Tahoma", "Verdana" size="4">
Hozirgi kunda mashhur va keng tarqalgan grafik muharrirlardan biri, rastrli 

grafika deb ataluvchi <br> Adobe Photoshop dasturi hisoblanib u
<A H REFxim g src=" Adobe Photoshop.jpg" w idth-’24" height="31" 

alt="Adobe Systems" border="0" title—' Adobe Photoshop " xb>Adobe 
Systems</b> </A> koфoratsiyasi tomonidan ishlab chiqilgandir.

</font> <Ур>
</body>
</html>
<A> tegi HREF atributi bilan bir qatorda style, class, name, title va target 

atributlarga ham ega boMib, ulaming dastlabki ikkitasi giperhavolaning uslubiy 
qoliplarini yaratishga va uchinchisi esa ichki murojaat tashkil qilishda nomni 
ko'rsatish uchun ishlatiladi. Title parametri, sichqoncha ko'rsatgichi murojaatga olib 
borilganda namoyon bo luvchi izohli darcha yaratish uchun ishlatiladi. Yuqoridagi 
misolda bu parametrdan foydalandik, brauzer oynasida sichqoncha ko‘rsatgichini 
murojaatga olib borib izohli darcha chiqishiga ishonch hosil qiling.

Target parametri esa murojaatli o'tishning maqsadli qoilanishini aniqlab 
beradi. Masalan. giperhavola ustida chap tugmani bosish natijasida joriy yoki alohida 
yangi oynada hujjatni ochish mumkin.

Barcha murojaatlar umumiy holda ikki ko'rinishga ajratiladi:
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■ Tashqi murojaat;
■ Ichki murojaat.

Tashqi murojaat global tarmoqning boshqa resurslanga yoki bitta Web- 
savtning boshqa hujjatlariga o‘tishni ta’minlasa. ichki murojaat esa bitta HTML 
hujjat ichida sayr qilish imkonini beradi.

Tashqi murojaatlar. Tashqi gipermatnli murojaatlar qonunivatlarini ko'rib 
chiqaylik. Tashqi murojaat tuzulishi ko‘rsatkich va manzildan iborat. O'z vaqtida 
tashqi murojaat orqali o‘tish manzili yozilishining absolvut va nisbiy ko'rinishlari 
mavjuddir.

■ Absolyut. HREF atributi qiymatida, hujjatda murojaat o‘matiladigan manbaga
o tishning toMiq yo‘li ko'rsatiladi Masalan: <A HREF="http: //www 
site.ru/docs/pagel.html"> Birinchi sahifaga o'tish murojaati </A>. Bunda. 
foydalanuvchi qaysi hujjatdan murojaatni tanlashidan qat'iy nazar http: //www. 
site.ru/docs/pagel html manzil bo'yicha o'tiladi.

■ Nisbiy. HREF atributi qiymatida, unga nisbatan murojaatli sahifa joylashgan 
oxirgi hujjat ko'rsatiladi. Masalan: <A H R E F-1'page2.html"> Birinchi sahifadan 
ikkinchi sahifaga o'tish murojaati </A>. Tashqi havolaning bunday formatli 
yozuvju page2 .html fayl (unga nisbatan murojaat ko'rsatiluvchi), pagel.html fayli 
(undan o'tish amalga oshiriluvchi) bilan bitta papkada joylashganligini nazarda 
tutadi.

Savol va topshiriqlar
1. HTML nima?
2. Teg nima?
3. Brauzer dasturi nima? Qandav brauzer dasturlarini bilasiz?
4. HTML hujjatning asosiy strukturasini tushuntirib bering?
5. HTML tilida rasm qo‘yish tegi va uning atributlarini tushuntiring?
6 . HTML tilida jadval qo‘yish tegi va uning atributlarini tushuntiring?
7. HTML tilida havola qo‘vish tegi va uning atributlarini tushuntiring?

Test savollari
1. W eb-sahifalar yaratishda ishlatiladigan 6. Freym nima?
professional dasturiy vositalarni ko‘rsating? A) matnning qismi boiib , boshqa fayl yoki
A) Dreamweaver. Adobe Flash, Home Site ob’yektga yo‘l ko‘rsatuvchi hisoblanadi
B) Visual Basic, Delphi, html, php, xml. B) bu HTML tilining tuzilishi yoki kontevncr
C) Delphi, html. php. xml. C) bu elementning boshlang'ich va oxirgi belgilari
D) Flashy 3DS MAX (markerlan) hisoblanadi. Teglar dementlami bir-

biridan ajratish va ta’sir doirasini belgilab beradi.
2. HTML bu -  ... D) o ‘zining mustaqil prokrutkalariga ega boigan
A) Hyper Text Markup Language>gipermatn gipermatnli hujjatning bir bo‘lagi. 
belgilash tili 7. Applet nima?
B) html formatdagi fayllami varatuvchi dasturlash A) matnning qismi boiib , boshqa fayl yoki 
tili ob’yektga yo‘l ko‘rsatuvchi hisoblanadi
Cj web-sahifalar yaratuvchi dasturlash tili B) bu HTML tilining tuzilishi yoki kontevner
D) Barcha javoblar to‘g‘ri C) bu elenwntning boshlang'ich va oxirgi belgilari

(markerlari) hisoblanadi. Teglar dementlarni bir-
3. HTML tilida teg nima? biridan ajratish va ta'sir doirasini belgilab beradi.
A) matnning qismi boiib . boshqa fayl yoki D) o ‘zining mustaqil prokrutkalariga ega boigan
ob’yektga y o l  ko‘rsatuvchi hisoblanadi gipermatnli hujjatning bir bolagi.
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8. Ski-ipt nima?
A) matnning qismi bo‘lib. boshqa fayl yoki 
ob’yektga yo‘l ko‘rsatuvehi hisoblanadi
B) bu HTML tilining tuzilishi yoki konteyner
C) bu elcmentning boshlang‘ich va oxirgi belgilari 
(markcrlari) hisoblanadi. Teglar elementlami bir- 
biridan ajratish va ta'sir doirasini belgilab beradi.
D) o ‘zining mustaqil prokrutkalariga ega boMgan 
gipermatnli hujjatning bir bo‘lagi.

9. Ko'chirib olish (DownLoad) nima?
A) web-sahifaning taikibiga kirib uning 
imkoniyatlarini kengaytirishga xizmat qiladi.
B) o ‘zining mustaqil prokrutkalariga ega bo'lgan 
gipermatnli hujjatning bir bo‘lagi.
C) mijoz kompyuteriga hujjatni serverdan ko‘chirib 
olish.
D) matnning qismi bo‘lib, boshqa fayl yoki 
ob’yektga yo‘l ko‘rsatuvehi hisoblanadi

10. Hujjatning asosiy qismi —  kodning qaysi 
qLsmida joylashadi?
A) <html> teglari orasida
B) <body> va </body> teglar juftligi orasida 
joylashadi
C) <title> tegida
D) <meta> tegida

31-§. Dreamweaver dasturida ishlash

Tayanch tushunchalar: obyektlar palitrasi, kod rejimi, dizayn rejimi, kodlar 
nazoratchisi, formatlash, WEB -  tugun, dastuming kutubxonasi, chiziqli struktura.

Dreamweaver dasturi nafaqat interfeysning tashqi ko'rtnishi yangilangani, 
balki radikal texnologik yangilangan, gipermatnli belgilash tili imkoniyatlari 
kengaygan. Unda Web-sahifa maketlarini yaratish uchun yangi ashyolar paydo 
bo‘ldi. Jumladan, tizimga Flash ob’vektlami qo‘yish buyruqlari qo‘shilgan, Web- 
uzellar bilan boshqarish va turli jamoaviy ishlami loyihalashda rivojlanishga imkon 
beradi. Endi Dreamweaver bilan batafsil tanishib chiqamiz.

Belgili kodlar bilan ishlash vositalari sezilarli darajada rivojlandi. Dastur 
ixtiyoriy murakkablikdagi dastlabki matn bilan ishlash uchun kuchli bazaga ega 
bo‘lgan gipermatnli dasturlashning toiaqonli qobig‘idir. Asosiy imkoniyatlarini 
sanab chiqamiz:
1) Hujjatning oynasi endi har xil rejimlarda ishlashi mumkin. Design View 
(Режим планировки) rejimi da. foydalanuvchi HTML sahifa maketini taxminan 
shunday ko'rinishda ko'rish mumkin. Code View (Режим разметки) rejimida esa 
hujjatning ovnasida belgili matn sahifasining barcha teglari, senariylari va izohlari 
tasvirlanadi. Dastuming bu rejimlari orasida kichik koordinatsiya mavjud. Kodlami

r> bu HTML tilining tuzilishi voki konteyner 
Г  bu elem entning boshlang‘ich va oxirgi belgilari 
/ m a r k e r l a r i )  hisoblanadi Teglar elementlami bir- 
b ^ d an  ajratish va ta’sir doirasini belgilab beradi.
D) o‘zining mustaqil prokrutkalariga ega bo‘lgan 
g ip erm atn li hujjatning bir bo‘lagi.

4 HTML tilida element nima?
Д ) niatnning qismi bo‘lib, boshqa fayl yoki 
o b  vektga vo‘l ko‘rsatuvehi hisoblanadi 
0 ) bu HTML tilining tuzilishi yoki konteyner 
О  bu elementning boshlang'ieh va oxirgi belgilari 
(m arkerlan) hisoblanadi. Teglar elementlami bir- 
biridan ajratish va ta’sir doirasini belgilab beradi 
9 )  o ‘zining mustaqil prokrutkalariga ega bo‘lgan 
gipermatnli hujjatning bir bo‘lagi.

5. HTML tilida giperbog‘Ianish nima?
A) matnning qismi bo‘lib. boshqa fayl yoki 
ob ’v e k tg a y o ‘ l ko‘rsatuvehi hisoblanadi
B) bu HTML tilining tuzilishi yoki konteyner
C) bu elementning boshlang‘ieh va oxirgi belgilari 
(m arkcrlari) hisoblanadi. Teglar elementlami bir- 
biridan ajratish va ta’sir doirasini belgilab beradi.
D) o'zining mustaqil prokrutkalariga ega bo'lgan 
gipermatnli hujjatning bir bo‘lagi
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o‘zgartirish maket modifikatsiyasiga, vizual rejimda rejalashtirish yoki formatlashga 
o‘zgartirish kiritish imkonini beradi;
2) Dreamweaver tizimi qobig‘iga barcha zaruriy qurilmalarga ega bo‘lgan 
tolaqonli kodlar tahrirlagichidan iborat dastur integratsiya qilingan. Unda HTML 
hujjatlarining dastlabki matnlari bilan ishlashni yengillashtiruvchi vositalar: kiritilgon 
teglaming sarlavhalari, turli kodlami rangli belgilash, tez qidinb topish vositalari aks 
etgan. Sintaktik noto 'gri loyihalami aniqlash, uzun qatorlami avtomatik ko'chirish, 
avtotuzatish rejimi yo‘lga qo‘yilgan. Dastur vositalari yordamida nafaqat gipermatnli 
sahifalami, balki matnli ko‘rinishga ega har qanday hujjatlami, dasturlar, senariylar, 
oddiy matnlar, XML belgili hujjatlar va boshqalami tahlil qilish mumkin.
3) Gipermatnlami belgilash kodlari bilan ishlashni ma'lumot paneli ancha 
soddalashtiradi. Bu dastur ichiga qurilgan interfaol ma’lumotnoma gipermatnli 
belgilash tilining barcha standart loyihalarini va u bilan bog‘langan vositalami: teglar, 
atributlar, iyerarxik stildagi o‘ziga xosliklaming deklaratsiyaliari (Cascading Style 
Sheet), Java Script tilining sintaktik loyihalarini qisqa va lo‘nda shaklda tavsiflaydi.
4) Java Script senariylar. Java Script dasturlash tilida yozilgan senariylardagi 
yashirin xatolami aniqlash imkonini beradi. Bu vosita nafaqat hozirgi vaqtda web- 
dasturlash sohasida qoilaniladigan ko‘p sonli analizatorlar uchun qiyin bo‘lmagan, 
sintaksis xatolami aniqlashga qodir. Kodlarni tuzatish vaqtida dastur ichiga qurilgan 
nazorat nuqtalari va qadamba-qadam bajariladigan dastur korsatmalari hamda 
o‘zgaruvchi laming holatini nazorat mexanizmlariga ega.

Dasturga kiritilgan yangiliklami qisqacha sanab o‘tamiz:
- iyerarxik stildagi o‘ziga xosliklar (CSS) bilan ishlash vositalari sezilarli darajada 
takomillashtirilgan.
- Dasturning dastlabki versiyalari Macromedia firmasi tomonidan ishlab chiqilgan 
(hozirda Adobe) Fire woks grafik muharriri ibilan Dreamweaver dasturining 
integratsiyasi yanada rivojlantirildi.
- yangi Assets (resurslar) palitrasi yaratildi. U dasturda bitta WEB -  tugunning bir 

necha sahifasi tomonidan birgalikda ishlatiladigan turli xildagi ma' lumotlaming 
bazasi vazifasini bajaradi. Bular tasvirlar, animatsiva roliklari, ranglar, senariylar, 
kutubxonalar va boshqalar bo'lishi mumkin. Saqlanayotgan resurslami turli 
sahifalaming talab qilinadigan sohalarida joyini o‘zgartirish (yoki surish) yoMi bilan 
joylashtirish mumkin.

Site Report (Отчет о сайте) buymg‘i loyiha holati haqidagi batafsil hisobotni 
hosil qiladi. Hisobot o‘ziga ko p sonli giperbogianishli hujjatlami biriktiradi:
- tahrirlagichga versiyalami va dasturiy ta'minotni yangilashni boshqarishni nazorat 
qilishning yetakchi dasturiy vositasi bo'lgan Microsoft Source Safe paketli 
integratsiya vositalari qo‘shilgan. Bu narsa Dreamweaver tizimini Internet uchun 
murakkab loyihalami ishlab chiquvchi jamoalar uchun asosiy uskuna sifatida 
qo‘llanilishiga asos bo‘ladi.
- dasturning bu versivasi WEBDav bayonnomasini to laqonli qo'llab-quvvatlaydi. Bu 
versiyalami boshqarish va taqsimlangan ishni tashkil qilish bobvicha kengaytirilgan 
imkoniyatlarga ega bo‘lgan klassik bayonnomasidir.
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- interfeysni standartlashtirish va sayqal berish bo'yicha katta ish qilindi. Ko‘pgina 
dasturlarnmg tashqi ko'rinishi noturg‘un palitralaming yagona kontseptsiyasiga 
asoslanadi. Muharriming oxirgi versiyasida palitralaming ko‘rinishi 
standartlashtirilgan. Ularning deyarli hammasi tarkibiy majmuaviy palitralarga 
birlashish imkoniyatiga ega boidilar. Oldingi versiyalaming ro'yxatga olishdagi 
ba’zi kamchiliklar bartaraf etildi.
- klaviatura kombinatsiyalari bir shaklga keltirildi. Ular web-dizavn uchun Adobe 
firmasi tomonidan ishlab chiqilgan, barcha dasturlash vositalari uchun umumiy 
bo‘lgan ichki standartga moslashtirilgan. Ichiga qurilgan boshqaruv tizimi yordamida 
tugmalaming har qandav tuzilishini o‘zgartirish mumkin.

Dasturni o‘rnatish va ishga tushirish. Tajribali foydalanuvchi dastumi 
o'matish jarayonida o‘zi uchun hech qandav yangilik ko'rmaydi. Distributiv diskda 
Dreamweaver Installer.exe (instalyator) favlini qidirib topish va ishga tushirish lozim 
(avto yuklanish boimagan holatda). Windowsning ko‘pchilik ilovalari kabi bu dastur 
bir necha bosqichda o‘matiladi. Ulaming har biri alohida muloqot oynasidan iborat. 
Dastumi o‘matishning asosiy bosqichlarini ketma-ket sanab oiamiz:

- Extracting Files (fayllami izlab topish). Bu bosqichda Dreamweaver tizimdagi 
qurilmalar va dastuming instalyatori ishlashi uchun zarur boigan fayllar arxivdan 
ochiladi. Bosqich foydalanuvchining aralashuvini talab qilmaydi.

- Welcome (Xush kelibsiz). Omatishning birinchi bosqichi boiib, unda 
foydalanuvchi tanlangan dastur va uni installyatsiva qilish qoidalari haqida asosiy 
ma’Iumotlami oladi.

- License Agreement (Litsenziya shartnomasi) Ikkinchi bosqichda litsenziya 
shartnomasi va muallifhing dasturiy mahsulotiga huquqlari bilan tanishish taklif 
etiladi. Foydalanuvchi taklif qilinayotgan majburiyatlami qabul qilishi yoki rad etishi 
kerak

- Dreamweaver Serialization (dastumi ro‘yxatdan o‘tkazish). Uchinchi bosqichda 
muloqot oynasi hosil boiadi, uning yordamida foydalanuvchining rekvizitlari va 
dastuming serial nomerini kiritish zarur boiadi.

- Choose Destination Location (joylashuv). Bu bosqichda dastumi o‘matish 
uchun disk va papkani olish zarur boiadi. Taklif qilinganidan farq qiluvchi manzilni 
ko‘rsatish Windows tizimi uchun standart boigan faol disk va papkani tanlash yoii 
bilan berish mumkin. Buning uchun Browse tugmasini bosish kerak.

- Default Editor o‘matishning bu bosqichida Dreamweaver dasturi keyin 
ishlatiladigan asosiy tahrirlash favllarini tanlashni taklif qiladi.

- Select Program Folder (Dastur papkasini tanlash). Bunda foydalanuvchi dastumi 
ishga tushiruvchi yorliq joylashgan papkani ko‘rsatishi kerak boiadi. 0 ‘matishning 
keyingi barcha operatsivalari foydalanuvchining aralashuvini talab etmaydi. 
Instalyator arxivlami ochadi. papkalar va kichik papkalar tizimini varatadi, unga ish 
uchun zarur boigan barcha fayllardan nusxa ko‘chiradi va ekranga gipermatnli faylni 
dastur imkoniyatlarining tavsifi, fovdali maiumotlar manbalari haqida qisqacha 
maiumotlar bilan chiqarib beradi.

Dasturni ishga tushirish. Paket ornatilgandan keyin Windows bosh 
menyusiga Dreamweavemi yuklash va unga tegishli fayllar maxsus boiimi



qo'shiladi. Har qanday holatda ham dastumi yuklash buyrug'i: Пуск > Программы > 
Adobe Dreamweaver > Dreamweaver ko'rinishida bo'ladi. Dastumi yuklashni bir 
nechta universal usullari mavjud. Bu bizga oddiy Microsoft Office paketi 
dasturlaridan ham ma’lum.

Interfeys. Dastur oynasi qismlari. Interfevs deganda informatikada 
dasturdagi turli komponentlar va foydalanuvchi o'rtasidagi o'zaro aloqani 
ta minlovchi vositalar va qoidalar yig'indisi tushuniladi. Dreamweaver paketi taklif 
etadigan muomala usuli zamonaviv foydalanuvchi uchun odatiy bo'lib qolgan grafik 
oynali interfey s printsiplariga asoslanadi. Dreamweaver paketi o‘sha sinfdagi boshqa 
dasturlar bilan taqqoslaganda ancha aniq, moslashuvchan va shu bilan bir pay'tda 
kuchli interfeys hisoblanadi. Palitralar, ko'p sonli klaviatura kombanatsiyalari va 
menyu qatori uning asosiy vositalari hisoblanadi. Barcha operatsivalar to‘xtatilgach 
ekranda qoladigan oynalami palitralari (Palette) yoki panellar (panel) deb atash qabul 
qilingan. Ekranning maxsus ajratilgan pozitsiyalarida emas, balki ixtiyoriv joyida 
joylasha oladdgan ovnalar ko'chib yuruvchi palitralar (floating plette) deb ataladi. 
Dreamweaver dasturi muloqot oynalarining ko'pchiligi ko‘chib yuruvchi palitralar 
ko‘rinishida ishlaydi. Palitralar va panellar orasidaga kichik farqlar dastumi tavsiflash 
uchun sezilarli ahamiyatga ega emas. Shuning uchun kelgusida bu atamalami 
sinonimlar sifatida qo'llaymiz.

Deyarli barcha palitralar birlashish xususiyatiga ega Bu har xil palitralami 
bitta muloqot oynasida joylashtirish mumkinligini bildiradi. Birlashtirish amali turli 
mavzu yoki buyruqlarga tegishli boshqaruv vositalariga ega bo'lgan ko‘p funktsiyali 
terma palitralami olish imkonivatini beradi. Birlashish xususiyatiga ega bo'lgan 
palitralami (uJar dasturda ko'pchilikni tashkil etadi) modulli (dockable) palitralar deb 
ataymiz. Bir nechta alohida modullardan iborat murakkab palitralar terma (tabbed) 
palitralar deb ataladi.

Boshqaruvning eng talab qilinuvchi vositasi so'zsiz, Properties inspector 
(xossalar nazoratchisi) palitrasi hisoblanadi. Uning yordamida HTML sahifalarida 
ob’yektlami formatlash va HTML sahifasidagi ob’vektlami tahrirlash bo'yicha 
ko'plab amallar bajariladi. Behavieros (rejimlar) palitrasi -  bu modul ko'chib 
yuruvchi palitraga misol bo'ladi. Dreamweaver dasturi turli loyiha masalalarini hal 
qilishga mo'ljallangan ob yektlarga ega.

Objekts palitrasi tashqi ob’yektlar: rasmlar, jadvallar, qatlamlar, freymlar va 
boshqa ob’yektlami qo'yish uchun mo'ljallangan. Boshqa barcha boshqaruv 
elementlari hujjat ovnasining ajralmas tashkil etuvchi qismi hisoblanadi. Texnik 
tizimlaming ishonchli ishlashi, dasturiy mahsulotlami interfeyslarining qulayligi 
asosida to'g'ri tashkil qilingan. Dreamweaver paketi formatlash va tahrirlashning 
dey arli barcha asosiy buy ruqlari uchun amaJga oshirishning bir necha xil usullarini 
taklif etadi. Keng formatli ekranlaming egalari barcha buyruqlami palitralar va 
panellar yordamida bajarishlari mumkin. Bundan mahrum foydalanuvchilarga esa 
dastur menyu qatori buyruqlarmi va klaviatura tugmalari kombinatsiyalaridan 
foydalanishadi.

Hujjat oynasi. Hujjat oynasi -  bu gipermatnli hujjatlar yaratiladigan ish 
maydoni hisoblanadi. U HTML sahifasi o'z ichiga olgan matnlar, rasmlar, jadvallar,
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shakllar va boshqa ob'yektlami saqlaydi. Dreamweaver, WYSIWYS sinfiga kiruvchi 
tahrirlagich dastur hisoblanadi. Bu u/.un atama inglizcha What you see is what you 
get (siz nimani ko‘rayotgan bo‘lsangiz shuni olasiz) iborasining bosh harflaridan 
tuzilgan. Bu narsa HTML sahifasining hujjat oynasida aks ettirilishi uning vanada 
ommaviyroq ko'rib chiqish dasturlari -  Microsoft Internet Explorer va Netscape 
Navigator brauzerlarida ifodalanishidan uncha farq qilmasligini bildiradi. HTML 
kodlari bilan to^ridan -to^ 'ri ishlash yuqori professionallik hisoblanishiga qaramay, 
hatto eng tajribali WEB -dizayner ham grafik interfeys va WYSIWYG rejimida 
hujjat уaratishda beradigan qulayliklardan voz kecha olmaydi.

Ko‘pchilik Windows ilovalaridan farqli ularoq Dreamweaver dasturi bitta 
dastur oy nasida bir necha hujjatlar bilan ishlay olmaydi. Tanlab olingan parametrlami 
o'matishdan kelib chiqib yangi hujjat dasturning alohida oynasigajoylashtiriladi yoki 
joriy oynada avval ochilgan hujjat o'mini egallaydi. Bunday ish rejimida dastur 
oynasi va hujjat oynasi orasida devarli farq yo‘q. Shuning uchun ham biz kelgusida 
bu nomlami sinonimlar sifatida ishlatamiz.

Ish rejimlari. WYSIWYG rejimida gipermatnli hujjat yaratish oddiy matn 
muharriri bilan ishlashdan ko p farq qilmavdi. Matnni kiritish va formatlashning 
bazaviv amallari, ob'yektlami joylashtirish buvruqlari, navigatsiva va tanlash 
texnikasining barcha amallari Dreamweaver dasturida so'nggi bir necha yil davomida 
vizual muhitda ustunlik qilish usulida amalga oshirib kelinmoqda. Foydalanuvchi 
lovihalash yechimlarini HTML tili vositalari tomonidan qanday yo iga  qo‘yilishi 
haqida o‘ylab o‘tirmasdan tahrirlash va formatlashning odatdagi vositalaridan 
foydalanib ishlashi mumkin. Dreamweaver paketi dastlabki matnni avtomatik 
ravishda varatadi, unda hujjatning malumot bilan toMdirilishi va ro‘vxatga olinishi 
bilan gipermatnni belgilash tilining kodlari yoziladi.

Yaratuvchanlik ishining katta qismi WYSIWYG rejimida bajarilishi 
mumkinligiga qaramay ba'zan to‘g‘ridan-to‘g‘ri kodlashga murojaat qilishga to‘g‘ri 
keladi. Buning bir nechta sababi bor. Asosan, bu belgilash kodlarini juda 
ehtiyotkorlik bilan sozlash zarurligidir. Bundan tashqari HTML tili standartida 
yuzdan ortiq teglar haqida eslatib otiladi, ulaming har biri bir nechta atributlar va 
modifikatorlarga ega bo‘lishi mumkin. Gipermatnli belgilashning eng ko’p talab 
qilinadigan vositalari Dreamweaver tizimi mterfeysi doirasidajoylashtirilgan.

Dreamweaver dastunning hamma versivalari, birinchisidan boshlab. 
foydalanuvchiga belgilash kodlarini to‘g‘ridan'to‘g‘ri tahrirlash imkonini beradi. Bu 
ish uchun qanday vositalar qo llaniladi?

Birinchidan, bu maxsus ichiga qurilgan Code Inspector (kodlar inspektori) 
tahrirlagich bo'lib, u Dreamweaver dasturini eng birinchi versiyalarida ham mavjud 
edi va bu oxirgi versiyalarda vaqt davomida faqatgina dizayniga o'zgartinshlar 
kiritildi. Ikkinchidan. foydalanuvchi HTML tiliga tashqi tahrirlagichlami ulash 
imkonivatiga ega. Turli dasturlar: universal vazifali (masalan. Bloknot) oddiy matn 
tahrirlagichlaridan boshlab, to murakkab gipermatnli hujjatlar bilan ishlashga 
mo‘ljallangan (Allaire Home Stile) yuqori darajali dastur vositalarigacha bu rolni 
bajarishi mumkin. Dastur juda qulay yangilik -  hujjat oynasining ish rejimi pavdo 
bo‘ladi. Hujjat oynasi uchta rejim yoki ko^rinishlardan birida bo‘lishi mumkin.
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Belgilash rejirrudagi hujjat oynasi Code and View (belgilash va rejalashtirish 
rejimi). Bu aralash rejim bo‘lib, unda hujjat oynasi ikkita qismga boiinadi. Bir 
qismda gipermatnli belgilash kodlari aks etadi. boshqasida dastur sahifani barcha 
ob’yektlar va formatlash atributlari bilan rejalashtirishni korsatadi.

Ish rejimini o‘zgartirishning bir necha usuli bor. Birinchidan, bu menvu qatori 
buvruqlari: View' > Code, View -  Design, View -  Code and Design. Ikkinchidan, 
uskunalar panelida bir rejirrudan boshqasiga tez o'tish imkonini beruvchi tugmalar 
bor. Ctrl + Tab tugmalar kombinatsiyasi yordamida rejalashtirish rejimidan belgilash 
rejimiga va aksincha yoki ajratilgan oynaning bir qismidan boshqasiga o‘tish 
mumkin.

Ajratilgan hujjat oynasi qismlarining o‘lchamlarini o‘zgartirish mumkin. 
Buning uchun ko’rsatkich yordamida ajratuvchi chiziqni ko'chinsh kerak boiadi. 
Oxirgi paytlarda dasturchilar orasida «dastlabki matn» atamasi pay do boidi. Yuqori 
saviyali dasturlash tilida yozilgan dastur ishlab chiqishning dastlabki bosqichlarida 
shunday deb ataladi. Bu atama gipermatnli hujjatning kodli qismi va kobrinadigan 
obrazi o‘rtasida mavjud boigan munosabatlardan tashkil topadi. Hujjatning HTML 
tilida yozilishini dastlabki matn deb ataymiz.

Menvu qatori. Menyu qatori -  bu Windowsning ixtiyoriv llovasining zaruriy 
atributidir. U buyruqlar yordamida, muloqot oynalariga, tugmalarga y o i ochadi, ular 
yordamida hujjat yaratish, dastumi sozlash, vizuallashtirish jarayonini boshqarish 
kabi dastuming barcha funktsional imkonivatlarini o‘z ichiga olgan samarali ishlar 
bajariladi. Menyu qatorining har bir bandi vazifasi jihatidan bir-biriga yaqin kiritilgan 
menyu va kichik menyular iverarxiyasini hosil qiluvchi buyruqlar guruhini 
birlashtiradi. Bu bandlaming qisqacha tavsifini keltiramiz.

• File menyusi (Файл) fayllar bilan bogiiq buyruqlami, gipermatnli hujjatlar 
shablonlari bilan ishlash, eksport qilish, import qilish va brauzer dasturlarida ko nsh 
buyruqlarini o‘z ichiga oladi.

• Edit (Правка) menyusiga tahrirlash va qidirish bilan bogiiq buyruqlar kiradi.
• View (Вид) menyusi interfeysning yordamchi elementlarini va gipermatnli 

hujjat ob'yektlarining ko rinishlari ustida ishlovchi buyruqlami o‘z ichiga oladi.
• Insert (Вставка) menyusiga har-xil ob’yektlami import qilish buyruqlari kiradi: 

rasmlar, jadvallar, shakllar, qatlamlar, maxsus belgilar va boshqalar.
• Modify (Изменить) menyusi o‘z ichiga gipermatnli hujjat obyektlari 

atributlarini o‘zgartirish buyruqlarini oladi.
• Text (Текст) menyusi matnli fragmentlami hosil qilish va ulami formatlash 

bilan bogiiq buyruqlami o‘z ichiga oladi.
• Commands (Команды) menyusi gipermatnli hujjatlami avtomatik qayta ishlash 

buyruqlarini o‘z ichiga oladi.
• Site (Сайт) menyusi sayt bilan ishlash vositalari va gipermatnli hujjatlar bilan 

bogiiq murakkab tizimlar vositalarini obz ichiga olgan.
• Window (Окно) menyusi dasturga tegishli palitralar. panellar va muloqot 

oynalarini ornatish va aksincha olib tashlash bilan bogiiq buyruqlami o‘z ichiga 
oladi.
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Help (Справка) menyusida dasturdan foydalanish haqidagi interfaol 
ma'lumotlami chaqirish, elektron qo‘llanmani chaqirish kabi buyruqlar jovlashgan.

Uskunalar paneli Uskunalar paneli dastuming asosiy dispetcherlik pulti 
vazifasini bajaradi. U eng ko'p ishlatiladigan buyruqlar va tahrirlash resurslarini 
chaqirish tugmalarini birlashtiradi. Bu ixchamgina panel kiritilgan menyu va kichik 
menyular tizimi navigatsiyasi bilan bog'liq sarf-harajatlami anchagina qisqartiradi. 
Unda jovlashgan barcha boshqaruv elementlarini sanab o'tamiz (chapdan o‘ngga):

. Code View (Режим разметки) - gipermatnli hujjatning faqat belgili kodlari 
tasvirlanadi (dizayni tasvirlanmaydi).

. Code and Design View (Режим разметки и планировки). Tugmasi 
bosilganda hujjat oynasi ikki qismga ajraladi: birinchi oynada belgili kodlar beriladi, 
ikkinchi ovnada esa gipermatnli sahifaning dizayni, ya'ni tashqi ko'rinishi beriladi.

. Design View (Режим планировки). Dasturda ishlashning vizual -  
WYSIWYG rejimiga o'tish tugmasi.

. Title (Заголовок) -  bu matnli maydon hujjatning sarlavhasini kiritishga 
mo'ljallangan.

. File Management (Управление файлами) -  tarmoqda ma lumot almashish 
uchun xizmat qiladigan fayllar bilan ishlash buyruqlaridan tarkib topgan menyuni 
ochish tugmasi.

. Preview/Debug in Browser (Просмотр/отладка в браузере) -  tugmasi 
gipermatnli hujjatni ko'rish va undagi Java Script kodlarini tanlangan brauzerda 
ishlash yoki ishlamasligini tekshiruvchi buyruqlaridan iborat menyuni ochadi.

• Refresh Design View (Обновить страницу) -  bu buyruq berilgandan so'ng, 
hujjatning belgili matnlarida bo'lgan barcha o'zgarishlar loyihalash rejimiga 
uzatiladi. Ana shu vaqtda kodlami interpritatsiyasi va sintaktik tekshiruv boshlanadi. 
Xato fragmentlari sariq rangda ko'rsatiladi. To'g'rilari esa sahifada tasvirlanadi.

• Reference (Справка) -  tugmasi elektron ma’lumotli qo'llanmani ekranga 
chiqarib beradi. Bu qo'llanmada gipermatnli belgilash tili deskriptorlari ifodalangan.

• Code Navigation (Навигация по кодом) -  tugmasi Java Script tilida yozilgan 
belgili kodlami tuzatishni boshqaruv buyruqlaridan tarkib topgan menyuni ochadi.

• View Options (Параметры отображения) -  tugmasi hujjat oynasining 
qo'shimcha elementlari vizualizatsiyasini boshqaruvchi buyruqlar menyusini ochadi. 
Bu menyuga asosiy menyu qatoridagi View menvusining bir necha buyruqlari kiradi.

Sahifalar o‘lchamlarini belgilash. Virtual to'plam hech qanday tartib- 
qoidalarga va standartlarga bo'ysunmasdan, tarqoq holda rivojlanadi. Bu esa ishlab 
chiquvchilar va dasturchilar uchun ko'p sonli qiyinchiliklar manbai bo'lishi «Internet 
almashuvi»ning juda tez o sishi sabablaridan biridir. Aslida sahifaga yoki saytni 
ishlayotganda muallif o'z asarini turli kompyuter tizimlarida aks etishi mumkinligini 
yodda tutishi kerak. Agar u tashnf buyuruvchilarini (foydalanuvchilarini) yo'qotishni 
istamasa. u holda har xil o'lchamli va har xil texnologiyalami qo'Ilovchi (elektron- 
nur trubka bazasida bo'lishi shart emas) monitorlarda hujjatning aniq va qisqa 
ifodalanishi haqida o'ylab ko'rish kerak. Onlaynli hujjatlami ko'rib chiqishda brauzer 
oynasi o'lchamlarini o'zgartirishga majbur qiluvchi boshqa sabablar ham bor. Har bir 
savodli inson o'qish tezligi boshqa sabablardan tashqari qator uzunligiga ham



bogiiqligini tushunadi. Agar qatorlar biror meyyordan sezilarli farq qiiSa 
o'qilganning qabul qilinishi murakkablashadi. Psixologik tadqiqotlar ko‘rsatishicha, 
matn qatorining optimal uzunligi alifbo simvollari soni bilan uzviy bog‘liq. Qulay 
o‘qish zonasini aniqlash uchun alifbo oichamini 1,5 dan 2 gacha qivmatni qabul 
qiladigan koeffitsiyentga kopaytirish kerak. Bu narsa rus tilida matn qatorlari 7o 
simvoldan uzun boimasligini bildiradi. Ko‘p fovdalanuvchilar bunday formulaning 
mavjudligi haqida o‘ylab ko rmaydilar va haddan tashqari uzun qatorlar paydo 
boiishining oldini olish uchun brauzer oynasining oichamlarini cheklab qo‘yadilar.

Dreamweaver paketini yaratuvchilari dastumi turli o‘lchamdagi monitorlarda 
hujjat qandayr korinishga ega bo‘lishini tasavvur qilish imkonini beruvchi maxsus 
vosita bilan ta’minlab qo'yganlar.

Holat qatorining o‘rta qismida hujjat oynasining joriy oichamlari piksellarda 
chiqariladigan maydon joylashgan. Birinchi son-kenglik qiymatini, ikkinchi son 
balandlikni oichamini ifodalaydi. Agar may donning ixtiyoriy nuqtasida sichqoncha 
tugmasini bosilsa, u holda Windows va Macintosh platformalarida hisoblash 
tizimlarining eng ommaviy konfiguratsiyalari uchun yettita standart oMchamga ega 
boigan muloqot oynasi chiqadi. Oichamni belgilash uchun oynaning tegishli 
qatorini tanlash yetarli.

Menyuning birinchi bandi hujjat sohasining 592 pikselga teng boigan 
kengligini belgilaydi va sohaning joriy balandligini o‘zgarishsiz qoldiradi. Edite 
Sizees (Oichamlami to‘girlash)ning oxirgi bandi hujjat oynasining oichamlarini 
tanlash va ulami standartlar ro‘yxatiga kiritish imkonini beradi. Ekranda Preferences 
(Sozlashlar) muloqot oynasi paydo bo'ladi, unda Width (kenglik, eni) maydonida 
kenglik, Height (balandlik) maydonda esa soha balandligi belgilanadi. Yangi 
standartning matnli tavsifi Description (tavsiya) maydonida ko‘rsatiladi.

Barcha o‘lchamlar dastur oynasining xizmat elementlarini: oichov chiziqlari 
va menyu qatorini inobatga olmasdan hisoblab chiqiladi. Faqatgina hujjat va uning 
ob’yektlari uchun ajratilgan ishchi soha hisobga olinadi.

Palitra va tez yuklanish paneli. Tez ishga tushirish palitrasi (Launcher) -  bu 
asosiy muloqot oynalari va dasturlar panellarini ekranga chiqarish uchun 
moijallangan vordamchi, xizmatchi palitra Palitrani aks ettirish uchun Windows > 
Launcher buyrugini bajarish kerak. Bu buyruqning takroran bajarilishi palitrani 
ekrandan olib tashlavdi. Palitraning Launcher (tez ishga tushirish) tugmasini bosish 
natijasida ekranga shu nomdagi muloqot oynasi chiqadi. Agar ochilgan palitra 
ekranning oldingi qavatida joylashgan b o isa  buymq tugmasini takroran bosish uni 
yopilishiga olib keladi. Agar faol palitra hech boimaganda qisman boshqa ob yektlar 
bilan to^ilgan b o isa  u oldingi qavatga oiadi.

Palitra yettita eng ko‘p talab qilinadigan dastur komponentlarining tez ishga 
tushirish tugmalarini birlashtiradii:

Site (Сайт) -  katta saytlami boshqarish uchun muloqot oynasi, murakkab 
kesishuvli bogianishlarga ega gipermatnli hujjatlar tizimi uchun.

• Assets (Библиотека) -  bu nom harfma-harf taijimada faollar yoki fondlar 
ma'nolarini beradi. Bu panel dasturda kutubxona rolini o‘ynaydi. U gipermatnli

204



hujjatlar dizayniga tegishli elementlami o‘zida saqlavdi. Bu elementlarga: tasvirlar, 
ranglar, tashqi boglanishlar, Flash -  roliklari, shablonlar va boshqalar kiradi.

. HTML Styles (Стили HTML) -  bu palitra matnli qator va hoshivalar uchun 
HTML belgili stillar bilan ishlashga moijallangan.

. CSS Styles (Каскадные листы стилей) -  bu palitra stillami kaskadli sahifalar 
bilan boshqarish uchun xizmat qiladi. Keyinchalik bu jumlani «iverarxik stillar 
spetsifikatsiyasi» kolinishida ham qollaymiz.

.  B ehaviors (Режимы) -  palitrasi gipermatnli sahifalarni interfaolligini 
boshqarish vositalanni o‘zida birlashtirgan. Senariy sahifani ko‘rish jarayonida ro‘y 
beradigan hodisalar asosida quriladi. Bu jarayonning chizmasida ko‘plab interfaol 
e f f e k t la r  yig'iladi: oddiy animatsivalashgan tugmalardan tortib ma iumotlar bazasini 
qayta ishlashning murakkab protseduralarigacha.

. History (Предыстория) -  palitrasi foydalanuvchining HTML hujjatni 
tahrirlashdagi hatti-harakatlarini yozib boradi va saqlaydi. Tahrirlash jarayonidagi 
operatsivalami bekor qilish imkonini beradi va ayrim zanjirli ketma-ketliklami 
buyruq ko‘rinishida saqlaydi.

. Code Inspector (Инспектор кода). Dastuming eng muhim palitralaridan biri. 
Dreamweaveming grafikli rejimiga HTML kodining ichki tahrirlagichi o‘zaro 
bog‘langan.

Tez ishga tushirish palitrasining o‘ng tomondagi pastki burchagida to‘g‘ri 
buichakli tugma joylashgan. Bu vosita palitraning yo‘nalishini o‘zgartirishga 
moijallangan. Tez ishga tushirish palitrasini obzgartirish mumkin. Buning uchun Edit
> Preferences buyrug'ini berish kerak. Dastuming asosiy sozlashlariga ega boigan 
muloqot oynasi ochiladi. Unda Panels (panellar) kategoriyasini tanlab oling va 
palitra ichidagi Show in Launche (tez ishga tushirish palitrasida ko‘rsating) bolimida 
beriladigan (holat qatorining o'ng qismida joylashgan) vositalar yordamida 
o‘zgartiring.

Property Inspector palitrasi. Property Inspector (Инспектор свойств) 
palitrasi -  bu dastuming asosiy uskunasidir. HTML sahifasida joylashgan ob yektlar 
atributlarini o'zgartirish ishlarining asosiy qismini uning yordamida bajariladi.

Property Inspector palitrasi ko'chib yuruvchi palitradan iborat boiib, uning 
tarkibi bajarilayotgan operatsiyaga, tanlangan ob’yekt turiga va kursorning holatiga 
qarab, mos ravishda o‘zgarib turadi. Palitrani ekranga chiqarish uchun quyidagi 
Window > Properties (Окно > Свойства) buyruglni berish yoki CTRL+F3 tugmalar 
kombinatsiyasini bosish kerak. Bu buymqni qaytadan berish palitrani ekrandan olib 
tashlaydi.
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7.2-rasm. Property Inspector palitrasi 
Palitraning asosiy maydonlari va tugmalarimi sanab o‘tamiz. PaJitraning shu 

boshqaruv elementlari matnni formatlash va gipermatnli bogManishlami hosil 
qilishga tegishli vazifalami o‘z ichiga oladi:

• Format (Формат) ro'vxati matnning standart strukturali tiplaridan birini 
tanlash imkonini beradi ( 1).

• Link (Ссылка) ro'yxati ushbu hujjatga tegishli giperbogianisihlar royxatini 
o'zida saqlaydi. Har bir bog‘lanishni bir necha marta qoMlash mumkin. Ya’ni bir 
marta tuzilgan bogManishni, boshqa faol hududlarga ham takror qo‘lJash mumkin (2).

• Matn fragmentini shriftini belgilash imkonini beradi. Bu ro'vxatning punktlari 
shriftlar to‘plamidan iborat bo‘lib ular qoMlanilishiga qarab jovlashgan (3).

• Size (Размер) ro'vxati shrift oMchamini tanlash uchun moljallangan (4).
• Standart ranglar palitrasini chaqirish tugmasi. Bu palitra tanlangan mamli 

fragment rangini tanlash imkonini beradi (5).
« Tanlangan rangning kodi tasvirlangan yoki kiritiladigan may don (6).
• Shriftni tanlash tugmasi Ko‘rinishi va funktsiyasi standart boshqa 

dasturlardagidek (7).
• Matnni tekislash tipini tanlash tugmalari (8).
• Interfaol yordamni chaqirish tugmasi (9).
• Marker-ko'rsatkich. Uni tegishli fayl yoki simvolga surish bilan gipermatnli 

bogManish hosil qilinadi (10).
• Select File (Выбрать файл) muloqot oynasini ochish tugmasi. Fayllar tizimida 

harakatlanish va gipermatnli bogManishlami asosi boMib xizmat qiladigan hujjatni 
tanlash(ll).

• Target (Назначение) ro‘yxati gipermatnli bog lanishda korsatilgan hujjatni 
ekranda yuklanish usulini tanlash imkonini beradi. Shu boMimda havolali hujjat 
chiqish oynasi yoki freymni belgilanadi ( 12).

• Ko‘pchilik tahrirlagich dasturlarda standart ko'rinishda, matnli va HTML 
ro‘yxatlami belgilash va nomerlash tugmasi (13).

• List Item (Раздел списка) tugmasi List Properties (Свойства списка) muloqot 
oynasini ochish uchun ishlatiladi. Bu oyna barcha tipdagi ro‘yxatlami tahrirlashga 
mo'ljallangan (14).

• Ikkita tugma, matnli fragmentlami gorizontal surilishini boshqaradi (15).
• Kodlami ekspress-tahrirlash oynasini chaqirish tugmasi (16).
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. Expander arrow (Расширение) palitra o‘lchamlarini o'zgartirish uchun xizmat 
qiladi. Uning yordamida Property Inspector (Инспектор свойств) palitrasini ochish 
vayopish mumkin (17).

Property Inspector paneli yordamida bajariladigan buvruqlaming ko‘pchiligi 
qayta ishlanayotgan ob’yektlar: rasm matn yoki jadvallarga tegishlilari pavdo 
boiadi. Xossalar panelida harakatlanish uchun TAB tugmasini bosish yoki kerakli 
qismga sichqonchani chap tugmasini bosish kerak. Tanlangan bolimda kerakli 
ko'rsatkichni kiritib, ENTER tugmasini bosish uni o'matilishi uchun yetarli.

Property Inspector panelining ko‘plab boshqaruv elementlari o‘zida matnli 
voki raqamli maydonlar kombinatsiyasi va bekiladigan ro‘yxatlaridan iborat. 
So‘ralgan qh matni klaviaturadan terish yoki menyudan tanlash yo‘li bilan tegishli 
parametrlami o rnatish uchun eng qulay usul hisoblanadi.

Dreamweaver o'zining bir qancha qo‘shimcha funktsiyalari bilan 
foydalanuvchilarga manzur bo'ldi: birinchidan, Dreamweaver barcha palitralari erkin 
holatda turadi. Ulami qayerga surib qo‘ysangiz o‘sha jovda jovlasha oladi. Bu esa 
monitoming ish maydoni hududini boshqaruvning xizmatchi elementlari va 
hujjatning ovnasiga eng optimal boiish imkonini beradi. Ikki monitorli tizimda 
ishlaydigan foydalanuvchilar barcha vordamchi oyna va palitralami bitta monitorga 
joylab, ikkinchisida esa hujjatlar bilan ishlashi mumkin. Ikkinchidan, dastur 
palitralari birlashish xususiyatiga ega Uchinchidan, barcha ochiq palitralami dastur 
ish stolidan olib tashlovchi buyruq mavjud. Bu operatsiyalami F4 tugmasini bosish 
bilan ham bajarish mumkin. Bu tugmani takror bosish esa yana tiklash imkonini 
beradi.

Ob’yektlar palitrasi. Faqatgina eng oddiy gipermatnli hujjatlar o'zida havola 
bo‘yicha boshqa hujjatlarga o‘tuvchi buy ruqlar biriktirilgan gipermatnli fragmentlami 
birlashtiradi. Ammo ko'pchilik zamonaviy HTML sahifalari multimedialashib 
bormoqda. Ya’ni ularning tarkibiga quyidagi tashqi ob’yektlar kiradi: multimediali 
fayllar, ijro etish vositalari, kartinkalar. animatsiya favllari va boshqalar. Objects 
(Палитра объектов) palitrasi ana shunday tashqi ob’yektlami yaratish va qo‘yish 
uchun xizmat qiladi Bu palitrani ekranga chiqarish uchun Window > Objects (Окно
> Объекты) buyrug‘ini bajarish kerak. Xuddi shu buyruqni klaviaturadan CTRL+F2 
tugmalar kombinatsiyasini bosish bilan ham berish mumkin. Bu buyruqni takror 
berish palitrani ekrandan olib tashlavdi. Palitra yettita nomdagi qismlardan iborat. 
Bular. Characters. Common, Forms, Frames, Head. Invisibles, Special.

• Characters (Специальные символы). KJaviaturada uchramaydigan maxsus 
simvollami qo'yish (savdo markasi, kopirayt va boshqalar).

• Common (Общие) -  bo‘limi eng ko'p qo‘llaniladigan ob’yektlami birlashtiradi. 
Bu jadvallar, rasmlar, gorizontal chizg‘ich, joriv kalendardagi sanalar va boshqalar.

• Forms (Формы). Formalar va elementlar, ulaming tashkil qiluvchilari: yoqib- 
o‘chiruvchilar, ro‘yxatlar. matn maydonlari va boshqalar.

• Frames (Фреймы). Freymlar tizimini yaratish. Har xil ko‘rinishdagi freymlar 
qismlaridan tarkib topgan freymlar tizmini hosil qilish. Ya’ni yaratilayotgan saytni 
sahifasini freymlarga bo‘Iib olish.

• Head (Заголовок) -  gipermatnli hujjatning sarlav ha qismiga tavsif berish.
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• Invisibles (Скрытые объекты). HTML sahifani brauzer dasturlarida namoyish 
qilishda, ko‘rinmaydigan yashirin ob'yektlami joylash. Bu palitraning eng kichik 
qismi bo‘lib, u faqat uchta tipdagi ob'yektlami qo‘shib beradi: simvollar, izohlar va 
senariylar.

• Special (Специальные объекты) -  bu bo lim o'zida maxsus ob'yektlami 
qo vish tugmalarini birlashtiradi. Bularga appletlar, ActiveX ob’yektlari va boshqa 
tashqi toMdiruvchilarni (plagins) kiritish mumkin.

Palitraning pastki qismida ikki guruhga bo;lingan to‘rtta tugma joylashgan: 
Layout (Компоновка) va View (Вид). Ular maketfash rejimiga o‘tish va sahifannig 
strukturasini tezda yaratishga imkon beradi. Bu elementlar bilan qisqacha tanishib 
o‘tamiz:

• Draw Layout Cell (Создание макетной ячейки) -  maketli katakcha yaratish 
uskunasini faollashtiradi.

• Draw Layout Table (Создание макетной таблицы). Maketli jadval yaratish 
uskunasini faollashtiradi.

• Standard View (Стандартный режим). Hujjat bilan ishlashning standart 
rejimiga oktish.

• Layout View (Режим макетирования) -  Hujjatni maketlash rejimiga o'tish.
Ushbu bo‘limni nomi palitra sarlavhasi qatori ostida tasvirlanadi. Bo limni

ochish uchun shu nomni sichqoncha chap tugmasi bilan bosing. Ochilgan menvudan 
foydalanuvchi kerakli qismni tanlash mumkin. Palitraning ayrim bo‘limlarida hamma 
tugmaliar ham tasvirlanmaydi. Masalan, Common (Общие) bo4imi yigirmaga yaqin 
tugmani o‘z ichiga oladi, ulaming hammasi ham palitra oynasiga sig'maydi. Boshqa 
tugmalami ko‘rish uchun prokmtkadan foydalanish (prokmtkani vazifasini 
palitraning chetida joylashgan strelkali tugraalar bajaradi) yoki muloqot oynasining 
o‘lchamini kattalashtirish kerak.

Aksariyat hollarda ob’yektlami qo‘yish uchun qo‘shimcha parametrlami 
kiritishga to‘g‘ri keladi. Bunday holatlarda ekranda foydalanuvchi tanlashi yoki 
ma lumot kiritishi mumkin bo igan muloqot oynasi paydo boMadi. Bu oynaga 
foydalanuvchi ob yektning kerakli ob’yektlarini tanlashi yoki kiritishi kerak.

Kodlar nazoratchisi bilan ishlash. Ko‘p sonli HTML tahrirlagichlari sinfi 
orasida Dreamweaver dasturi gipermatnli hujjatlar kodlari bilan ishlash imkoniyatlari 
jihatidan keskin farq qiladi. Foydalanuvchining HTML kodlami qo‘lda tahrirlashdan 
qutilishi eng kattayutuq va tezkorlikni ta’minlab beradi.

Kodlar bilan to‘g‘ridan-to‘g‘ri ishlash, yashirin xatolami identifikatsiya qilish, 
ortiqcha kodni bartaraf etish, gipermafinning tanlangan fragmentiga tezkor 
o'zgartirish kiritish, hujjatning strukturasini yoki uning formatlanishini 
optimallashtirish imkoniyatlari mavjud.

Dreamweaver paketi tarkibida gipermatnli hujjatlami belgilash kodlarini 
ko‘rish va tahrirlashga mo‘ljallangan maxsus vositasi mavjud. Bu vosita Code 
Inspector (Инспектор кода) deb nomlanadi. Uni quyidagi usullar bilan omatish 
mumkin: birmchidan, Window > Code Inspector (Окно > Инспектор кода) 
buvrug‘ini berish yo‘li bilan, ikkinchidan, bu F10 tugmasini bosish yo‘li bilan. Bu 
buyruqlar takror bosilganda Code Inspector yana ish stolidan yo‘qoladi.
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Kodlami nazorat palitrasida kodlaming belgilanishini tanishtirishni View 
Options (Параметры отображения) tugmasi yordamida ochiladigan buyruqlar 
boshqaradi. Bu buyruqlami ko‘rib chiqamiz:

, Word Wrap (Перенос по словам). Kod qatorini ko‘chirish rejimi. Agar u 
voqilgan bo'lsa, HTML tili bayonnomasi tahrirlagich oynasining o‘lchamiga 
vetganda avtomatik ravishda yangi qatorga o tadi.

. Line Numbers (Номера строк) -  nomerlashni o‘matish buyrug‘i. Agar bu rejim 
o'matilgan bo'lsa, har bir qator tartib bilan nomerlanadi.

. Highlight Invalid HTML (Пометка некорректных кодов). Bu buyruq sintaktik 
xatoga ega konstruktsivalami Property Inspector panelida va hujjatning oynasida 
sariq rangda ajratish rejimini faollashtiradi. Shundan so‘ng Property' Inspector xato 
haqida xabar beradi va ayrim hollarda uni tuzatish uchun ko‘rsatmalar beradi.

. Sy ntax Coloring (Раскраска синтактических конструкция). Bu rejimda belgili 
kodlar turli xil ranglarda ajratiladi. Bu esa hujjatning kiritiladigan matni va belgili 
kodlarini tez ajratib olishga imkon beradi. Bundan tashqari Dreamweaver dasturi 
HTML tilining har bir tegi uchun alohida rang belgilash imkoniyatiga ega. Ranglami 
belgilashning asosiy ko'rsatkichlarini Code Colors (Цвета кода) boMimida amalga 
oshiriladi.

. Auto Indent (Автоматические отступ) buyrug‘i kodlar nazoratchisi oynasiga 
kiritilgan belgilash teglari uchun avtomatik joy qoldirish rejimini faollashtiradi.

Kodlar nazoratchisi oynasining o‘ng qismida uchburchak formada tugma 
joylashgan. U hujjatning mavjud matnlariga xizmat qiladigan buyruqlardan iborat 
menyuni chaqiradi. Bu buyruqlami sanab o'tamiz:

. Find and Replace (Найти и Заменить). Qidirish va almashtirish vazifasini 
bajaradi.

. Find Next (Найти Далее). Avval qidirilgan namunani mavjud parametr asosida 
qidirish. Bunda qidirish va almashtirish muloqot oynasi chiqmasdan to‘g‘ridan-to‘g‘ri 
amalga oshiriladi.

• Reference (Справочное руководство). HTML, JavaScript va CSS manbalari 
asosidagi malumotli qo‘llanmani chaqiradi.

• Set Breakpoint (Вставить контрольную точку). Matn kursori pozitsiyasida 
nazorat nuqtasini belgilaydi.

• Remove All Breakpoint (Удалить все контрольные точки). Hujjatning mavjud 
matnidan barcha nazorat nuqtalarini olib tashlaydi.

• Cut (Вырезать). Tanlangan kodli fragmentni buferga qirqib olish.
• Copy (Копировать). Tanlangan kodli fragmentni nusxasini buferga olish.
• Paste (Вставить). Buferga olingan fragmentni qo‘vish.

Kodlar nazoratchisini matn muharriri uchun biroz g‘ayri oddiv holda 
muvaffaqiyatli qo‘llash mumkin. Dreamweaver dasturi ASCII simvollarini qo‘llash 
bilan yozilgan fayilami, masalan oddiy matnli fayllami yoki dastuming dastlabki 
matnini muvaffaqiyatli oqiydi. Bunday hujjatlar Open (Открыть) buyrug‘i 
yordamida ochiladi va kodli rejimda ishlaydigan oyna hujjatiga yuklanadi. Bunda 
dastuming ba’zi resurslarigakirish mumkin bo lmav qoladi.
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Das turning kutubxonasi Kutubxonalar -  bu gipermatnli sahifaning dizayniga 
tegishli ko'p marta qoilaniladigan elementlarni saqlash vositasidir. Bu elementlarga: 
tasvirlar, bogianishlar, matn boiaklan va boshqalar kiradi. Dreamweaver dasturida 
esa kutubxonaning ishlash printsipi biroz boshqacha Dastlab kutubxonaga 
saqlashning bitta elementi hisoblangan, ob'yekt yoki ob’vektlarga tegishli 
gipermatnli belgilash fragmentlari saqlanadi. Dreamweaver dasturida kutubxona 
elementlari maxsus Library papkasida saqlanadi. Bu papka saytning asosiy papkasi 
ichida joylashadi. Har bir Web-uzel o'zining standart elementlari va ularni saqlash 
papkasini tashkil qiluvchi shaxsiy kutubxonasiga ega Ular bilan ishlash uchun 
palitraning Assets (Ресурсы) boiimidan foydalaniladi. Kutubxonalar bilan 
boshqarish ishlarining asosiy qismini palitraning Assets (Ресурсы) boiimi buvruqlari 
yordamida amalga oshiriladi. Dreamweaver dasturida kutubxonalaming asosiy 
imkoniyatlarini sanab o‘tamiz:

• Kutubxona elementi deb <body> tegi orasida yotgan har qanday fragmentni 
aytish mumkin;

• Kutubxona elementlari qoilanilishida cheksiz imkoniyatlarga ega. Ulami 
gipermatnli sahifalarga hech qanday tahrirlashsiz qo'yish mumkin;

• Kutubxona elementlariga o zgartirish kiritilsa ulami boshqa gipermatnli 
sahifalar va hujjatlarda qoilashda saqlanib qoladi.

• Sahifalardagi kutubxona namunasi va uning nusxalari orasidagi aloqani uzishga 
ruxsat etiladi.

• Dastur alohida saytlar o‘rtasida kutubxona elementlarini almashish buyruqlariga 
ega

• Kutubxonalar dinamik xususiyatga ega boigan ob’yektlami ham saqlaydi.
• Vaqt diagrammalari (timeline) va stilliaming kaskadli sahifalari kutubxonada 

saqlanishi mumkin emas.
Holat qatori va uni o‘rnatish. Status Bar (Строка состояния) bu lcichik 

boiim  dastuming holat qatori ko‘rinishi ko‘rsatkichlarim belgilaydi. Bu element 
hujjat oynasining pastki qismida joylashgan. Odatda bu qatorda joriy oyna oichami 
haqidagi maiumotlar va uning yuklanishi uchun ketadigan vaqt ko'rsatiladi. Undan 
tashqari holat qatorining o'ng qismini tez vuklanish paneh egallaydi:

• Window Sizes (Размеры окна). Gpermatnli sahifalar har xil oichamdagi 
oynalarda tasvirlanishi mumkin. Window Sizes (Размеры окна) paneli standart 
o‘lchamlar ro‘yxatini to‘ldirish uchun moijallangan. Barcha tahrirlash amallari 
klaviaturadan shu panelning tegishli mavdonlariga kiritish yordamida bajariladi.

• Connection Speed Kilobits Per Second (Скорость соединения. Kbit/s). Bu 
maydonga server bilan bogianishning taxminiv tezligi kiritiladi. Bu joriy sahifani 
taxminiy vuklanish vaqtini belgilaydi. Odatda 28,8 Kbit/s tezlik o‘matilgan boiadi.

• Show Launcher in Status Bar (Панель быстрого запуска в строке состояния) 
bu bayroqcha tez yuklanish paneilini holat qatorida chiqishini boshqaradi.
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MASHQ. Fayllar bilan ishlash imkoniyatlari 
Ishning maqsadi: Fayllar bilan ishlash imkoniyatlarini o'rgatish

Fayllami ochish texnikasi Windows tizimida ishlaydigan boshqa dasturlardan 
farqi yo‘q. Buning uchun File > Open (Файл > Открыть) buvrug'ini berish kerak. Bu 
buyruqni klaviaturadan CTRL+0 tugmalar kombinatsiyasini bosish bilan ham 
bajarish mumkin. Bundan tashqari dasturda fayllami ochishning surib kelish usuli 
ham mavjud. HTML fayl belgisini sichqoncha yordamida surib kelib, hujjat 
oynasining ixtiyoriy yeriga tashlansa fayl ochiladi. Dasturda bir vaqtda bir nechta 
oyna bilan ishlash imkoniyati faqatgina kompyuteming bo‘sh xotirasi bilan mos 
ravishda cheklanadi. Agar dasturda bo‘sh sahifa bilan ish boshlangan bo‘lsa, u holda 
yangi fayl har qanday holatda uni ornini egallaydi.

Dreamweaver dasturi ochiladigan HTML sahifalarida sintaksis xatolami 
tekshiradi. Dastur standart HTML gipermatnli belgilash tilida yozilgan barcha 
kengaytmali fayllami ocha oladi. Ularga quyidagilar kiradi: .HTM, HTML, .ASP, 
CFM, CFML, TXT, .SHTM, SHTML, STM, LASSO, .XML, .CSS, .PHP.

Fayllami saqlash. Dreamweaverda fayllami saqlash ham Windows tizimining 
boshqa standart dasturlaridagi singari amalga oshiriladi. Buning uchun: File > Save 
(Файл > Сохранить) yoki File > Save as (Файл > Сохранить как) buyruqlaridan 
birini berish kerak. Birinchi buyruqni CTRL+S tugmalar kombinatsiyasini bosish 
bilan ham bajarish mumkin. Bu buyruq shu nomdagi muloqot oynasini hosil qiladi. 
Oynaga foydalanuvchi tomonidan faylning nomi, tipi va saqlash joyi belgilanadi.

Gipermatnli hujjatlar fayllari Windows operatsion tizimida htm kengaytma 
oladi, Macintosh platformasida esa html kengaytma oladi. Ammo bu kengavtmadagi 
fayllami dasturlarda ochish va saqlash buyruqlari bajarilishi teng kuchli. Dasturda 
ochilishi mumkin bo‘lgan barcha tipdagi fayllar, xuddi shu dasturda saqlanadi ham.

Tabiiv sharoitda yoki ilmiy laboratoriyalarda o‘tadigan ko‘pgina fizik jarayonlar 
qaytmas hisoblanadi. Bu tabiatshunoslikda olamning butun ilmiy manzarasini 
shakllantiruvchi fundamental qoidalaridan biridir. Zamonaviy hisoblash mashinalari 
insonni bu falsafiv kategoriyadan qisman qutqarishga qodir. Kopchilik zamonaviy 
dasturlar qoniqarsiz natijani bekor qilishga imkon beradi. Ya'ni hujjatning avvalgi 
holatiga qaytish, qabul qilingan qarorlami qadamba-qadam orqaga qaytarish imkonini 
beradi.

Dreamweaver dasturida buning uchun Edit > Undo (Правка > Отмена) 
buymg‘ini bajarish yoki CTRL+Z tugmalar kombinatsiyasini bosish yetarli.

Dastur bekor qilishni bir nechta o‘zaro bog'langan ketma-ket qadamda amalga 
oshiradi. Bu ketma-ketlik qadamlarining soni dasturning tegishli ko'rsatkichida 
ifodalangan songa teng: odatda bu son 100 ga teng.

Bu sonni quy idagicha o‘zgartirish mumkin:
1. Edit>Preferences (Правка>Настройки) -  buy rug‘ini bering;
2. General (Общие) kategoriyasini oching;
3. Maximum Number of History Steps (Максимальное число записей жу рнала) 
maydoniga o’zingiz saqlamoqchi bo'lgan ketma-ketliklar maksimal sonini kiriting.

Tahrirlash ishlari va buyruqlarini yozish va saqlash foydalanuvchidan 
qo‘shimcha hisoblash manbalarini talab qiladi.



Undo (Отмена) buyrug‘i «eng muhim izlami» bekor qilish imkoniyatini beradi. 
Ammo bu usul bilan jarayonni bir necha bor bajarib «bekor qilish» buyrug‘idan 
vaxshi natija olib bo‘lmaydi. Chunki uning yordamida faqatgina eng muhim izlami 
bekor qilish mumkin xolos. Bundan tashqari, ayrim buyruqlami bu usul bilan bekor 
qilib bo‘lmaydi. Bekor qilib boimaydigan buyruqlami orqaga qaytarish yoki ancha 
oldin bajarilgan operatsiyalami qaytarish uchun File > Revert (Файл > Вернуться к 
сохраненному) buyrug‘idan foydalanish mumkin. Bu buyruq hujjatni oxirgi 
saqlangan holatini tiklab beradi.

Buyruqni ishlatish yo‘li oddiy. Qaytarib bo‘lmaydigan buyruqlar mavjud 
ketma-ketlikni tiklashga berishdan oldin hujjatni diskka saqlab olish kerak. Agar ish 
vaxshi natija bermasa. u holda Revert (Файл > Вернуться к сохраненному) 
buvrug'i hujjatni o'sha holat 1 da tiklab beradi.

Dasturda bajarilgan operatsiyalami takrorlash ham mumkin. Edit > Redo 
(Правка > Повторить) buyrug‘i oxirgi buyruqni yoki tahrirlash ishlarini takroran 
bajaradi. Bu buy ruqni CTRL+Y tugmalar kombinatsiyasi yordamida ham berish 
mumkin.

Shuni esda tutish kerakki, dastuming ish bayonnomasiga faqatgina natijaviy 
operatsiy alar yoziladi, masalan: simvollami kiritish va o'chirish, ob’yektlami 
qo'vish, formatlash buy ruqlari va boshqalar. Faqat shunday holatlami bekor qilish 
yoki takrorlash mumkin. Kxfplab yordamchi tipdagi buyruqlami bekor qilib yoki 
takrorlab bo‘lmaydi. Kursomi surish, ob’yektlami belgilash, hujjatni saqlash va 
boshqalar shular jumlasidan.

MASHQ. Web-uzel yaratish va stnikturaiar 
Ishning maqsadi: Web-uzel yaratish va strukturalami orgatish

Jahon o rgimchak uyasining (World Wide Web) barcha informatsion 
manbalarini ikkita katta sinfga bo‘lish qabul qilingan: sahifalar va uzellar yoki 
saytlar. Biz yuqorida web -  sahifalar ta'rifi bilan tanishdik. Web-uzellar ya’ni saytlar
-  deganda o'ziga sahifalami birlashtirgan tizim tushuniladi. Boshqacha ay tganda uzel 
deganda minglab hujjatlami o‘zida birlashtirgan, ko'psonh bogManishga ega, 
multimediali murakkab tizim tushuniladi.

Dreamweaver paketi - bu ko'p qirrali dastur. Uni alohida sahifalar yaratish 
uchun oddiy gipermatnli hujjatlar tahrirlagichi sifatida ham ishlatish mumkin. 
Bundan tashqari dastur har qanday' murakkablikdagi Web-uzellami ham у arata oladi.

Chiziqli struktura. Kompy uter paydo bo lgunga qadar barcha chop etiladigan: 
badiiy kitoblar, qo'llanmalar, ma lumotnomalar. texnik ko rsatmalar chiziqli 
strukturaga misol bo‘la olar edi. Bugungi kunga kelib bularni multimediali 
qo‘llanmalar va elektron ko‘rsatmalar ko‘rinishida qo‘llanmoqda. Chiziqli zanjir 
elektron do‘konda buyurtma berishni rasrniy lashtirish qadamlari, ayrim tarmoq 
manbalariga kirish uchun ro'yxatdan o‘tish yoki rasmiylashtirish ketma-ketliklarini 
tushunish mumkin.

Chiziqli strukturaga kirish nuqtasi bo‘lib birinchi sahifa xizmat qiladi. Bu bosh 
sahifa odatda index.htm yoki main.htm deb nomlanadi. Bu esa kitob yoki 
jurnallardagi muqova rolini bajaradi. Bu sahifa bir vaqtning o‘zida ham
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namovishbop, ham tanishtiruv sahifasi, ham maiumotli sahifa boim ogi lozim. 
Qidiruv mashinalari har bir sahifani alohida indekslaydi. Shuning uchun barcha ichki 
sahifalami bosh sahifaga oikazadigan harakatlanish tugmalari bilan to‘ldirish kerak.

Iyerarxik struktura. Saytlar yaratishning zanjirli printsipi sahifalar 
joylashuviga va ular orasidagi bir-biriga oiishlarga qat'iy cheklashlar qo‘yishga 
asoslanadi. Iyerarxik bo'ysunish printsipi bo‘yicha qurilgan tugunlar ancha katta 
nioslashuvchanlikka ega. Ko'plab korxonalar, tashkilotlar Iyerarxik struktura 
chizmasi asosida qurilgan. Bu esa iyerarxik strukturaning kamchiliklari va yutuqlari 
vaxshi o‘rganilganidan darak beradi. Bu strukturani ba’zan daraxtsimon struktura 
ham deyilib, bitta bosh o‘zak (butun savtga kirish nuqtasi hisoblangan) sahifaga ega 
boiadi.

Har qanday ichki sahifa informatsion manba hisoblanib bosh sahifa bilan 
mantiqiy bogiangan boiadi.

Ko‘p bogianishli struk tu ra  Ko‘p bogianishli strukturada hech qanday 
cheklanishlar boimaydi. Ya’ni har bir sahifa boshqa barcha sahifalar bilan 
bogiangan boiishi kerak. Katta saytlarda tashrif buyuruvchilaming moijal olishi 
uchun maxsus indeksatsiya tizimlari yoki saytning aylanish kartasi ifodalanishi kerak.

Materialning taqsimoti. Materialning Web-uzelda boiimlar bo‘yicha 
taqsimoti mantiqiy ravishda amalga oshirilishi kerak. Har bir sahifaga faqat 
belgilangan predmet yoki mavzudagi material joylanishi kerak. Tanlangan gipermatn 
ostida aynan shu mavzudagi hujjat borligi foydalanuvchining ishonchini yanada 
orttiradi. Avrim hollarda buning aksini, ya’ni tanlangan gipermatnga xos boimagan 
hujjatning ochilishini ham ko'rish mumkin.

Saytni qismlarga boiishda ham ma’lumotning katta-kichikiigiga, maium 
mavzu yoki predmetga xosligiga qarab boiish ham maqsadga muvofiqdir. Yuqorida 
aytilgandek biror sahifada bir predmet yoki mavzuga xos boigan matnlar bilan birga 
rasmlar. jadvallar, animatsiyalar va boshqa ko‘rinishdagi materiallaming ham shu 
boiimga xosligi katta ahamiyatga ega. Maiumotlaming mos kelmasligi 
foydalanuvchilaming ishonchini yo qotib. ulaming sonini keskin kamaytirib 
yuboradi. Bunday holatga tushib qolmaslik uchun Web-dizaynerdan qunt bilan 
ishlashni talab qiladi. Agarda tayyorlanayotgan saytdagi materiallar Web-dizaynerga 
notanish mavzuda boisa, u holda o‘sha sohadagi biror vetuk mutaxassis bilan 
hamkorlikda ishlashga to‘g‘ri keladi.

Web-saytlarni internetga joylash uchun manzil berish. Saytlarga 
intemetda manzil berish uchun URL (Uniform Resource Locator) deb nomlanadigan 
ibora qoilaniladi. URL-intemetga murojaat qiiishning eng oddiy usuli boiib, u 
manzilni ifodalaydi. URL manzilidan ixtiyoriy sondagi foydalanuvchi bir vaqtning 
o‘zida foydalanishi mumkin. URL manzili qat’iy format asosida yoziladi:

Bayonnoma : II xost: port I yo‘l / fayl # fragment
Manzilni toiiqroq tushunish uchun quyidagi misolni ko‘rib chiqamiz: 

http ://www.tdpu.uz/index. php 
bu URL manzili tarkibiy qismlari quvidagicha:
http -  resursdan foydalanishda gipermatn bayonnomasi ishlatilayotganini bildiradi. 
www.tdpu.uz - maiumotlar joylashgan Internet sahifa nomini bildiradi.
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Index.php -  faylning kompyuterdagi to4a nomini bildiradi.
Manzilning asosiy tashkil qiluvchilarini ko‘rib chiqamiz:

• Протокол -  bayonnoma Internet -  mijozlari va serverlarining bog‘lanishi 
usulini tavsiflovchi qism. Odatda http (HyperText Transfer Protocol) gipermatnli 
uzatish maxsus bayonnomasidan foydalaniladi. Manzil kichik lotin harflari bilan 
yoziladi (http://).

• Имя сервера. Bunda joylanadigan ma'lumotlami saqlaydigan hisoblash 
tizimining (bu hisoblash tizimini server deb nomlash qabul qilingan) nomi 
ko'rsatiladi. Serverga berilgan ta’rifda ham -  tarmoq ishini nazorat qiluvchi 
kompyuter deb aytilganligi bejiz emas. Server nomi domen nomi kabi www bilan 
yoki usiz yozilishi mumkin. Masalan, www.adobe.com. Boshqacha usulda nomni IP
-  manzil ko'rinishida ifodalash mumkin Masalan, 199.227 52.143.

• Порт. Port raqamini ko‘rsatish bitta server ichidagi jarayonni adresatsiya qilish 
uchun talab etiladi. Biroz vaqtdan keyin port ishlatiladi va uning raqamini tushirib 
qoldirish mumkin.

• Путь поиска. Kataloglar va ostki kataloglar zanjiri. fay lning joylashgan ornini 
belgilaydi. Bu zanjiming elementlari «/» simvoli bilan ajratiladi.

• Файл. Faylning nomi uning kengaytmasi bilan birga yoziladi (faqat kengaytma 
so‘ralgan platformada). Agarda faylning nomi tushirib qoldirilgan bo‘lsa u holda 
Web-brauzer ko'rsatiladigan faylni qidiradi. Brauzer reaktsiyasi va uning keyingi 
harakatlari faylning nomini kengaytirishga bog‘liq bo‘ladi. Masalan, grafik fayllari 
GIF yoki JPG ko‘rish dasturiga tasvirlaming yuklanishini boshlab beradi. Arxiv 
fayllar (ZIP, RAR va boshqalar) bilan uyg'unlashgan kengaytma -  mijoz 
kompyuterida faylning saqlanishini boshlab beradi.

. Фрагмент. URL man/ilning fakultativ qismi. U # (panjara) maxsus simvoli 
bilan boshlanadi. Bu belgi gipermatnli hujjatning lavhasini ajratib ko‘rsatuvchi 
maxsus belgidir. Tarkibga qo‘shib qo‘yish simvoli nomining kiritilishi butun sahifaga 
emas. balki uning ma’lum bir qismiga murojaat qilish imkonini beradi.

http bayonnomasi bo‘yicha bog lanish Internet tarmog'ida eng ko p tarqalgan 
usul. Intemetdagi ob’yektlaming manzillari aloqaning boshqa uslublanni va 
bayonnomalarini o‘z ichiga olishi mumkin. Ulardan bir nechtasini sanab o‘tamiz.

7.14-jadval. Intemetdagi ob’yektlaming manzillari

Bayonnoma
nomi

Yozish
qoidasi

Q o‘llanish sohasi

FTP ftp:// Fayllami uzatish bayonnomasi. FTP-serveri bilan bogTanish uchun 
qoTlaniladi

File file:// Kompyuter yoki lokal tarmoqda berilgan fayllarga bogTanish 
bayonnomasi

Gopher gopher:// Gopher serveriga bog‘lamsh bayonnomasi. Hozirgi vaqtda 
qoTlanilmaydi

JavaScript javascript. JavaScript tilida yozilgan dastumi chaqirish
Mailto mailto: Elektron pochta manzih
Newt news: Telekonfierentsiyalarga bogTanish bayonnomasi
Telnet telnet: Kompyuterga bog'lamsh bayonnomasi
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Intemetning bugungi ommaviyligini tushuntiruvchi sabablardan biri HTTP 
b a y o n n o m a s i  imkoniy atlarining kengligidir. O'zidan avvalgi avlodlarining ba’zi 
b a y  onnomalarini u butunlay yutib у uboradi, ba’zilarini esa shunchaki siqib chiqaradi 
va ko‘rgazmali grafik interfeys yordamida qo‘llab-quvvatlash yo‘li bilan yaxshiroq 
imkonivat yaratadi.

MASHQ. Lokal uzel yaratish va havolalar o‘matish 
Ishning maqsadi: Lokal uzel yaratish va havolalar o'matishga o'rgatish 
Dreamweaver dasturida saytlar va sahifalar yaratishning har xil yoMlari bor. 

Bulardan savtlami yaratish bo‘yicha eng mashhur texnologivani ko‘rib chiqamiz. 
Buning uchun quy idagi ketma-ketlikni bajaramiz:

. saytning lokal versivasini yaratish;

. lokal versiyani Internet tarmogMgajoylash.
Lokal uzel -  bu foydalanuvchi yoki foydalanuvchi laming kompvuterida 

joylashgan haqiqiv virtual Web-uzelning versiyasidir. Lokal uzel tarmoqdan 
ko‘rinmaydi, unga faqat mualliflarigina bogMana olishlari mumkin.

Lokal uzelning ma’lumotlari diskdagi belgilangan katalog ichida saqlanadi. Bu 
katalog vazifasini diskdagi har qanday katalog bajarishi mumkin. Yangi lokal uzel 
hosil qilish uchun quyidagi ketma-ketliklami bajaring:

1. Site > New Site (Сайт > Создать) buyrug‘ini bering. Ekranda Site Definition 
(Определение сайта) muloqot oynasi hosil bo'ladi.

2. Oynaning chap qismidan Local info (Информация о локапьном узле) 
boMimini tanlang. Maydonnmg qiymatini kiriting.

3. Remote Info (Сведения об удаченном сервере) kategoriyasiga savt 
saqlanayotgan server haqidagi ma lumotlarni kiriting.

4. Muloqot oynasining у uqorida sanalgan maydonlar toMdirilishi shart. Site Map 
Layout (Планировка карты узла). Design Notes (Комментарии разработчика) va 
File View Columns (Колонки отображения файловых атрибутов) mavdonlari 
toidirilishi shart emas (foydalanuvchi o‘z xohishiga qarab toidirishi mumkin).

5. Barcha kerakli ma’lumotlar kiritilgach OK tugmasini sichqoncha chap tugmasi 
yordamida bosing yoki ENTER tugmasini bosing.

Uzel kartasi -  lokal uzel yaratishning qulay interfaol vositasi hisoblanib, unda 
ko‘plab texnik qiy inchiliklarga ega bo‘lgan topshiriqlar grafikli ko‘rinishda vengillik 
bilan amalga oshiriladi. Bu rejimda saytning kartasi tasvirlanadi. Uzel dispetcheri 
oynasi ikki qismga boMingan. Chap tomonda uzelning kartasi kiritiladi (kartada -  
sahifa belgilari HTML favllami ifodalavdi). Hujjatlar orasidagi gipermatnli 
bogManishlami strelkalar ifodalaydi.

Uzel kartasi. 0 ‘ng tomonda esa uzelning fayllar va kataloglar ro'vxati 
beriladi. Kartaning ko‘rinishi organizatsion diagrammani eslatib yuboradi. Kartada 
ikki darajani ko‘rish mumkin. Yuqori darajani uzelning asosiy sahifasi egallaydi. 
Quyi darajada esa unga tegishli va o'zaro giperbogManishga ega sahifalar tushuniladi. 
Uzelning gipermatnli hujjatlaridagi bogManishlar ko‘k rangda tasvirlanadi. Agar 
bogManishda ko‘rsatilgan fayl kengaytmasi HTM, HTML va boshqa shu 
formatdagilardan farq qilsa u holda yashil rangda tasvirlanadi. Agar bogManishda



qo‘pol xatoliklar bolsa, u holda bog'lanish qizil rangda ifodalanadi. Tashqi fayllar 
boshqa fayllarda joylashgan fayllar va maxsus bogianishlar (masalan, mailto: y0kj 
javascript© globus ko‘rinishidagi maxsus belgi oladi. Bulardan tashqari agar ko‘k 
rangli belgi qoVilgan bo‘lsa — bu fayl foydalanuvchining o‘zi tomonidan 
taqiqlanganim bildiradi. Qulf belgisi ostidagi belgi faqat o'qish uchun moijallangan 
fayllami bildiradi.

Hujjatlarga havolalar o‘matish va olib tashlash. Tegishli hujjatga havola 
o'mat ish unchalik murakkab emas. Bunda foydalanuvchini chalkashtiradigan eng 
asosiy muammo -  bu operatsiyani bajarish usul va uslublarining ko‘pligidir. 
Qachonki biror hujjatga yoki sahifaga havola o‘matmoqchi boisangiz, buning uchun 
quyidagi uch holatdan birini belgilash kerak. Ular bir-biridan faylning holati va 
vuklanish texnikasi bilan farq qiladi.

Havola uchun ko‘rsatilgan hujjat uzelning hisobidagi ob’yekt sanaladi. Ya’ni 
faylning nomi fayllar va papkalar ro'yxatidan iborat uzelning kartasi va panelida 
ifodalanadi. Bunday faylga havola o'matish uchun asosiy hujjatni tanlash, sichqoncha 
yordamida marker ko'rsatkichga boglab olib, uni tegishli hujjatga olib o‘tish lozim. 
Marker-korsatkich — bu havola o'matish uchun maxsus interfaol vosita hisoblanadi. 
Markemi uzel dispetcherining har qanday paneliga (kartaga yoki fayllar ro'yxatiga) 
surib kelish mumkin.

• Butun hujjat saytmng tarkibiga kiradi, ammo uning ro‘yxatidan olmagan. 
Ya ni uning nomi o‘ng paneldagi fayllar ro‘yxatida mavjud, ammo u uzel kartasida 
yo‘q. Bunday holatlarda marker ko‘rsatkichni o‘ng panel ustiga surish va uni fayl 
nomi ustiga tashlash kerak.

• Butun hujjat saytga kirmagan. Bunday holatda marker-ko'rsatkichini surishni 
teskari yonalishini qoilash kerak.

Havolani o‘zgartirish. Havolalarni o zgartirish uchun eski boglanishga 
tegishli ko‘rsatkichlami o'chirib tashlab, yangi faylga tegishli ko‘rsatkichlami kiritish 
mumkin. Ammo Dreamweaverda buni o‘zgartirish uchun maxsus vositalar mavjud:

1. Uzel kartasidan hujjat belgisini tanlang;
2. Uzel dispetcheri oynasidan Site > Change Link (Сайт > Изменить ссылку) 

buyruglni bering. Xuddi shu buyruqni -  CTRL+L tugmalar kombinatsiyasi 
yordamida ham berish mumkin;

3. Select HTML Files (Выбор гипертекстовых файлов) muloqot oynasi 
ochiladi. Unda yangi fay lning nomi va joylashgan katalogini ko‘rsatish kerak;

4. Fay l tanlangandan keyin, Dreamweaver dasturi Update Files (Обновление 
файлов) muloqot oynasi ochiladi. Barcha o'zgarishlami qo'shish uchun Update 
(Обновить) tugmasini bosing.

Agar bir nechta hujjatlar bilan bitta hujjat o'rtasida boglanish o‘matmoqchi 
boisangiz buning uchun maxsus buvruq mavjud. Bu buyruq yordamida barcha 
ob’yektlardagi havolalarni global tarzda o‘zgartirish mumkin. U barcha gipermatnli 
havolalardagi ko‘rsatilgan favlni nomini o‘zgartirib chiqadi.

1. Uzel dispetcheri oynasini oching;
2 . 0 ‘zgartirilishi kerak boigan hujjatni oling;
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3 Site > Change Link Sitewide (Сайт > Изменить связи по всему сайту ) 
jn^ nigiini bering. Shunomdagi muloqot oynasi ochiladi.

1 Tanlangan faylning nomi Change All Links To (Изменить все ссылки на) 
maydonida ifodalanadi. Yangi faylning nomini Into Links To (На ссылки на) 
maydoniga kiritish yoki standart protseduralar yordamida tanlash mumkin

2. OK tugmasini (кнопка) bosing yoki ENTER klavishasini bosing.
3. Update Files (Обновление файлов) muloqot oynasi ochiladi, bunda 

bog‘lanishga ega va ayni vaqtda yangilanishni talab etadigan, fayllar nomi aks etadi. 
Fayllami tanlang va ularga tegishli havolani o‘mating.

Change Link Sitewide (Изменить связи по всему сайту) buyrug‘i ham 
havolalami ommaviy almashtirish uchun juda qulay. Masalan, bunday 
almashtirishlami ko'pincha saytning barcha sahifalaridagi elektron pochta manzilini 
almashtirish uchun qoMlash mumkin.

1. Change All Links To (Изменить все ссылки на) maydoniga o'zgartirilishi 
kerak bo‘lgan havolani to‘liq kiriting.

2. Into Links To (На ссылки) maydoniga to‘liq yangi havolani kiriting.
3. OK tugmasini bosing.

Havolani olib tashlash. Havolani olib tashlashni bir nechta usullari mavjud 
Masalan, havolaga tegishli, ya'ni manba hisoblangan hujjat favlini ochish va uni 
oddiy yo‘l bilan o‘chirib tashlash mumkin. Bu usul balki noqulay tuvulishi mumkin, 
ammo maksimal aniqlikda bo‘ladi. Uzel dispetcheri orqali amalga oshiriladigan 
bog‘lanishni olib tashlash usulini ko‘rib chiqamiz:

1. Uzel dispetcheri oynasini oching;
2. Uzel kartasidan bog‘lanishni ko'rsatuvchi hujjat belgisini oling;
3. Site > Remove Link (Сайт > Удалить ссылку) buy rug'ini bering. Bu 

buyruqning klaviaturada ikkita ekvivalenti bor: CTRL+SHIFT+L tugmalar 
kombinatsiyasi yordamida ham berish mumkin.

MASHQ. Hujjatning o‘lchamlarini belgilash 
Ishning maqsadi: Hujjatning o'lchamlarini belgilash

Dasturda yaratilgan har qanday yangi hujjat Ьо‘т-Ь о‘8Ь oq rangdagi fonli 
sahifadan iborat boladi. Hujjatda ish boshlashdan oldin uning bir qancha muhim 
parametrlarini kiritib olish kerak. Bular ish maydonining o‘lchami. fon rangi, hujjat 
sarlavhasi, havola ranglaridir. Bu parametrlami ish jarayonining ixtiyoriy vaqtida 
ham o zgartirish mumkin. Sanalgan barcha parametrlami yagona Page Properties 
(Свойства страницы) muloqot oynasi yordamida kiritiladi. Bu muloqot oynasini bir 
necha yo llar bilan ochish mumkin:

• Dastur menyu qatoridan Modify > Page Properties (Изменить > Свойства 
страницы) buyrug^ini berish bilan;

• CTRL+J tugmalar kombinatsiyasini bosish bilan;
• Kontekstli menyudan Page Properties (Изменить > Свойства страницы) 

buyrug'ini berish bilan.
Endi Page Properties (Свойства страницы) muloqot oynasining boshqaruv 

elementlari bilan tanishib chiqamiz:
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• Title (Заголовок). Sahifaning sarlavhasini kiritish uchun xizmat qiladi.
• Background Image (Фоновый рисунок). Hujjatga fon sifatida qo‘yiladigan 

rasm ko‘rsatiladi.
• Background (Фоновый цвет). Sahifaning fon rangini tanlash imkoniyatini 

beradi.
• Text (Текст). Shriftning rangini tanlash imkoniyatini beradi.
• Links (Ссылки). Bu boiimda giperhavolalar rangi va grafikli havolalar 

ramkasi rangi belgilanadi.
• Visited Links (Просмторенные ссылки). Brauzerda ko'rilgan havolalar 

rangini tanlash.
• Active Links (Активные ссылки). Faol havola rangini belgilash.
• Left Margin (Левое поле). Sahifaning chap tomonidan qoldiriladigan 

maydonni pikselda belgilaydi.
• Top Margin (Верхное поле). Sahifaning yuqori qismidan qoldiriladigan 

maydonni pikselda belgilaydi.
• Margin Width (Ширина полей). Sahifa maydoni ernni belgilaydi.
• Margin Height (Высота полей). Sahifa maydoni bo‘yini belgilaydi.
• Document Encoding (Кодировка документа). Kiril simvollaridan iborat 

sahifalar tuzish uchun juda muhim ko'rsatkich. Chunki uning yordamida qanday 
simvollami brauzer dasturlarida tasvirlab berish ko'rsatiladi. Rus alifbosini faqat 
quyidagi to'rtta kodirovka tasvirlab bera oladi xolos ISO-8859-5, MacCvrillic, KOI8- 
R va Windows-1251.

• Reload (Повторная загрузка). Tugmasi yordamida hujjatning grafik tahrirlash 
ishlari bilan bog'liq oxirgi saqlangan ko'rinishni tiklash imkonini beradi.

• Tracing Image (Трафаретное Изображение). Sahifaning dizayni bilian 
ishlashda namuna sifatida ishlatiladigan tasvirlami ifodalaydi. Bu tasvirlar sahifani 
ko‘rish rejimida ko‘nnmay di.

• Image Transparency (Прозрачность Изображения). Iz qoldirish uchun 
tanlab olingan rasmning shaffoflik darajasi belgilanadi.

. Document Folder (Папка документа). Hujjatning qaysi papkada 
joyiashganini ko‘rsatib turadi.

• Site Folder (Корневая папка узла). Tegishli Web-uzelning o‘zak papkasiiga 
to‘liq yo‘l ko‘rsatadi.

Yuqoridagi ko‘rsatkichlar tanlangandan so‘ng, barcha o‘zgarishlami saqlab, 
ulami ko‘rish uchun File > Preview in Browser (Файл > Просмотр в браузере) 
buyrug‘i beriladi.

Gorizontal va vertikal chizg‘ich. Hujjat bilan ishlashda o‘lchash va etalon 
vazifalarini bajaradi. Chizg'ichga qarab ob’vektlaming o’lchamini boshqa 
ob’yektlarga nisbatan joylashuvini ko‘rish mumkin. Boshqaruvda chizg‘ichlar 
maxsus buyruq yordamida o‘matiIadi. Buning uchun View > Rulers (Вид > 
Линейки) buyrug'ini berish kerak. Bu meny uning punktlarini sanab o4amiz.

• Show (Показать) buyrug'i chizgMchni o‘matib beradi. Bu buyruqni -  
CTRL+ALT+R tugmalar kombinatsiyasi yordamida ham bajarish mumkin. Buy ruqni 
takror berish chizg‘ichni ekrandan olib tashlaydi.
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. Pixels (Пикселы), Inches (Дюймы), Centimeters (Сантиметры) -  buyruqlari 
o ich a m  birligini tanlash imkonini beradi

. Reset Origin (Восстановить начато координат). Koordinatalar boshini 
sahifaning ixtivoriy nuqtasi bilan bog‘lash mumkin. Buning uchun chiziqlar 
kesishuvida joylashgan krest shaklidagi markemi hujjatoing ixtivoriy joyiga olib 
o'tish yetarli. Ushbu buvruqning bajarilishi sanoq nuqtasini dastlabki vaziyatga 
qaytaradi.

Montaj to‘ri. Montaj to‘ri -  hujjat elementlarini tekislash va joylashtirish 
uchun mo‘ljal olish vositasidir. Hujjat elementlariga: matn. rasmlar, jadvallar va 
boshqalar kiradi. Sahifani rejalashtirishnmg eng asosiy vositasidir. Loyihaning dizavn 
bilan bog‘liq ishlan tugagach to‘mi olib tashlash mumkin. To‘mi vana ekranga 
chiqarish uchun View > Grid > Show Grid (Вид > Разметочная сетка > Показать 
сетку) buyrugi beriladi yoki CTRL+ALT+G tugmalar kombinatsiyasi bosiladi. Olib 
tashlash uchun shu buyruq takror beriladi.

View > Grid > Edit Grid (Вид > Разметочная сетка > Настроить сетку) 
buyrugi natijasida shu nomdagi muloqot oynasini ekranga chiqaradi. Uning tarkibiy 
qismi bilan tanishib chiqamiz:

о Color (Цвет) -  to‘r rangini tanlash imkonini beradi 
о Show Grid (Показать сетку) -  to‘mi o'matish yoki olib tashlash. 
о Spacing (Расстояния) -  oichash birligi va chiziqlar orasidagi boiinish 

qadamini belgilaydi.
о Display (Отображение) -  to‘r chiziqlari kobrinishini belgilay di.

[Grid Settings E3
.

Color ; _ pjMflK

Г  £hoi*Gnd 
Г  SnaptoQ/id

OK j

Apply

Cancel
SpactvJSO j Pwete j»]

:: 1 ■■■-'" Dtspisy J,ines 

f  £o<s HHp j

7.3-rasm. Montaj to'rini o'matish.

MASHQ. Matnlarni formatlash. Shriftlar 
Ishning maqsadi: Matnlarni formatlash imkoniyatlari va shriftlar bilan ishlash

Bizga boshqa dasturlardan belgilangan matnni yoki butun hujjatdagi matnni 
shriftini o‘zgartirish maium. Endi ana shu jarayonni HTML tilida qanday 
bajarilishini ko‘rib chiqamiz. Bu vazifani HTMLda maxsus teg <font> yordamida 
bajariladi. Uning qivmatlari boiib bir nechta shriftlar nomi ishlatilishi mumkin, 
masalan: <font face=,:Courier, Helvetica, sans-serif‘>Shriftni belgilash </font>.

Shriftlami belgilashni texnik tomoni esa matn muharrirlaridan hech ham farq 
qilmaydi:

1. Matnni belgilang yoki matn kursorini hujjatning shrifti o‘zgarishi kerak 
boigan joyiga qo'ying;
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2. Text > Font (Текст > Шрифт) buyrug'ini bering va kerakli shriftni tanlang 
Xuddi shu ishni Property Inspector (Инспектор свойств) palitrasi yordamida ham 
bajarish mumkin.

Tanlangan shriftning nomi shriftlar ro‘yxatining nomi hisoblanadi.
Shriftlar ro‘vxatini tahrirlash. Shriftlar to'plami ro‘yxatiga foydalanuvchi 

o'z xohishiga qarab yangi shriftlar qo‘shishi yoki qo llanilmaydigan shriftlami olib 
tashlashi ham mumkin:
1. Text > Font > Edit Font List (Текст > Шрифт > Редактировать список 
шрифтов) buyrug‘ini bering. Bu buymqni CTRL+F3 tugmalar kombinatsiy asini 
bosish bilan ham bajarish mumkin. Buymqni berish natijasida Edit Font List muloqot 
oynasi hosil bo ladi.
2. Bu ovna y ordamida foydalanuvchi o'ziga kerakli shriftlar ro‘yxatini qaytadan 
tuzib olishi mumkin.
3. Ishni tugallashdan oldin muloqot oynasida OK tugmasi bosiladi.

Muloqot oynasining tugma va mavdonlari bilan tanishib chiqamiz:
• Font List (Список шрифтов). Muloqot oynasining bu bo‘limida ayni vaqtdagi 

ro yxatga tegishli shriftlar berilgan. Endi qo^shiladigan shriftlar esa ro‘yxatning eng 
oxirigajoylashadi.

• Chosen Font (Выбранные шрифты). Tanlangan shriftlar nomi.
• Available Fonts (Начатьные шрифты). Ushbu hisoblash tizimida ©‘matilgan 

shriftlar ro‘yxati. Bu shriftlardan birortasini tanlangan shriftlar to‘plamiga qo‘shish 
uchun, chapni ko‘rsatish yo‘nalish tugmasini bosish kerak.

• To plamdagi tanlangan shriftni o'chirish uchun «-» belgili tugmani, to'plamga 
yangi shrift qo'shish uchun «+» belgili tugmani bosish kerak.

• Yuqoriga va pastga qaragan strelkalar esa tanlangan shriftni ro'yxatdagi holatini 
o‘zgartirish, va ni yuqoriga va pastga yurish imkonini beradi.

Matn e ‘lchamini belgilash. HTMLda matn o‘lchamini qanday belgilash bilan 
tanishib chiqamiz. Buning uchun <font> tegida size atributi qo‘llaniladi. Masalan, 
<font s iz e -4 ’> 0 ‘lchamni belgilashning mutloq tizimi <yfont>. Bundan tashqari 
<body> tegi yordamida ham <basefont size=”qiymat”> shriftni belgilash mumkin. 
Bunda sizening qiymatiga birdan to yettigacha bo‘lgan har qanday qiymatni qo'yish 
mumkin.

Kattalashadigan o‘lchamlarda esa size atributi qiymati oldiga + (kattalashtirish) 
yoki -  (kichiklashtirish) belgisi qo‘yiladi. Nisbiy tizimda shriftni o‘lchamini 
0‘zgartirishga misol keltiramiz:
<font s iz e - ,+l,,>Nisbiy tizimda o‘lcham</font>
Shrift o‘lchamini quyidagi у o‘I bilan o‘zgartirish mumkin:

1. Matnni belgilang yoki kiritiladigan joy ga kursomi qo‘ying.
2. Absolyut o‘lchamni belgilash uchun Text > Size (Текст > Размер) buyrug‘ini 

bering yoki nisbiy tizimida o‘lchamni berish uchun Text > Size Change (Текст > 
Изменить размер) buyrug‘ini bering. Ikkala buy ruqni ham Property Inspector 
(Инспектор свойств) palitrasidan berish mumkin. Palitraning Size (Размер) 
ro'yxatida shrift o ichamini o'zgartirishning barcha imkoniyatlari ko‘rsatilgan.

3. Absolyut yoki o‘sish o‘lchamini tanlang.
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Matnlarga rang berish. Agar matnga biror rang berilmagan bo‘lsa, u holda 
W indows operatsion tizimidagi yoki brauzerda tanlangan rang tasvirlanadi. 
iCo'pincha bu rang qora rang boiadi. Butun massivning simvollariga rang hujjatning 
asosiy kokrsatkichlarida belgilanadi. Ko‘pincha hujjat yaratib olingach. bu kabi 
ko‘rsatkichlar kiritilib olinadi. Buning uchun yuqorida ko'rganimizdek Modify > 
page Properties (Изменить > Свойства страницы) buyrug'ini berish kerak 
(CTRL+J). Har qanday simvollar to'plamiga alohida rang berish mumkin. Ranglami 
saqlash uchun <font> tegida color atributi ishlatiladi. Masalan, yashil-ko'k rangini 
belgilovchi kod quyidagicha yoziladi:
<font color=’#66FFFF”>bu moviy rangning kodi</font>

Shuni esda tutish kerakki HTML tilida rang o‘n oltilik sanoq tizimi kodlari 
vordamida belgilanadi. Palitraning ayrim elementlari o'zining nomiga ega, masalan 
green (ko‘k), red (qizil) va boshqalar.

Dasturda ranglami tanlashni Property Inspector (Инспектор свойств) 
palitrasidan foydalanib ham uskunaviy yo‘l bilan belgilash mumkin. Bu jarayon 
xuddi boshqa matn muharrirlarida bajarilgandek boradi.

Matnli maydonlar. Matn maydoni -  sahifaning asosiy  qism i hisoblanadi. 
Chunki har qanday Web-sahifaning asosiy belgilovchi qismi matnlar hisoblanadi. 
Matnli maydonlar uch xil ko'rinishda bo'ladi:

. Single line (Однострочное). Qisqa xabar yoki javoblarni kiritish uchun xizmat 
qiladi.

• Multi line (Многострочное). Ixtiyoriy uzunlikdagi xabami kiritish uchun 
moMjallangan.

• Password (Пароль). Parolni kiritish uchun moijallangan.
Matnning uchala ko‘rinishi ham bitta buy ruq yordamida qo'yiladi. Ulami 

tiplarga ajratish esa Property Inspector (Инспектор свойств) palitrasi yordamida 
amalga oshiriladi. Buning uchun shu nomlardagi uchta qayta ulagich xizmat qiladi.

Single line matn maydoni. Bitta qatordan tarkib topgan oddiy matn maydoni. 
U <input> tegi yordamida belgilanadi. Quyidagi misolda shundav ob’yektni 
ifodalovchi belgili kod qatori keltirilgan:

<input type=’text” nam e-’maydon_nomi”> 
bu yerda ty pe atributi maydonning tipini bildiradi, name atributi esa ob’yektning 
nomini bildiradi.

Oddiy matn maydoni bilan bog'liq ko‘rsatkichlar bilan tanishib chiqamiz:
• TextField (Текстовое поле). Palitraning bu boMimi matn maydonining nomini 

belgilaydi. Bu yerda maxsus belgilardan foydalanish, bir nomni takrorlash va 
maydonni bo‘sh qoldirish ham mumkin emas.

• Char Width (Ширина в символах). Matn maydonining enini simvollar soni 
bo‘vicha belgilash. Odatda bu o4cham 20 ta simvolni tashkil qiladi.

• Max Chars (Максимальный объем). Matn maydoniga kiritiladigan 
simvollaming maksimal soni.

• Init Val (Начальное значение). Bu mavdonga qarab ko'rish dasturi 
sahifani birinchi yuklashdan keyin olib chiqadigan matn qatorini kiritish mumkin. 
Password matn maydoni. Kiritilgan simvollaming oynada aks etmasligini ta’minlash
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maqsadga muvofiq bo'lgan holatlar ham mavjud. Ko‘pincha bunday zarurat maxfiy 
axborotlami, masalan, parollar yoki kalit so'zlarni kiritishda yuzaga keladi.

Password (Пароль) matn maydoniga kiritilgan maiumot faqat yulduzchalar 
ko'rinishida tasvirlanadi. Matn mavdoni bunday xususiyati bilan boshqa tipdagi matn 
mavdonlaridan keskin farq qilib turadi.

Multi Line matn maydoni. Katta hajmdagi matnli ma'Iumotlami kiritish 
uchun Multi Line (Многострочное) tipidagi maydonlar ishlatiladi Bunday tipdagi 
ob’yektlami yaratish uchun, sahifaga matn maydoni qo'yish kerak, masalan Insert > 
Form Objects > Text Field (Вставка > Объекты форм > Текстовое поле) buyrugi 
yordamida Xossalar paneli oching va undan Multi Line (Многострочное) qayta 
ulagichni oling. Natijada, bir qatorli matn maydoni ko p qatorli matn maydoniga 
aylanadi. Uning uzunligi 18 simvoldan, balandligi esa3 qatordan iborat.

Bu tipdagi ob’yektlar ishlash uchun yana Property Inspector (Инспектор 
свойств) palitrasiga murojaat qilamiz:

• TextField (Текстовое поле) -  ko‘p qatorli mavdonning nomi.
• Char Width (Ширина в символах) -  matn maydonining simvollarda 

belgilanadigan kengligi.
• Num Lines (Число строк) -  matn maydonining qatorlar soni.
• Int Val (Начальное значение) -  maydonining boshlangich qiymati.
• Wrap (Перенос по словом) -  ko‘p qatorli matn maydonida matnni yangi 

qatorga ko'chirish imkoniyatlarini belgilaydi

MASHQ. Grafikli formatdagi fayllar bilan ishlash 
Ishning maqsadi: Grafikli formatdagi fayllar bilan ishlashni o rgatish 
Grafik tasvirlar ishtirokisiz tuziladigan hujjatlar juda kamchilikni tashkil qiladi. 

Ayniqsa Web -  sahifalami rasmlar, logotiplarsiz tasavvur ham qilib boimaydi. Bu 
kabi grafikli maiumotlaming turlari juda ham ko‘p. Ulami faqat formati bo‘yicha 
ajratish mumkin. Masalan, birgina rasm degan maiumot ostida har xil formatdagi 
fayllar yotadi. Faylning formati deganda maiumotni yozish va saqlash uchun 
belgilangan standart qoidalar to'plami tushuniladi. Hozirda o nlab grafikli formatlar 
mavjudki, ular turli tizimlarda har xil maqsadda qoilaniladi. Grafikli formatlar uchta 
sinfga boiinadi. Bular: rastrli, vektorli, metafaylli.

Dastuming rasmlami qo'yish imkonivatlari. Rasmlar Web-sahifalarga jilo 
beruvchi vositalar hisoblanadi. Rasmlami qo‘yish -  bu oddiy texnik operatsiya 
Dasturda uni qolyishning bir nechta yoilari bor. Awal rasmni qo‘yish buyruqlaridan 
birini tanlaymiz:

• Objects (Объекты) palitrasini oching, Common (Общие) boiimiga o'ting, 
palitraning yuqori -  chap qismida joylashgan Insert Image (Вставка Изображения) 
tugmasini bosing.

• Insert > Image (Вставка > Изображение) buyrugini bering.
• CTRL+ALT+I tugmalar kombinatsiyasidan foydalaning.
• Tasvimi Assets (Фонды) palitrasidan hujjat oynasining kerakli qismiga 

ko'chinng.
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. Saytning dispetcheri oynasidan rasmning belgismi olib hujjatning oynasiga 
tashlang. 6 7

. Rasmni ish stolidan hujjat oynasining kerakli joyiga tashlang.
HTML tilida esa bu vazifalami <img> tegi bajaradi. Bu teg rasmning barcha 

ko'rsatkichlanm belgilaydigan bir nechta atributlami o‘z ichiga oladi. Quy idagi 
misolda teg o‘ziga to'qqizta atributni bogiagan.
<img src=«T emp/ani m 1. gif» width=«170» height=«180» a!t= «T ushuncha»  
border=«l» name=«ins» align=«right» vspace=«50» hspace=«60>»
Shuningdek qo‘yilgan rasmga ramka ham qo‘yish mumkin:
<img src=« 10.jpg» border=«l»>
Bu misolda border atributi ramkaning qalinligini bildiradi.

Rasmni fon sifatida qo’yish. Biz yuqorida gipermatnli hujjatning 
parametrlarida fonga rang tanlash, fonga rasm qo'yish bilan tanishib chiqdik. Endi 
rasmlami fon sifatida qo‘yish bilan batafsil tanishib chiqamiz:

1. Modify > Page Properties (Изменить > Свойства страницы) buyrug‘ini 
bering.

2. Background Image (Фоновый рисунок) maydonida rasm faylini ko‘rearing.
Xuddi shu vazifani HTML tilida <body> tegi yordamida bajariladi. Masalan,

<body background=«image.jpg»> bunda rasm hujjat saqlangan p a p k a d a  joylashgan.
<body background=«\\Avw. images.com/source/back.gif»> fragmenti esa 

intemetning ko‘rsatilgan manzilidagi rasmni fon sifatida qo'yib beradi.
Interfaol rasmlar. Hozirgj kunga kelib rasmlar va ani mats iyalarsiz sahifalami 

uchratish juda qiyin. Aksarivat Web-sahifalar animatsivalar, animatsion tugrnalar 
yoki harakatlanish tugmalari, rasmlar, interfaol rasmlar bilan boyitilgan.

Interfaol rasmlar so;zi rollover image iborasidan olingan bo4ib so ‘zm a-so‘z  
tarjimada “tasvimi ko4chirib o‘tkazish” ma’nosini bildiradi. Agar Web-sahifada biror 
rasm ustiga sichqon ko‘rsatkichini olib borganingizda boshqa rasm paydo bo'lsa 
bilingki u rasm interfaol rasmdir. Interfaol rasmlami qo‘yish quyidagi yo‘l bilan 
bajariladi:

1. Matn kursorini rasm qo‘yiladigan joyga qo'ying.
2. Insert > Interactive Image > Rollover Image (Вставка > Динамические 

Изображения > Интерактивное Изображение) buyrug‘ini bering.
3. Bu muloqot oynasining tegishli maydonlarini to‘ldiring:

о Image Name (Имя Изображения) maydonda rasmning nomi ko‘rsatiladi. 
о Original Image (Исходное Изображение). Joriy holatda ko rinadigan 

rasmning nomi ko'rsatiladi.
о Rollover Image (Интерактивное Изображение). Sichqon ko‘rsatkichi kelishi 

bilan almashinadigan rasmni nomini ifodalaydi.
t ° Preload Rollover Image (Предварите-чьная загрузка) -  bu bayroqcha rasm ni 

ko‘rish dasturlarida vuklash rejimini ishga tushiradi.
о When Clicked Go To URL (переход no a4pecv) — bu yerda gipermatnli o 'tish  

buyrugi saqlanadi.
4. Tegishli ko rsatkichlar kiritilgandan so'ng OK tugmachasini bosing yoki 
klaviaturadan ENTER tugmasini bosing.
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Dreamweaver dasturi rasmlarning dinamik almashinuvini ko'rsatmaydi. Bu 
jarayonni faqat sahifa ko‘rish dasturlarida ko'rish mumkin. Brauzer dasturlarini 
chaqirishning eng qisqayoMi F I2 tugmasini bosishdir.

MASHQ. Jadvallar qo‘yish va ular bilan ishlash 
Ishning maqsadi: Jadvallar qo‘yish va ular bilan ishlashni o‘rgatish

Jadvallar -  matnli va grafikli ma'lumotlami saqlash uchun tayyor forma 
hisoblanadi. Bundan tashqari sahifalarda rasmlami birlashtirish uchun, matn ostiga 
rasm qo‘yish uchun ham jadval kataklaridan foydalansa bo4adi. Qatordagi ikkita 
yonma-yon joylashgan katakchalardan kolonka sifatida foydalansa boiadi. Bir 
katakli jadvaldan tortib to murakkab jadvalgacha -  bulaming barchasi qator, ustun, 
katakchalaming oddiy kombinatsiyasidan tuzilgan.

HTML tilida jadvalga tegishli barcha amallar yoki ma’lumotlar <table> 
</table> teglar juftligi orqali ifodalanadi. Bu tegning ko'plab atributlari mavjud. Bu 
atributlar yordamida jadvalning eni, foni rangi, chegarasi, tekislash, mavdon, kataklar 
orasidagi masofa va boshqa ko^rsatkichlami belgilash mumkin. Biz yuqorida 
HTMLda jadvallami qo‘vishning barcha imkoniyatlari bilan tanishib chiqdik. Endi 
esa Dreamweaverda jadval qo'yish bilan tanishib chiqamiz.

Jadval qo‘yish. Jadval qo‘yish -  bu uncha qiyin bolmagan texnik jarayondir. 
Dreamweaverda jadval qo‘yish uchun quyidagi ketma-ketlik bajariladi:

1. Jadval qo‘yilishi kerak bo‘lgan joyga kursomi qo'ying.
2. Insert > Table (Вставка > Таблица) buyrug‘ini bering. Bu buyruqni 

bajarishning altemativ variantlari ham bor:
о CTRL+ALT+T tugmalar kombinatsivasi;
о Object (Объекты) palitrasidagi Common (Общие) boiimining Insert Table 

(Вставить таблицу ) tugmasini bosish bilan;
3. Insert Table (Вставка таблицы) muloqot oynasi maydonlarini toidiring. Bu 

oynaning boshqaruv elementlarini ko‘rib chiqamiz:
о Rows (Строки). Jadvalning qatorlari soni.
о Colums (Столбцы). Jadvalning ustunlari soni.
о Width (Ширина). Jadvalning eni o'lchamini.
о Border (Рамка). Har bir katakchaning va butun jadvalning chegara ramkalari eni 

piksellarda beriladi.
о Cell Padding (Поля ячейки). Katakcha chegarasi va ichidagi ma’lumot 

orasidagi mavdon kattaligi.
о Cell Spacing (Расстояние между' ячейками). Kataklar orasidagi masofa.
4. OK tugmasini bosing.

Ixtiyoriy ko'rsatkichli jadval qo'yilgandan keyin, uni to‘ldirish vaqtida yoki 
undan keyin ham o‘zgartirish mumkin.

Jadvalli ma’lumotlarni import qilish. Dreamweaver dasturida tashqi matnli 
fayllami o‘qish va undagi jadvallami o‘girib olish uchun maxsus buy ruqlar mavjud. 
Jadvalli ma’lumotlami import qilish quy idagicha amalga oshiriladi:

1. File > Import > Import Tabular Data (Файл > Импорт > Импорт табличных 
данных) buyrug ini bering.
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2. Import Table Data (Импорт табличных данных) muloqot oynasi hosil 
bo‘ladi. Bu muloqot oynasining asosiy boshqaruv elementlari bilan tanishib 
chiqamiz:

о Data File (Файл данных). Bu maydonga jadvalli ma’lumot joylashgan faylni 
qidirish uchun to'liq yo l ko'rsatiladi.

о Delimiter (Разделитель). Bu ro'yxatda matnli fayldagi jadvalni bo'luvchisi 
kiritiladi. Ro‘yxat o‘z ichiga quyidagi bandlarni oladi: Tab (Символ табуляции), 
Comma (Запятая), Semicolon (Точка с запятое), Colon (Двоеточие), Other 
(Другое).

о Fit to Data (Подбирается по данным). Agar bu qayta ulagich o‘matilgan 
bo'lsa. jadval kengligi har bir ustunda eng uzun qator olchami bo‘yicha tanlab 
olinadi

о Set (Равна). Agar bu qayta ulagich o'matilgan bo’lsa, u holda jadvalning 
enini oldindan belgilash mumkin boiadi.

о Cell Padding (Поля ячейки). Katakcha tashkil etuvchilari va chegarasi 
orasidagi masofani belgilaydi.

о Cell Spacing (Расстояние между ячейками). Jadvalning yonma-yon turgan 
kataklari orasidagi masofani belgilaydi.

о Format Top Row (Форматирование верхней строки). Jadvalning birinchi 
qatorini formatlash uchun to' rtta variantni taklif qiladi.

о Border (Рамка). Bu verda jadvalning chegaraviy ramkasining qalinligi 
belgilanadi. Agar ramka zarur boMmasa u holda bu maydonda nol koTsatish kerak.

3. OK tugmasini bosing.
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7.4-rasm. Property Inspector palitrasi.

Agar muloqot oynasida ko‘rsatilgan jadval tashkil qiluvchilari va matnli 
fayldagi jadval tashkil qiluvchilariga to'g'ri kelmasa, u holda jadvalni import qilish 
noto'gii bajariladi. Aniqroq aytganda jadval buzilgan holda ko‘chadi.

Formatlash. Jadvalni yaratish bilan birga ulaming tashqi ko‘rinishlarini 
belgilash, formatlash operatsiv alarini bajarish mumkin. Dasturda esa bu 
atributlaming aksariyat qismi Property Inspector (Инспектор свойств) palitrasi 
yordamida o'matiladi. Bu palitrani ochish usullari bilan tanishib chiqamiz:

• Window >Properties (Окно > Свойства) buyrug‘i bilan;
• CTRL+F3 tugmalar kombinatsiyasini bosish bilan;
• Kontekstli menyudan Properties (Свойства) buyrug‘ini berish bilan.

Palitraning barcha uskunalari jadvalni tahrirlash va ko‘rsatkichlarini belgilash
uchun mo ijallangan. Endi palitraning boshqaruv elementlari bilan tanishib chiqamiz:

• Table Name (Имя таблицы) — jadval nomi;
• Rows (Строки) — qatorlar soni:
• Cols (Столбцы) — ustunlar soni;
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• W (Ширина) — jadvalning eni:
• H (Высота) — jadvalning balandligi;
• CellPad (Поля) — katakcha maydoni;
• CellSpace (Интервалы) — katakchalar orasidagi masofa;
• Align (Выравневание) — jadvalni tekislash;
• Border (Рамка) — katakcha vajadvalning ramkasi ko rinishi;
• Bg Color (Фоновый цвет) — fon rangi;
• Brdr Color (Цвет рамки) — katakcha vajadvalning ramkasi rangi;
• Bg Image (Фоновый рисунок) — fon sifatida qo‘yiladigan rasm;

Jadvalga qator va ustunlar qo'shish. Dasturda qator va ustunlami
qo'shishning bir nechta texnik usullari bor. Ularga menyu buy ruqlari, klaviaturada 
tugmalar kombinatsivasi va palitra bilan ishlash operatsiyalari kiradi.
Qator yoki ustun qo'shish quyidagicha amalga oshiriladi:

1. Jadvalning katakchasiga matn kursorini qo‘ying. Bu katakcha yangi qator yoki 
ustun qo‘vishda mo‘ljal vazifasini o‘taydi. Yangi qator qo‘vilsa katakcha ostidan, 
ustun esa katakchaning chap tomonidan qo‘yiladi.

2. Qo yish buyrug^ini bering. Bular quyidagi buyruqlar:
о Modify > Table > Insert Row (Изменить > Таблица > Вставить 

строки), Modify > Table > Insert Column (Изменить > Таблица > Вставить 
столбец), Modify > Table > Insert Rows or Columns (Изменить > Таблица > 
Вставить строки или столбцы). Birinchi ikkita buyruq bitta qator yoki ustun qo‘yib 
beradi. Oxirgi buy ruq Insert Rows or Columns (Вставка строк или столбцов) 
muloqot oynasini ekranga chiqaradi. Uning yordamida qator yoki ustunni tegishli 
ko rsatkichlar asosida qo‘vish mumkin:

о Yuqorida sanalgan barcha buyruqlami kontekstli menyu orqali ham bajarish 
mumkin.

о CTRL+M tugmalar kombinatsivasi bitta qator qo‘yib beradi. 
c. CTRL+SHIFT+A bitta ustun qo‘yib beradi.
о Property' Inspector (Инспектор свойств) palitrasini oching va jadvalni 

oichamlarini Rows (Строки) va Cols (Столбцы) maydonlaridan foydalanib 
belgilang.

Jadvalning qator yoki ustunlarini o‘chirish. Jadvalning qator va ustunlarini 
o‘chirish quyidagicha amalga oshiriladi:
1. Matn kursorini katakchaga qo‘ving.
2. Navbatdagi buyruqlami bersangiz, katakcha turgan qator yoki ustun o‘chiriladi:

о Modify > Table > Delete Row (Изменить > Tablitsa > Удалить строку') buyrug‘i 
yoki CTRL+SHIFT+M tugmalar kombinatsivasi;

о Modify > Table > Delete Column (Изменить > Таблица > Удалить столбец) 
buyrug‘i yoki CTRL+SHIFT+ - tugmalar kombinatsivasi.

Bundan tashqari biror qator yoki ustun to‘liq belgilangan bo‘lsa, u holda Delete 
tugmasini bosish bilan ham o‘chirish mumkin. Jadval qismlarini formatlash. 
Dreamweaver dasturi nafaqat jadvalni formatlash. balki uning tarkibiv qismlari: 
qatorlami, ustunlami va hatto katakchalarni alohida-alohida formatlashga imkon 
beradi. Jadvalning tarkibiv qismlarini formatlash Property' Inspector (Инспектор
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свойств) palitrasi yordamida bajariladi. Palitraning boshqaruv elementlari jadv alning 
katakchalar, qatorlar va ustunlari bilan ishlashiga imkon beradi.

Ulaming asosiy imkoniyatlari bilan tanishib chiqamiz:
. Cell (Ячейка). Boklimi o‘z ichiga ikkita tugmani birlashtiradi: Merges selected 

cells using spans (Объединить выбранные ячейки) va Splits cell into rows or 
columns (Разделить ячейку на строки или столбцы). Ular katakchalami 
birlashtirish (birinchisi) va bo'lish (ikkinchisi) uchun mo'ljallangan.

. W (Ширина). Katakchaning enini belgilaydi.

. H (Высота). Katakchaning balandligini belgilash uchun maydon.

. No Wrap (Без переноса). Bo‘g‘in ko‘chirish rejimini o‘chiradi.

. Header (Заголовок). Bu bayroqcha sarlavhani belgilaydi. Ya’ni bu ko‘rsatkich 
faol bo lganda, katakchadagi ma’lumot o‘rtaga tekislanib qalin shrift bilan yoziladi.

. Bg (Фоновый цвет) va Vg (Фоновый рисунок). Palitraning bitta nomdagi 
ikkita bo‘limi fon rangini va fonga qo‘yiladigan rasmni belgilaydi.

. Brdr (Цвет рамки). Tanlangan katak, qator yoki ustunning ramkasi rangini 
belgilaydi.

• Horz (Выравневание по горизонтали). Katakchadagi malumotni gorizontal 
bo'yicha tekislab beradi.

. Vert (Выравневание по вертикали). Katakchadagi ma lumotni vertikal 
bo‘vicha tekislab beradi.

Test savollari
1. Dreamweaver dasturida yangi sahifaning 6. Dreamweaver qanday tipdagi dastur? 
param etrlarini o'zgartirish uchun qaysi buyruq 
beriladi?
A ) M odify >  Page Properties buyrug'i yoki Ctrl + J 
tugmalar birga bosiladi
B ) Ctrl + J tugmalar birga bosiladi 
S) Kontekstli menyudan D esign  Notes for Page 
buyrug‘i beriladi
D ) M odify > Page Properties buyrug‘i yoki Ctrl +
W  tugmalar birga bosiladi
E) Tobg ‘ri javob v o ‘q

2. Dreamweaver dasturida yangi sahifaga fon 
berish to‘g‘ri ko‘rsatilgan qatom i toping?
A ) M odify >  Page Properties buyrug‘ini berib Page 
Properties oynasidan Backgrounddan rang 
tanlanadi
B ) Properties panelining Text Color qismidan rang 
tanlanadi.
C) M odify >  Page Properties buyrug‘ini berib Page 
Properties oynasidan Text dan rang tanlanadi.
D ) M odify >  Page Properties buyrug‘ini berib Page 
Properties oynasidan Links dan rang tanlanadi
E) To‘g ‘ri javob berilmagan

A) Hyper Text Markup Languagc-gipermatn 
belgilash tili
B) Dreamweaver animatsiyalar tayyorlash
S) Murakkab strukturali saytlar yaratish uchun 
qo‘llaniladi
D) 3 o‘lchamli animatsiyalarni tayy orlash
E) Rasmli formatlarga turli vizual effektlar berish

7. Quyidagilardan qaysi biri kod ish rejimiga 
o'tish hisoblanadi?
A) View > Code;
B) View -  Design;
C) View -  Code and Design;
D) View -Zoom;

8. Quyidagilardan qaysi biri dizayn ish rejimiga 
o‘tish hisoblanadi?
A) View -  Design;
B) View > Code;
C) View — Code and Design;
D) View-Zoom;

3. Dreamweaver dasturida sahifani freymlarga 
bo‘lish to‘g‘ri ko'rsatilgan qatom i toping?
A ) Sahifani yaratish vaqtida a w a l bo'lib olinadi
B ) Insert >  Frames buyrug'i beriladi
C ) Maxsus skriptlar kiritiladi
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9. Quyidagilardan qaysi b in  aralash ish itjim iga 
o'tish hisoblanadi?
A ) V iew  -  Code and Design;
B ) V iew  -  Design;
C) V iew  >  Code;
D ) V iew  -Z oom ;



D) Frames uskunalar panelidan freymlarga 
bo‘lishning mos shakli tanlanadi
E) To‘g"ri javob berilmagan

4. Dreamweaver dasturida sahkfaga rasm 
qo'yish uchun qaysi buyruq beriladi?
A) Insert > Image
B) Modify > Page Properties
C) Insert > Interactive Images
D) Insert > Interactive Images > Rollover Image
E) Insert > Table

5. Dreamweaver dasturida yangi sahifa yaratish 
ko‘rs»tilgan qatomi toping?
A) File > Save ibuvrug‘i beriladi yoki Ctrl+S
B) File > New buyrug‘i beriladi yoki Ctrl+N
C) File > Slose buvrug‘i beriladi yoki Ctrl+W
D) File > New buyrug‘i beriladi yoki Ctrl+S
E) File > Save buvrug‘i beriladi yoki Ctrl+N

10. Dreamweaver dasturining Modify 
(Изменить) menyusi qanday buyruqlarnj 
qam rab oigan?
A) o‘z ichiga gipermatnli hujjat ob’yektlarj 
atributlarini o ‘zgartirish buyruqlarini oladi
B) tahrirfash va qidirish bilan bog‘liq buyruqlar 
kiradi.
C) interfeysning yordamchi elementlarini va 
gipermatnli hujjat ob’yektlarining ko‘rinishlari 
ustida ishlovchi buyruqlami o‘z ichiga oladi.
D) har-xil ob'yektlami import qilish buyruqfan 
kiradi rasmlar, jadvallar, shakllar, qatlamlar 
maxsus belgilar va boshqa ob'yektlami import 
qilish.

32-§. Tizim tushunchasi. Axborot tizimlari

Tayanch tushunchalar: tizim, axborot tizimi, faktografik tizimlar, moddiy tizim, 
mavhum tizim, oddiy tizim, murakkab tizim. axborot tizimi. tizimning yaxlitligi, 
tizimning bo ‘linuvchanligi, tizimning turkumUmishi.

Tizim (sistema) deganda. vagona maqsad yo‘lida bir vaqtning o‘zida ham 
vaxlit, ham o‘zaro bog‘langan tarzda faoliyat ko‘rsatadigan bir necha turdagi 
elementlar majmui tushuniladi.

Hozirgi davrda fan va texnikada ko‘p foydalaniladigan tushunchalardan bin - 
tizimdir. Tizim - vunoncha so‘z bo‘lib, tashkil etuvchilardan iborat bir Ibutunlik degan 
manoni anglatadi. Zamonaviy sharoitda axborot tizimi axborotlarni qayta 
ishlashning asosiy texnik vositasi sifatida shaxsiy kompvuterlardan foydalanishni 
ko‘zda tutadi. Bundan tashqari. axborot tizimi tarkibiga inson ham kiradi, chunki 
ishlab chiqilayotgan axborot unga mo‘ljallangan boMadi va u siz bu axborotni olish 
yoki taqdim qilish mumkin emas.

Turli elementlardan tashkil topgan va turli maqsadlarga xizmat qiluvchi 
tizimlarga misollar 7.5-rasmda keltirilgan. Informatikada «tizim» tushunchasi 
kokproq, texnik vositalar va dasturlar to‘plamiga nisbatan ishlatiladi.

Kompyuteming texnik qismini «tizim» deb tasavvur etish mumkin. 
Shuningdek, hisobotlami tayyorlash va elektron hujjatlar oqimini boshqarish kabi 
amaliy vazifalami haJ qilishga mo‘ljallangan dasturlar to‘plamini ham «tizim» deb 
hisoblash mumkin. Kompyuter axborot tizimlari o‘zida apparatli vositalar, dasturiy 
ta’minot, ma’lumotlar bazasi, telekommunikatsiyalar, odamlar va axborotni to‘plash, 
qayta ishlash, saqlash jarayonlarining vagona to‘plamini taqdim qildi.
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Tizim turi Tizim elementlari
Tizimning asosiy 

maqsadi

Korxona Odamlar, qurilmalar, 
materiallar, bino va h.k.

v - :: Щ  

Mahsulot ishlab chiqarish

Kompyuter

S - a r f f i j f

Elektron va elektro-mexanik 
qurilmalar

Ma'lumotlarni qayta ishlash

TK tizim
Kommunikatsiya vositalari, 
eiementlar, aloqa kanallari, 

qurilmalar

Aloqa kanallarini о'гаго 
bog'lash va m a'lumot 

almashinuvini ta'minlash

Axborot tizimi
Kompyuteriar, kompyuter 

tarmoqlari, odamlar, 
axborot, dasturiy ta 'm inot va 

boshqalar

Axbortrttemi Uvtomatlashgan 
holda qayta Khlash

7.5-rasm. Tizimlar tasnifi 
7.6-rasmda axborot texnologiyalarining jihozlarga, dasturiy ta minotga, 

malumotlar bazasiga va telekommunikatsivalarga bogliqligi korsatilgan. 
Shuningdek telekommunikatsiyalar ham o‘z ichiga tarmoqlar intemetni birlashtiradi. 
Texnologik infratuzilma esa: o‘z ichiga apparat vositalar, dasturiy ta'minot, 
ma’lumotlar bazasi, telekommunikatsiyalar, odamlar va axborotni to'plash. qayta 
ishlash. saqlashga moslashgan jarayonlami birlashtiradi. Infratuzilma texnologiyasi 
o‘zida umumiy manbalar majmuini taqdim qiladi. Bunday manbalar axborot tizimlari 
bazasidagi har bir kompyuter asosini tashkil qiladi57.

57 Ralph M. Stair, George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology,
Cengage Learning. U SA  2012 11-p.
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7.6-rasm. Axborot texnologivalarining bogiiqhgi
Tizimi ami ulaming turli belgi lariga qarab turkumlash mumkin. Umuman 

olganda, tizimlar moddiy yoki mavhum boiishi mumkin (mavhum - inson ongi 
mahsuli).

Moddiy tizimlar asosan moddiy ob’yektlar to‘plamidan tashkil topadi. 0  z 
navbatida moddiy tizim anorganik (mexanik, kimyoviy) va organik (biologik) 
tizimga yoki aralash tizimga ajratiladi. Moddiy tizimlarda asosiy o'rinni ijtimoiy 
tizim egallaydi. Bunday tizimning xususiyatlaridan biri insonlar o‘rtasidagi 
munosabatlami aks ettirishdir.

Mavhum tizimlar inson ongining mahsuli boiib, har xil nazariyalar, bilimlar, 
farazlardan iborat. Yangi axborot texnologivasi ham moddiy tizim unsurlarini 
(kompyuterlar, hujjatlar, insonlar), ham nomoddiy tizim unsurlarini (matematik 
modellar, inson bilimlari va hokazo) o‘z ichiga oladj.

Shunday qilib, tizim - bu o‘zaro bog‘liq va yagona maqsadga erishish uchun 
ma lum qoida asosida o‘zaro munosabatda boiadigan unsurlar to‘plami. Bu unsurlar 
to'plami oddiy unsurlar yigindisidangina iborat boimay, har bir unsur ham o‘z 
navbatida tizim boiishi mumkin.

Tizimlar tuzilishi bo‘yicha oddiy yoki murakkab boiishi mumkin.
Oddiy tizimlarni tashkil etuvchi unsurlar soni kam boiib, sodda tuzilishga 

ega boiadi.
Murakkab tizimlar esa, bir nechta unsurlardan tashkil topgan boiib bu 

unsurlar ham o‘z navbatida alohida tizimlarga boiinishi mumkin.
Vaqt davomida o‘zgarishiga qarab tizimlar statik va dinamik turlarga 

ajratiladi. Statik tizimda vaqt davomida o‘zgarish boimaydi. Dinamik tizimda esa, 
vaqt oiishi bilan holat o'zgarib boradi.

Tashqi muhit bilan boiadigan aloqasiga qarab ochiq yoki yopiq tizimlar 
boiishi mumkin. Ochiq tizimlar tashqi muhit bilan faol aloqada boiadi. Yopiq 
tizimlaming unsurlari esa tashqi muhitdan ta’sirlanmaydi.
Axborot tizimlarini ikkita asosiy guruhga ajratish mumkin:
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1. Axborot ta rninot tizimi.
2. Maqsadli faoliyat ko'rsatuvchi tizim.

Axborot ta ’minoti tizimi har qanday avtomatlashgan boshqaruv tizimining tarkibiga 
kiradi. Hozirgi davrga kelib quy idagi avtomatlashtirilgan tizimlar paydo boidi:

1) Loyihalashtirishning avtomatlashtirilgan qismi;
2) Ilmiy izlanishning avtomatlashtirilgan qismi;
3) Korxonaning avlomatlashtirilgan boshqarish tizimi.
Maqsadli faoliyat ko‘rsatuvchi tizimlar tarkibiga:
1) Axborot qidiruv tizimi;
2) Axborot ma’lumotnoma beruvchi tizim;
3) Axborot boshqaruvchi tizim kiradi.
Axborot - qidiruv va axborot - ma’lumotnoma beruvchi tizimlar foydalanuvchi 

tomonidan berilgan talabga mos ravishda tegishli axborotlarni saqlash va taqdim etish 
uchun mo'ljallangan. Bunday tizimlar faoliyati ikki qismdan iborat:

1. Axborotni yig‘ish va saqlash.
2. Axborotlarni qidirish va foydalanuvchiga berish.
Maiumotlami tarqatish usuliga ko‘ra axborot qidiruv tizimlari quyidagi uch 

turga boiinadi:
1. Axborot qidirishni tartibli amalga oshiruvchi tizim
2. Berilgan talab bo‘vicha qidirishni amalga oshiruvchi tizim.
3. Umumlashtirilgan tizim.
Axborot tizimlari deyarli barcha mavjud kasblarda qo‘llaniladi. Ta'lim 

muassasalarida ta’limni tashkil qilish va boshqarish, shuningdek masofaviv ta’limni 
tashkil qilish uchun qo'llanilsa, tadbirkorlar va kichik biznes egalari esa butun 
dunyoda mavjud mijozlari bilan ozaro aloqani tashkil qilish uchun foydalanadilar. 
Savdo vakillari esa axborot tizimlarini mahsulotlarini reklama qilish uchun, mijozlar 
bilan muloqot qilish uchun, shuningdek savdo tendentsiyasini tahlil qilish uchun 
qoMlaniladi. Menejerlar esa ulami ko‘p millionli qarorlar qabul qilishda qo‘llaydilar. 
Masalan, ishlab chiqarish bo yicha zavod qurish kerakmi yoki saraton kasaliga davo 
boiadigan tadqiqot olib borish kerakmi? Moliyaviy maslahatchilar esa axborot 
tizimlarini o‘z mijozlariga maslahatlar berish maqsadlarida foydalanishi mumkin58.

Belgilangan maqsadga erishish uchun axborotlarni shakli va mazmuniga ko‘ra 
turlarga ajratish, ulami saqlash, izlash va qayta ishlash printsiplariga, qayta ishlashda 
qo‘llaniladigan usullar, shaxslar hamda vositalaming o‘zaro bog‘langan majmuiga 
axborot tizimi (AT) deyiladi.

Axborot tizimining vazifasi. Axborotlarga asoslangan, maqsadi oldindan 
belgilangan va shu maqsadga erishish dasturi ishlab chiqilgan boshqariluvchi 
jaray onga maqsadli ta’sir ko'rsatish - qaror qabul qilish deb ataladi. Qaroming 
shakllanish jarayoni esa - qaror qabul qilish jaray oni deb yuritiladi. Tashkilotni 
boshqarish doirasida mehnat taqsimotiga muvofiq qabul qilinadigan qarorlar 
boshqaruvning u yoki bu vazifasiga kiradi.

58 Ralph M. Stair, George W.ReynoWe. Fundamentals o f  Information Systems. Sixth edition. Course Technology,
Cengage Learning. USA. 2012. 4-p.



Qaror qabul qilish jarayonini ta'mmlash, ya’ni avnan, kerakli axborotni kerakli 
vaqtda va kerakli joyga taqdim etish - tashkilot axborot tizimining asosiy 
vazifalaridan biridir. Shu bois ham qaror moxiyati, uni qabul qilish jaravoni, qaror 
qabul qiiishning barbod bo‘lishi tashkilotning axborot tizimi faoliyatiga u yerda 
qoilaniladigan texnologiyaga sezilarli ta’sir qiladi va hatto axborot tizimining butun 
boshli sinfi - qaror qabul qilish tizimini shakllantirish zaruriyatini keltirib chiqaradi.

Tashkilotni boshqarishning yuqorida ko rib chiqilgan tizimi albatta, unga 
kibemetik nuqtai nazardan yondashuviga ko ra belgilangan. Agar boshqaruv tizimi 
haqida ayrim mavhumliklarsiz gapiradigan boisak, yuqorida qayd etilganlardan 
tashqari tashkilotning boshqaruv tizimiga uning tashkiliy tarkibi, xodimlar, vazifani 
bajarish choralarini ko'rish. tashkilotning ichki madaniyati va hokazo omillar ta’sir 
ko‘rsatadi

Axborot tizimining asosiy vazifasiga berilgan turdagi axborotni izlash, uni 
qayta ishlash va qisqa vaqt ichida kerakli joyga uzatish masalalarini hal qilish kiradi. 
Kompyuter axborot tizimi bilan samarali ishlaydigan elektron qurilmadir.

Axborat tizimining ta’rifiga muvofiq amalda har bir iqtisodiy ob’yektni о‘г 
faolivat yuritishida belgilangan maqsaga erishishga harakat qiluvchi tizim sifatida 
ko‘rib chiqish mumkin. Misol sifatida taiim , energetika, transport, iqtisodiy va 
boshqa tizimlarni aytish mumkin. Tizim uchun quyidagi asosiy xususiyatlar 
xosdir:

• Tizimning murakkabligi;
• Tizimning boiinuvchanligi;
• Tizimning yaxlitligi;
• Tizim elementlarining ko‘p turliligi va ular tabiatining xilma-xilligi;
• Tizimning tarkiblashtirilganligi.

Tizimning murakkabligi -  unga kiruvchi tarkibiy qismlaming ko'pligi, 
ularning tarkibiy o'zaro hamkorligi, ishlab chiqarish va tashqi aloqalaming 
murakkabligiga hamda dinamikligiga bogiiq.

Tizimning boiinuvchanligi -  uning belgilangan alomati bo‘vicha ajratilgan, 
aniq maqsadlar va vazifalarga javob beruvchi bir qator tizimchalar va elementlardan 
iboratligini bildiradi.

Tizimning yaxlitligi -  tizimning ko'pgina elementlarini faoliyat yuritishi 
vagona maqsadga bo'ysunishini bildiradi.

Tizim elementlarining ko‘p turliligi va ular tabiatining xilma-xilligi ularning 
vazifaviy o'ziga xosligi va alohidaligi bilan bogiiq.

Tizimning tarkiblashtirilganligi -  tizim ishlab chiqarishidagi elementlar 
o'rtasida o'matilgan aloqalar va munosabatlar mavjudligini, tizim elementlarining 
iyerarxik pog'onalari bo'yicha taqsimlanishini belgilab beradi.

Axborot tizimlarining turkumlanishi. Axborot tizimini yaratish va undan 
foydalanish qo'yiladigan maqsadga muvofiq boiishi lozim. Aks holda undan 
foydalanish ma’noga ega boimaydi. Shu ma’noda maiumotlar bazalarini umumiy 
bir turda tasnif qilish mushkul. Bazi tizimlar esa umuman tasnif qilinmaydi.

Biznes tashkilotlarda qoilaniladigan axborot tizimlarining eng keng tarqalgan 
turi elektron va mobil tijoratga moijallangan boiib, ko'chirmalami qayta ishlash,
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axborotni boshqarish va qarorlar qabul qilishni qoilab-quvvatlashga moijaJIangan. 
LJndan tashqari ayrim tashkilotlar virtual voqelik kabi ixtisoslashgan tizimlami

‘jlaydilar. Bunday tizimlar haqida elektron tijorat mavzusida batafsil ma’lumot
4 . 50 
olamiz

Bajaradigan vazifasiga ko ra axborot tizimlarining ikki turini ajratamiz va 
ulaming mazmuni bilan tanishib chiqamiz.

Ma lumotlar bazalarini shartli ravishda ikki turga ajratish mumkin: 
b i r i n c h i s i  —  foydalanuvchilar uchun biror tashkilot (o‘quv muassasasi, xususiy 
shaxs va h.k.) yoki firma tomonidan yaratilgan va umumiy bo‘lgan ma’lumotlami 
beruvchi tizimlar, ikkinchisi — ma lum dastur asosida ma’lumot beruvchi 
ma’lumotlar bazasini yaratish.

Birinchi turdagi ma’lumotlar bazasi qo'yilgan masalalarga aniq javob bera 
oladi va ularga shartli ravishda axborot-ma’lumotnomali tizimlar, axborot-izlashli 
tizimlari va ma’ lumotlami tezkor qayta ishlash tizimlarini kiritish mumkin.

Axborotlami izlovchi tizimlar (ma’lumotnomalar) to‘plangan bilimlami vig‘ish, 
ro‘yxatlash, turlarga ajratish va undan foydalanish imkonini beradi (masalan, telefon 
ma’lumotnomalari, xodimlar haqida ma lumotlar va h.k). Bunday ma’lumotlar bazasi 
vangi bilimlar manbai vazifasini bajarishi ham mumkin.

Ma'lumotlami tezkor qayta ishlash tizimlari kopgina amaliy masalalami hal 
qilish, ishlab chiqarishni boshqarish, baxgalteriya hisoboti va hokazolami hal qilishga 
mo‘ljallangan bo‘ladi.

Hajmi va ma’lumotlaridan foydalanishga ko‘ra axborot tizimlari quyidagilarga 
ajaratiladi:

• avtonomyoki «shaxsiy» axborot tizimlari;
• «fayl-server» texnologiyasi bo'yicha qurilgan oddiy tarmoqli axborot tizimlari;

• «klient server» tuzilishiga ega quvvatli axborot tizimlari. Endi faktografik tizimlami 
ta’riflashga o‘tamiz. Ko‘rinishi sodda va qo‘yilgan masalalarga yagona aniq 
yechimni ko‘rsata oladigan tizimlar faktograflk tizimlar deyiladi. Faktografik 
tizimlami universal va maxsus tizimlarga ajratish mumkin.

Universal tizimlar turli sohalardagi har qanday ma’lumot bilan ishlashi 
mumkin. Bu tizimda asosiy vazifa kiritilgan ma lumotlar bazasidan to 'g^i foydalana 
olishdir. Universal tizim ma lum ma’noda televizorga o‘xshaydi, chunki u hamma 
narsani xokkey o4ini, simfonik konsert, badiiv film va boshqalami ko‘rsataveradi.

Tizimning maqsadi odatda foydalanuvchining so‘roviga ko‘ra uni qanoatlantira 
oladigan darajada javob berishdir. Masalan, «kuchlanish» sokzi ishlatiladigan barcha 
maqolalar ro'yxatini ekranga chiqarish masalasini qaraylik. Hujjatli tizimning asosiy 
xossalaridan biri shundaki, foydalanuvchiga kerakli hujjatlami bermasdan (masalan, 
«kuchlanish» so‘zi boshqa ma'noda ishlatilgan axborotlar) kerakli ma'lumotlami 
berishidir (masalan, muallif «kuchlanish» so‘zini noto‘g‘ri vozib yuborganda). 
Hujjatli tizim biror-bir iborani gapda qanday ma’noda kelishiga qarab ajrata olishi 
kerak (masalan. qisqichbaqa hayvon, qisqichbaqa yulduzlar turkumi, rak 
(qisqichbaqa) — kasallik).

59 Ralph M. Stair, George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology,
Cengage Leaning USA. 2012. 15-p.
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1. Faktografik tizim nima?
2. Tizimning elementlaming ko‘p turliligi nima?
3. Tizimning tarkiblashtirilganligi nima?
4. Axborot tizimlarining turkumlanishi nima?
5. Tizimning murakkabligi nima?
6. Tizimning bo‘linuvchanligi nima?
7. Tizimning yaxlitligi nima?

Savol va topshiriqlar

Test savollari
1. Tizim nima?
A) yagona maqsad yoMida bir vaqtning o ‘zida ham 
yaxlit, ham o‘zaro bog‘langan tarzda faoliyat 
ko‘rsatadigan bir necha turdagi elcmentlar majmui 
tushuniladi.
B) belgilangan maqsadga erishish uchun 
axborotlarni shakli va mazmuniga ko‘ra turlarga 
ajratish, ularna saqlash, izlash va qayta ishlash 
printsiplariga, qayta ishlashda qoMlaniladigan 
usullar. shaxslar hamda vositalarning o‘zam 
bog‘langan majmui.
C) asosan moddiy ob’yektlar to‘plamidan tashkil 
topadi. o‘z navbatida moddiy tizim anorganik 
(mexanik, kimvoviy) va organik (biologik) tizimga 
yoki aralash tizimga ajratiladi.
D) har-xil ob'yektlami import qilish buvruqlari 
kiradi: rasmlar, jadvallar, shakllar, qatlamlar. 
maxsus belgilar va boshqa ob’yektlarni import 
qilish.

2. Axborot tizimi nima?
A) belgilangan maqsadga erishish uchun 
axborotlarni shakli va mazmuniga ko‘ra turlarga 
ajratish. ulami saqlash, izlash va qayta ishlash 
printsiplariga. qayta ishlashda qoilaniladigan 
usullar. shaxslar hamda vositalarning o‘zaro 
bogiangan majmui.
B) yagona maqsad yoiida bir vaqtning o ‘zida ham 
yaxlit, ham o'zaro bog‘langan tarzda faoliyat 
ko‘rsatadigan bir necha turdagi elementlar majmui 
tushuniladi.
C) asosan moddiy ob’yektlar to‘plamidan tashkil 
topadi. o ‘z navbatida moddiy tizim anorganik 
(mexanik, kimvoviy) va organik (biologik) tizimga 
yoki aralash tizimga ajratiladi.
D) har-xil ob’yektlami import qilish buvruqlari 
kiradi: rasmlar, jadvallar, shakllar, qatlamlar, 
maxsus belgilar va boshqa ob’yekUaini import 
qilish.
4. Moddiy tizim nima?
A) asosan moddiy ob’yektlar to'plamidan tashkil 
topadi. o‘z navbatida moddiy tizim anorganik 
(mexanik, kimvoviy) va organik (biologik) tizimga 
yoki aralash tizimga ajratiladi.

6. Oddiy tizim nima?
A) tashkil etuvshi unsurlar soni kam bo‘lib, sodda 
tuzilishga ega bo‘ladi.
B) asosan moddiy ob’yektlar to‘plamidan tashkil 
topadi. o ‘z navbatida moddiy tizim anorganik 
(mexanik, kimvoviy) va organik (biologik) tizimga 
yoki aralash tizimga ajratiladi.
C) inson ongining mahsuli bo‘lib, har xil 
nazariyalar, bilimlar, gipotezalardan iborat.
O) bir nechta unsurlardan tashkil topgan boMib bu 
unsurlar ham o‘z navbatida aiohida tizimlarga 
bo'linishi mumkin.

7. M urakkab tizim nima?
A) bir nechta unsurlardan tashkil topgan bolib bu 
unsurlar ham o‘z navbatida aiohida tizimlajga 
boMinishu mumkin.
B) asosan moddiy ob’yektlar to‘plamidan tashkil 
topadi. o ‘z navbatida moddiy tizim anorganik 
(mexanik, kimvoviy) va organik (biologik) tizimga 
yoki aralash tizimga ajratiladi.
C) inson ongining mahsuli bo‘lib. har xil 
nazariyalar, bilimlar. gipotezalardan iborat.
D) tashkal etuvshi unsurlar soni kam bo "lib, sodda 
tuzilishga ega bo'ladi.

8. Statik tizim nima?
A) vaqt davomida o'zgarish boMmaydi Dinamik 
tizimda esa, vaqt o'tishi bilan holat o‘zgarib boradi.
B) bunday tizimlar tashqi muhit bilan faol aloqada 
bo‘ladi.
C) bunday tizimlar unsurlari esa tashqi muliitdan 
ta’sirlanmaydi.
D) har-xil ob’yektlami import qilish buyruqlari 
kiradi: rasmlar, jadvallar, shakllar, qatlamlar, 
maxsus belgilar va boshqa ob’yektlarni import 
qilish.

9. Ochiq tizim nima?
A) bunday tizimlar tashqi muhit bilan faol aloqada 
bo'ladi.
B) vaqt davomida o‘zgarish boMmaydi. Dinamik 
tizimda esa, vaqt o ‘tishi bilan holat o‘zgarib boradi.
C) bunday tizimlar unsurlari esa tashqi muliitdan
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ол inson ongining mahsuli boiib, liar xil 
„azarivalar. bilimlar, gipotezalaidan iborat.
О  tashkil etuvshi unsurlar soni kam boiib, sodda 
tuzilishga ega boiadi. . . . . . . .
n ) bir nechta unsurlardan tashkil topgan boiib bu 
unsurlar ham o‘z navbatida alohida tizimlarga 
bo'linishi mumkin.

5. Mavhum tiiini nima?
Д) inson ongining mahsuli boiib, liar xil 
„azanyalar, bilimlar, gipotezalaidan iborat 
3) asosan moddiy ob’yektlar to‘plamidan tashkil 
topadi o‘z navbatida moddiy tizim anorganik 
(mexanik, kimyoviy) va organik (biologik) tizimga 
yoki aralash tizimga ajratiladi.
C) tashkil etuvshi unsurlar soni kam boiib. sodda 
tuzilishga ega boiadi.
D) bir nechta unsurlardan tashkil topgan boiib bu 
unsurlar ham o‘z navbatida alohida tizimlarga 
bolinishi mumkin.

ta’sirlanmavdi
D) har-xil ob’vektlarni import qilish buyruqlari 
kiradi: rasmlar, jadvallar, shakllar, qatlamlar, 
maxsus belgilar va boshqa ob’yektlami import 
qilish.

10. Yopiq tizim nima?
A) bunday tizimlar unsurlari esa tashqi muhitdan 
ta’sirlanmavdi.
B) vaqt davomida o‘zgarish bolmaydi. Dinamik 
tizimda esa, vaqt o‘tishi bilan holat o ‘zgarib boradi.
C) bunday tizimlar tashqi muhit bilan faol aloqada 
boiadi
D) har-xil ob’yektlami import qilish buyruqlari 
kiradi: rasmlar. jadvallar, shakllar, qatlamlar. 
maxsus belgilar va boshqa ob’yektlarni import 
qilish.

33-§. Avtomatlashtirilgan ish joylari

Tayanch tushunchalar: avtomatlashgan ish jo y l mutaxassis, rahbar, axborot 
ta ’minoti, texnik ta ’minot, huquqiy ta ’minot. do'stonalik, moslashuvchanlik, 
samaradorlik, lingvistik ta minot, matematik ta minot, tashkiliy ta minot.

Boshqaruv tizimining ikkita asosiy turi farqlanadi:

Texnologik 
jaravonlami 

boshqaruv tizimi

Informatsion 
boshqaruv tizimi

7.7-rasm. Boshqaruv tizimining ikkita asosiy turi 
Avtomatlashtirilgan ish joylari - rahbar, mutaxassis yoki xizmat ko‘rsatuvchi 
xodimlarning vazifasini almashtirish emas. balki ularning faoliyatiga yordam berish, 
va ni ularga qulay ish sharoiti yaratish tushuniladi. Hozirgi davrda barcha 
avtomatlashgan ish joylari (AIJ) asosida beshta texnologik tizimcha ta’minoti 
mavjud:

• ish faoliyatini ta minlovchi:
• kasbiy faoliyatni ta'minlovchi;
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bevosita ishlab chiqarish jarayonlarini jismoniy 
darajadagi boshqarish jarav oni;

obVektlar bilan tashkiliv xarakterdagi ishlarni olib 
borish. boshqaruv ob’vektlarining boshqaruv 
va/il'alanni yechishga moijallangan.



• qarorlar qabul qilish:
• qo'lda bajariladigan ishlar;
• kommunikatsiya.

AIJning axborot ta’minoti quyidagicha:
• tezkor faoliyat ish to‘plami:
• elektron taqvim;
• elektron haftalik;
• elektron yozuv daftarchasi;
• shaxsiy arxiv;
• topshiriqlar kartotekasi;
• turli axborot — ma’lumotnomah tizimlar, tahliliv kartotekalar, ekran grafikasi 

vositalaridan iborat axborotlami izlash va tahlil qilish vositalari;
• iqtisodiy-matematik modellar, elektron jadvallar, qarorlar qabul qilish 

modellaridan iborat boshqaruv va iqtisodiy jarayonlarni modellashtirish 
vositalari:

• bilimlar bazasidan iborat ekspert tizimlari;
• turli mantiqiy-hisoblash masalalarini vechish vositasi;
• matnli va rasmiy axborotlami qayta ishlash vositasi.

«Do‘stonalik» deganda - foydalanuvchini muloqot tartibida qulay va oson 
ishlashi tushuniladi. Bunda tizimga maksimal kirish imkoniyati yaratiladi. Hech 
qanday muammolarsiz turli sharoitlardan oson chiqib ketish yoilarini ko‘rsatuvchi 
ma lumotlar bilan to‘ldirilishi lozim. Hujjatlar odatdagi ko‘rinishda, ular bilan ishlash 
murakkab boMmasligi kerak.

«Moslashuvchanlik (egiluvchanlik)» - deganda, yangi xarakteristikalar, 
belgilar kiritish yoki olzgartirish imkoniyati nazarda tutiladi. Masalan, ekran rangini 
yoki hujjat ko'rinishini o‘zgartirish.

«Saniaradorlik» - deganda, muomala qilingandan boshlab yakuniv natijani 
olish uchun ketgan vaqt tushuniladi.

Bu uch ko rsatkich AUda quyidagi uch asosiy funktsivani amalga oshirishni 
ta’minlaydi:

• matnlami ekranda qayta ishlash;
• shakllami ekranda qayta ishlash;
• ish grafikasini ekranda qayta ishlash.
Rahbarning AIJ o'zimng tuzilmasiga ko‘ra quyidagilarga bo'linadi:
□  Rahbarning yoyilgan AIJ — monitor, klaviatura hamda sichqonchadan iborat 

va boshqa barcha funktsional qismlar uning yordamchisi yoki kotibada bo‘ladi.
□  Lokallashgan tuzilma avtonom ishlash va funktsional yopiqlik bilan 

ta’minlanadi.
Rahbarning AIJni yaratishda ikkita asosiy funktsiya hisobga olinadi:

□  tezkor boshqarish
□  qarorlar qabul qilish.

Shuning uchun ham, rahbarning AIJ quyidagi talablarga javob berishi kerak:
□  doimiy ravishda ishonchli axborotlar bilan toMdirilib boriluvchi, kirish 

chegaralangan, rivojlangan ma’lumotlar bazasi (MB):
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□  axborotlarni tezkor izlash;
□  axborotlarni ko'rgazmali tasvirlash;
□  haqiqiy sharoitga maksimal moslashtirilgan. ishlash uchun optimal kinsh 

sharoitini ta'minlovchi muloqot dasturiy vositalarning mavjudligi;
□  boshqa axborot manbalari bilan tezkor aloqani ta’minlash;
□  texnik va dasturiy vositalarning yuqori ishonch bilan ishlashi hamda oddiy ligi;
□  AIJ xotirasida qabul qilingan qarorlar tajribasini to plash imkoniyati 

mavjudligi.
• Mutaxassisning AIJ. Mutaxassis — bu ma’lum bir sohaning kasb egasidir. 

Uning AIJ shunday boMishi lozimki. u shaxsiy hamda muassasaning MBdagi 
axborotlar asosida tahliliy ish bajarishi va natijani biror hujjat sifatida taqdim 
etishi lozim.

• Odatda, ma’lum bir ishni bajarishga ketgan vaqtning 40%i uni 
shakllantirishga ketadi
Mutaxassisning kasbga yo'naltirilganligi AIJning dasturiy va texnik 

ta’minotiga boigan talabini belgilaydi:
• shaxsiy va umumiy (global) MB bilan ishlash imkoniyati;
• boshqa axborot manbalari bilan kommunikatsion muloqot qilish imkoniyati;
• to‘plangan tajribalar asosida tahlil qilinayotgan jarayonlami modellashtirish 

imkoniyati;
• tizimning yuqori darajadagi ko‘p funktsiyaliligi va moslashuvchanligini 

ta'minlash.
• Bu talablardan kelib chiqib, mutaxassisning AIJ ish va kasbiy faoliyatlarni, 

qo'lda bajariladigan ishlami hamda kommunikatsiya aloqalarini ta'minlovchi 
tizimchalardan iborat bo‘lishi kerak.

Mutaxassis AIJda quyidagi operatsiyalami bajaradi:
□  klaviatura yordamida hujjatlardan ma’lumotlami kiritish (ekranda vizual 

nazorat qilish bilan);
□  kompyuterga ma’lumotlami magnit tashuvchilardan, boshqa AIJdan kiritish:
□  lokal hisoblash tarmog’ida boshqa AUdan aloqa kanallari orqali ma'lumotlami 

xabarlar sifatida qabul qilish;
□  ma’lumotlami tahrirlash va ular bilan amallar bajarish;
□  ma’lumotlami to'plash va saqlash;
□  ma’lumotlami izlash, vangilash va himoyalash;
□  foydalanuvchining natijaviy axboroti, shuningdek, turli ma'lumotnomalar va 

yo'riqnomali xabarlami ekranga chop etish qurilmalariga va magnit 
tashuvchilarga chiqarish;

□  ma’lumotlami shakllantirish va boshqa AIJga fayl sifatida magnit 
tashuvchilarda yoki hisoblash tarmog'ida aloqa kanallari orqali uzatish;

□  so‘rovlar bo'yicha tezkor ma'lumotnomalar olish.
Boshqaruv ob'yekti xarakteridagi farq:
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7.8-rasm. Boshqaruv ob yekti xarakteri 
Axborot ta'minoti. AATEXda aylanadigan axborotlami tashkil qilish 

shakllari, joylashtirish, hajmi bo‘yicha loyihaviy vechimlar majmnasidan tarkib 
topgan. Bu ko‘rsatkichlar, ma'lumotnomalar, klassifikatorlar va axborotlami 
kodlashtiruvchilar, avtomat xizmat ko‘rsatish uchun maxsus tashkil qilingan 
hujjatlami umversallashtiruvchi tizimlar, mashina tashuvchilaridagi axborot 
massivlari, shuningdek, axborotlami ishonchli saqlash, o z  vaqtida va sifatli qayta 
ishlashni ta’minlovchi xodim faoliyatini o‘z ichiga oladi.

Lingvistik ta’niinot. Tabiiy tilni shakllantirish uchun til vositalari majmuasini 
birlashtiradi. Bu ta’minot orqali mashinaning inson bilan muloqoti amalga oshiriladi. 
Lingvistik ta’minot AATEX axborot bazasi (hujjatlar, ko‘rsatkichlar, rekvizitlar va 
shu kabilar) tuzilmaviv birligini ifodalovchi axborot tili; AATEX axborot bazasi 
malumotlarini manipulyatsiya qilish va boshqarish tillari; axborot-qidiruv tizimi 
vositalari; AATEXni avtomat loyihalashtiruvchi til vositalari; maxsus moMjallangan 
muloqot tillari va boshqa tillar; avlomat boshqaruv tizimini ishlab chiqish va ishlash 
jarayonida fovdalanadigan atamalar hamda ta’riflar tizimini o‘z ichiga oladi.

Texnik ta’minot. AATEX ishini ta’minlovchi (axborotlami yig‘ish, qavd 
qilish, uzatish, qayta ishlash, tasvirlash, ko‘paytirish texnik vositalari, orgtexnika va 
shu kabi) texnik vositalar majmuasidan tashkil topgan. Barcha texnik vositalar 
o'rtasida markaziy o‘rinni kompvuter egallaydi. Texnik taminotning tuzilmasi 
elementlariga texnik vositalar qatori uslubiy va mamuriy materiallar, texnik hujjatlar 
va ushbu texnik vositalarga xizmat qiluvchi xodim ham kiradi.

Dasturiy ta’minot. AATEX masalalan va vazifalarini amalga oshiruvchi 
hamda texnik vositalar majmuasining bir me’yorda ishlashini ta’minlovchi dasturlar 
majmuasidan iborat. Dasturiy ta'minot tarkibiga umumtizimli va maxsus dasturlar, 
shuningdek, dasturiy ta’minot vositalarini qo‘llash bo‘yicha uslubiv-yo‘riqnomali 
materiallar va uni ishlab chiqish hamda AATEXni butun faoliyatini kuzatib boruvchi 
xodim kiradi.
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Mateniatik ta’minot. AATEXni loyihalashtirish ishini avtomatlashtirish 
jarayonida va funktsional masalalarni yechishda ishlatiladigan, axborotlami qayta 
jshlash algoritmi va modellari, matematik usullar to^lamidan iborat. Matematik 
ta'minot boshqaruv jarayonini modellashtirish vositalari. boshqaruvning namunaviy 
masalalarini yechish vosita va usullari, tekshirilayotgan boshqaruv jarayonlarini 
optimallashtirish usullari va qarorlar qabul qilish (kcTp kriteriyali optimallashtirish. 
matematik dasturlashtirish, matematik statistika, ommaviy xizmat qilish nazariyasi) 
va shu kabi omillardan tashkil topgan. AATEXning bu turdagi taminotining texnik 
hujjatlari masalani ifodalash, algoritmlashtirish bo‘yicha topshiriqlar, masalaning 
iqtisodiy- matematik modeli va yechimining nazorat misoli va matnidan iborat 
boiadi.

Tashkiliy ta'minot. Avlomatlashtirilgan axborot tizimi faoliyati sharoitida 
AATEX xodimning ish tartibini belgilovchi hujjatlar majmuasini tashkil qiladi. 
Boshqaruv masalalarini yechish jarayonida bu turdagi ta'minot boshqaruv xizmati 
xodimlarining va AATEXni texnik vositalar bilan o‘zaro harakatlarini belgilay di. 
Tashkiliy ta’minot turli uslubiy va rahbariyat materiallarida AATEX va AATni ishlab 
chiqish, qoilash va ishlatish bosqichlarida joriv etiladi Xususan, awalgi tekshirish 
o‘tkazishda, texnik masalani loyihalashtirish va texnik-iqtisodiy asoslashni 
shakllantirishda hamda loyiha yechimini ishlab chiqish jarayonida, 
avtomatlashtiriladigan masalani, namunaviy loyihaviy yechimlar va amaliy dasturlar 
to‘plamini tanlashda, tizimni qo‘llash va ishlatishda amalga oshiriladi.

Huquqiy ta’minot. AATEX va AATni ishlab chiqish, qo'llash va ishlatish 
bosqichlarida huquqiy munosabatlami belgilaydigan huquqiy me’yyorlar majmuasini 
tashkil qiladi. Huquqiy ta'minot AATEX va AATni ishlab chiqish bosqichida 
buyurtmachi hamda ishlab chiquvchi o'rtasidagi shartnomaviy munosabatlar bilan 
bog‘liq me’yyoriy dalolatnomalami, bu jarayondagi turli chekinishlami huquqiy 
yo‘lga solishni o‘z ichiga oladi.

Ergonometrik ta’minot. Ishlab chiqish va faoliyatning turli bosqichlarida 
ishlatiladigan usullar va vositalar majmuasidan iborat boiib, insonning faoliyatida 
xatosiz vayuqori samarali, ya ni tezroq o^lashtirish uchun optimal sharoit varatishga 
mo'lj al king an Ergonometrik ta’minot tarkibiga quyidagilar kiradi:

□  ishjoylariga,
□  axborot modellariga,
□  xodim faoln ati sharoitlariga qo‘viladigan ergonometrik talablardan iborat turli 

hujjatlar, shuningdek, bu talablami amalga oshirish uchun eng ma qul usullar 
majmuasi.
Avlomatlashtirilgan axborot tizimlari va texnologiyalarining qo'llanilish 

jabhalari:
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Statistikada

Buxgalteriya hisobida

Bank faoliyatida

Marketing faoliyatida

Sug'urta faoliyatida

Soliq xizmatida

Birja faoliyatida

7.9-rasm. Avtomatlashtirilgan axborot tizimlari va texnologivalarining qo'llanilishi 
Avtomatlashtirilgan axborot tizimlari va texnologiyalari ko‘plab jabhalarda 

mutaxassis va rahbaming ish faoliyati samaradorligini ta minlash maqsadida 
qo‘llaniladi.

Test savollari
1. Texnukigik jarayunlarni boshqaruv tizimi 
nima?
A) bevosita ishlab chiqarish jarayonlarini jismoniy 
darajadagi boshqarish jarayoni;
B) ob’yektlar bilan tashkiliy xarakterdagi ishlami 
olib borish, boshqaruv ob’yektlarining boshqaruv 
vazifalarini yechishga mo‘ljallangan.
C) rahbar. mutaxassis yoki xizmat ko‘rsatuvchi 
xodimlaming vazifasini almashtirish emas, balki 
ulaming faoliyatiga yordam berish. va’ni ularga 
qulav ish sharoiti yaratish tushuniladi
D) foydalanuvchini muloqot lartibida qulay va oson 
ishlashi tushuniladi

2. Infurmatsion boshqaruv tizimi nima?
A) ob’yektlar bilan tashkiliy xarakterdagi ishlami 
olib borish. boshqaruv ob’yektlarining boshqaruv 
vazifalarini yeehishga moijallangan.
B) bevosita ishlab chiqarish jaruyonlarira jismoniy 
darajadagi boshqarish jarayoni;
C) rahbar. mutaxassis yoki xizmat ko‘rsatuvchi 
xodimlaming vazifasini almashtirish emas, balki 
ulaming faoliyatiga yordam berish. va ni ularga 
qulay ish sharoiti yaratish tushuniladi.
D) foydalanuvchini muloqot tartibida qulay va oson 
ishlashi tushuniladi

3. Avtomatlashtirilgan ish joylari nima?

C) foydalanuvchini muloqot tartibida qulay va oson 
ishlashi tushuniladi.
D) rahbar, mutaxassis yoki xizmat ko‘rsatuvchi 
xodimlaming vazifasini almashtirish emas. balki 
ularning faoliyatiga yordam berish, ya’ni ularga 
qulay ish sharoiti yaratish tushuniladi.

7. Rahbarning yoyilgan avtomatlashgan ish joyi 
nima?
A) monitor, klaviatura hamda sichqonchadan iborat 
va boshqa barcha funktsional qismlar uning 
yordanKhisi yoki kotibada boiadi
B) tuzilma avtonom ishlash va funktsional yopiqlik 
bilan ta’minlanadi.
C) foydalanuvchini muloqot tartibida qulay va oson 
ishlashi tushuniladi.
D) rahbar. mutaxassis yoki xizmat ko'rsatuvchi 
xodimlaming vazifasini almashtirish emas. balki 
ulaming faoliyatiga yordam berish, va ni ularga 
qulay ish sharoiti yaratish tushuniladi.

8. Rahbarning lokallashgan avtomatlashgan ish 
joyi nima?
A) tuzilma avtonom ishlash va funktsional yopiqlik 
bilan ta’minlanadi.
B) monitor, klaviatura hamda sichqonchadan iborat 
va boshqa barcha funktsional qismlar uning 
yordamchisi yoki kotibada boMadi.
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rahbar, mutaxassis yoki xizm at ko'rsatuvchi 
jdimlaming vazifasini almashtirish emas. balki 

Earning faoliyatiga yordam berish. ya’ni ularga 
‘|ay ish sharoiti varatish tushuniladi.

R) ob’vektlar bilan tashkiliy xarakterdagi ishlarni 
0jjb borish, boshqaruv ob ’vektlarining boshqaruv 
vaZifalarini yechishga m oljallangan.
C ) bevosita ishlab chiqarish jarayonlarini jism oniy  
dara jad ag i boshqarishjarayoni;
D )  foydalanuvchini muloqot tartibida qulay va oson  
ishlashi tushuniladi.

4. «Do‘stonalik» nima?
Д) foydalanuvchini muloqot tartibida qulay va oson  
ishlashi tushuniladi.
0) ob’vektlar bilan tashkiliy xarakterdagi ishlarni 
olib borish. boshqaruv ob yektlanm ng boshqaruv 
vazifalarini yechishga m o‘ljallangan.
C) bevosita ishlab chiqarish jarayonlarini jism oniy  
darajadagi boshqarishjarayoni; 
p )  rahbar, m utaxassis yoki xizm at ko‘rsatuvchi 
xodimlarning vazifasini almashtirish em as, balki 
ularning faoliyatiga vordam berish, ya'ni ularga 
qulay ish sharoiti varatish tushuniladi

5. «Moslashuvchanlik (egiluvchanlik)» nhna?
A) yangi xarakteristikalar. belgilar kiritish yoki 
o ‘zgartirish imkoniyati nazarda tutilodi. Masalan, 
ekran rangini yoki hujjat ko'rinishini o ‘zgartirish.
B) muomala qihngandan boshlab yakuniy natijani 
olish uchun kctgan vaqt tushuniladi.
C) foydalanuvchini muloqot tartibida qulay va oson  
ishlashi tushuniladi.
D ) rahbar, mutaxassis yoki xizmat ko'rsatuvchi 
xodimlarning vazifasini almashtirish em as, balki 
ularning faoliyatiga yordam berish, ya’ni ularga 
qulay ish sharoiti varatish tushuniladi

6. «Samaradorlik» nima?
A) muomala qilingandan boshlab yakuniy natijani 
olish uchun ketgan vaqt tushuniladi.
B) yangi xarakteristikalar. belgilar kiritish yoki 
o ‘zgartirish imkoniyati nazarda tutiladi

C) foydalanuvchini muloqot tartibida qulay va oson 
ishlashi tushuniladi.
D) rahbar, mutaxassis yoki xizmat ko‘rsatuvchi 
xodimlarning vazifasini almashtirish emas, balki 
ularning faoliyatiga yordam berish, va’ni ularga 
qulay ish sharoiti varatish tushuniladi.

9. Mutaxassisning avtomatlashgan ish joyi 
nima?
A) bu ma lum bir sohaning kasb egasidir. Uning 
AIJ shunday boiishi lozimki, u shaxsiy hamda 
muassasaning MBdagi axborotlar asosida tahliliy 
ish bajarishi va natijani biror hujjat sifatida taqdim 
etishi lozim.
B) monitor, klaviatura hamda sichqonchadan iborat 
va boshqa barcha funktsional qismlar uning 
yordamchisi yoki kotibada bo‘ladi
C) foydalanuvchini muloqot tartibida qulay va oson 
ishlashi tushuniladi.
D) rahbar, mutaxassis yoki xizmat ko'rsatuvchi 
xodimlarning vazifasini almashtirish emas, balki 
ularning faoliyatiga yordam berish, ya’ni ularga 
qulay ish sharoiti yaratish tushuniladi

10. Lingvistik ta ’minot nima?
A) Tabiiy tilni shakllantirish uchun til vositalari 
majmuasini birlashtiradi. Bu ta’minot orqali 
mashinaning inson bilan muloqoti amalga 
oshiriladi.
B) AATEX ishini ta’minlovchi (axborotlami 
yig‘ish. qayd qilish, uzatish. qayta ishlash, 
tasvirlash, ko‘paytirish texnik vositalari, orgtexnika 
va shu kabi) texnik vositalar majmuasidan tashkil 
topgan.
C) AATEX masalalari va vazifalarini amalga 
oshiruvchi hamda texnik vositalar majmuasining bir 
me’j'orda ishlashini ta’minlovchi dasturlar 
majmuasidan iborat.
D) AATEXni loyihalashtirish ishini 
avtomatlashtirish jarayonida va funktsional 
masalalami yechishda ishlatiladigan. axborotlami 
qayta ishlash algoritmi va modellari, matematik 
usullar to‘plamidan iborat.
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VIII BOB. AXBOROT XAVFSIZLIGI

34-§. Axborot xavfsizligi va axborotlarni himoyalash usullari

Tayanch tushunchalar: Axborot himoyasi, axborotni himoyctlashning maqsadlari 
axborotni himoya vositalari. axborotni himoyasining apparat vositalari, axborotni 
himoyasining dasturiy vositalari, axborotni himoyasining tashkiliy vositalari.

Axborotning himoyasi deb, boshqarish va ishlab chiqarish faolivatining 
axborot xavfsizligini ta’minlovchi va tashkilot axborot zahiralarining yaxlitligi 
ishonchliligi, foydalanish osonligi va maxfiyligini ta'minlovchi qat’iy 
reglamentlangan dinamik texnologik jarayonga aytiladi.
Axborotni himoya qilish deganda:
• Axborotning jismoniy butunligini ta'minlash, shu bilan birga axborot 
elementlarining buzilishi, yoki yo‘q qilinishigayo‘l qo ymaslik;
• Axborotning butunligini saqlab qolgan holda uni elementlarini qalbakilashtirishga 
(o‘zgartirishga) yo‘l qo4ymaslik;
• Axborotni tegishli huquqlarga ega bo‘lmagan shaxslar yoki jarayonlar orqali 
tarmoqdan ruxsat etilmagan holda olishga yo‘l qo‘ymaslik;
• Egasi tomonidan berilayotgan (sotilayotgan) axborot va resurslar faqat tomonlar 
ortasida kelishilgan shartnomalar asosida qo‘llanilishiga ishonish kabilar tushuniladi.

Axborotni himoyalashning maqsadlari quyidagilardan iborat:
- axborotning kelishuvsiz chiqib ketishi, o‘g;irlanishi, yo qotilishi, o‘zgartirilishi, 
soxtalashtirilishlaming oldini olish;
- shaxs, jamiyat, davlat xavfsizligiga boMgan xavf-  xataming oidini olish;
- axborotni vo‘q qilish, o‘zgartirish, soxtalashtirish, nusxa ko‘chirish, to‘siqlash 
bo yicha ruxsat etilmagan xarakatlaming oldini olish;
- hujjatlashtirilgan axborotning miqdori sifatida huquqiv tartibini ta'minlovchi, 
axborot zahirasi va axborot itizimiga har qandav noqonuniy aralashuvlaming 
ko‘rinishlarining oldini olish;
- axborot tizimida mavjud boMgan shaxsiy ma lumotlaming shaxsiv maxfiyligini va 
konfidentsialligini saqlovchi fuqarolaming konstitutsion huquqlarini himoyalash;
- davlat sirini, qonunchilikka mos hujjatlashtirilgan axborotning konfidentsialligini 
saqlash:
- axborot tizimlari, texnologiyalari va ulami ta'minlovchi vositalami jaratish, ishlab 
chiqish va qo‘llashda sub'yektlaming huquqlarini ta’minlash.

Tashkilotning himoyalash tizimiga boMgan haqiqiy ehtiyojini aniqlash va 
xavfsizlikning mavjud barcha xilma-xil choralaridan kerakligini tanlashda turli 
vondashishlardan foydalaniladi. Bundav vondashishlardan biri axborot himoyasining 
quyidagi uchtajihatiga asoslangan.
1. Himoyaning buzilishlari. Korxonaga tegishli axborotni saqlash va ishlatish 
xavfsizligiga zarar keltiruvchi har qanda> harakatlar.
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2 Himoya mexanizmi. Himoyaning buzilishlarini aniqlash va bartaraf etish, hamda 
jjuzilishlar oqibatini yo^qotish mexanizmlari.
3 Himoya xizmati. Ma’lumotlami ishlash tizimlari va korxonaga tegishli axborotni 
tashish xavfsizligi saviyasini ko‘tarishga mo‘ljallangan servis xizmati.
Himoyaning buzilishi. Kompyuter tizimi yoki tarmog'i himoyasmi buzishga 
ujinishlami kompyuter tizimini axborotni ta'minlovchi ob’yekt sifatida ko‘rish orqali 
klassifikatsiyalash mumkin. Umumiy holda qandaydir manbadan (masalan, fayl yoki 
xotira qismi) axborot oqimining adresatga (masalan, boshqa fayl yoki bevosita 
fovdalanuvchi) uzatilishi kuzatiladi. Shu nuqtai nazardan quyidagi hujumlami 
farqlash mumkin:

• Uzish (разъединение);
• Ushlab qolish (перехват);
• Turlash (модификация);
• Soxtalashtirish (фатсификация).

Uzish (разъединение). Tizim resursi yo‘q qilinadi, axborotdan foydalanuvchanlik 
buziladi. Bunday buzilishlarga misol tariqasida uskunaning ishdan chiqishi, aloqa 
linivasining uzilishi yoki fayllami boshqaruvchi tizimning bшilishini ko'rsatish 
mumkin
Ushlab qoiish (перехват). Resursdan ruxsat berilmagan foydalanishga yo‘l ochiladi. 
Natijada axborotning maxfiyligi (konfidentsialligi) buziladi. Bunday 
foydalanuvchilar fizik shaxs, dastur yoki kompyuter boiishi mumkin. Bunday 
buzilishlarga misol tariqasida ma’lumotlami ushlab qolish maqsadida aloqa kabeliga 
ulanish va fayllardan yoki dasturlardan noqonuniy nusxa ko‘chirishni ko^rsatish 
mumkin
Turlash (модификация). Resursdan nafaqat noqonuniy foydalanishga yo'l ochiladi, 
balki resurs buzg'unchi tomonidan o‘zgartiriladi. Natijada axborotning yaxlitligi 
buziladi. Bunday buzilishlarga misol tariqasida fayldagi malumotlar mazmunini 
o‘zgartirilishini, dastuming vazifalari va xarakteristikalarini o‘zgartirish maqsadida 
uni modifikatsiyalashni. tarmoq orqali uzatilayotgan axborotlar mazmunini 
o‘zgartirilishini va hokazolami korsatish mumkin.
Soxtalashtirish (фачсификация). Tizimga soxta ob’yekt kiritiladi. Natijada 
axborotning asliga to‘g‘riligi buziladi. Bunday buzilishlarga misol tariqasida tarmoq 
orqali yasama ma’lumotlami uzatish yoki fajlga yozuvlami qo‘shishni ko‘rsatish 
mumkin.

Yuqorida keltirilgan buzilishlar passiv va faol hujum atamalari bo‘vicha 
klassifikatsiyalanganida passiv tahdidga ushlab qolish mansub bo‘lsa, uzish, turini 
o‘zgartirish va soxtalashtirish faol tahdidga mansub ekanligini ko‘rish qiyin emas.

Passiv hujumlar natijasida uzatilayotgan ma lumotlar ushlab qolinadi yoki 
monitoring amalga oshiriladi. Bunda buzg‘unchining maqsadi uzatilayotgan 
axborotni ushlab qolishdir. Passiv buzilishlami ikkita guruhga ajratish mumkin 
axborotlar mazmunini fosh etish va ma’lumotlar oqimini tahlil etish.

Axborotlar mazmunini fosh etish nima ekanligi ma lum. Telefon orqali 
suhbatda elektron pochta axborotida yoki uzatilayotgan fa> Ida muhim yoki maxfiy
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axborot bo'lishi mumkin. Tabiiyki, bundav axborot bilan bu axborot moljallanmagan 
shaxslaming tanishishi maqbul emas.

Malumotlar oqimini tahlili mukammalroq hisoblanadi. Faraz qilaylik, biz 
axborot yoki boshqa uzatiluvchi ma lumotlar mazmunini shunday niqoblaviikki 
buzg‘unchi axborotni o'z ixtiyoriga kiritganida ham undagi axborotni chiqarib 
ololmasin. Ko'pincha axborot mazmunini niqoblashda shifrlash qo‘llaniladi. Лтщ 0 
axborot mazmuni shifrlash yordamida ishonchli tarzda berkitilgan bo'lsada^ 
buzg'unchida uzatiluvchi malumotlaming o‘ziga xos alomatiarini kuzatish 
imkoniyati qoladi. Masalan. uzatuvchini va axborotlarni uzatishga ishlatiluvchi 
uzellami, axborotlar uzunligini va ulaming almashinuv chastotasini aniqlash 
mumkin. Bunday axborot malumotlar almashinuvidan ko'zlangan maqsadni 
aniqlashda juda ham qo l kelishi mumkin.

Himoyaning passiv buzilishlarini aniqlash juda qiyin, chunki ularda 
ma lumotlarga qandaydir o'zgartinshlar kiritish ko‘zda tutilmaydi. Ammo, bunday 
xil buzilishlami oldim olishni amalga oshirsa bo‘ladi. Shu sababli passiv buzilishlar 
xolida e’tibomi ulami aniqlashga emas, balki ulami oldini olishga qaratish lozim.

Faol hujumlar natijasida ma’lumotlar oqimi ozgartiriladi yoki soxta oqimlar 
hosil qilinadi. Bunday buzilishlami to'rtta guruhga ajratish mumkin: imitatsiya, 
tiklash, axborotni turlash (modifikatsiyalash). xizmat ko'rsatishdagi xalaqit berishlar.

Axborotni qayta ishlash jarayonlarini avlomatlashtirish vosita, usul va 
shakllarining rivojlanishi va murakkablashishi axborot himoyasi sustlashishining 
ortishiga olib keladi. Bu sustlashishning ortishi quyidagi asosiy omillarda namoyon 
boMadi:

4  kompyuter va boshqa avtomatlashtirish vositalarida to^planadigan, 
saqlanadigan va qayta ishlanadigan axborot hajmining keskin ortib ketishi;

4- turli vazifali va turlicha mansublikka oid axborotni yagona ma lumotlar 
bazasida to‘planishi;

4  hisoblash tizimi manbalan va unda jovlashgan ma’lumotlarga bevosita 
bog lanish vakolatiga ega foydalanuvchilar doirasining keskin ortib ketishi;

4- hisoblash tizimining texmk vositalarini ishlash rejimlarini murakkablashuvi: 
ko'p dasturli rejimni keng joriy qilinishi, shuningdek vaqtni taqsimlanishi va 
real vaqt rejimlari;

4  axborotni mashinalar o‘rtasida almashinuvim avtomatlashtirish (shu jumladan 
uzoq masofalardagi).

Bunday sharoitlarda ikki ko‘rinishning zaiflashuvi kuzatiladi:
> bir tomondan, axborotni yo'qotilishi yoki buzilishi imkoniyati (ya’ni uning 

jismoniy butunligining buzilishi),
> boshqa tomondan -  axborotdan noqonuniv foydalanish imkoniyati (ya’ni 

qoMlashda cheklovga ega axborotni oqib (tarqalib) ketish xavfi).
Axborot tarqalib ketishining asosiy potentsial mumkin bo‘lgan kanali 

quyidagi hisoblanadi:
❖ Axborot tashuvchilarini vahujjatlami to"gbridan-to‘g 'n  o'girlash;
❖ Axborotni eslab (yodlab) qolish yoki nusxalab olib;
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Aloqa liniyalari va apparaturalarga noqonuniy bog'lanish yoki noqoniiniy 
(ro‘yxatdan o'tmagan) apparaturalar tizimlarini noqonuniy qoilash.
Axborotni hiinoya vositalari -  bu axborotni himoyalashda turli vazifalami 

amalga oshirish uchun qo‘llaniladigan, shu jumladan, himoyalanadigan axborot 
0‘g‘irlanishi haqida ogohlantirish va xavfsizligini ta’minlashga moijallangan 
muhandis-texnik. elektrik. elektron. optik va boshqa qurilmalar. moslamalar. uskuna 
v a  texnik tizimlar, shuningdek, ularga tegishli elementlari majmui tushuniladi.

Axborotni himoyalashni ta mini ash vositalarini quyidagi guruhlarga bo'lish 
mumkin:

Apparat (texnik) vositalari. Bu turi bo‘yicha turli xil qurilmalar (mexanik, 
elektromexanik. elektron va boshqalar) bo lib, bunday apparat vositalarida axborot 
himoyasi vazifalan amalga oshiriladi. Ular axborotga jismoniy bogianishga qarshilik 
qiladi yoki agar bog'lanish amalga oshgan bo'lsa, u holda axborotga bog'lanishga 
ulami niqoblash yordamida himoyalaydi. Birinchi navbatda bu vazifani xonadagi 
qulf. oynadagi panjara, qorovul, himova signalizatsiyasi va boshqalar bajaradi. 
Ikkinchi navbatda esa — shovqin generatorlari, tarmoq filtrlari, skanirlovchi radio 
qabul qilgichlar va ko'plab boshqa qurilmalar axborotni oqib ketishi kanallarini 
bekitadi va ulami bartaraf qiladi. Texnik vositalaming afzalligi ularning ishonchliligi. 
sub’yektiv faktorlarga bog'lanib qolmaganligi bilan, boshqa turlarga chidamliligida 
namoyon boMadi.
• Dasturiy vositalar o‘z ichiga foydalanuvchilami identifikatsiya qilish. bogianishni 
nazorat qilish, axborotni shifrlash, vaqtinchalik fayllar singari qoldiq axborotni 
o‘chirish, himova tizimini sinov nazoratini amalga oshirish va boshqa vazifalami 
amalga oshiruvchi dasturlami oladi. Dasturiy vositalaming afzalliklari - uruversallik, 
moslashuvchanlik, ishonchlilik, o‘matish soddaligi, boshqa shaklga o'tish va 
rivojlantirishga moyilligi.
• Aralash (apparat-dasturiy) vositalar -  apparat va dasturiy vositalar alohida 
bajaradigan shu funktsiyalami amalga oshiradi va faqat oraliq xususiyatlarga ega.
• Tashkiliy vositalar tashkiliy-texnik (kompyuterga turar joy tayyorlash, kabel 
tizimini 0‘tkazishda bogianishni cheklash talablarini hisobga olish va boshqalar) va 
tashkiliy-huquqiydan (milliy qonunchilik va aniq bir tashkilot rahbariyati tomonidan 
o‘matilgan ishlar qoidalari) tarkib topadi. Tashkiliy vositalaming afzalliklari shundan 
iboratki, ular ko‘plab xilma-xil muammolami yechish imkonini beradi, ishlab chiqish 
oson, tarmoqdagi kutilmagan harakatlarga tezkor ta’sir ko‘rsatadi, o‘zgarishlar va 
rivojlanishda cheklanmagan imkoniyatlar.

Axborotni himoyalashning apparatli vositalari
Himoyaning apparat vositalariga turli xil elektron, elektron-mexanik, elektron- 

optik qurilmalar kiradi. Hozirgi vaqtda ko‘p sondagi turli xil maqsadli apparat 
vositalar ishlab chiqilgan bo‘lib, ulardan eng ko‘p tarqalgani quyidagilar:
• himoya rekvizitlarini saqlash uchun maxsus registrlar: parollar, identifikatsiyalovchi 
kodlar, griflaryoki maxfiylik darajalari;

identifikatsiya qilish maqsadida inson individual xususiyatlarini (tovush, barmoq 
izi) o'lchovchi qurilma; 

aloqa liniyasida axborotni uzatishni to‘xtab qolishi chizmasini davriy tekshirish;
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• axborotni shifrlash uchun qurilma (kriptografik metodlar).
Axborot tizimi qamrov doirasini himoya qilish uchun quyidagilar 

yaratiladi:
■ qo‘riqlash va yong‘in signalizatsiya tizimlari;
■ raqamli video kuzatuv tizimi;
■ bog'lanishni nazorat va boshqarish tizimlari.

Aloqaning texnik kanallaridagi yoriqlardan axborotni himoya qilish quyidagi 
vosita va tadbirlar orqali amalga oshadi:

■ kabellar va ulami o'tkazish simlariga to‘siq qo‘yib tashqi ta’sirdan himoyalash 
konstruktsiyasi qo‘llash orqali;

■ aloqa liniyalarida yuqori chastotali filtrlami o^matish;
■ tashqi ta'sirdan saqlovchi turar joy («kapsula») qurish;
■ tashqi ta'sirdan himoyalangan jihozlami qo‘llanilishi;
■ shovqin qilishning faol tizimini o rnatish;
■ nazoral qilib turiladigan hududni varatish.

Axborotni himoyalashning apparat ta’minoti vazifalari. Axborotni 
himoyalashning apparat vositalari quyidagi vazifalami yechish uchun qoilaniladi:

■ axborot vorigi kanallari mayjud bo4ganda texnik vositalar ustida maxsus 
tadqiqot o'tkazish;

■ turli ob’yektlar va inshootlarda axborot yorig‘i kanallari paydo bo‘lganda;
■ axborotyorig‘i kanallarini kengayishiga yo‘l qo‘ymaslik;
■ sanoat josusligi vositalarini qidirish va tutish;
■ maxfiy axborot manbalariga noqonuniy boglanishlarga qarshi harakatlar.
■ Vazifalariga kora  apparat vositalari quyidagicha tasniflanadi:

■ qo'lga olish vositalari,
■ qidirish vositalari,
■ batafsil o‘lchov birligi,
■ faol va passiv qarshi harakat vositalari.

Qidiruv apparaturalarini ikki guruhga bo'lish mumkin:
Birinchi turdagi apparatura -  yovuz nivatli shaxslami noqonuniy bogManish 
vositalarini qidirish va mavjudlarining kanallarini kengayishiga voM qo'vmaslik 
uchun xizmat qiladi.
Ikkinchi turdagi apparatura axborot yorig‘i kanallarini yuzaga chiqarish uchun 
moMjallangan. Bunday turdagi tizimlar uchun tadqiqot tezkorligi va olingan 
natijaning ishonchliligi muhim xususiyatlardan hisoblanadi Professional qidiruv 
apparaturalar qoida bo‘yicha juda qimmat va unda ishlash uchun yuqori 
kvalifikatsiyali mutaxassislar talab qiladi. Shunga bog‘liq holda har doim tegishli 
ko rikdan o‘tkazib turishni tashkil qilishi mumkin bo'ladi.
Axborot himoyasining apparatli vositalari ko4rinishlari. Ixtisoslashgan saqlash 
tarmog‘i SAN (Storage Area Network) ma’lumotlarga ko‘chirilishda kafolatli 
o'tkazish voiini ta’minlavdi. Saqlash tarmoqlarini tashkil qilish uchun u bilan bir 
qatorda mashhur Fiber Channel texnologiyasida oxirgi paytlarda ko'pincha iSCSI 
qurilma qo llanilmoqda. Apparat vositalariga misol ko‘rib chiqamiz:
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1) eToken - elektron kalit, shaxsiy avtorizatsiya, autentifikatsiya va ma'lumotlami 
saqlashning himoyalangan, raqamli sertifikatlar va elektron raqamli imzo bilan 
ishlashni qo‘llab-quvvatlaydigan apparatli vosita hisoblanadi. eToken USB-kalit, 
smart-karta yoki brelok shakllanda ishlab chiqiladi.
eToken NG-OTP modeli o ‘zida bir martalik parollaming generatorini oladi. 
eToken NG-FLASH modeli ichki modulga ega b o iib , flesh-xotirasi hajmi 4 GB 
gacha bo‘iadi.
eToken PASS modeli faqat bir martalik parol generatoridan tarkib topadi.
eToken PRO (Java) modeli elektron raqamli imzo kalitini paydo b o iish i va elektron
raqamli imzoni shakilantirishda apparatli vosita hisoblanadi.
Shuningdek eToken o'zida simsiz radio nishonlarga ega boiish i, uni inshootga 
kirishga imkoniyat varatib beradi.
Axborotni himoyalashning dasturiy vositalari. Axborotlarni himoyalashning 
dasturiy ta'minotiga quyidagilar kiradi: 

ma’lumotlami arxivlash vositalari;
• antivirus dasturlari;
• kriptografik vositalar;

foydalanuvchini identifikatsiya va autentifikatsiya qilish vositalari;
• bog‘lanishni boshqarish vositasi;
• bavonnomalash va audit.

Yuqorida sanalgan imkoniyatlar kombinatsiyasi sifatida quyidagilami keltirish 
mumkin:
• ma lumotlar bazasini himoyalash;
• operatsion tizimni himoyalash;
• kompyuter tarmoqlarida ishlashda axborotni himoyalash.

Test savollari
1. Foydakinuvchining login va parolni U kshirish 
hamda uning tizimdagi barcha harakaHarini 
belgilash jarayoni qandav ataladi
a) kriptografiya
b) kontrafaktsiya 
v) plagiat
g) autenlikatsiya.

2. Tizimga kirishda foydalanuvchining logini va 
paroli noto‘g*ri kiiitilsa qandav jarayon sodir 
boiadi
a) amaliyot tizim yuklanmaydi
b) amaliyot tizim yuklanadi 
v) kompyuter o‘chib qoladi 
g) kompyuter qayta yuklanadi

3. Axborotning himoyasi nima?
A) boshqarish va ishlab chiqarish taolivatining 
axborot xavfsizligini ta’minlovchi va tashkilot 
axborot zahiralarining yaxlitligi, ishonchliligi, 
fovdalanish osonligi va maxfiyligini ta’minlovchi 
qat’iy reglamentlangan dinamik texnologik

D) boshqarish va ishlab chiqarish faoliyatining 
axborot xavfsizligini ta’minlovchi va tashkilot 
axborot zahiralarining yaxlitligi, ishonchliligi. 
foydalanish osonligi va maxfiyligini ta’minlovchi 
qat’iy reglamentlangan dinamik texnologik 
jaravonga aytiladi

7. Uztsh nima?
A) Tizim rcsursi yo‘q qilinadi, axborotdan 
foydalanuvchanlik buziladi. Bunday buzilishlarga 
mi sol tariqasida uskunaning ishdan chiqishi, aloqa 
liniyacining uzilishi yoki favllami boshqaruvchi 
tizimning buzilishini ko‘rsatish mumkin.
B) Resursdan ruxsat berilmagan foydalanishga yo‘l 
ochiladi. Natijada axborotning maxfiyligi 
(konfidentsialligi) buziladi.
C) Resursdan nafaqat noqonuniy foydalanishga yo‘l 
ochiladi, balki resurs buzg‘unchi tomonidan 
o‘zgartiriladi. Natijada axborotning yaxlitligi 
buziladi.
D) Tizimga soxta ob’yekt kiritiladi. Natijada 
axborotning asliga to‘g‘riligi buziladi.
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jarayonga aytiladi.
B) korxonaga tegishli axborotni saqlash va ishlatish 
xavfsizligiga zarar keltiruvchi har qandav 
harakatlar.
C) himoyaning buzilishlarini aniqlash va bartaraf 
etish, hamda buzilishlar oqibatini yo‘qotish 
mexanizmlari.
D) ma’lumotlarni ishlash tizimlari va korxonaga 
tegishli axborotni tashish xavfsizligi saviyasini 
ko‘tarishga mo‘ljallangan servis xizmati

4. Himoyaning bu/ilishlaii nima?
A) korxonaga tegishli axborotni saqlash va ishlatish 
xavfsizligiga zarar keltiruvchi har qandav 
harakatlar.
B) boshqarish va ishlab chiqarish faoliyatining 
axborot xavfsizligini ta’minlovchi va tashkilot 
axborot zahiralarining yaxlitligi, ishonchliligi, 
foydalanish osonligi va maxfiyligini ta’minlovchi 
qativ reglamentlangan dinamik texnologik 
jarayonga aytiladi.
C) himoyaning buzilishlarini aniqlash va bartaraf 
etish, hamda buzilishlar oqibatini yo'qotish 
mexanizmlari.
D) Ma’lumotlami ishlash tizimlari va korxonaga 
tegishli axborotni tashish xavfsizligi saviyasini 
ko‘tarishga mo'ljallangan servis xizmati.

5. Himoya inexanizmi nima?
A) Himoyaning buzilishlarini aniqlash va bartaraf 
etish, hamda buzilishlar oqibatini yo‘qotish 
mexanizmlari.
B) Korxonaga tegishli axborotni saqlash va 
ishlatish xavfsizligiga zarar keltiruvchi har qandav 
harakatlar.
C) boshqarish va ishlab chiqarish faoliyatining 
axborot xavfsizligini ta’minlovchi va tashkilot 
axborot zahiralarining yaxlitligi, ishonchliligi. 
foydalanish osonligi va maxfiyligini ta’minlovchi 
qat’iy reglamentlangan dinamik texnologik 
jarayonga aytiladi.
D) Ma’lumotlami ishlash tizimlari va korxonaga 
tegishli axborotni tashish xavfsizligi saviyasini 
ko‘tarishga mo'ljallangan servis xizmati.

6. Himoyaning buzilishi nima?
A) Kompyuter tizimi yoki tarmog‘i himoyasini 
buzishga urinishlami kompyuter tizimini axborotni 
ta’minlovchi ob’yekt sifatida ko‘rish orqali 
klassifikatsivalash mumkin.
B) Himoyaning buzilishlarini aniqlash va bartaraf 
etish, hamda buzilishlar oqibatini yo'qotish 
mexanizmlari
C) Korxonaga tegishli axborotni saqlash va 
ishlatish xavfsizligiga zarar keltiruvchi har qandav 
harakatlar.

8. Ushlab qolish nima?
A) Resursdan ruxsat berilmagan foydalanishga y0‘| 
ochiladi. Natijada axborotning maxtiyligj 
(konfidentsialligi) buziladi.
B) Tizim resursi vo‘q qilinadi, axborotdan 
foydalanuvchanlik buziladi. Bunday buzilishlarga 
misol tariqasida uskunaning ishdan chiqishi, aloqa 
liniyasining uzilishi yoki favllami boshqaruvchi 
tizimning buzilishmi ko^rsatish mumkin.
C) Resursdan nafaqat noqonuniy foydalanishga vo‘l 
ochiladi, balki resurs buzg‘unchi tomonidan 
o‘zgartiriladi Natijada axborotning yaxlitligi 
buziladi.
D) Tizimga soxta ob’yekt kiritiladi. Natijada 
axborotning asliga to‘g‘riligi buziladi.

9. Turlash (modifikatsiva) nun a?
A) Resursdan nafaqat noqonuniy foydalanishga 
yo‘l ochiladi, balki resurs buzg‘unchi tomonidan 
o‘zgartiriladi. Natijada axborotning yaxlitligi 
buziladi.
B) Tizim resursi vo‘q qilinadi, axborotdan 
foydalanuvchanlik buziladi. Bunday buzilishlarga 
misol tariqasida uskunaning ishdan chiqishi, aloqa 
liniyasining uzilishi yoki favllami boshqaruvchi 
tizimning buzilishmi ko'rsatish mumkin.
C) Resursdan ruxsat berilmagan foydalanishga vo‘l 
ochiladi. Natijada axborotning maxtiyligi 
(konfidentsialligi) buziladi
D) Tizimga soxta ob’yekt kiritiladi Natijada 
axborotning asliga to‘gLriligi buziladi

It). Soxtalashtirish nima?
A) Resursdan nafaqat noqonuniy foydalanishga 
yo‘l ochiladi, balki resurs buzg‘unchi tomonidan 
ozgartiriladi Natijada axborotning yaxlitligi 
buziladi.
B) Tizim resursi vo‘q qilinadi. axborotdan 
foydalanuvchanlik buziladi. Bunday buzilishlarga 
misol tariqasida uskunaning ishdan chiqishi, aloqa 
liniyasining uzilishi yoki favllami boshqaruvchi 
tizimning buzilishmi ko'rsatish mumkin.
C) Resursdan ruxsat berilmagan foydalanishga vo‘l 
ochiladi. Natijada axborotning maxfiyligi 
(konfidentsialligi) buziladi.
D) Tizimga soxta ob'yekt kiritiladi. Natijada 
axborotning asliga to'g‘riligi buziladi.
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35-§. Axborot xavfsizligi va uni ta’minlash

jayanch tushunchalar: identifikatsiya, autentifikatsiya, login, parol, avtorizatsiya, 
yo yxatdan о 'tish, hujum tiishunchasi, kompyuter virusi, davlat sirlari. harbiy sir.

Hayotimizda har birimiz shaxsiv ma’lumotlarimizni konfidentsialligini 
ta'minlashga harakat qilamiz. Bizga o‘zimizning tibbiy tariximiz yoqmasligi yoki 
do^tlarimiz bilan bo‘lgan shaxsiv yozishmalaringizni nashr qilinishni, boshqalar 
lco‘rishini yoqtirmaymiz. Bizning tashrif buyuradigan saytlarimiz, xaridlarimiz 
haqidagi ma’lumotlami boshqalar bilishini xohlamaymiz. Yuqorida keltirilgan barcha 
ma’lumotlar sir bo'lib qolishini xohlaymiz. Ammo, internet asrida siz xohlamagan 
shaxslaming ma’lumotlaringizga qiziqishi va bog‘lanib olishi juda ham oson va tez 
kechishi mumkin. Shu tarzda axborot xavfsizligining qonuniy asosi sizning shaxsiy 
ma'lumotlaringizni himoyalash uchun imkon beradi va bularga ko‘ra sizning vozma 
ruxsatingizsiz hech kim malumotlaringizdan noqonuniy foydalana olmaydi. Bu kabi 
qonunlar ko‘plab mamlakatlarda qabul qilingan60.

“Axborotlashtirish to‘g 'risida’gi qonunda:
. Davlat organlari, yuridik va jismoniy shaxslar davlat sirlari hamda mahfiy sirlar 

to‘g‘risidagi axborotni o‘z ichiga olgan axborot resurslari va axborot tizimlarining 
muhofaza qilinishini ta'minlashi shart.
• Axborot resurslari va axborot tizimlari muhofaza qilishini tashkil etish tartibi 

ularning mulkdorlari, egalari tomonidan mustaqil belgilanadi.
• Davlat sirlari hamda mahfiy sirlar to'g'risidagi axborotni o'z ichiga olgan axborot 

resurslari va axborot tizimlarining muhofaza qilinishini tashkil etish tartibi 
0 ‘zbekiston Respublikasi Vazirlar Mahkamasi tomonidan belgilanadi.
Axborot xavfsizligini ta’minlashning huquqiy asoslari O'zbekiston Respublikasi 
Prezidentining 2005 yil 5 sentyabrdagi «Milliy axborot-kommunikatsiya 
tizimlarining kompyuter xavfsizligini ta’minlash bolyicha qo‘shimcha choralar 
to'g‘risida»gi PQ-167-son qarori Kompyuter hodisalariga chora ko'rish xizmati (UZ- 
CERT) hisoblanib, uning asosiy vazifasi:

• Kompyuter tizimlari mojarolarini yig‘ish va ulami tahlil qilish;
• Axborot himoyasi bo‘yicha malakali maslahatlar berish;

Axborot xavfsizligini ta’minlashning huquqiy asoslari:
■ 0 ‘zbekiston Respublikasi Prezidentining” 0 ‘zbekiston Respublikasida 

axborotni kriptografik muhofaza qilishni tashkil etish chora-tadbirlari to‘g‘risida 
2007 yil 3 apreldagi PQ -  614-son qarori O zbekiston Respublikasida axborotni 
kriptografik muhofaza qilish to'g'risidagi Nizom;

■ O'zbekiston Respublikasida axborotni kriptografik muhofaza qilish vositalarini 
sertifikatlash to‘g‘risidagi Nizom.

Vazirlar Mahkamasining "‘0 ‘zbekiston Respublikasi Prezidentining “Milliy 
axborot resurslarini muhofaza qilishga doir qo‘shimcha chora-tadbirlari to‘g‘risida”gi

60 V. Rajarainan Introduction to Informat b n  technology (second edition) PHI bearing Private Limited. India, 2013.
342-p.
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2011 yil 8 iyuldagi 1572-son qarorini amalga oshirish choratadbirlari haqida’gi 2011 
yil 7 noyabrda 296-son qarori qabul qilindi.

Mazkur qaror bilan Axborotlashtirish ob’yektlarini attestatsiyadan o ‘tkazish 
ishlarini amalga oshirish uchun ruxsatnoma berish lartibi to‘g‘risidagi Nizom hamda 
maxfiy axborotlar sirasiga kiritilgan malumotlar rovxati tasdiqlandi.
Axborot xavfsizligi turlari:

• Axborot xavfsizligining tashkiliy choralar
• Axborot xavfsizligining texnik choralari
• Axborot xavfsizligining dasturiy choralari 

Axborot xavfsizligini ta’minlash
• Axborot xavfsizligini ta’minlash -  bu foydalanuvchining axborotlarinj 

himoyalashga qo'yilgan me’yor va talablami bajarishidir.
• Axborot xavfsizligi -  bu axborot foydalanuvchilariga va ko‘plab axborot 

tizimlariga zarar keltiruvchi tabiiy yoki sun iv xarakterga ega tasodifiy va 
uvushtinlgan ta’sirlardan axborotlarni va axborot kommunikatsiya tizim 
ob’yektlarining himoyalanganligidir.
Havfsizlik malumotlar va dasturiy vositalami g‘avri qonuniy kimsalar 

tomonidan tasodifiy yoki atayin buzish yoki ochishdan himoyalash tushuniladi. 
Buning oldini olish uchun siz o;z ma'lumotlaringizni yo‘qolmasligi yoki buzilmasligi 
uchun tegishli xushyorlik choralarini ko‘rinishingiz talab qilinadi. Buni biz 
navbatdagi bo‘limda batafsil ko‘rib chiqamiz.

Siz taqdim qilayotgan ma'lumot foydalanishga varoqli bo‘lishi ulaming toMiq, 
butun, ishonchli, dolzarb, zamonaviy va o‘z vaqtida bo lishi kerak. Boshqacha 
aytganda gohida axborotning xavfsizligini ta’minlashdan ko‘ra ko'proq uning sifatini 
oshirishga bezovta bo'lasiz. Agar kelavotgan axborot shikastlangan bofsayoki unda 
xatolik topilgan bo‘lsa butunligi yo'qolgan bo'lsa, u holda uni asrash mavjud 
muammolami bartaraf qilish vositalarini qo‘llash kerak. Chunki bu axborot asosida 
qarorlar qabul qilish, harakatlami belgilash talab qilinadi. Bu yerda axborotning 
butunligi buzilgan bo lsa. u holda unga aniqlik kiritish vositasida tushunarli holatga 
keltirish talab qilinadi. Bunda axborot butunligini taminlash maqsadlarida ayni 
paytda uskunalar ishlab chiqilmoqda61. Login va parol tushunchasi.

• Login -  shaxsning, o‘zini axborot kommunikatsiya tizimiga tanishtirish 
jarayonida qoflaniladigan belgilar ketma-ketligi bo‘lib, axborot kommunikatsiya 
tizimidan foydalanish huquqiga ega bo‘lish uchun foydalanuvchining maxfiy 
bo lmagan qayd yozuvi hisoblanadi.

• Parol -  uning egasi haqiqiyligini aniqlash jaravonida tekshiruv axboroti 
sifatida ishlatiladigan belgilar ketma-ketligi (maxfiy so‘z). U kompyuter bilan 
muloqot boshlashdan oldin. unga klaviatura yoki identifikatsiya kartasi yordamida 
kiritiladigan harfli, raqamli yoki harfli-raqamli kod shaklidagi maxfiy so^zdan iborat.

0 ‘z uyingizda yoki ofisda kompyuter yordamida siz ehtiyot choralarini 
ko rishingizni talab qiladi. Chunki ular okgirlanishi shikastlanishi mumkin. Bunda 
vana bir himoya yo‘li kompyuterdagi yoki tizimdagi o'z parolingizni ham ehtiyot

61 V. Rajaraman Introduction to Int'ormation teclmo logy (second edition) PHI Leafing Private Limited. India.
2013. 342-p.
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ailishingiz, undan boshqa foydalanuvchilar xabar topmasligi kerak bo‘ladi. 
jCo‘pchilik kishilar tez topiladigan parollami ya'ni, nomi, familiyasi, tug‘ilgan sanasi, 
opasining ismi, mushugining ismi yoki shunga o‘xshashlami qo‘llashadi. Agar biror 
foydalanuvchi o‘z parolini unutib qo‘ysa (yoki yo‘qotib qo‘ysa) u holda parolni 
ochish uchun maxsus dastumi ishga tushirishi va bir necha urinishlarda (har bir 
yrinishi bir variant) bir necha kun davomida (topilgunga qadar) urinishi kerak 
bo‘ladi. Parolni qo'yish (yaratish) uchun quyidagilar amalga oshiriladi:

• Qisqa parollami qo'llamang. Parolda 8 simvoldan kam so‘zlami qo‘llamang.
• Hech boimaganda bitta maxsus simvol va bir nechta raqam qoMlang.
• Tasodifiy simvollar to‘plamini qo‘llagan ma’qul. chunki ma’noli so‘z!ami 

parol sifatida tez ochilib tashlanishi ehtimoli bor.
• parolni kamida bir oyda bir marta o‘zgartirish kerak.
Xavfsiz maxfiy so‘z: rj; 42mn$. Bunday maxfiy so'zni eslab qolish juda qiyin. 

Bunday qiyin maxfiy so'zlami ozingizning ishonchli kundalik yoki shunga o‘xshash 
ishonchli joylargayozib qo‘yish kerak. Chunki bunday kombinatsiyali maxfiy so‘zlar 
biror narsani eslatmagani va bog‘liq bo‘lmagani sababli hatto o‘zingizning ham 
vodingizdan ko tarilib ketishi mumkin. Faqatgina bir necha marta qoilaganingizdan 
so‘ng eslab qolishingiz mumkin62.
Identifikatsiya va autentifikatsiya.
• Identifikatsiya (ingl. Identification) -  axborot tizimlari ob'yekt va sub’yektlariga 

uni tanish uchun nomlar (identifikator) berish va berilgan nom bo‘yicha solishtirib 
uni aniqlash jarayoni.
• Autentifikatsiya (ingl. Authentication) -  ob’yekt yoki sub yektni unga berilgan 

identifikatorga mosligini tekshinsh va belgilar ketma-ketligidan iborat maxfiy kodini 
tekshirish orqali aslligini aniqlash.

• Avtorizatsiya -  foydalanuvchining resursdan foydalanish huquqlari va 
ruxsatlarini tekshirish jarayoni. Bunda foydalanuvchiga hisoblash tizimida ba’zi 
ishlami bajarish uchun muayyan huquqlar beriladi. Avtorizatsiya shaxs harakati 
doirasini va u foydalanadigan resurslami belgilaydi.
Ro'yxatdan o'tish tartibi

Ro'yxatdan o'tish -  foydalanuvchilami ro‘>xatga olish va ularga dasturlar va 
ma’lumotlami ishlatishga huquq berish jarayoni.

Ayrim web-saytlar foydalanuvchilarga qo‘shimcha xizmatlami olish va pullik 
xizmatlarga obuna boiish uchun ro‘yxatdan o‘tishni hamda login va parol olishni 
taklif qiladilar. Foydalanuvchi ro yxatdan o‘tgandan so‘ng tizimda unga qayd yozuvi 
(account) yaratiladi va unda foydalanuvchiga tegishli axborotlar saqlanadi.

Hiijum tushunchasi va axborot hujumlari. Hujum tushunchasi -  
buzg‘unchining biror-bir maqsad yo‘lida axborot kommunikatsiya tizimlarining 
mavjud himovalash tizimlarini buzishga qaratilgan harakati. Bundan maqsad 
foydalanuvchining login va parolini aniqlash yoki buzish orqali uning huquqlariga 
ega boiish.
Axborot hujumlari odatda 3 ga bo ‘linadi:

62 V. Rajaranian Introduction to Information technology (second edition) РШ  Learing Private Limited. India,
2013. 342-p.
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-  Ob'yekt haqida ma'lumotlar yig'ish (razvedkalash) hujumi.
-  Ob yektdan foydalanishga ruxsat olish hujumi.
-  Xizmat ko‘rsatishdan voz kechish hujumi.

Konfidentsial axborot
Konfidentsial axborot - ma 'lum doiradagi sub 'yektlar tanishishiga ruxsati berilgan 
axborot.
Konfidentsial axborotga tahdid deganda muhofaza qilinayotgan axborot resurlaridan 
ma lumot olish bo‘yicha amalga oshirilgan yoki amalga oshirilishi mumkin bo‘lgan 
xatti-harakatlar tushuniladi.
Davlat maxfiy axboroti

• Davlat sirlari -  Fosh etilishi davlatning harbiy-iqtisodiv potentsialiga salbiy 
ta’sir etib, mudofaa qudrati. davlat xavfsizligi, siyosiy va iqtisodiy 
manfaatlariga putur yetkazishi mumkin boMgan ma'lumotlardir.

• Harbiy sir -  fosh boMishi 0 ‘zbekiston Respublikasi qurolli kuchlarining 
mudofaa qudratiga hamda davlat xavfsizligiga salbiy ta’sir etuvchi va natijada 
og‘ir oqibatlarga olib keluvchi harbiy xarakterdagi ma’lumotlardir.

• Xizmat sirlari- fan-texnika, ishlab chiqarish va boshqaruvdagi ma’lumotlami 
o‘z ichiga olib, ularning fosh etilishi Davlat manfaatlariga zarar yetkazishi 
mumkin.

• Tijorat siri -  ishlab chiqarish, texnologiya, boshqaruv, moliya va boshqa 
faoliyat bilan bog‘liq boigan ma’lumotlar bo‘lib, ulami fosh etilishi tashkilot 
yoki axborot egalariga zarar yetishi mumkin.

• Personal bilan bog‘liq sirlar- fuqarolammg shaxsiy hayoti bilan bog‘liq 
bo‘lgan faktlar, voqealar vaholatlar haqidagi ma’lumotlar bo lib ularning fosh 
etilishi shaxsga moddiy va ma naviy zarar yetkazishi mumkin.
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■ Axborot xavfsizligiga tahdid ob'yektlariga himoya qilinishi lozim bo'lgan
ob'yektning tarkibi, holati va faoliyati haqidagi ma lumotlar kiradi.

■ Axborotga tahdid deganda uning konfidentsialligi. butunligi, to‘laligi va u bilan
tanishish qoidasi buzilishi tushuniladi.

■ Axborot xavfsizligiga tahdid manbalariga raqiblar, jinoyatchilar,
korruptsiyachilar hamda boshqa buzg'unchilar kiradi;

■ Axborot xavfsizligiga tahdid manbalarining maqsadlari quyidagilarga
yo'naltirilgan boiishi mumkin: muhofaza qilinayotgan malumotlar bilan 
tanishish, g‘arazli maqsadlarda ulami o‘zgartirish va moddiy zarar yetkazish 
yoiida ulami yo‘qotish;

■ Konfidentsial axborot manbalariga odamlar, hujjatlar, nashrlar, axborot tashish
texnik vositalari, ishlab chiqarish va mehnat faoliyatini ta'minlovchi texnik 
vositalar, mahsulot hamda ishlab chiqarish chiqindilari kiradi.

■ Axborot himoyasi yo’nalishlarining asosiylariga huquqiy, tashkiliy va injener-
texnik himoyalar kirib, bular axborot xavfsizligini taminlashda kompleks 
yondoshishning asosini belgilaydi.

■ Axborot himoyasi vositalari sifatida apparat-dasturiy vositalar va kriptografik
tizimlardan foydalaniladi. Kriptografik tizimlardan alohida apparat yoki dastur 
ko‘rinishida hamda ulami birgalikda qo‘llab foydalanish mumkin.

■ Axborot himoyasi usullariga axborotga sanktsiyasiz kirishni oldini olish va uni
bartaraf etishning barcha yo‘llari, usullari va amallari kiradi.

■ Konfidentsial axborotga noqonuniy ega boiish uchun qilinadigan harakatlar;
■ Axborot egasi (manba) konfidentsial axborotni saqlashga hech qanday chora 

ko rmaganligi sababli raqib o‘zi qiziqqan ma lumotni yengil olishi mumkin;
■ Axborot manbasi axborot xavfsizligi choralarini qattiq saqlaydi va raqib 

saqlanayotgan axborotga kirishi yoki uni olishi uchun axborotga sanktsiyasiz 
kirishning barcha usullarini qoilaydi;

■ Axborot egasi (manba) bilmagan holda texnik kanallardan axborotni beixtiyor 
chiqib ketishi va undan raqib o‘zining maqsadlarida hech qanday qivinchiliksiz 
oson foydalanishi mumkin.

Kompyuter axborotiga huquqsiz kirishda qo'llanadigan vositalar:
• Kompyuter axborotiga huquqsiz kirishda asosiy qurol sifatida kompyuterning 

texnik vositalardan foydalaniladi. Shu jumladan, maxsus dasturiy ta minotlardan ham 
keng foydalaniladi;

• Axborotga masofadan turib kirish qurollariga birinchi navbatda tarmoq 
qurilmalari hamda global tarmoq vositalari (telefon aloqasi, modem) kiradi;

• Korxona, tashkilot, muassasa firma yoki kompaniya bilan mehnat 
munosabatlarida boigan shaxslar;

• Xakerlar;
Axborot xavfsizligiga tahdid soluvchi shaxslar

• Tadqiqotchi xakerlar - ushbu soha boVicha juda katta bilimga ega shaxslar 
boiib, kompyuter dasturiy ta’minotining himoyasi zaif joylarini qidirib topadilar va 
ulardan buzg’unchilikda foydalanishga imkoniyat yaratadilar.
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• Buzg‘unchi xakerlar - ular turli hil maqsadlarda “toza buzush’ni am ab  
oshiradilar. “Toza buzish" deganda axborot tashuvchisiga hech qanday zarar 
vetkazmasdan, axborot tizimining ishi samarasini kamaytirmagan holda kerakT 
axborot resursiga kiriladi.

• Vandal xakerlar - kompyuter tizimiga ongli ravishda kirib unga zarar 
vetkazuvchi shaxslar.

• Kompyuter qaroqchilari -  kompyuter dasturiy ta’minotini sotish maqsadida 
ularning kalitini sindiruv chi shaxslar yoki guruhlar.

• Kiberterroristlar- terrorizmning yangi tun bo4gan virtual terror bilan 
shug'ullanuvchi shaxslar. Ular kompyuter axborot tizimlari va tarmoqlari vordamida 
turli xil g arazli axborot (davlat sivosatiga yot g oyalami) targ ibotlami amalga 
oshiradilar.

• Virmeykerlar - kompyuter viruslarini yaratuvchi shaxslar.
• Frikerlar - telefon tarmog‘iga qonunbuzarlik yo‘li bilan kiruvchi shaxslar.

Kompyuter virusi -  bu o‘z-o‘zidan ko‘payuvchi. kompyuter tarmoqlari va
axborot tashuvchilari orqali erkin tarqaluvchi, hamda kompyuter va unda 
saqlanayotgan axborot va dasturlarga zarar vetkazuvchi dastur kodi yoki buyruqlar 
ketma-ketligi hisoblanadi. Kompyuter viruslari quyidagi xossalarga ega: o‘zidan 
nusxa ko‘chirish, axborotdan ruxsatsiz foydalanishni amalga oshirish. Virus, 
aksarivat hollarda nosozlik va buzilishlarga sabab bo'ladi va biror hodisa yuz berishi 
bilan, masalan. aniq kunning kelishi bilan ishga tushirilishi mumkin.

Axborot himoyasi - tashkilot axborot resurslarini butunligi, haqiqiyligi va 
qimmat baho ma’lumotlaming konfidentsialligi buzilishini oldini olish va buning 
natijasida tashkilotning boshqaruv va ishlab chiqarish faoliyatida real axborot 
xavfsizligini ta'minlashdir.

8.2-rasm. Axborotlami himoyalash tizimining ta minotlari 
Axborotlami himoyalashning huquqiy ta'minoti. Axborotlami himoyalash 
bo‘yicha tashkilot va dav lat o'rtasidagi munosabatlaming qonuniyligi va shuningdek,
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tashkilot bilan xodimlar orasida axborotlami himoya qilish bo'yicha xodimlaming 
^ajburiyati va qoida buzilganda javobgarlikning huquqiy asoslarini nazarda tutadi. 
Axborotlami himoyalashning tashkiliy ta’minoti. Xodimlami axborot himoyalash 

idalariga rioya qilish bo‘yicha boshqaruv hamda himoya texnologiyasim 
olrnatuvchi tadbirlar qo'llashni o‘z ichiga oladi 
Axborotlami himoyalashning tashkiliy ta’minoti

• Himoyalashning rejimlarini o'matish;
. Hujjat bilan kirish rejimini o‘matish;
• Xodimlami olrganish va ularga ma'suliyatni tushuntirish;
• Konfidentsial axborot bilan ishlash reglamentini o‘matish;
. Konfidentsial axborotni ro^yxatlashtirish, saqlash va vobqotish ishlarini tashkil 

etish;
• Axborot xavfsizligiga boigan tashqi va ichki tahdidlami tahlil qilish hamda 

ulami bartaraf qilishni tashkil etish va boshqalar.
Axborot himoyasining texnik -  muhandislik ta’minoti muhandislik ta’minoti 
axborotga qilinadigan tahdidning oldini olishdagi texnik va muhandislik vosita va 
uslublarini ozida jamlavdi. Ularga tashkilot hududi muhofaza chegaralarini 
shakllantirish, bino va xonalami himoya texnik vositalar majmuasi bilan jihozlashlar 
kiradi.
Axborotlami himoyalashning dasturiy-matematik ta ’minoti. Axborotlami 
himoyalash tizimiga kiruvchi bu ta’minot bevosita kompyuterda lokal tarmoqda 
hamda turli axborot tizimlarida ishlov berilayotgan va saqlanayotgan axborotni 
himoyalash uchun moMjallangan. Unga:

• Kompyuter va undagi axborotlami parol bilan himoyalash dasturlari;
• Ixchamlovchi dasturlar;
• Antivirus dasturlari;
• Kriptogrfik himoyalash tizimlari.

Konfidentsial axborot himoyasini ta’minlash bo‘vicha quyidagi vo‘nalishlarda 
dasturlami keltirish mumkin:

• axborotlarga ruxsatsiz kirishdan himoya qilish;
• axborotlami nusxa ko chirishdan himoya qilish;
• kompyuter viruslaridan himoya qilish;
• aloqa kanallarini himoya qilish dasturlari.

Antivirus dasturlari
• Asosiy vazifasi: Kompyuter viruslarini yuqishini oldini olish, tezkor xotira va 

disklardagi viruslami topish va davolash. Turlari:
- DrWeb;
- Kasperskiy
- ESET NOD 32
- AVAST
- Norton antivirus. Antivirus dasturlarining imkoniyatlari bilan yuqorida xizmat 

ko'rsatuvchi dasturlar mavzusida batafsil tanishganmiz.
Axborotlami himoyalashning kriptografik usullari. Kriptografiya -  “sirli 

vozuv” degan ma'noni anglatib, axborotlaming o‘zaro ta’siri jarayonida ulami
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himoyalash usullarini o'rganuvchi fandir. Axborotlarni o'zaro tasiri jarayo^ 
deganda ikki yoki undan ortiq sub’yektlaming axborot almashinishi yoki unga ishloy 
berish jarayoni tushuniladi. Axborotlarni himoya qilishning boshqa usullaridan farqij 
o‘laroq kriptografiya usullari axborotlarni maxfiy algoritmlar yordami^ 
0‘zgartirishga asoslangandir.
Oddiy shifrlashga misol

• «Axborot»
• «Btsvpspu»

MASHQ. Axborotlarni himoyalovchi texnik va dasturiy vositalar bilan ishlash 
Ishning maqsadi: Talabalarda axborotlarni himoyalovchi texnik va dasturiy vositalar 
bilan ishlash ko‘nikmava malakalami shakllantirish.

Axborotlar hajmi kun sayin oshib borishi va kompvuterlashtirish ko‘lami 
kengaygan sari axborotni himoya qilish o'ta dolzarb muammo bo‘lib bormoqda 
Bunga misol sifatida ruxsat etilmagan axborotlarga kirish, ulami ko‘chirib olish, 
zarur axborotlarni u yoki bu yo‘l bilan yo‘q qilishga bo‘lgan harakatlami 
keltirishimiz mumkin.

Axborot xavfsizligi. informatsion texnologiyalar sohasida tez rivojlanib 
kelayotgan yo'nalishlardan hisoblanadi. Axborot xavfsizligi sozi keng ma noda 
ishlatilib, axborot doirasida biror bir jarrayat, davlat va xalqlaming qiziqishini 
himoyalashdan iboratdir.

Ikkinchi tomondan axborotlarni himoyalash, bu ma’lumotlaming xavfsizligini 
ta’minlashgayonaltirilgan kompleks tadbirdir.

Uchindu tomondan axborotlarni himoyalash deb. jamivatda axborot 
muhitining fuqarolar, tashkilotlar va davlat manfaatlarida shakllanishi, foydalanishi 
va rivojlanishini ta'minlaydigan himoyalash tushuniladi. Umumiy holda axborotlarni 
himoyalash deyilganda:

4  Axborot butunligini ta minlash;
4- Maxsus ruxsatga ega boimagan shaxslaming davlat va jamiyat uchun muhim 

bo lgan axborotlardan foydalanishlarining oldini olish kabi tushunchalar tushuniladi. 
Axborot xavfsizligining asosiy tashkil qiluvchilariga:

4  Boglana olish, bu talab qilingan xizmat qiluvchi ma’lumotlami kerakli vaqtda 
olish imkoniyatining mavjudligi;

4- Yaxlitlik. bu ma’lumotlaming ruxsatsiz o‘zgartirilishi va buzilishidan 
himoyalash;

4  Maxfiylik bu ma’lumotlarga yashirin, ruxsatsiz kirishdan himoyalanish 
tushunchalari kiradi.
Bulardan tashqari, xavf va hujum kabi asosiy tushunchalar mavjud bo4lib, ular 

quyidagicha talqin qilinadi:
Xavf deb, ma’lum ma’noda axborot xavfsizligi buzilishining potentsial 

imkoniyati mavjudligi tushuniladi
Hujum deb esa, xa\ fni amalga oshirishga qaratilgan har qanday noqonuni}r 

xatti harakatlarga aytiladi. Hujumning eng xavfli usuli - bu axborot tizimlariga zarar 
yetkazuvchi dasturiy ta minotlarning ishlab chiqarilishidir. Ularga:



■ zarar yetkazuvchi funktsiyalar;
■ vims tarqatuvchi kichik hajmdagi dasturlar kiradi.

2arar yetkazuvchi funktsiyalar quyidagilami bajarishga moMjallangan:
• boshqa zarar yetkazuvchi dasturlar ishlab chiqish;
• manbalarga agressiv talab qo yish va shu tarzda ulardan foydalanish;
■ ma’lumotlami o^gartirish yoki buzib vuborish;
■ hujum qilinavotgan tizim ustidan tekshirishni qamrab olish

Virus tarqatuvchi dasturlaming vazifasi turlicha bo'lib, asosan boshqa 
dasturlarga kirish. tarqalish va unga yuklatilgan vazifa yuzasidan amallami 
bajarishga qaratilgandir. Ma’lumotlami himoyalashdan asosiy maqsad, yetkazilishi 
kutilayotgan zararlami iloji boricha kainaytmshdan iborat.

Axborotni himova qiiishning texnik usullari: uskunaviv, dasturiy va uskunali 
dasturlarga bo'linib, u quydagi masalalarni ham yechishga qaratilgandir:

■ Kompyuter tizimlari va tarmoqlarida, axborotga ruxsat etilmagan
murojaatlardan himoyalash;

■ Virusga qarshi himoya qilish;
■ Xabarlami berkligini taminlash.

O'z vaqtida, axborotlami dasturiy himoya qiiishning quydagi usullari mavjud:
■ Axborotni zaxiralash yoki nusxalash usullari;
■ Axborotni himoya qiiishning kriptografik usullaridan foydalanish;
■ Simmetrik va nosimmetrik shifrlash usullaridan foydalanish.

Kompyuter tarmoqlarida axborotni himoyalash deb, foydalanuvchilami 
ruxsatsiz tarmoq elementlari va zaxiralariga egalik qilishni man etishdagi texnik, 
dasturiy va kriptografik usul д а vositalar hamda tashkiliy tadbirlarga aytiladi.

Texnik vositalar - bu avtonom holda ishlaydigan qurilma va tizimlardir. 
Masalan, oddiy eshik qulflari, derazaga o‘matilgan temir panjaralar, qo‘riqlash elektr 
uskunalari texnik vositalarga kiradi.

Dasturiy vositalar - bu axborotlami himoyalash funktsiyalarini bajarish uchun 
moMjallangan maxsus dasturiy ta’minotdir.

Axborotlami himoyalashda birinchi navbatda eng keng qo'llanilgan dasturiy 
vositalar, hozirgi kunda ikkinchi darajali himoya vositasi hisoblanadi. Bunga misol 
sifatida parol tizimini keltirish mumkin.

Tashkiliy himoyalash vositalari - bu telekommunikatsiya uskunalarining 
varatilishi va qoMlanishi jarayonida qabul qilingan tashkiliy-texnikaviy va tashkiliv- 
huquqiv tadbirlardir. Bunga bevosita misol sifatida quyidagi jarayonlami keltirish 
mumkin: binolaming qurilishi, tizimni loyihalash, qurilmalami o‘matish, tekshirish 
va ishga tushirish.

Ahloqiy himoyalash vositalari - bu hisoblash texnikasining rivojlanishi 
oqibatida paydo bo‘ladigan tartib va kelishuvlardir. Ushbu tartiblar qonun darajasida 
bo‘lmasada, uni tan olmaslik foydalanuvchilarga ziyon yetkazishi mumkin.

Qonuniy himoyalash vositalari - bu davlat tomonidan ishlab chiqilgan 
huquqiy hujjatlar sanaladi. Ular bevosita axborotlardan foydalanish, qayta ishlash va 
uzatishni tartibga soladi va ushbu qoidalami buzuvchilaming mas’uli) atlarini aniqlab 
beradi.
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Hozirgi kunda ma'lumotlami ruxsatsiz chetga chiqib ketish yo‘llari 
quyidagilardan iborat:

■ Elektron nurlami chetdan turib o‘qib olish;
■ Aloqa kabellarini elektromagnit to‘lqinlar bilan nurlatish;
■ Yashirin tinglash qurilmalarini qo'llash;
■ Masofadan rasmga tushirish;
■ Printerdan chiqadigan akustik to'lqinlarni o'qib olish;
■ Ma'lumot tashuvchilarni va ishlab chiqarish chiqindilarini o'g'irlash;
■ Tizim xotirasida saqlanib qolgan ma’lumotlami o‘qib olish;
■ Himoyani yengib ma’lumotlami nusxalash;
■ Qayd qilingan foydalanuvchi niqobida tizimga kirish;
■ Dasturiy tuzoqlami qo llash;
■ Dasturlash tillari va operatsion tizimlarning kamchiliklaridan foydalanish;
■ Dasturtarda maxsus belgilangan sharoitlarda ishga tushishi mumkin bo‘lgan 

qism dasturlaming mavjud bo'lishi;
■ Aloqa va uskunalarga noqonuniy ulanish;
■ Himoyalash vositalarini qasddan ishdan chiqarish;
■ Kompyuter viruslarini tizimga kiritish va undan foydalanish.

Ushbu yoilardan deyarli barchasini oldini olish mumkin, lekin kompyuter 
viruslaridan hozirgacha qoniqarli himoya vositalari ishlab chiqilmagan. Bevosita 
tarmoq bo‘yicha uzatiladigan ma’lumotlami himoyalash maqsadida quyidagi 
tadbirlami bajarish lozim bo‘ladi:

■ uzatiladigan ma’lumotlami ochib o’qishdan saqlanish;
■ uzatiladigan ma’lumotlami tahlil qilishdan saqlanish;
■ uzatiladigan ma’lumotlami o‘zgartirilishiga yo'l qo'ymaslik va o'zgartirishga 

urinishlarni aniqlash;
■ ma lumotlami uzatish maqsadida qo‘llaniladigan dasturiy uzilishlami 

aniqlashgayo‘l qo‘ymaslik;
■ firibgarlik vo'li bilan ulanishlaming oldini olish.

Ushbu tadbirlami amalga oshirishda asosan kriptografik usullar qollaniladi.
Axborotni himoyalash uchun kodlashtirish va kriptograflya usullari 

qollaniladi.
Kodlashtirish deb axborotni bir tizimdan boshqa tizimga ma lum bir belgilar 

yordamida belgilangan tartib bo‘yicha o'tkazish jarayoniga aytiladi.
Kriptograflya deb maxfiy xabar mazmunini shifrlash, ya’ni ma’lumotlami 

maxsus algaritm bo'yicha o'zgartirib, shifrlangan matnni yaratish vo'li bilan 
axborotga ruxsat etilmagan kirishga to‘siq qo‘yish usuliga aytiladi.

Stenografiyaning kriptografiyadan boshqa o zgacha farqi ham bor. Ya’ni 
uning maqsadi - maxfiy xabaming mavjudligini yashirishdir. Bu ikkala usul 
birlashtirilishi mumkin va natijada axborotni himoyalash samaradorligini oshirish 
uchun ishlatilishi imkoni paydo bolladi. (masalan. kriptografik kalitlami uzatish). 
Kompyuter texnologivalari stenografiyaning rivojlanishi va mukammallashuviga 
yangi turtki berdi. Natijada axborotni himoyalash sohasida yangi yo'nalish - 
kompyuter stenogryaflyasi paydo bo ldi.
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Kriptografiya nuqtai -  nazaridan shifr - bu kalit demakdir va ochiq 
jna’lumotlar to'plamini yopiq (shifrlangan) ma'lumotlarga o‘zgartirish kriptografiya 
o‘zgartirishlar aigoritmlari majmuasi hisoblanadi.

Kalit - kriptografiya o‘zgartirishlar algoritmining ba’zi-bir parametrlarining 
maxfiy holati bo lib, barcha algoritmlardan yagona variantini tanlaydi. Kalitlarga 
nisbatan ishlatiladigan asosiy ko rsatkich bo‘lib kriptomustahkamlik hisoblanadi.

Kriptografiya himoyasida shifrlarga nisbatan quyidagi talablar qo'yiladi:
• yetarli darajada kriptomustahkamlik;
• shifrlash va qavtarish jarayonining oddiyligi;
• axborotlarni shifrlash oqibatida ular hajmining ortib ketmasligi;
• shifrlashdagi kichik xatolarga tasirchan boMmasligi.

Ushbu talablarga quyidagi tizimlar javob beradi:
• o‘rinlarini almashtirish;
• almashtirish;
• gammalashtirish;
• analitik o‘zgartirish.

0 ‘rinlarini almashtirish shifrlash usuli bo‘yicha boshlang‘ich matn 
belgilarining matnning ma’lum bir qismi doirasida maxsus qoidalar yordamida 
o‘rinlari almashtiriladi.

Almashtirish shifrlash usuli bo'yicha boshlangich matn belgilari 
foydalanilavotgan yoki boshqa bir alifbo belgilariga almashtiriladi.

Gammalashtirish usuli bo‘yicha boshlang'ich matn belgilari shifrlash 
gammasi belgilari, ya’ni tasodifiy belgilar ketma-ketligi bilan birlashtiriladi.

Tahliliy o‘zgartirish usuli bo‘yicha boshlang‘ich matn belgilari analitik 
formulalar yordamida o‘zgartiriladi, masalan, vektomi matritsaga ko‘paytirish 
yordamida. Bu yerda vektor matndagi belgilar ketma-ketligi bo1 Isa, matritsa esa kalit 
sifatida xizmat qiladi.

0 ‘rinlarni almashtirish usullari.
Ushbu usul eng oddiy va eng qadimiy usuldir. 0 ‘rinlami almashtirish 

usullariga misol sifatida quyidagilami keltirish mumkin:
• shifrlovchi jadval;
• sehrli kvadrat.

Shifrlovchi jadval usulida kalit sifatida quyidagilar qoilaniladi:
• jadval oichovlari;
• so‘z yoki so‘zlar ketma-ketligi;
• jadval tarkibi xususiyatlari.

Almashtirish usullari.
Almashtirish usullari sifatida quyidagi usullami keltirish mumkin:

4- Sezar usuli;
4- Affin tizimidagi Sezar usuli;
A- Tayanch so‘zli Sezar usuli va boshqalar.

Sezar usulida almashtiruvchi harflar к siljish bilan aniqlanadi. Sezar bev osita к 
= 3 bo‘lganda ushbu usuldan foydalangan.
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к = 3 bo'lganda va alifbodagi harflar m = 26 ta boMganda quyidagi jalvaJ hosil 
qilinadi (8.1-jadval):
__________________ 8. 1-jadval. к = 3 bolganda va alifboiiagi harflar m = 26 ta bo‘lgandaRi iadv»i

4 __.. 1Л XT " ЛA D N -> Q
В -*■ E О R
С —► F P -*■ S
D — G Q -> T
E — H R —► и
F —’► 11 S -* V
G — J T -> w
H -*■ К и — X
I —*• L V -> Y
J —<• M w —► z
К — N X -> A
L — О Y —> В
M -*■ P Z С

Misol:
Main sifatida KOMPUTER soVini oladigan bo‘lsak, Sezar usuli natijasida 

quyidagi shifrlangan yozuv hosil bo‘ladi: NRPSBX3HU.
Sezar usulining kamchiligi bu bir xil harflaming o‘z navbatida, bir xil harflarga 

almashishidir.

Savol va topshiriqlar
1. Kriptografiya haqidagi asosiy tushunchalami izohlang
2. Axborotlami kriptografiyali himoyalash tamoyillarini izohlang.
3. Simmetriyali kriptotizim asoslarini izohlang.
4. O'rinlami almashtirish usullarini izohlang.
5. Axborot xavfsizligi deganda nimani tushundingiz?
6. Axborotlami himoyalash deganda nimani tushundingiz?
7. Xavf nima? Hujum nima?

Test savollari
1. Kompyuter v irusi. . .
A) Boshqa dasturlarga Icirib boruvchi va turli 
maqsadga muvofiq bo‘lmagan harakatlarai amalga 
oshiruvchi dastur
B) Hujjatlami yo‘qotuvchi dastur
C) Kompyuter bajara olmavdigan maxsus tilda 
yozilgan dastur
D) Bajarilishida to‘xtab qoladigan noto‘g ‘ri 
yozilgan dastur

2. Qaysi dastur antivirus emas?
A) Defrag
B) Norton Antivirus
C) A VP
D) Dr Web

D) ob’yekt yoki sub’yektni unga berilgan 
identifikatorga mosligini tekshirish va belgilar 
ketma-ketligidan iborat maxfiy kodini tekshirish 
orqali aslligini aniqlash.

7. Autentifikatsiya (ingL Authentication) nima?
A) ob’yekt yoki sub’yektni unga berilgan 
identifikatorga mosligini tekshirish va belgilar 
ketma-ketligidan iborat maxfiy kodini tekshirish 
orqali aslligini aniqlash.
B) axborot tizimlari ob’yekt va sub'yektlariga uni 
tanish uchun nomlar (identifikator) berish va 
berilgan nom bo‘yicha solishtirib uni aniqlash 
jarayoni.
C) uning egasi haqiqiyligini aniqlash jarayonida
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•j «Milliy axborot-kommunikatsiya
fixinibirining kompyuter xavfsizligini ta ’minlash 
bo’yicha qo 'shinuha choralar to‘g‘risida»gi PQ- 
i 67-son qarori qachun qabul qilingan?
д) 2005 yil 5 senlvabr
B) 2015 yi! 15 scntyabr
C) 2005 yil 25 sentyabr
D)2017 yil 17 sentyabr

4, Login nima?
д) shaxsning, o ‘zini axborot kommunikatsiya 
tizimiga tanishtirish jarayonida qoMlaniladigan 
belgilar ketma-ketligi bo‘lib. axborot 
kommunikatsiya tizimidan foydalanish huquqiga 
ega bo‘lish uchun foydalanuvchining maxfiy 
bo'lmagan qayd yozuvi hisoblanadi.
B) uning egasi haqiqiyligini aniqlash jarayonida 
tek sh iru v  axboroti sifatida ishlatiladigan belgilar 
ketma-ketligi (maxfiy so‘z). U kompyuter bilan 
muloqot boshlashdan oldin. unga klaviatura yoki 
identifikatsiya kartasi yordamida kiritiladigan 
liarlli, raqamli yoki harfli-raqamli kod shaklidagi 
maxfiy so‘zdan iborat.
C) axborot tizimlari ob’yekt va sub yektlariga uni 
tanish uchun nomlar (identitikator) berish va 
berilgan nom bo‘yicha solishtirib uni aniqlash 
jarayoni
D) ob’yekt yoki sub’vektni unga berilgan 
identifikatorga mosligini tekshirish va belgilar 
ketma-ketligidan iborat maxfiy kodini tekshirish 
orqali aslligini aniqlash.

5 Parol nima?
A) uning egasi haqiqiyligini aniqlash jarayonida 
tekshiruv axboroti sifatida ishlatiladigan belgilar 
ketma-ketligi (maxfiy so‘z). U kompyuter bilan 
muloqot boshlashdan oldin. unga klaviatura yoki 
identifikatsiya kartasi yordamida kiritiladigan 
hartli, raqamli yoki harfli-raqamli kod shaklidagi 
maxfiy so‘zdan iborat.
B) shaxsning. o‘zini axborot kommunikatsiya 
tizimiga tanishtirish jarayonida qo'llaniladigan 
belgilar ketma-ketligi boMib, axborot 
kommunikatsiya tizimidan foydalanish huquqiga 
ega bo‘lish uchun foydalanuvchining maxfiy 
boimagan qayd yozuvi hisoblanadi.
C) axborot tizimlari ob yekt va sub yektlariga uni 
tanish uchun nomlar (identitikator) berish va 
berilgan nom bo‘yicha solishtirib uni aniqlash 
jarayoni.
D) ob’yekt yoki sub'yektni unga berilgan 
identifikatorga mosligini tekshirish va belgilar 
ketma-ketligidan iborat maxfiy kodini tekshirish 
orqali aslligini aniqlash

6. Identifikatsiya (ingL Identification) nima?

tekshiruv axboroti sifatida ishlatiladigan belgilar 
ketma-ketligi (maxfiy so‘z). U kompyuter bilan 
muloqot boshlashdan oldin, unga klaviatura yoki 
identifikatsiya kartasi yordamida kiritiladigan 
hartli, raqamli yoki hartli-raqamli kod shaklidagi 
maxfiy so‘zdan iborat.
D) shaxsning. o‘zini axborot kommunikatsiya 
tizimiga tanishtirish jarayonida qoMlaniladigan 
belgilar ketma-ketligi bo‘lib, axborot 
kommunikatsiya tizimidan foydalanish huquqiga 
ega bo‘lish uchun foydalanuvchining maxfiy 
bo‘lmagan qayd yozuvi hisoblanadi.

8. Avtorizatsiya nima?
A) foydalanuvchining resursdan foydalanish 
huquqlari va ruxsatlarini tekshirish jarayoni. Bunda 
foydalanuvchiga hisoblash tizimida ba’zi ishlami 
bajarish uchun muayyan huquqlar beriladi.
B) ob’yekt yoki sub’yektni unga berilgan 
identifikatorga mosligini tekshirish va belgilar 
ketma-ketligidan iborat maxfiy kodini tekshirish 
orqali aslligini aniqlash.
C) axborot tizimlari ob’yekt va sub’yektlariga uni 
tanish uchun nomlar (identitikator) berish va 
berilgan nom bo‘yicha solishtirib uni aniqlash 
jarayoni.
D) uning egasi haqiqiyligini aniqlash jarayonida 
tekshiruv axboroti sifatida ishlatiladigan belgilar 
ketma-ketligi (maxfiy so‘z). U kompyuter bilan 
muloqot boshlashdan oldin. unga klaviatura yoki 
identifikatsiya kartasi yordamida kiritiladigan 
hartli, raqamli yoki harfli-raqamli kod shaklidagi 
maxfiy so‘zdan iborat.

9. Ro'yxatdan o'tish nima?
A) foydalanuvchilarni ro'yxatga olish va ularga 
dasturlar va ma’lumotlami ishlatishga huquq berish 
jarayoni.
B) ob’yekt yoki sub’yektni unga berilgan 
identifikatorga mosligini tekshirish va belgilar 
ketma-ketligidan iborat maxfiy kodini tekshirish 
orqali aslligini aniqlash.
C) axborot tizimlari ob’yekt va sub’yektlariga uni 
tanish uchun nomlar (identifikator) berish va 
berilgan nom bo‘yicha solishtirib uni aniqlash 
jarayoni.
D) uning egasi haqiqiyligini aniqlash jarayonida 
tekshiruv axboroti sifatida ishlatiladigan belgilar 
ketma-ketligi (maxfiy so‘z). U kompyuter bilan 
muloqot boshlashdan oldin, unga klaviatura yoki 
identifikatsiya kartasi yordamida kiritiladigan 
hartli, raqamli yoki hartli-raqamli kod shaklidagi 
maxfiy so‘zdan iborat.

10. Hujum tushunchasi nima?
A) buzg‘unchintng biror-bir maqsad yo‘lida 
axborot kommunikatsiya tizimlarining mavjud 
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A) axborot tizimlari ob'yekt va sub’yektlariga uni 
tanish uchun nomlar (identifikator) berish va 
berilgan nom bo‘yicha solishtirib uni aniqlash 
jarayoni.
Bj uning egasi haqiqivligiru aniqlash jarayonida 
tekshiruv axboroti sifatida ishlatiladigan belgilar 
ketma-ketligi (maxfiy so‘z). U kompyuter bilan 
muloqot boshlashdan oldin, unga klaviatura yoki 
identifikatsiya kartasi yordamida kiritiladigan 
harfli, raqamli yoki hartli-raqamli kod shaklidagi 
maxfiy so‘zdan iborat.
C) shaxsning, o ‘zini axborot kommunikatsiya 
tizimiga tamshtirish jarayonida qo‘llaniladigan 
belgilar ketma-ketligi bo‘lib, axborot 
kommunikatsiya tizimidan fovdalanish huquqiga 
ega bo‘lish uchun foydalanuvchining maxfiy 
bo‘lmagan qayd yozuvi hisoblanadi.

himoyalash tizimlarini buzishga qaratilgan liarakati
B) ob’yekt yoki sub'yektni unga berilgan 
identifikatorga mosligini tekshirish va belgilar 
ketma-ketligidan iborat maxfiy kodini tekshirish 
orqali aslligiru aniqlash.
C) axborot tizimlari ob'yekt va sub'yektlariga uni 
tanish uchun nomlar (identifikator) berish va 
berilgan nom bo‘yicha solishtirib uni aniqlash 
jarayoni
D) uning egasi liaqiqiyligini aniqlash jarayonida 
tekshiruv axboroti sifatida ishlatiladigan belgilar 
ketma-ketligi (maxfiy so‘z). U kompyuter bilan 
muloqot boshlashdan oldin, unga klaviatura yoki 
identifikatsiya kartasi yordamida kiritiladigan 
harfli. raqamli yoki hartli-raqamli kod shaklidagi 
maxfiy so‘zdan iborat.
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IX BOB. ELEKTRON TIJORAT

36-§. Elektron tijorat tizimlari va ularning ahamiyati

X ayanch  tushunchalar; elektron tijorat, elektron pul, mobil tijorat, Internet- 
banking, elektron kannon.

Elektron tijorat tizimlari va m-tijoratda elektron va mobil savdo 
konvertatsiyasining afzalliklari biznesga kirishda sarf harajatlami kamaytirish, 
axborot va mollar oqimini tezlatish, buyurtmalar berish va buyurtmalami qayta 
ishlashni aniqligini orttirish, shuningdek mijozlarga xizmat ko‘rsatish darajasini 
ko‘tarishdan iborat. Bu afzalliklar 9.1-jadvalda keltirilgan63.

9.1 -jadval.

Provides global reach
Explanation

Tashkilotlarga o ‘z mahsulotlarini butun dunyo bozori bo‘ylab 
sotish, ishlab chiqaruvchilarga esa past narhlarda sotib olish 
imkonini beradi.

Reduces costs Vaqtni ortiqeha sarflashni kamaytirish va buyurtma qilish va 
yetkazishning butun jarayonidagi qadamlar sonini kamaytirishi 
bilan biiga kolp sonli xaridlarni yuqori aniqlik bilan amalga 
oshirish imkonini beradi.

Speeds flow o f goods and 
information

Elektron bog‘Ianishlar va kommunikatsion jarayonlar hisobiga 
axborot oqimi tezlashadi.

Increased accuracy Foydalanuvchilarga o ‘zlarining shaxsiy spetsifikatsiyasini va 
buyurtma haqidagi axborotni bevosita inson tomonidan 
ma’lumotlami xato kiritilishini bartataf qilgan holda kiritishga 
imkon beradi.

Improves customer service Jony holati va yetkazib berish muddati haqidagi batafsil 
axborotlar va ularning ortishi

Mobil tijorat. Mobil tijorat (m-tijorat) mobil simsiz qurilmalami qoilashga 
moMjallangan bo'lib, bunday qurilmalarga uyali telefonlar, smartfonlar orqali 
buyurtmalar berish va tijoratni yuritish imkonini beradi64.

Elektron tijorat faoliyati dastlab 0 ‘zbekiston Respublikasining «Elektron 
tijorat to‘g‘risida»gi 2004 yil 29 apreldagi 613-son Qonuni bilan, 2018 yil 14 maydan 
0 ‘zbekiston Respublikasi Prezidentining «Elektron tijoratni jadal rivojlantirish chora- 
tadbirlari to‘g'risida»gi PQ-3724-sonli qarori bilan belgilanadi va amalga oshiriladi. 
Elektron tijorat -  bu tijorat aloqalarining bir turi bo‘lib, sotuvchi va xaridor 
o‘rtasidagi shartnomalar hamda xizmatlar Interent orqali amalga oshiriladi.
Elektron tijoratning an’anaviy savdo turlaridan farqi:

• xaridor o‘ziga qulay vaqt, joy va tezlikda mahsulotni tanlash va sotib olish;

63 Ralph M. Stair, George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology, 
Cengage Learning. USA. 2012. 227-p.
64 Ralph M. Stair, George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology, 
Cengage Learning. USA. 2012. 221-p.
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• savdo-sotiq faoliyatini ish faolivati bilan birga parallel ravishda borishi;
• ko'p sonli xaridorlaming bir vaqtning o‘zida murojaat qila olishi.
• kerakli malisulotlarni tezlikda izlab topish va transport vositalaridan samarali 

foydalanish;
• xaridoming yashash joyi. sog‘lig‘i va moddiv ta’minlanish darajasidan qat’iy 

nazar hamma qatori teng huquqli mahsulot sotib olish imkoniyati;
• hozirgi kunda chiqqan jahon standartlariga javob beradigan mahsulotlarni 

tanlash va sotib olish imkoniyati;
• elektron tijorat sotuvchining mahsulotlarini sotish jarayonidagi imkoniyatini 

vanada kengaytiradi vayangilavdi.
Elektron tijorat ayni vaqtda savdoda keng qoMlanilmoqda. Elektron sotuv 

mollarni to g'ridan-to g‘ri sotish va xizmatlami ko'rsatish tashkilotlar va 
istemolchilar o‘rtasida elektron vitrinalar orqali yoki kataloglar orqali amalga 
oshiriladi. Office Depot, Wal-Mart va boshqa shu kabi kompaniyalar aynan shunday 
model asosida xizmat ko‘rsatadi. O n minglab elektron web-saytlarda uiguiji savdoda 
barcha tovarlami sotib olish mumkin. 9.2-jadvalda B2C turkumidagi web-saytlar top- 
reylingi bo‘yicha ro‘yxati keltirilgan. Unda reyting natijalari Michigan shtati 
universiteti tomonidan ishlab chiqilgan.

9.2-jadvalda B2C turkumidagi web-saytlar top-reytinftj
W eb sayt ACSI indeks Mahsulot turi

NetflLx.com 85 DVDlarpochta orqali
Amazon.com . « I ...... Kitoblar, musiqalar, DVDlar va boshqalar

Avon.com 81 Salomatlik, govzallik va fitness mahsulotlari
DrsFosterSmith.com 1 81 Sevimli yetkazmalar

Newegg.com 81 Kompyuterlar л̂ а kompyuter jihozlari
QVC.com 81 Moda, g o ‘zallik, zargarlik va uy jihozlari

TigerDirect.com 79 Kompyuterlar va kompyuter jihozlari
HPShopping.com 1 78 Kompyuterlar va kompyuter jihozlari

LLBean.com 78. Ayollar va erkaklar kiyimlari
Shutterfly.com 78 Fotografiya boTimi

VictoriaSecret.com 78 J Ayollar kiyimlari

Elektron pul aylanmasini tushunish uchun 9.1-rasmda keltirilgan chizmaga 
e'tiboringizni qarating. Unga ko‘ra elektron tijoratni amalga oshirish uchun awal 
mijoz (foydalanuvchi) o‘zining naqd puli bilan bankka tashrif buyurishi va naqd pulni 
bankdan elektron pulga avlantirib olishi mumkin boiadi.

So‘ng o‘zining hisobidagi e-pulni o‘zi xohlagan xizmatlar va itovarlar uchun 
sotuvchilarga (internet do'koni. turli xizmatlami amalga oshiruvchi tashkilotlar) 
sarflashi mumkin bofadi. Bunda foydalanuvchi tovarlar xizmatlami qaysi 
sotuvchidan olishni o‘zi erkin tanlaydi65.

S5 V. Rajaraman Introduction to Information technology' (second edition) PHI Learing Private Limited. India. 2014. 
328-p
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... --> e-pulni eaqlaeh
9.1-rasm. Elektron pul avlanmasi

Elektron pul tushunchasi. Elektron pul -  bu pul birligiga tenglashtirilgan 
belgilar hamda kupvura va tanga rolini bajaruvchi juda katta son yoki favllardir.

Bunday tizimning faoliyat ko‘rsatish 
harajatlari boshqalaridan ancha kam. 
Elektron pullar to‘liq anonimlikni 
ta’minlashi mumkin, chunki uni ishlatgan 
mijoz haqida hech qanday ma’lumot 
berilmaydi.
Elektron pul birliklari. Barcha davlatlarda 
o‘zining pul birliklari bo‘lgani singari 
elektron tijoratda ham pul birliklari mavjud.

9.2-rasm. Elektron tijorat
Bu pul birliklarining ayrimlarini to‘g‘ridan-to‘g‘ri boshqa mamlakatlar hududida 
sarflab boimaydi. Shu sababli ulami sarflashda mos pul birligi kursi bo‘vicha zarur 
pul birligiga ekvivalent sifatida to‘lanadi. Shu bilan birga ko'plab pul birliklarini 
dunyoning aksariyat davlatlari hududida sarflash mumkin.
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0 ‘zbekiston zonasida operatsiyalami amalga oshirish uchun UZSning 
Y-hamyondagi ekvivalenti.

rubl zonasida operatsiyalami amalga oshirish uchun RURning R- 
hamvondagi ekvivalenti.

AQSH dollarida operatsiyalami amalga oshirish uchun USDning Z- 
hamvondagi ekvivalenti.

• EVROda operatsiyalami amalga oshirish uchun EVROning E- 
hamyondagi ekvivalenti.

9.3-rasm. Elektron pul birliklari

Ukraina zonasida operatsiyalami amalga oshirish uchun UAHning U- 
hamyondagi ekvivalenti.

Bdorussiya zonasida operatsiyalami amalga oshirish uchun BYRning B- 
hamyondagi ekvivalenti.

1 gramm oltinning G-hamyondagi ekvivalenti.

m WBC, WMD - WMZning С va D hamyonlardagi kredit operatsiyalari 
uchun ekvivalenti.

9.4-rasm. Elektron pul birliklari 
Bugungi kunda respublikamizda ham bir qancha elektron to‘lov tizimlari 

faoliyat korsatmoqda Bular: WEBSUM; iPAY; PAYNET; WEBMONEY; 
IntellectMoney; Perfect Money; RBK Money; V-money.
Elektron va mobil tijoratni quyidagi turlarda amalga oshirish mumkin66:_________

Ikka firma o‘rtasidagi elektron tijorat.

j
Й ';F 
В В Й .....

Шшm

Firma va mijoz o‘rtasidagi elektron tijorat.

Firma va Davlat o'rtasidagi elektron tijorat.

Mijoz va Davlat o‘rtasidagi elektron tijorat.

9.5-j-asm. Elektron tijorat turlari

64 Ralph M. Stair, George W. Reynolds. Fundamentals o f Information Systems. Sixth edition. Course Technology,
Cengage Learning. USA. 2012. 17-p.
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9.6-rasmda shunday texnologik tizimlar mavjudki ularda biznes-informatsion 
operatsiyalar amalga oshirilishi natijasida axborot yetkazilib berilishi va qarorlar 
qabul qilinishi mumkin bo‘ladi67.

Bilimlami 
va maxsus biznes 

axborot 

tizimlarini boshqarish

Axborotni boshqarish tizimlari va 
qarorlar qabul qilishni qo'Uab- 

quvvatlash 1

| § j p  Elektron tijorstning korporativ tizimlari

9.6-rasm. Axborot yetkazilib berilishi va qarorlar qabul qilinishi6*
Internet -  bank tarmog i. Rivojlangan mamlakatlar banklari o'z xizmat 

darajalarini kengavtirgan holda mijozlariga Intemetdan foydalanishning eng ma’qul 
yo‘llarini tavsiva qilmoqdalar. Bugungi kunda bank sohasida e-banking yangi termini 
paydo bo4di yoki Intemet-bank tarmog‘i yuzaga keldi. Internet -  bank tarmog‘i 
hozirgi kunda 3 ta asosiy onlavnlar orqali xizmat qilmoqda:

• B2C-business-to-consumer;
• B2B-business-to-business;
• E-trading-biijada elektron savdo o‘tkazish.

Web Money Tranfer -  bu elektron hisob tizimi boiib, unda barcha 
foydalanuvchilar universal hisob birliklari bilan ayira boshlashlari mumkin: 
WebMoney (WM) titul belgilari bilan.

iPAY -  bu UzExdagi biija savdolarida, www.uzbex.com global savdo 
maydonchasida, hamda iPAY tizimiga qo‘shilgan internet do‘konlarda onlayn 
to‘lovlami amalga oshirish imkonini beruvchi, 0 ‘zbekiston Respublikasi tovar hom- 
ashyo biijasining to‘lov tizimidir.

Dunyoga mashhur C2C elektron tijorat tizimida to‘lovlami amalga oshirish 
internet orqali jismoniy shaxslar o‘rtasida amalga oshiriladi. Bunda mijoz toiovni 
kredit kartochka bo'yicha yoki elektron pul ko‘chirish vositasida olishi mumkin 
emas. Chunki u qoida bo‘vicha bunday to‘lovlami qayta ishlash infrastrukturasiga 
ega emas. Bunday xizmatlami PayPal.com nomi ostidagi kompaniya taqdim qiladi. 
PayPal tizimini qo‘llash uchun, ikki tomon ham (to‘lov qiluvchi ham oluvchi ham) 
PayPal tizimida o‘z hamyoniga ega (ro yxatdan o‘tgan) boiishi kerak. PayPal 
tizimida o‘z elektron hamyoningizni yaratish juda sodda. Buning uchun siz PayPal

67 Ralph M. Stair, George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology, 
Cengage Learning. USA. 2012. 15-p.
68 Ralph M. Stair, George W.Reynolds. Fundamentals o f  Information Systems. Sixth edition. Course Technology; 
Cengage Learning. USA. 2012. 15-p.
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savtiga kirish va o'zingizning elektron identifikatoringizni kiriting. Ya ni пощ, 
manzil va kredit kartochka yoki bank hisobining rekvizitlari kiritiladi. Bundan 
tashqari siz parolni ham yaratishingiz kerak boiadi. U sizga tasdiq sifatida elektron 
xabar bilan birga identifikatomi ham jo ‘natadi. Siz bundan xabaming (identifikator) 
PayPal tizimidan kelganiga amin boiasiz. Bulami kiritgandan so'ng Pay tugmasini 
bossangiz, ko rsatilgan summa sizning hisobingizdan siz korsatgan oluvchining 
hisobiga ko‘chiriIadi. Tizim esa bundan keyin sizga pul ko'chganligi haqidagi 
tasdiqni elektron xatm pochtangizga jo'natadi. Pa) Pal tizimini qoilashning asosiy 
afzalligi shundaki, siz o‘z kredit kartochkangiz yoki bankdagi hisob raqamingiaii 
xatarga qo‘ymaysiz. Unda hisobni ochish uchun xizmat haqi olinmaydi. PayPal tizimi 
ko‘chirilgan pulni oluvchisidan summaning biror belgilangan foizini oladi xolos. 
PayPal xalqaro kompaniya hisoblanib uning kafili boiib  eBay hisoblanadi. Turli 
valyutalarda toiash imkonini beradi va mahaliiv qonunchilikka bo‘y so nadi. 
Masalan, siz Hindiston banklarida xaridga pul toiashingiz mumkin. Bunda PayPal 
o‘zining hisobidagi puldan mahaliiv almashinuv kursi bo‘yicha toiaydi va 
komissivasi bilan birga yechib oladi69.

Internet-banking. Toiov tizimlari orasida alohida guruh, bu Internet banking 
funktsiyasini bajaruvchi tizim, ya’ni Internet orqali bank operatsiyani amalga oshirish 
hisoblanadi. Internet-banking -  bankdagi hisob raqamni Internet orqali boshqarish 
imkoniyatini beradigan xizmat. Internet-banking imkoniyatlari quyidagilami 
bajarishga imkon beradi:

• bankka barcha turdagi molivaviy hujjatlami yuborish;
• istalgan davr uchun bankdagi hisob raqamlardan ko‘chirmalar va ularga 

tegishli boshqa hujjatlami olish;
• haqiqiy vaqt tartibida toiov hujjatlari bank ishlovidan o'tishining barcha 

bosqichlarini kuzatish;
• xatolar to'g'risida xabarlami tezkor olish:
• kirim va chiqim to‘lov hujjatlarini ko‘rish va chop etish.

Elektron karmon, ulami toidirish va pul olish:
• elektron karmon - bu elektron pullami saqlash uchun mo4jallangan vosita
• tovarlami sotish va xarid qilishga mo‘ljallangan web texnologiyalar asosida 

yaratilgan axborot tizimi tomonidan amalga oshiriladigan vazifalar 
quyidagilardan tashkil topadi:

• mijozga tovar (xizmat) haqida ma’lumot berish;
• mij ozdan to\ ar (xizmat)ga buyurtma qabul qilish;
• ba’zan onlaynli toiov tizimlaridan foydalanilganda uchinchi vazifa-toiov 

haqini olish, tovami sotishda esa yana to'rtinchi vazifa - haqi toiangan tovami 
jo ‘natish qo‘shiladi.
Elektron karmonni toidirish va ulardan pul yechishni quyidagi usullar bilan 

amalga oshirish mumkin:
1. tijorat banklarida naqd pul bilan;
2. bank kartalari (VISA. MasterCard, UzKart) yordamida;

\  Rajaraman Introduction to Information technology (second edition) PHI Learing Private Limited. India. 2014.
328-p.
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3 . pochta orqali;
4. internet-banking yordamida;
5. pul o‘tkazmalar tizimlari yordamida;
6. mobil aloqa yordamida.

VISA kartalari Visa Inc. -  to'lov operatsiyalarini amalga oshirish 
xizmatlarini ta’minlovchi Amerika kompanivasidir. VISA International Service 
Association - jahonning yetakchi to‘lov tizimi hisoblanadi. VISA kartalari bo‘yicha 
yillik savdo aylanmasi 4,8 trillion AQSH dollarini tashkil qiladi. VISA kartalari 
dunyoning 200 dan ortiq mamlakatlarida qabul qilinadi.

9.7-rasm. Xalqaro kartalar 
MasterCard World w ide- dunyoning 210 mamlakatlaridagi 22 ming molivaviy 
tashkilotlami birlashtirgan xalqaro to'lov tizimi hisoblanadi. Bosh ofisi AQSHning 
Nyu-York shahrida joylashgan.
Dunyoda to‘lov kartalarining ulushi (%)

VISA Master Card American
Express

9.8-rasm. Dunyoda to‘lov kartalarining ulushi (%)
Internet do‘konlar va internet birja. Bugungi kunda “Internet do'kon’ nomi 

ostida turli ко 'lam va maqsaddagi yechimlaming keng spektri taklif qilinmoqda. 
WEBSUM elektron toMov tizimidan foydalanadigan internet do‘konlar quyidagilar: 
shoppinguz, evision.uz, pozdrav.uz. market.vvsmuz, nav.uz inmarket.uz.
UzEx internet biija -  bu shaxsiv kompyuter orqali UzEx savdo maydonchalarida 
savdo qilish imkoniyatini beruvchi global milliv savdo maydonchasi. Ushbu savdo 
tizimi, iPAY tizimi foydalanuvchilariga maksimal qulayliklar bilan osongina o‘z 
tovarlarini sotish va kerakli tovarlarni xarid qilish imkonini beradi.
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Test s
1. 0 ‘zbekiston Respublikasining “ Elektron 
tijorat to‘g*risida''gi 613-son Qonuni qathon 
qabul qilingan?
A ) 2004 yil 29 aprelda
B) 2014 yil 29 aprelda 
Cj 1992 yil 29 aprelda
D ) 1994 yil 29 aprelda

2. Elektron tijorat nima?
A) bu tijorat aloqalarining bir turi bo‘lib. sotuvchi 
va xaridor o'rtasidagi shartnomalar hamda 
xizmatlar Interent orqali amalga oshiriladi.
B) xaridor o‘ziga qulay vaqt, joy va tezlikda 
mahsulotm tardash va sotib olish;
C) savdo-sotiq taoliyatini ish taoliyati bilan birga 
parallel ravishda borislii;
D) ko‘p sonli xaridorlaming bir vaqtning o'/.ida 
murojaat qila olishi.

3. Elektron pul nima?
A) bu pul birligiga tenglashtirilgan belgilar hamda 
kupvura va tanga rolim bajaruvchi juda katta son 
yoki fayllardir.
B) bu tijorat aloqalarining bir turi bo'lib, sotuvchi 
va xaridor o‘rtasidagi shartnomalar hamda 
xizmatlar Interent orqali amalga oshiriladi.
C) xaridor oxziga qulay vaqt, joy va tezlikda 
mahsulotni tanJash va sotib olish;
D) savdo-sotiq taoliyatini ish t'aolivati bilan birga 
parallel ravishda borishi;

4. WMY-qanday pul birligi?
A) 0 ‘zbekiston zonasida operatsivalami amalga 
oshirish uchun UZSning Y-hamyondagi 
ekvivalenti.
B) Rubl zonasida operatsivalami amalga oshirish 
uchun RURrung R-hamyondagi ekvivalenti.
C) AQSH doltarida operatsiyalami amalga oshirish 
uchun USDning Z-hamyondagi ekvivalenti.
D) EVROda operatsivalami amalga oshirish uchun 
EVROning E-hamyondagi ekvivalenti.

5. WMR-qanday pul birligi?
A) Rubl zonasida operatsiyalami amalga oshirish 
uchun RURrung R-hamyondagi ekvivalenti.
B) O‘zbekiston zonasida operatsiyalami amalga 
oshirish uchun UZSning Y-hamyondagi 
ekvivalenti.
C) AQSH doliarida operatsiyalami amalga oshirish 
uchun USDning Z-hamyondagi ekvivalenti.
D) EVROda operatsiyalami amalga oshirish uchun 
EVROning E-hamyondagi ekvivalenti.

6. WMZ-qanday pul birligi?
A) AQSH doliarida operatsiyalami amalga oshirish 
uchun USDning Z-hamyondagi ekvivalenti.
B) Rubl zonasida operatsiyalami amalga oshirish 
uchun RURning R-hamyondagi ekvivalenti.
C) 0 ‘zbekiston zonasida operatsiyalami amalga 
oshirish uchun UZSning Y-hamyondagi 
ekvivalenti.
D) EVROda operatsiyalami amalga oshirish uchun 
EVROning E-hamyondagi ekvivalenti.
7. W ME-qanday pul birligi?
A) EVROda operatsiyalami amalga oshirish uchun 
EVROning E-hamyondagi ekvivalenti
B) AQSH doliarida operatsiyalami amalga oshirish 
uchun USDning Z-hamyondagi ekvivalenti.
C) Rubl zonasida operatsiyalami amalga oshirish 
uchun RURning R-hamyondagi ekvivalenti.
D) 0 ‘zbekiston zonasida operatsiyalami amalga 
oshirish uchun UZSning Y-hamyondagi 
ekvivalenti.
8. WMU-qanday pul birligi?
A) Ukraina zonasida operatsiyalami amalga 
oshirish uchun UAHning U-hamyondagi 
ekvivalenti.
B) Belorussiya zonasida operatsiyalami amalga 
oshirish uchun BYRning V-hamyondagi 
ekvivalenti.
C) 1 gramm oltinning G-hamyondagi ekvivalenti^
D) WBC. WMD - WMZrung S va D 
hamvonlardagi kiedit operatsiyalan uchun 
ekvivalenti.
9. W MB-qanday pul birligi?
A) Belorussiya zonasida operatsiyalami amalga 
oshirish uchun BYRning V-hamyondagi 
ekvivalenti.
B) Ukraina zonasida operatsiyalami amalga 
oshirish uchun UAHning U-hamyondagi 
ekvivalenti.
C) 1 gramm oltinning G-hamyondagi ekvivalenti.
D) WBC. WMD - WMZning S va D 
hamvonlardagi kiedit operatsiyalan uchun 
ekvivalenti.
10. W MG-qanday pul birligi?
A) 1 gramm oltinning G-hamyondagi ekvivalenti
B) Belorussiya zonasida operatsiyalami amalga 
oshirish uchun BYRning V-hamyondagi 
ekvivalenti.
C) Ukraina zonasida operatsiyalami amalga 
oshirish uchun UAHning U-hamyondagi 
ekvivalenti.
D) WBC, WMD - WMZning S va D 
hamvonlardagi kredit operatsiyalari uchun 
ekvivalenti.
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37-§. Elektron raqamli imzo

Tayanch tushunchalar: elektron raqamli imzo, elektron raqamli imzoning yopiq 
Icaliti, elektron raqamli imzoning ochiq kaliti, elektron raqamli imzoning haqiqiyligini 
tasdiqlash, elektron hujjat, ro yxatga olish markazi, elektron raqamli imzo vositalari.

(Vzbekiston Respublikasining Elektron raqamli imzo to‘g‘risida Qonuni (N 
562-11) 2003 yil 11 dekabrda qabul qilingan. Qonunda talab etilgan shartlarga rioya 
etilgan taqdirda elektron raqamli imzo qog‘oz hujjatga shaxsan qo‘yilgan imzo bilan 
bir xil ahamiyatga egadir. Elektron malumotlami kriptografik olzgartirish natijasida 
hosil qilingan belgilar ketma-ketligi. Elektron raqamli imzo ma’lumotlar blokiga 
qo'shib qo'viladi va blokni qabul qiluvchiga, manbani va maiumotlaming 
butunligini tekshirish hamda sohtalashtirishdan muhofazalanish imkonini beradi. 
Hozirgi kunga kelib, ayrim mamlakatlar qonunchilik yo‘li bilan raqamli imzodan 
foydalanishni layoqatliligini qonunlashtirib qo‘yganlar. Elektron raqamli imzo 
kalitlari sertifikatlari ro‘yxatga olish markazlari tomonidan beriladi.

0 ‘zbekiston Respublikasining “Elektron raqamli imzo to‘g‘risida”gi Qonuniga 
muvofiq, elektron raqamli imzo — elektron hujjatdagi mazkur elektron hujjat 
axborotini elektron raqamli imzoning yopiq kalitidan foydalangan holda maxsus 
o‘zgartirish natijasida hosil qilingan hamda elektron raqamli imzoning ochiq kaliti 
yordamida elektron hujjatdagi axborotda xatolik yo‘qligini aniqlash va elektron 
raqamli imzo yopiq kalitining egasini identifikatsiya qilish imkoniyatini beradigan 
imzo. Ushbu Qonunda quyidagi asosiv tushunchalar qoilaniladi;

Elektron raqamli imzo — elektron hujjatdagi mazkur elektron hujjat 
axborotini elektron raqamli imzoning yopiq kalitidan foydalangan holda maxsus 
o‘zgartirish natijasida hosil qilingan hamda elektron raqamli imzoning ochiq kaliti 
yordamida elektron hujjatdagi axborotda xatolik yo‘qligini aniqlash va elektron 
raqamli imzo yopiq kalitining egasini identifikatsiya qilish imkoniyatini beradigan 
imzo;

Elektron raqamli imzoning yopiq kaliti — elektron raqamli imzo 
vositalaridan foydalangan holda hosil qilingan, faqat imzo qo‘yuvchi shaxsning 
o‘ziga ma lum bo‘lgan va elektron hujjatda elektron raqamli imzoni yaratish uchun 
moijallangan belgilar ketma-ketligi;

Elektron raqamli imzoning ochiq kaliti — elektron raqamli imzo 
vositalaridan foydalangan holda hosil qilingan, elektron raqamli imzoning yopiq 
kalitiga mos keluvchi, axborot tizimining har qandav foydalanuvchisi foydalana 
oladigan va elektron hujjatdagi elektron raqamli imzoning haqiqiyligini tasdiqlash 
uchun moijallangan belgilar ketma-ketligi;

Elektron raqamli imzoning haqiqiyligini tasdiqlash — elektron raqamli 
imzoning elektron raqamli imzo yopiq kalitining egasiga tegishliligi va elektron 
hujjatdagi axborotda xatolik yo‘qligi tekshirilgandagi ijobiy natija;

Elektron hujjat — elektron shaklda qayd etilgan, elektron raqamli imzo bilan 
tasdiqlangan hamda elektron hujjatning uni identifikatsiya qilish imkonini beradigan 
boshqa rekvizitlariga ega bo‘lgan axborot.
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Mazkur Qonunga ko‘ra elektron raqamli imzodan foydalanish sohasini davlat 
tomonidan tartibga solishni O'zbekiston Respublikasi Vazirlar Mahkamasi va u 
maxsus vakolat bergan organ amalga oshiradi. Aloqa axborotlashtirish va 
telekommunikatsiv a texnologiyalari sohasida 0 ‘zbekiston Respublikasi aloqa, 
axborotlashtirish va telekommunikatsiva texnologiyalari davlat qo'mitasi ERIni 
ro‘yxatga oluvchi vakolatli davlat organi hisoblanadi. Mazkur vazifa Qo'mita 
tizimidagi «UNICON.UZ» -  Fan-texnika va marketing tadqiqotlari markazi Davlat 
unitar korxonasi qoshidagi Elektron raqamli imzolar kalitlarini ro‘vxatga olish 
markazi tomonidan amalga oshiriladi.

Elektron raqamli imzo. Elektron raqamli imzo (ERI) -  elektron hujjatning 
rek\ iziti hisoblangan simvollar ketma-ketligi boMib, elektron hujjatning butunligi va 
haqiqiyligini tasdiqlash uchun moijallangan. Elektron raqamli imzo vositasi bo‘lib -  
dasturiy, dasturiy-apparatli yoki texnik vositalar hisoblanib, quyidagi bir yoki bir 
nechta funktsiyalami amalga oshiradi: elektron raqamli imzo ishlab chiqish, elektron 
raqamli imzoni tekshirish, imzoning shaxsiy kaliti yoki ochiq kalitni varatish. Ochiq 
kalit bilan shifrlash algoritmlarining eng keng tarqalganlandan biridir. Ko‘pincha 
elektron hujjatni tarkibini (mazmunini) shifrlash emas balki, uning muallifini va 
haqiqiyligini o‘matish zarur bo'ladi. Elektron raqamli imzoning asosi bo'lib 
imzolanadigan ma'lumotlami matematik qayta o‘zgartirilishi hisoblanadi. 
Imzolanadigan ma’lumotlarda shaxsiy yopiq kalit qoilamlishi bilan imzolanadigan 
va quyidagi sharoitlarda bajarilishi bilan boradi:
• Elektron raqamli imzoni yaratish faqatgina shaxsiy yopiq kalitni qo‘llagan holda 
amalga oshirilishi mumkin.
• Elektron raqamli imzoni haqiqiyligini tekshirish uchun ochiq kalitga ega bo lish 
yetarli hisoblanadi.
• imzolangan ma'lumotdagi har qandav o'zgarish (xatto katta fayldagi atigi bir bit 
o‘zgarish) elektron raqamli imzoni haqiqiv emas qiladi. Raqamli imzoni qo‘llashda 
axborot shifrlanmavdi va unga bog‘lanish imkoni boMgan har qanday 
foydalanuvchiga ochiqligicha qoladi.

Elektron raqamli imzolar kalitlarini ro'yxatga olish markazi elektron raqamli 
imzoning ochiq kalitlari va shifrlash sertifikatlaridan quyidagi maqsadlarda 
foydalanishni ta'minlash uchun moMjallangan:
- uzatiladigan elektron hujjatlar va ommaviy axborot resurslarining butunligini, 
shuningdek, ulaming ishonchli autentifikatsiya qilinishini nazorat qilish;
- axborot o‘zaro hamkorligi sub yektlarining yuridik jihatdan ahamiyatli elektron 
identifikatsiyalash tizimini yaratish;
- tizim sub vektlarining axborot o‘zaro ishlashida xavfsizlik va foydalana olishning 
ajratilishini ta'minlash;
- axborot o‘zaro hamkorligi sub’yektlarining elektron raqamli imzo kalitlarini 
boshqarish tizimini yaratish.
Hujjatni imzolash jarayoni. Hujjatni imzolash jarayoni quyidagi tarzda amalga 
oshadi. Birinchi qadamda nazorat summasini eslab qoladigan maxsus funktsiya 
(xesh-funktsiya) quriladi. U hujjat tarkibini identifikatsiyalaydi (hujjatning 
"daydjesti" yaratiladi). Ikkinchi qadamda hujjat muallifi o‘zining yopiq kaliti bilan
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xesh-funktsiyasi tarkibini shifrlaydi. Shifrlangan xesh-funktsiya hujjat singari o‘sha 
xabarga joylanadi (9.9-rasmga qarang). Elektron raqamli imzo algoritmida 
qoilaniladigan xesh-funktsiya qator talablami qanoatlantirishi kerak:
• har qanday uzunlikdagi xabar qayd qilingan uzunlikning binar ketma-ketligiga 
o^zgartirilishi kerak;
• xabaming xeshlanishidan olingan versivasi joriy xabar va ulaming ketma-ketligi 
tartibining har bir bitga bog'liq bo‘ladi;
• xabarning xeshlangan versiyasidan xabaming o'zini hech bir usul bilan ham tiklab 
bo‘lmavdi.

Elektron imzoni verifikatsiya qilish algoritmi. Elektron imzoni verifikatsiya 
qilish quvidagilardan iborat. Birinchi bosqichda xabami oluvchi imzolangan hujjat 
xesh funktsiyasining shaxsiy variantini quradi. Ikkinchi bosqichda xesh-funktsivani 
rasshifrovka (qayta shifrlab ma nosini anglab olish) qilish amalga oshadi.

Kalitlami ro'yxatga olish markazi «Elektron raqamli imzo to‘g‘risida»gi 
Qonun talablariga muvofiq vazifa va funktsiyalami bajaradi. Kalitlami ro‘vxatga 
olish markazi tomonidan tayyorlanadigan elektron raqamli imzo kalitining sertifikati 
ITU-T X.509, RFC3279, RFC3280 xalqaro tavsiyalarida belgilangan formatdan 
foydalanadi.

9.9-rasm. Elektron raqamli imzoni imzolash va tekshirish jarayoni 
Dasturiy ta'minot o‘z ichiga Sertifikatlashtirish markazi va ma'muriy 

boshqaruvni oladi. Sertifikatlashtirish markazining serveri elektron raqamli imzo 
kalitlarini ro‘yxatga olish markazi funktsiyalarining kompleksini ta minlaydi va 
elektron raqamli imzo ochiq kalitlari sertifikatlarining muhofazalangan saqlash 
joyidan iborat. Ma’muriy boshqaruvning dasturiy ta’minoti o‘z funktsiyalarini 
bajarishlari uchun kalitlami ro'yxatga olish markazini uzoqdan turib boshqarilishini 
ta'minlaydi.

Ro‘yxatga olish markazi. Ro'yxatga olish markazi maxsus vakolatli organda 
davlat ro‘yxatidan o‘tgan va ushbu Qonunda nazarda tutilgan vazifalami 
bajarayotgan yuridik shaxsdir.
Ro vxatga olish markazi;

■ elektron raqamli imzolaming yopiq va ochiq kalitlarini yaratadi;
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■ elektron raqamli imzo yopiq kaliti muhofaza qilinishini ta’minlaydi;
■ elektron raqamli imzolar kalitlari sertifikatlarining reestrini yiiritadi, uning о‘г 

vaqtida vangilanishini hamda undan yuridik va jismoniy shaxslaming erkin foydalana 
olish imkoniyatini taminlaydi;

■ yuridik va jismoniy shaxslarga elektron raqamli imzolar kalitlarining 
sertifikatlarini elektron hujjatlar shaklida va qog oz hujjatlar shaklida beradi;

■ elektron raqamli imzolar kalitlari sertifikatlarining amal qilishini to'xtatib turadi 
va qayta tiklaydi, shuningdek ulami bekor qiladi;

■ yuridik va jismoniy shaxslaming murqjaatiga binoan elektron raqamli imzolar 
kalitlari sertifikatlarining ko‘chirma nusxalari berilishini, shuningdek elektron 
raqamli imzolar kalitlarining to xtatib turilgan va bekor qilingan sertifikatlari 
to g‘risidagi ma lumotlardan erkin fovdalanilishini ta'minlaydi;

■ yuridik va jismoniy shaxslaming murojaatiga binoan elektron hujjatlardagi 
elektron raqamli imzomng haqiqiyligini tasdiqlaydi;

■ elektron raqamli imzoli qog‘ozdagi elektron hujjatlaming ko‘chirma nusxalarini 
tasdiqlaydi;

■ elektron raqamli imzo kalitining sertifikatidan bundan buyon foydalanish 
imkoniyatiga ta’sir etishi mumkin boigan hollar haqida elektron raqamli imzo yopiq 
kalitining egasini xabardor qiladi;

■ elektron raqamli imzo yopiq kalitining egalarini elektron raqamli imzodan 
foydalanish qoidalariga o'qitish imkoniyatini ta’minlaydi.

Ro yxatga olish markazi bilan yuridik va jismoniy shaxslar o rtasidagi 
munosabatlar shartnoma asosida amalga oshiriladi. Ro‘yxatga olish markazining 
vuridik va jismoniy shaxslar uchun yaratilgan elektron raqamli imzolaming yopiq 
kalitlarini saqlashi hamda elektron raqamli imzo kalitining sertifikatini berish 
maqsadiga tokg‘ri kelmaydigan ma’lumotlami so‘rab olishi taqiqlanadi. Ro‘yxatga 
olish markazlari faoliyatining tartibi 0 ‘zbekiston Respublikasi Vazirlar Mahkamasi 
tomonidan belgilanadi.

Qonunning 7-moddasida elektron raqamli imzo bilan qo‘lda o‘zi qo‘ygan 
imzoning bir xil ahamiyatga ega ekanligini e’tirof etish shartlari elektron hujjatdagi 
elektron raqamli imzo ayni bir vaqtning o‘zida quyidagi shartlarga rioya etilgan 
taqdirda qog‘oz hqjjatga qo‘lda o‘zi qo‘ygan imzo bilan bir xil ahamiyatga egadir, 
agar:

■ elektron raqamli imzoning haqiqivligi tasdiqlangan bo‘Isa;
■ elektron raqamli imzoning haqiqiyligi tasdiqlangan pavtda yoki imzolash paytini 

belgilovchi dalillar boMganda elektron hujjat imzolanayotgan paytda elektron raqamli 
imzo kalitining sertifikati amal qilib turgan bo‘lsa

■ elektron raqamli imzodan elektron raqamli imzo kalitining sertifikatida 
ko‘rsatilgan maqsadlarda foydalanilavotgan bolsa.

Elektron raqamli imzo vositalari. Elektron raqamli imzo vositalari elektron 
hujjatda elektron raqamli imzo varatilishini, elektron raqamli imzoning haqiqiyligi 
tasdiqlanishini, elektron raqamii imzoning yopiq va ochiq kalitlari yaratilishini 
ta’minlaydigan barcha texnikaviy va dasturiy vositalardan iborat bo;ladi. Elektron
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raqamli imzo vositalari qoniin hujjatlarida belgilangan tartibda sertifikatlashtirilishi 
lozim.

Elektron raqamli imzoning yopiq kalitlarini va ochiq kalitlarini yaratish
(9-modda). Elektron raqamli imzoning yopiq kalitlari va ochiq kalitlari yuridik va 
jismoniy shaxslar tomonidan yoki ulaming murojaatiga binoan ro'yxatga olish 
markazi tomonidan elektron raqamli imzo vositalari yordamida yaratilishi mumkin.

Elektron raqamli imzoning yopiq kaliti egasi (10-modda). Elektron raqamli 
imzoni varatgan (elektron hujjatga imzo qo'ygan) va ro'yxatga olish markazi 
tomonidan uning nomiga elektron raqamli imzo kaliti sertifikati berilgan jismoniy 
shaxs elektron raqamli imzo yopiq kalitining egasi bo'ladi. Elektron raqamli imzo 
vopiq kalitining egasi:

* elektron raqamli imzoning yopiq kalitidan foydalanish ustidan nazoratni 
taminlashi;

■ elektron raqamli imzo kaliti sertifikatini bergan ro'yxatga olish markaziga 
elektron raqamli imzoning yopiq kalitidan foydalanish rejimi buzilganligi yoki 
buzilishi ehtimoli borligi to'g'risida xabar qilishi va elektron raqamli imzo kaliti 
sertifikatining amal qilishini to'xtatib turishni yoxud mazkur sertifikatni bekor 
qilishni talab qilishi;

■ o'zi vakil bo'lgan yuridik shaxsning qayta tashkil etilishi yoki tugatilishi 
to'g'risida ro'yxatga olish markaziga xabar qilishi shart.

Elektron raqamli imzo yopiq kaliti egasining javobgarligi (11-modda). 
Elektron raqamli imzo yopiq kalitining egasi ushbu Qonun 10-moddasining ikkinchi 
qismida korsatilgan majburiyatlami bajarmaganligi oqibatida elektron raqamli 
imzoning yopiq kalitidan ruxsatsiz tarzda fovdalanilishi tufayli yetkazilgan zarar 
uchun tegishli elektron raqamli imzo ochiq kalitining fovdalanuvchisi oldida javobgar 
bo'ladi.

Elektron raqamli imzo ochiq kalitining foydalanuvchisi (12-modda). 
Elektron raqamli imzoning haqiqiyligini tasdiqlash uchun elektron raqamli imzoning 
ochiq kalitidan foydalanavotgan yuridik yoki jismoniy shaxs elektron raqamli imzo 
ochiq kalitining foydalanuvchisi bo'lishi mumkin. Elektron raqamli imzo ochiq 
kalitining foydalanuvchisi elektron raqamli imzoning ochiq kaliti elektron raqamli 
imzo yopiq kalitining egasiga tegishliligini va elektron raqamli imzoning 
haqiqiyligini tekshirish uchun elektron raqamli imzo kalitining sertifikatini bergan 
ro'yxatga olish markaziga murojaat etishga shuningdek elektron raqamli imzoning 
haqiqiyligi tasdiqlanmagan hollar haqida elektron raqamli imzo yopiq kalitining 
egasiga xabar qilishga haqli. Elektron raqamli imzo ochiq kalitining foydalanuvchisi 
elektron raqamli imzo yopiq kaliti egasining shaxsi to'g'risidagi ma lumotlar 
muhofaza qilinishini ta minlashi kerak.

Elektron raqamli imzo kalitining sertifikati (13-modda). Elektron raqamli 
imzo kalitining sertifikati elektron raqamli imzoning ochiq kaliti elektron raqamli 
imzoning yopiq kalitiga mosligini tasdiqlaydigan va elektron raqamli imzo yopiq 
kalitining egasiga ro'yxatga olish markazi tomonidan berilgan hujjatdan iborat 
bo'ladi. Elektron raqamli imzo kalitining sertifikati elektron hujjat shaklida va qog'oz
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hujjat shaklida tayyorlanishi mumkin. Elektron raqamli imzo kalitining sertifikatida 
quyidagilar ko'rsatilishi kerak:

■ elektron raqamli imzo yopiq kalitining egasi boMgan jismoniy shaxsning 
familiyasi, ismi, otasining ismi;
■ agar elektron raqamli imzo yopiq kalitining egasi yuridik shaxsning vakili 

bo'Isa shu yuridik shaxsning nomi;
■ uning tartib raqami va amal qilish muddati;
■ elektron raqamli imzoning ochiq kaliti;
■ elektron raqamli imzoning ochiq kalitidan foydalanishda yordam berishi 

mumkin bo‘lgan elektron raqamli imzo vositalarining nomi;
■ mazkur sertifikatni bergan ro'yxatga olish markazining nomi va joylashgan 

manzili;
■ elektron raqamli imzodan foydalanish maqsadlari to‘g'risidagi ma’lumotlar;
■ elektron raqamli imzo kalitlari sertifikatlari reestrining elektron manzili. 

Elektron raqamli imzo yopiq kalitining egasi tashabbusi bilan elektron raqamli imzo 
kaliti sertifikatiga boshqa malumotlar ham kiritilishi mumkin.

Elektron raqamli imzo kalitining sertifikatini berish (14-modda). Elektron 
raqamli imzo kalitining sertifikati ro'yxatga olish markazi tomonidan beriladi. 
Elektron hujjat shaklidagi elektron raqamli imzo kalitining sertifikati berilayotganda 
u ro'yxatga olish markazi vakolatli shaxsining elektron raqamli imzosi bilan 
tasdiqlanadi. Qog‘oz hujjat shaklidagi elektron raqamli imzo kalitining sertifikati ikki 
nusxada rasmiylashtiriladi. Bunday sertifikatning har bir nusxasi ro‘vxatga olish 
markazining vakolatli shaxsi tomonidan imzolanishi va ro'yxatga olish markazining 
muhri bilan tasdiqlanishi kerak. Elektron raqamli imzo kaliti sertifikatining bir 
nusxasi elektron raqamli imzo yopiq kalitining egasiga beriladi, boshqa nusxasi esa 
ro'yxatga olish markazida saqlanadi. Elektron hujjatlar shaklidagi elektron raqamli 
imzolar kaliflari sertifikatlarining ko‘chirma nusxalarini behshga doir xizmatlar 
ro‘yxatga olish markazi tomonidan bepul ko‘rsatiladi.

Elektron raqamli imzo kaliti sertifikatining amal qilishini to‘xtatib turish 
(15-modda). Elektron raqamli imzo kaliti sertifikatining amal qilishi elektron raqamli 
imzo yopiq kaliti egasining arizasi asosida arizada ko‘rsatilgan muddatga, lekin 
mazkur sertifikatning amal qilish muhlatidan ko‘p bo‘lmagan muddatga ro'yxatga 
olish markazi tomonidan to‘xtatib turilishi mumkin. Elektron raqamli imzo yopiq 
kaliti egasining elektron raqamli imzo kaliti sertifikatining amal qilishini to‘xtatib 
turish to‘g'risidagi arizasi tushganda ro'yxatga olish markazi elektron raqamli 
imzolar kalitlari sertifikatlarining reestriga tegishli vozuv kiritadi va ayni bir vaqtning 
o‘zida bu haqda elektron raqamli imzo yopiq kalitining egasini xabardor qiladi. 
Elektron raqamli imzo kaliti sertifikatining amal qilishi to‘xtatib turilgan muddat 
ichida ro'yxatga olish markazi elektron raqamli imzo yopiq kaliti egasining arizasiga 
binoan mazkur sertifikatning amal qilishini qayta tiklashi mumkin.

Elektron raqamli imzo kalitining sertifikatini bekor qilish (16-modda). 
Elektron raqamli imzo kalitining sertifikati elektron raqamli imzo yopiq kaliti 
egasining arizasi asosida ro‘yxatga olish markazi tomonidan bekor qilinishi mumkin. 
Ro‘vxatga olish markazi, elektron raqamli imzo yopiq kaliti egasining roziligidan
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qat’iy nazar, quyidagi hollarda elektron raqamli imzo kalitining sertifikatini bekor 
qilishi shart, agar:

■ mazkur sertifikatning amal qilish muddati tugagan bo‘lsa;
■ elektron raqamli imzo kalitining sertifikati benlishiga asos bo'lgan hujjatning 

amal qilishi tugatilganligi aniq m alum bo'lsa;
■ elektron raqamli imzo yopiq kalitining egasi ushbu Qonun 10-moddasining 

ikkinchi qismida nazarda tutilgan o'z majburiyatlarini bajarmagan hollar aniqlangan 
bo'lsa Elektron raqamli imzo kaliti sertifikatining amal qilishini to'xtatib turish 
muddati tugagan va elektron raqamli imzo yopiq kaliti egasining uni qayta tiklash 
haqida arizasi bo'lmagan taqdirda ham elektron raqamli imzo kalitining sertifikati 
bekor qilinishi kerak. Elektron raqamli imzo kalitining sertifikatini bekor qilish 
elektron raqamli imzo yopiq kaliti egasining arizasi olingan yoki ushbu moddaning 
ikkinchi va uchinchi qismlarida bayon qilingan holatlar yuzaga kelgan kunda 
ro‘yxatga olish markazi tomonidan amalga oshiriladi.

Elektron raqamli imzo kalitining sertifikatini bekor qilish to'g'risidagi yozuv 
ro'yxatga olish markazi tomonidan elektron raqamli imzolar kalitlari 
sertifikatlarining reestriga kiritilib, bu haqda elektron raqamli imzo yopiq kalitining 
egasi xabardor qilinadi.

Elektron raqamli imzo kalitining sertifikatini ro'yxatga olish markazida 
saqlash tartibi (17-modda). Elektron hujjat shaklidagi elektron raqamli imzo 
kalitining sertifikatini ro'yxatga olish markazida saqlash tartibi hamda muddati 
ro'yxatga olish markazi va elektron raqamli imzo yopiq kalitining egasi o'rtasidagi 
shartnoma bilan belgilanadi. Elektron hujjat shaklidagi elektron raqamli imzo 
kalitining bekor qilingan sertifikati ro'yxatga olish markazida kamida uch yil 
saqlanadi. Elektron hujjat shaklidagi elektron raqamli imzo kalitining sertifikatini 
saqlash muddati tugaganidan keyin, u ro'yxatga olish markazining elektron raqamli 
imzolar kalitlari sertifikatlarining reestridan chiqariladi va arxivda saqlash rejimiga 
o‘tkaziladi. Qog‘oz hujjat shaklidagi elektron raqamli imzo kalitining sertifikati 
qonun hujjatlarida belgilangan tartibda saqlanadi. Elektron raqamli imzo kalitining 
sertifikati yo'qolgan taqdirda, ro'yxatga olish markazi elektron raqamli imzo kaliti 
sertifikatining dublikatini berishi mumkin.

Ro‘yxatga olish markazini tugatish (18-modda). Ro'yxatga olish markazi 
qonun hujjatlarida belgilangan tartibda tugatilishi mumkin. Ro'yxatga olish markazi 
tugatish to'g'risida qaror qabul qilingan paytdan e'tiboran bir ov mobavnida bu haqda 
maxsus vakolatli organga shuningdek mazkur ro'yxatga olish markazining elektron 
raqamli imzolar kalitlari sertifikatlarining reestriga kiritilgan elektron raqamli imzo 
yopiq kalitlarining barcha egalariga xabar qilishi shart. Ro'yxatga olish markazi 
tugatilgan taqdirda mazkur ro'yxatga olish markazi tomonidan berilgan elektron 
raqamli imzolar kalitlarining sertifikatlari elektron raqamli imzo yopiq kalitlari 
egalarinmg roziligi bilan boshqa ro'yxatga olish markazlariga topshirilishi mumkin. 
Boshqa ro'yxatga olish markazlariga topshirilmagan elektron raqamli imzolar 
kalitlarining sertifikatlari bekor qilinadi va maxsus vakolatli organga saqlash uchun 
topshirilib, bu haqda elektron raqamli imzolar ochiq kalitlarining foydalanuvchilari 
xabardor qilinadi.

r
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Chet davlatlarning elektron raqamli imzolar kalitlari sertifikatlaridan 
foydalanish (19-modda). Chet davlatlarning elektron raqamli imzolar kalitlari 
sertifikatlaridan foydalanish qonun hujjatlarida belgilangan tartibda amalga 
oshinladi.

Muhr o‘mida ishlatish (20-modda). Muhr bilan tasdiqlangan va elektron 
hujjatga aylantirilgan qog'oz hujjatning mazmuni qonun hujjatlarigayoki taraflaming 
kelishuviga muvofiq ro‘yxatga olish markazi vakolatli shaxsining elektron raqamli 
imzosi bilan yoki elektron raqamli imzo yopiq kaliti egasining elektron raqamli 
imzosi bilan tasdiqlanishi mumkin.

Test savollari
1. Elektron raqamli imzo nima?
A) elektron hujjatdagi mazkur elektron hujjat 
axborotini elektron raqamli imzoning vopiq 
kalitidan foydalangan holda maxsus o‘zgartirish 
natijasida hosil qilingan hamda elektron raqamli 
imzoning ochiq kaliti yordamida elektron hujjatdagi 
axborotda xatolik yo‘qligini aniqlash va elektron 
raqamli imzo yopiq kalitining egasini 
identifikatsiya qilish imkoniyatini beradigan imzo 
(qonun).
B) bu tijorat aloqalarining bir turi bo'Iib, sotuvchi 
va xaridor o‘i1asidagi shartnomalar hamda 
xizmatlar Interer* orqali amalga oshiriladi.
C) savdo-sotiq taoliyatini ish faoliyati bilan birga 
parallel ravishdaIborishi;
D) ko‘p sonli xaridorlaming bir vaqtning o'zida 
murojaat qila olishi.

2. 0 ‘zbekiston Respublikasining Elektron 
raqam li imzo to‘g‘risida Qonuni (N 562-11) 
qacbon qabul qilingan?
A) 2003 yil 11 dekabrda;
B) 2013 yil 11 dekabrda;
C) 1992 yil 11 dekabrda;
D) 1993 yil 11 dekabrda;

3. Elektron raqamli imzoning yopiq kaliti nima?
A) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, faqat imzo qo‘yuvchi 
shaxsning o‘ziga ma’lum bo'lgan va elektron 
hujjatda elektron raqamli imzoni yaratish uchun 
mo‘ljallangan belgilar ketma-ketligi;
B) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, elektron raqamli imzoning 
yopiq kalitiga mos keluvchi, axborot tizimining har 
qanday fovdalanuvchisi foydaiana oladigan va 
elektron hujjatdagi elektron raqamli imzoning 
haqiqiyligini tasdiqlash uchun mu'ljallangan 
belgilar ketma-ketligi;
C) elektron hujjatdagi mazkur elektron hujjat 
axborotini elektron raqamli imzoning yopiq 
kalitidan foydalangan holda maxsus o‘zgartinsh 
natijasida hosil qilingan hamda elektron raqamli

C) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan. elektron raqamli imzoning 
yopiq kalitiga mos keluvchi, axborot tizimining har 
qanday foydalanuvchisi foydaiana oladigan va 
elektron hujjatdagi elektron raqamli imzoning 
haqiqiyligini tasdiqlash uchun moMjallangau 
belgilar kelma-ketligi;
D) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, faqat imzo qo‘vuvchj 
shaxsning o‘ziga ma’lum boMgan va elektron 
hujjatda elektron raqamli imzoni yaratish uchun 
mo‘ljallangan belgilar ketma-ketligi;

7. Elektron raqamli imzo vositalari nima?
A) Elektron raqamli imzo vositalari elektron 
hujjatda elektron raqamli imzo yaratilishinii, 
elektron raqamli imzoning haqiqiyligi 
tasdiqlanishini, elektron raqamli imzoning yopiq va 
ochiq kalitlari yaratilishini ta’minilaydigan barcha 
texnikaviv va dasturiy vositalardan iborat boladi.
B) elektron shaklda qayd etilgan, elektron raqamli 
imzo bilan tasdiqlangan hamda elektron hujjatning 
uni identifikatsiya qilish imkonini beradigan boshqa 
rekvizitlariga ega bo'lgan axborot.
C) elektron raqamli imzoning elektron raqamli 
invzo yopiq kalitining egasiga tegishliligi va 
elektron hujjatdagi axborotda xatolik yo‘qligi 
tekshirilgandagi ijobiy natija;
D> elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, elektron raqamli imzoning 
yopiq kalitiga mos keluvchi, axborot tizimining har 
qanday foydalanuvchisi foydaiana oladigan va 
elektron hujjatdagi elektron raqamli imzoning 
haqiqiyligini tasdiqlash uchun mo‘ljallangan 
belgilar ketma-ketligi;

8. Elektron raqamli imzoning yopiq kaUti egasi 
nima?
A) elektron raqamli imzoni yaratgan (elektroa 
hujjatga imzo qo'ygan) va ro‘yxatga olish markazi 
tomonidan uning nomiga elektron raqamli imzo 
kaliti sertilikati berilgan jismoniy shaxs elektron 
raqamli imzo yopiq kalitining egasi bo‘ladi.
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imzoning ochiq kaliti yordamida elektron hiijjatdagi 
axborotda xatolik vo‘qligini aniqlash va elektron 
raqamli imzo yopiq kalitining egasini 
identifikatsiya qilish imkoniyatini beradigan imzo. 
p) bu tijorat aloqalarining bir turi boiib, sotuvchi 
va xaridor o'rtasidagi shartnomalar hamda 
xizmatlar Interent orqali amalga oshiriladi.

4. Elektron raqamli imzoning ochiq kaliti nima?
A) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, elektron raqamli imzoning 
yopiq kalitiga mos keluvclu, axborot tizimining har 
qandav t'oydalanuvchisi foydalana oladigan va 
elektron hujjatdagi elektron raqamli imzoning 
haqiqiyligini tasdiqlash uchun mo‘ljallangan 
belgilar ketma-ketligi:
B) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, faqat imzo qo‘yuvchi 
shaxsning o'ziga ma’lum boigan va elektron 
hujjatda elektron raqamli imzoni yaratish uchun 
moijallangan belgilar ketma-ketligi;
C) elektron hujjatdagi mazkur elektron hujjat 
axborotini elektron raqamli imzoning yopiq 
kalitidan foydalangan holda maxsus o‘zgartirish 
natijasida hosil qilingan hamda elektron raqamli 
imzoning ochiq kaliti yordamida elektron hujjatdagi 
axborotda xatolik vo‘qligini aniqlash va elektron 
raqamli imzo yopiq kalitining egasini 
identifikatsiya qilish imkoniyatini beradigan imzo.
D) bu tijorat aloqalarining bir turi boiib, sotuvchi 
va xaridor o'rtasidagi shartnomalar hamda 
xizmatlar Interent orqali amalga oshiriladi.

5. Elektron raqam li imzoning haqiqiyligini 
tasdiqlash nima?
A) elektron raqamli imzoning elektron raqamli 
imzo yopiq kalitining egasiga tegishliligi va 
elektron hujjatdagi axborotda xatolik vo'qligi 
tekshirilgandagi ijobiv natija;
B) elektron shaklda qayd etilgan, elektron raqamli 
imzo bilan tasdiqlangan hamda elektron hujjatning 
uni identifikatsiva qilish imkonini beradigan boshqa 
rekvizitlariga ega boigan axborot.
C) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, elektron raqamli imzoning 
yopiq kalitiga mos keluvchi, axborot tizimining har 
qandav t’oydalanuvchisi foydalana oladigan va 
elektron hujjatdagi elektron raqamli imzoning 
haqiqiyligini tasdiqlash uchun moijallangan 
belgilar ketma-ketligi;
D) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, faqat imzo qo'yuvchi 
shaxsning o‘ziga ma’lum boigan va elektron 
hujjatda elektron raqamli imzoni yaratish uchun 
mo‘ljallangan belgilar ketma-ketligi;

B) elektron shaklda qayd etilgan, elektron raqamli 
imzo bilan tasdiqlangan hamda elektron hujjatning 
uni identifikatsiya qilish imkonini beradigan boshqa 
rekvizitlariga ega bo‘lgan axborot.
C) elektron raqamli imzoning elektron raqamli 
imzo yopiq kalitining egasiga tegishliligi va 
elektron hujjatdagi axborotda xatolik yo‘qligi 
tekshirilgandagi ijobiv natija;
D) elektron raqamli imzo vositalaridan foydalangan 
holda hosil qilingan, elektron raqamli imzoning 
yopiq kalitiga mos keluvclu, axborot tizimining har 
qanday t'oydalanuvchisi foydalana oladigan va 
elektron hujjatdagi elektron raqamli imzoning 
haqiqiyligini tasdiqlash uchun moijallangan 
belgilar ketma-ketligi;

9. Elektron raqamli imzo kalitining sertifikati
(13-modda) nima?
A) elektron raqamli imzo kalitining sertifikati 
elektron raqamli imzoning ochiq kaliti elektron 
raqamli imzoning yopiq kalitiga mosligini 
tasdiqlaydigan va elektron raqamli imzo yopiq 
kalitining egasiga ro‘yxatga olish markazi 
tomonidan berilgan hujjatdan iborat boiadi.
B) elektron raqamli imzoni yaratgan (elektron 
hujjatga imzo qo‘ygan) va ro'yxatga olish markazi 
tomonidan uning nomiga elektron raqamli imzo 
kaliti sertifikati berilgan jismoniy shaxs elektron 
raqamli imzo yopiq kalitining egasi boiadi.
C) elektron shaklda qayd etilgan. elektron raqamli 
imzo bilan tasdiqlangan hamda elektron hujjatning 
uni identifikatsiya qilish imkonini beradigan boshqa 
rekvizitlariga ega boigan axborot.
D) elektron raqamli imzoning elektron raqamli 
imzo yopiq kalitining egasiga tegishliligi va 
elektron hujjatdagi axborotda xatolik yo‘qligi 
tekshirilgandagi ijobiy natija;

10. Elektron raqamli imzo kalitining sertifikatini 
bekor qilish (16-modda) nima?
A) elektron raqamli imzo kalitining sertifikati 
elektron raqamli imzo yopiq kaliti egasining arizasi 
asosida ro‘yxatga olish markazi tomonidan bekor 
qilinishi mumkin.
B) elektron raqamli imzo kalitining sertifikati 
elektron raqamli imzoning ochiq kaliti elektron 
raqamli imzoning yopiq kalitiga mosligini 
tasdiqlaydigan va elektron raqamli imzo yopiq 
kalitining egasiga ro‘vxatga olish markazi 
tomonidan berilgan hujjatdan iborat boiadi.
C) elektron raqamli imzoni yaratgan (elektron 
hujjatga imzo qo‘ygan) va ro‘yxatga olish markazi 
tomonidan uning nomiga elektron raqamli imzo 
kaliti sertifikati berilgan jismoniy shaxs elektron 
raqamli imzo yopiq kalitining egasi boiadi.
D) elektron shaklda qayd etilgan. elektron raqamli 
imzo bilan tasdiqlangan hamda elektron hujjatning
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6. Elektron hujjat nima?
A) elektron shaklda qayd etilgan. elektron raqamli 
imzo bilan tasdiqlangan hamda elektron hujjatning 
uni identifikatsiya qilish imkonini beradigan boshqa 
rekvizitlanga ega bo‘lgan axborot.
B) elektron raqamli imzoning elektron raqamli 
imzo yopiq kalitining egasiga tegishliligi va 
elektron hujjatdagi axborotda xatolik yo‘qligi 
tekshirilgandagi ijobiy natija;

uni identifikatsiya qilish imkonini beradigan boshqa 
rekvizitlanga ega bo‘lgan axborot.
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1-ilova HTML tilida qoshimcha teglaming ro'vxati
Teglar Vasifasi I/oh

<a> </a> Murojaat
<abbr> </abbr> Abbreviatura
<address> </address> Manzil, muallif haqidagi m a’lumotlar berishda 

ishlatiladi.
<acronym> </acronvm> Akronim
<applet> </applet> Java dasturi imkoniyatlarini qo‘llaydi.
<area> Rasmning qism xaritasi
<article> </article> Sahifaning asosiy kontenti HTML5 tegi
<aside> </aside> Saytning yon paneli deb ataladi. HI M l.5 tegi
<audio> </audio> Audiofayl ovozini chiqarish va ulami boshqarish 

uchun panel tashkil qiladi
HTML5 tegi

<b> </b> Qalin shrift (Ж)
<base> Sahifaning bazaviy manzili
<basefont> Butun sahifa uchun matnni formatlaydi
<bdi> </bdi> M atnvo‘nalishini o'zgartirishni ta'qiqlaydi HI’ML 5 tegi
<bdo> </bdo> Matn vo‘nalishini boshqaradi
<bgsound> Sahifa ochiiishida musiqa yangrashini ta minlaydi Nostandart teg
<big> </big> Bir o ‘lchamga shrift o ‘lchamini kattalashtiradi
<blink> </blink> Yuqolib paydo bo‘lishni ta’minlovchi teg Nostandart teg
<body> </body> HTML hujjat tanasi
<br> Keyingi satoga o ‘tkazish
<button> </button> Kengaytirilgan tugmani anglatuvchi forma 

elementi
<canvas> </canvas> Flash texnologiyalami almashtirish tegi HTML5 tegi
<caption> </caption> Jadval sarlavhasi
<center> </center> Elementlami markaz bo‘yicha tekislash
<cite> </cite> Asar, ashula, rasm, roman, ... nomini kirituvchi 

teg
<code> </code> Dastur kodi
<col> Jadvalnmg bir (bir necha) ustunini formatlaydi
<command> 0 ‘chirib yoqish buyrug‘i HTML5 tegi
<comment> </comment> Kommentariya berish Nostandart teg
<datalist> </datalist> Paydo boTuvchi ro‘yxatni tashkil etuvchi teg HTML5 tegi
<dd> </dd> Terminni izohlash
<del> </del> Eski (o‘chirilgan) matn
<details> </details> Spoyler HTML5 tegi
<dfn> </dfn> Matnda birinchi uchraydigan termin
<dialog> </dialog> Dialoglar HTML5 tegi
<dir> </dir> Papkalar nryxati
<div> </div> Blokli element
<dl> </dl> Izohlar va terminlar ro‘yxati
<dt> </dt> Termin
<i> <f\> Kursivli shrift
<em> </em> Kursivli shrift
<embed> Plaginlami qo41ashni ta’minlovchi teg HTML5 tegi
<fieldset> </fieldset> Forma elementlarini guruhlaydi
<font> </font> Matnni formatlaydi
<footer> </footer> Sayt asosi HfM L5 tegi
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"<form> </form> Forma
~<frame> </frame> Freym
"<frameset> </frameset> Frevmlar tuzulishi
"<h*> </h*> h i dan h6 pacha bo'lgan sarlavhalar berish teglari
~<head> </head> HTML hujjat bosh qismi
"<headcr> </header> Savt shapkasi HTML5 tegi
”<hgroup> </hgroup> Sarlavhalami guruhlaydi HTML5 tegi
<hr> Gorizontal chiziq
<html> </html> HTML hujjat

"<iframe> </iframe> Suzuvchi freym
<img> Rasm qo‘yish tegi
<input> Forma elementi bo'lib, undan tugma, matn 

maydoni, o'chirib voqgich sifatida foydalanish 
mumkin

<ins> </ins> Yangi (qo‘shilgan) matn
<isindex> Qidirish satri
<kbd> </kbd> Tez qoilovchi tugmalar
<keygen> Ma’lumotlami shifrlash va rasshifrovka qilish HTML5 tegi
<label> </label> Forma elementi. Forma elementi bilan aloqa 

o ‘matadi
<legend> </legend> Forma elementi. Fieldset tegi sarlavhasi
<li> </Ii> R o‘yxat elementi. ul va ol teglari orasida 

joylashadi.
<link> .css, .xml, ico tashqi fayllami yuklaydi
<listing> <flisting> Dastur kodi
<map> </map> Tasvir kartasi
<raark> </mark> Belgilangan matn HTML5 tegi
<marquee> </marquee> Harakatlanuvchi satr Nostandart teg
<menu> </menu> Command teglarini hoshiyasini olish HTML5 tegi
<meta> meta-teg
<meter> </meter> 0 ‘lchash shkalasi HTML5 tegi
<multicol> </multicol> Ko‘p kolonkali matn Nostandart teg
<nav> </nav> Sahifaning muhim murojaatlari ITTML 5 tegi
<noembed> </noembed> Plaginni qo‘llovchi brauzerlar boimuganda 

mantni chiqarish
Nostandart teg

<noframes> </noframes> Freym qo‘llovchi brauzerlar boTmaganda mantni 
chiqarish

<noscript> </noscript> Skriptlami qo‘llovchi brauzerlar bo‘lmaganda 
mantni chiqarish

<object> </object> Plaginlanu qo’llavdi
<ol> </ol> Tartibli ro'yxat
<OptgTOUp> </optRTOUp> Option teglarini guruhlaydi
<option> </option> select, optgroup, datalist teglari orasida 

joylashgan ro‘yxat elementini tanlash imkonini 
beradi

<output> </output> Script ishini chiqarish HTML5 tegi
<p> </p> Hoshiya
<param> Applet va object plaginlar parametn
<pre> </pre> Oldindan formatlangan matn
<progress> </progress> O'sish shkalasi
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<q> </q> Sitata
---------------------------

<rp> </ф> Annotasiya qismi, ruby tegi almashtiradi. HTML 5 tegi
<rt> </rt> Annotatsiya HTML 5 tegi ■
<rubv> </ruby> Annotatsiya hoshiyasini olish I CTML5 tegi "
<s></s> Ustidan chizilgan matn

. - .........

<samp> </samp> Dastur chiqarish kodi
<script> </script> Skript
<select> </select> Option teglarini guruhlaydi '
<small> </small> Shrift oicham ini bir birlikka kichraytiradi
<source> audio/video fayllarni qo‘llaydi HI ML5 tegi
<spacer> </spacer> B o‘sh soha Nostandart top '
<span> </span> Tezkor element . . . . .

<strike> </strike> Ustidan chizilgan matn -

<strong> </strong> Qalin shrift
<style> </style> Sahifaga CSS-kodlami qo'llavdi
<sub> </sub> Quyiindeks *
<summary> </summary> Details tegi sarlavhasi HT ML5 tegi
<sup> </sup> Yuqori indeks, daraja """ 1

<table> </Cable> Jadval
<tbody> <Abody> Jadval tanasi
<textarea> <Aextaiea> Forma elementi, ko'p satrli kiritish maydom
<tfoot> <Afoot> Jadval asosj
<th> <Ah> Sarlavhali jadval katakchasi
<thead> <Ahead> Jadval bosh qismi
<time> <Aime> Sana va/yoki vaqt HTML5 tegi
<title> <AitIe> Sahifa nomi
<tr> </tr> Jadval satri
<tt> <At> Monoshirli shrift
<track> Audio va video teglari yordamida audio va video 

favllarga qo'shadi. M atnlim a’lumotlami 
qo‘llaydi.

HTML5 tegi

<var> </var> Dasturlash tillari o ‘zgaruvchilari
<video> </video> Boshqarish panelini yaratish orqali videofayllami 

qo'llaydi
HTML5 tegi

<wbr> Brauzer oynasiga sig magan uzun so‘zni qaverga 
joylashtirishm ko‘rsatadi

HTML5 tegi

<xmp> </xmp> Oldindan formatlangan matn
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GLOSSARIY
Atamaning o'zbek Atamaning ingliz At» ma rung ms Atamaga izoh
tilida nomlanishi tilida nomlanishi tilida nomlanishi

autentifikatsiya ingl.: authentication rus.:
аутентификации

Ob’yektning e'lon qilingan bir 
xilligini tekshirish jarayoni.

avtomatik tizim ingl.: automated 
system

rus.:
автоматическая
система

Inson ishtirokisiz mustaqil faoliyat 
qiluvchi dasturiy va apparatli 
vositalar tizimi.

avlomatlashtirilgan 
boshqaruv tizimi 
(ABT)

ingl.: automatized 
management system

rus.:
автоматизиро ва н 
ная система 
управления

Matematik uslublar, texnik 
vositalar (kompyuterlar, aloqa 
vositalari, malumotlarni chiqarish 
qurilmalari va h.k.) va tashkiliy 
majmualar to‘plami. U belgilab 
olingan maqsadga muvofiq 
murakkab obyekt (jarayon)ni 
boshqarishm ta’minlavdi.

avlomatlashtirilgan
tizim

ingl.: automatized 
system

rus.:
автоматизирован 
ная система

Inson faoliyati jarayonini 
avtomatlashtirishga qaratilgan 
dasturiy va apparatli vositalar 
tizimi.

avlomatlashtirilgan 
tizim resursining 
xavfsizligi

ingl.: security of 
automated system’s 
resources

rus.: безопасность 
ресурса
автоматизирован
ной
системы

Maxfiylik, butunlik va 
kirishimlilik kabi uch tavsifni 
ta’minlashdan iborat. Tizim 
tarkibiy qismining maxfiyligi 
shundaki, unga faqat tegishli 
vakolatlarga ega boTgun 
sub’yektlar kira oladi.

axborot tizimi ingl.: information 
system

rus.:
информационная
система

Axborotni to‘plash, saqlash, 
izlash, unga ishlov berish hamda 
ulardan foydalanish imkonini 
beradigan, tashkihy jihatdan 
tartibga solingan jami axborot 
resurslari, axborot texnologiyalari 
va aloqa vositalari. (qonun)

axborot tizimlarini 
klonlash

ingl.: cloning o f  
information systems

rus.:
клонирование
информационных
систем

Replikant-dasturlar asosida yangi 
axborot tizimlarini qurish. 
Tizimlar axborot ifodalashning 
yagona standartlariga mos 
keladigan. kesishib o ‘tadigan 
ma lumotlar bazasiga. umumiy 
axtaruvchi tizimga. o ‘xshash 
interfevslarga ega boiadi

axborot xavfsizligi ingl.: Information 
security

rus.:
информационная
безопасность

Axborotning uning egasiga zarar 
keltiradigan tasodifan yoki 
qasddan qilingan tahdidlarga 
(xavf-xatarlarga) chidamliligining 
umumlashgan xossasi.

axborot xavfsizligi 
ko‘rsatgichi

ingl.: criteria o f  
information security

rus.: критерий 
безопасности 
информации

Turli xavf-xatar faktorlari ta' siriga 
nisbatan axborot xavfsizligini 
tavsiflovchi ko‘rsatkich.
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axborot xavfsizligi 
obyekti

ingl.: information 
security object

rus.: объект 
информационной

Axborot sohasida amalga ' 
oshiriladigan axborot xavfsizligi 
subyektlarining huquq va 
erkinliklari; axborot resurslari; 
axborot infratuzilmasi.

axborot xavfsizligi 
siyosati

ingl.: information 
security policy

rus.: политика
информационной
безопасности

Muhofaza qilinayotgan axborotga~ 
ishlov berishning huquqiy 
jihatlarini tartibga soluvchi jami 
qabul qilingan tashkiliy choralar

axborot xavfsizligi 
subyekti

ingl.: information 
security subject

rus.: субъект
информационной
безопасности

Axborot xavfsizligi subyektlangjT~ 
davlat organlari ko'rinishidagi 
davlat, yuridik shaxslar, jismoniy 
shaxslar kiradi.

axborot
xavfsizligini
ta’minlash

ingl.: information 
security assuranoe

rus.: обеспечение
безопасности
информации

Foydalanuvchining axboroti 
muhofazasiga qo‘yilgan me’yor va 
talablami bajarish.

axborot
xavfsizligining
maqsadi

ingl.: purpose of
information
protection

rus.: цель защиты 
информации

Axborot muhofazalashdan istalgan 
natija. Axborotni muhofazalash
dan maqsad, axborot mulkdori, 
egasi va foydalanuvchisi axborotni 
mumkin bo‘lgan sizib chiqishi va 
(yoki) axborotga nisbatan 
ruxsatsiz va qasddan qilingan 
harakatlar oqibatida zarar 
ko‘ri shining oldini olishdir

elektron tijorat ingl.: electronic 
commerce, e- 
commerce

rus.: электронная 
коммерция

Axborot texnologiyalari 
yordamida amalga oshiriladigan 
tovarlami sotish, ishlami bajarish 
va xizmatlar ko‘rsatish bo‘vicha 
tadbirkorlik faoliyati.

elektron to‘lov 
E

ingl.: electronic 
payment

rus.: электронный 
платеж

Xaridlarga elektron vositalar 
yordamida haq to‘lash. Uy banki, 
tovarlar uchun elektron 
do'konlarda haq to lash va shu 
kabi tizimlar eng ko‘p tarqalgan.

elektron to‘lov 
hujjatini qayta 
ishlash

ingl.: processing o f  
the electronic 
payment document

rus.: обработка 
электронного 
платежного 
документа

To'lov hujjati bilan bajariladigan 
barcha vig'ish, kiritish, yozish, 
o'zgartirish, o ‘qib olish, saqlash, 
yo‘q qilish, elektron to‘lov 
hujjatini ro'yxatga olish kabi 
amallammg majmuasi.

elektron to‘lovlar 
tizimi

ingl.: electronic 
payments system

rus.: система
электронных
платежей

Mahsulotlarga to'lovlarni 
kompyuter va magnit kartalari 
yordamida amalga oshiruvchi 
apparath va dasturiy vositalar 
majmui.

filtrlash ingl.: filtering rus.: фильтрация Signallami yoki ma’lumotlami 
umumiy oqimidan kerakli 
mezonlarga ega bo'lganlarmi 
ajratib qo'yish jarayoni. Filtrlash 
filtr yordamida amalga oshiriladi.
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gjpermatn ingl.: hypertext rus.: гипертекст Matnni kompyuterda ifodalash 
shakli. Unda ajratilgan 
tushunchalar, obyektlar va 
boTimlar orasidagi ma’noli 
bogianishlar avtomatik tarzda 
qo ‘ llab-quwatlanadigan.

gipermatnli 
markerlash tili

ingl.: HyperText 
Markup Language 
(HTML)

rus.:
гипертекстовый 
язык разметки

Markerlash tili. Intemetning 
global ulanish xizmatida 
hujjatlami yozma shaklini 
belgilaydi. HTML tili, matn 
muharriri yordamida tayyorlangan 
matnga kiritiladigan buyruqlar 
majmuasidan iborat bo Tib, veb- 
sahifalami GIF yaratishda 
ishlatiladi.

grafik axborot ingl.: graphical 
information

rus.: графическая 
информация

Sxemalar, eskizlar, tasvirlar, 
grafiklar, diagrammalar, ramzlar 
ko‘rinishida ifodalangan 
maTumotlar yoki xabarlar.

grafik fayl ingl.: graphic file rus.: графический 
файч

Nuqtama-nuqta kodlangan tasvimi 
o‘z ichiga olgan fayl. Bundan 
tashqari, grafik faylga dasturlarda 
va qurilmalarda ishlatiladigan 
boshqaruvchi kodlar ham kiradi.

grafik interfeys ingl.: graphic 
interface

rus.: графический 
интерфейс

Foydalanuvchini hisoblash tizimi 
bilan o ‘zaro aloqasini tashkil 
qiladigan grafik muhit.

grafik muharrir ingl.: graphic editor rus.: графический 
редактор

Tasvirlami tahrirlashni 
ta minlaydigan amaliy dastur.

grafika ingl.: graphics rus.: графика Predmetlarni rang ishlatmasdan, 
kontur chiziqlar va shtrixlar 
vositasida aks ettirish san ati. Shu 
sababli, dastlab oq -  qora 
chizmalami va sxemalami 
tayyorlash jarayoni kompyuter 
grafikasi deb nomlangan edi.

grafikani
maqbullash

ingl.: graphics 
optimization

rus.: оптимизация 
графики

Tasvir fayllari oTchamlanni, 
ularni maqbul sifatini saqlagan 
holda, mumkin qadar 
kichraytirish. Veb-sahifa 
yaratishda, uning sahifalarini 
yuklanish tezligini oshirish 
maqsadida ishlatiladi.

HTML atributi ingl.: HTML 
attribute

rus.: атрибут 
HTML

Belgilanayotgan elementga 
qo‘shimcha
xususiyatlami belgilash uchun 
HTML tegida qo‘llaniluvchi 
qiymat.

Internet ingl.: Internet rus.: Интернет Butun jahon global tarmog‘i. U  
davlat. ta’lim, tijorat. harbiy va
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korporativ tarmoqlami birlashtirib~ 
IP (Inter-network Protocol) 
ma’Iumotlami uzatish 
bayonnomasiga asoslangan.

Internet serveri ingl.: Internet server rus.: Интернет- 
сервер

Xohlagan kerakli Internet 
xizmatlar faoliyatmi ta'minlovchi 
texnikaviy va dasturiy vositalar: 
http (sayt), Email (elektron 
pochtasi), anjumanlar, ftp va h.k.

Internet-2 ingl.: Intemet-2 rus.: Интернет-2 Yangi Internet infratuzilmasini 
yaratish loyihasi. Yangi IPv6 
bayonnomasiga asoslangan bo1 lib, 
allaqachon 150 dan ko‘p 
universitetni birlashtirgan. Yuqori 
samaradorlik, ishonchhlik va 
ma’lumotlami uzatish tezligiga 
ega (soniyasiga 2,4 Gigabit).

Intemetda muloqot ingl.:
communication in 
Internet

rus.: общение в 
Интернете

Internet -  bu nafaqat ommaviy 
axborot vositasi va butundunyo 
ma’lumotnomasi, balki muloqot 
muhiti hamdir. Intemetning, 
muloqot joylarini -  chatlar. 
forumlar, mehmon kitoblari, 
tarqatish ro‘yxatlari.

Intemetdagi
manzil

ingl.: Internet 
address

rus.: адрес в 
Интернете

Sahifa. Fayl yoki boshqa 
resursning Intemetda joylashishini 
aniqlovchi noyob manzil. 
Intemetdagi manzil odatda to‘rtta 
elementdan iborat. resursdan erkin 
foydalanish bayonnomasi. URL 
(Uniform Resource Locator) 
manzili deb ham ataladi.

Intemetga ruhiy 
og‘ish

ingl.: Internet 
addiction

rus.: Интернет- 
аддикция

Intemetga ruhiy bog‘liq 
bo‘lishning haqiqatan mavjud 
bo'lgan hodisasi (Uni kasallik deb 
hisoblash uchun ayni paytda klinik 
ma’lumotlar vetarli emas). 
Intemetga bog‘liqlik ko'nmshlan 
orqasida, shuningdek, boshqa 
ruhiv og‘ishlar ham yashiringan 
bo'lishi mumkin.

Intemetga ulanish ingl.: Internet 
connection

rus.: подключение 
к Интернет

Ajratilgan aloqa kanali (optik 
tolasi, yo'kiosh aloqasi, 
radiokanal, ajratilgan 
uzibulanmaydigan telefon liniyasi) 
bo‘yicha doimiy ulanish

Intemetni rostlash ingl.: Internet 
regulation

rus.:
регулирование
Интернет

Intemetni rivojlantirish va 
quwatlashga qaratilgan 
qonunchilikka oid va tashkiliy 
tadbirlar majmui.

Intemetni tartibga ingl.: sorting of rus.: Tarmoq axborot makonining ichki
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solish Internet упорядочение
Интернет

tartibga solinishi. U asosiv axborot 
bogMamalarini tartibga solish, 
guruhlarga qayta ajratish va ulami 
muayyan mavzular bo‘yicha 
birlashtirishni ko‘zlavdi.

Intemetning ichki 
tahdidlari

ingl.: internal 
Internet threats

rus.: внутренние 
угрозы Интернет

Tarmoq axborot makonining 
ahvoli va rivojlanishi uchun salbiy 
oqibatlarga ega b o iish i mumkin 
boigan  tahdidlar.

Intemetning tashqi 
tahdidlari

ingl.: external 
Internet threats

rus.: внешние 
угрозы Интернет

Foydalanuvchilar uchun salbiy 
oqibatlarga ega boTishi mumkin 
bo‘lgan tahdidlar. Tashqi tahdidlar 
texnologik va ijtimoiy bo'lishi 
mumkin.

intranet ingl.: intranet rus.: интранет Internet standartlari, 
texnologiyalari va dasturli 
ta minotidan foydalanu\rchi 
tashkilot yoki korxonaning 
mahalliy hisoblash tarmog‘i

IP bayonnomalari ingl.: IP protocol rus.: протокол IP Xalqaro Internet kompyuter 
tarmog'ming asosiy 
bayonnomalari to'plami. Ular 
Intemetda birlashgan hududiy 
tarmoqlaming ham, tarmoqqa 
alohida ulangan kompyuterlaming 
ham o ‘zaro ishlash qoidalarini 
belgilaydi.

IP manzili ingl.: IP-address rus.: IP-адрес Nuqtalar bilan ajratilgan to'rtta 
sondan iborat noyob son. Har bir 
son 0-255 oralig'ida bo‘lishi 
lozim. Masalan, 212.134.145.156. 
Internet tarmog'idagi har bir 
kompyuter o ‘zining noyob 
(doimiy yoki ulanish vaqtida 
belgilanadigan) IP manziliga ega.

IP shluzi ingl.: IP gateway ms.: шлюз IP IP-bayonnomadan foydalanadigan 
tarmoqda signallar yoki 
ma'lumotlami tashish uchun 
yaroqli shaklga aylantiruvchi 
qurilma.

IP telefoniyasi ingl.: IP-phone ms.: IP-телефония Internet yoki boshqa IP tarmoqni 
ayni vaqtdagi xalqaro va 
shaharlararo telefon so‘zlashuvlari 
va fakslami jo ‘natishm tashkil 
etish va amalga oshirish vositasi 
sifatida qo‘llanilishim 
ta'minlovchi texnologiya. Buning 
uchun tovush raqamli shaklga 
o'tkazilib raqamli ma lumotlar 
uzatiladigan holda uzatiladi.
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ma’lumotlar ingl.: data rus.. данные Rasmiylashtirilgan, ya’ni uzatish"  
izohlash va qayta ishlash uchun 
mos shaklda taqdim etilgan 
axborot.

ma' lumotlar 
bazalarini 
boshqaruv tizimi

ingl.: DataBase 
Management 
System (DBMS)

rus.: система 
управления 
базами данных

Umumiy yoki maxsus maqsaddagT 
dasturiy va lingvistik vositalar 
majmui. U rna'lumotlarga ishlov 
berishning qabul qilingan 
texnologiyasi sharoitida 
ma’lumotlar bazalanni yaratish, 
ularni markazlashtirilgan 
boshqarish va ularni turli 
foydalanuvchilar tomonidan erkin 
foydalanishni tashkil etishni 
qollabquwatlashni amalga 
oshiradi. Eng mashhur MBBT: 
Oracle, MS SQL, SYBASE va 
boshqalar.

ma lumotlar bazasi 
(MB)

ingl.: database (DB) rus.: база данных
(БД)

Elektron hisoblash mashinalari 
yordamida qidirib topilishi va 
qayta ishlanishi mumkin bo‘lgan 
tarzda tartibga solingan 
ma’lumotlar to‘plami

ma’lumotlar bazasi 
ma'muri

ingl.: database 
administrator

rus.:
администратор 
базы данных

Tashkilot yoki muassasa 
ma’lumotlar bazasining ahvoli, 
rivojlanishi va undan 
foydalanishga javobgar inson yoki 
shaxslar guruhi.

ma'lumotlar bazasi 
muallifi

ingl.: database 
author

rus.: автор базы 
данных

Ijodiy faolivat tufayli ma’lumotlar 
bazasini yaratgan jismoniy shaxs.

ma' lumotlar
bazasidan
foydalanish

ingl.: database use rus.:
использование 
базы данных

Chop etish, aks ettirish, tarqatish 
va ulami turli xo‘jalik faoliyatiga 
kiritish (jumladan o'zgartirilgan 
shaklda ham) bo'vicha harakatlar

ma’lumotlar 
bazasini chop etish

ingl.: database 
publishing

rus.: выпуск базы 
данных

Ma‘lumotlar bazasi nusxalanni 
muallif rozihgi asosida 
cheklanmagan shaxslar doirasiga 
taqdim etish.

ma’lumotlar
bazasini
moslashtirish

ingl.: database 
adaptation

rus.: адаптация 
базы данных

Foydalanuvchining muayyan 
texnik vositalari yoki aniq 
dasturlari boshqaruvidagi 
ma’lumotlar bazasini faoliyatini 
ta’minlash maqsadida amalga 
oshiriladigan o‘zgartirishlar 
kiritish.

ma'lumotlar 
bo‘lagi

ingl.: data fragment rus.: фрагмент 
данных

Amaliy jarayonlar bir -  biriga 
tarmoq va
trasnport pog‘onalari chegarasida 
uzatayotgan maiumotlar bloklari. 
Uzatilayotgan xabarlami
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qismlarga bo‘lish oqibatida hosil 
boiadi.

ma’lumotlar
butunligi

ingl.: data integrity rus.: целостность 
данных

qarang: axborot butunligi

ma’lumotlar
elementi

ingl.: data item rus.: элемент 
данных

Axborot ob’yekti bo‘lib, o ‘z  nomi 
va u ifodalovchi qiymatlar 
(kattaliklar) majmuasi bilan 
belgilanadigan Obyekt sifatida 
jarayon, hodisa, narsa, mamlakat, 
fan sohasi va h.k. lar bo‘lishi 
mumkin.

ma’lumotlar
maydoni

ingl.: data field rus.: поле данных Axborot tashuvchisida 
ma ’ lumotlami, ma’ lumotlar 
elementlarini yozish uchun 
ajratilgan maydon.

ma’lumotlar
modeli

ingl.: data model rus.: модель 
данных

Ma lumotlami saqlash. uzatish va 
qayta ishlash sohalarida tarkibiy 
qismlar turi va ulaming aloqalari 
to‘g ‘risidagi tasavvur.

ma’lumotlar sifati ingl.: data quality rus.: качество 
данных

Ma’ lumot laming muavyan 
masalalami yechish uchun 
Varoqliligini ta'minlab beradigan 
xossalar majmui.

m a’lumotlarga 
islilov berish 
tizimi

ingl.: data 
processing system

rus.: система
обработки
данных

Ma’lumotlarga ishlov berishni 
ta’minlovchi bitta yoki undan ko‘p 
kompyuter, chekka qurilmalar va 
dasturiy vositalar.

ma’lumotlarm 
boshqarish tili

ingl.: Data 
Manipulation 
Language (DML)

rus.: язык 
манипулирования 
данными

Ma'lumotlar bazasining 
boshqarish tizimida dasturlar bilan 
ma lumotlar bazasi orasida 
almashuvni tashkil qilish uchun 
foydalaniladigan til.

ma’lumotlami
filtrlash

ingl.: data filtering rus.: фитьтрация 
данных

Ma’lumotlarm umumiy oqimidan 
kerakli mezonlarga ega 
bo‘lganlarini ajratib qo'yish 
jarayoni.

ma’ lumotlaming 
buzilishi

ingl.: data damage rus.: повреждение 
данных

Ma’lumotlar butunligimng 
buzilishi.

ma’lumotlarning
xavfsizligi

ingl.: data security rus.: безопасность 
данных

Dasturlami va ma’lumotlami 
tasodifiy yoki qasddan 
o‘zgartirish, yo‘q qilish, oshkor 
qilish, hamda ruxsatsiz 
foydalanishdan muhofazalash 
tamoyillar to‘plami

mobil agent ingl.: mobile agent rus.: мобильный 
агент

Ma’lumotlar bazalari bo'ylab 
axborot izlash maqsadida 
«o‘rmalovchi» dastur. Mobil agent
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izlashni amalga oshirish lozinT 
bo'lgan ma lumotlar bazasiga ega 
tizimga o'tach. 0 ‘rgimchak deb 
ham nomlanuvchi mobil agent 
faqat nimadir topilganda va o ‘z 
foydalanuvchisiga topilganni 
berish lozim boiganda tarmoqqa 
murojaat qiladi.

mobil aloqa ingl.. mobile 
communications

m s.: мобильная 
связь

Mobil aloqa yemsti tayanch 
stansiyasi va bir guruh abonent 
tizimlaridan iborat. Bunday 
yulduzsimon tarmoqda tayanch 
stansiyasi tizimlarning o ‘zaro 
ishlovchi juftlarini bogiab  yoki 
keng tarqatishni amalga oshirib 
ushbu tizimlami uzib-ulash 
jaravonlarini ta mmlavdi.

mobil banking ingl.: mobile 
banking

rus.: мобильный 
банкинг

Bank hisob raqamidan simsiz 
erkin foydalanish 
texnologiyasidan (WAP 
bayonnomasi) foydalangan holda 
uvali telefon yoki portative 
kompyuter (PDA) yordamida 
boshqarish.

mobil Internet ingl.: mobile 
Internet

rus.: мобильный 
Интернет

WAP bayonnomasi asosida 
Intemetdan simsiz erkin 
foydalanish texnologiyasi. Mobil 
aloqa tarmoqlarida so‘rovlami 
uzatish uchun ma'lumotlami 
paketli uzatish xizmati GPRS 
(general packet radio servise) yoki 
CSD transport vazifasini bajarishi 
mumkin.

mobil telefon ingl.: mobile phone m s.: мобильный 
телефон

Mobil aloqada foydalaniladigan 
telefon apparati turi.

mobil telefoniya ingl.: mobile 
telephony

rus.: мобильная 
телефония

Ko'chma telefon qurilmalarini 
zamonaviy kundalik hayotga 
tadbiq etish.

mobil tijorat ingl.: mobile 
commerce

m s.: мобильная 
коммерция

Mobil aloqa vositalari -  uyali 
telefon, PDA —yordamida 
mahsulot va xizmatlami sotib 
olish va sotish. Internet bilan 
bog‘lanish uchun bunday 
tizimlarda WAP bayonnomasidan 
foydalaniladi.

mobil tizim ingl.: mobile system ms.: мобильная 
система

Harakatlanuvchan va 
harakatlanmaydigan 
abonentlaming bir-biri bilan 
o‘zaro ishlashini ta’minolovchi 
kommunikatsiya tarmog'i xizmati.

pochta server ingl.: mail server rus.: почтовый Foydalanirvchilaming shaxsiy
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сервер xatlarini qabul qilib olish va 
uzatishni hamda ularni 
yo‘naltirishni ta’minlovchi server. 
Pochta serverini tashkil qilish 
uchun shaxsiy kompyuterga 
tegishli dasturiy ta'minotni 
o‘matish lozim.

proksi-server ingl.: proxy server rus.: прокси- 
сервер

Brauzer va oxirgi veb-server 
o ‘rtasida vositachi sifatida 
foydalaniluvchi o ‘rtaliq veb- 
serveri. Proksi-serverdan 
foydalanishning asosiy sababi -  
axborotni uzatishni tejash va 
keshlash orqali kirish tezligini 
oshirish.

so‘rov ingl.: query rus.: запрос M alumotlami uzatishda bosh 
kompyuter tomonidan 
bo‘ysunuvchi kompyutemi uning 
holatini (ish maromini) aniqlash 
va oydinlashtirish maqsadida 
so‘rov qilish jarayom.

so‘rovlar tili ingl.: query 
language

rus.: язык 
запросов

Ma’lumotlar bazasidan axborot 
chiqarib olish uchun moijallangan 
ixtisoslashgan til. So‘rovlar tiliga 
de-fakto (hodisa yuz bergandan 
so‘ng) standart bo‘lib SQL tili 
hisoblanadi.

tarmoq ingl.: network rus.: сеть Bogiamalar va ularni 
birlashtiruvchi shoxchalar 
chizmasi. qarang: Kompyuter 
tarmog‘i.

larmoq amaliy 
tizimi

ingl.: network 
operating system

rus.: сетевая
операционная
система

qarang: tarmoq operatsion tizimi

tarmoq boshqarish 
markazi

ingl.: network 
management centre

rus.: центр 
управления сетью

Katta tarmoqlaming ma’muriy 
tizimi

tarmoq kartasi ingl.: network card rus.: сетевая карта Ma iumotlami kompyuter 
tarmog‘ida bitta kompyuterdan 
boshqasiga uzatish paytida 
kompyuter va aloqa kanali ishini 
muvofiqlashtiruvchi plata shaklida 
yaratilgan moslashtirgich.

tarmoq ma’muri ingl.: network 
administrator

rus.:
администратор
сети

Avtomatlashtirilgan tizim va/yoki 
hisoblash tarmogi resurslarming 
me yoriy ishlashi va ulami 
ishlatish uchun javobgar 
mutaxassis.

tarmoq
moslashtirgichi

ingl.: network 
adapter

rus.: сетевой 
адаптер

qarang: tarmoq kartasi

tarmoq operatsion 
tizimi

ingl.: network 
operating system

rus.: сетевая 
операционная

Tarmoqda maiumotlarga ishlov 
berish, ulami saqlash va uzatishni
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система ta’minlovchi dasturlar majmui.

tarmoq provayderi ingl.: network 
provider

rus.: провайдер 
сети

Abonentlik punkti va bevosita 
tarmoq abonentlariga tarmoq 
xizmatlarmi ko'rsatuvchi vakolatli 
tashkilot.

tarmoq
texnologiyalari

ingl.: network 
technologies

rus.: сетевые 
технологии

Tarmoq maromida muloqotda 
bo‘hsh unkonini beruvchi 
texnologiyalar.

tarmoqda
joylashish

ingl.: network 
location

rus.: сетевое 
расположение

URL manzilida Internet serverini 
aniqlovchi noyob nom. Tarmoqda 
joylashish nuqta bilan ajratilgan 
ikki yoki undan ko‘p qismdan 
iborat boTadi.

tarmoqni
boshqarish

ingl.: network 
management

rus.: управление 
сетью

Hisoblash yoki axborot tarmog‘iga 
maqsadga yo‘naltirilgan ta’sir. U  
belgilangan dasturga binoan 
faoliyat tashkil etish uchun amalga 
oshiriladi.

tarmoqqa faol 
ulanish

ingl.: active line 
connection

rus.: активное 
подключение к 
линии

Tarmoqqa maTumotlami 
o ‘zgartirish yoki 
kirgizish maqsadida ulanish.

veb bog‘lama 
tuzilmasi

ingl.: web-node 
structure

rus.: структура 
веб-узла

Veb bog‘lamasi sahifalan 
orasidagi aloqalarito‘plami

veb-bogiama ingl.: web-node rus.: веб-узел Veb-serverda umumiy katalogda 
saqlangan. birbiri bilan bogTiq 
boTgan veb-sahifalar, rasmlar, 
hujjatlar, kolptashuvchi fayllar va 
boshqa fayllar to‘plami.

veb-dizayn ingl.: web-design rus.: веб-дизайн Veb-sahifalarini bezash. Veb- 
dizayn qog‘oz nasliri uchun 
poligrafik dizayn va sahifalash 
qanday vazifani bajarsa, sayt 
uchun ham xuddi shunday 
vazifani bajaradi. Veb-dizayn sayt 
uchun grafik elementlar, sayt 
uning tuzilmasi, navigatsiyasi va 
ba'zan sayt ishi uchun zarur 
bo‘lgan skriptlarm lovihalash- 
tirish, ya’ni saytni to‘liq yaratish 
nazarda tutiladi.

veb-hujjat ingl.: web- 
document

rus.: веб
документ

Odatda, maxsus murojaat HTML 
(Hypertext Markup Language) 
tilidagi hujjat. Veb-hujjat 
Umumjahon tarmog‘i asosini 
tashkil qiladi.

veb-sahifa ingl.: webpage rus.: веб-страница Internet manzili (URL) bilan bir 
xil ma’noda belgilanuvchi 
mantiqiv birlik. U veb-saytning 
tarkibiy qismidir. lismoniy nuqtai
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nazardan u HTML fayldir.

veb-sahifa nomi ingl.: webpage title rus.: название 
веб-страницы

Veb-sahifani aynanlashtiruvchi 
tavsiflovchi matn. Ochiq sahifa 
nomi veb-brauzeri oynasining 
sarlavha qatorida aks etiriladi.

veb-sayt ingl.: web site rus.: веб-сайт Inglizcha «site» (tarjimasi «joy») 
so'zining o‘zbekcha talaffuzi. 
Umumjahon o‘rgimchak to‘ri 
maTum axborot topish mumkin 
bo‘lgan va noyob URL bilan 
belgilangan virtual joy.

veb-saytni nashr 
etish

ingl.: web-site 
publishing

rus.: публикация 
веб-сайга

Internet yoki tarmoqqa ulangan 
veb-serverga sahifa va fayllarini 
ko‘chirish orqali veb-sayt Internet 
yoki ichki tarmoqda foydalanish 
uchun ochiq bo'lishini amalga 
oshiruvchi jarayon.

veb-server ingl.. web-server rus.: веб-сервер Internet yoki Intranetga ulangan 
umumfoydalanishdagi axborot 
serveri. Unda hujjatlar va fayllar -  
audio, video, grafik va matn 
fayllari -  saqlanib, ular 
foydalanuvchilarga HTTP 
vositalari orqali taqdim etiladi.

veb-usta ingl. . webmaster rus.: веб-мастер Veb-sahifalami loyihalashtirish, 
yaratish va bezash bilan 
shug‘ullanuvchi shaxs. Veb-usta 
Internet texnologiyalari bo‘yicha 
bilimlar majmuasi va rassom- 
bezaklovchi tajribasiga 
(kompozitsiya, dizayn) ega 
boiish i lozim.
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